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Chapter 1: Introduction to Data Flow Management
This chapter includes:

Data Flow Management Overview 18

Data Flow Management Architecture 22

Data Flow Management Concepts 23

Data Flow Management Overview

This section gives an overview about the Universal Discovery and Integrations.

This section includes:

l "Integrations" below

l "Discovery" on the next page

l "Data Flow Management Modules" on the next page

l "Reconciliation" on page 21

Integrations

You use the Integration Studio to set up integrations with external data repositories.

You can set up the following types of integrations:

l Population. Integration that populates the CMDB with CI and relationship information.

l Federation. Integration that retrieves CIs and relationships from an external repository whenever

the data is requested in an ad hoc fashion.

l Data Push. Integration that pushes CIs and relationships from the CMDB to an external data

repository.

Each integration adapter supports certain types of integrations. For example, an integration adapter

that supports both population and federation types can retrieve data periodically for storage within the

CMDB or upon query time; both of these configurations can co-exist within a single integration.
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Discovery

The Discovery process is the mechanism that enables you to collect information about your IT

infrastructure resources and their interdependencies. Discovery automatically discovers and maps

logical application assets in Layers 2 through 7 of the Open System Interconnection (OSI) Model.

Discovery discovers resources such as installed and running applications, network devices, servers, and

so on. Each discovered IT resource is delivered to, and stored in, the configuration management

database (CMDB) where the resource is represented as a managed CI.

Discovery is an ongoing, automatic process that continuously detects changes that occur in the IT

infrastructure and updates the CMDB accordingly. You can discover nodes using agent-based or

agentless discovery.

After configuration, Universal Discovery automatically discovers the network on which the Data Flow

Probe is located, the Node on which the Probe resides, and the Node's IP address. A CI is created for

each of these objects. These discovered CIs populate the CMDB. They act as triggers that activate

discovery jobs. Every time a job is activated, the job discovers more CIs, which in turn are used as

triggers for other jobs. This process continues until the entire IT infrastructure is discovered and

mapped.

For details on out-of-the-box discovery packages and supported integrations, see the HP UCMDB

Discovery and Integrations Content Guide.

Data Flow Management Modules

Note: The Data Flow Management modules are available only when you are logged into UCMDB in

Actual state.

Data Flow Management (DFM) includes the following application modules:

Integration Studio

The Integration Studio enables you to set up UCMDB integrations to define and control data flows from

external data repositories to the CMDB, or from the CMDB to external data repositories.

Note: You must have a valid license to integrate with third-party products. Contact your HP Account

Manager for more details.

For more information, see "Integration Studio" on page 310.
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Universal Discovery

Note: You must have a valid license to use this module. Contact your HP Account Manager for more

details.

The Universal Discovery module enables you to manage the process for discovery of the CIs and

relationships of your IT infrastructure. You control the process by activating discovery jobs.

You can manage discovery by partitioning your enterprise into zones and activating discovery activities

(groups of discovery jobs) to discover infrastructure (IPs, nodes), basic software (shallow running

software including application servers, databases, and web servers), deep database configuration, and

inventory ( for example, CPUs, installed software, logical volumes), among other data.

You could also control the process by manually activating discovery jobs. You can choose to activate all

or some of the jobs in a module. You can also edit discovery jobs, and schedule a job to run at a certain

time.

For more information, see "Introduction to Universal Discovery" on page 415.

Data Flow Probe Setup

The Data Flow Probe Setup module enables you to add Data Flow Probes to the system and to manage

existing Data Flow Probes. You define the network range that each Data Flow Probe covers.

You also manage communication credentials from the Data Flow Probe Setup module. These credentials

are used for both discovery and integration purposes.

Universal Discovery integrates with HP Real User Monitor (RUM) to provide passive, real-time discovery

and monitoring of traffic in a given environment. This is known as the Just-In-Time discovery

mechanism. You manage IP ranges and port ranges for passive discovery probes from the Data Flow

Probe Setup module.

For more information, see "Data Flow Probe Setup" on page 29.

Reconciliation Priority

The Reconciliation Priority module enables you to specify the reconciliation priority for a particular

integration point, CIT, or attribute.

For more information, see "How to Add Reconciliation Priorities to a CI Type" on page 772.
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Adapter Management

The Adapter Management module enables you to edit adapters, scripts, configuration files (including

discovery rules), and scanner configurations. You can also replace or remove external resources needed

for discovery or integration from this module.

For more information, see "Adapter Configuration" on page 214.

Universal Discovery Community

The Universal Discovery Community website provides you with a convenient way to obtain the latest HP

UCMDB Discovery and Integration Content Pack. The Content Pack provides all of the out-of-the-box

discovery packages and integration adapters required for performing discovery and integrating with

other HP products and third-party sources.

For more information, see "Universal Discovery Community" on page 415.

Data Flow Probe Status

The Data Flow Probe Status module enables you to view the current status of a particular Data Flow

Probe: which discovery or integration job the Probe is currently running, execution statistics, and so on.

Note: Data Flow Probes installed on Windows platforms only are displayed in this module.

For details, see "Data Flow Probe Status" on page 132.

Software Library

The Software Library module enables you to view the contents of the SAI files that are contained in

UCMDB. This module also enables to you teach applications to Universal Discovery.

For more information, see "Software Library " on page 692 or "Express Teaching Overview" on page 702.

Reconciliation

The Reconciliation process consists of two important steps:

l Identification. The process by which CIs and relationships within the CMDB are identified against

existing CIs within the CMDB, other CIs within the same bulk, or CIs coming from various federated

data sources.

l Reconciliation Priority. The process by which the CMDB reconciliation engine decides how to deal

Data Flow Management Guide

Chapter 1: Introduction to Data Flow Management

HP Universal CMDB (10.22) Page 21 of 795



with conflicting data. When conflicting values are given for the same CI attribute by different

integrations, the CMDB reconciliation engine resolves the conflict by looking at the reconciliation

priority assigned to each integration.

By default, unless you customize the reconciliation priorities within the Reconciliation Priority Manager,

the CMDB reconciliation engine uses the last reported value as the most accurate, that is, all

integrations have exactly the same priority.

For more information about reconciliation, see "Data Reconciliation" on page 756.

For details about the Reconciliation Priority Manager, see "Reconciliation Priority Window" on page 781.

Data Flow Management Architecture

Data Flow Management architecture is deployed as follows:

l The Data Flow Probe is responsible for integration of data to and from external data repositories

and for performing discovery.

l The Data Flow Probe initiates communication with the UCMDB Server using HTTP or HTTPS traffic,

enabling the product to bypass possible firewalls.
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Data Flow Management Concepts

This section describes the main topics of Universal Discovery:

Data Flow Probe

The Data Flow Probe is the main component responsible for requesting tasks from the server,

scheduling and executing discovery and integration tasks, and sending the results back to the UCMDB

Server. You define a range of network addresses for a specific, installed Data Flow Probe. Each Data

Flow Probe is identified by its name, chosen during the Data Flow Probe installation process.

Probe Cluster

A probe cluster is a logical container for a number of Data Flow Probes. You define a network range for

a cluster. The cluster is responsible for calculating how to distribute the IPs in its network range to

ensure a maximum balance of its IPs among its Probes.

HP UCMDB Integration Service

If your remote managed data repositories are accessible from the UCMDB server machine, you can use

the UCMDB Integration Service (installed on the UCMDB Server) instead of a Data Flow Probe, to run non-

Jython-based integrations.

This enables running non-Jython-based integrations without the need for using Data Flow Probe

resources, leaving the Data Flow Probe resources available for other discovery tasks.

Passive Discovery Probe

A passive discovery probe is an HP Real User Monitor (RUM) probe that is configured to integrate with a

Data Flow Probe to provide passive, real-time discovery and monitoring of traffic in a given

environment. This is known as Just-in-Time discovery.

Communication Protocols

Discovery of the IT infrastructure components uses protocols such as SNMP, WMI, JMX, Telnet, and so on

for communication. For details about each protocol, see the HP UCMDB Discovery and Integrations

Content Guide.

Agent-based Discovery

To collect inventory information, you can deploy Universal Discovery agents (UD agents) on client or
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server machines. The UD agent provides a secured communication channel between the Data Flow

Probe and the nodes being discovered. After setting up the secure communication channel, Universal

Discovery deploys and activates scanners onto the nodes being discovered. The Scanners scan the

nodes for inventory information and store the scanned results in scan files which are downloaded to the

Data Flow Probe through the secured communication channel established with the UD agent.

When the UD agent is installed, collection of software utilization information is enabled. The UD agent

also enables you to benefit from the Call Home feature. Call Home is useful in the case where a node

was unavailable for scanning for a long period. It enables the UD agent to notify the Data Flow Probe

that the node is currently available for scanning.

Agentless Discovery

Although agentless discovery does not require the installation of dedicated agents on the servers that

are to be discovered, it does depend on native OS or standard agents that are already installed such as

SNMP, WMI, TELNET, SSH, NETBIOS, and others. Other discovery capabilities are based on application-

specific protocols such as SQL, JMX, SAP, Siebel, and so on. For details on supported protocols, see the

HP UCMDB Discovery and Integrations Content Guide.

Discovery and Integration Adapters

Adapters on which discovery jobs and integrations are based.

l Jython Adapter. An adapter based on a set of Jython scripts that are executed sequentially.

l Java Adapter. An adapter based on Java code that implements the various DFM interfaces and is

wrapped in a JAR file.

l Generic DB Adapter. An adapter that uses SQL queries and maps database tables to CIs and

relationships by using an ORM file.

l Generic Push Adapter. An adapter that uses a mapping file and Jython scripts to push data to an

external data repository.

The adapters themselves do not contain information about the target to which they are to connect and

from which they are to retrieve information. For data flow to be configured correctly, adapters require

further context information, which can include an IP address, port information, credentials, and so on.

For discovery adapters (adapters used for performing discovery), the additional information is brought

from the Trigger CIs associated with the discovery jobs; for integration adapters, the information is

manually fed when creating the integration or taken from the selected Trigger CI.

Data Flow Management Guide

Chapter 1: Introduction to Data Flow Management

HP Universal CMDB (10.22) Page 24 of 795



For details on making adapter changes, see "Adapter Management Window" on page 258. For details on

creating adapters, see Adapter Development and Writing in the HP Universal CMDB Developer Reference

Guide.

Discovery Modules

The module is a grouping of discovery jobs that logically belong together, can be operated and managed

together, and so on. This helps to reduce clutter in the main view when many jobs need to be written,

and can also offer better manageability.

When creating a job, you should add it to a module or create a new module. If you are creating several

jobs, the best practice is to split them into logical groups and assign them to modules accordingly.

Discovery Modules support a hierarchy of folders, to facilitate easy finding of the relevant discovery

capability.

Management Zones

A Management Zone is a region in the network defined by a collection of IP ranges. A region of an

organization’s infrastructure should be defined as a Management Zone when you want to discover all

the managed objects of the region using the same scheduling policy and parameters.

You can set up multiple Management Zones to run different instances of a discovery activity in different

data centers in your enterprise.

For information, see "Zone-based Discovery" on page 419.

Discovery and Integration Content Pack

The latest discovery and integration content for UCMDB are installed in a Content Pack during the

installation of UCMDB. Updates to the Content Pack are available for download via the HP Live Network.

For details on downloading and installing Content Pack updates, see the "Universal Discovery

Community" on page 415.

Integration Points

Integration points are entities used to set up UCMDB integrations. Each integration point is created with

a selected integration adapter and the additional configuration information required to set up the

integration. For details on creating integration points, see "Integration Studio" on page 310.

Discovery Jobs

A job enables reuse of a discovery adapter for multiple discovery process flows. Jobs enable scheduling
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the same adapter differently over different sets of triggered CIs and also supplying different

parameters to each set. You can launch a discovery by activating the relevant set of discovery jobs that

must be run. Relevant trigger CIs are automatically added to the activated discovery jobs based on their

trigger queries.

Discovery Activities

You use discovery activities within Management Zones to discover infrastructure (IPs, nodes), basic

software (shallow running software including application servers, databases, and web servers), deep

database configuration, and inventory ( for example, CPUs, installed and virtualized software, logical

volumes), among other information.

Input Queries

Note: Input queries refer only to discovery adapters and Jython integration adapters.

Each adapter is assigned an input query that is used as follows:

l The input query defines a minimal set of requirements for every Trigger CI included in a discovery

job or integration point that triggers this adapter. (This is true even when no trigger query is

associated with the job.)

For example, an input query can query for IPs related to nodes with an SNMP agent installed and

discovered on them, that is, only IPs with installed SNMP agents can trigger this adapter. This

prevents the case where a user could manually create a Trigger CI that adds all IPs as triggers to an

adapter.

l An input query defines how to retrieve data information from the CMDB. Destination data

information, even if it is not included in a Trigger CI, can be retrieved by the input query. The input

query defines how to retrieve the information.

For example, you can define a relationship between a Trigger CI (a node with the node name of

SOURCE) and the target CI and then can refer to the target CI according to this node name.

For details on using input queries when writing adapters, see Step 1: Create an Adapter in the HP

Universal CMDB Developer Reference Guide.

Trigger CIs and Trigger Queries

A trigger CI is a CI in the CMDB that activates a discovery job. Every time a job is activated, the job may

discover additional CIs, which in turn are used as triggers for other jobs. This process continues until the
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entire IT infrastructure is discovered and mapped.

A trigger query associated with a job is a subset of the input query, and defines which specific CIs

should automatically trigger a job. That is, if an input query queries for IPs running SNMP, a trigger query

queries for IPs running SNMP in the range 195.0.0.0-195.0.0.10.

Note: A trigger query must refer to the same objects as the input query. For example, if an input

query of an adapter queries for IPs running SNMP, you cannot define a trigger query for an

associated job to query for IPs connected to a node. This is because some of the IPs may not be

connected to an SNMP object, as required by the input query.
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Data Flow Probes and Probe Clusters

The Data Flow Probe is the main component responsible for requesting tasks from the server,

scheduling and executing discovery and integration tasks, and sending the results back to the UCMDB

Server. You define a range of network addresses for a specific, installed Data Flow Probe. Each Data

Flow Probe is identified by its name, chosen during the Data Flow Probe installation process.

A probe cluster is a logical container for a number of Data Flow Probes. You define a network range for

a cluster. The cluster is responsible for calculating how to distribute the IPs in its network range to

ensure a maximum balance of its IPs among its Probes.

HP UCMDB Integration Service

If your remote managed data repositories are accessible from the UCMDB server machine, you can use

the UCMDB Integration Service, installed on the UCMDB Server, instead of a Data Flow Probe, to run

non-Jython-based integrations.

This makes Data Flow Probe resources available for other discovery tasks.
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For information on using the HP UCMDB Integration Service to run integrations, see "How to Set Up an

Integration Point" on page 319.

Note:

l The HP UCMDB Integration Service is supported in a standalone UCMDB environment only.

l The HP UCMDB Integration Service must be started on the UCMDB Server.

l If there is a Data Flow Probe installed and running on the UCMDB Server machine, you must first

stop the Data Flow Probe before you can start the UCMDB Integration Service. For details, see

"How to Check the HP UCMDB Integration Service Status" on page 48.

l The HP UCMDB Integration Service on Linux supports the following integrations:

o HP SIM

o HP SE

o HP NNMi

o EMC Control Center

o CMS Sync

Cluster Range Distribution Policy

A probe cluster is a logical container for a number of Data Flow Probes. When you define a network

range for the cluster, the cluster distributes IP ranges to its Probes, thereby ensuring that the load on

the Probes is evenly balanced.

A cluster balances its IPs among its Probes as follows:

1. To ensure that specific IPs are always distributed to a particular Probe, you can set a TQL query

constraint on that Probe. When the TQL query runs, the resulting IPs are distributed to the

respective Probe.

2. All of the remaining IP addresses in the cluster's range are then distributed evenly among all of the

cluster's Probes (including the Probes with the TQL query constraints).
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Note: The cluster balances its IPs over its Probes in such a way so as to minimize IP movement

after the IPs have been distributed to the Probes.

If the cluster's IPs become unbalanced, the cluster tries to re-balance the IPs among its

Probes. The cluster is allowed to retry to balance the Probes depending on how much

IP movement is allowed. For details, see "How to Limit IP Movement in a Cluster" on page 49.

Example

Consider the following scenario:

l Cluster Range: 10.10.10.0 - 10.10.10.255

l Cluster includes Probe1, Probe2, Probe3

l TQL constraint on Probe1: Probe1's range must include IPs 10.10.10.20 - 10.10.10.40

After running a TQL query on UCMDB, the following IPs are returned:
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The cluster balances its network ranges among its Probes as follows:

l Because of the TQL constraint on Probe1, range 10.10.10.30 - 10.10.10.40 is specifically distributed

to Probe1

l Range 10.10.11.0 - 10.10.11.20 is out of the cluster's range, so it is not distributed to any of the

cluster's Probes

l The remaining IPs in the cluster's ranges are then evenly balanced among all of the cluster's Probes.

The remaining ranges are:

o 10.10.10.0 - 10.10.10.29

o 10.10.10.41 - 10.10.10.255

The cluster always attempts to distribute an IP address to a Probe whose TQL constraint includes

that IP address

Note: Technically, IPs 10.10.10.20 - 10.10.10.29, which fall within Probe1's TQL constraint, can

be distributed to any of the cluster's Probes, and not necessarily only to Probe 1. This is because

these addresses were not found by the TQL query, which means they do not exist in UCMDB. In

turn, no actual workload can be distributed to them anyway, so it is insignificant which Probe

received these IP addresses.

Nonetheless, the cluster does make a special effort to distribute these IPs to Probe1. This way,

if a subsequent recalculation of the TQL query returns these IPs, they are already in place, and

IP movement is minimized.

Furthermore, when the TQL query is recalculated, and if these addresses are found in UCMDB,

these IP addresses are indeed distributed to Probe 1, per its TQL constraint.
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Limiting IP Movement in a Cluster

In a probe cluster, unassigned IPs are assigned to the cluster's Probes in such a way that the imbalance

IP ratio among the Probes remains at a minimum. The imbalance ratio is governed by the imbalance

threshold.

Changing the cluster's network range, changing the set of Probes associated with the cluster, or

assigning a TQL constraint on a Probe in the cluster can cause an imbalance of IPs among the Probes in

the cluster.

In such a situation, and depending on the IP imbalance threshold, the cluster attempts to re-balance the

IPs among the cluster's Probes. That is, if one of the Probes violates the average number of IPs per

Probe, as defined by the imbalance threshold, the cluster re-balances the IPs. If not, the cluster leaves

the current IP distribution unchanged.

Example:

If a cluster has 5 Probes and 1000 IPs in its range, the average number of IPs per Probe should be 200.
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If the imbalance threshold is set to 20%, then if each of the Probes has between 160-240 IPs, they do

not violate the imbalance threshold, and no re-balancing is necessary.

If, however, there are Probes with less than 160 IPs, or more than 240 IPs (see image below)—that is,

more than a 20% deviation from the average 200—the cluster attempts to re-balance the IPs among

the Probes—as long as the TQL constraints on the Probes allow this.
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For details on how to specify the imbalance threshold, see "How to Limit IP Movement in a Cluster" on

page 49.

Job Execution Policies

You can define periods of time when a Probe/probe cluster may not run. You can choose to disable

specific jobs running on any Probe or all jobs running on a specific Probe or on Probes in a cluster. You

can also exclude jobs from a job execution policy so that they continue running as usual.

For details on defining a job execution policy, see "New/Edit Policy Dialog Box" on page 87.

Example of Policy Ordering

Say there are two policies, Total TCP Blackout and Always (the out-of-the-box policy). Total TCP

Blackout does not allow any TCP discovery jobs to run. The policies appear in the list as follows:

A job (Class C IPs by ICMP) starts running. It checks the policies in the policy list from top to

bottom. It starts by checking Total TCP Blackout. The job does not appear in this policy, so it

continues down the list and checks Always. The job does appear here (Allow All is selected in the

Edit Policy dialog box) so the job runs:

The next job (Software Element CF by Shell) starts running. It checks the policies in the policy list

from top to bottom. It starts by checking Total TCP Blackout. The job appears in this policy

(Disallowed Jobs is selected in the Edit Policy dialog box), so the job does not run:
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Caution: If a job is not connected to any policy, it does not run. To run these jobs, set the last

policy in the list to Allow All.

Running JobsWhen a Job Execution Policy Is Running

If a policy begins to operate while a Probe is executing a job, the job pauses. When the policy finishes,

the job continues to run from where it ceased. For example, say a job contains 10,000 trigger CIs. The

job finishes working on 7,000 of them and then the policy starts to operate. When the job continues

(after the policy finishes), it works on the remaining 3,000 trigger CIs—the job does not start running

from the beginning.

Effects of Range Type on Discovery Workflows

Depending on the type of network range defined for a discovery environment, different reconciliation

rules and discovery workflows are applied.

To support different types of environments, the IP Address CI contains the Lease Time attribute which

stores the type of network range. The type of network range the routing domain, and certain discovery

options determine the reconciliation rules and workflows that are applied to that network range.

Updates to the IP Address CI occur when ranges are updated, when IP Address CIs are reported by the

Data Flow Probe, or when new IP/MAC pairs are discovered. This behavior minimizes unnecessary add

and delete operations for IP Address CIs.

For descriptions of typical environments for range types, and for information on how to configure range

types, see "New/Edit Range Dialog Box" on page 120.
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For explanations on choosing the best discovery options for Client types ranges, see "Discovery Options

for Client IP Ranges" on page 533.

The following explains the range types and discovery options, and the effects on data reconciliation:

Range

Type

Discovery

Option Discovery Workflow

Effects on Data

Reconciliation

Data

Center

N/A 1. Ping Sweep by ICMP job runs.

Note: MAC addresses are not captured

during a ping sweep discovery job.

2. Node CI is created.

3. Host Connection jobs run.

4. Inventory Discovery jobs and Universal Discovery

Agent related jobs run.

If the IP addresses that

are discovered during

two unique discovery

runs are identical, the

data is merged into a

single IP Address CI.

Client SNMP 1. Client SNMP Discovery job runs to discover ARP-

enabled devices that provide IP/MAC pair

information.

2. IP/MAC Address Harvesting job runs against

SNMP devices to retrieve IP/MAC pair

information.

3. New or updated IP/MAC pair information and a

CallHomeEvent CI is reported to UCMDB.

4. The Host Connection job and the Call Home

Processing job runs.

5. Inventory Discovery jobs and Universal Discovery

Agent-related jobs run. However, if the Data Flow

Probe cannot establish a connection with the

discovery node or a job is waiting for other tasks

to complete, the workflow is put into a parked

state.

A CallHomeEvent CI is received by UCMDB when

If the IP addresses that

are discovered during

two unique discovery

jobs are different but

the ARP/MAC values are

identical, the data is

merged into a single IP

Address CI.

If the IP addresses that

are discovered during

two unique discovery

jobs are different and

the ARP/MAC addresses

are null or

undetermined, the data

is merged into a single IP

Address CI if the

Interface IDs are

identical.
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Range

Type

Discovery

Option Discovery Workflow

Effects on Data

Reconciliation

the Universal Discovery Agent sends a call home

message to the Data Flow Probe, or when a new

IP/MAC address pair is harvested from an ARP

cache job. As a result, a Call Home Processing job

is triggered and the parked workflow is put into

an activated state. Then, the Inventory Discovery

jobs and Universal Discovery Agent-related jobs

run. For more information on parked workflows

and other traffic cases, see "Call Home

Overview" on page 154.

Without

SNMP

1. Ping Sweep by ICMP job runs.

Note: MAC addresses are not captured

during a ping sweep discovery job.

2. Host Connection jobs run.

3. Inventory Discovery jobs and Universal Discovery

Agent-related jobs run.

Standalone (i.e., not

connected to any CIs) IP

addresses without

ARP/MAC values are

reported to UCMDB.

However, IP addresses

that are connected to a

CI (i.e., not standalone)

and without ARP/MAC

values are not reported

to UCMDB.

If an IP address without

an IP/MAC value is

discovered, and there is

another instance of the

same IP address

together with the same

domain name, the two

instances are reconciled.

This behavior occurs

whether there are

IP/MAC values or not.
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How to Add Data Flow Probes to UCMDB

This task describes how to add a Data Flow Probe to UCMDB.

1. Prerequisites

o Verify that the Probe is installed and make a note of its IP address.

For details about installing a Data Flow Probe, see the interactive HP Universal CMDB

Deployment Guide.

o Ensure that the probe's domain is defined in UCMDB. For details, see "Add New Domain Dialog

Box" on page 88.

2. Add a Data Flow Probe

a. In the Data Flow Management module, go to the Data Flow Probe Setup window.

b. In the Domains and Probes tree, select the domain to which to add the probe.

c. Select the Data Flow Probes node, click , and select New Data Flow Probe.

d. Define the Probe name and provide a description if desired.

e. Select the new Probe and define its network range. For details, see "New/Edit Range Dialog

Box" on page 120.

Note: Two Probes in the same domain cannot have the same IP address in their range.

3. Results

To verify that it the Probe is connected, select the Domains and Probes tree, and in the details

pane on the right, verify that the Status is Connected.

Note: When you install and start the Probe, it automatically connects to UCMDB.
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How to Add Probe Clusters to UCMDB

This task describes how to add a probe cluster to UCMDB.

1. Create a cluster

a. In Data Flow Management , go to Data Flow Probe Setup.

b. In the Domains and Probes tree, select the Data Flow Probes node.

c. Click , and select New Cluster.

d. Enter a name and a description for the cluster.

2. Define a network range for cluster

Select the cluster in the Domains and Probes tree on the left, and in the Ranges pane on the right,

click New Range to define a network range for the cluster.

For details, see "New/Edit Range Dialog Box" on page 120.

3. Add Data Flow Probes to the cluster

a. Select the cluster in the Domains and Probes tree.

b. In the Associated Probes pane on the right, click Add Probe to Cluster , and select Data

Flow Probes to add to the cluster.

Note:

l A Data Flow Probe can belong to one cluster only.

l You can define a Data Flow Probe in a cluster even before the Data Flow Probe has

actually been installed and connects to the UCMDB Server. To do this, select the

cluster in the Domains and Probes tree, click New Data Flow Probe , and give the

Probe a name and a description.

l When a Data Flow Probe is added to a cluster its whole network range becomes part of

the cluster's range. If you remove the Probe from the cluster, the Probe will have no
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defined network ranges because all of them remain part of cluster's range.

Exception: If the Probe was added, and then removed without making any changes to

its range, and before saving the cluster, then its range is not merged with the cluster's

range, but remains with the Probe.

l If management zones are used on the Probe that you are adding to the cluster, and

those management zones contain IP ranges, add the IP ranges to the management

zones again using the Edit Management Zones dialog box.

c. (Optional). Set TQL constraints for one or more Probes. For details, see Set TQL Constraint on

page 106.

4. Save the cluster

Click OK at the bottom of the Details pane to save the cluster.

5. Results

The cluster balances its network ranges among its Probes. For details, see "Cluster Range

Distribution Policy" on page 31.

How to Start a Data Flow Probe

This task describes how to start the Data Flow Probe service.

Note:

l A Data Flow Probe running on a Linux platform is intended for the CMS Sync integration only,

and not for discovery.

l The managed environment is defined by the ranges of the domains. However, with some

discovery adapters it is possible to override this behavior and discover CIs that are out of a

Probe's range.

1. Prerequisite

o Ensure that the UCMDB Server is installed and running.
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o Ensure that the Data Flow Probe is installed.

For installation instructions, see the interactive HP Universal CMDB Deployment Guide.

2. Start the Probe

Start the Probe on the machine on which the Probe is installed:

o Windows: Start > Programs > HP UCMDB > Start Data Flow Probe

o Linux: /opt/hp/UCMDB/DataFlowProbe/bin/ProbeGateway.sh start

The Probe is started as a service.

To verify that the Probe has been launched successfully (Windows Probe only):

a. In UCMDB select Data Flow Management > Data Flow Probe Setup.

b. Select the Probe and, in the Details pane, verify that the status is Connected.

Note:

o The user running the Probe service must be a member of the Administrators group.

o You can also configure the Probe so that it opens in a console. In this case, the command

prompt window is displayed. To open the console, on the Probe machine select Start >

Programs > HP UCMDB > Start Data Flow Probe (console).

How to Stop a Data Flow Probe

l To stop a Probe when it is running as a service, on the machine where the Data Flow Probe is

installed select:

o Windows: Start > Programs > HP UCMDB > Stop Data Flow Probe

o Linux: /opt/hp/UCMDB/DataFlowProbe/bin/probegateway.sh stop

l To stop a Probe when it is running in a command prompt window (the console), on the machine

where the Data Flow Probe is installed press CTRL+c, then y.
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How to Change the Data Flow Probe Default Domain

This task describes how to change a Data Flow Probe's default domain.

1. Stop the Probe. For details, see "How to Stop a Data Flow Probe" on the previous page.

2. Remove the Probe from UCMDB:

o If the Probe appears in the Data Flow Probe Setup > Domains and Probes tree, select the Probe

and click Remove .

o If the Probe does not appear in the Data Flow Probe Setup > Domains and Probes tree (in the

case of a Probe on Linux/Probe configured for Integration only), you must delete it from the

UCMDB JMX console:

i. Log in to the UCMDB JMX Console. For details, see How to Access the JMX Console in the HP

Universal CMDB Administration Guide.

ii. If you do not know the exact name of the Probe that you want to remove, you can

generate a list of the Probes on UCMDB by invoking the getAllRegisteredProbes

operation.

iii. Locate the removeProbeOrCluster operation, enter your customer ID (default:1) and the

name of the Probe you are removing, and invoke the operation.

The Probe is removed from UCMDB.

3. Update the Probe default domain property.

a. On the Probe machine, open the DataFlowProbe.properties file, located in:

l Windows: C:\hp\UCMDB\DataFlowProbe\conf

l Linux: /opt/hp/UCMDB/DataFlowProbe/conf

b. Update the following property with the new domain name:

l appilog.collectors.domain

For more details about this property, see "DataFlowProbe.properties Parameters" on page 69.
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4. Clear the data from the Probe.

Note: The clearProbeData script resets the Data Flow Probe's DB schemas and file system

state. After running this script the Data Flow Probe re-sends all discovered data to UCMDB.

This could potentially create a significant load on the UCMDB Server.

For details, see "How to Clear Data Flow Probe Data" on page 58.

5. Restart the Probe. For details, see "How to Start a Data Flow Probe" on page 42.

How to Change the Data Flow Probe Port

This task describes how to change a Data Flow Probe's port number.

1. Stop the Probe. For details, see "How to Stop a Data Flow Probe" on page 43.

2. Update the Probe's port property.

a. Open the DataFlowProbe.properties file, located in:

l Windows: C:\hp\UCMDB\Data Flow Probe\conf

l Linux: /opt/hp/UCMDB/Data Flow Probe/conf

b. Update the following property with the new port number:

l If HTTP communication is configured: serverPort

l If HTTPS communication (SSL) is configured: serverPortHttps

For more details about these properties, see "DataFlowProbe.properties Parameters" on page

69.

3. Clear the data from the Probe.

Note: The clearProbeData script resets the Data Flow Probe's DB schemas and file system

state. After running this script the Data Flow Probe re-sends all discovered data to UCMDB.

This could potentially create a significant load on the UCMDB Server.

Data Flow Management Guide

Chapter 2: Data Flow Probe Setup

HP Universal CMDB (10.22) Page 45 of 795



For details, see "How to Clear Data Flow Probe Data" on page 58.

4. Restart the Probe. For details, see "How to Start a Data Flow Probe" on page 42.

How to Move Resources From One Domain to Another

Domain

This task describes how to move credentials, Data Flow Probes, and Probe ranges from one domain (the

source domain) to another domain (the target domain).

1. Prerequisite: Deactivate all running jobs and all activities running in all the Management Zones.

2. Stop each Data Flow Probe in the source domain that you want to move to the target domain. For

details, see "How to Stop a Data Flow Probe" on page 43.

3. On each Probe machine, open ..\hp\UCMDB\DataFlowProbe\conf\dataFlowProbe.properties, and

locate the following line:

appilog.collectors.domain =

Set the parameter's value to ${DefaultDomain}.

Save the changes, but do not yet restart the Probe.

4. In UCMDB, go to Data Flow Management > Data Flow Probe Setup and for each Probe under your

source domain:

a. Select the Probe and click Export to CSV to export the Probe's ranges to a CSV file.

b. Delete the Probe from the source domain.

5. Create a new domain—the target domain—with Type = Customer.

6. In the source domain, select each credential, click Copy to Another Domain , and select the

target domain that you created above.

7. In UCMDB, go to Administration > Infrastructure Settings Manager.

Data Flow Management Guide

Chapter 2: Data Flow Probe Setup

HP Universal CMDB (10.22) Page 46 of 795



a. In the Filter by Column box, select Name, and in the adjacent box, type domain.

b. Among others, the Default Domain Property Value setting is displayed. In the Valuecolumn of

this setting, enter the name of the target domain you created above.

c. Save your changes.

8. Delete all the ipaddress and ipsubnet CIs from your CMDB.

9. On each Probe:

a. Run clearProbeData.bat. For details, see "How to Clear Data Flow Probe Data" on page 58.

b. Start the Probe. For details, see "How to Start a Data Flow Probe" on page 42.

Note: Ensure that the Probe started properly.

10. In UCMDB, go to Data Flow Management > Data Flow Probe Setup:

a. Check that all the Probes from the source domain now appear under the target domain you

created above.

b. For each Probe, import the corresponding CSV with the Probe ranges that you exported earlier.

How to Change the HP UCMDB Integration Service Default

Domain

This task describes how to change the default domain of the HP UCMDB Integration Service.

1. Stop the Integration Service.

Windows Start > Programs > HP UCMDB > Stop HP Universal CMDB Integration Service

Linux /opt/hp/UCMDB/UCMDBServer/integrations/bin/service.sh stop

2. Update the domain properties.
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o Open the DataFlowProbe.properties file, located in:

Windows c:\hp\UCMDB\UCMDBServer\integrations\conf

Linux /opt/hp/UCMDB/UCMDBServer/integrations/conf

o Update the following property with the new domain name:

appilog.collectors.domain

For more details about this property, see "DataFlowProbe.properties Parameters" on page 69.

3. Clear the data from the Integration Service.

For details, see "How to Clear HP UCMDB Integration Service Data" on page 59.

Note: The clearProbeData script resets the Integration Service's DB schemas and file system

state. After running this script the Integration Service re-sends all discovered data to UCMDB.

This could potentially create a significant load on the UCMDB Server.

4. Restart the Integration Service.

Windows Start > Programs > HP UCMDB > Start HP Universal CMDB Integration Service

Linux /opt/hp/UCMDB/UCMDBServer/integrations/bin/service.sh start

How to Check the HP UCMDB Integration Service Status

If your remote managed data repositories are accessible from the UCMDB server machine, you can use

the UCMDB Integration Service for non-Jython-based integrations instead of a Data Flow Probe.

Note: The HP UCMDB Integration Service is supported in a standalone UCMDB environment only.

To ensure that the service is running:
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1. Check the status on the UCMDB Server machine:

Windows Control Panel > Administration Tools > Services

Linux /opt/hp/UCMDB/UCMDBServer/integrations/bin/service.sh status

2. If the service is not running:

a. Check if there is a Data Flow Probe installed and running on the UCMDB Server machine. If so,

you must first stop the Data Flow Probe before you can start the UCMDB Integration Service.

To stop the Data Flow Probe:

Windows Select Start > Programs > HP UCMDB > Stop Data Flow Probe

Linux Enter the following command:

/opt/hp/UCMDB/DataFlowProbe/bin/probegateway.sh stop

b. Start the UCMDB Integration Service:

Windows Use one of the following:

l Select Start > Programs > HP UCMDB > Start HP UCMDB Integration Service

l Select Start > Control Panel > Administration Tools > Services, and start

the UCMDB Integration Service

Linux Enter the following command:

/opt/hp/UCMDB/UCMDBServer/integrations/bin/service.sh start

How to Limit IP Movement in a Cluster

This task describes how to set the IP imbalance threshold for probe clusters to minimize IP movement in

the cluster.

To set the imbalance threshold:

1. Go to Administration > Infrastructure Settings > General Settings > Maximal allowed cluster

imbalance.
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2. Enter the imbalance threshold (in percentage).

Default: 20% The cluster must distribute the IPs among its Probes so that they are balanced. That

is, by default no Probe may have 20% more or less than the average number of IPs. If the number

of IPs on any Probe deviates from this threshold, the cluster attempts to redistribute the IPs

among its Probes.

For an example, see "Limiting IP Movement in a Cluster" on page 34.

Note: If minimal IP movement is more critical than cluster imbalance, then minimize the

IP movement by making this threshold higher. The higher the imbalance threshold, the less

the IPs will be moved around.

How to Update the Data Flow Probe's IP Address

This task describes how to configure a Data Flow Probe if its IP address has changed.

Note: If the IP address of a Data Flow Probe has changed, it is advisable to re-install the Probe. For

information about installing the Data Flow Probe, see the interactive HP Universal CMDB

Deployment Guide. If it is not possible to reinstall the Probe, perform the procedure below.

To change the IP address of a Data Flow Probe:

1. Update the Probe properties

In C:\hp\UCMDB\Data Flow Probe\conf folder:

o Open the DataFlowProbe.properties file and update the following properties:

l appilog.collectors.local.ip

l appilog.collectors.probe.ip

For more details about these properties, see "DataFlowProbe.properties Parameters" on page

69.

o Open the probeMgrList.xml, locate the line that starts with <probeMgr ip= and update the

Probe Manager machine name or IP address, for example:

<probeMgr ip="OLYMPICS08">
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2. Stop the Probe

o To stop the Probe when it is running as a service, select

Start > Programs > HP UCMDB > Stop Data Flow Probe

o To stop the Probe when it is running in a command prompt window (the console), press CTRL+c,

then y.

3. Clear the data from the Probe

For details, see "How to Clear Data Flow Probe Data" on page 58.

Note: The clearProbeData script resets the Data Flow Probe's DB schemas and file system

state. After running this script the Data Flow Probe re-sends all discovered data to UCMDB.

This could potentially create a significant load on the UCMDB Server.

4. Restart the Probe

To restart the Probe from the Start window or from the console, see "How to Start a Data Flow

Probe" on page 42.

How to Update the Data Flow Probe Memory Size

The Data Flow Probe Memory Size is defined during installation.

This task describes how to change the maximum heap size..

1. Open the WrapperEnv.conf located in

Windows C:\hp\UCMDB\DataFlowProbe\bin\

Linux /opt/hp/UCMDB/DataFlowProbe/bin

2. Update the following parameters:

o set.GATEWAY_MAX_MEM

o set.MANAGER_MAX_MEM
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Note: For Probes on Linux machine, update only set.GATEWAY_MAX_MEM

3. Restart the Data Flow Probe process.

How to Define Owner Tenants on Data Flow Probes

In multi-tenancy environments, all discovered CIs/relationships are assigned an owner tenant. If no

owner tenant is defined in the discovery adapter parameters, but an owner tenant is defined in the

Data Flow Probe properties, the discovered CIs/relationships are assigned this owner tenant.

This task describes how to define an owner tenant in the Data Flow Probe properties.

Note: This section is relevant for multi-tenancy environments only.

1. Prerequisite

The owner tenant that you want to define in the Data Flow Probe properties must already be

defined in UCMDB. For details on creating owner tenants in UCMDB, see New Tenant/Edit Tenant

Dialog Box in the HP Universal CMDB Administration Guide.

2. On the Data Flow Probe open the DataFlowProbe.properties file, located in the Data Flow Probe's

installation folder under ..\UCMDB\DataFlowProbe\conf.

3. Define the owner tenant parameter by adding the following line:

com.hp.ucmdb.discovery.Probe.DefaultTenant=<owner_tenant>

where owner_tenant is the name of the owner tenant, as defined in the Security > Tenants

Management module.

4. Save the DataFlowProbe.properties file.

5. Restart the Data Flow Probe.

6. Result

The owner tenant is displayed in the Data Flow Probe Setup module.
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How to Configure the Number of Connections to Other

Machines

This task describes how to configure the number of connections per second that a Data Flow Probe is

allowed to create to other machines. You configure these settings in the globalsettings.xml file which

is located in the Adapter Management module under Resources pane > Packages >

AutoDiscoveryContent > Configuration Files.

To configure the number of connections per second created by the Probe to other machines:

1. In the globalsettings.xml file, configure the properties listed below as follows:

Property Description

maximumConnectionsPerSecond Enables limiting the number of new connections per second

created by the Probe to other machines.

o 0. Unlimited number of connections allowed.

o > 0. The maximum number of connections. If this limit is

reached, any job trying to create a new connection will

wait for a period of time that is determined in the

timeToSleepWhenMaximumConnectionsLimitReached

property (see below)

Default: 0 (unlimited)

timeToSleepWhenMaximum

ConnectionsLimitReached

Determines how long (in milliseconds) a job needs to wait

until a new connection can be created, assuming the

"maximumConnectionsPerSecond" limit has been reached.

Default: 1000 milliseconds (1 second)

Note: If maximumConnectionsPerSecond = 0, this

property is ignored.

2. Save your changes.
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For more details about the globalsettings.xml file, see the HP UCMDB Discovery and Integrations

Content Guide.

How to Configure Periodic Data Flow Task Updates

When a data flow job is activated, the input TQL of the adapter is calculated once and is sent to the Data

Flow Probe. If trigger CI data changes (for example, a laptop acquires a different IP address) the Data

Flow Probe needs to be updated with the modified trigger CI data. As long as the Data Flow Probe is not

updated with any changes, the query continues to run with out-of-date information.

To ensure that the Data Flow Probe is always kept up-to-date with possible changes in trigger CI data,

you can configure UCMDB to recalculate trigger CI data and send any changes to the Data Flow Probe.

There are rare situations where triggers appear as part of a Service Discovery activity, although they

are not part of the discovered service or CIs related to the service. In this case, the periodic data flow

task updates will dispatch and undispatch these triggers to return the activity to its valid state.

This section includes: 

l "Global Configuration" below

l "Adapter Configuration" on the next page

l "Ad Hoc Updates" on page 56

Global Configuration

Data flow tasks for all adapters are updated per the global setting configured in the Infrastructure

Settings.

Note: Where necessary, you can configure updates for a particular adapter to behave differently.

For details, see "Adapter Configuration" below.

To configure global data flow task updates:

1. Select Administration > Infrastructure Settings Manager.

2. Select the General Settings category.
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a. Locate Enable periodic update of data flow tasks parameter and set the value to true.

b. Locate Periodic data flow task update interval and Periodic data flow task update start

time and specify how often (in hours) to update the data flow tasks, and the time (01-24) at

which to start the update.

By default, this option is enabled, and the data flow tasks are updated once a day, at midnight.

Adapter Configuration

This task describes how to configure a particular adapter so that updates to its data flow tasks are

periodically sent to the Data Flow Probe.

Note:

l The setting in the adapter file overrides the global setting (Enable periodic update of data

flow tasks) described above.

For example, if the setting in the adapter file is set to true, but the global setting is set to false,

the adapter's tasks are still updated on the Data Flow Probe (and vice versa).

l This setting should be configured for an adapter only in the case where updates for the adapter

should behave differently to configuration in the global settings.

To configure data flow task updates for a particular adapter:

1. Open the adapter's xml file in an editor.

2. Locate the <dispatchMechanism> tag. If it does not exist, create it.

3. Add the following parameter:

<dispatchOnChanges isEnabled = "<true or false>" />

Example:

<pattern>

..
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<dispatchMechanism type = "IpAddress">

<dispatchOnChanges isEnabled = "true" />

</dispatchMechanism>

..

</pattern>

Ad Hoc Updates

1. Log in to the UCMDB JMX console. (Launch the Web browser and enter the following address:

http://localhost:8080/jmx-console. You may have to log in with a user name and password.)

2. Click UCMDB:service=Discovery Manager to open the JMX MBEAN View page.

3. Run one of the following methods, depending on which is relevant:

JMX Method Description

recalculateAndUpdateDFMTasks Updates data flow tasks for all the adapters for

which data flow task update is enabled.

Note: Data flow task updates are enabled in

the adapter's configuration file.

recalculateAndUpdateDFMTasksForAdapter Updates data flow tasks for selected adapters

without checking the adapter configurations.

That is, even if the data flow task update is not

enabled for a selected adapter, the updates are

run.

How to Prevent Probes from Sending Touch Information

Simultaneously

When multiple Data Flow Probes send touch information simultaneously to the UCMDB Server, the

Server may become overloaded. To enable a manual load balancing between the multiple Data Flow

Probes running against the UCMDB Server, you can set the time at which each Probe reports the touch:
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1. Open the DataFlowProbe.properties file in a text editor.

2. Locate the lines beginning with # Is touch window mechanism active:

    "# Is touch window mechanism active
appilog.agent.probe.touchWindowMechanism.isActive = false
    "# Defines the time when the touch window starts (HH:MM - 00:00-23:59)
appilog.agent.probe.touchWindowMechanism.startTime = 10:00
    "# Defines the time when the touch window ends (HH:MM - 00:00-23:59)
appilog.agent.probe.touchWindowMechanism.endTime = 23:59

3. Change the appilog.agent.probe.touchWindowMechanism.isActive parameter to true.

4. Set the time at which the Probe should report the touch.

5. Save the file.

These parameters enable the Probes to perform "touching" in non-overlapping time frames.

How to Configure the Data Flow Probe to Automatically

Delete CIs

This task explains how to configure a job so that CI instances of specific CITs are automatically deleted.

1. Select the CIs to be deleted

a. Select an adapter.

b. In the Adapter Configuration tab > Results Management pane, select Enable Automatic

Deletion and in the adjacent drop-down box, select when to enable automatic

deletion: Always, On Success or Warnings, or Only on Success.

c. In the Automatic Deletion box, click .

d. In the Choose Discovered Class dialog box that opens, select CITs for deletion. For details, see

"Choose Discovered Class Dialog Box" on page 262.

e. In the Automatic Deletion box, in the Deletion Method column, select the deletion method for

the CIT: Auto Delete or Candidate for Deletion. For details on the deletion methods, see
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"Automatically Deleted CIs and Relationships and Candidates for Deletion CIs" on page 216.

f. Click the Save button at the bottom of the page.

2. Results

To view the deleted CIs, access the Deleted column in the Discovery Results pane. For details, see

"Discovery Results Tab/Pane" on page 686.

How to Delete Unsent Probe Results

This task describes how to empty the Probe queue that contains results that have not yet been

transmitted to the UCMDB Server.

1. Access the Data Flow Probe JMX console: Launch a Web browser and enter the following address:

http://<Probe Gateway machine name or IP address>:1977. If you are running the Data Flow

Probe locally, enter http://localhost:1977.

You may have to log in with a user name and password.

2. Locate the Probe_<Probe Name> > type=MainProbe service and click the link to open the JMX

MBEAN View page.

3. Invoke the operation by clicking the dropUnsentResults button.

Note: This operation deletes 100 results at a time. To delete more results, re-invoke the operation

as many times as necessary.

How to Clear Data Flow Probe Data

This task describes how to clear the data from the Data Flow Probe.

Note: For details on clearing the data from the UCMDB Integration Service, see "How to Clear HP

UCMDB Integration Service Data" on the next page.
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1. Stop the Data Flow Probe service. To do this, see "How to Stop a Data Flow Probe" on page 43.

2. Run the clearProbeData script

Note: The clearProbeData script resets the Data Flow Probe's DB schemas and file system

state. After running this script the Data Flow Probe resends all the discovered data to UCMDB.

This could potentially create a significant load on the UCMDB Server.

Windows a. On the Data Flow Probe machine, go to:

c:\hp\UCMDB\DataFlowProbe\tools

b. At the command prompt, type:

clearProbeData.bat

Linux /opt/hp/UCMDB/DataFlowProbe/tools/clearProbeData.sh

3. Restart the Data Flow Probe service

Start the Data Flow Probe service. For details, see "How to Start a Data Flow Probe" on page 42.

4. Results

All the data is deleted from the Data Flow Probe.

How to Clear HP UCMDB Integration Service Data

This task describes how to clear the data from the UCMDB Integration Service.

Note: For details on clearing the data on a Data Flow Probe, see "How to Clear Data Flow Probe

Data" on the previous page.
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1. Stop the Integration Service.

Windows Start > Programs > HP UCMDB > Stop HP Universal CMDB Integration Service

Linux /opt/hp/UCMDB/UCMDBServer/integrations/bin/service.sh stop

2. Run the clearProbeData script.

Note: The clearProbeData script resets the Integration Service's DB schemas and file system

state. After running this script the Integration Service resends all the discovered data to

UCMDB. This could potentially create a significant load on the UCMDB Server.

On the UCMDB Server machine, run the script as follows:

Windows c:\hp\UCMDB\UCMDBServer\integrations\tools\clearProbeData.bat

Linux /opt/hp/UCMDB/UCMDBServer/integrations/tools/clearProbeData.sh

3. Restart the Integration Service:

Windows Start > Programs > HP UCMDB > Start HP Universal CMDB Integration Service

Linux /opt/hp/UCMDB/UCMDBServer/integrations/bin/service.sh start

4. Results

All the data is deleted from the Integration Service.

How to Deploy a Data Flow Probe CUP

This task describes how to deploy a cumulative update package (CUP) for Data Flow Probes

(Windows/Linux) connected to UCMDB.

Note:

l This task describes how to deploy the Probe CUP from within the UCMDB user interface. For

instruction on deploying the Data Flow Probe CUP manually on an individual Probe, see "How to

Deploy Data Flow Probe CUP Manually" on page 62.
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l Upgrading Data Flow Probes that operate in separate mode is not supported. To perform an

upgrade, see "How to Deploy Data Flow Probe CUP Manually" on the next page.

l Download CUPs from the HP Live Network website. For more information, see "Universal

Discovery Community" on page 415. For detailed instructions on how to install CUPs, see the

release notes document that is included in the CUP package.

To deploy a Data Flow Probe CUP on all the connected Data Flow Probes:

1. In Data Flow Management, go to the Data Flow Probe Setup module.

2. Click the Deploy Probe Update button.

3. Select a CUP version to deploy, and click OK.

4. Linux only:

a. Extract the upgrade package by running:

/opt/hp/UCMDB/DataFlowProbe/tools/upgrade/extractUpgradePackage.sh

b. Restart the Data Flow Probe.

5. Windows Probe only: Verify that the Probes is connected and that the Probe version is updated:

Go to Data Flow Management > Data Flow Probe Setup, and select the domain. For details, see

"<Domain> Details Pane" on page 96.

Note:

l During the CUP deployment process, all compatible Data Flow Probes are automatically

restarted. If an integration is running on a Data Flow Probe while it is restarting, the integration

stops running, and starts over when the Data Flow Probe restarts. If an integration is almost

finished running, or a significant part has already run, to avoid starting the integration over, we

recommend letting it complete its run, and, thereafter, updating the CUP.

l To undeploy a Data Flow Probe CUP for the purpose of aligning the CUP version with the UCMDB

Server's CUP version, see "How to Align the Data Flow Probe CUP with the UCMDB Server CUP" on

page 63.

Data Flow Management Guide

Chapter 2: Data Flow Probe Setup

HP Universal CMDB (10.22) Page 61 of 795



How to Deploy Data Flow Probe CUP Manually

This task describes how to manually deploy a Data Flow Probe CUP on an individual Data Flow Probe.

Note:

l This procedure can be used if you are upgrading Data Flow Probes that operate in separate

mode. If your Data Flow Probe is not operating in this mode, see "How to Deploy a Data Flow

Probe CUP" on page 60.

l Download CUPs from the HP Live Network website. For more information, see "Universal

Discovery Community" on page 415. For detailed instructions on how to install CUPs, see the

release notes document that is included in the CUP package.

1. Prerequisites

To avoid loss of data, deactivate all discovery jobs before running the update.

2. Install the UCMDB CUP

Run the installation wizard to install the UCMDB server CUP only.

3. Copy files from UCMDB server to Data Flow Probe

Copy the CUP package file from the following source locations on the UCMDB server to the

following destination locations on the Data Flow Probe as follows, depending on the OS platform

you are using:

Note: When the Data Flow Probe is operating in separate mode, copy the file to both the Data

Flow Probe gateway and Data Flow Probe manager.

Windows:

Source: C:\hp\UCMDB\UCMDBServer\content\probe_patch\probe-patch-

10.<VersionNumber>.CUP<VersionNumber>-windows.zip

Destination: C:\hp\UCMDB\DataFlowProbe\runtime\upgrade\ probe-patch-

10.<VersionNumber>.CUP<VersionNumber>-windows.zip
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Linux:

Source: C:\hp\UCMDB\UCMDBServer\content\probe_patch\probe-patch-

10.<VersionNumber>.CUP<VersionNumber>-linux.zip

Destination: /opt/hp/UCMDB/DataFlowProbe/runtime/upgrade/probe-patch-

10.<VersionNumber>.CUP<VersionNumber>-linux.zip

4. Restart the Data Flow Probe

Restart the Probe.

5. Result

(Windows only) Verify that the Probe is connected and that the Probe version is updated: Go to

Data Flow Management > Data Flow Probe Setup, select the domain select the Probe. For details,

see "<Domain> Details Pane" on page 96.

Note:

l If this process fails, uninstall the Probe, reinstall a new Probe, and then deploy the relevant

Probe CUP.

l For details on installing the Probe, see the interactive HP Universal CMDB Deployment Guide.

How to Align the Data Flow Probe CUP with the

UCMDB Server CUP

The cumulative update package (CUP) version of Data Flow Probes connected to the UCMDB Server must

always be aligned with the corresponding CUP version of the UCMDB Server.

This task describes how to align the CUP version on the Data Flow Probes with the corresponding UCMDB

Server's CUP.

Note:

l Aligning Data Flow Probe CUPs is necessary only if any of the connected Data Flow Probes in

your system are installed with CUP versions that are later than the UCMDB Server CUP version.
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l This option is available only for Probes that were updated with a CUP version (manually or using

the Deploy Probe Update feature).

l If a Probe installation includes a CUP, you cannot uninstall the CUP. To uninstall the CUP, you

need to uninstall the Probe, and then reinstall the Probe with the correct CUP version.

To align the Data Flow Probe CUP version:

1. In Data Flow Management module, go to Data Flow Probe Setup.

2. Click the Undeploy Probe Update button. The CUP version on each Data Flow Probe is

downgraded by one CUP version, relative to the CUP version installed on each Data Flow Probe.

Note: If this button is not enabled, the CUP on each of the Probes is aligned with UCMDB, and

nothing further needs to be done.

3. As long as the Undeploy Probe Update button is enabled, this indicates that there is one or

more Probe whose CUP version is not aligned with the UCMDB Server's CUP version. Click this

button again to align the CUP version on those Probes.

When the Undeploy Probe Update button becomes disabled, this indicates that the CUP

version on all of the Probes is aligned with the UCMDB Server's CUP version.

4. Remove the CUP resource from UCMDB to ensure that it is not deployed again:

a. In Administration > Package Manager, select the probeUpdate package, and click Undeploy

Resources .

b. In the Undeploy Package Resources dialog box that opens, select the CUP resource.

c. Click Next and then Finish.

Example

Consider the following deployment:

l UCMDB Server has CUP1 installed

l Probe1 has CUP1 installed.
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l Probe2 has CUP2 installed.

l Probe3 has CUP3 installed.

Aligning the CUP versions will have the following effect:

l Probe1 remains untouched because its CUP version is aligned with that of the UCMDB Server.

l Probe2 is downgraded to CUP1.

l Probe3 is downgraded to CUP2.

In order for Probe3 to be compatible with the UCMDB Server, aligning the CUP versions again will

have the following effect:

l Probe1 and Probe2 remain untouched because their CUP versions are aligned with that of the

UCMDB Server.

l Probe3 is downgraded to CUP1.

How to Uninstall Probe CUPs Manually

This task describes how to uninstall a Data Flow Probe CUP that was deployed manually. This can be

done using manual methods only.

To uninstall a Probe CUP manually:

1. Stop the Probe.

2. Copy ${PROBE_INSTALL}\UninstallCUP\CUP_NUMBER\ probeUninstallCup<CUP_number>.zip to

the ${PROBE_INSTALL}\runtime\upgrade\ directory.

3. From the command prompt, navigate to the ${PROBE_INSTALL}\tools\upgrade\ directory.

4. Run:

o Windows: extractUpgradePackage.bat

o Linux: extractUpgradePackage.sh

5. Ensure that the CUP resource was removed from UCMDB so that it is not deployed again:
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a. In Administration > Package Manager, select the probeUpdate package, and click Undeploy

Resources .

b. In the Undeploy Package Resources dialog box that opens, if the CUP resource is displayed,

select it.

c. Click Next and then Finish.

Data Flow Probe Process Ports

l "Data Flow Probe Machine Ports" below

l "Remote Machine Ports" on the next page

Data Flow Probe Machine Ports

The following ports are used by the Data Flow Probe process on the Data Flow Probe machine:

Port Description

1977 Data Flow Probe’s web application port. Used for JMX console and other web services.

1978 If the Data Flow Probe is installed in separate mode (Probe Manager and Probe Gateway are

running in separate processes), this port is used by the Probe Manager process for the web

application port (Manager’s JMX console).

8453 Data Flow Probe’s secured web application port. It is used to share the Incoming and Original

directories via HTTPs.

8454 If the Data Flow Probe is installed in separate mode and Jetty HTTPS mode is enabled, this

port is used to share the Incoming and Original directories.

1741 Port opened by the Probe Gateway to enable RMI (Remote Method Invocation) between

Gateway and Managers.

1742 Port opened by the Probe Manager to enable RMI (Remote Method Invocation) between

Gateway and Managers.

80 Opened by a CallHome service for Universal Discovery Agents.
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Port Description

5432 Port used by the PostgreSQL database.

1777 Port used by the Tanuki wrapper.

2055 Port opened when the Collect Network Data by Netflow job has been activated. Used for

connecting netflow data reported by nProbe software.

Remote Machine Ports

The following ports are used by the Data Flow Probe process on remote machines:

Port Description

8080 Data Flow Probe uses this port to communicate with the

UCMDB server (if the communication is configured to

HTTP).

8443 Data Flow Probe uses this port to communicate with the

UCMDB server (if the communication is configured to

HTTPS).

22 Used for SSH-based discovery.

23 Used for Telnet-based discovery.

80 Used for HTTP, NNM, PowerShell, UDDI, VMware VIM

discoveries.

135, 137, 138, 139 + DCOM ports Used for WMI and NTCMD discoveries.

161 Used for SNMP discovery.

389 Used for LDAP discoveries.

1521, 1433, 6789, 2048 Used for SQL (Database)-based discoveries.

2738, 7738 Used for Universal Discovery Agent-based discoveries.

443 Used for UDDI, PowerShell discoveries.

280 Used for HP SIM discovery.

1099 Used for JBoss discovery.
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Port Description

5985, 5986 Used for PowerShell discoveries.

Note: These ports depend on the Microsoft Windows

operating system configuration.

3200, 3300-3303, 33xx, where xx is the SAP

server instance number

Used for SAP discovery.

50004, 50104, 50204, 50304, 50404, 5xx04

where xx is the SAP J2EE server instance

number

Used for SAP JMX discovery.

2320 Used for Siebel Gateway discovery.

7001, 7002 Used for WebLogic discovery.

8880 Used for WebSphere discovery.

50001 Used for HP SIM discovery (secure communication).

DataFlowProbe.properties File

A DFM process needs several parameters to be activated. These parameters specify the method to be

used (for example, ping five times before declaring a failure) and against which CI a method should be

run. If parameters have not been defined by the user, the DFM process uses the default parameters

defined in the DataFlowProbe.properties file. To edit the parameters, open DataFlowProbe.properties

in a text editor.

The DataFlowProbe.properties file is located in the following folder:

C:\hp\UCMDB\DataFlowProbe\conf.

Caution: If you update the parameters in the DataFlowProbe.properties file, you must restart the

Probe so that it is updated with the changes.

The DataFlowProbe.properties file is divided into the following sections:

l Server Connection Definitions. Contains parameters that are needed to set up the connection

between the server and the Probe, such as the protocol to be used, machine names, default Probe

and domain names, time-outs, and basic authentication.
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l Data Flow Probe Definitions. Contains parameters that define the Probe, such as root folder

location, ports, and Manager and Gateway addresses.

l Probe Gateway Configurations. Contains parameters that define time intervals for retrieving data.

l Probe Manager Configurations. Contains parameters that define Probe Manager functionality, such

as scheduled intervals, touching, result grouping, chunking, threading, time-outs, filtering, and

reporting multiple updates.

l I18N Parameters. Contains parameters that define language settings.

l Internal Configurations. Contains parameters that enable DFM to function efficiently, such as

thread pool size.

Caution: Internal configuration parameters should not be changed without an advanced

knowledge of Data Flow Management.

DataFlowProbe.properties Parameters

This section describes the parameters of the DataFlowProbe.properties file.

These include:

l "Server Connection Definitions" on the next page

l "Data Flow Probe Definitions" on page 72

l "Probe Gateway Configurations" on page 75

l "Probe Manager Configurations" on page 76

l "I18N Parameters" on page 81
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Server Connection Definitions

Parameter Name (A-Z) Purpose Type

Value

Description

appilog.agent.Probe.

DownloadingTimeout

Timeout in ms. for download

configuration files and userExt files

(that is, serverData files).

long Default: 300000

appilog.agent.probe.protocol Defines the protocol used to

communicate between the Probe

Gateway and the Server.

string HTTP or HTTPS

(SSL)

Default: HTTP

appilog.agent.Probe.

ServerTimeout

Timeout in ms. for Probe requests going

to the server.

long Default: 180000

appilog.agent.Probe.

BasicAuth.User

appilog.agent.Probe.

BasicAuth.Pwd

Basic authentication feature of Probe to

Server. These properties are supplied by

the admin who configured the Web

server. Deprecated: certificate-based,

mutual SSL authentication should be

used instead.

string All keys must be

used to indicate

usage of this

feature. Values

can be empty to

represent non-

values.

appilog.agent.Probe.JMX.

BasicAuth.User

Authentication data for the Probe JMX -

user name.

string All keys must be

used to indicate

usage of this

feature. Values

can be empty to

represent non-

values.

appilog.agent.Probe.JMX.

BasicAuth.Pwd

Authentication data for the Probe JMX -

password.

bytes All keys must be

used to indicate

usage of this

feature. Values

can be empty to

represent non-

values.
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Parameter Name (A-Z) Purpose Type

Value

Description

Password has to

be encrypted.

Encrypt password

using the Probe

JMX (that is, the

getEncryptedKey

Password

operation in the

MainProbe

MBean).

appilog.collectors.

domain

The domain which the Probe Gateway

belongs to (formerly known as the

Domain of the Probe).

string Default:

DefaultProbe

appilog.collectors.

domain.type

The type of the domain. string customer;

external

Default:

customer

appilog.collectors.probe.name The Probe Gateway name used for

identification by the UCMDB server

The server uses this name to pass tasks

to the appropriate Probe Gateway.

string Uses the value

defined during

installation.

The default value

is the machine

name.

http.proxyHost Used only when the Probe should be

connected to the UCMDB server using

proxy server

string DNS names

http.proxyPass Used only when the Probe should be

connected to the UCMDB server using

proxy server

string Default: None

http.proxyPort Used only when the Probe should be

connected to the UCMDB server using

int Default: None
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Parameter Name (A-Z) Purpose Type

Value

Description

proxy server

http.proxyRealm Used only when the Probe should be

connected to the UCMDB server using

proxy server

string Default: None

http.proxyUser Used only when the Probe should be

connected to the UCMDB server using

proxy server

string Default: None

server.webApp.

name

Name of the server Web application

(.war file) responsible for the Probe.

string Default: mam-

collectors

serverName Defines the Server DNS name to which

the Probe Gateway connects.

string The DNS name

serverPort The port number for HTTP

communication.

int Default: 8080

serverPortHttps The port number for HTTPS

communication.

int Default: 8443

Data Flow Probe Definitions

Parameter Name Purpose Type Value Description

appilog.agent.

local.jdbc.user

appilog.agent.

local.jdbc.pwd

PostgreSQL user

name

string

appilog.agent.

local.jdbc.pwd

PostgreSQL password bytes To change the DB password:

1. The out-of-the-box script set_

dbuser_password.cmd can be used in

order to change the password of the

default PostgreSQL user.

2. The password value in the properties
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Parameter Name Purpose Type Value Description

file should be encrypted. Encrypt the

password using the Probe JMX (that is,

getEncryptedKey Password operation

in MainProbe MBean).

appilog.agent.

probe.jdbc.driver

Probe Gateway

database information

string Default:

com.postgresql.jdbc.Driver

appilog.agent.

probe.jdbc.uri

Probe Gateway

database information

string Default:

jdbc:postgresql://localhost/dataflowprobe

appilog.agent.

probe.jdbc.user

Probe Gateway user

name

string

appilog.agent.

probe.jdbc.pwd

Probe Gateway

password

bytes Password has to be encrypted. Encrypt

password using the Probe JMX (that is,

getEncryptedKey

Password operation in MainProbe MBean).

appilog.agent.local.

jdbc.driver

Probe Manager

database information

string Default: com.postgresql.jdbc.Driver

appilog.agent.local.

jdbc.uri

Probe Manager

database information

string Default:

jdbc:postgresql://localhost/dataflowprobe

appilog.agent.netflow.

jdbc.uri

Netflow database

info

boolean jdbc:postgresql://localhost/dataflowprobe

appilog.collectors.

probeLocal

Union

true: Probe GW

process should also

run a Probe Manager

on same JVM.

false: Probe manager

runs separately

boolean Default: true

appilog.collectors.

rmi.gw.port

Communication port

between Probe GW

and Probe Managers

in case they are

installed on separate

int Default: 1742.

Note: This value should be the same

for all installed Probe Managers

belonging to this Probe Gateway.
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Parameter Name Purpose Type Value Description

processes

appilog.collectors.

rmi.port

Internal

communication port

int Default: 1741.

Note: This value should be the same

for all installed Probe Managers

belonging to this Probe Gateway.

appilog.collectors.

storeDomain

ScopeDocument

true: Encrypted

DomainScope

document is stored

on file system and

internal DB.

false: Encrypted

DomainScope

document is retrieved

from server each

startup and stored

only in memory.

boolean Default: true

appilog.collectors.

local.ip

The Probe Manager IP

address or DNS name

string DNS Name

appilog.collectors.

probe.ip

The Probe Gateway IP

address or DNS name

string DNS Name

jettyHttpsEnabled Enables using the

default https server.

Boolean Default: false

To use the https server, change to true.

probe.fips.status Indicates which stage

the probe is on in FIPS

mode:

0 = NON-FIPS

1 = JCE is ready

2 = FIPS

int Default: 0
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Probe Gateway Configurations

Parameter Name Purpose Type Value Description

jettyGtwHttpPort The port of the jetty server used by

Probe Gateway (in separate mode),

or the Probe (in union mode).

int Default: 1977

jettyGtwHttpsPort The https port of the jetty server

used by Probe Gateway (in

separate mode), or the Probe (in

union mode).

int Default: 8453

appilog.agent.

probe.

reconnection.

interval

The interval in ms. between

reconnection attempts of the

Probe Gateway to its Probe

Managers.

long Default: 30000

appilog.agent.

probe.retrieve

tasksFromServer.

interval

The interval in ms. between task

requests from the server by the

Probe Gateway.

long Default: 15000

appilog.agent.probe.

saveResultsInBKPTable

true: Results sent to the Server are

stored in the database in a backup

table.

false: Results are not stored in a

backup table.

boolean Default: false

appilog.agent.probe.

restartProbeAfterJarDownload

.interval

Downloaded jar file resources can

cause the Data Flow Probe to

restart before all the other

resources of an adapter package

have downloaded. This parameter

prevents the restart from

occurring.

long Default: 180000

msec (3 minutes)

Note: The

delay until a

restart on the

first resource

download (that

is, for a first

start or after

clearing the
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Parameter Name Purpose Type Value Description

Probe data) is

10

milliseconds.

probe.master.key Specifies probe master key for

password encryption purpose.

Note: For a probe that is

upgraded to version 10.21, this

parameter is not present by

default. You can manually set

the value for this parameter

by using the changeMasterKey

JMX method. For details, see

the HP Universal CMDB JMX

Reference Guide.

string Default:

appilog.common.

system.types.vect

ors.ObjectStateHo

lderVector

Probe Manager Configurations

Parameter Name Purpose Type

Value

Description

jettyMgrHttpPort The port of the jetty server used by

Probe Manager (in separate mode).

int Default:

1978

jettyMgrHttpsPort The https port of the jetty server

used by Probe Manager (in separate

mode).

int Default:

8454

appilog.agent.

local.max.worker.runtime

Maximal time (in msec) which a

worker thread is allowed to run.

long Default:

900000

appilog.agent.local.max.worker.stuck After this period it is considered as

stuck.

int Default: 8

appilog.agent.

local.check.stuck

Maximal number of worker threads

which can be considered as stuck at

boolean Default:

true
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Parameter Name Purpose Type

Value

Description

Threads the same time. When the number is

reached, the Probe schedules a

restart to release these threads.

true - the Probe Manager should

detect stuck threads.

false - otherwise.

appilog.agent.local.services.

maxRemoteProcesses

The maximum number of remote

processes allowed to be created

during discovery. Remote processes

are used to separate specific

discovery from Probe process to

prevent the Probe from possible

memory issues.

Used, for example, in J2EE Discovery.

int Default: -1

(no limit)

appilog.agent.local.services.

maxRemoteProcessesPerJob

The maximum number of remote

processes per job that are allowed to

run simultaneously.

int Default: 3

appilog.agent.local.process.result.

dataValidation.content

Defines whether to validate data

reported to the UCMDB server by

content. Deals mainly with reported

values (i.e. attribute value), rather

than metadata of objects.

boolean Default:

true

appilog.agent.local.process.result.

checkMultiUpdate

Defines whether to check data

consistency on objects.

boolean Default:

true

appilog.agent.local.process.result.

filterRedundant.filterIgnoredCIs

l true. If CIs were ignored by

reconciliation on a discovery

cycle, as long as they have not

undergone any changes, they are

filtered by the Probe on

subsequent discovery cycles, and

a warning is displayed on the

boolean Default:

true
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Parameter Name Purpose Type

Value

Description

trigger CI level. To resend these

objects, you must clear the

results cache.

l false. Even if CIs that were

ignored by reconciliation, they are

still sent to the UCMDB on each

discovery cycle, together with

new and updated CIs.

appilog.agent.

local.services.poolThreads

Maximal number of concurrent

threads allocated for the multi-

threaded job's execution activity.

int Default: 80

appilog.agent.local.services.

defaultMaxJobThreads

Maximal number of concurrent

threads running on a specific job.

int Default: 8

appilog.agent.local.services.

adHocMaxThreads

Maximal number of threads for ad

hoc tasks.

int Default: 20

appilog.agent.

local.process.

result.data

Validation.

validLinks

true - validate links are legal.

false - do not validate links.

boolean Default:

true

appilog.agent.

local.process.

result.

filter

Redundant

true - filter results which have been

already sent to server.

false - disable filter.

boolean Default:

true

appilog.agent.

local.discovery

AnalyzerFrom

Eclipse

True: DiscoveryAnalyzer is executed

from Eclipse.

False: DiscoveryAnalyzer is not

executed from Eclipse.

boolean Default:

false

appilog.agent

.local.maxTask

Chunk maximal size of results being

sent to the server.

int Default:

20000
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Parameter Name Purpose Type

Value

Description

ResultSize
Note:

Loweri

ng this

value

lowers

the

numbe

r of CIs

sent to

the

CMDB

in a

single

bulk.

appilog.agent.

local.probe.restart.interval

Interval (in msec) before auto-

restarts of the Probe Manager.

long Default:

900000

appilog.agent.

local.process.

result.autoDelete

true - send autodelete notification to

Server for aged objects, not

discovered by the Probe.

false - do not send

Note: This can be enabled only if

appilog.agent.local.process.

result.filterRedundant is

enabled.

boolean Default:

true

appilog.agent

.local.process.

result.filterCI

true - filter results be predefined

rules (CI types).

false - otherwise

boolean Default:

true

appilog.agent.local.

process.result.fixLinks

Direction

true - fix direction of illegal links.

false - otherwise.

boolean Default:

true
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Parameter Name Purpose Type

Value

Description

appilog.agent.local.

process.result.warnOn

MultiUpdate

true - Reports multiple update

warnings to the UCMDB server.

Note: This parameter is global. It

can be overridden on the

adapter level by the

warnOnDuplicates parameter

which is absent by default, but

gets its value from the global

parameter.

boolean Default:

true

appilog.agent.

local.serverdata.

sync.timeout

Timeout (in msec) for the Probe to

sync with Server data before starting

executing tasks.

long Default:

60000

appilog.agent.

local.special

Characters

Remove

Filter characters from string

attributes of result objects which are

reported to server by Probe.

string Default:

empty

string (do

not filter)

appilog.collectors.probemgr.

DefaultResultGroupMinTime

appilog.collectors.probemgr.

DefaultResultGroupMaxObjs

Probe Mgr - Result Grouping defaults

(used when DFM adapter does not

override). Grouping means holding on

to results and sending them to the

Gateway only upon meeting one of

the grouping thresholds. This is used

to control the rate of data flowing

from Probes to the Server.

long Default

min: 5000

Default

max: 30000

(in ms.)

Relation

between

two keys:

OR

appilog.agent.probe.

touchWindowMechanism.isActive

The touch window defines the period

when touch process is allowed . The

parameter defines whether the

touch window mechanism is active.

boolean Default:

false

appilog.agent.probe. Defines the time, in hours and string Format:
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Parameter Name Purpose Type

Value

Description

touchWindowMechanism.startTime minutes, when the touch window

starts

HH:MM

Values:

00:00-

23:59

Default:

00:00

appilog.agent.probe.

touchWindowMechanism.endTime

Defines the time, in hours and

minutes, when the touch window

ends

string Format:

HH:MM

Values:

00:00-

23:59

Default:

23:59

I18N Parameters

Parameter Name Purpose Type Value Description

appilog.collectors.encoding.ANSI Default encoding used for

Windows applications (requiring

ANSI encoding)

string Default: empty (ANSI

encoding is chosen

from the Data Flow

Probe operating

system)

appilog.collectors.encoding.OEM Default encoding used for

DOS/UNIX Shells/IBM encoded

applications.

string Default: empty (OEM

encoding is chosen

from the Data Flow

Probe operating

system)

chcpCodeTo

CharasetName.

xxx

Mapping entry between chcp code

page to specific encoding name

(used for cases where the

cp+<code> rule is not followed)

string Syntax: chcpCodeTo

CharasetName.

<code>=<encoding_

name>
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Parameter Name Purpose Type Value Description

Example: chcpCodeTo

CharasetName.

932=MS932

collectors_language Language settings (must be

manually configured for non-

English environments).

string Default: English

Options: get=German

rus=Russian

Data Flow Probe Database Scripts

The table below lists the Data Flow Probe database scripts. These scripts can be modified for

administration purposes, both in Windows and Linux environments.

Note:

l The scripts are located on the Data Flow Probe machine, in the following location:

o Windows: C:\hp\UCMDB\DataFlowProbe\tools\dbscripts

o Linux: /opt/hp/UCMDB/DataFlowProbe/tools/dbscripts

l Data Flow Probe database scripts should be changed for specific administration purposes only.

Script Description

exportPostgresql [PostgreSQL root account

password]

Exports all data from the DataFlowProbe

database schema to data_flow_probe_

export.bin in the current directory

importPostgresql [Export file name] [PostgreSQL

root account password

Imports data from a file created by the

exportPostgresql script into the DataFlowProbe

schema

enable_remote_user_access Configures the PostgreSQL Data Flow Probe

account to be accessible from remote machines

remove_remote_user_access Configures the PostgreSQL Data Flow Probe

account to be accessible only from the local
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Script Description

machine (default)

set_db_user_password [new PostgreSQL Data

Flow Probe account password] [PostgreSQL root

account password]

Modifies the PostgreSQL Data Flow Probe account

password

set_root_password [new PostgreSQL root

account password] [Current PostgreSQL root

account password]

Modifies the PostgreSQL root account password

Data Flow Probe Log Files

Data Flow Probe logs store information about job activation that occurs on the Probe Gateway and

Probe Manager. The log files can be accessed from the following location:

C:\hp\UCMDB\DataFlowProbe\runtime\log

Note: Alternatively, to access the Data Flow Probe's log files, log in to the JMX console

(http://<probe_machine>:1977/jmx-console/) and, from the main page, select the GeneralUtils

mbean. Activating the executeLogGrabber function zips all the Data Flow Probe's log files. Save the

.zip file locally on your client machine.

General Logs

WrapperProbeGw.log Records all the Probe's console output in a single log file.

l Levels:

o Error. Any error that occurs within the Probe Gateway.

o Information. Important information messages, such as the arrival or

removal of a new task.

o Debug. N/A

l Basic Troubleshooting: Use this file for any Probe Gateway problems to

verify what occurred with the Probe Gateway at any time as well as any

important problems it encountered.
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probe-error.log Summary of the errors from the Probe.

l Levels:

o Error. All errors in the Probe components.

o Information. N/A

o Debug. N/A

l Basic Troubleshooting: Messages from the Probe's infrastructure only.

wrapperLocal.log When running the Probe in separate mode (that is, the Probe Manager and

Probe Gateway are installed on separate machines), a log file is also saved

to the Probe Manager.

l Levels:

o Error. Any error that occurs within the Probe Manager.

o Information. Important information messages such as received

tasks, task activation, and the transferring of results.

o Debug. N/A

l Basic Troubleshooting: Use this file for any Probe Manager problems to

verify what occurred with the Probe Manager at any time as well as any

important problems it encountered.

postgresql.log Displays database related error during the installation.

Note: If this log is empty check in the Event Viewer logs.

Probe Gateway Logs

probeGW-

taskResults.log

Records all the task results sent from the Probe Gateway to the server.

l Levels:

o Error. N/A

o Information. Result details: task ID, job ID, number of CIs to delete
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or update.

o Debug. The ObjectStateHolderVector results that are sent to the

server (in an XML string).

l Basic Troubleshooting:

o If there is a problem with the results that reach the server, check

this log to see which results were sent to the server by the Probe

Gateway.

o The results in this log are written only after they are sent to the

server. Before that, the results can be viewed through the Probe JMX

console (use the ProbeGW Results Sender MBean). You may have to

log in to the JMX console with a user name and password.

probeGW-tasks.log Records all the tasks received by the Probe Gateway.

l Levels:

o Error. N/A

o Information. N/A

o Debug. The task's XML.

l Basic Troubleshooting:

o If the Probe Gateway tasks are not synchronized with the server

tasks, check this log to determine which tasks the Probe Gateway

received.

o You can view the current task's state through the JMX console (use

the Discovery Scheduler MBean).

Probe Manager Logs

probeMgr-

performance.log

Performance statistics dump, collected every predefined period of time,

which includes memory information and thread pool statuses.

l Levels:
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o Error. N/A

o Information. N/A

o Debug. N/A

l Basic Troubleshooting:

o Check this log to investigate memory issues over time.

o The statistics are logged every 1 minute, by default.

probeMgr-

adaptersDebug.log

Contains messages that are created following a job execution.

Discovery Rules Engine Log Files

normalization.audit.log Logs information about the processing of the Discovery Rules Engine.

l Levels:

o Error. N/A

o Information. Audits the number of element processed and the

number of CIs that were changed.

Example:

Normalization (OSHV: 8 elements) (Time: 125 ms) (Modified CIs:

1)

o Debug. N/A

normalization.log Logs detailed information about the processing of the Discovery Rules

Engine, enabling you to trace detailed information of the Discovery Rule

Engine process.

l Levels:

o Error. All discovery rule processing errors.

o Information. Logs all levels of information about the processing of
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the Discovery Rules Engine.

o Debug. Logs mainly for debugging purposes.

l Basic Troubleshooting. Check this log when you need to analyze why a

CI was not enriched by the Discovery Rules Engine.

Data Flow Probe Setup User Interface

This section includes:

New/Edit Policy Dialog Box 87

Add New Domain Dialog Box 88

Data Flow Probe Setup Window 89

New/Edit Range Dialog Box 120

New/Edit Policy Dialog Box

Enables you to create a job execution policy, to disable jobs from running at specific times.

To

access

Go to Data Flow Management > Data Flow Probe Setup > Domains and Probes > Details

pane > Job Execution Policy section. Select an existing policy and click the Edit Policy

button, or click the New Policy  button.

See

also

l "Job Execution Policies" on page 36

l "Domains and Probes Details Pane" on page 94

User interface elements are described below:

UI

Element

(A–Z) Description

Related

jobs

l Allow all. Run the job execution policy on all jobs.

l Total blackout. The policy does not run on any jobs.
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UI

Element

(A–Z) Description

l Allowed jobs. Choose jobs to run even during the configured blackout time.

l Disallowed jobs. Choose jobs that do not run during the configured blackout time.

For allowed and disallowed jobs, clicking the Add job button opens the Choose

Discovery Jobs dialog box enabling to you choose specific jobs to be included/excluded on

the policy.

To remove selected jobs, click the Remove job button.

Tip: Use the SHIFT or CTRL key to select multiple jobs or packages.

Related

Probes

The Probes on which to run the policy. Click the button to open the Edit Related Probes

dialog box to define which Probes are included in the policy.

Time The date and time during which the policy is active. Click the button to open the Edit

Timetable dialog box.

l Description. Add a description of the specific policy. This field is mandatory.

Tip: The text you enter here appears in the Time column in the Job Execution

Policy pane, so it is recommended that the description be informative:

l Time Definition. Click a cell for a day and time to be included in the policy. To add more

than one time unit, drag the pointer over the cells.

Note: To clear a time unit, click the cell a second time.

Add New Domain Dialog Box

Enables you to add a domain.
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To access Go to Data Flow Management > Data Flow Probe Setup > Domains and Probes pane,

click , and select New Domain.

Important

information

In a version 8.01 or later environment that has been upgraded from version 6.x, to

enable data to be modeled similarly as in the previous version, you must define the

Probes as belonging to the External domain and not to the Customer domain.

Relevant

Tasks

"How to Add Data Flow Probes to UCMDB" on page 40

User interface elements are described below:

UI Element

(A–Z) Description

Description Enter a description to appear in the Details pane of the Data Flow Probe Setup window.

Domain

Type

l Customer. A private domain used for your site. You can define several domains and

each domain can include multiple Probes. Each Probe can include IP ranges but the

customer domain itself has no range definition.

l External. Internet/public domain. A domain that is defined with a range. The

external domain can contain only one Probe whose name equals the domain name.

However, you can define several external domains in your system.

Name Enter a unique name for the domain.

Data Flow Probe Setup Window

In this window you can manage the discovery domains, Data Flow Probes, and probe clusters in UCMDB.

You can also manage connection data for each connection protocol.

To

access

Select Data Flow Management > Data Flow Probe Setup.

See also l "How to Add Data Flow Probes to UCMDB" on page 40

l "How to Add Probe Clusters to UCMDB" on page 41

l "How to Start a Data Flow Probe" on page 42

l "How to Stop a Data Flow Probe" on page 43
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l Supported Protocols and Supported Agents in the HP UCMDB Discovery and Integrations

Content Guide.

Domains and Probes Pane

Enables you to view, define or edit domains, connection credentials, probe clusters, Data Flow Probes,

and passive discovery probes. Also enables you to automatically upgrade all the Data Flow Probes with

the latest cumulative patch (CUP).

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element

(A–Z) Description

l New Domain. Opens the Add New Domain dialog box, enabling you to define a

discovery domain in UCMDB. For details, see "Add New Domain Dialog Box" on

page 88.

Available when: Domains and Probes root is selected

l New Data Flow Probe. Opens the Add New Probe dialog box, enabling you to add

a Data Flow Probe to UCMDB.

Available when: The Data Flow Probes node or a cluster is selected.

l New Cluster. Opens the Add New Cluster dialog box, enabling you to define a

new probe cluster. For details, see "How to Add Probe Clusters to UCMDB" on

page 41.

Available when: The Data Flow Probes node is selected.

Remove Domain/Probe/Cluster. Removes the selected domain, Data Flow

Probe/probe cluster, or passive discovery probe.

Note:

l When you remove a Data Flow Probe from a cluster, its network range

remains part of the cluster's network range, and a new network range

needs to be defined for the Data Flow Probe.

Exception: If the Probe was added to a cluster , and then removed without
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UI Element

(A–Z) Description

making any changes to its range and before saving the cluster, then its

range is not merged with the cluster's range, but remains with the Probe.

l If you remove a probe cluster, and its Probes are still up and running, the

Probes automatically reconnect to UCMDB server, and, after a few minutes,

reappear in the Data Flow Probe Setup under their defined domain.

Find Probe Range by IP. If a Probe has many defined ranges, you can locate a

specific range on the Probe.

To do this, select the Probe and click Find Probe Range by IP. In the Find Probe

Range dialog box, enter the IP address (in IPv4 or IPv6 format, as appropriate) and

click the Find button. The range is highlighted in the Ranges pane.

Reload Domain Information from Server. Updates all domain and probe

information from the server.

/ l Suspend Probe/Cluster. Suspends the selected Data Flow Probe/probe cluster

from the UCMDB Server such it cannot run discovery and integration jobs.

l Resume Probe/Cluster. Resumes the Data Flow Probe/probe cluster's ability to

run discovery and integration jobs.

Note: When a Data Flow Probe/probe cluster is suspended, only the ability to

run jobs is suspended. All other processes continue to run as usual.

Deploy Probe Update. Opens the Deploy Probe Update dialog box, enabling you to

automatically update the CUP version of all the Data Flow Probes connecting to the

UCMDB Server to the CUP version compatible with the UCMDB CUP version.

In the Deploy Probe Update dialog box, navigate to the Probe CUP .zip file.

Note: During the CUP deployment process, all compatible Data Flow Probes are

automatically restarted. If an integration is running on a Data Flow Probe while

it is restarting, the integration stops running, and starts over when the

Data Flow Probe restarts. If an integration is almost finished running, or a

significant part has already run, to avoid starting the integration over, we
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UI Element

(A–Z) Description

recommend letting it complete its run, and, thereafter, updating the CUP.

Undeploy Probe Update. Enables you to undeploy CUP versions of the Data Flow

Probes connecting to the UCMDB Server, and thereby align them with the CUP

version of the UCMDB Server.

For details, see "How to Align the Data Flow Probe CUP with the UCMDB Server CUP"

on page 63.

<Domain and

Probes tree>

Displays the domains defined in the system, along with the credential per supported

protocol and the probe clusters, Data Flow Probes, and passive discovery probes in

each domain.

Note: Integration Probes—that is Probes on Linux machines, and Windows

Probes configured for integration only— are not displayed in the tree. To verify

if an integration Probe is connected, create a dummy integration point and

verify that the Probe is listed among the Probes that can be selected for the

integration point. For details, see "How to Set Up an Integration Point" on page

319.

<Credential

status icons>

. Indicates that an active discovery job or activity wants to connect using the

protocol, but no protocol credential information is defined.

<Data Flow

Probe status

icons>

l . Indicates that the Probe is connected.

l . Indicates that the Probe is suspended.

l . Indicates that the Probe is disconnected.

<Probe Cluster

status icons>
l . Indicates that the probe cluster is connected.

l . Indicates that the probe cluster is suspended.

Note: A red exclamation mark on the cluster icon ( ) indicates an warning or

error that needs attention.
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Details pane

Displays details relevant to the node selected in the Domains and Probes tree.

Selected Node Information Pane

Domains and Probes Displays details of all the Data Flow Probes. You can also

define and edit job execution policies.

For details, see "Domains and Probes Details Pane" on the next

page.

A specific domain Displays a list of probe clusters, Data Flow Probes, and passive

discovery probes defined and running in the selected domain.

You can add a description for the domain in this pane.

For details, see "<Domain> Details Pane" on page 96.

A specific protocol Displays the details on the protocol, including user credentials.

You can add/edit protocol parameters in this pane.

For details, see "<Protocol> Details Pane" on page 98.

For a list of supported protocols, see the HP UCMDB Discovery

and Integrations Content Guide.

A probe cluster Displays details of the selected probe cluster, including range

information. You can also add ranges to, or exclude ranges

from, the cluster.

For details, see "Cluster Details Pane" on page 105.

A Data Flow Probe Displays the details of the Data Flow Probe, including range

information. You can also add ranges to, or exclude ranges

from, the Data Flow Probe.

For details, see "Data Flow Probe Details Pane" on page 109.
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Selected Node Information Pane

Passive Discovery Probes You can view and globally configure notification types and

verification policies for all passive discovery probes that

integrate with the Data Flow Probes of the same domain.

For details, see "Passive Discovery Probes Pane" on page 114.

A specific passive discovery probe Displays the details of a passive discovery probe, including the

Data Flow Probe to which it connects, and its IP range

information. You can also configure the IP ranges to be

monitored by the passive probe, and you can remove a passive

probe from the domain.

For details, see "Passive Discovery Probe Details Pane" on

page 117.

Domains and Probes Details Pane

To

access

Select Data Flow Probe Setup > Domains and Probes pane > Domains and Probes root

node.

Domains and Probes Pane

Displays all of the Probes connected to the UCMDB Server.

User interface elements are described below:

UI

Element

(A–Z) Description

IP The main IP address with which the Probe communicates with the UCMDB server.

Last

Access

Time

The last time that the Probe requested tasks from the server.
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UI

Element

(A–Z) Description

Name The name given the Probe when it was added to UCMDB.

Probe

Version

The version of the Probe.

If the version of the Probe is not compatible with the version of the UCMDB server, this is

indicated. Moreover, if the incompatible Probe tries to connect to the UCMDB server, the

server sends a shutdown instruction to the Probe. To ensure compatibility, you must

update the Probe. For details, see "How to Deploy a Data Flow Probe CUP" on page 60.

Status l Connected. The Probe is connected to the server (the Probe connects every few

seconds).

l Connected (suspended). The Probe is connected, but it is suspended such that no jobs

can run on the Probe.

l Disconnected. The Probe is not connected to the server.

Job Execution Policy Pane

Enables you to configure the periods of time when jobs should or should not run on selected

Probes/clusters.

Important

information

l The default job execution policy is Always. This policy allows all jobs to run on any

Probe/cluster at any time.

l Jobs that have a listening functionality—that is, they do not perform discovery, for

example, they listen to SNMP traps—are not included in a policy.

See also "Job Execution Policies" on page 36

User interface elements are described below:

UI

Element

(A–Z) Description

Move priority up/down. Move the priority for the policy up or down. Universal Discovery

executes all the policies in the list with the first policy taking priority. If a job is included in
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UI

Element

(A–Z) Description

two policies, only the first policy for that job is executed.

New Policy. Opens the New Policy dialog box, enabling you to add a job execution policy.

Remove Policy. Removes the selected job execution policy.

Note: If a job affected by the policy is active when the Remove command is executed,

UCMDB removes the policy but any of the job's triggers that are currently running

remain unaffected.

Edit Policy. Opens the Edit Policy dialog box, enabling you to edit the selected job

execution policy.

Jobs The jobs that are affected by the policy.

Probes The Probes/clusters that are affected by the policy.

Time The schedule of the policy.

<Domain> Details Pane

This pane displays the details of the selected domain and the probes defined in the domain.

To

access

Select Data Flow Probe Setup > Domains and Probes pane > Domains and Probes root

node > a domain.

Domain Details

User interface elements are described below:

UI Element

(A–Z) Description

Description The description that was given to the domain when it was defined in UCMDB.

Note:  This field is editable.
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UI Element

(A–Z) Description

Domain

Type

l Customer. A private domain used for your site. You can define several domains and

each domain can include multiple Probes. Each Probe can include IP ranges but the

customer domain itself has no range definition.

l External. Internet/public domain. A domain that is defined with a range. The

external domain can contain only one Probe whose name equals the domain name.

However, you can define several external domains in your system.

Data Flow Probes Details

Lists all of the probes in the selected domain.

User interface elements are described below:

UI

Element

(A–Z) Description

IP The main IP address with which the Probe communicates with the UCMDB server.

Last

Access

Time

The last time that the Probe requested tasks from the server.

Name The name given the Probe when it was added to UCMDB.

Probe

Version

The version of the Probe.

If the version of the Probe is not compatible with the version of the UCMDB server, this is

indicated. Moreover, if the incompatible Probe tries to connect to the UCMDB server, the

server sends a shutdown instruction to the Probe. To ensure compatibility, you must

update the Probe. For details, see "How to Deploy a Data Flow Probe CUP" on page 60.

Status l Connected. The Probe is connected to the server (the Probe connects every few

seconds).

l Connected (suspended). The Probe is connected, but it is suspended such that no jobs

can run on the Probe.

l Disconnected. The Probe is not connected to the server.
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Passive Discovery Probes Details

For details, see "Passive Discovery Probes Pane" on page 114.

<Protocol> Details Pane

Enables you to manage protocol connection credentials.

UI Element

(A–Z) Description

Create New Connection Details. Opens the Protocol Parameters dialog box, enabling

you to define a connection credential for the selected protocol type. For details, see

"Protocol Parameter Dialog Box" on page 100.

Remove Connection Details. Removes the selected connection credential.

Edit Connection Details. Opens the Protocol Parameters dialog box, enabling you to

edit the selected connection credential. For details, see "Protocol Parameter Dialog

Box" on page 100.

Copy/Move selected credential to another domain. Enables you to copy/move the

selected credential to another domain in the Domains and Probes tree.

Export Certificate for Manual Agent Deployment. Enables you to export the Universal

Discovery Agent certificate when installing the Universal Discovery Agent manually. For

details, see "How to Install the Universal Discovery Agent Manually" on page 160.

Available for: Universal Discovery Protocol only.

Import DDMI Certificates. Opens the Universal Discovery Protocol Parameters dialog

box, enabling you to import certificates during a migration from DDMI to Universal

Discovery. For details on the dialog box, see "Protocol Parameter Dialog Box" on page

100. For details on DDMI migration, see the DDMI to Universal Discovery Migration

Walkthrough Guide.

Available for: Universal Discovery Protocol only.

Move entry up/Move entry down. Enables you to move credential connections up or

down to set the order in which credential sets are attempted. UCMDB tries to connect

using all the credential sets in the list, with the first set taking priority.

<Protocol Displays the connection credentials defined for the protocol type selected in the
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UI Element

(A–Z) Description

connection

details

grid>

Domains and Probes tree on the left. The details displayed in this section vary from

protocol type to protocol type. For details, see the relevant protocol information as

described in the Supported Protocols section in the HP UCMDB Discovery and

Integrations Content Guide.

All protocol credentials include the following parameters:

l Index. Indicates the order in which credential instances are selected to make a

connection attempt. The lower the index, the higher the priority.

Default: Credentials are added with an auto-increasing index value. To update the

index, use the arrows buttons ( ).

l Scope. To change the range that a protocol must discover or to select a Probe or

probe cluster, click Edit. For details, see "Protocol Parameter Dialog Box" on the

next page.

Default: ALL

l User Label. Enables you to enter a label to help you identify the protocol credential

when you use it later.

Syntax: Maximum of 50 characters

<right-

click

menu>

When you right-click connection credential, choose from the following options:

l Edit. Enables you to enter protocol parameters, such as user name and password,

that enable connection to an application on a remote machine.

l Edit using previous interface. Choose this option under any of the following

circumstances:

o In a previous version of UCMDB, you added parameters to this protocol that do

not exist in this version.

o Values in this version cannot be deleted. For example, in this version you cannot

configure Generic DB (SQL) Protocol credentials with an empty port number.

Select this option to open the previous Edit Protocol Parameter dialog box and

delete the port number.

l Copy/Move to another domain. Enables you to copy/move the selected protocol
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UI Element

(A–Z) Description

credential to another domain in the Domains and Probes tree.

l Check credential. Opens the Check Credential dialog box, where you specify the

host name or IP address (in IPv4/IPv6 format) of the remote machine on which the

protocol must run, and specify a connection timeout (in milliseconds).

o If you enter an IP address, the system populates the Data Flow Probe field with

the Probe whose ranges include the IP address. If the system cannot find a Probe

associated with the IP address, you must select a Probe manually from the Data

Flow Probe drop-down list.

o If you enter a host name, you must select a Probe in the Data Flow Probe drop-

down list. The Probe tries to resolve the name to a valid IP address using the DNS

server specified on the Probe.

The selected Probe attempts to connect to the remote machine within the specified

timeout and returns an answer as to whether the connection succeeded or not. If

the connection is not successful, click Details for a description of the error.

l Export public certificates. Opens the Export dialog box, enabling you to export the

UD Agent certificate when deploying the UD Agent manually. For details, see "How to

Install the Universal Discovery Agent Manually" on page 160.

Available for: Universal Discovery Protocol only.

<right-

click a

column

heading>

Choose from the following options:

l Hide Column. Displayed when a column is shown.

l Show All Columns. Displayed when a column is hidden.

l Select Columns. Select to choose which columns to display or to change the display

order of the columns.

l Auto-resize Column. Select to change the column width to fit the contents.

Protocol Parameter Dialog Box

Displays the attributes that can be defined for a protocol.
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To

access

Select Data Flow Probe Setup > Domains and Probes pane > Domains and Probes root

node > a domain > Credentials > a protocol.

In the right-hand pane:

l To add new connection detail, click the Add new connection details button.

l To edit an existing credential, click the Edit connection details button.

See

also

l "Data Flow Probe Setup Window" on page 89

l "<Protocol> Details Pane" on page 98

l Supported Protocols in the HP UCMDB Discovery and Integrations Content Guide.

User interface elements are described below:

UI Element

(A–Z) Description

General l Network Scope. Opens the Scope Definition dialog box enabling you to define the

network scope for the credential.

o Selected Probes. Clicking the Edit button opens the Select Probes dialog box,

where you select specific Probes/probe clusters whose IP range must be

changed.

o Selected Ranges.

l All. Discovery runs on all ranges in the domain (default).

l Selected Range. Enables you to selects a specific range on which to run

discovery. You can also define ranges to exclude from the range. For more

details, see "Ranges Pane" below.

l User Label. The display name for the credential.

<Protocol

attributes>

Enables you to define/edit the protocol attributes for the credential. The fields

displayed are based on the protocol selected.

For details about the protocol attributes, see the section about the supported protocols

in the HP UCMDB Discovery and Integrations Content Guide.
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Ranges Pane

Enables you to define network IP addresses on which a Probe/probe cluster must discover CIs.

Important

Information

l This pane is disabled when the selected Probe is contained within a probe cluster

because the Probe's range is dynamically determined by the load balancing

mechanism of the probe cluster.

l For details on searching for a specific range, see the Find Probe Range by IP

button in "Data Flow Probe Setup Window" on page 89.

User interface elements are described below:

UI

Element

(A–Z) Description

New IP Range. Opens the New IP Range dialog box, enabling you to define a new IP range

for the selected Probe/probe cluster. For details, see "New/Edit Range Dialog Box" on page

120.

Delete IP Range. Select an IP range and click the button to delete a range from the list.

Note: You can also delete an excluded IP range.

Edit IP Range. Opens the Edit IP Range dialog box, enabling you to edit the selected IP

range for the selected Probe/probe cluster. For details, see "New/Edit Range Dialog Box"

on page 120.

Note: You can also edit an excluded IP range.

Export Data To File. Enables you to export the defined ranges in the following formats:

l Excel. The table data is formatted as an .xls (Excel) file that can be displayed in a

spreadsheet.

l PDF. The table data is exported in PDF format.

l RTF. The table data is exported in Rich Text Format.

l CSV. The table data is formatted as a comma-separated values (CSV) text file that can
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UI

Element

(A–Z) Description

be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the comma (,) must

be defined as the list separator in your Windows Control Panel. In Linux, you can

specify the list separator in the application that opens the CSV file.

l XML. The table data is formatted as an XML file that can be opened in a text or XML

editor.

Tip: To extract HTML code from the report:

l Save the file as HTML

l Open the file in an HTML editor

l Copy the relevant table into the target file

Note: Ranges in CIDR notation can also be exported.

Import Ranges from CSV File. Opens the Import Ranges from File dialog box, enabling you

to select a CSV file from which to import a set of ranges.

Before importing ranges, verify that:

l The imported file is a valid CSV file

The CSV file must be built using the following names for the column headings:

o Range. The range to import. This can be an IP range (IPv4 only) or in CIDR notation

(IPv4/IPv6).

o Excluded Ranges. The IP ranges to exclude from the imported range.

Note: The excluded range must be defined in the same format (IPv4/IPv6) as

the full range.
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UI

Element

(A–Z) Description

Important: See example below:

l When defining an excluded IP range, always include the full range in the Ranges

column as well.

l When a range is defined in CIDR notation, the excluded ranges must be defined

in the IP range format (<start_ip_address> – <end_ip_address>)

o Description. A description of the range

o Type. The range type: 1 = Client; 0 = Data Center

Example

Expand All. Expands the entire hierarchical tree structure to display all of the defined

IP ranges, including the excluded IP ranges.

Collapse All. Collapses the hierarchical tree structure, leaving the top-level IP ranges

showing, but hiding excluded IP ranges.

Show/Hide Legend. Shows/Hides the legend for the Ranges pane.

l . Denotes the range of IP addresses included for the selected Probe/probe cluster.

l . Denotes a range of IP addresses to exclude from the defined IP range.

<Ranges

grid>

The network range where the Probe/probe cluster discovers CIs. For details, see "New/Edit

Range Dialog Box" on page 120.
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Cluster Details Pane

Enables you to view the details of the probe cluster selected in the Domains and Probes tree.

To

access

Select Data Flow Probe Setup > Domains and Probes pane > Domains and Probes root

node > a domain > Data Flow Probes > a cluster.

Relevant

task

l "How to Add Probe Clusters to UCMDB" on page 41

l "How to Limit IP Movement in a Cluster" on page 49

See also l "Data Flow Probes and Probe Clusters" on page 30

l "Cluster Range Distribution Policy" on page 31

l "Limiting IP Movement in a Cluster" on page 34

User interface elements are described below:

UI Element Description

Cluster

Description

pane

The description of the selected cluster.

Associated

Probes

pane

Enables you to manage Data Flow Probes associated with the cluster.

l Add Probe to Cluster . Enables you to add Data Flow Probes to the cluster.

l Remove Probe from Cluster . Removes the selected Data Flow Probe from the

cluster.

Note:

o A Probe that is removed from a cluster has no network range. To define a

range for the Probe, see "New/Edit Range Dialog Box" on page 120.

o If you add a Probe to a cluster and remove the Probe before saving the

cluster then:

l if changes were made to the Probe's range after adding the Probe, the

range remains with the cluster
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UI Element Description

l if no changes were made to the Probe's range after adding the Probe,

the range remains with the Probe

l View Constraint . Opens the Trigger Query Editor dialog box and displays the

defined TQL constraints for the selected Probe.

l Set TQL Constraint. Opens the Choose Discovery Query dialog box, enabling you

select a constraint query for the Probe. When the cluster distributes its network

range among its Probes, it takes into account the constraints defined on the

Probes.

Ranges Pane

Enables you to define network ranges over which the Data Flow Probes in the cluster should perform

discovery.

Important

Information

l For details on searching for a specific range, see the Find Probe Range by IP

button in "Data Flow Probe Setup Window" on page 89.

l When a specific Probe in a cluster is selected, its range is displayed but is not

editable.

User interface elements are described below:

UI

Element Description

New Range. Opens the New Range dialog box, enabling you to define a new network range

for the selected probe cluster. For details, see "New/Edit Range Dialog Box" on page 120.

Delete Range. Enables you to delete the selected range.

Note: You can also delete an excluded IP range.

Edit Range. Opens the Edit Range dialog box, enabling you to edit the selected range for

the probe cluster. For details, see "New/Edit Range Dialog Box" on page 120.
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UI

Element Description

Note: You can also edit an excluded IP range.

Export Data To File. Enables you to export the defined ranges in the following formats:

l Excel. The table data is formatted as an .xls (Excel) file that can be displayed in a

spreadsheet.

l PDF. The table data is exported in PDF format.

l RTF. The table data is exported in Rich Text Format.

l CSV. The table data is formatted as a comma-separated values (CSV) text file that can

be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the comma (,) must

be defined as the list separator. In Windows, to verify or modify the list separator

value, open Regional Options from the Control Panel, and on the Numbers tab

ensure that the comma is defined as the List Separator value. In Linux, you can

specify the list separator in the application that opens the CSV file.

l XML. The table data is formatted as an XML file that can be opened in a text or XML

editor.

Tip: To extract HTML code from the report:

o Save the file as HTML

o Open the file in an HTML editor

o Copy the relevant table into the target file

Note: Ranges in CIDR notation can also be exported.

Import Ranges from CSV File. Opens the Import Ranges from File dialog box, enabling you

to select a CSV file from which to import a set of ranges.
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UI

Element Description

Before importing ranges, verify that:

l The imported file is a valid CSV file

The CSV file must be built using the following names for the column headings:

o Range. The range to import. This can be an IP range (IPv4 only) or in CIDR notation

(IPv4/IPv6).

o Excluded Ranges. The IP ranges to exclude from the imported range.

Note: The excluded range must be defined in the same format (IPv4/IPv6) as

the full range.

Important: See example below:

l When defining an excluded IP range, always include the full range in the Ranges

column as well.

l When a range is defined in CIDR notation, the excluded ranges must be defined

in the IP range format (<start_ip_address> – <end_ip_address>)

o Description. A description of the range

o Type. The range type: 1 = Client; 0 = Data Center

Example

Expand All. Expands the entire hierarchical tree structure to display all of the defined
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UI

Element Description

IP ranges, including the excluded IP ranges.

Collapse All. Collapses the hierarchical tree structure, leaving the top-level IP ranges

showing, but hiding excluded IP ranges.

Show/Hide Legend. Shows/Hides the legend for the Ranges pane.

l . Denotes the range of IP addresses included for the selected Probe.

l . Denotes a range of IP addresses to exclude from the defined IP range.

<Ranges

grid>

Lists the network ranges where the Data Flow Probes in the cluster perform discovery. For

details, see "New/Edit Range Dialog Box" on page 120.

Data Flow Probe Details Pane

To

access

Select Data Flow Probe Setup > Domains and Probes pane > Domains and Probes root

node > a domain > Data Flow Probes > a Data Flow Probe.

Relevant

tasks

"How to Add Data Flow Probes to UCMDB" on page 40

See also "Data Flow Probe Status" on page 132

Probe Details Pane

Displays the details of the selected Data Flow Probe.

User interface elements are described below:

UI Element

(A–Z) Description

Default

Tenant

Displays the default tenant for the Data Flow Probe.

Note: When working in multi-tenancy mode, the best practice is for all Data Flow

Probes in a probe cluster to have the same default tenant defined for them. If
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UI Element

(A–Z) Description

Data Flow Probes have different default tenants and a re-distribution of the

ranges occurs, the tenant of the already discovered CIs is not changed.

Available: In multi-tenancy environments only.

Last time

probe

accessed

UCMDB

The last time that the Probe accessed the server machine.

Probe

Description

The description given to the Probe when it was added to UCMDB.

Note: This field is editable.

Probe IPs The IPs of the Probe machine.

Note: If the Probe machine has more than one network card, all the IP addresses

are displayed.

Status The status of the selected Probe:

l Connected. The Probe has successfully connected to the server. (The Probe

connects every few seconds.)

l Disconnected (being restarted). The Probe gateway service is restarting. This may

be because, for example, the Probe has downloaded a Content Pack Update, or

detected a job that is stuck.

l Disconnected (stopped). The Probe gateway service is stopped by the server

administrator.

l Disconnected (reason unknown). The Probe gateway service is stopped for some

other reason.

Note: When the Probe is suspended, (suspended) is also displayed together with

the status.
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UI Element

(A–Z) Description

Version The version of the Probe.

Note: If the version of the Probe is not compatible with the version of the UCMDB

server, this is indicated. Moreover, if the incompatible Probe tries to connect to the

UCMDB server, the server sends a shutdown instruction to the Probe. To ensure

compatibility:

l If the Probe version is correct but the CUP version is not aligned with the

UCMDB Server CUP version, see "How to Align the Data Flow Probe CUP with the

UCMDB Server CUP" on page 63.

l If the Probe is an old version, you need to uninstall the Probe, and reinstall the

correct version. For details, see the interactive HP Universal CMDB Deployment

Guide.

Ranges Pane

Enables you to define network IP addresses on which a Probe must discover CIs.

Important

Information

l This pane is read-only when the Probe is associated with a probe cluster because

the Probe's range is dynamically determined by the load balancing mechanism of

the probe cluster.

l For details on searching for a specific range, see the Find Probe Range by IP

button in "Data Flow Probe Setup Window" on page 89.

User interface elements are described below:

UI

Element

(A–Z) Description

New IP Range. Opens the New IP Range dialog box, enabling you to define a new IP range

for the selected Probe. For details, see "New/Edit Range Dialog Box" on page 120.

Delete IP Range. Select an IP range and click the button to delete a range from the list.
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UI

Element

(A–Z) Description

Note: You can also delete an excluded IP range.

Edit IP Range. Opens the Edit IP Range dialog box, enabling you to edit the selected IP

range for the selected Probe. For details, see "New/Edit Range Dialog Box" on page 120.

Note: You can also edit an excluded IP range.

Export Data To File. Enables you to export the defined ranges in the following formats:

l Excel. The table data is formatted as an .xls (Excel) file that can be displayed in a

spreadsheet.

l PDF. The table data is exported in PDF format.

l RTF. The table data is exported in Rich Text Format.

l CSV. The table data is formatted as a comma-separated values (CSV) text file that can

be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the comma (,) must

be defined as the list separator. In Windows, to verify or modify the list separator

value, open Regional Options from the Control Panel, and on the Numbers tab

ensure that the comma is defined as the List Separator value. In Linux, you can

specify the list separator in the application that opens the CSV file.

l XML. The table data is formatted as an XML file that can be opened in a text or XML

editor.

Tip: To extract HTML code from the report:

l Save the file as HTML

l Open the file in an HTML editor

l Copy the relevant table into the target file
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UI

Element

(A–Z) Description

Note: Ranges in CIDR notation can also be exported.

Import Ranges from CSV File. Opens the Import Ranges from File dialog box, enabling you

to select a CSV file from which to import a set of ranges.

Before importing ranges, verify that:

l The imported file is a valid CSV file

The CSV file must be built using the following names for the column headings:

o Range. The range to import. This can be an IP range (IPv4 only) or in CIDR notation

(IPv4/IPv6).

o Excluded Ranges. The IP ranges to exclude from the imported range.

Note: The excluded range must be defined in the same format (IPv4/IPv6) as

the full range.

Important: See example below:

l When defining an excluded IP range, always include the full range in the Ranges

column as well.

l When a range is defined in CIDR notation, the excluded ranges must be defined

in the IP range format (<start_ip_address> – <end_ip_address>)

o Description. A description of the range

o Type. The range type: 1 = Client; 0 = Data Center

Example
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UI

Element

(A–Z) Description

Expand All. Expands the entire hierarchical tree structure to display all of the defined

IP ranges, including the excluded IP ranges.

Collapse All. Collapses the hierarchical tree structure, leaving the top-level IP ranges

showing, but hiding excluded IP ranges.

Show/Hide Legend. Shows/Hides the legend for the Ranges pane.

l . Denotes the range of IP addresses included for the selected Probe.

l . Denotes a range of IP addresses to exclude from the defined IP range.

<Ranges

grid>

The network range where the Probe discovers CIs. For details, see "New/Edit Range Dialog

Box" on page 120.

Passive Discovery Probes Pane

This pane enables you to globally configure notification types for all passive discovery probes that

integrate with the Data Flow Probes of the same domain. The passive discovery probes notify UCMDB of

changes in traffic, such as an unseen IP address or software not running.

To access Select Data Flow Management > Data Flow Probe Setup > Domains and Probes

pane > a domain > Passive Discovery Probes.

Important

information

The definitions defined here are valid for all of the passive discovery probes that

integrate with the Data Flow Probes of the same domain.

Relevant "How to Configure Just-In-Time Discovery" on page 661
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task

See also l "Just-In-Time Discovery Overview" on page 661

l "Data Flow Probe Setup Window" on page 89

l "Passive Discovery Probe Details Pane" on page 117

Notification Types Pane

Note: By default all types of notifications are enabled.

User interface elements are described below :

UI Element Description

Report IP

notifications

l Reports new IP addresses seen on the network.

l Reports unseen IP addresses.

o Select the amount of time that the passive probe should wait before

triggering a notification that the IP address was not seen.

o After this notification is sent, the Data Flow Probe performs a

verification. Select an action that should be taken upon verification:

l set the IP address as a candidate for deletion

l remove the IP address from UCMDB

Report running

software

notifications

l Reports new running software seen on the network

l Reports unseen running software.

o Select the amount of time that the passive probe should wait before

triggering a notification that the software is not running.

o After this notification is sent, the Data Flow Probe performs a

verification. Select an action that should be taken upon verification:

l set the RunningSoftware CI as a candidate for deletion
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UI Element Description

l remove the RunningSoftware CI from UCMDB

Report dependency

link notifications

Enables notification of dependency relationships.

Removal Verification Policy Pane

User interface elements are described below:

UI Element Description

Verify ports by

scanning

Enables verification of listening ports by scanning.

Ping configuration for

verification process

Enables you to specify the number and frequency of pings to verify unseen

IP addresses before removal, as well as the overall number of

simultaneous pings allowed.

Passive Probes Pane

Lists the passive discovery probes that are connected to Data Flow Probes.

User interface elements are described below:

UI Element (A - Z) Description

Data Flow Probe The name of the Data Flow Probe to which the passive discovery probe

reports.

IP Address The IP address of the passive discovery probe (RUM Engine) machine.

Last access time The date and time the passive discovery probe was last accessed.

Name The name given to the passive discovery probe (RUM Engine) when it was

defined in HP RUM.

Status Indicates the status of the passive discovery probe:

l Connected. The passive discovery probe is connected and available to

report information to the Data Flow Probe.
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UI Element (A - Z) Description

l Suspended. The passive discovery probe is connected but not available

to report information to the Data Flow Probe.

l Disconnected. The passive discovery probe is not connected.

Version The HP RUM version.

Passive Discovery Probe Details Pane

This pane enables you to configure the passive discovery probes (HP RUM Engines) to monitor the IP

address ranges and ports that you specify.

To access Select Data Flow Management > Data Flow Probe Setup > Domains and

Probes pane > a domain > Passive Discovery Probes > a passive probe.

Important

information

The passive discovery probes can be configured to monitor the IP address

ranges in the domain of the Data Flow Probe only.

Relevant task "How to Configure Just-In-Time Discovery" on page 661

See also l "Just-In-Time Discovery Overview" on page 661

l "Passive Discovery Probes Pane" on page 114

l "Data Flow Probe Setup Window" on page 89

Passive Discovery Probe Details Pane

User interface elements are described below :

UI Element Description

Name The name given to the passive discovery probe (RUM Engine) when it was defined in HP

RUM.

Data Flow

Probe

The name of the Data Flow Probe to which the passive discovery probe reports.

IP The IP address of the passive discovery probe (RUM Engine) machine.
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UI Element Description

Version The HP RUM version.

Status Indicates the status of the passive discovery probe:

l Connected. The passive discovery probe is connected and available to report

information to the Data Flow Probe.

l Suspended. The passive discovery probe is connected but unavailable to report

information to the Data Flow Probe.

l Disconnected. The passive discovery probe is not connected.

Last access

time

The date and time the passive discovery probe was last accessed.

Passive Discovery Ranges Pane

This pane lists the RUM Probes that report to the RUM Engine. This information is obtained from the

RUM Server.

User interface elements are described below :

UI Element Description

Passive

Discovery

Agent Name

The name of the RUM Probe.

Range The IP address range defined for the RUM Probe. Information from within this

range is reported to the RUM Engine (passive discovery probe).

Note: The range can be displayed here either according to the IP range format

or the CIDR notation, as explained in "New/Edit Range Dialog Box" on page 120.

Ports The ports defined for the RUM Probe over which information is reported.

Passive Discovery Integrated Ranges Pane

User interface elements are described below :
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UI Element Description

Use All Ranges Of Data

Flow Probe <Data Flow

Probe name>

Enables passive discovery over all address ranges of the connected

Data Flow Probe, over selected ports:

l All available ports. Enables passive discovery over all available

ports.

l Selected ports Enables passive discovery over ports that you

select from the Global Ports List. Click to select ports to

monitor.

Use Selected Ranges Of

Data Flow Probe <Data

Flow Probe name>

Enables passive discovery over the Ranges Definition area where you

can select existing Data Flow Probe ranges over which to perform

passive discovery. See below.

Note:

l Ranges must be a subset of both the connected Data Flow

Probe’s ranges and Passive Discovery ranges.

l Ranges can be displayed here either according to the IP range

format or the CIDR format, as explained in "New/Edit Range

Dialog Box" on the next page.

Ranges Definition Area

User interface elements are described below :

UI

Element

(A–Z) Description

New Range. Enables you to define a new range for the passive discovery probe to

monitor.

Note: This range must be a subset of one of the Data Flow Probe's ranges.

For details about defining Probe ranges, see "New/Edit Range Dialog Box" on the next

page.
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UI

Element

(A–Z) Description

Delete Range. Enables you to remove a range defined for passive discovery.

Select Range Enables you to select defined ranges for the passive discovery probe to

monitor from the ranges defined for the connected Data Flow Probe.

Edit Range. Enables you to modify a selected range.

For example, you can select one of the Data Flow Probes ranges, and then exclude some IP

addresses from that range for passive discovery.

Export Data To File.

Note: Not enabled for passive discovery probes.

Import Ranges from CSV File.

Note: Not enabled for passive discovery probes.

Expand All. Expands the hierarchical tree structure to display all of the defined ranges,

including the excluded IP ranges.

Collapse All. Collapses the hierarchical tree structure, hiding excluded IP ranges.

Show/Hide Legend. Shows/Hides the legend for the Ranges pane.

l . Denotes a range included for the selected passive discovery probe.

l . Denotes an IP range to exclude from the parent range.

<Ranges

grid>

Lists the ranges and ports selected for the passive discovery probe to monitor.

New/Edit Range Dialog Box

Enables you to set network ranges for Data Flow Probes, a probe clusters, or passive discovery probes.

The results are retrieved from the addresses in the range you define. You can also define IP addresses

that must be excluded from a range.
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To access Select Data Flow Management > Data Flow Probe Setup > Domains and Probes >

<Domain>.

l Data Flow Probes/Clusters: Select Data Flow Probes > a probe/cluster, and in the

Ranges pane click the New Range or Edit Range button.

l Passive discovery probes: Select Passive Discovery Probes > a passive probe, and

in the Passive Discovery Integrated Ranges pane click the New Range or Edit

Range button.

Important

information

l An IP address can belong to only one probe or probe cluster's range in the same

domain. That is, two Probes in the same domain cannot have the same IP address

in their ranges.

l For a passive discovery probe, the range must fall within the range of the Data Flow

Probe it is reporting to.

l If you define a range that is out of the scope of the network on which the

probe/cluster is installed, a warning message informs you that the probe is not

included in the range.

o Click Yes to save the current range without including the probe in the range.

o Click No to continue editing without saving the current range.

Relevant

tasks

l "How to Add Data Flow Probes to UCMDB" on page 40

l "How to Run Module/Job-based Discovery" on page 463

l "How to Configure Just-In-Time Discovery" on page 661

l "How to Configure Probe IP Ranges with Active Directory" on page 329

User interface elements are described below:

UI Element Description

IPv4/6 Enables you to define the IP range in IPv4 or IPv6 format.

Definition

Type

l IP Range. (IPv4 format only) Enables you to define an IP address range for the

probe/cluster. You define a start IP address and an end IP address.

l CIDR. Enables you to define an address range using the CIDR (Classless Inter-
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UI Element Description

Domain Routing) notation, where each IP address has a network prefix that

identifies either an aggregation of network gateways or an individual gateway. The

length of the network prefix is also specified as part of the IP address and varies

depending on the number of bits that are needed.

Available: When creating a new range only

Range Enables you to select a range over which the probe or cluster should perform discovery.

IPv4

l IP Range. Define a range of IPv4 addresses using the following rules:

o The IP address range must have the following format:

start_ip_address – end_ip_address

For example: 10.0.64.0 - 10.0.64.57

o The first decimal value (octet) of the start IP address and the end IP address

must be identical.

For example, 10.1.2.3 - 10.4.5.6

o The range can include an asterisk (*), representing any number in the range of 0-

255.

l If you use an asterisk, you do not need to enter a second IP address. For

example, you can enter the range pattern 10.0.48.* to cover the range from

10.0.48.0 to 10.0.48.255.

l Use an asterisk in the lower bound IP address of the IP range pattern only. If

you use an asterisk in the lower bound IP address and also enter an upper

bound IP address, the upper bound IP address is ignored.

l You can use more than one asterisk (*) in an IP address as long as they are

used consecutively. The asterisks cannot be situated between two numbers

in the IP address, nor can they be substituted for the first digit in the

number.

For example, you can enter 10.0.*.* but not 10.*.64.*.

l CIDR Notation. Define a range using the CIDR notation as follows:
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UI Element Description

a. Enter the IP address in IPv4 format.

b. In the drop-down, choose the number of bits (1-32) to determine the network

prefix.

For example, if you enter 192.30.250.00/18, then 192.30.250.00 is the network

address and 18 indicates that the first 18 bits are the network part of the

address, leaving the last 14 bits for specific host addresses.

IPv6

IPv6 ranges are defined in CIDR notation only:

1. Enter the IP address in IPv6 format. You can define IPv6 ranges using the full or

compressed IPv6 notation

Example:

o Full IPv6 addresses: abcd:abcd:abcd:abcd:abcd:abcd:abcd:abcd

o Compressed IPv6 address:

l A:B:C:D:1:2:3:4 is the compressed version of

000A:000B:000C:000D:0001:0002:0003:0004

l abcd::abcd is the compressed version of

abcd:0000:0000:0000:0000:0000:0000:abcd

l ::abcd is the compressed version of

0000:0000:0000:0000:0000:0000:0000:abcd

2. In the drop-down, choose the number of bits (1-128) to determine the network

prefix.

For example, if you enter abcd:abcd:abcd:abcd:abcd:abcd:abcd:abcd/100, then

abcd:abcd:abcd:abcd:abcd:abcd:abcd:abcd is the network address and 100

indicates that the first 100 bits are the network part of the address, leaving the

last 28 bits for specific host addresses.

Note: IPv6 ranges cannot include IPv4-mapped IPv6 addresses (0.0.0.0 -

255.255.255.255). If your IPv6 range includes IPv4-mapped IPv6 addresses, these
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UI Element Description

addresses must be defined separately in IPv4 ranges.

For example,the IPv6 range, 0:0:0:0:0:fffe:0:0/60, must be defined as a number of

ranges as follows:

l IPv6 range: 0:0:0:0:0:0:0:0 – 0:0:0:0:0:fffe:ffff:ffff

l IPv4-mapped IPv6 range, 0:0:0:0:0:ffff:0:0 - 0:0:0:0:0:ffff:ffff:ffff, must be

defined in IPv4 format: 0.0.0.0 - 255.255.255.255, per network class

l IPv6 range: 0:0:0:1:0:0:0:0 – 0:0:0:f:ffff:ffff:ffff:ffff

Type Defines the IP address lease time setting for the range.

Available when: Defining a range for a Data Flow Probe or a probe cluster.

Note: It is important to select the appropriate IP Address type to ensure that

discovery is performed as expected. For more information, see "Effects of Range

Type on Discovery Workflows" on page 37.

l Data Center. For permanent or long IP address lease times. This type is suitable for

environments that have the following characteristics:

o IP addresses are stable due to long lease times or due to the consistent

availability characteristics of the nodes and network

o Nodes connect to the network using the same interfaces due to a single access

technology

o Few or no mobile users

o Single domain environment

l Client. For short IP address lease times. This type is suitable for environments that

have the following characteristics:

o IP addresses are not stable due to short lease times or due to the inconsistent

availability characteristics of the nodes and network.

o Nodes connect to the network using different interfaces due to multiple access

technologies. Therefore, the same IP address is bound to different interfaces at
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UI Element Description

different times.

o Mobile users access the network from different domains in a multi-domain

environment.

Note: Enable SNMP on all networking devices.

Description

(Optional)

A description about the selected range.

Note:

l Maximum number of characters allowed: 150

l No new lines or tabs may be inserted

Excluded

IP Ranges

Enables you to define a range of IP addresses to exclude from the full network range

specified above.

Note:

l The rules for entering an excluded range are the same as for entering a range.

For details, see Range (on page 122).

l The excluded range must be defined in the same format (IPv4/IPv6) as the full

network range.

l Even when a network range is defined using CIDR notation, the excluded ranges

can still only be defined in <start_ip_address> – <end_ip_address> format.

New Excluded IP Range . Enables you to define a range of IP addresses to exclude

from the full range, and enter a description about the excluded range if desired.

Delete Excluded IP Range . Deletes an excluded IP range.

Edit Excluded IP Range . Enables you to edit a defined excluded IP range.

Example:

You can divide a network range into several sub-ranges.

For example, if the range is 10.0.64.0 – 10.0.64.255
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UI Element Description

and you define three excluded ranges:

l 10.0.64.45 – 10.0.64.50

l 10.0.64.65 – 10.0.64.70

l 10.0.64.89 – 10.0.64.95

the Universal Discovery is performed over:

l 10.0.64.0 – 10.0.64.44

l 10.0.64.51 – 10.0.64.64

l 10.0.64.71 – 10.0.64.88

l 10.0.64.96 – 10.0.64.255

Ports Enables you to define ports over which passive discovery should be performed within

the defined range:

l All available ports. Enables passive discovery over all available ports.

l Selected ports Enables passive discovery over ports that you select from the Global

Ports List. Click to select ports to monitor.

Available: When defining a network range for a passive discovery probe only.
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Troubleshooting and Limitations – Data Flow Probe Setup

Troubleshooting

Problem: You cannot transfer a Data Flow Probe from one domain to another.

Reason: Once you have defined the domain of a Probe, you can change its ranges, but not the domain.

Solution: Install the Probe again:

1. (Optional) If you are going to use the same ranges for the Probe in the new domain, export the

ranges before removing the Probe. For details, see "Ranges Pane" on page 111.

2. Remove the existing Probe from UCMDB. For details, see the Remove Domain or Probe button in

"Data Flow Probe Setup Window" on page 89.

3. Install the Probe. For details, see the section about installing the Data Flow Probe in the interactive

HP Universal CMDB Deployment Guide.

4. During installation, make sure to give the new Probe a different name to the name given to the old

Probe, or make sure you delete the reference to Probe from the original domain.

Problem: Discovery shows a disconnected status for a Probe.

Solution: Check the following on the Probe machine:

l That the Probe is running

l That there are no network problems

Solution: The probe status is Disconnected or Disconnected (being restarted).

l Search for restart messages in the wrapperProbeGW logs.

l If the probe does not restart, try to take probe thread dump from the disconnected time and search

for the ProbeGW Tasks Downloader thread.

l If there is no probe thread dump, investigate the problematic timeframe in the wrapperProbeGw

log. In particular:
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o Check if the probe tasks confirmer has been running for more than 5 minutes.

o Check if some of the resources are being downloaded for more than 5 minutes.

Problem: The connection between the HP Universal CMDB server and the Probe fails

due to an HTTP exception.

Solution: Ensure that none of the Probe ports are in use by another process.

Problem: A Data Flow Probe node name cannot be resolved to its IP address. If this

happens, the host cannot be discovered, and the Probe does not function correctly.

Solution: Add the host machine name to the Windows HOSTS file on the Data Flow Probe machine.

Problem: After uninstalling the Data Flow Probe, mysqld.exe and associated files

are not deleted.

Solution: To delete all files, restart the machine on which the Data Flow Probe was installed.

Problem: After the UCMDB Server CUP is updated, the Probe fails to start or fails to

connect to server

Solution: The Probe's CUP version must be the same as UCMDB Server's CUP version. If the CUP versions

are not aligned, you must update the Probe's CUP version. To do this, see "How to Deploy a Data Flow

Probe CUP" on page 60.

In some cases, the CUP may need to be deployed manually on a Probe. For details, see "How to Deploy

Data Flow Probe CUP Manually" on page 62.

Problem: I want to check if my integration probe is connected, but I can't see it

listed in the Data Flow Probe Setup module tree.

Reason: The Data Flow Probe Setup module displays only Data Flow Probes for discovery. Integration

Probes—that is, Probes on Linux machines, and Windows Probes configured for integration only— are

not displayed in the Data Flow Probe Setup module.

Workaround: To see if an integration Probe is connected, create a dummy integration point and verify

that the Probe is listed among the Probes that can be selected for the integration point (in the Data

Flow Probe field). For details, see "How to Set Up an Integration Point" on page 319.

Data Flow Management Guide

Chapter 2: Data Flow Probe Setup

HP Universal CMDB (10.22) Page 128 of 795



Problem: Troubleshooting PostgreSQL Issues

Solution:

The table below lists the Data Flow Probe database scripts. These scripts can be modified for

administration purposes, both in Windows and Linux environments.

Note:

l The scripts are located on the Data Flow Probe machine, in the following location:

o Windows: C:\hp\UCMDB\DataFlowProbe\tools\dbscripts

o Linux: /opt/hp/UCMDB/DataFlowProbe/tools/dbscripts

l Data Flow Probe database scripts should be changed for specific administration purposes only.

Script Description

exportPostgresql [PostgreSQL root account

password]

Exports all data from the DataFlowProbe

database schema to data_flow_probe_

export.bin in the current directory

importPostgresql [Export file name] [PostgreSQL

root account password

Imports data from a file created by the

exportPostgresql script into the DataFlowProbe

schema

enable_remote_user_access Configures the PostgreSQL Data Flow Probe

account to be accessible from remote machines

remove_remote_user_access Configures the PostgreSQL Data Flow Probe

account to be accessible only from the local

machine (default)

set_db_user_password [new PostgreSQL Data

Flow Probe account password] [PostgreSQL root

account password]

Modifies the PostgreSQL Data Flow Probe account

password

set_root_password [new PostgreSQL root

account password] [Current PostgreSQL root

account password]

Modifies the PostgreSQL root account password
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Problem: The Data Flow Probe database service cannot start.

l Reason: Hosts machine must not contain "localhost".

Solution: On the Data Flow Probe machine, open

o Windows: %systemroot%\system32\drivers\etc\hosts

o Linux: /etc/hosts

and ensure that all lines containing "localhost" are commented out.

l Reason: Microsoft Visual C++ 2010 x64 Redistributable is installed during the installation of the

Probe. If for some reason this redistributable is uninstalled, PostgreSQL stops working

Solution: Check if Microsoft Visual C++ 2010 x64 Redistributable is installed. If not, reinstall it.

Limitations

l

Note: The clearProbeData script resets the Data Flow Probe's DB schemas and file system

state. After running this script the Data Flow Probe re-sends all discovered data to UCMDB. This

could potentially create a significant load on the UCMDB Server.

If you reconfigure a Data Flow Probe to work with a different UCMDB server, you must first run the

clearProbeData.bat file before you restart the Probe. For details, see "How to Clear Data Flow Probe

Data" on page 58.

l When the Probe is running in separate mode on a machine where both the Gateways and the

Manager share same installation folder, the Data Flow Probe CUP must be installed manually. For

details, see "How to Deploy Data Flow Probe CUP Manually" on page 62.

l Data Flow Probe CUPs that were deployed manually can be uninstalled using manual methods only.

For details, see "How to Uninstall Probe CUPs Manually" on page 65.

l Universal Discovery Agent may not callhome in, but not limited to, the following scenario:

o The callhome IP address that is configured on the Universal Discovery Agent belongs to a client

type range that is added to a cluster.

Note: The Universal Discovery Agent supports 1 primary and 1 secondary probe.

Data Flow Management Guide

Chapter 2: Data Flow Probe Setup

HP Universal CMDB (10.22) Page 130 of 795



o The range is a member of a probe cluster.

o The cluster contains two or more probes.

In this scenario, callhome may not work as expected. Contact HP Support for assistance in

configuring callhome.
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Chapter 3: Data Flow Probe Status
This chapter includes:

How to View Job Information on the Data Flow Probe 132

Data Flow Probe Status User Interface 133

Discovery Job Operation Commands 139

Job Operation Parameters 147

How to View Job Information on the Data Flow Probe

This task describes how to view job information (for example, job threads and Trigger CIs) saved to the

Data Flow Probe's PostgreSQL database. You work with the JMX console.

This task includes the following steps:

1. Access the MBean operations

Use the following procedure to access the JMX console on the Data Flow Probe and to invoke the

JMX operations.

a. Launch the Web browser and enter the following address:

http://<machine name or IP address>.<domain_name>:1977/

where <machine name or IP address> is the machine on which the Data Flow Probe is

installed. You may have to log in with the user name and password.

b. Click the Local_<machine name or IP address> > type=JobsInformation link.

2. Locate the operation to invoke

On the MBean View page, select type=JobsInformation. Locate the required operation. For details,

see "Discovery Job Operation Commands" on page 139 and "Job Operation Parameters" on page

147.

3. Run the operation
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Click the Invoke button to run the operation. A message is displayed with the results of the

operation run.

Reload The number of seconds between automatic reloads of the JMX interface.

0: The interface is never reloaded.

Click the Reload button to manually reload the current page (if more operations

have been added or removed).

Unregister Do not touch (the view becomes inaccessible to the application that is running).

Data Flow Probe Status User Interface

This section includes:

<Job Name> Dialog Box 133

Data Flow Probe Status Window 134

<Job Name> Dialog Box

Enables you to view status and progress of a job that ran or is currently running on a Data Flow Probe.

To

access

Select Data Flow Management > Data Flow Probe Status > Progress pane > a job, and click

the View job progress button.

See

also

l "How to Add Data Flow Probes to UCMDB" on page 40

l "How to Start a Data Flow Probe" on page 42

l "How to Stop a Data Flow Probe" on page 43

l "How to Run Zone-based Discovery" on page 423

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

User interface elements are described below:
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UI

Element

(A–Z) Description

Job

Details

l Status. The status of the job:Scheduled, Running, Blocked, Removed.

l Last updated. The last time that the job was updated.

l Threads. The number of threads currently allocated to this job.

l Progress. The number of Trigger CIs in the job and the number of Trigger CIs that the

Probe has finished working on.

l Discovered CIs in sending queue. The number of CIs/relationships discovered by the

discovery job, and that are waiting to be sent to the UCMDB Server.

Schedule l Previous invocation. The last time that Universal Discovery ran the job.

l Next invocation. The next time that Universal Discovery is scheduled to run the job.

l Last duration. The length of time, in seconds, taken to run the job in the previous

invocation. This is calculated according to the start time of the first trigger until the

end time of the last trigger, even if triggers were added later on.

l Average duration. The average duration (in seconds) per trigger of the time it took

the Probe to run this job.

l Recurrence. The number of times the job ran via the scheduler (manual runs are not

counted).

Discovery

Results

For details, see "Data Flow Probe Status Window" below.

Data Flow Probe StatusWindow

Enables you to view the current status of discovered CIs and all active jobs running on the Probes.

To access Select Data Flow Management > Data Flow Probe Status.

Important

Information

l Depending on what you select in the Domains Browser pane, different

information is displayed in the viewing pane.

If you select:

Data Flow Management Guide

Chapter 3: Data Flow Probe Status

HP Universal CMDB (10.22) Page 134 of 795



o a domain, you can view details and discovery results for the domain.

o a Probe, you can view details on the Probe (such as the Probe IP), the

progress of a job and you can view discovery results.

l The view is not automatically updated. To refresh the status data, click the

button.

l If a Probe is configured in Separate mode, no results are shown in this window.

Relevant tasks l "How to View the Current Status of Discovered CIs" on page 667

l "How to Add Data Flow Probes to UCMDB" on page 40

l "How to Start a Data Flow Probe" on page 42

l "How to Stop a Data Flow Probe" on page 43

l "How to Run Zone-based Discovery" on page 423

l "How to Run Module/Job-based Discovery" on page 463

Domain Browser Pane

Displays the domains and Probes defined in the UCMDB system in a tree view.

Domain Details Pane

Displays the details of the domain selected in the Domains Browser pane.

User interface elements are described below:

UI

Element

(A–Z) Description

Domain

Type

l Customer. A private domain used for your site. You can define several domains and

each domain can include multiple Probes. Each Probe can include IP ranges but the

customer domain itself has no range definition.

l External. Internet/public domain. A domain that is defined with a range. The external

domain can contain only one Probe whose name equals the domain name. However,
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UI

Element

(A–Z) Description

you can define several external domains in your system.

For details on defining domains, see "Add New Domain Dialog Box" on page 88.

Data Flow Probe Details Pane

Displays the details of the Probe selected in the Domains Browser pane.

User interface elements are described below:

UI Element

(A–Z) Description

Refreshed the data so that the most current status of the discovered CIs and jobs on

the selected Probe is displayed.

Note: The maximum timeout for refreshing is set to 30,000 milliseconds by default.

To change this setting, change the Max time out for getting probe status setting

in the Infrastructure Settings Manager. For details, see "Infrastructure Settings

Manager Page" in the HP Universal CMDB Administration Guide.

Last

updated

The date and time at which the Get snapshot button was last pressed (that is, the date

and time of the data displayed in Data Flow Probe Status).

Probe IP The IP address which the Probe communicates with UCMDB.

Running

jobs

The number of jobs running on the Probe.

Scheduled

jobs

The number of jobs that are scheduled to run according to the settings in the Discovery

Scheduler. For details, see "Discovery Scheduler Dialog Box" on page 492.

Status The status of the Probe:

l Connected. The Probe is connected to the server (the Probe connects every few

seconds).

l Connected (suspended). The Probe is connected, but it is suspended such that no
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UI Element

(A–Z) Description

jobs can run on the Probe.

l Disconnected. The Probe is not connected to the server.

Threads The sum of all threads currently allocated to the running jobs.

Total

Discovered

CIs in

sending

queue

The total number of CIs/relationships discovered by all of the discovery jobs that ran on

the Probe, and that are waiting to be sent to the UCMDB Server.

Progress Pane

Displays the progress of the jobs on the selected Probe.

User interface elements are described below:

UI

Element

(A–Z) Description

View Job Progress. Opens the <Job Name> dialog box, enabling you to view the details of

the selected job. For details, see "<Job Name> Dialog Box" on page 133.

Available: When a job is selected in the Progress pane.

View Workflow Information. Opens the Workflow Information dialog box, enabling you to

view workflow information for a selected job that is dependent on a workflow adapter and

that is currently running. This dialog box shows the following information for the job:

Trigger CI, current step, workflow status, workflow start time, workflow end time, parking

status, current timeout period, and next invocation time.

If you double-click on a Trigger CI in the Workflow Information dialog box, a history of all

steps that have already been executed during the current execution of the selected job is

displayed.

Available when: A currently running job that is dependent on a workflow adapter is

selected in the Progress pane.
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UI

Element

(A–Z) Description

Job List List the following information about the jobs that ran or are scheduled to run on the Probe,

and their progress:

l Job. The name of the job scheduled to run on the Probe.

l Discovered CIs in Sending Queue. The number of CIs/relationships discovered by the

selected discovery job, and that are waiting to be sent to the UCMDB Server.

l Next invocation. The next time that the Probe is scheduled to run.

l Previous invocation. The last time that the Probe ran.

l Progress. The progress of the job as it is running.

Note: If a job has not started running, the Progress column displays Scheduled.

l Thread count. The number of threads currently allocated to the selected job.

l Triggered CIs. The number of CIs triggered by the job.

Discovery Results Pane

Enables you to view discovery results.

User interface elements are described below:

UI Element

(A–Z) Description

Refresh. Enables you to retrieve the latest data from the Probe.

Note: This data is not automatically updated.

Set Filter. Enables you to set the time range for which to display discovery results.

l All. Displays results for all job runs.
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UI Element

(A–Z) Description

l Last Hour/Day/Week/Month. Choose a period of time for which to display discovery

results.

l Custom Range. Opens the Change Timeframe dialog box customize the time range

for which to display discovery results. Do one of the following:

o In the From and To boxes, click the arrow to choose a date and time from the

calendar.

o Click Last Day to view the last 24 hours worth of results.

<Results

grid>

l CIT. The name of the discovered CIT.

l Created. The number of CIT instances created by the Probe

l Deleted. The number of CIT instances deleted by the Probe.

l Discovered CIs. The sum of all the CIs for all the invocations.

l Updated. The number of CIT instances that have been updated.

Filter Displays the selected filter.

Last

updated

The date and time that the results data was updated for a particular Probe.

Discovery Job Operation Commands

For details on viewing job information, see "How to View Job Information on the Data Flow Probe" on

page 132.

activateJob

Enter the name of a job and click the button to activate the job immediately. This operation returns a

message, for example, <job name> was triggered.

Note: The following message is displayed if the job has not been activated and there is no

information about the job in the Probe's database:
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Job '<job name>' does not exist in the Jobs Execution table (job was not activated!).

activateJobOnDestination

Enter the name of a job and a Trigger CI and click the button to activate the job immediately on a

specific Trigger CI. This operation returns a message, for example, The operation returned with the

value: Job <job name> was triggered on destination <CI name>.

Note: Both the JobID and triggerCI fields are mandatory.

start/stop

These operations start and stop the JobsInformation service. Do not use these operations; instead,

restart the Probe itself.

viewJobErrorsSummary

Enter the name of a job to return a list of error messages reported on this job, together with the error

severity, the last time that the error was reported, and the number of Trigger CIs that have the error.

For details on the job operation parameters, see "Job Operation Parameters" on page 147.

Click the entry in the Number of Trigger CIs column to view a list of one job's Trigger CIs with errors on

the viewJobTriggeredCIsWithErrorId page.

viewJobExecHistory

Enter the name of a job to retrieve a history of job invocations. A table is displayed showing the job

invocations (the last invocation is shown first).

For details on the job operation parameters, see "Job Operation Parameters" on page 147.

For each invocation the number of triggered CIs and the total running time is shown. The Execution

Details column shows at which times the job was executed. If the Probe shut down in the middle of a job

execution and then resumed running or if there were blackout periods during the job execution, several

running times are shown.

viewJobProblems

Enter the name of a job to retrieve a list of Trigger CIs that have problems for that job. Enter the name

of a Trigger CI to retrieve a list of problems for that trigger CI. If no values are entered, problems all the

jobs and triggers are displayed.
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For details on the job operation parameters, see "Job Operation Parameters" on page 147.

Column Description

Job ID Displayed if the jobID field is left empty.

The job name as it appears in Data Flow Management.

Click a job to go to its viewJobStatus page, to view its status and scheduling

information.

Trigger CI Displayed if the triggerID field is left empty.

The CMDB object ID of the trigger for a job.

ErrMsgCode The error message hash string (error hash ID).

ErrParams The error parameters.

Severity The severity of the error. For details on severity levels, see "Error Severity Levels" in

the HP Universal CMDB Developer Reference Guide.

viewJobResultCiInstances

Fill in one or more of the parameters to return a list of CIs that have been discovered by a job.

For details on the job operation parameters, see "Job Operation Parameters" on page 147.

The Object State Holder column displays the code for the CI or relationship defined in the CMDB. For

details on creating object state holders for common CITs, see modeling.py in "Jython Libraries and

Utilities" in the HP Universal CMDB Developer Reference Guide. For details on the

appilog.common.system.typesClass ObjectStateHolder method, see the ObjectStateHolder method in

the online API documentation.

viewJobResults

Fill in one or more of the parameters to return a list of CIs that have been discovered by a job.

For details on the job operation parameters, see "Job Operation Parameters" on page 147.

When Hide Touched CIs Info is set to True, the results page displays the following information:

Column Description

Job Name Displayed if the jobID field is left empty.
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Column Description

The job name as it appears in Data Flow Management.

Click a job to go to its viewJobStatus page, to view its status and scheduling

information.

CI Type Click to filter the list to show results for one CIT only.

Total CIs Click to go to the viewJobResultCiInstances page, to view a list of all CIs that have

been discovered by a job.

Triggered CIs Click to go to the viewJobTriggeredCIs page, to view a list of all Trigger CIs that have

been discovered by a job.

Last Discover

Time

The date and time that the job was invoked.

When Hide Touched CIs Info is set to False, the results page displays the following information:

Column Description

Job Name Displayed if the jobID field is left empty.

The job name as it appears in Data Flow Management.

Click a job to go to its viewJobStatus page, to view its status and scheduling

information.

CI Type Click to filter the list to show results for one CIT only.

Touched CIs Click to go to the viewJobResultCiInstances page, to view a list of those CIs

discovered by the job that are Touched CIs. For details, see "Job Operation

Parameters" on page 147.

Non Touched

CIs

Click to go to the viewJobResultCiInstances page, to view a list of those CIs

discovered by the job that are not Touched CIs.

Triggered CIs

for Touched

CIs

Click to go to the viewJobTriggeredCIs page, to view a list of those Trigger CIs

included in a job that are Touched CIs.

Triggered CIs

for Non

Touched CIs

Click to go to the viewJobTriggeredCIs page, to view a list of those Trigger CIs

included in the job that are not Touched CIs.

Data Flow Management Guide

Chapter 3: Data Flow Probe Status

HP Universal CMDB (10.22) Page 142 of 795



Column Description

Last Discover

Time

The date and time that the job was invoked.

You can further filter results in the results page by entering text filters in one of the fields, and clicking

the Search button.

viewJobsStatuses

Click the viewJobsStatuses button to return status and scheduling information for all jobs. You can

choose to filter the results. For details, see "Job Operation Parameters" on page 147.

Note: This page is saved under \DataFlowProbe\runtime\jobsStatuses once a day.

The results page displays the following information:

Column Description

No. The number of the job in the list.

Job Name The job name as it appears in Data Flow Management.

Click a job to go to its viewJobStatus page, to view its status and scheduling

information.

Status The severity of the job's status, as calculated by the Probe.

l Blocked. Not in use.

l Removed. The job is no longer active.

l Done/Total Triggers. The number of trigger CIs that the Probe finished running on,

against the total number of triggers for the job.

For example, (28/69) indicates that there is a total of 69 triggers for the job, while

the Probe has completed running on 28 of those triggers.

l Scheduled. The job is scheduled to run. For details on scheduling jobs, see

"Discovery Scheduler Dialog Box" on page 492.

A red background signifies that a thread has run longer than expected and may be

stuck. A green background signifies that the job is running as expected.
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Column Description

Triggered

CIs

The Trigger CIs that have been run by the job. Click to go to the viewJobTriggeredCIs

page.

Errors &

Warnings

The number of errors and warnings for a specific job. Click to go to the

viewJobErrorsSummary page, to view a list of error and warning messages reported on

this job.

Last

Invocation

The date and time that the job was last run.

Next

Invocation

The date and time that the job is next scheduled to run.

Last Total

run

duration

(seconds)

The length of time, in seconds, taken to run the job in the previous invocation. This is

calculated according to the start time of the first trigger until the end time of the last

trigger, even if triggers were added later on.

Avg run

duration

(seconds)

The average duration (in seconds) per trigger of the time it took the Probe to run this

job.

Recurrence The number of times that the job was invoked. Click to go to the viewJobExecHistory

page, to retrieve a history of job invocations.

Results The number of CITs that have been discovered by the job. Click to go to the

viewJobResults page to view the CITs.

Note: Displayed when hideResults parameter is set to False.

viewJobStatus

Enter the name of a job to return its status and scheduling information.

For details on the job operation parameters, see "Job Operation Parameters" on page 147.

The results page displays the following information:
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Column Description

Threading

info

The total number of worker threads created by the invocation, the free worker

threads, and the stuck worker threads.

Total work

time

The time that the Probe took to run this job.

Tasks

waiting for

execution

A list of jobs together with the number of Trigger CIs that are awaiting activation.

Max.

Threads
The number of threads that are serving this job.

Progress A summary of the current run, that is, since the specific run was activated.

For example, Progress: 2017 / 6851 destinations (29%) means that out of

6851 CIs, 2017 CIs have already run.

Working

Threads

information

l Thread Name. The thread that is now running this job. Click to go to the

viewJobThreadDump page. You use this page when a thread is running for a long

time, and you must verify that this is because the thread is working hard, and not

because there is a problem.

l Curr Dest. ID. The name of the node on which the job is running.

l Curr Dest. IP. The IP for which the job is discovering information.

l Work Time (Sec). The length of time that this thread is running.

l Communication Log. Click to go to the viewCommunicationLog page, to view an

XML file that logs the connection between the Probe and a remote machine. For

details, see the Create communication logs field in the "Execution Options Pane"

on page 253.

Discovery

Jobs

Information

table

l Status. The severity of the job's status, as calculated by the Probe. For details, see

"Status" on page 143.

l Triggered CIs. Click to go to viewJobTriggeredCIs page, to view a list of Trigger CIs

that are part of a job.

l Errors & Warnings. Click to go to viewJobErrorsSummary page, to view a list of

error and warning messages reported on this job.
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Column Description

l Last invocation. The date and time that the job was last run.

l Next invocation. The date and time that the job is next scheduled to run.

l Last Total run duration (seconds). The length of time, in seconds, taken to run the

job in the previous invocation. This is calculated according to the start time of the

first trigger until the end time of the last trigger, even if triggers were added later

on.

l Avg run duration (seconds). The average duration (in seconds) per trigger of the

time it took the Probe to run this job.

l Recurrence. The number of times that the job was invoked. Click to go to

viewJobExecHistory page, to view a history of job invocations.

Note: Click Results below the table to go to the viewJobResults page to view the CITs that have

been discovered by the job.

viewJobTriggeredCIs

Fill in one or more of the parameters to return a list of Trigger CIs that are part of a job.

For details on the job operation parameters, see "Job Operation Parameters" on the next page.

The results page displays the following information:

Note: Depending on the triggers, other information might also be displayed.

Column Description

No. The number of the job in the list.

Triggered

CI ID

The CI instances that have been discovered by the job. Click to go to the

viewJobTriggeredCIs page to view information about their CITs.

Last

Execution

Start

Time

The date and time that the job last started running.
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Column Description

Last

Execution

End Time

The date and time that the job last finished running.

Service

Exec.

Duration

(ms)

The maximum time that it took for a job to run in the last invocation, not including

periods when the job did not run. Compare this result with the total execution duration.

For example, when several jobs run simultaneously, but there is only one CPU, a job

might have to wait for another job to finish. The service duration does not include this

waiting time, whereas the total duration does.

Total

Exec.

Duration

(ms)

The time that it took for a job to run in the last invocation, including the periods when

the job did not run.

Last Run

Status

The status of the last run, that is, whether the run succeeded or failed. In case of failure,

click to go to the viewJobProblems page, to view a list of Trigger CIs with problems.

Priority The priority of the job.

Note: The lower the value, the higher the priority.

viewJobTriggeredCIsWithErrorId

Note: This operation is part of the inner interface and serves as a helper function. Do not use this

page to view Trigger CIs information; instead, use the viewJobTriggeredCIs page.

Job Operation Parameters

The following list includes job operation parameters.

l ciType. The name of the CI type (for example, ip, host).

l data. A textual field in the DiscoveryResults table that contains information about the discovered

object. For example:
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<object class="ip">
<attribute name="ip_probename" type="String">EBRUTER02</attribute>
<attribute name="ip_address" type="String">16.59.58.200</attribute>
<attribute name="ip_domain" type="String">DefaultDomain</attribute>
</object>

l Error Id. The error message hash string (error hash ID) that is displayed in the Jobs_Problems table.

l HideRemovedJobs.True: do not display jobs that have run previously and are not relevant to the

current run.

l Hide Touched CIs Info. Touched CIs are CIs which were discovered in previous invocations. DFM

already has information about these CIs, so there is no need for the Probe to send the information

to the server again. The server identifies that these CIs are relevant and that there is no need to

enforce the aging mechanism on them. For details on aging, see "The Aging Mechanism Overview" in

the HP Universal CMDB Administration Guide.

True: the table displays the total number of CIs and the total number of Trigger CIs for each CIT.

False: The table displays the total number of CIs and Trigger CIs divided between touched CIs and

non-touched CIs.

l includeNonTouched. Enables filtering the table to view non-touched CIs. Choose between viewing

non-touched CIs only, all CIs (touched and non-touched), or none:

l includeNonTouchedCIs. See includeNonTouched.

l includeTouched. Enables filtering the table to view touched CIs. Choose between viewing touched CIs

only, all CIs (touched and non-touched), or none.

l includeTouchedCIs. See includeTouched.

l jobID. The name of the job, for example, Host Applications by PowerShell:
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l maxRows. The maximum number of rows that should be displayed in the results table. The default

is 100 or 1000.

l maxTriggeredCIs. See maxRows.

l objectID. The CMDB object ID.

l hideRemovedJobs. Hides information about jobs with the status, REMOVED. These are jobs that

have run previously but that are not currently scheduled to run.

l hideResults. Indicates whether or not to hide the Results column. If the Results column is present,

you can navigate to the job results. For more information, see "viewJobResults " on page 141, and

"viewJobsStatuses " on page 143.

l triggerCI. The CMDB object ID of the trigger for a job.

l triggeredCiID. See triggerCI.
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Chapter 4: Universal Discovery Agents
This chapter includes:

Universal Discovery Agent Overview 150

Universal Discovery Agent Deployment 151

Universal Discovery Agent Certificates 153

Call Home Overview 154

FDCC/USGCB Support 156

How to Create New Certificates for Universal Discovery Agent 158

How to Customize Platforms for Universal Discovery Agent Deployment 159

How to Install the Universal Discovery Agent Manually 160

How to Install Universal Discovery Agent to Run Under a Non-Root Account on UNIX 164

How to Configure Call Home 165

How to Specify Data and Temp Folder Locations when Installing or Updating the Universal

Discovery Agent for UNIX 166

How to Completely Uninstall the Universal Discovery Agent 167

Agent Installation Wizard Overview 168

Agent Installation User Interface 168

Discovery Node Disk Requirements 174

Universal Discovery Agent Installation Resources 175

Universal Discovery Agent File Locations 183

Software Identification Tags 184

Universal Discovery Agent Overview

Universal Discovery (UD) Agent is a program that is installed on a discovery node. The following table

shows functions that the UD Agent performs:
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Function

Communication. Performs job scheduling and job execution functions with the Data Flow Probe and

with the Scanner.

Shell. Provides a command line interface that provides access to services. The UD Agent uses the

Universal Discovery protocol.

Software Utilization. Generates files that contains application utilization data. For more information,

see "Software Utilization" on page 716.

For more information about deployment methods, see "Universal Discovery Agent Deployment" below.

The UD Agent generates a Unique ID when it is installed on a discovery node. However, if there is a

Unique ID already stored on the node, the UD Agent uses the existing Unique ID. Unique ID generation

occurs when agent-based and agentless discovery methods are used. Additionally, generation might

also occur when the Inventory Discovery by Scanner job and the Host Connection by Shell job run.

The Unique ID can be utilized as follows:

l Reconciliation. The Unique ID is used for identification and validation criterion during reconciliation

operations.

l Authentication. The Data Flow Probe uses the Unique ID to validate that it is connecting to the

correct discovery node when performing discovery.

For details about deploying the UD Agent, see "Universal Discovery Agent Deployment" below.

Universal Discovery Agent Deployment

The Universal Discovery (UD) Agent can be installed using one of the following methods:

Deployment

Method Description

Infrastructure

Discovery

Activity

You can use the Infrastructure Discovery activity to configure and deploy UD Agents.

For more information about setting up this activity, see the HP UCMDB Discovery and

Integrations Content Guide.

Manual Third party software distribution tools, scripting, or any remote access technology

can be used to deploy and install discovery packages. For more information, see

"How to Install the Universal Discovery Agent Manually" on page 160.
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Supported Platforms

When installing the agent via the Infrastructure Discovery activity, the configuration file,

AgentsSupportMatrix.xml, located in the UDAgentManagement package controls the list of platforms

on which the UD Agent can be installed. The list of platforms defined in this file matches the list of

platforms officially supported by the UD agent.

Owing to the large number of platform versions, as well as new platform versions emerging all the time,

the configuration file does not include every possible platform on which the corresponding UD agent

may be installed and function correctly.

For example, there may be different distributions of Linux not currently officially supported, where the

Linux UD Agent may indeed be deployed and work correctly. If, after internal testing, you can confirm

that the UD Agent works correctly on a particular platform, you can modify the

AgentsSupportMatrix.xml file to include the additional version/distribution. Any such modifications can

be used only on an “as is” unsupported basis.

To edit the AgentsSupportMatrix.xml file, see "How to Customize Platforms for Universal Discovery

Agent Deployment" on page 159.

Note:

l For a list of out-of-the-box supported platforms and versions for the UD Agent, see the

Supported Content section of the HP UCMDB Discovery and Integrations Content Guide.

Supported platforms are added based on the growing number of tested platforms and

customer requests.

l Deploying the UD Agent on a platform that is not defined among the supported platforms may

result in the UD Agent not functioning properly.

UD Agent Running Modes

After deployment, you can configure the UD Agent to run in one of the following modes:

Running

Mode Description

Complete

Install

The UD Agent, software utilization, and Software Identification Tags are installed on the

discovery node.
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Running

Mode Description

Note: This running mode is the default one when you use activities to install

discovery packages.

Software

Utilization

Software utilization and Software Identification Tags are installed on the discovery

node. Scanners are run manually using third party solutions, scripts, or other remote

access technology.

Universal Discovery Agent Certificates

Universal Discovery Agent certificates are files that provide encrypted communication between the

Universal Discovery Agent and Data Flow Probe.

For each Universal Discovery Agent credential that is created, there is a corresponding pair of

certificate files.

l Acstrust.cert. This file is the public certificate file of the Data Flow Probe.

l Agentca.pem. This file contains the public and private certificate file of the Universal Discovery

Agent.

Caution: These files are critical in maintaining communication between the Data Flow Probe and

the discovery nodes.

Note: If you want to change the certificate files, you must uninstall the Universal Discovery Agents,

create new credentials and perform Universal Discovery Agent deployment again.

Using Certificates

In order for Data Flow Probes to use the same Universal Discovery Agent certificates in different

domains, perform the following:

1. Select your credential in the Data Flow Probe Setup > Domains and Probes > Credentials pane.

2. Click the Copy selected credential to another domain button.
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Call Home Overview

Call Home provides a way for discovery nodes to communicate with the Data Flow Probe. This option is

most suited for networks that have mobile nodes, VPN clients, or for any nodes that have short DHCP

lease times. Nodes regularly initiate communication with the Data Flow Probe. This Call Home

communication occurs within ten minutes after the node is attached to the network.

Note: Call Home is enabled by default.

Traffic Case-Typical

The following traffic case typically occurs when a Universal Discovery Agent that is installed on a

computer initiates Call Home:

1. The Universal Discovery Agent sends a request message to the Data Flow Probe.

2. The Data Flow Probe sends an acknowledgement message to the Universal Discovery Agent.

Note:

o If the Universal Discovery Agent does not receive the acknowledgement message, it sends

messages to the Data Flow Probe every hour until an acknowledgement message is

received.

o The acknowledgement message is an HTTP 200 series status message.

3. The Data Flow Probe creates a Node CI, a Call Home Event CI, and a UD Agent CI.

4. The Call Home Event CI triggers the Call Home Processing job.

5. The Call Home Event CI for the Call Home Processing job is sent to the Data Flow Probe.

6. The Call Home Processing job starts.

7. The Call Home Processing job sends a notification message to workflows that are associated with

the node and that are waiting to be run. These workflows are also known as parked workflows.

After the notification message is received, the parked workflow runs. The Universal Discovery

Agent continues to send the request message according to the value that is set for the Call Home

Request Frequency parameter. This parameter is configured when configuring Universal Discovery
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Agents for deployment. For more information on configuring this parameter, see the section about

the Infrastructure discovery activity in the HP UCMDB Discovery and Integrations Content Guide.

Traffic Case-New Node

The following traffic case occurs when a Universal Discovery Agent that is installed on a new node

initiates Call Home:

1. The Universal Discovery Agent sends a request message to the Data Flow Probe.

2. The Data Flow Probe sends an acknowledgement message to the Universal Discovery Agent.

Note: If the Universal Discovery Agent does not receive the acknowledgement message, it

sends messages to the Data Flow Probe every hour until an acknowledgement message is

received.

The acknowledgement message is an HTTP 200 series status message.

3. UCMDB creates a Node CI, Call Home Event CI, and UD Agent CI.

4. A new Inventory Discovery by Scanner job is triggered.

Traffic Case-Mobile Computer

The following traffic case typically occurs when a mobile computer connects to the network after a long

time:

1. The computer connects to the network.

2. The IP/MAC Harvesting job runs. The job updates IP/MAC pair information, and then it creates a Call

Home Event CI.

3. The Call Home Event CI triggers the Call Home Processing job.

4. The Call Home Event CI for the Call Home Processing job is sent to the Data Flow Probe.

5. The Call Home Processing job starts.

6. The Call Home Processing job sends a notification message to workflows that are associated with

the node and that are waiting to be run. These workflows are also known as parked workflows.

After the notification message is received, the parked workflow runs.
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FDCC/USGCB Support

Overview

The Federal Desktop Core Configuration/United States Government Configuration Baseline (USGCB) is a

list of security settings recommended by the National Institute of Standards and Technology for

computers that are connected directly to the network of a United States government agency.The

purpose of the initiative is to create security configuration baselines for Information Technology

products.

Feature Impact

UCMDB Web Interface. To establish a web connection with the UCMDB server, the Java Runtime

Environment needs to be installed.

Infrastructure Activity. Using this activity to install or upgrade Universal Discovery Agents is not

supported. Alternatively, use manual methods to deploy Universal Discovery Agent installation packages

to nodes. For details, see "How to Install the Universal Discovery Agent Manually" on page 160.

How to Update Security Policy Settings for FDCC

This task describes how to make security policy configurations to ensure compliancy with the FDCC

mandate after you manually deploy the Universal Discovery Agent.

This task includes the following steps:

1. "Allow firewall exceptions" below

2. "Create firewall exceptions" on the next page

3. "Results " on the next page

1. Allow firewall exceptions

The FDCC security policy disables the Firewall Exceptions setting. Enable it either using local policy

or domain policy by using the Group Policy Editor.

a. Click Run and type gpedit.msc to open the Group Policy Editor.

b. Select Local Computer Policy > Computer Configuration > Administrative Templates >

Network >Network Connection > Windows Firewall > Standard Profile|Domain Profile.
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c. Double click "Windows Firewall- Do not allow exceptions".

d. In the Properties dialog box, click Disabled.

2. Create firewall exceptions

The FDCC security policy disables the Firewall Exceptions setting. You must enable it either using

local policy or domain policy by using the Policy Editor.

a. Select Go to Local Computer Policy > Computer Configuration > Administrative Templates >

Network >Network Connection > Windows Firewall > Standard Profile|Domain Profile.

Note: Paths may vary depending on the version of Windows.

b. Double click Windows Firewall-Define the Inbound Program Exceptions.

c. In the Properties dialog box, click Enabled.

d. Click Show.

e. In the Show Contents dialog box, create an entry for the Universal Discovery Agent. Follow the

format conventions that are specified in the Options pane on the left side.

Note: Values vary depending on the configuration that you specified when deploying

Scanners. The port number of the Universal Discovery Agent is 2738 or 7738. The path of

the Universal Discovery Agent is C:\Program Files\Hewlett-Packard\Discovery

Agent\bin32\discagnt.exe. For more information about Scanners and Scanner

parameters, see "Scanner Command Line Parameters Overview" on page 583.

3. Results

Verify that the Universal Discovery Agent can communicate with the Data Flow Probe by invoking

the Check Credentials option for any Universal Discovery Protocol credential. For more

information, see "<Protocol> Details Pane" on page 98.
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How to Create New Certificates for Universal Discovery

Agent

This task describes how to regenerate and reissue certificate files that are used for communication

between the Data Flow Probe and the Universal Discovery Agent.

Note:

l The Universal Discovery Agent may be upgraded during this procedure.

l The frequency that you perform this task depends on your organization's policy.

1. Prerequisites

Ensure that the UCMDB server is running.

2. Enable the parameter

a. In UCMDB, go to Data Flow Management > Universal Discovery > Discovery Modules/Jobs

tab.

b. In the Discovery Modules tree, select Tools and Samples > UD Agent Management.

c. Select the Install UD Agent or Update UD Agent job. Click the Properties tab and select the

UDAgentInstallCredentialID parameter. In the Parameters pane, perform the following:

i. Select the Override check box for the parameter.

ii. Click the corresponding cell in the Value column and click . The Choose Credentials

dialog box opens.

d. In the Choose Credentials dialog box, select a credential for the job to use to connect to the

remote machine, or click to create new credentials.

3. Results

The certificates are deployed to the remote machines the next time the job that you selected in

step 2 runs.
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How to Customize Platforms for Universal Discovery Agent

Deployment

The configuration file AgentsSupportMatrix.xml is located in the UDAgentManagement package and

controls the list of platforms on which the Universal Discovery (UD) Agent can be installed.

Owing to the large number of platform versions, as well as new platform versions emerging all the time,

the configuration file does not include every possible supported platform on which the UD Agent may be

installed and function correctly.

This task describes how to modify the AgentsSupportMatrix.xml file to include additional

versions/distributions on platforms that have been tested and confirmed to support UD Agent

functionality:

Note: Any such modifications can be used only on an “as is” unsupported basis.

1. Go to Data Flow Management > Adapter Management.

2. Under the UDAgentManagement package, select Configuration Files > AgentsSupportMatrix.xml.

3. Go to the relevant <operating-system> tag.

4. Check if the version of the operating system already exists under the relevant <architecture> tag.

If not, enter the unlisted version by copying one of the existing <version> tags, and replacing the

name and display name values with the relevant new values.
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For example:

Note:

l If the relevant operating system or architecture is not listed, create new tags for these.

l To allow support for all versions of a particular architecture of an operating system, under that

architecture's tag, uncomment the line: <version name="any" display-

name="Any">.*</version>

l For a list of out-of-the-box supported platforms and versions for the UD Agent, see the

Supported Content section of the HP UCMDB Discovery and Integrations Content Guide.

l For more information about UD Agent deployment, see "Universal Discovery Agent Deployment"

on page 151.

How to Install the Universal Discovery Agent Manually

This task describes how to install the Universal Discovery (UD) Agent manually on remote machines.
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1. Prerequisite

o Ensure that the platform of the remote machine on which you want to install the UD Agent is

supported.

o For more information, see "Universal Discovery Agent Deployment" on page 151.

o For a list of out-of-the-box supported version, see the Supported Content section in the HP

UCMDB Discovery and Integrations Content Guide.

2. Export the UD Agent installation file and the UD Protocol certificate.

a. Go to Administration > Package Manager and export the UDAgentManagement archive file.

For more information, see "How to Export a Package" in the HP Universal CMDB Administration

Guide.

b. Extract the UD Agent installation file or files that are appropriate for the platform of your

discovery nodes from the following location in the archive file:

discoveryResources\ud_agents

For a mapping of installation files to platforms, see "Universal Discovery Agent Installation

Resources" on page 175.

Tip:

l The file name indicates the platform.

l UNIX only. Additionally, extract the agentinstall.sh file.

c. In Data Flow Management, go to Data Flow Probe Setup > Domains and Probes. In the

relevant domain, select the UD protocol credential whose certificate you want to export, and

click Export Public Certificates.

3. Copy the UD Agent installation and the UD Protocol certificate.

Copy the exported UD Agent and certificate to the remote machine and install them using one of

the following methods:

Note: Ensure that you distribute or copy installation files that are appropriate to the platform

of the discovery node.
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o Attended (Windows only)

Copy the UD Agent installation file and certificate using any manual method or remote access

technology to the remote Windows machine, and then perform installation by clicking the

executable (.MSI) file. For more information on running or configuring this installer, see "Agent

Installation Wizard" on page 168.

o Unattended (All platforms)

i. Copy the UD Agent installation file or files and the certificate file to the remote machine

using any manual method or remote access technology.

UNIX only. Additionally, copy the agentinstall.sh file.

ii. Perform the installation by using command line parameters. For details on parameters for

all platforms, see "Universal Discovery Agent Installation Resources" on page 175.

For example, the following command is used to install the UD Agent on a Windows machine,

to listen on port 7738, with a connection timeout of 900 msec, with the UD Protocol

certificate located in c:\UDAgentInstall

c:\AgentTest>msiexec /i hp-ud-agent-win32-x86-10.10.000.xxx.msi /quiet

SETUPTYPE=Enterprise PORT=7738 TIMEOUT=900 CERTPATH=c:\UDAgentInstall

PERIOD=90 SOFTWAREUTILIZATION=ON URL0=15.178.179.124 URL1=15.178.179.125

URL2=15.178.179.126

Note:

l For error code information, see platform-specific information at "Universal Discovery

Agent Installation Resources" on page 175.

l If an error occurs, the screen may also display a message with information about the

error.

4. Generate Unique IDs for Disk Cloning- Optional

If you are using disk cloning to distribute images that contain the UD Agent, perform the following

to generate Unique IDs:

a. UNIX and Mac OS X only. Log in using the user account that is used to run the UD Agent. If the

location of the data files were modified with the --home command line option at the time of
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installation, type HOME=<HOME> and press ENTER at a command prompt.

Note: <HOME> is the home directory of the user that runs the UD Agent on the computer

where the disk image was created.

b. Navigate to the directory that contains the UD Agent executable files and run the following

command:

l Windows: discagnt.exe --newuniqueid

l UNIX: ./discagnt --newuniqueid

Note: Ensure that you run the command before the UD Agent runs the first time.

5. Results

When you activate the Infrastructure activity, the Data Flow Probe connects to the UD Agent

installed on the remote machine.

To verify that the Data Flow Probe is able to communicate with the remote UD Agent, go to

Universal Discovery > Activity Discovery Status > Progress  tab and make sure that a UDA CI

instance was discovered. For more information, see "Zone-based Discovery View" on page 449.

The following events also occur as a result of installing the UD Agent:

o The UD Agent generates a Unique ID which is stored locally on the discovery node and in UCMDB

as follows:

l Windows and UNIX. For more information on where Unique ID is stored, see "Universal

Discovery Agent File Locations" on page 183.

l UCMDB. Stored in the ud_unique_id attribute of Node CI.

For more information on Unique ID, see "Universal Discovery Agent Overview" on page 150.

o Software Identification Tag files are created and stored on the discovery node. For more

information about Software Identification Tags, see "Hardware and Software Recognition" on

page 527.
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How to Install Universal Discovery Agent to Run Under a

Non-Root Account on UNIX

This task describes how to install the UD Agent to run under a non-root account on UNIX systems.

1. Go to Data Flow Management > Universal Discovery > Zone-based Discovery, and select a

Management Zone or create a new one.

2. In the Infrastructure Discovery activity, in the Define Credentials page, ensure that SSH and

Universal Discovery protocol credentials are defined, as follows:

o SSH protocol:

l In the User Name and Password fields, define credentials for a non-root user for connecting

to the host through the SSH network protocol.

l In the Privileged Command Execution Properties area, define details for the Sudo prefixed

command execution:

l For the Policy, select Sudo-like.

l For the Mode, select Sudo.

l In the sudo paths field, make sure to include the full path to the sudo command on the

remote machine. If the path is different on different computers/operating systems, you

should provide multiple paths, separated by commas.

l Enter the sudo commands. Ensure that the agentinstall.sh and nohup commands are

included among these commands.

o Universal Discovery protocol:

l In the sudo paths field, ensure that the sudo paths defined for the SSH protocol above are

also included.

l In the sudo commands field, ensure that the sudo commands defined for the SSH protocol

above are also included. Ensure that the agentinstall.sh and nohup commands are included

among these commands.

3. On the Universal Discovery Agent Deployment page:

Data Flow Management Guide

Chapter 4: Universal Discovery Agents

HP Universal CMDB (10.22) Page 164 of 795



a. Select the deployment option: Install or Update.

b. Clear the Install UD Agent to run under the root account on UNIX machines option.

Note:

l After installing the UD Agent under a non-root account, the SSH credential used to install the

agent must be kept in UCMDB because this credential is used to retrieve the password for the

sudo command.

If, for whatever reason, the SSH credential was removed and created again, the Host

Connection by Shell job must be rerun on the relevant triggers so that the other jobs can run

sudo commands successfully.

l The Universal Discovery Agent will be run on the remote machine under the credential that was

used for SSH in step 2.

How to Configure Call Home

This task describes how to configure the Call Home feature.

1. Configure the parameters

Call Home is configured depending on the method you use to perform deployment and installation

of discovery resources.

o Infrastructure Discovery Activity

Configure Call Home parameters on the Agent Deployment page of the Infrastructure Discovery

Activity. For details, see the HP UCMDB Discovery and Integrations Content Guide.

o Manual

If you manually deploy discovery packages, include parameters according to the target

platform of your discovery nodes:

Windows

l Unattended. For details on available parameters, see "Universal Discovery Resources for

Windows" on page 175 and "Agent Installation Wizard" on page 168.
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l Attended. For details on how to configure, see "Agent Installation Wizard" on page 168.

UNIX. For details on available parameters, see "Universal Discovery Resources for UNIX" on page

178.

2. Results

o If you use the activity to configure Call Home, verify that you see configuration values on the

Summary page of the Infrastructure Discovery activity. Then, verify the activity ran

successfully by viewing the results summary in Data Flow Management > Universal Discovery

> Zone-based Discovery, and select the Progress tab. For more information, see "Zone-based

Discovery View" on page 449.

o If you use manual methods to configure Call Home, see the section that describes the traffic

case in "Call Home Overview" on page 154.

How to Specify Data and Temp Folder Locations when

Installing or Updating the Universal Discovery Agent for

UNIX

This task describes how to specify the location of data folders and temporary folders when installing

and updating the Universal Discovery Agent on UNIX discovery nodes only. This task also applies to

migrating DDMI agents to the Universal Discovery Agent.

1. Edit the XML file

a. Locate the AgentConfigurationbyPlatform.xml file. To do this, choose from the following

options:

l Data Flow Management > Universal Discovery > Discovery Modules/Jobs, expand Tools

and Samples, expand Universal Discovery Agent Management and select a job. Under the

Properties tab select AgentConfigurationbyPlatform.xml and click Edit . The script

editor opens.

l Data Flow Management > Adapter Management, expand Universal Discovery Agent

Management, expand Configuration Files and select AgentConfigurationbyPlatform.xml.

The script editor opens.
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b. In the Script Editor, click Find Text to open the Find Text dialog box.

Find the agent-install-data-folder and agent-install-temp-folder parameters. Replace the

DEFAULT value with the new value for the parameters you want to modify.

For more information on the Find Text dialog box, see "Find Text Dialog Box" on page 268.

2. Results

The new values for the parameters that you modified are used when the Install UD Agent or the

Update UD Agent job runs.

How to Completely Uninstall the Universal Discovery Agent

This task describes how to completely uninstall the Universal Discovery Agent and all its associated files.

A complete uninstall differs from a default, or normal uninstall which retains certain files.

Note:

l Perform this task only when you will not re-install the Universal Discovery Agent.

l Configuration data files will be removed. This action cannot be undone.

l If you re-install the Universal Discovery Agent after you perform this task, reconciliation issues

may occur due to the removal of the file that contains the Unique ID of the previous instance of

Universal Discovery Agent. As a result, you may notice duplicate Node CIs after inventory

discovery runs.

l This task can also be performed manually. For more information, see "Agent Installation User

Interface" on the next page.

1. Prerequisites

Ensure the UCMDB server is running.

2. Enable the parameter

a. In UCMDB, go to Data Flow Management > Universal Discovery > Discovery Modules/Jobs

tab.

b. In the Discovery Modules tree, select Tools and Samples > UD Agent Management.
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c. Click the Properties tab and select Uninstall UD Agent. In the Parameters pane, perform the

following:

i. Select the Override check box for the RemoveAgentData parameter.

ii. Click the corresponding cell in the Value column and set the value by typing True.

3. Results

The Universal Discovery Agent is completely uninstalled the next time the job runs. To verify that all

files were removed, see "Universal Discovery Agent File Locations" on page 183.

Agent Installation Wizard Overview

This MSI package is used in manual deployments of the Universal Discovery Agent for Windows

computers only. It can be used for installing, uninstalling, upgrading, or repairing the Universal Discovery

Agent. Additionally, you can enable and set the options for software utilization.

For more information about deployment methods for the Universal Discovery Agent, see "Universal

Discovery Agent Deployment" on page 151.

For more information about the Agent Installation Wizard, see "Agent Installation Wizard" below.

Agent Installation User Interface

This chapter includes:

Agent Installation Wizard 168

Agent Installation Wizard

Enables you to install and configure the Universal Discovery Agent on a discovery node that is running

Windows.

To access l Export the MSI package from the Package Manager. After the resource is deployed,

double click hp-ud-agent-win32-x86-<VersionNumber>.msi.
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l For details about how to export the package, see How to Export a Package in the

HP Universal CMDB Administration Guide.

Important

Information

l This MSI installer can be run on Windows computers only. Additionally, the Windows

computer must be running Microsoft Installer version 2.0 or above.

l There are two operational modes that are available-Complete Installation mode

or Software Utilization mode. The mode that you select determines which pages

are displayed.

l If the Universal Discovery Agent is already installed on the computer, the wizard

starts at the "Uninstall Options Page".

l For more information on using command line parameters to configure unattended

deployments of Universal Discovery Agents, see "Universal Discovery Resources for

Windows" on page 175.

Relevant

tasks

"How to Install the Universal Discovery Agent Manually" on page 160

Wizard map The Agent Installation Wizard contains:

"Set Up Type Page" > "Agent Configuration for Complete Installation Page" > "Software

Utilization Page" > "Uninstall Options Page" > "Uninstall Type Page"

See also "Universal Discovery Agent Overview" on page 150

Set Up Type Page

Enables you to select a mode of operation for Universal Agent installation.

Important

Information

The Windows computer must be running Microsoft Installer version 2.0 or later.

Wizard Map The Agent Configuration Wizard contains:

Set Up Type Page > "Agent Configuration for Complete Installation Page" > "Software

Utilization Page" > "Uninstall Options Page" > "Uninstall Type Page"

User interface elements are described below:
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UI

Element

(A–Z) Description

Set Up

Type

Select a mode of operation:

l Complete Install. This is the default mode and suggested for most client type

environments. Universal Discovery Agents are installed on the discovery nodes, and

then the Data Flow Probe installs the Scanner on the discovery nodes. Scanner

schedules and jobs are managed by the Data Flow Probe.

l Software Utilization Only. Only the Software Utilization software is installed on the

discovery node. For more information, see "Software Utilization" on page 716.

Agent Configuration for Complete Installation Page

Enables you to make configurations for the Universal Discovery Agent installation when you select the

Complete Installation mode.

Important

information

l The Windows computer must be running Microsoft Installer version 2.0 or later.

l This page is displayed only if you selected Complete Installation on the Set Up

Page.

Wizard map The Agent Configuration Wizard contains:

"Set Up Type Page" > Agent Configuration for Complete Installation Page >

"Software Utilization Page"> "Uninstall Options Page" > "Uninstall Type Page"

UI

Element Description

Port Select the port that you want to use for communication between the Universal

Discovery Agent and the Data Flow Probe.

Note:  This port number should be the same as the port number you specified in

the UD Protocol Parameters dialog box at Data Flow Management > Data Flow

Probe Setup > Domains and Probes > Domain > Credentials. Additionally, if you

change this port number manually after installation, the new port number takes

effect only after the Universal Discovery Agent is upgraded.
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UI

Element Description

Time Out Enter a value that sets a time out threshold.

Measured in seconds.

Note:  This parameter is called Call Home Frequency in the Infrastructure

Discovery activity.

Primary

Call Home

Probe

Address

Enter a primary address for the Data Flow Probe server that you want the Universal

Discovery Agent to contact for Call Home messages.

Use one of the following formats:

l Hostname (For example: probehost)

l IP Address

o IPv4Address (For example: 10.11.12.13)

o IPv6Address (For example: 2010:836b:4179::836b:4179)

l Full Path

o http://HostNameOrIPv4Address:Port/callhome (For example:

http://probehost:1977/callhome)

o http://[IPv6Address]:Port/callhome (For example: http://[ 

2010:836b:4179::836b:4179]:1977/callhome)

Note:

l Port 80 is used by default when no port number is specified. If port 80 is

occupied, use a format that specifies port 1977.

l Separate each entry by using a comma. Multiple entries should only be used

when you are running DDMI server and UCMDB in parallel as part of a larger

migration effort. For more information on how to perform Universal Discovery

Agent migration, see the the overview section in the DDMI to Universal Discovery

Migration Guide.

Secondary Enter a secondary address for the Data Flow Probe server that you want the Universal
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UI

Element Description

Call Home

Probe

Address

Discovery Agent to contact for Call Home messages. See Primary Call Home Probe

Address (above) for formatting information.

Certificate

Path

Select a credential to use.

For more information on exporting certificate files, see "Universal Discovery Agent

Certificates" on page 153.

Note:  The path must be a folder that contains the asctrust.cert file and

agentca.pem file.

Software Utilization Page

Enables you to make configurations for the software utilization feature.

Important

Information

The Windows computer must be running Microsoft Installer version 2.0 or later.

Wizard Map The Agent Configuration Wizard contains:

"Set Up Type Page" > "Agent Configuration for Complete Installation Page" > Software

Utilization Page > "Uninstall Options Page" > "Uninstall Type Page"

UI Element (A–Z) Description

Software

Utilization

Select this option if you want to enable this feature. For more information, see

"Software Utilization" on page 716.

Software

Utilization Period

Choose the range to retain the software utilization data:

l 31 days

l 90 days

l 365 days
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Uninstall Options Page

Enables you to select options for the uninstall operation.

Important

Information

l The Windows computer must be running Microsoft Installer version 2.0 or later.

l This page is available only if the Universal Discovery Agent is already installed on

the computer.

Wizard Map The Agent Configuration Wizard contains:

"Set Up Type Page" on page 169 > "Agent Configuration for Complete Installation Page"

on page 170 > "Software Utilization Page" on the previous page> Uninstall Options

Page > "Uninstall Type Page" below

UI Element Description

Repair Select this option if you want to install the installation files again.

Note: All configuration options are preserved.

Remove Select this option to remove the Universal Discovery Agent.

Uninstall Type Page

Enables you to select the type of uninstall operation.

Important

Information

l The Windows computer must be running Microsoft Installer version 2.0 or later.

l This page is available only if you selected Remove on the "Uninstall Options Page".

Wizard Map The Agent Configuration Wizard contains:

"Set Up Type Page" > "Agent Configuration for Complete Installation Page" > "Software

Utilization Page" > "Uninstall Options Page" > Uninstall Type Page
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UI

Element Description

Default Select this option if you want perform a typical uninstall operation that deletes agent

executable files and configuration files.

Note:

l Use this option when upgrading the Universal Discovery Agent.

l The Universal Discovery Agent log and software utilization files are not deleted.

Complete Select this option if you want to perform a complete uninstall and remove most Universal

Discovery Agent and scanner files.

Note:

l Use this option when you do not plan on installing the Universal Discovery Agent

again.

l Temporary files that are associated with the scanner are not deleted.

Discovery Node Disk Requirements

The estimated minimum disk space requirements for a discovery node are as follows:

Type of Node

Universal Discovery Agent and

Scanner

Inventory

Data

Utilization

Data

Desktop/Workstation/Laptop 25 MB 250 KB- 3 MB 5-10 MB

Servers 25 MB 3-100 MB 50-100 MB

Note:

l The size of the inventory data heavily depends on the scanner configuration and the size of the

file system on the target computer being inventoried. These are guideline figures for typical

computers scanned using default scanner configuration. If the scanners are configured to

collect information on all files (not just executables) or for computers hosting very large

amount of files that are being scanned and the information on which is captured into the scan
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file, the space required could be larger.

l The size of the software utilisation data heavily depends on the amount of processes being

executed and the length of the software utilization collection period. These are guideline

figures, for computers hosting large amount of processes the amount of space required could

be larger. Additionally, the value is estimated for one year of utilization data.

Universal Discovery Agent Installation Resources

The Discovery resources are files that support the deployment and installation of Universal Discovery

Agents and Scanners. When using manual methods of deployment you can retrieve these resources by

exporting them from Administration > Package Manager > UDAgentManagement. For details, see How

to Export a Package in the HP Universal CMDB Administration Guide.

To export individual resource files, go to Data Flow Management > Adapter Management > Resources

Pane > UDAgentManagement > ExternalResources > UD_Agents.

Tip: You do not have to export or include XML files in the discovery packages.

Universal Discovery resources are available for the following platforms:

l Windows. For details, see "Universal Discovery Resources for Windows" below.

l Mac. For details, see "Universal Discovery Resources for Mac" on page 178.

l UNIX. For details, see "Universal Discovery Resources for UNIX" on page 178.

Universal Discovery Resources for Windows

Resources

Discovery resources for Windows are as follows:

Platform Resource Name Description

Windows hp-ud-agent-win32-x86- This installer package is required for all installations.
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Platform Resource Name Description

(x86) <VersionNumber>.msi

agentupgrade.cmd Used when upgrading or migrating DDMI agents to

Universal Discovery Agents.

Parameters

You can use parameters in a command line interface to customize the Universal Discovery Agent

installation, uninstallation, or upgrade as follows.

c:\AgentTest>msiexec <InstallOption> <Product.msi> /log <UPGRADELOGFILEPATH> [CLEAN=ON]

SETUPTYPE=Enterprise PORT=7738 TIMEOUT=900 CERTPATH=c:\ PERIOD=90

SOFTWAREUTILIZATION=ON URL0=15.178.179.124 URL1=15.178.179.125 URL2=15.178.179.126

Parameter Name Description

InstallOption Indicates the type of operation. The following options are supported:

l /i: Installs the Universal Discovery Agent.

l /x: Uninstalls the Universal Discovery Agent.

Product.msi Indicates the product file name.

For example, hp-ud-agent-win32-x86-10.20.000.xxx.msi

UPGRADELOGFILEPATH Specify a path to save a log file.

Note:

l Only use with the agentupgrade.cmd script.

l Use together with the /log switch.

CLEAN Indicates the type of uninstall procedure. Most Universal Discovery Agent

files and scanner files are deleted.

Note:

l This parameter must be used together with the uninstall option.
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Parameter Name Description

l If you do not want to use this option, omit the parameter from the

string.

SETUPTYPE Indicates the operational mode.

Type Enterprise or Manual.

Note:  The manual parameter value is called "Software Utilization Plug

In Only" in the Agent Installation Wizard User Interface.

PORT Port number for Universal Discovery Agent to use for communication with

Data Flow Probe.

Type 2738 or 7738.

Note: The default value is 2738. If you change this port number

manually after installation, the new port number takes effect only after

the Universal Discovery Agent is restarted.

TIMEOUT Frequency that the Universal Discovery Agent contacts the Data Flow Probe

when the Universal Agent sends Call Home messages.

Measured in seconds.

Default is 86400 seconds.

Note:  This parameter is called Call Home Frequency in the

Infrastructure Discovery activity.

CERTPATH Path to install certificate files.

Default is the working directory.

PERIOD Number of days to retain software utilization data.

Default is 365 days.

SOFTWAREUTILIZATION Enable or disable Software Utilization plug in.

Use "ON" to enable and "OFF" to disable.
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Parameter Name Description

Default is "OFF".

URL0|URL1|URL2 IP address for Data Flow Probe that is used for Call Home messages.

Note: If you are performing a migration from DDMI to Universal

Discovery, this parameter is also used for the DDMI server.

Universal Discovery Agent Error Codes

For error codes that may be returned when using installation or upgrade packages, see

http://msdn.microsoft.com/en-us/library/windows/desktop/aa376931(v=vs.85).aspx.

Universal Discovery Resources for Mac

Discovery resources for Mac are as follows:

Platform Resource Name

Mac OS X (x86) hp-ud-agent-macosx-x86.dmg

Universal Discovery Resources for UNIX

Resources

The following script files are available for manual agent installations and upgrades:

Platform Resource Name Description

UNIX agentinstall.sh l Installs the Universal Discovery Agent.

l Replaces the non-native version of the UD Agent with a version

that is packaged in the native operating system version of the

discovery node.

agentupgrade.sh Upgrades the DDMI agent to a Universal Discovery agent. However,

this version of the Universal Discovery agent is not packaged in the

native operating system version of the discovery node.
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These files are available in the Package Manager. For more information on exporting resources, see

How to Export a Package in the HP Universal CMDB Administration Guide.

Additionally,discovery resources for UNIX and the UNIX variants that are also available in the Package

Manager are as follows:

Operating System Platform File Name

HP-UX ia64 hp-ud-agent-hpux-ia64.depot

HPPA hp-ud-agent-hpux-hppa.depot

Linux (Red Hat, SUSE, CentOS, Oracle) x86,x64 hp-ud-agent-linux-x86.rpm

Linux (Ubuntu) x86,x64 hp-ud-agent-linux-x86.deb

AIX POWER hp-ud-agent-aix-ppc.bff

Solaris x86 hp-ud-agent-solaris-x86.i86pc

SPARC hp-ud-agent-solaris-sparc.sparc

Mac OS X x86 hp-ud-agent-macosx-x86.dmg

Parameters

You can use parameters in a command line interface to customize the discovery installation as follows:

filename [--help] [--url0 ipaddress] [--url1 ipaddress] [--url2 ipaddress] [--port number] [--timeout

seconds] [--cert path] [--usage] [--softwareutilization] [--softwareutilizationonly] [--period days] [--

home path] [--upgrade] [--uninstall] [--clean] [--temp] [--user] [--group] packagename

--isnative

where:

Parameter Name Description

cert Path to install certificate files.

Default: Working directory

clean Specifies a type of uninstall procedure. Most Universal Discovery Agent files

and scanner files are deleted.
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Parameter Name Description

Note:  This parameter can only be used together with the uninstall and

home parameters.

filename The name of the installation file.

Note:

l This is a mandatory parameter.

l The filename is usually agentinstall.sh.

group Specifies the group name for the user account that you want to run the

Universal Discovery Agent under.

Note: Use this parameter together with the user parameter.

help Displays help messages.

home Directory that contains the Universal Discovery Agent log and the software

utilization data files.

Default: HOME directory

packagename Full path for the package installation file.

Default: Working directory

Note:  This parameter is required when installing or upgrading the

Universal Discovery Agent.

period Number of days to retain software utilization data.

Default: 365 days

port Port number for the Universal Discovery Agent to use for communication

with the Data Flow Probe.

Type 2738 or 7738

Default: 2738
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Parameter Name Description

Note:  If you change this port number manually after installation, the

new port number takes effect only after the Universal Discovery Agent

is restarted.

softwaretutilization Enables software utilization.

softwareutilizationonly Enables the Software Utilization plug-in only.

Note:

l The Universal Discovery Agent is disabled.

l This parameter is supported only when installing the Universal

Discovery Agent manually.

temp Directory that contains Universal Discovery Agent and scanner temporary

files.

Default: $TEMP directory.

timeout Frequency (in seconds) that the Universal Discovery Agent contacts the Data

Flow Probe for Call Home.

Default: 86400 seconds

uninstall Uninstalls the Universal Discovery Agent.

Note: When you use this parameter:

l All parameters except the clean parameter are ignored.

l The filename parameter is required.

upgrade Upgrades the Universal Discovery Agent.

url0|url1|url2 IP address for Data Flow Probe that is used for Call Home messages.

Note: If you are performing a migration from DDMI to Universal

Discovery, this parameter is also used for the DDMI server.
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Parameter Name Description

usage Displays help messages.

Note: This parameter provides the same information as the help

parameter.

user The user account that is used to start up the Universal Discovery Agent.

isnative Returns whether a native or non-native Universal Discovery Agent is

installed.

Universal Discovery Agent Error Codes

The following error codes may be returned when using installation or upgrade scripts as follows:

Error Code Description

1 General error

2 Wrong parameter

3 Not root user

4 File creation error

5 Wrong platform

6 Install package error

7 Directory missing

8 File missing

9 File not executable

10 Link startup script error

11 Startup script error

12 Universal Discovery Agent is already installed

Note: Applicable only when performing an installation operation.
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Error Code Description

13 System package installer error

14 Run agent with non-root user error

15 The DDMI agent is installed.

Universal Discovery Agent File Locations

Universal Discovery Agents and supporting files are installed on the discovery node as follows:

Windows

Platf

orm

Installation

Files Data/Utilization Data Files Unique ID

x86 program

files\hewlet

t-

packard\dis

covery

agent

<AgentServiceData>\Hewlett-

Packard\Universal

Discovery\Data\Perf

where <AgentServiceData> is the location of

the application data directory for the profile

that is used by the UD Agent service. By

default, <AgentServiceData> refers to the

following if Windows is installed on C drive:

l XP/Server 2003: C:\Documents and

Settings\LocalService\Application Data

l Vista and above:

 C:\Windows\system32\config\systempro

file\AppData\Roaming

HKEY_LOCAL_

MACHINE\SOFTWARE\Hewlett-

Packard\Universal

Discovery\V1\Options\UD_

UNIQUE_ID

x64 program

files(x86)

\hewlett-

packard

\discovery

agent

C:\Windows\SysWOW64\config\systemprofil

e\

AppData\Roaming\Hewlett-

Packard\Universal

Discovery\Data\Perf

HKEY_LOCAL_

MACHINE\SOFTWARE\Wow643

2Node\Hewlett-

Packard\Universal

Discovery\V1\Options\UD_

UNIQUE_ID.
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l Certificate files are contained in the same location as program files. For more information, see

"Universal Discovery Agent Certificates" on page 153.

l The Perf subdirectory contains most of the utilization data. This applies to all platforms listed.

UNIX

Platform Installation Files

Data Files

Utilization Data Files Unique ID

Linux

/Solaris/HP-

UX/Unix

/opt/HP/Discovery $HOME/.discagnt/Perf UD_UNIQUE_ID entry in

$HOME/.discagnt/aioptionrc

Mac OS X (x86) /Library/StartupItems/

HPDiscoveryAgent

$HOME/.discagnt/Perf

AIX /usr/lpp/HP/Discovery $HOME/.discagnt/Perf

Note:

l Certificate files are contained in the same location as program files. For more information, see

"Universal Discovery Agent Certificates" on page 153.

l The Perf subdirectory contains most of the utilization data. This applies to all platforms listed.

l "$HOME" refers to the home directory of the account that runs the Universal Discovery Agent.

l You can modify the Universal Discovery Agent log and software utilization data files location

when you use the installagent.sh script. For more information, see "Universal Discovery

Resources for UNIX" on page 178.

Software Identification Tags

Tag File Name

When you install the Universal Discovery Agent, a Software Identification Tag file is created and named

as follows:
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Agent Deployment

Mode File Name

Complete Install regid.1986-04.com.hp_UD-AgentComplete-<VersionNumber>.swidtag

Software Utilization regid.1986-04.com.hp_UD-AgentSoftwareUtlizationOnly-

<VersionNumber>.swidtag

For more information on the deployment modes for the Universal Discovery Agent, see "Universal

Discovery Agent Overview" on page 150.

Tag File Location

Operating system vendors can specify where software identification tags are located. If the vendor

does not specify a location, software identification tags may be stored as follows:

Platform Version Local File Location Global File Location

Apple

Macintosh OS X

Leopard /Library/StartupItems

/HPDiscoveryAgent

/Library/Application

Support/regid.1986-04.com.hp

Apple

Macintosh OS X

Prior to

Leopard

/Applications

/HPDiscoveryAgent.app

/Contents

UNIX and Linux

(Excluding AIX)

/opt/HP/Discovery /usr/share/regid.1986-

04.com.hp/

Windows XP,2000,2003 l (x32): C:\Program

Files\Hewlett-

Packard\Discovery Agent

l (x64): C:\Program Files (x86)

\Hewlett-Packard\Discovery

Agent

%AllUsersProfile%\Application

Data\regid.1986-04.com.hp

Windows Vista,Server

2008 and

2012

%Program Data%\regid.1986-

04.com.hp

AIX /usr/lpp/HP/Discovery /usr/share/regid.1986-

04.com.hp/

Software Identification Tag Attributes

The following attributes are contained in scan files if Software Identification Tags are enabled during

discovery:
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Field Name Attribute Name Description

Entitlement_

required_

indicator

hwOSSoftwareIdTagEntitlementRequiredIndicator Indicates if an entitlement

must match up against this

software in order for a

successful software

reconciliation to occur.

product_title hwOSSoftwareIdTagProductTitle Name of software as assigned

by the software creator.

product_

version

hwOSSoftwareIdTagProductVersionName,

hwOSSoftwareIdTagProductVersionNumber

Textual and numeric version of

the software.

software_

creator

hwOSSoftwareIdTagSoftwareCreatorName,

hwOSSoftwareIdTagSoftwareCreatorRegid

Software creator that

produced the software

package, and the creator's

domain.

software_

licensor

hwOSSoftwareIdTagSoftwareLicensorName,

hwOSSoftwareIdTagSoftwareLicensorDomain

Software licensor that owns

the copyright for the software

package, and the licensor's

domain.

software_id hwOSSoftwareIdTagSoftwareUniqueId,

hwOSSoftwareIdTagSoftwareIdCreatorDomain

Unique ID of the product and

the domain name of the tag

provider.

tag_creator hwOSSoftwareIdTagTagCreatorName,

hwOSSoftwareIdTagTagCreatorDomain

Name of the tag creator, and

the tag creator's domain name.

tag file path hwOSSoftwareIdTagTagFilePath Location of the tag file. If the

file is located at the root of the

application's installation

directory, this field will indicate

the installation directory of the

application.

Tip: This information may be

useful for application teaching.

For more information, see
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Field Name Attribute Name Description

"Application Teaching" on page

522.

license

linkage

hwOSSoftwareIdTagLicenseLinkageActivationStatus Licensing level that a software

licensor uses to track software

status. Every software licensor

may have a different set of

values.

Information may include the

following:

l Trial. Indicates that the

software is in a trial mode

and this value may include

the number of days the trial

mode is valid, or that the

trial has expired.

l Serialized. Indicates that

the software user has

entered a valid serial

number during the

installation process,

however, the software is

not activated.

l Fully Licensed. Indicates

that the product is

activated.

l Unlicensed. Indicates that

the software is running in a

limited mode. Software can

enter into this state by one

or more of the following:

a. A trial period has

expired.
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Field Name Attribute Name Description

b. A time-based license has

expired.

c. Software package

contained a serial

number, however, the

software package was

not activated in the

given timeframe.

hwOSSoftwareIdTagLicenseLinkageChannelType Indicates the channel the

software was targeted for.

Every software licensor may

have a different set of values.

Information may include the

following:

l Volume. Targeted for

volume consumption.

l Retail. Target for the retail

channel.

l OEM. Targeted for the OEM

channel.

l Academic. Targeted for the

education or academic

channel.

hwOSSoftwareIdTagLicenseLinkageCustomerType Identifies the target customer

of the software. Every software

licensor may have a different

set of values.

Information may include the

following:

l Government. Targeted for

government customers.
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Field Name Attribute Name Description

l Corporate. Targeted for

corporate customers.

l Educational. Targeted for

education or academic

customers.

l Retail. Targeted for retail

customers.

serial

number

hwOSSoftwareIdTagSerialNumber Unique identifier that may be

represented as a combination

of numbers, letters, or symbols.

The serial number for the

software product is a

commonly used unique number

assigned for identification of a

particular title and purchase.

Note: The value might be the

serial number that is run

through a one-way hash

encryption scheme.

For more information about enabling discovery of Software Identification Tags, see "Hardware Data

Page" on page 609.
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Chapter 5: Scanner Scheduler
This chapter includes:

Scanner Scheduler Overview 190

How to Deploy the Scanner Scheduler 190

Scanner Scheduler Resources 193

Scanner Scheduler Overview

Scanner Scheduler is often used together with Store and Forward servers when manually deploying

scanners. The Scanner Scheduler enables you to download and update scanners from the Data Flow

Probe to discovery nodes, and you can also specify when a scanner runs on discovery nodes. Using this

feature ensures scanners are automatically updated, and it also ensures uninterrupted scanning when

connectivity or firewall issues prevent the Data Flow Probe from initiating scan jobs on discovery nodes.

Additionally, you can centrally configure and manage schedules by using a configuration (.ini) file that is

stored on a remote server. The scanner, using a third party data transfer program called Curl,

periodically downloads this remote configuration file according to a download schedule that you

configure. Updates that are contained in the remote configuration file overwrite the local configuration

file.

Deploy the Scanner Scheduler manually using any remote access technology or third party distribution

tool. The Scanner Scheduler runs as a service on Windows or as a detached process on UNIX.

To install the Scanner Scheduler, see "How to Deploy the Scanner Scheduler" below.

To see resources for the Scanner Scheduler, see "Scanner Scheduler Resources" on page 193.

To see support information, see the Supported Content section of the HP UCMDB Discovery and

Integrations Content Guide.

How to Deploy the Scanner Scheduler

This task describes recommended workflows for deploying the Scanner Scheduler.
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Installing the Scanner Scheduler

This task includes the following steps:

l "Prerequisites" below

l "Copy the installation package for the Scanner Scheduler to the discovery node" below

l "Install the Scanner Scheduler" on the next page

l "Generate scanner- Optional" on the next page

l "Customize download and running schedules" on the next page

l "Results" on the next page

1. Prerequisites

Ensure that UCMDB is installed.

2. Copy the installation package for the Scanner Scheduler to the discovery node

Note: Ensure that you distribute or copy the installation files that are appropriate to the

platform of the discovery node.

Windows:

a. On the UCMDB server, copy the MSI installation package from the following location to your

local computer:

UCMDB\UCMDBServer\tools\InventoryDiscovery\ScannerScheduler

b. Copy the MSI installation package to the discovery node using any manual method or remote

access technology.

UNIX:

From the UCMDB installation media, copy the file that is appropriate to your discovery node

platform to your local computer. Additionally, copy the scannerschedulerinstall installation
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script file.

Tip: The file name of the resources file indicates the platform.

3. Install the Scanner Scheduler

Windows:

For attended installations, double-click or execute the MSI file. For unattended, or silent

installations, run the following command: msiexec /quiet /I <MSIFilename>

Note: To debug the installation, use the following command: /L*v <FullPathToLogFile>. Log

files are stored in the same location as scan files. For more information on scan file locations,

see "Scanner Options Page" on page 639.

UNIX:

Run the following command with root privileges: scannerschedulerinstall hp-ud-scanner-

scheduler-<platform>-10.20.000<buildnumber>.<packageformat>

4. Generate scanner- Optional

Note: If you do not want to update the scanners that are deployed to discovery nodes, skip

this step.

If you want to use Scanner Scheduler to download and update scanners to discovery nodes, use the

Scanner Generator wizard to generate a scanner. For more information, see "Scanner Generator

Wizard" on page 603.

5. Customize download and running schedules

Customize the config.ini file to specify schedules for running scanners, to download centrally-

managed configuration files using Curl, and to download scanners to discovery nodes. For more

information, see "Scanner Scheduler Resources" on the next page.

6. Results

The Scanner Scheduler starts automatically when the discovery node is started.
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o The scanner downloads and runs according to the parameter values that are specified in the

config.ini file.

Upgrade the Scanner Scheduler

Windows:

From the Control Panel, uninstall the Scanner Scheduler. Then, install the Scanner Scheduler normally.

UNIX:

From a command line, use the upgrade parameter. For example,scannerschedulerinstall --upgrade hp-

ud-scanner-scheduler-<platform>-10.20.000<buildnumber>.<packageformat>

Uninstall the Scanner Scheduler

Windows:

From the Control Panel, uninstall the Scanner Scheduler.

UNIX:

From a command line, use the uninstall parameter. For example, scannerschedulerinstall --uninstall

For more information on Scanner Scheduler, see "Scanner Scheduler Overview" on page 190.

For more information on Scanner Scheduler operations and resources, see "Scanner Scheduler

Resources" below.

Scanner Scheduler Resources

File Locations

The following table describes information about the Scanner Scheduler installation and log file

locations.

The Curl program and the config.tmp file are located in the same directories as listed under the

Installation Location column.

Platform Installation Location Log File Location

Windows 32-

Bit

<ProgramFiles>\Hewlett-Packard\Universal

Discovery\10.20\Scanner Scheduler

<ALLUSERSPROFILE>\Hewlett-

Packard\Universal Discovery
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Platform Installation Location Log File Location

Note:

l This location can be configured by using the

following

command: INSTALLDIR=C:\ScannerScheduler

l The <ProgramFiles> environment variable is

normally located at C:\Program Files

Windows 64-

Bit

<ProgramFiles(x86)>\Hewlett-Packard\Universal

Discovery\10.20\Scanner Scheduler

Note:

l This location can be configured by using the

following

command: INSTALLDIR=C:\ScannerScheduler

l The <ProgramFiles(x86)> environment

variable is normally located at C:\Program

Files(x86)

UNIX /opt/HP/ScannerScheduler $HOME/.discagnt directory

Mac /Library/StartupItems/HPScannerScheduler

AIX /usr/lpp/HP/ScannerScheduler

Configuration File Parameters

The config.ini file contains parameters for managing the running schedule of the scanner, the

downloading schedule for the scanner, and for downloading a configuration file on a remote server. The

parameters are as follows:

Configuration File Parameter Description

Monday|Tuesday|Wednesday|Thursday

Friday| Saturday| Sunday

For each day of the week, enter the range of hours you

want your scheduled event to run. If you specify multiple

time intervals, use commas to separate each interval. For

Data Flow Management Guide

Chapter 5: Scanner Scheduler

HP Universal CMDB (10.22) Page 194 of 795



Configuration File Parameter Description

example: 10:00-12:00,14:00-18:00

Note: The 24-hour clock is used.

FrequencyHours Indicates how frequently the scheduled event occurs.

Assume you want to use a weekly interval for your

scheduled event. In this scenario, set the value to 168.

If this parameter is set to 0, scheduling is disabled.

Note: This field is mandatory.

RandomDelayMinutes Specifies a random delay to the start time for load

balancing purposes. Assume that the scanner is scheduled

to run at 9:00 and the random delay is 60 minutes. In this

scenario, the scanner runs at a random point in time

between 9:00 and 10:00.

If this parameter is set to 0, no random delay is used.

CommandLine Enter a command to run the scanner, to run a program that

will download the config.ini file from a remote server, or to

download the scanner.

l The Scan section. Enter a command to run the scanner.

If no path is specified, the Scanner Scheduler attempts

to start the scanner from the same directory as the

Scanner Scheduler executable is located.

l The DownloadConfig section. Enter a command to run

Curl, or any other data transfer tool, to download a

remote config.ini file. Additionally, in the

<RemoteConfigPath> parameter, enter a URL that

specifies the location of the config.ini file that you want

to download.

Note:
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Configuration File Parameter Description

o After the config.ini file is downloaded, the file is

stored as config.tmp and then automatically

converted to config.ini.

o The RemoteConfigPath parameter is

mandatory.

l The DownloadScanner section. In the

<RemoteScannerPath> parameter, enter the path to

the location where the scanner that you want to

download is located.

Note: The scanner file name is scan.tmp after it is

downloaded. However, you can change the file

name in the ScannerFileName parameter.

ScannerFileName In the <LocalScannerPath> parameter, enter the full file

path to the local computer where you want to store the

scanner file. The scanner file name is changed from

scan.tmp to the file name specified in this parameter.

Note: This parameter is mandatory.

Windows Specific Resources

File name Description

ScannerScheduler.exe Executable file of the Scanner Scheduler service.

config.ini Configuration file that contains parameters that manages the scanning

schedule of the scanner. It also manages, together with a third party

program, the download schedule of another config.ini file that is located on a

remote server.

curl.exe Executable file of Curl. This third party program can be used to download a

new configuration file from a remote server.
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File name Description

libeay32.dll OpenSSL DLL to enable Curl to work over HTTPS.

libssl32.dll OpenSSL DLL to enable Curl to work over HTTPS.

curl-ca-bundle.crt Root CA certificates to enable Curl to work over HTTPS.

UNIX Specific Resources

File Name Description

bin/scansched Executable file of the Scanner Scheduler service.

bin/config.ini Configuration file that contains parameters that manage the scanning

schedule of the scanner. The configuration file also manages, together with a

third party program, the download schedule of another config.ini file that is

located on a remote server.

bin/curl Executable file of Curl. This third party program can be used to download a

new configuration file from a remote server.

bin/curl-ca-

bundle.crt

Root CA certificates to enable Curl to work over HTTPS.

discscannerscheduler Script to manage the scanner scheduler. For more information about

available parameters that you can use in this script, see "Scanner Scheduler

Parameters (UNIX only) " below.

Scanner Scheduler Parameters (UNIX only)

To manage the Scanner Scheduler for nodes that are running UNIX, enter the following command:

discscannerscheduler <ParameterName>

where <ParameterName> is a placeholder for the parameter name specified as follows.

Note: Ensure that you run the command from the installation location.
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Parameter

Name Description

start Starts the Scanner Scheduler service.

stop Stops the Scanner Scheduler service.

restart Restarts the Scanner Scheduler service.

status Indicates running status information of the Scanner Scheduler service.

l If the Scanner Scheduler is running, the following message is returned: “Universal

Discovery Scanner scheduler (pid xxxx) is running.”

l If the Scanner Scheduler is not running, the following message is returned:

“Universal Discovery Scanner scheduler stopped.”
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Chapter 6: Store and Forward
This chapter includes:

Store and Forward Overview 199

How to Install the Store and Forward Server 199

Store and Forward Installation Wizard 203

Store and Forward Resources 206

Store and Forward Commands 211

Store and Forward Overview

Store and Forward is a system that enables you to design flexible,secure, and resilient communication

paths to move scan files through firewalls or other networking obstacles. Store and Forward works

together with Scanner Scheduler to maintain clear, uninterrupted paths between scanners and the Data

Flow Probe. For more information on Scanner Scheduler, see "Scanner Scheduler Overview" on page 190.

Each Store and Forward server uses a configuration file to determine its behavior. Depending on the

parameter values contained in the configuration file, a Store and Forward server may forward or route

scan files through logical "channels" that map to directories on one or more "upsteam provider" Store

and Forward servers. The last Store and Forward server in the system is the Data Flow Probe. A web

server that is installed together with the Store and Forward server continuously listens on a TCP port for

incoming scan files. Store and Forward servers support resumed file transfer.Monitoring statistics for

each Store and Forward server are available by accessing a web page that is hosted on each server.

To install the Store and Forward server, see "How to Install the Store and Forward Server" below.

To see support information, refer to the HP Universal CMDB Support Matrix document.

How to Install the Store and Forward Server

This task describes how to install the Store and Forward server. Perform this task for each computer

that you want to use as a Store and Forward server.

This task includes the following steps:
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l "Prerequisites" below

l "Copy the installation package" below

l "Install the Store and Forward server" below

l "Copy certificate files from upstream servers" on the next page

l "Configure the system behavior" on page 202

l "Results" on page 202

l "Additional operations" on page 203

1. Prerequisites

o Scanners are deployed in Manual Deployment mode.

o Scanners are configured to save scan files offsite. For more information, see "Scanner Options

Page" on page 639.

2. Copy the installation package

Note: Ensure that you copy installation files that are appropriate to the platform of the

computer that you want to install the Store and Forward server.

Windows:

From the UCMDB server, copy the MSI installation file from the following location to the computer

that you want to install the Store and Forward server:

UCMDB\UCMDBServer\tools\InventoryDiscovery\StoreAndForward

Linux:

From the UCMDB installation DVD, copy the hp-ud-store-and-forward-linux-x86-10.20.000.xxx.tar

installation file to the computer where you want to install the Store and Forward server.

3. Install the Store and Forward server

Windows:
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a. Double-click the MSI file. The main page of the installation wizard displays.

b. Navigate through the wizard. For more information about the wizard, see "Store and Forward

Installation Wizard " on page 203.

Linux:

a. Run the following command to decompress the archive file: tar -xzf <FileName>.tar.gz

b. Run the following command to switch to root user if not logged in as root already: su root

c. Run the following commands with root privileges to configure parameter values: ./configure

Note: The installation directory must be the current directory when you run this

command.

d. Enter the following information when prompted:

i. The TCP port that you want to use for the Store and Forward server service. The default

is 5005.

ii. The username that you want to use to authenticate to the web server that is hosting the

Store and Forward status page. The default is hpud.

iii. The password that you want to use together with the username to authenticate to the

web server that is hosting the Store and Forward status page. This field is mandatory.

iv. The communication protocol that you want to use between Store and Forward servers.

Enter 1 for HTTP (plain) or 2 for HTTPS (secure).

e. Start the service by running the following command with root privileges: /etc/init.d/hpudsaf

start

4. Copy certificate files from upstream servers

Note: This step is only applicable if the HTTPS (secure) communication protocol is used.

a. Copy the server.crt files of each upstream server to the computer that you are installing the

Store and Forward server. An upstream server is a server that you are forwarding scan files to.

This file is stored in the <DataDir>\Cert directory. For Windows, <DataDir> is configured
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in"Install the Store and Forward server" on page 200. For Linux, <DataDir> is the data folder in

the directory where you installed the Store and Forward server in "Install the Store and

Forward server" on page 200.

b. Rename each upstream server certificate file so that all files have unique names. For example,

server1.crt, server2.crt.

c. Concatenate all the certificate files from upstream servers into one file. Separate each

upstream server file with plus (+) signs. To do this, run the following command with root

privileges: copy /b <server1.crt> + <server2.crt> + <server3.crt> trustedcerts.crt. A file

named trustedcerts.crt is created.

d. Copy the trustedcerts.crt file to the <DataDir>\Cert directory of the computer that you are

installing the Store and Forward server.

Note: If the host name of any upstream server changes, perform this step again.

5. Configure the system behavior

Update the config.ini file to control the behavior of the Store and Forward server.

l The config.ini file is contained in the following location:

l Windows: The conf folder that is contained in the directory where you installed the Store

and Forward server.

l Linux: The conf folder that is contained in the directory where you installed the Store and

Forward server.

To see parameters that are available to update, see "Store and Forward Resources" on page 206.

Note: If you make changes to the configuration file, restart the Store and Forward server. For

more information, see "Results" below.

6. Results

o The Store and Forward server service and the Apache web server service start automatically

when the computer is started. For more information on names of services, see "Store and

Forward Resources" on page 206.
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o To verify the system is operating as expected, go to the following web page on each Store and

Forward server to view operating statistics: http://<StoreAndForwardServer>:<port>/server_

status.xml

Note: If the HTTPS communication protocol is used, type HTTPS instead of HTTP.

7. Additional operations

To throttle the upload bandwidth, perform the following:

a. Locate the http.conf file in the installation folder where you installed the program files.

b. Locate the following line: safbwInputLimit 0

c. Change 0 to any non-zero integer to specify the maximum bandwidth (in kilobytes).

For more information on Store and Forward concepts, see "Store and Forward Overview" on page 199.

For more information on Store and Forward operations and resources, see "Store and Forward

Resources" on page 206.

For more information on Store and Forward commands, see "Store and Forward Commands" on page

211.

Store and Forward Installation Wizard

Enables you to install and configure the Store and Forward server on a computer that is running

Windows.

To access From the UCMDB installation media, copy the following file to your local computer and

then double click to launch the wizard: HP Universal Discovery Store and Forward

server (x86) 10.20.000.xxx.msi.

Important

information

l This MSI installer is used for Windows computers only.

l The Windows computer must be running Microsoft Installer version 2.0 or above.

Related

Tasks

"How to Deploy the Scanner Scheduler" on page 190

See also "Store and Forward Overview" on page 199
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Wizard Map "Destination Folder Page" below > "Data Files Page" below> "Store and Forward

Configuration Page" below > "SSL Certificate Generation Page" on the next page

Destination Folder Page

Enables you to select a folder for the Store and Forward server program files.

Important

Information

The Windows computer must be running Microsoft Installer version 2.0 or later.

Wizard Map The "Store and Forward Installation Wizard" contains:

Destination Folder Page > "Data Files Page" > "Store and Forward Configuration

Page" > "SSL Certificate Generation Page"

UI Element (A–Z) Description

Change Click to browse to a folder that you want to contain the program files.

Data Files Page

Enables you to select a folder for the Store and Forward data files.

Important

Information

The Windows computer must be running Microsoft Installer version 2.0 or later.

Wizard Map The "Store and Forward Installation Wizard" contains:

"Destination Folder Page" > Data Files Page > "Store and Forward Configuration

Page" > "SSL Certificate Generation Page"

UI Element (A–Z) Description

Change Click to browse to a folder that you want to contain the data files.

Store and Forward Configuration Page

Enables you to make configurations for the Store and Forward server.
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Important

Information

The Windows computer must be running Microsoft Installer version 2.0 or later.

Wizard Map The "Store and Forward Installation Wizard" contains:

"Destination Folder Page" > "Data Files Page" > Store and Forward Configuration

Page > "SSL Certificate Generation Page"

UI Element Description

TCP Port Type a port number that listens for incoming scan files from downstream

servers.

Default: 5005

User name Type a user name to use to for the service.

Default: hpud

Password Type a password to use for the service.

Note: This is a mandatory field.

Communication

Protocol

Select a communication protocol that you want to use as the transport

mechanism when uploading scan files.

l HTTPS (secure)

l HTTP (plain)

SSL Certificate Generation Page

Enables you to make configurations to the certificate file if HTTPS is selected as the communication

protocol.

Important

Information

The Windows computer must be running Microsoft Installer version 2.0 or later.

Wizard Map The "Store and Forward Installation Wizard" contains:

"Destination Folder Page" > "Data Files Page" > "Store and Forward Configuration

Page" > SSL Certificate Generation Page
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UI Element (A–

Z) Description

DNS Name Enter the full computer name of the computer that is running the Store and

Forward server.

For example,somehost.example.com

Store and Forward Resources

Windows

By default, program files are installed in the following location:

<Program Files>\Hewlett-Packard\Universal Discovery\<VersionNumber>\Store and Forward

By default, data files, log files, and scan files that are in transit are stored in the following location:

<ALLUSERSPROFILE>\Application Data\Hewlett-Packard\Universal Discovery S&F

In addition, the following directories are created after installation.

Subdirectory Description

bin Contains the Apache web server executable files, DLL files, and the Store and Forward

server executable files

conf Contains the configuration files, including httpd.conf (the configuration file for the

Apache web server)

Note: The httpd.conf file contains parameters that control bandwidth throttling

modules Contains the Apache web server modules

Logs Contains the logs for the Apache web server and the Store and Forward server

Incoming Contains incoming scan files

InProgress Contains the files that the server is processing
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Subdirectory Description

Status Contains status files

Resume Contains scan files that are partially uploaded

The Windows service is registered with the following parameters:

Service attribute Value

Apache Service Name ovedApacheSF

Apache Display Name HP Universal Discovery Store and Forward Web Server

Apache Startup Type Automatic

Store and Forward Service Name ovedStoreAndForward

Store and Forward Display Name HP Universal Discovery Store and Forward Server

Store and Forward Startup Type Automatic

Linux

The following directories are created in the installation folder after installation.

File name Comment

bin Contains the Apache web server executable files, DLL files, and the Store and

Forward server executable files.

conf Contains the configuration files, including httpd.conf (the configuration file for the

Apache web server).

Note: The httpd.conf file contains parameters that control bandwidth

throttling.

data Parent data directory.

data/Logs Contains Apache web server and Store and Forward server log files.

data/Incoming Contains incoming scan files.
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File name Comment

data/InProgress Contains the files that the server is processing.

data/Status Contains status files.

data/Resume Contains scan files that are partially uploaded.

modules Contains the Apache web server modules.

The Linux service is registered with the following parameters:

Service attribute Value

Linux Service Name StoreNForward

Apache Service Name httpd

Status Information XML File Printout

In addition to using web-based methods to access status file information, data that is contained in this

file can also be accessed by external programs or scripts. The file resembles the following:

<?xml version="1.0" encoding="UTF-8"?>

<?xml-stylesheet type="text/xsl" href="server_status.xsl"?>

<StoreAndForwardStatus version="1.0">

<statusDirBytes>0</statusDirBytes>

<incomingDirBytes>0</incomingDirBytes>

<inProgressDirBytes>0</inProgressDirBytes>

<resumeDirBytes>0</resumeDirBytes>

<freeDiskSpaceBytes>50882215936</freeDiskSpaceBytes>

<numIncomingFiles>0</numIncomingFiles>

<numInProgressFiles>0</numInProgressFiles>

<numResumeFiles>0</numResumeFiles>

<modifiedTime>12/22/10 08:23:30</modifiedTime>

</StoreAndForwardStatus>
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Configuration File

The structure of the config.ini file is as follows.

Section Name Parameter Name Description

Log filterLevel Type default or debug. When debug is specified,

detailed logging is enabled.

rotateSizeMB Specifies the size of each log file. The Store and

Forward server can store the log information in

several log files.

rotationFileCount Specifies the number of log files to keep. When the

parameter value is reached, the oldest log file is

discarded.

[BaseDirectories] dataDir Specifies the location of the data directory. Normally,

it is not necessary to modify this setting because it is

configured automatically by the installer.

incomingDir Specifies the location of the Incoming directory.

Normally, it is not necessary to modify this setting, as

it is configured automatically by the installer.

[Channels] channelX Specifies the name for each channel. Channel names

are used to name the top level directory of the Store

and Forward server. The corresponding physical

directory is created under the Incoming directory of

the Store and Forward server.

[UpstreamProviders] providerX Specifies the URLs for upstream Store and Forward

servers. The URL should include the HTTP username

and password required to access the URL. When the

HTTPS protocol is used, the host name of the Store

and Forward server supplied in this URL must match

the host name given during the installation of that

Store and Forward server, as this host name is

encoded in the HTTPS certificate.

When configuring a Store and Forward server that is

installed together with the Data Flow Probe, use the
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Section Name Parameter Name Description

following configuration:

This key specifies the full path to a local directory. In

this case, the received file is copied to that directory,

or moved if the channel is mapped to only one

upstream provider. The only provider that is listed

should be the incoming directory of the XML Enricher,

as all files received by this Store and Forward server

will be moved automatically to the Incoming directory

of the XML Enricher.

[ChannelMapping] channelX Specifies how the files arriving to this channel will be

forwarded. One or more upstream Store and Forward

servers from the [UpstreamProviders] section should

be specified. Multiple servers are separated with

commas.

[StatusPage] updateFrequencyMins Specifies how frequently (in minutes) the status page

is updated.

The default is 20. If the setting is set to 0, the status

page is not updated.

Sample Configuration File

The following is a sample config.ini file that has two upstream Store and Forward servers configured,

two channels, and three providers:

[Log]

filterLevel=default

rotateSizeMB=10

rotationFileCount=5

[BaseDirectories]

dataDir=C:\ProgramData\Hewlett-Packard\DDMI S&F\

incomingDir=C:\ProgramData\Hewlett-Packard\DDMI S&F\Incoming\

[Channels]
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channel0=ddmi

channel1=hpca

[UpstreamProviders]

provider0=http://ddmi:ddm1passw0rd@ForwardS&Fserver1:5005/ddmi/

provider1=http://ddmi:ddm1passw0rd@ForwardS&Fserver2:5005/hpca/

provider2=http://ddmi:ddm1passw0rd@ForwardS&Fserver3>:5005/ddmi/

[ChannelMappings]

channel0=provider0,provider2

channel1=provider1

[StatusPage]

updateFrequencyMins=20

Store and Forward Commands

Commands that are available for the Store and Forward server service are as follows:

Windows

Description Command

Restart net start ovedStoreAndForward

Stop net stop ovedStoreAndForward

Uninstall Control Panel > Add/Remove Programs

Linux

Description Command

Restart /etc/init.d/hpudsaf restart

Stop /etc/init.d/hpudsaf stop

Uninstall 1. /sbin/chkconfig --del

hpudsaf
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Description Command

2. rm -rf /etc/init.d/hpudsaf
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Identifying Running Software by Processes

An application is identified by the existence of one or more running processes which are defined by their

names and by command line (optional).

A process can be optionally marked as a key process or as a main process.

An application is identified if the following holds true:
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l At least one process was found.

l All processes that are marked as key processes exist.

If an application is identified, a result RunningSoftware CI is created for the application obeying the

following rules:

l If none of the processes is marked as a main process, a single RunningSoftware CI will be created,

linked to all discovered processes by dependency relationships.

l If there are processes that are marked as main processes, a RunningSoftware CI will be created for

each instance of these main processes.

For example, assume that rules are defined for the identification of two applications, application_a and

application_b:

l application_a is identified by proc.exe and unique_ proc_a.exe.

l application_b is identified by proc.exe and unique_ proc_b.exe.

Say that proc.exe is found but none of its processes are marked as key or main processes. In this case,

RunningSoftware CIs are created for both application_a and application_b. These CIs are linked by a

dependency relationship to the same process (that is, proc.exe).

Assume too that unique_proc_a.exe and unique_proc_b.exe are marked as key processes:

l If the proc.exe process only is discovered, a RunningSoftware CI is not created.

l If unique_ proc_a.exe is discovered, RunningSoftware CIs are created for application_a linked by a

dependency link to unique_ proc_a.exe. If in addition, proc.exe is discovered, it is linked to the same

CI. The same holds for application_b.

Assume that two instances of unique_proc_a.exe are discovered:

l If the process is not marked as a main process, a single RunningSoftware CI is created for

application_a linked to both processes.

l If the process is marked as a main process, two separate RunningSoftware CIs are created for

application_a.

For details on the key field in the Software Identification Rule Editor dialog box, see "Identifying

Processes" on page 289.
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Automatically Deleted CIs and Relationships and

Candidates for Deletion CIs

During discovery, the Data Flow Probe compares CIs found during the previous, successful job invocation

with those found during the current job invocation. A missing component, such as a disk or software, is

assumed to have been removed from the system, and its CI is automatically deleted from the Probe's

database.

By default, the Data Flow Probe deletes CI instances of certain CITs, for example, the current

configuration for the Host Resources and Host Applications jobs (snmp: file system, installed software,

osuser, service).

DFM enables you to customize which CI instances the Probe should automatically delete for specific

jobs.

You can also mark a CIT as a candidate for deletion. In this case, if no CI instances of that CIT are

discovered, the CIT is isolated rather than automatically deleted. Carefully choose the CITs that are to

be candidates for deletion. For example, process CITs are not good candidates because they often shut

down and start up again and, as a result, may be deleted at every invocation.

Example of Automatic Deletion

During the previous job invocation, the Data Flow Probe ran the Host Resources by WMI job and

discovered a host with disks a, b, c, and d. During the current job invocation, the Probe discovers

disks a, b, and c, compares this result with the previous result. Since it finds that disk d is missing,

it deletes the CI for disk d.

Note:

l The Data Flow Probe does not wait for the aging mechanism to perform the calculation, but

immediately sends a deletion request to the server. For details about aging, see "The Aging

Mechanism Overview" in the HP Universal CMDB Administration Guide.

l The change is defined on the job's adapter.

l If discovery fails and errors occur, objects are sent for deletion according to how the results are

managed. For details, see "Adapter Configuration Tab" on page 252.

l You can use this procedure to delete relationships, too. For example, the containment
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relationship is used between a node and an IP address. A laptop machine is allocated a different

IP address very often. By deleting the relationship, you prevent the accumulation of old IP

addresses attached to this node.

l You can view deleted CIs in the Probe log and in the Deleted column in the Discovery Results

pane. For details, see "Data Flow Probe Log Files" on page 83 and "Discovery Results Tab/Pane"

on page 686.

For details on configuring automatic deletion, see "How to Configure the Data Flow Probe to

Automatically Delete CIs" on page 57.

How to Configure Adapter Settings

You should edit adapter and XML files in one of the following ways:

Change the adapter's definitions in the Adapter Management module

Note: This method is recommended.

1. Navigate to Data Flow Management > Adapter Management.

2. In the Resources pane, select the adapter file in the Packages > <package name> > Adapters

folder.

3. Do one of the following:

o To edit general adapter settings, use the Adapter Definition and Adapter Configuration tabs.

For details, see "Adapter Definition Tab" on page 244 and "Adapter Configuration Tab" on page

252.

o To define specific settings for the selected adapter, right-click the adapter and select Edit

Adapter Source from the shortcut menu.

Edit the adapter package and redeploy it using the Package Manager

Export the package to your local drive, edit the package and redeploy it. For information see, "How to

Export a Package" and "How to Deploy a Package" in the HP Universal CMDB Administration Guide.
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How to Define the Owner Tenant Adapter Parameter

In multi-tenancy environments, all discovered CIs/relationships are assigned an owner tenant. If an

owner tenant parameter is defined in the discovery adapter, the discovered CIs/relationships are

assigned this owner tenant.

If a job using the adapter has an override defined for this parameter, then the overriding value is

assigned to the discovered CI/relationship. For details, see "How to Define the Owner Tenant For a

Discovery Job" on page 469.

This task describes how to define an owner tenant parameter in an adapter.

Note: This section is relevant for multi-tenancy environments only .

1. Prerequisite

The owner tenant that you want to define in adapter's parameter must already be defined in

UCMDB. For details on creating owner tenants in UCMDB, see "New Tenant/Edit Tenant Dialog Box"

in the HP Universal CMDB Administration Guide.

2. In the Adapter Management module, select the adapter whose parameter you want to define.

3. Click the Adapter Definition tab.

4. In the Adapter Parameters pane, click the Add button:

a. In the Name box, type defaultOwner.

b. In the Value box, enter the name of the owner tenant in UCMDB that you want to define in the

adapter.

c. (Optional) Enter a description for the owner tenant parameter.

How to Configure Full Population Run

Because the UCMDB integration adapter only synchronizes changes, over time CIs are not touched and

are aged out. Therefore, by default, the UCMDB integration adapter runs a full population job every

seven days.
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Note: For other adapters, if the Allow Integration job to delete removed data check box is

selected, touch is performed automatically. If the check box is cleared, touch is not performed.

To change the full population value of the UCMDB integration adapter:

1. Open the CmdbAdapter adapter source.

a. Select Data Flow Management > Adapter Management > Resources pane > CmdbAdapter.

b. Under Adapters, right-click CmdbAdapter, and select Edit Adapter Source.

2. In the source file, locate the following tag:

<full-population-days-interval>

7

</full-population-days-interval>

3. Edit the value as follows:

Value Description

7 Run full population job every 7 days

1 Run full population job each day

0 Always run a full population job

-1 The option is disabled

How to Configure Global Probe Result Filtering

Global filtering enables you to filter Probe results for all adapters, so that only results of interest to you

are sent to the UCMDB Server.

You can also filter specific adapters. For details, see "Adapter Configuration Tab" on page 252.

This section includes:

Configure Filtering in UCMDB 220

Configure Filtering Using the globalFiltering.xml File 221
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Configure Filtering in UCMDB

This task describes how to use the UCMDB interface to filter the UCMDB CIs that are discovered.

1. Prerequisites

Before creating a filter, perform an analysis on what information you want to map and what data

element in the scan file contains the information you want to filter.

2. Select a CI to filter

a. Select Adapter Management.

b. In the Resources tree, expand the DDMiInfra node and then expand the Configuration Files

node.

c. Right-click GlobalFiltering.xml and select Open in Frame.

d. In the Global Filtering dialog box, click Include or Exclude.

l Include. All CIs that do not match the filter are removed. If this marker is left empty, all

results are sent to the server.

l Exclude. All CIs that match the filter are removed. If this marker is left empty, all results

are sent to the server.

e. Click Select CI Type . The Select CI Type dialog box opens.

Note: This option is only available when Include or Exclude is selected in the left pane.

f. Select a CI for which you want to create a filter, and click OK.

3. Select attributes to filter

a. Click Select Attribute . The Select an Attribute dialog box opens.

b. Select properties for the attribute, and click OK.

Data Flow Management Guide

Chapter 7: Adapter Configuration

HP Universal CMDB (10.22) Page 220 of 795



Note: You can use the "between" operator when filtering results, but only when the Object

class is “ip_address” and the attribute name is “name”.

For details on CI attribute types, see "Attributes Page" in the HP Universal CMDB Modeling Guide.

4. Activate and configure settings

In the Global Filtering Configuration Settings pane, select your options.

Available when: Global Filtering Configuration or Include or Exclude is selected in the left pane.

5. Results

Use the CI Type Manager to verify that data is filtered as expected in UCMDB. For more

information, see "CI Type Manager" in the HP Universal CMDB Modeling Guide.

Configure Filtering Using the globalFiltering.xml File

This document explains how to perform filtering using a manual method. If you want a UI-driven solution

to performing this task, see "Configure Filtering in UCMDB" on page 577.

Note:

l You can use regular expressions in filters.

l Attributes in the filter should be of type string only. For details on CI attribute types, see

Attributes Page in the HP Universal CMDB Modeling Guide.

l You can use the "between" operator when filtering results, but only when the Object class is “ip_

address” and the attribute name is “name”.

l A result is considered to be a match only if all filter attributes have the same values as those in

the CI. (If one of a CI's attributes is not specified in the filter, all the results for this attribute

match the filter.)

l A CI can match more than one filter. The CI is removed or remains according to the filter in

which it is included.

l Recursive Filtering. Using global filtering, you can filter out a CI so that it is not included in the

filter results. This CI may be a root CI, containing other CIs or relationships. By default, during
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the filter process, the contained CIs and relationships, as well as any CIs related to them, are

added to the filter results—including the root CI. This causes undesired filter results. Recursive

filtering corrects this by ensuring that if a root CI is filtered out, then any contained CIs or

relationships are filtered out too, such that the root CI cannot be found again.

To enable recursive filtering:

In the globalFiltering.xml file, under the resultFilters element, locate the recursiveFilter

attribute. (If the recursiveFilter attribute does not appear, then you must add it.) Set the

attribute value to true.

Note: By default, recursive filtering is true, that is recursiveFilter = true.)

l DFM filters first according to the <includeFilter> and then applies the <excludeFilter> on the

results of <includeFilter>.

Configure a Filter

Open the globalFiltering.xml file. (Adapter Management module > Resources pane > Packages > DDM

Infra > Configuration Files)

The code in displayed in the View pane:

<resultFilters>
<excludeFilter>

<vector />
</excludeFilter>
<includeFilter>

<vector />
</includeFilter>

</resultFilters>

l <excludeFilter>. When a vector marker is added to this filter, all CIs that match the filter are

removed. If this marker is left empty, all results are sent to the server.

l <includeFilter>. When a vector marker is added to this filter, all CIs that do not match the filter are

removed. If this marker is left empty, all results are sent to the server.

The following example shows an IpAddress CI that has address and domain attributes:

<vector>
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    <object class="ip_address">
        <attribute name="name" type="String">192\.168\.82\.17.*</attribute>
        <attribute name="routing_domain" type="String">DefaultProbe</attribute>
    </object>
</vector>

If this vector is defined in <includeFilter>, all results not matching the filter are removed. The results

sent to the server are those where the ip_address matches the regular expression 192\.168\.82\.17.*

and the ip_domain is DefaultProbe.

If this vector is defined in <excludeFilter>, all results matching the filter are removed. The results sent

to the server are those where the ip_address does not match the regular expression 192\.168\.82\.17.*

and the ip_domain is notDefaultProbe.

The following example shows how logical OR and logical AND statements can be created.

Example of 'OR' condition:

<vector>
<object class="ip_address">

<attribute name="name" type="String">192\.168\.82\.17.*</attribute>
</object>
<object class="ip_address">

<attribute name="name" type="String">192\.168\.82\.18.*</attribute>
</object>
<object class="ip_address">

<attribute name="routing_domain" type="String">DefaultProbe</attribute>
</object>

</vector>

If this vector is defined, all results where the IP address matches "192\.168\.82\.17.* " OR matches

"192\.168\.82\.18.* " OR routing_domain is "DefaultProbe" is filtered.

Example of 'AND' condition:

<vector>
<object class="ip_address">

<attribute name="name" type="String">192\.168\.82\.17.*</attribute>
<attribute name="routing_domain" type="String">DefaultProbe</attribute>

</object>
</vector>

If this vector is defined, all results where the IP address matches "192\.168\.82\.17.* " AND routing_

domain is "DefaultProbe" is filtered.

The following example shows an ip_subnet CI that has no attributes.
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<vector>
    <object class="ip_subnet">
    </object>
</vector>

Configure a Filter to Ignore Case

You can configure a filter to ignore case by prefixing a regular expression with (?i). For example, (?i)

DefaultProbe finds defaultprobe as well as DefaultProbe.

The following example removes all occurrences of the DefaultdoMain attribute because the vector code

is located in the <excludeFilter> section:

<resultFilters>
<excludeFilter>

<vector>
<object class="ip_address">

<attribute name="routing_domain" type="String">(?i)
DefaultdoMAin</attribute>

</object>
</vector>

</excludeFilter>
<includeFilter>

<vector />
</includeFilter>

</resultFilters>

How to Configure CI Aging Settings

This task explains how to configure the aging mechanism for adapters.

To learn more about aging, see "The Aging Mechanism Overview" in the HP Universal CMDB

Administration Guide.

To enable aging of CIs:

1. Select the adapter: Adapter Management > Resources pane > Packages > <adapter>

2. In the Adapter Configuration tab, under Results Management, select an Enable Aging option as
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follows:

System

Default

Enables aging of CIs using the default aging setting defined in each CI type's

attribute settings.

For details, see "Configuration Item Properties Dialog Box" in the HP Universal

CMDB Modeling Guide.

Always

Enabled

Always enables aging of CIs discovered by jobs that use this adapter.

Note: When this option is selected, the default aging setting defined in each

CI type's attribute settings is ignored.

Always

disabled

Disables aging of CIs discovered by jobs that use this adapter.

Note: This option overrides the default aging setting defined in each CI type's

attribute settings.

3. Save your changes.

How to Define CITs to be Deleted by Java-based Population

Adapters

This task describes how to define CITs to be deleted by population jobs that use Java-based population

adapters.

1. Open the population adapter's configuration file.

2. Under the <taskInfo> tag, locate the <remove-cis> tag.

If this tag does not exist, create it.

3. Under the <remove-cis> tag, add the CITs to be removed using the format in the following

example:

<remove-cis isEnabled="false">
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<ci-type>link</ci-type>

<ci-type>object</ci-type>

</remove-cis>

4. Save the configuration file.

Note: When defining integration jobs that use the population adapter, to configure the job to

delete CITs as defined in the adapter, ensure that the Allow Integration Job to delete removed

data option is selected . For details, see "New Integration Job/Edit Integration Job Dialog Box" on

page 345.

How to Attach Discovery Documentation to a Discovery

Package

This task describes how to attach updated or new documentation to a discovery package.

1. Prerequisites

a. Create the help document in PDF format.

b. Create a folder called docs, and copy your PDF into that folder.

c. Zip the docs folder, and copy it to your local file system.

2. Deploy the document on the UCMDB server

Navigate to Administration > Package Manager, and click the Deploy packages to server

button to deploy the .zip file containing the PDF you want to deploy. For details, see "How to Deploy

a Package" in the HP Universal CMDB Administration Guide.

3. Attach the document to the relevant discovery package

a. Navigate to Data Flow Management > Adapter Management.

b. In the Resources pane, expand the adapter file: Packages > <package name> > Adapters and

select the adapter to which to attach the document.

c. Do one of the following:
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l In the Adapter Definition tab, under Details, click the Edit button adjacent to the

Content Help box, and select the help document that you deployed.

l Right-click the adapter and select Edit Adapter Source from the shortcut menu. Look for

RelatedDocument in the code, and replace the line with:

<RelatedDocument>name_of_pdf.pdf</RelatedDocument>

where name_of_pdf is the name of the help document you deployed.

How to Attach a Readme to a Discovery Package

This task describes how to attach an updated or new Readme file to a discovery package.

1. Prerequisite

To attach a Readme file to a discovery package, the package's .zip file must be located somewhere

on your local file system.

If you are updating the Readme file of a discovery package that is already deployed on your UCMDB

server, you must export the package's .zip file to your local file system before attaching the

updated file. For details on exporting packages, see "How to Export a Package" in the HP Universal

CMDB Administration Guide.

2. Add the Readme file to the discovery package's .zip file

o Create or update the Readme file, and save it with the name, Readme.txt.

o Copy the Readme.txt file into the root of the package's .zip file.

3. Deploy the package on the UCMDB server

Navigate to Administration > Package Manager, and click the Deploy packages to server

button to deploy the .zip file containing the Readme. For details, see "How to Deploy a Package" in

the HP Universal CMDB Administration Guide.
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How to View Discovery Resource History

Discovery resources are saved to the URM on the UCMDB Server and from there are distributed to all

the Data Flow Probes.

Whenever a user changes the definition of a resource, an updated version of the resource is stored in

the URM. The URM keeps all the historical revisions of each resource.

You can view changes between an older version and the current version of resources such as discovery

scripts, integration and discovery adapters, discovery jobs, and so on, from the JMX console of the

UCMDB Server.

Note: The purpose of this task is to describe how to access the discovery resources in the JMX

console for the purpose of viewing the resources and their history only.

Adding or modifying a discovery resource in the JMX console is not supported.

To view a discovery resource and its history:

1. Log in to the UCMDB JMX console. For details, see How to Access the JMX Console in the HP

Universal CMDB Administration Guide.

2. In the UCMDB JMX Quick Search box, enter listResourceTypes.

3. Enter your Customer ID. (Default: 1)

4. Click Invoke. The URM Services mbean is displayed.

5. Among the UCMDB resource types displayed on this page, the following discovery resource types

are displayed:

Resource Type Description

Displays

Diff Metadata

Displays

Diff Content

Discovery_ADAPTER_

METADATA

Adapter resources ü ü

Discovery_CONFIGURATION_

FILE_METADATA

Configuration Files ü ü
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Resource Type Description

Displays

Diff Metadata

Displays

Diff Content

Discovery_JOB_METADATA Discovery job definitions ü ü

Discovery_MODULE_

METADATA

Discovery modules ü ü

Discovery_WIZARD_

METADATA

Activity types ü ü

Discovery_SCRIPT_

METADATA

Script resources ü ü

Discovery_BIN_RESOURCE_

METADATA

External resources ü û

Discovery_DOC_METADATA PDF documents that come

with the adapters

ü û

Discovery_MULTI_SCANNER_

METADATA

Multiple scanner packages ü û

Discovery_SCANNER_

CONFIG_METADATA

Scanner configuration files ü û

Discovery_SAI_RES_

METADATA

SAI resources ü û

6. Click a resource type to view all the resources of that type.

7. To see the history of a particular resource, click the history link in that resource's row.

A page opens displaying the current version of the resource, as well as all its previous revisions.

8. Click the Diff Content link to view the actual change. All changes between the selected and current
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revisions are displayed.

Note: The Diff Content link appears only for those resources whose changes you are able to

see (see table above).

How to Create and Configure Mapping Files Using the

Visual Mapping Tool

The new mapping tool enables you to create, update, or delete mapping files in a visual way. You can

configure both link root-based TQL queries and CI root-based TQL queries.

Prerequisites

l You have deployed any Generic Adapter package, or the package for any of the latest out-of-the-

box adapters (Asset Manager Generic Adapter or the SM 9.40 Adapter)

l You have established an integration point with Asset Manager or Service Manager, or your custom

adapter/integration that uses the Generic Adapter Framework

l The integration is activated

How to Open and View a Supported Mapping File Using the Visual

Mapping Tool

The current version of the Visual Mapping tool supports the following mapping files:

l Enhanced Generic Push Adapter mapping files

l Generic Adapter mapping files for Population, Federation and Push scenarios

To open and view a supported mapping file using the visual mapping tool

1. Navigate to Data Flow Management > Adapter Management.

2. In the Resources pane, expand the Packages > <package name> > Configuration Files folder.
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3. Do one of the following:

o Click a mapping file and click Yes in the popup window that asks if you want to open the

configuration file with the new mapping tool editor.

o Right-click a mapping file and select Open Mapping Tool from the context menu

o Click a mapping file and click the Open Mapping Tool icon at the top of the script pane, or

o In the Configuration Files pane, double click a mapping file and click Yes in the popup window

that asks if you want to open the configuration file with the new mapping tool editor.

The new mapping tool editor window opens, with tree representation of local and external class

models loaded and displayed.

Note: In case the integration point provides a null external class model, you can still open the

Visual Mapping tool. An empty default class model will be displayed in the External Class Model

pane instead.

Note: If you open an old Enhanced Generic Push Adapter mapping file using the Visual Mapping

tool, you will be asked if you want to convert the file to the new schema and that if you want

to use the visual mapping tool as the default editor.

4. To view the entities and attributes of the UCMDB TQL or the external class model, expand the

relationship type hierarchical tree in the Local Query pane or the External Class Model pane.

How to Create a Mapping File Using the Visual Mapping Tool

To create a mapping file using the visual mapping tool

1. Navigate to Data Flow Management > Adapter Management.

2. In the Resources pane, expand the Packages > <package name> > Configuration Files folder.

<package name> indicates the adapter package in where you want to create the new mapping file.

3. Click the Create new resource icon at the top of the Resource pane, and select New

Configuration File.
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4. In the Enter a Name dialog that pops up, provide values as described in the table below.

Field Description

Name Enter a name for the new mapping file.

Naming convention for new mapping files:

<adapter_name>/mappings/push/<filename>.xml

For example, <adapter_

name>/mappings/population/customDataPopulation.xml.

Note: You must specify the adapter name and include push or

population in the name.

Package Click for the Package field, then in the Select Package dialog

that pops up, select a package and click OK.

The new mapping file is created.

5. Open the new empty mapping file in the mapping tool editor, and edit the attribute mappings as

necessary.

For details, see "How to Edit and Update a Mapping File Using the Visual Mapping Tool" below.

Note:

o For push scenario, you can add multiple roots, and you can select which one to use.

o You can have duplicated source_instance nodes as long as the root-element is different.

6. Click Validate Mapping File to validate the mapping file you just created.

7. Click Save .

How to Edit and Update a Mapping File Using the Visual Mapping

Tool

You can do the following to edit or update a mapping file using the visual mapping tool:
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To edit or modify the mapped target attribute value for a specific attribute

mapping

You can use one of the following methods:

l Quick action. Locate a corresponding entity in the External Class Model pane, and then select a

desired attribute value in the External Class Model Attributes pane, and then click the green arrow

button ( or ) to add the value to the mapping in the Visual Mapping pane.

l Drag and drop. After selecting a desired attribute value in the External Class Model Attributes pane,

simply drag and drop the value to the Visual Mapping pane to update the selected mapping.

l Auto-complete. Directly type in the target attribute value field and select a desired value to update

the mapping. The auto-complete suggestions are generated based on valid existing relationships

between entities from the external class model or from the local TQL query.

When you type a character, the first level suggestions will appear. Usually these are all first level

CITs from the external class model that match the string or items from the local TQL query.

After you type or select a valid CIT entity:

o If you enter the "." character, you obtain suggestions for linked CITs based on existing

relationships from the external class model or from the local TQL query.

For example, you have a Computer to Node relationship,

l if you type Computer, Node will appear in the suggestions list.

l if you type Node, Computer will not appear unless you have another relationship from Node to

Computer.

o If you enter the "[" character, you obtain attribute suggestions for the current CIT:

l For local TQL query, attributes are filtered with the Element Layout feature.

l For external class model, all attributes are displayed.

The Visual Mapping tool can also provide auto-complete suggestions on possible methods from

imported Groovy scripts. For example, you have a mapping file that imports the

mappings.scripts.AMPushFunctions Groovy script, if you write an attribute value like

AMPushFunctions, you should receive a list of possible method names; If you write an attribute value

like AMPushFunctions.get, you should receive a list of possible method names that start with get.
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l Edit the mapping value in the XML Editor directly. You can directly edit the XML mapping value in

the XML Editor pane below the Visual Mapping pane to update the mapping.

To add a new attribute mapping for the selected target_entity tag

1. In the Local Query pane, select a UCMDB entity.

2. To add a UCMDB attribute to the Visual Mapping pane, in the Local Query Attribute pane, select a

desired attribute and click the green arrow button ( or , depending on the push, population,

or federation scenario).

To add a source attribute from a different UCMDB TQL query,

a. From the Query drop-down list, select a different UCMDB TQL query.

If the desired TQL is not in the drop-down list, click Add TQL Queries . In the Add Queries

dialog box, select and add an available integration TQL query from the Available items pane to

the Selected items pane, then click OK.

b. Expand the TQL query representation.

c. Select a UCMDB entity that corresponds to the parent target_entity tag in the Visual Mapping

pane where you want to add the new UCMDB attribute.
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d. In the Local Query Attributes pane, select an attribute and click the green arrow button ( or

, depending on the push, population, or federation scenario) to move the attribute to the

Visual Mapping pane.

3. Add a mapping attribute value from the External Class Model entity to the Visual Mapping pane.

To do so, follow one of the following methods:

o Quick action. Locate a corresponding entity in the External Class Model pane, and then select a

desired attribute value in the External Class Model Attributes pane, and then click the green

arrow button ( or ) to add the value to the mapping in the Visual Mapping pane.

o Drag and drop. After selecting a desired attribute value in the External Class Model Attributes

pane, simply drag and drop the value to the Visual Mapping pane to update the selected

mapping.

o Auto-complete. Directly type in the target attribute value field and select a desired value to

update the mapping. The auto-complete suggestions are generated based on valid existing

relationships between entities from the external class model or from the local TQL query.

o Edit the mapping value in the XML Editor directly. You can directly edit the XML mapping

value in the XML Editor pane below the Visual Mapping pane to update the mapping.

To update the mapping file for the selected source_instance or target_entity tag

Do one of the following:

l Update Info Tag. Clicking this button opens the Update Info Tag dialog box, enabling you to

modify and update the information about the data repositories being integrated, including Name,

Version, and Vendor for both source and target data repositories.

l Update Import Tag. Click this button opens the Update Import Tag dialog box, enabling you to

select and add available items and import new groovy scripts. You can also move up or down the

sequence of a script to decide the order of scripts to be imported.

l Update Optional Tags. Clicking this button opens the Update Optional Tags dialog box, enabling

you to update optional tags by defining values for the Type, Is Valid, and Is Delected fields. You can
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also select the Show Warning check box to display warning messages.

Note: This button is not available for the source_entity tag.

To add a new mapping element to the existing mapping file

Select the parent source_instance or target_entity element of your interest, and do the following to

add the source element:

l Add For Each Tag. Clicking this button opens the Add For Each Tag dialog box, enabling you to

define the source and the index for the tag that you want to add for each child mappings under the

current parent entity:

o Source Entities. Defines the source entities for the tag.

o Count Index. Defines the iteration loop index ("i") that can be used to reference the currently

iterated element. For example, pc.ip[i].

o Var Name. (Optional) Specifies the variable name for the tag.

Each time you edit a field you will see a notification of what attribute will be edited.

l Add Variable Tag. Clicking this button opens the Add Variable Tag dialog box, enabling you to

define and add variable tags to the selected variable element:

o Name. Specifies name for the variable.

o Type. Select a value from the drop-down list as type of the variable in database.

o Value. Specifies a value for the variable.

Note: This button is not available for the source_instance tag.

l Add Custom Section. Enables you to add an empty section in the Visual Mapping pane, allowing

you to manually define a new mapping element that may not fall into any of the existing mapping

categories, including customized XML tags.
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After adding an empty section in the Visual Mapping pane by clicking the Add Custom Section

button, you can edit the empty section in the XML Editor pane. Clicking Save in the XML Editor

saves the code.

Note: To save the entire mapping file, click Save for the entire Visual Mapping tool window.

To use the "is-valid" XML attribute inside attribute mappings to indicate valid

attributes

When creating attribute mappings such as the one below, you may have a use case to ignore certain

attribute mappings within a target entity based on some custom logic:

This can be done via the newly added is-valid XML attribute on the target_mapping XML tag.

If you change the mapping line for the description attribute to use the new XML attribute, you get

something like this:

<target_mapping name="description" is-valid="CustomFunctions.isSupportedType
(Computer['name'])" datatype="STRING" value="Computer['name']"/>

where CustomFunctions.isSupportedType(Computer['name']) represents a Groovy expression that will

result in a boolean value (true means the attribute is valid, false means the attribute will be ignored).

For a quick check you can use any simple expression like "1 == 1" or "true".

Relevant log lines are also available. For example, if the expression is invalid, you will see the following

log statements in the fcmdb.push.all.log or fcmdb.push.mapping.log:

2014-08-14 14:07:56,974 [JobExecuterWorker-0:DS_ga_test] TRACE - >> Execution of
is-valid expression [1 == 2] = [false]

Data Flow Management Guide

Chapter 7: Adapter Configuration

HP Universal CMDB (10.22) Page 237 of 795



2014-08-14 14:07:56,974 [JobExecuterWorker-0:DS_ga_test] DEBUG - >> Ignoring
invalid property [description] from target entity [Root]

And, if the expression is valid you will simply see:

2014-08-14 14:06:39,660 [JobExecuterWorker-0:DS_ga_test] TRACE - >> Execution of
is-valid expression [1 == 1] = [true]

To configure the icons for the external entities

1. Open the icon-related mapping file for the adapter.

For example, for AM Generic Adapter, open the am-entity-config.xml file.

For Service Manager adapter, open the icon.properties file.

2. Locate the icon type tag for the CIT of your interest in the mapping file.

For example, for AM Generic Adapter, it is icon-type.

3. Modify the value for icon type tag with a UCMDB icon value as needed.

For available UCMDB icons, check Modeling > CI Type Manager > Icon tab.

4. Click Save.

5. Open a desired mapping file, click the Refresh External Class Model button, the icons should

be updated.

To configure the positions of Local Query and External Class Model panes on left or

right

To do so,

1. Go to Administration > Infrastructure Settings Manager.

2. In the Categories pane, select GUI Settings.

3. In the Name column, locate the Switch between external and local tree panels in the integration

mapping tool setting.

Data Flow Management Guide

Chapter 7: Adapter Configuration

HP Universal CMDB (10.22) Page 238 of 795



4. In the Value column, click the value for the setting you selected, and then choose a value from the

drop-down list.

The default value for this setting is False.

5. Click Save .

The change takes effect immediately.

To search for CI types or attributes in the Local Query or External Class Model panes

You can search for a CI type or an attribute in both of the Local Query, External Class Model, and their

Attributes panes the same way as you do in the Script pane.

You can use * as a wildcard character to search inside the text.

To remove a mapping element from the mapping file

To remove a target_entity or target_mapping tag from the mapping file, select the desired mapping

element, and click Remove Node .

To remove the entire mapping

To remove the entire mapping, select any tag in the Visual Mapping pane and click Clear Entire Mapping

.

To revert to the last saved change

To revert to the last saved change, click Revert Changes .

To validate the changes you made to the entire mapping

Click Validate Mapping File to validate the changes you just made to the mapping file.

Note: Although the Visual Mapping tool supports all mapping files, the following configurations are

not supported:

l Non-instance based adapters: The UCMDB enhanced push adapter works with instance based

adapters. (For more information, see the HP Universal CMDB Developer Reference Guide).
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l Mappings containing both CI root and link root TQL queries in the same file.

l Mappings having wildcard tags that select multiple TQL queries for a target mapping.

In case you wish to edit an existing mapping file that references one of the above mentioned cases,

you may see that the Open Mapping Tool option is not available, or an error message stating that

the mapping file is unsupported and that only manual XML editing is possible.

How to Synchronize Class Model Changes to External System

through Push Adapter

With the new mapping tool, you can create new CI types and attributes for external class model in

Universal CMDB and synchronize the changes in real time to the external system. This enables you to

manage class model changes on both systems centrally from Universal CMDB.

To synchronize class model changes to external system through push adapter

1. Open an existing mapping file using the Visual Mapping tool.

The external tree is populated with a class model.

2. In the External Class Model pane, select a node.

3. Create and synchronize a CI type.

a. Click Add New CI Type to External Class Model in the toolbar for the External Class Model

pane.

The Add New CI Type to External Class Model dialog box opens, comprising of general section

and metadata section.

The fields in the metadata section are populated dynamically as specified in the external

system (passed through the adapter).

Note: If you already selected a CIT before you click Add New CI Type to External Class

Model , the new CIT is created as a child CIT of the selected node; If no CIT is selected,

the new CIT is created as a root CIT.

Data Flow Management Guide

Chapter 7: Adapter Configuration

HP Universal CMDB (10.22) Page 240 of 795



b. Define the following standard properties for the new CI type:

l Name. Specify the name for the new CI type.

l Description. (Optional) Detailed description of the CI type.

c. Click OK.

The new CIT synchronization is triggered and the save operation runs as a background task.

Until the status of the save operation is confirmed, the newly created CIT appears as greyed

out in the external tree.

After the save is successful, the CIT turns into a selectable tree node, and the node can be

further used in mappings and drag and drop scenarios.

In case the save operation failed, the CIT will not appear in the external tree anymore, and an

error notification appears at the top of the Visual Mapping pane.

4. Create and synchronize an attribute.

You can similarly create new attributes for a selected CIT and synchronize the change to the

external system. To do so,

a. In the External Class Model Attributes pane, click Add New Attribute to Selected External

Node on the toolbar.

The Add New Attribute dialog box that opens.

There is no metadata section in this dialog box.

b. Define the following properties for the new attribute:

l Name. Specify the name for an attribute property.

l Display Name. Specify the display name for an attribute property.

l Description. (Optional) Detailed description of the attribute property.

l Type. Select a value from the drop-down list as type of the attribute property in database.

c. Click OK.
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The new attribute synchronization is triggered and the save operation runs as a background

task.

Until the status of the save operation is confirmed, the newly created attribute appears as

grayed out in the external attributes table.

After the save is successful, the attribute turns into a selectable attribute entry, and the

attribute can be further used in mappings and drag and drop scenarios.

In case the save operation failed, the attribute will not appear in the external attributes table

anymore, and an error notification appears at the top of the Visual Mapping pane.

Pre/Post-Scan Script Editor

Enables you to edit pre and post scan scripts in your Management Zones.

To access l Adapter Management > Inventory Discovery > expand Adaptors

> Inventory Discovery by Scanner > expand the Global Configuration

Files pane, select the PrePostScanScriptingConfiguration file and click

Edit .

l Data Flow Management > Universal Discovery > Zone-based Discovery

> Inventory Discovery Activity > Preferences tab > select Scanner

based Inventory Discovery and click Edit Script.

Important

information

UI elements are available only when a script file is selected in the left pane.

Relevant tasks "How to Edit Pre-/Post-Scan Scripts" on page 540

See also "Inventory Discovery Scanners" on page 505

User interface elements are described below:

UI

Element Description

Find Text. Opens the Find Text dialog box, enabling you to find text in the selected script

file. For more information, see "Find Text Dialog Box" on page 268.
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UI

Element Description

Go to Line. Opens the Go To Line dialog box, enabling you to jump to a specific line in the

script file. Enter the line number and press Enter.

Import a File. Opens the Import File dialog box, enabling you to import a script file or a

resource file.

Export to a File. Opens the Export File dialog box, enabling you to export the selected

script or resource file.

Pre-Scan and Post-Scan Scripts

Scripts can be run by the Scanner on discovery nodes. Scripts are typically created to capture custom

data on specific hardware, settings, or applications. Scripts together with related files are packaged

with the Scanner and deployed to a remote machine. You can create a script using any external text

editor and import into UCMDB, or you can create it using an embedded text editor.

The pre-scan scripts run at scanner start-up before the hardware and software scanning. The post-

scan scripts run after the hardware and software scanning is complete.

To see more information on how to edit pre and post scan scripts, see "How to Edit Pre-/Post-Scan

Scripts" on page 540.

Note: If you create a post-scan script, you may want to map your captured data to a UCMDB

attribute using the Hardware Mapping Configuration tool. To do this, see "How to Map Scan File

Attributes to UCMDB" on page 569.

Adapter Management User Interface

This section describes:

Adapter Definition Tab 244

Adapter Configuration Tab 252

Adapter Management Window 258

Adapter Source Editor Window 259
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Attributes Assignment Editor Dialog Box 260

Choose Discovered Class Dialog Box 262

Configuration File Pane 263

Edit Process Dialog Box 265

Find Resource/Jobs Dialog Box 267

Find Text Dialog Box 268

Input Query Editor Window 269

Mapping Tool Editor Window 273

Permission Editor Dialog Box 281

Resources Pane 282

Script Pane 285

Software Identification Rule Editor Dialog Box 288

Software Library Dialog Box 290

Global Filtering Dialog Box 291

Adapter Definition Tab

Enables you to define an adapter by specifying which CITs the adapter should discover and which

protocols are needed to perform discovery.

To access Select Adapter Management > Resources pane > Packages > <adapter>.

Relevant

tasks

"Implement a Discovery Adapter" in the HP Universal CMDB Developer Reference

Guide

User interface elements are described below:

UI Element (A–Z) Description

Adapter Category Used to arrange adapters by category.

Content Help The Help document associated with the adapter, in PDF format.

To change the Help document associated with the adapter, do one of the

following:
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UI Element (A–Z) Description

l Click and select the relevant PDF file.

l Right-click the adapter in the Packages tree and click Edit adapter source.

Find the following line in the code:

<RelatedDocument>name_of_pdf.pdf</RelatedDocument>

and change the name of the PDF file.

To detach the selected Help document, click .

Description A detailed description of the adapter's purpose, including relevant comments.

Display Name A display name to identify the adapter.

Type l For Discovery adapters: jython

l For Integration adapters: can be of various types

Used as

Integration

Adapter

Select to define that this adapter is an integration adapter.

Note: These adapters cannot be used for defining discovery jobs, and are

accessible only through the Integration Studio.

Input Pane

User interface elements are described below:

UI

Element

(A–Z) Description

Input CI
Type

The input CIT is used as the adapter input. For details, see "Define Adapter Input (Trigger

CIT and Input Query)" in the HP Universal CMDB Developer Reference Guide.

Click the button to choose a CIT to use as the input.

Edit Input Query. Enables you to edit the input query.

Remove Input Query. Enables you to delete the input query.
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UI

Element

(A–Z) Description

Input

Query

Defines a query for validation of the triggered CIs for jobs that run this adapter. (CIs

matching the job's triggered query must match the Input query as well.)

l Click the Edit Input Query button to open the Input Query Editor window.

l Click the Remove Input query button to remove the Input query from the

adapter.

To define which CIs can be Trigger CIs for jobs that run a specific adapter, see "Input

Query Editor Window" on page 269. For more information, see "Trigger CIs and Trigger

Queries" on page 26.

For an example of an input query definition, see "Example of Input Query Definition" in

the HP Universal CMDB Developer Reference Guide.

Note:

l Because this field is optional, not all adapters include an Input query. None

signifies this adapter does not have an Input query definition.

l To ensure that the Data Flow Probe is always kept up to date with possible

changes to the Trigger CI data, you can configure UCMDB to periodically

recalculate the Trigger CI data and send any changes to the Data Flow Probe. For

details, see "How to Configure Periodic Data Flow Task Updates" on page 54. This

option is disabled by default because it can interfere with performance.

Triggered

CI Data

. Add Trigger CI data to the adapter.

. Remove Trigger CI data from the adapter.

. Edit the Trigger CI data in the Parameter Editor dialog box.

l Name. The information that is needed to perform a task on a specific CI. This

information is passed to the CI queried in the task.

Important: Do not use id for a Triggered CI Data entry, as it is a reserved name.

l Value. The attribute value. Variables are written using the following syntax:
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UI

Element

(A–Z) Description

${VARIABLE_NAME.attributeName}

where VARIABLE_NAME can be one of three predefined variables:

o SOURCE. The CI that functions as the task's trigger.

o HOST. The node in which the triggered CI is contained.

o PARAMETERS. The parameter defined in the Parameter section.

You can create a variable. For example, ${SOURCE.network_netaddr} indicates that

the trigger CI is a network.

Used Scripts Pane

Displays the scripts used by the selected adapter.

Important Information Available for Jython adapters only

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI

Element

(A–Z) Description

Move up/Move down. Enables you to change the order of the scripts. DFM runs the

scripts in the order in which they appear here.

Add script. Enables you to add a script to the adapter.

Remove script. Enables you to remove a script from the adapter.

Edit. Enables you to edit the selected script in the Script Editor that opens.

<Scripts> A list of Jython scripts used by the adapter.

Workflow Steps Pane

Displays only the workflow element of the selected adapter script.
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Important Information Available: Only for the adapters that contain workflows

Example: UDAgentManagement adapters

User interface elements are described below:

UI Element

(A–Z) Description

Find text. Enables you to find specific text in the workflow steps. For details, see "Find

Text Dialog Box" on page 268.

Go to line. Enables you to jump to a specific line in the workflow steps. In the Go To

Line dialog box, enter the line number, and press ENTER.

Open External Editor. Opens the workflow steps in an external text editor.

Prerequisite: Click the Edit the External Editor Preferences button to define the

path to an external editor. If no external editor path is defined, you will be prompted to

provide one when you try to open the external editor.

Edit the External Editor Preferences. Click to edit the external editor preferences.

You can run the editor by adding flags to the path.

Note: You cannot specify the file name. Instead, you can use flags relevant to your

external editor to retrieve the file name, such as :file.

In the following example, :file sets the place of the file in relation to the flags.

If no flags are defined, the file name is automatically added to the end of the

path.

Switch Editor Mode. Enables you to switch between the default advanced editor and a

simple text editor.

Validation

Information

Displays if the definition is valid or not:
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UI Element

(A–Z) Description

l . Indicates that the definition is valid.

l . Indicates that there is an error in the definition.

Required Permissions Pane

Enables you to view the permissions that you have configured for an adapter.

To access Select Data Flow Management > Adapter Management > an adapter > Adapter

Definition tab > Required Permissions pane.

Important

Information

l Workflow:
o Configure the permissions in the Permission Editor dialog box.

o View the permissions in this pane.

o When working with jobs in the Universal Discovery window, view these

permissions for a specific job.

l For details on the fields in this pane, see "Permission Editor Dialog Box" on page

281.

See also l "Permission Editor Dialog Box" on page 281

l "Discovery Permissions Window" on page 491

l "Viewing Permissions While Running Jobs" on page 460

User interface elements are described below:

UI

Element

(A–Z) Description

Add. Opens the Permission Editor dialog box, enabling you to add a permission object. The

Permission Editor dialog box opens. For details, see "Permission Editor Dialog Box" on page

281.
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UI

Element

(A–Z) Description

Edit. Opens the Permission Editor dialog box, enabling you to edit a selected permission

object. For details, see "Permission Editor Dialog Box" on page 281.

Remove. Enables you to delete a selected permission object.

Move up/Move down. Enables you to change the order of the permissions. Select the

permission object and click the up or down button. The order given here is the order in

which the credentials are verified.

Export Data to File. Enables you to export a permission object in Excel, PDF, RTF, CSV, or

XML format. For details, see "Browse Views Mode" in the HP Universal CMDB Modeling

Guide.

Required Discovery Protocols Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element

(A–Z) Description

Add required protocol. Enables you to add a required protocol.

Remove required protocol. Enables you to remove an existing protocol that is no

longer required.

<Protocols> List of protocols required by the adapter for the task. For example, the NTCMD

protocol, together with its user name, password, and other parameters, is needed for

DFM to access a Windows system.

For information, see "Supported Protocols" in the HP UCMDB Universal Discovery

Content Guide - Supported Content.

Discovered CITs Pane

User interface elements are described below:
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UI

Element

(A–Z) Description

Add Discovered CIT. Opens the Choose Discovered Class dialog box, enabling you to select

a CIT to be discovered by the adapter. For details, see "Choose Discovered Class Dialog

Box" on page 262.

Remove Discovered CIT. Enables you to remove the CIT from the list of CITs that the

adapter discovers.

View Discovered CITs as Map. Opens the Discovered CITs Map window enabling view a

graphical map of the CITs and relationships that are discovered by the adapter.

CITs List of CITs that the adapter discovers.

Global Configuration Files Pane

Enables you to add default configuration files to the adapter, as well as the specific configuration files

that the adapter needs.

Important

Information

The applicationsSignature.xml file contains a list of all applications that DFM

attempts to find in the environment.

The configuration file applicationsSignature.xml opens the Software Library dialog

box. For details, see "Software Library Dialog Box" on page 290.

Relevant

tasks

"How to Discover Running Software – Scenario" on page 466

User interface elements are described below:

UI Element

(A–Z) Description

Add. Opens the Global Configuration Files dialog box, enabling you to select

configuration files that are needed by the adapter.

Remove. Enables you to delete a selected configuration file.

Edit. Opens the selected configuration file in an appropriate editor.

For example, the file msServerTypes.xml opens the Script Editor.
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Adapter Parameters Pane

User interface elements are described below:

UI

Element

(A–Z) Description

Add Parameter. Opens the Parameter Editor dialog box, enabling you to enter details

about a new parameter. The value you enter here is assigned to the attribute.

Remove Parameter. Enables you to remove a selected parameter.

Edit Parameter. Opens the Parameter Editor dialog box, enabling you to make changes to

the parameter definition.

Name Each row represents the definitions for one parameter.

Value Separate values with commas.

Adapter Configuration Tab

Enables you to define additional options relevant to adapter execution and result filtering.

To access Select a specific adapter in the Resources pane and click the Adapter

Configuration tab.

Important

Information

Click the Save button to save any changes you make.

See also "DataFlowProbe.properties File" on page 68

Trigger Dispatch Options Pane

Enables you to specify dispatch options for triggers.

UI Element (A–

Z) Description

Override

default probe

Defines the Probe to use with the adapter. For more information, see "Override

Probe Selection - Optional" in the HP Universal CMDB Developer Reference Guide.
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UI Element (A–

Z) Description

selection

Supports IPv6 When selected, indicates that the adapter can connect to a remote machine via

IPv6 addresses, and can handle IPv6 results in the output.

Note: If this option is not selected for an adapter, and no IPv4 addresses are

found for the trigger, the trigger is not dispatched to the Probe.

Execution Options Pane

User interface elements are described below:

UI Element (A–Z) Description

Create

communication log

Choose to create a log file that logs the connection between the Probe and a

remote machine.

l Always. A communication log is created for this session.

l Never. A communication log is not created for this session.

l On Failure. A communication log is created for this session, only if the

execution fails.

That is, DFM reports an error (report of a warning does not create a

communication log). This is useful when you need to analyze which

queries or operations take most of the time, send data for analysis from

different locations, and so on. If the job completes successfully, no log is

created.

When requested (in the Discovery Progress pane), a log retrieved from the

Probe is displayed (if a log has been created). For details, see "Discovery

Progress Dialog Box" on page 677.

Note: For debug purposes, you can always retrieve the communication

logs for the last 10 executions, even if Create communication logs is set

to On Failure.
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UI Element (A–Z) Description

Communication log files are created on the Probe Manager under the

C:\hp\UCMDB\DataFlowProbe\runtime\

communicationLog folder. For details on how the communication logs work,

see "Record DFM Code" in the HP Universal CMDB Developer Reference Guide.

Note: CDATA mechanism is used to store information retrieved from

user environment in the communication logs. When scan files get some

characters or XML segments that cannot be parsed by the CDATA

mechanism, the information will be saved in binary format for further

troubleshooting purpose. HP Software Support will decode the binary

data in the communication logs to perform troubleshooting.

Include results in

communication log

Select to enable capturing the discovered results with the created

communication log; these discovered results may help in investigating

various discovery problems.

Max. execution time The maximum time allowed for an adapter to run on one Trigger CI.

Max. threads Each job is run using multiple threads. You can define a maximum number of

threads that can be used concurrently when running a job. If you leave this

box empty, the Probe's default threading value is used (8).

The default value is defined in the DataFlowProbe.properties file, in the

appilog.agent.local.services.defaultMaxJobThreads parameter.

Note: The jobs in the Network – Host Resources and Applications

module require a permanent connection to the Probe's internal

database. Therefore, these jobs are limited to a maximum number of 20

concurrent threads (which is the maximum number of concurrent

connections permitted to the internal database). For details, see "Host

Resources and Applications Discovery" in the HP UCMDB Discovery and

Integrations Content Guide.

Results Management Pane

User interface elements are described below:
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UI Element

(A–Z) Description

Enable

aging

The aging mechanism specifies how long a period must pass in which CIs are

discovered, before DFM treats these CIs as no longer relevant and removes them.

Choose from one of the following aging options:

l System Default: Use the system's default value for the Enable Aging attribute of

each CI type.

l Always Enabled: Select this option to always enable the aging mechanism.

l Always Disabled: Select this option to always disable the aging mechanism.

The value you set here is for each CI result that is reported to the UCMDB by the jobs of

this adapter.

For details on aging, see "The Aging Mechanism Overview" in the HP Universal CMDB

Administration Guide.

Enable

Automatic

Deletion

Choose between:

l Always. Automatic Deletion or Candidate for Deletion is always enabled, regardless

of whether discovery succeeds or fails.

l On Success or Warnings. Automatic Deletion or Candidate for Deletion is enabled

only when discovery finishes with a success or warning status. In the case of a

discovery error, nothing is removed and CIs are not marked as a candidate for

deletion.

l Only on Success. Automatic Deletion or Candidate for Deletion is enabled only when

discovery finishes with a success status. In the case of a discovery error or warning,

nothing is removed and CIs are not marked as a candidate for deletion (this is the

default).

Selecting this option enables the Automatic Deletion box where you select specific

CITs for deletion or as candidates for deletion, if the Data Flow Probe does not find

them during its next invocation.

To select CITs, click the Add button. In the Choose Discovered Class dialog box,

choose the CITs that should be automatically deleted.

The changes you make here are added to the adapter configuration file, for example:
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UI Element

(A–Z) Description

<resultMechanism isEnabled="true">

    <autoDeleteCITs isEnabled="true">

        <CIT>shell</CIT>

 <candidateForDeletionCIT>node</candidateForDeletionCIT>

    </autoDeleteCITs>

</resultMechanism>

For information about how the Data Flow Probe handles CI deletion, see "Automatically

Deleted CIs and Relationships and Candidates for Deletion CIs" on page 216.

Note for Java-based population adapters: In order for CITs to be deleted by the

population engine, you must configure the adapter configuration file manually as

described in "How to Define CITs to be Deleted by Java-based Population Adapters" on

page 225.

Enable

collecting

'Discovered

by' data

l Selected. DFM collects data on the results of running the adapter. This data is then

used to enable rediscovery of CIs. The data is necessary for the Discovery tab in IT

Universe to function correctly. It is also used for the View Based Discovery Status

functionality which leverages the data to aggregate the complete discovery status

for certain views.

l Cleared. DFM does not collect this data. The check box needs to be cleared for

adapters where rediscovery is not helpful. For example, the Range IPs by ICMP job

has this check box cleared by default because its Trigger CI is the Probe Gateway

and so all CIs discovered by this job have the same Trigger CI. If the check box was

not cleared, a rediscovery attempt on any view containing any single IP would result

in a ping sweep throughout the entire customer network—certainly not desirable

behavior.

The job results of this adapter are displayed in the Discovery for View dialog box only if

this check box is selected. For details, see "How to Check the Status of Application

Discovery (Rediscover a View)" and "Show Discovery Status and Changes Dialog Box" in

the HP Universal CMDB Modeling Guide.

Enable When selected, the Data Flow Probe reports empty values for discovered properties to
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UI Element

(A–Z) Description

reporting

of empty

values

UCMDB.

Default: Enabled

Enable

update

'Last

Access

Time'

When selected, if a CI is touched when a discovery or integration job runs, the Last

access time property of the CI is updated. This indicates that the CI represents an

active component in the system, and prevents the CI from becoming a deletion

candidate.

For details about the aging mechanism and deletion candidates, see "The Aging

Mechanism Overview" in the HP Universal CMDB Administration Guide.

Note: If this option is not selected:

l For new CIs, the Last access time property is given the same value as the

Create Time property

l For existing CIs, subsequent activations of the job do still update the

LastModifiedTime property, but the Last access time property is not updated.

Use-Case Example

When importing data from an external data source, this data may include

meta-data about CIs. If this option is enabled, the CIs are updated with the

metadata and their Last Access Time value is updated. Disabling this option

can be useful if you do not want to affect the aging status or the deletion

candidacy of these CIs. In this case, the information is added to the CIs but

their Last Access Time remains unchanged.

Fail entire

bulk if

invalid CIs

are found

If a set of objects (for example, 1,000 objects) includes even one invalid CI (for example,

a node cannot be identified because of missing topological information), the

reconciliation engine drops the entire set and does not send it to the CMDB. This is the

default behavior.

If this option is not selected, the results are still sent to the CMDB but without the

invalid CIs (and their topology). In the above example, 999 objects would be processed.

UCMDB displays an error message when you view the results.

Available for: Discovery adapters and Jython-based integration adapters only
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UI Element

(A–Z) Description

Initiate

agent

connection

When this option is selected, the adapter finds a credential to work with an agent so

that other discovery adapters can connect to the agent.

Result Grouping Pane

User interface elements are described below:

UI Element

(A–Z) Description

Grouping

Interval

(Seconds)

To group results in the Probe before they are sent to the server, type the value that

indicates how long results are stored in the Probe before being transferred to the

server.

The default value is 30 seconds.

Note: If you enter a value in both boxes, DFM applies the value of whichever

occurs first.

Max. CIs in

group

Specify the number of CIs that should accumulate in the Probe before being

transferred to the server.

The default value is 5000.

Adapter Management Window

Enables you to view or edit default parameter values used for the discovery and integration processes.

To access Select Data Flow Management > Adapter Management or right-click a job in the

Universal Discovery window and click Go to Adapter.

Important

Information

l An asterisk (*) next to a resource (adapter, script, or configuration file) signifies

that the resource has changed since the package (in which it is included) was

deployed. If the original package is redeployed, the changes are deleted from the

resource. To save the changes, move the resource to a new package and deploy

the package (the asterisk disappears).
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l Only administrators with an expert knowledge of the discovery and integration

processes should delete packages.

See also l "Adapter Definition Tab" on page 244

l "Global Configuration Files Pane" on page 251

l "Adapter Configuration Tab" on page 252

l "Script Pane" on page 285

l "Resources Pane" on page 282

l "Configuration File Pane" on page 263

l HP UCMDB Discovery and Integrations Content Guide

Adapter Source Editor Window

Enables you to edit an adapter script.

To access Right-click an adapter in the Resources pane and select Edit Adapter Source.

See also "Resources Pane" on page 282

User interface elements are described below:

UI Element (A–

Z) Description

Find text. Enables you to find specific text in the adapter definition. For details,

see "Find Text Dialog Box" on page 268.

Go to line. Enables you to jump to a specific line in the adapter definition. In the Go

To Line dialog box, enter the line number, and press ENTER.

Open External Editor. Opens the adapter definition in an external text editor.

Prerequisite: Click the Edit the External Editor Preferences button to define

the path to an external editor. If no external editor path is defined, you will be

prompted to provide one when you try to open the external editor.

Edit the External Editor Preferences. Click to edit the external editor

preferences. You can run the editor by adding flags to the path.
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UI Element (A–

Z) Description

Note: You cannot specify the file name. Instead, you can use flags relevant to

your external editor to retrieve the file name, such as :file.

In the following example, :file sets the place of the file in relation to the flags.

If no flags are defined, the file name is automatically added to the end of the

path.

Switch Editor Mode. Enables you to switch between the default advanced editor

and a simple text editor.

Validation

Information

Displays if the definition is valid or not:

l . Indicates that the definition is valid.

l . Indicates that there is an error in the definition.

l . Indicates that the definition could not be validated.

Note: This may occur due to an internal error while performing the

validation. This does not, under any circumstances, harm the process of

saving your definition to the server. See %temp%\UcmdbLog\error.log for

details. For further assistance, contact HP Software Support.

Attributes Assignment Editor Dialog Box

Enables you to define a regular expression that discovers specific running software according to a CIT's

attribute value.
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To access In the Software Identification Rule Editor dialog box, click .

Relevant tasks "How to Discover Running Software – Scenario" on page 466

See also "Software Identification Rule Editor Dialog Box" on page 288

User interface elements are described below:

UI Element

(A–Z) Description

Attribute

assignments

for Type

Enables you to manage rules that discover a CIT according to an attribute. The

attribute is defined according to a regular expression.

l / / . Enable you to add/edit/remove an attribute assignment.

l Name. Choose from the list of attributes of the CIT selected in the editor. This

attribute name is replaced by the value found by the regular expression. To find

an attribute, start typing the name.

l Type. The type of operation defined for the attribute, for example, Boolean,

string, date, and so on.

l Value. The value that replaces the name in the Rule ID field in the Parse Rule

Editor dialog box (see "Parsing Rules" below).

Use the following syntax for the value:

${<rule ID name>(<group number>)}

For example, ${DB_SID(1)} means that DFM should search for the Rule ID with the

name DB_SID and retrieve its regular expression.

DFM should then retrieve the code for the first group (1). For example, in the

regular expression .+\s+(\w+)$, the first group is (\w+)$, that is, a word or words

that appear at the end of the line.

Parsing Rules Enables you to manage parsing rules that match attribute to process-related

information.

Note: Only users with a knowledge of regular expressions should make changes

to a parse rule.
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UI Element

(A–Z) Description

l / / . Enable you to add/edit/remove a parsing rule.

l Rule ID. The name of the rule. The Rule ID must be unique. It is needed to identify

the rule in the Attributes Assignment Editor pane.

l Process Attribute. The rule is invoked on the selected process-related attribute.

l Regular Expression. Enables you to create a dynamic expression that finds at

least one process that defines this running software. The regular expression is

invoked on the value in the Process Attribute field.

For example, a command line process includes the following regular expression:

.+\s+(\w+)$

This expression searches for any character, followed by a space or spaces,

followed by a word or words (a-z or A-Z or 0-9) that appear at the end of the line.

The following command line matches this regular expression:

c:\ora10\bin\oracle.exe UCMDB

Choose Discovered Class Dialog Box

Enables you to choose CITs that are to be discovered by a selected adapter and to limit links so that

they are mapped only when they connect specific CITs.

To

access

Select Data Flow Management > Adapter Management > Resources pane > an adapter.

l In the Adapter Definition tab > Discovered CITs pane, click the Add Discovered CIT

button.

l In the Adapter Configuration tab > Results Management pane, select the Enable

Automatic deletion check box and click the Add button in the Automatic Deletion pane.
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User interface elements are described below:

UI

Element

(A–Z) Description

Link Enables DFM to discover CITs only when they are linked by link types you choose in this box.

Select a link type from the list and click the button in the End 1 and End 2 boxes to

open the Choose Configuration Item Type dialog box. Choose the CITs that DFM should map

when they are linked by the selected link type.

DFM automatically recognizes the links between CIs and adds them to the map of

discovered CITs. However, during adapter writing, you may need to exclude links between

certain CITs.

For example, both nodes and IPs and nodes and ports are linked by usage. You might need

to receive results only for those nodes and IPs that are connected by the usage link, and

not for nodes and ports. The End 1 and End 2 links determine the result received from the

adapter, and this result is reflected in the map, as can be seen in the following example:

Note: This section is relevant only when adding a discovered CIT, not for defining CITs

for automatic deletion.

Object Select a CIT to be added to the list of CITs that an adapter is to discover. Save the changes

by clicking the Save button at the bottom of the Adapter Definition pane.

Configuration File Pane

Enables you to edit a specific configuration file that is part of a package. For example, you can edit the

portNumberToPortName.xml file so that specific port numbers, names, or types are discovered.
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To access Click a specific configuration file in the Resources pane.

Important

Information

The Editor is sensitive to the type of file (.xml, .properties, or .groovy) and displays

words with context specific meanings as highlighted text.

The following files are for internal use only and should only be changed by users with

an advanced knowledge of adapter-writing:

l discoveryPolicy.xml

l jythonGlobalLibs.xml

For details, see "How to Define Discovery Rules" on page 305 and "Internal

Configuration Files" on page 293.

User interface elements are described below:

UI

Element

(A–Z) Description

Find specific text in the configuration file. For details, see "Find Text Dialog Box" on page

268.

Click to go to a specific line in the configuration file. In the Go To Line dialog box, enter the

line number.

Click to opens the configuration in an external text editor.

Prerequisite: Click the Edit the External Editor Preferences button to define the path

to an external editor. If no external editor path is defined, you will be prompted to provide

one when you try to open the external editor.

Edit the External Editor Preferences. Click to edit the external editor preferences. You

can run the editor by adding flags to the path.

Note: You cannot specify the file name. Instead, you can use flags relevant to your

external editor to retrieve the file name, such as :file.

In the following example, :file sets the place of the file in relation to the flags.
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UI

Element

(A–Z) Description

If no flags are defined, the file name is automatically added to the end of the path.

Click to toggle between the advanced editor and a simple text editor. You can use the

simple editor when the advanced editor causes problems.

For XML files, signifies that the code is valid.

For XML files, signifies that the code is not valid.

Edit Process Dialog Box

Enables you to add a process that can identify specific running software.

To access In the Software Identification Rule Editor dialog box, in the Identifying Processes

pane, click Add .

Relevant

tasks

"How to Discover Running Software – Scenario" on page 466

See also l "Attributes Assignment Editor Dialog Box" on page 260

l "Software Identification Rule Editor Dialog Box" on page 288

User interface elements are described below:

UI Element Description

Name The name of the processes that can identify specific running software, for example,

java.exe.
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UI Element Description

l Select Starts with to use a process that starts with the string entered in this field.

l Select Ignore Case. to ignore the case of the string entered in this field.

Port The port number or name.

Enter the port number or click Add to select the ports in the Global Ports List.

l If the process has to listen at a specific port, the port should be listed. You can enter

more than one port, separated by commas, for example, 8888,8081,8080,

81,8000,82,80.

l If the process does not have to listen at a specific port (that is, the running software

can use any port), select the All Ports option.

Note: To enable discovery of processes that are not listening at any of the ports

entered in the Port field (that is, identification is by process name only), select Port

match is optional.

If Port match is optional is not selected, processes are discovered based on the

process name and the port number entered in the Port field.

Command

Line

The running software can also be mapped using the process name. In this case, you

must add a process command line (or part of it) with which the process name uniquely

identifies the software, for example, c:\\ora10\\bin\\oracle.exe UCMDB.

Owner The name of the user that must run the matching process.

Service

Endpoint

Name

The name of port to be reported as an IpServiceEndpoint CI linked to discovered

RunningSoftware and used to discover the port number.

Main

process

Select this check box to mark this process as a unique and distinguishing process. For

such processes there need to be several instances of the software CI.

Key

Process

Select this check box if, during discovery, Universal Discovery must distinguish between

applications that run similar processes (for example, IP, port, command line, or owner).

For an explanation of this box, see "Identifying Running Software by Processes" on page

214.

Parsing

Rules

Enables you to manage parsing rules that match attribute to process-related

information.
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UI Element Description

Note: Only users with a knowledge of regular expressions should make changes to

a parse rule.

l / / . Enable you to add/edit/remove a parsing rule.

l Rule ID. The name of the rule. The Rule ID must be unique. It is needed to identify

the rule in the Attributes Assignment Editor pane.

l Process Attribute. The rule is invoked on the selected process-related attribute.

l Regular Expression. Enables you to create a dynamic expression that finds at least

one process that defines this running software. The regular expression is invoked

on the value in the Process Attribute field.

For example, a command line process includes the following regular expression:

.+\s+(\w+)$

This expression searches for any character, followed by a space or spaces, followed

by a word or words (a-z or A-Z or 0-9) that appear at the end of the line.

The following command line matches this regular expression:

c:\ora10\bin\oracle.exe UCMDB

Find Resource/Jobs Dialog Box

Enables you to build a search query to find a particular resource or job.

To

access

Do one of the following:

l Select Universal Discovery > Discovery Modules/Jobs > Discovery Modules tree. Click

the Find Job button.

l Select Adapter Management > Resources pane. Click the Find resource button.

See

also

"Resources Pane" on page 282

User interface elements are described below:
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UI Element

(A–Z) Description

Click to select a CIT from the dialog box that opens. Click OK to return to the Find

Resource dialog box.

Note: This button is not accessible when Name is selected.

Direction Searches forwards or backwards through the packages.

Find All Click to highlight all instances of the text entered in Name.

Find

Discovery

Job by/

Find

Discovery

resource by

Choose between:

l Name. Enter the name, or part of it, of the resource.

l Input type/Adapter input type. CIs that trigger the job. Click the button to open

the Choose Configuration Item Type dialog box. Locate the CI type that you are

searching for.

l Output type/Adapter output type. CIs that are discovered as a result of the job or

the adapter.

Find Next The next job/resource meeting the search criteria is highlighted in the Discovery

Modules/Resources pane.

Find Text Dialog Box

Enables you to find text in a script or configuration file.

To access Select a script or configuration file and click the Find text button in the file pane.

User interface elements are described below:

UI Element (A–Z) Description

l Click Find to find one instance of the text you are searching for.

l Click Find All to find all instances of the text.

Direction Search forwards or backwards through the script or configuration file.

Find what Type the text to be found or click the down arrow to choose from previous

searches.
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UI Element (A–Z) Description

Click the adjacent arrow to display a list of symbols you can use in wildcard or

regular expression searches. This arrow is enabled when you select the Use

option.

Options Select an option to narrow your search.

Origin Enables a search of the entire scope or from the current cursor position.

Target l Global. Searches throughout the file.

l Selected Text. Searches through the selected text.

Input Query Editor Window

Enables you to define which CIs can be Trigger CIs for jobs that run a specific adapter.

To access Select Data Flow Management > Adapter Management > select an adapter

> Adapter Definition tab > Input pane, and click the Edit Input Query button

next to the Input Query box.

Important

information

To ensure that the Data Flow Probe is always kept up to date with possible

changes to the Trigger CI data, you can configure UCMDB to periodically

recalculate the Trigger CI data and send any changes to the Data Flow Probe.

For details, see "How to Configure Periodic Data Flow Task Updates" on page

54. This option is disabled by default because it can interfere with

performance.

See also l "Trigger CIs and Trigger Queries" on page 26

l "Trigger Query Editor Window" on page 497

User interface elements are described below:

UI Element (A–Z) Description

<Panes> l "CI Type Selector Pane" on the next page

l "Editing Pane" on the next page

l "Information Pane" on page 271

Query Name The name of the adapter's Input query.

Data Flow Management Guide

Chapter 7: Adapter Configuration

HP Universal CMDB (10.22) Page 269 of 795



CI Type Selector Pane

Displays a hierarchical tree structure of the CI Types found in the CMDB. For more details, see "CI Type

Manager User Interface" in the HP Universal CMDB Modeling Guide.

Note: The number of instances of each CIT in the CMDB is displayed to the right of each CIT.

To access To create or modify a query, click and drag nodes to the Editing pane and

define the relationship between them. Your changes are saved to the CMDB.

Note: Each time you select the same object from the tree, you must

rename the object node to have a unique name.

Relevant tasks l "How to Define a TQL Query" in the HP Universal CMDB Modeling Guide

l "How to Create a Pattern View" in the HP Universal CMDB Modeling Guide

See also "How to Add Query Nodes and Relationships to a TQL Query" in the HP

Universal CMDB Modeling Guide

Editing Pane

User interface elements are described below:

UI Element (A–Z) Description

<node> Hold the cursor over a node to view information about the node:

<right-click

menu>

For details, see "Shortcut Menu Options" in the HP Universal CMDB Modeling

Guide.
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UI Element (A–Z) Description

<Toolbar> For details, see "Toolbar Options" in the HP Universal CMDB Modeling Guide.

Information Pane

Displays the properties, conditions, and cardinality for the selected node and relationship.

Important Information Hold the pointer over a node to view information:

A small green indicator is displayed next to the tabs that include

information:

User interface elements are described below:

UI Element

(A-Z) Description

Attributes Displays the attribute conditions defined for the node or the relationship. For details,

see "Attribute Tab" in the HP Universal CMDB Modeling Guide.
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UI Element

(A-Z) Description

Cardinality Cardinality defines how many nodes you expect to have at the other end of a

relationship. For example, in a relationship between node and IP, if the cardinality is 1:3,

the query retrieves only those nodes that are connected to between one and three IPs.

For details, see "Cardinality Tab" in the HP Universal CMDB Modeling Guide.

Details l CI Type. The CIT of the selected node/relationship.

l Visible. A tick signifies that the selected node/relationship is visible in the topology

map. When the node/relationship is not visible, a box is displayed to the right of

the selected node/relationship in the Editing pane:

l Include subtypes. Display both the selected CI and its descendants in the topology

map.

Note: To change the visible and subtype settings, select a node in the Editing pane

and click the Edit button. In the Query Node Properties dialog box, select or clear

the boxes.

Edit

button

Select a node or relationship in the Editing pane and click the Edit button to open the

Query Node Properties dialog box. For details, see "Query Node/Relationship Properties

Dialog Box" in the HP Universal CMDB Modeling Guide.

Qualifiers Displays the qualifier conditions defined for the node or the relationship. For details,

see "Qualifier Tab" in the HP Universal CMDB Modeling Guide.

Selected

Identities

Displays the element instances that are used to define what should be included in the

query results. For details, see "Identity Tab" in the HP Universal CMDB Modeling Guide.
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Mapping Tool Editor Window

Enables you to configure value and field mappings in a visualized way for complex integration

configurations for data push, population, or federation integration scenarios.

To access Select Data Flow Management > Adapter Management > Select a specific

adapter in the Resources pane > Expand the Configuration Files folder:

l Click a mapping file and click Yes in the popup window that asks if you

want to open the configuration file with the new mapping tool editor

l Right-click a mapping file and select Open Mapping Tool from the

context menu

l If you chose to open the mapping file with the XML editor, you can switch

to the Mapping Tool by clicking the Open Mapping Tool icon at the top

of the Script pane

Or, in the Configuration Files pane, double click a mapping file and click Yes in

the pop-up window that asks if you want to open the configuration file with

the new mapping tool editor.

Important

information

The Mapping Tool window title bar includes the actual physical location of the

script. For example, the following script is located in

C:\hp\UCMDB\DataFlowProbe\runtime\probeManager\

discoveryConfigFiles/AMPushAdapter/mappings

(or probeGateway\AMPushAdapter/mappings)

See also l "How to Create and Configure Mapping Files Using the Visual Mapping

Tool" on page 230

User interface elements are described below:

UI Element (A–Z) Description

Save. Saves the changes you made to the mapping file.
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UI Element (A–Z) Description

Validate Mapping File. Validates the mapping file you created, edited, or

modified.

Open XML Editor. Enables you to switch back to the default script editor.

<Panes> l "Local Query Pane" below

l "(Local Query) Attributes Pane" on the next page

l "Visual Mapping Pane" on page 276

l "External Class Model Pane" on page 278

l "(Local Query) Attributes Pane" on the next page

l "XML Editor Pane" on page 280

Local Query Pane

Displays a hierarchical tree structure of the local TQL query in the CMDB.

Relevant tasks l "How to Define a TQL Query" in the HP Universal CMDB Modeling Guide

l "How to Create a Pattern View" in the HP Universal CMDB Modeling Guide

See also "How to Add Query Nodes and Relationships to a TQL Query" in the HP

Universal CMDB Modeling Guide

User interface elements are described below:

UI Element Description

Query: <Query Name>. Displays the name of the currently selected

integration TQL query found in CMDB.

Add TQL Queries. Opens the Add Queries dialog box, enabling you to

select and add available integration TQL queries from the Available

items pane to the Selected items pane, so that you can map items from

them.

Refresh TQL Query Representation. Refreshes the query
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UI Element Description

representation.

Expand All. Expands the entire hierarchical tree structure to display all

of the items available under the integration TQL queries.

Collapse All. Collapses the hierarchical tree structure, leaving the top-

level integration TQL query showing.

(for Population or

Federation scenario)

Add Node to Mapping for Population scenario. Enables you to add the

selected node to the mapping.

(for Push scenario) Add Node to Mapping for Push and Federation scenarios. Enables you to

add the selected node to the mapping.

(Local Query) Attributes Pane

The Attributes pane for the Local Query pane displays attributes of a local integration TQL query.

User interface elements are described below:

UI Element (A–Z) Description

(for Population or

Federation scenario)

Add Attribute to Mapping. Enables you to add the selected attribute to

the mapping.

(for Push scenario) Add Attribute to Mapping. Enables you to add the selected attribute to

the mapping.

<Attributes table> The Attributes table contains the following columns:

l Status. Status of an attribute.

l Display name. Display name of an attribute.

l Name.Name of an attribute.

l Type. Type of an attribute.

l Description. Detailed description of an attribute.
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Visual Mapping Pane

Allows you to establish mappings for items you selected from the Local Query pane and the External

Class Model pane in a visual way.

User interface elements are described below:

UI

Element

(A-Z) Description

Update Info Tag. Opens the Update Info Tag dialog box, enabling you to modify and

update the information about the data repositories being integrated, including Name,

Version, and Vendor for both source and target data repositories.

Update Import Tag. Opens the Update Import Tag dialog box, enabling you to select and

add available items and import new groovy scripts. You can also move up or down the

sequence of a script to decide the order of scripts to be imported.

Update Optional Tags. Opens the Update Optional Tags dialog box, enabling you to

update optional tags by defining values for the Type, Is Valid, and Is Deleted fields. You

can also select the Show Warning check box to display warning messages.

Note: This button is not available for the source_instance element.

Add For Each Tag. Opens the Add For Each Tag dialog box, enabling you to define the

source and the index for the tag that you want to add for each child mappings under the

current parent entity:

l Source Entities. Defines the source entities for the tag.

l Count Index. Defines the start index when iterating over the source entities.

l Var Name. (Optional) Specifies the variable name for the tag.

Add Variable Tag. Opens the Add Variable Tag dialog box, enabling you to define and add

variable tags to the selected variable element:

l Name. Specifies name for the variable.

l Type. Select a value from the drop-down list as type of the variable.

l Value. Specifies a value for the variable.
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UI

Element

(A-Z) Description

Note: This button is not available for the source_instance element.

Add Custom Section. Enables you to add an empty mapping element, where you can

manually define a new mapping element that may not fall into any of the existing

mapping categories.

Revert Changes. Allows you to revert the changes you just made.

Clear Entire Mapping. Enables you to clear the entire mapping.

Remove Node. Enables you to remove a selected node or attribute mapping association

from the mapping file.

Expand All. Expands the entire hierarchical tree structure to display all of the mapping

elements.

Collapse All. Collapses the hierarchical tree structure, leaving the top-level integration

mapping showing.

<Groovy

Function

Viewer>

Each time you select a target mapping that contains a groovy function, this component is

displayed.

Also, when you edit a target mapping and fill in some groovy function, you can preview the

code of that function.

Note: The current version supports only one function per line.

<In the

Visual

Mapping

pane>

The visual representation of mapping relationship elements inside the Visual Mapping

pane are described below:

l - Represents the root integration tag in the Visual Mapping pane.

l - Represents a source_instance root element. The Root Element Name attribute

field is editable in the Visual Mapping pane.

l - Represents a target_entity element. This is the default icon. The icon of any
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UI

Element

(A-Z) Description

target_entity can be customized at the adapter level. For details, see Configure Icons

for Mapping Entities.

l - Represents a variable mapping element. The Name attribute, Datatype, and

Value attribute fields are all editable. When you edit the value in the Value attribute

field, the groovy function viewer shows up, allowing you to view the XML script for the

groovy function.

l - Represents an attribute mapping of the target_mapping element.

o For population and federation scenarios, the name value is read-only, and the

Value attribute field is editable.

o For push scenario, both the Name attribute and Value attribute fields are

editable.

l - Represents a for-each-source-entity tag. You can define values for the Source

Entities attribute, Count Index attribute, and Var Name attribute fields.

l - Represents a custom tag that you define.

External Class Model Pane

Displays a hierarchical tree structure of the external class model.

User interface elements are described below:

UI Element Description

Refresh External Class Model. Refreshes the external class model.

Expand All. Expands the entire hierarchical tree structure to display all of the

items available under the external class model.

Collapse All. Collapses the hierarchical tree structure, leaving the top-level
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UI Element Description

external class model showing.

Add New CI Type to External Class Model. Opens the Add New CI Type to

External Class Model dialog box, enabling you to define the following properties

for a new CI type so as to add the new CI type to the external class model:

l Name. Specify the name for the new CI type.

l Description. (Optional) Detailed description of the CI type.

Note: This button is enabled only if the adapter setting

enable.classmodel.changes is set to true inside the Adapter Source Editor.

(for Push

scenario)

Add Node to Mapping. Enables you to add the selected node to the mapping.

(for

Population or

Federation

scenario)

Set Node as Root Element. Enables you to set the selected node as root element

in the mapping.

(External Class Model) Attributes Pane

The Attributes pane for the External Class Model displays attributes of an external class model.

User interface elements are described below:

UI Element (A–Z) Description

(for Push

scenario)

Add Attribute to Mapping. Enables you to add the selected attribute to the

mapping.

(for Population

or Federation

scenario)

Add Attribute to Mapping. Enables you to add the selected attribute to the

mapping.

Add New Attribute to Selected External Node. Opens the Add New Attribute

dialog box, enabling you to define the following properties for a new attribute

so as to add it to the selected external node:
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UI Element (A–Z) Description

l Name. Specify the name for an attribute property.

l Display Label. Specify the display label for an attribute property.

l Description. (Optional) Detailed description of the attribute property.

l Type. Select a value from the drop-down list as type of the attribute

property.

Note: This button is enabled only if the adapter setting

enable.classmodel.changes is set to true inside the Adapter Source Editor.

<Attributes table> The Attributes table contains the following columns:

l Status. Status of an attribute. indicates that the concerning attribute is

marked as Mandatory inside the adapter configuration.

l Display name. Display name of an attribute.

l Name. Name of an attribute.

l Type. Type of an attribute.

l Description. Detailed description of an attribute.

XML Editor Pane

User interface elements are described below:

UI

Element Description

Find Text. Opens the Find Text dialog box, enabling you to find text in the selected script

file. For more information, see "Find Text Dialog Box" on page 268.

Go to Line. Opens the Go To Line dialog box, enabling you to jump to a specific line in the

script file. Enter the line number and press Enter.

Save. Saves the changes you made to the mapping configuration file.
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UI

Element Description

<Script

Editing

Pane>

Displays the XML script and allows you to edit the script manually. The script displayed in

the XML Editor pane corresponds to the hierarchical tree element you selected in the

Mapping UI pane.

Permission Editor Dialog Box

Enables you to configure an adapter you have written, so that users can view permissions for the job.

To access Select Data Flow Management > Adapter Management > an adapter > Adapter

Definition tab > Required Permissions pane, and click the Add button.

Important

Information

The information you define here is not dynamic, that is, if an adapter is changed, the

information in this dialog box is not updated.

See also l "Discovery Permissions Window" on page 491

l "Viewing Permissions While Running Jobs" on page 460

l "Adapter Definition Tab" on page 244

l "Discovery Module/Jobs – Details Tab" on page 481

User interface elements are described below:

UI Element

(A–Z) Description

Operation The action that is being run.

Permission Enter a name for the permission, to appear in the Required Permissions pane.

Usage

Description

Free text that you enter to describe the permission object and its parameters. This text

is usually a general comment on the type of permission object, whereas the description

is a more specific comment. For example, you could enter Permissions for host

machines here, and Permissions for host machines running on Windows for a

particular row.
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Permission Objects and Parameters Pane

UI Element

(A–Z) Description

Click to open the Permission Object and Parameter pane. You can enter more than one

object or parameter for each permission.

The information you enter in this dialog box appears in the Required Permissions pane,

in the Objects and Parameters column.

Click to delete a permission object.

Click to edit an existing permission object.

Context Specific information about the permission object's environment, for example, Windows

or UNIX.

Parameter The parameters that are needed during the job run. For example, the UNIX permission

object cat needs the /etc/passwd parameter.

Permission

Object

The name of the command, table, or other content of the Jython script.

Resources Pane

Enables you to locate a specific package, adapter, script, configuration file, or external resource. You

can also create an adapter, Jython script, configuration file, or Discovery activity, and you can import an

external resource.

To access Select Data Flow Management > Adapter Management.

Important

Information

l Depending on the node you select in the Resources tree, different information is

displayed in the right pane. If you select:

o One of the following folder nodes: Packages root, a specific package, an

adapter, script, configuration file, or external resource: a list of the resources in

that folder is displayed. To access a resource directly, double-click the resource

in the View pane.

o An adapter: The Adapter Definition and Adapter Management tabs are

displayed. For details, see "Adapter Definition Tab" on page 244 and "Adapter
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Configuration Tab" on page 252.

o A script or configuration file: The script editor is displayed. For details, see

"Script Pane" on page 285.

o An external resource: Information about the file is displayed.

l You can view the history of discovery resources from the JMX console of the UCMDB

Server. For details, see "How to View Discovery Resource History" on page 228.

See also "Package Manager User Interface" in the HP Universal CMDB Administration Guide.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI

Element

(A–Z) Description

Create New Resource. Enables you to create a resource in a selected package. Select a

resource, enter its details, click the ellipsis  button, and select a package to which

to add the resource. If you do not select a package, the new resource is created in the <No

Package> folder:

l New Adapter. Enter the adapter name. Choose whether it should be used as a

discovery adapter or for integration. For integration adapters, choose the integration

type from the list of available types. Click OK. Edit the adapter. For details, see

"Adapter Definition Tab" on page 244 and "Adapter Configuration Tab" on page 252. For

details on moving an adapter to a package, see "How to Create a Custom Package" in

the HP Universal CMDB Administration Guide. For details on creating integration

adapters, see "Discovery and Integration Adapters" on page 24.

l New Jython script. Enter the script name. For details, see "Script Pane" on page 285.

l New Configuration File. Enter the configuration file name. By default, the file takes an

.xml extension. To give the file another extension, for example, *.properties, name

the file and include the extension. Add the appropriate XML code or other content. For

XML files, you can save the file only if it is valid. For details, see "Configuration File

Pane" on page 263.

l Import External Resource. Opens the Select Resources to Import dialog box.

o Resources. Click the ellipsis to locate the resources that you want to import. You

can import more than one file by selecting multiple files at the same time.
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UI

Element

(A–Z) Description

o Package. Click the ellipsis to locate the package that you want to contain the

resources.

o Path. Enter a directory path for the resources.

l New Discovery Wizard. Name the new wizard. By default, the file takes an .xml

extension. The file is in template format.

l New Scanner Configuration Configure the new scanner using the Scanner

Configuration Generator wizard. For more information see section about the "Scanner

Generator Wizard" on page 603.

l Import Normalization Rules from Content Pack. Opens the Import Content Pack

dialog box, enabling you to import the normalization rules files only that are contained

in a Content Pack archive file. For more information about discovery rules that

normalize data, see "Discovery Rules Engine Overview" on page 295.

Delete the Selected Item. Deletes the resource.

Find Resource. Opens the Find Resource dialog box. For details on filtering, see "Filtering

Discovery Results" on page 666.

Refresh. Refreshes the list of packages.

Packages tree. Displays a list of all packages.

Package root. Displays a list of all resources included in the package. Expand the folders

to see available resources:

Right-click a resource to do one of the following:

l Save As. Enables you to clone an existing resource. The new resource includes all

attributes of the existing resource. Give the resource a name, and click the ellipsis
 button to select a package to which to add the resource.

l Delete. Enables you to delete the resource. The resource is removed completely from

the system.

l Open in Frame. Enables you to view or edit the resource script in the Script Editor.
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UI

Element

(A–Z) Description

Available for: Configuration files and scripts

l Go to Discovery Job. Enables you to open the discovery job associated with the

selected adapter in the Universal Discovery window

Available for: Adapters only. This option is enabled if the adapter is included in a

discovery job.

l Go to Integration Point. Enables you to view and edit the integration point that uses

this adapter in the Integration Studio.

Available for: Adapters only. This option is enabled if the adapter is used by an

integration point.

l Edit Adapter Source. Enables you to view or edit the adapter's XML file in the Adapter

Source Editor. For details, see "Adapter Source Editor Window" on page 259.

Available for: Adapters only

Script Pane

Enables you to edit a specific script that is part of a package.

To access Click a specific script in the Resources pane.

Important

Information

The script pane title bar includes the actual physical location of the script. For

example, the following script is located in

C:\hp\UCMDB\DataFlowProbe\runtime\

probeManager\discoveryConfigFiles/AMAdapter/META-INF

(or probeGateway\discoveryConfigFiles/AMAdapter/META-INF)

See also Adapter Development and Writing in the HP Universal CMDB Developer Reference

Guide
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A–Z) Description

Find text. Enables you to find specific text in the script definition. For details,

see "Find Text Dialog Box" on page 268.

Go to line. Enables you to jump to a specific line in the script definition. In the

Go To Line dialog box, enter the line number, and press Enter.

Open External Editor. Opens the script definition in an external text editor.

Prerequisite: Click the Edit the External Editor Preferences button to

define the path to an external editor. If no external editor path is defined, you

will be prompted to provide one when you try to open the external editor.

Edit the External Editor Preferences. Click to edit the external editor

preferences. You can run the editor by adding flags to the path.

Note: You cannot specify the file name. Instead, you can use flags

relevant to your external editor to retrieve the file name, such as :file.

In the following example, :file sets the place of the file in relation to the

flags.

If no flags are defined, the file name is automatically added to the end of

the path.

Switch Editor Mode. Enables you to switch between the default advanced

editor and a simple text editor.

Open Mapping Tool. Enables you to open the new mapping tool window. See

"Mapping Tool Editor Window" on page 273.

Note: This icon is available for adapter mapping configuration files only.
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UI Element (A–Z) Description

See "Validation Information" below.

Note: This button is displayed when a script contains Framework API

errors.

<script definition> The Jython script used by the package. For details on working with Jython, see

Create Jython Code in the HP Universal CMDB Developer Reference Guide.

Validation

Information

Displays if the script definition is valid or not:

l . For Jython files, indicates that the script definition is valid.

l . For Jython files, indicates that the script definition is not valid, and

displays the errors in the script.

For example:

Script has failed validation.

At line 48: Factory.getProtocolProperty( found. This is a
problem - Usage of Factory is deprecated. Use
Framework.getProtocolProperty instead.

Click , then OK to update the script.

The error may occur due to changes in the Framework object's API. For

details, see the HP Universal CMDB Developer Reference Guide.

l . For Jython files, indicates that the script definition could not be

validated.

Note: This may occur due to an internal error while performing the

validation. This does not, under any circumstances, harm the process

of saving your definition to the server. See

%temp%\UcmdbLog\error.log for details. For further assistance,

contact HP Software Support.
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Software Identification Rule Editor Dialog Box

Enables you to define rules for managing discovered running software.

To access 1. Go to Data Flow Management > Universal Discovery > Discovery Modules/Jobs.

2. In the Discovery Modules tree, select Hosts and Resources.

3. Select a job under Basic Applications, or under Inventory Discovery > Basic

Inventory.

4. In the Properties tab, select Global Configuration Files >

applicationsSignature.xml. Click Edit to open the Software Library dialog box.

5. In the Software Library dialog box, click Add or select an existing element and

click Edit .

Important

Information

Each rule must be matched by at least one process.

Relevant

tasks

"How to Discover Running Software – Scenario" on page 466

See also "Global Configuration Files Pane" on page 251

User interface elements are described below:

UI Element Description

Software Signature ID The name of the software signature.

Note: This is not the running software's name but a name you give to

differentiate this discovery from similar discoveries.

Category You can:

l Choose the category under which the new running software should

appear.

l Change the category for an existing element.

l Add a new category by typing its name in this field.
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UI Element Description

The changes you make here are immediately displayed in the Software

Library dialog box.

Supported versions Versions supported for this running software.

Created CI Properties The properties of the created CIs:

l CI Type. The CIT that is to be discovered

l Discovered Product Name. The name of the running software to be

created by this signature.

l Vendor. The vendor of this running software.

l Installed Software. The regular expression used to match the

application in the list of installed software on the target machine's

operating system.

l Additional Attributes. Attributes of the created CI. To manage the

attributes, click . For details, see "Attributes Assignment

Editor Dialog Box" on page 260.

Identifying Processes Lists the processes that can identify specific running software. The Edit

Process dialog box opens. For details, see "Edit Process Dialog Box" on page

265.

Add. Opens the Edit Process dialog box opens where you can define a

new identifying process.

Edit. Opens the Edit Process dialog box opens where you can modify the

selected identifying process.

Remove. Removes the selected identifying process.

Linked Configuration

Files

Enables you to manage configuration files linked to the identification rule.

Note: You can create parsing rules to define the paths to the

configuration files. For details, "Attributes Assignment Editor Dialog

Box" on page 260.

Add. Creates a new row where you can add the path to a linked
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UI Element Description

configuration file. Enter the full path to the running software's

configuration file and the file name.

Edit. Enables you to edit the path to the selected configuration file.

Remove. Removes the selected configuration file.

Software Library Dialog Box

Enables you to view the logical groups of running software.

To access Use one of the following:

l From Data Flow Management > Universal Discovery > Discovery Modules/Jobs:

a. In the Discovery Modules tree, select Hosts and Resources.

b. Select a job under Basic Applications, or under Inventory Discovery > Basic

Inventory.

c. In the Properties tab, select Global Configuration Files >

applicationsSignature.xml.

d. Click Edit .

l From Data Flow Management >Adapter Management window:

a. Select one of the Host_Resources_By_SNMP/TTY/WMI adapters.

b. In the Adapter Definition tab > Global Configuration Files pane, select

applicationsSignature.xml and click Edit .

Important

Information

The software elements are organized in logical categories. You can change the names

of these elements, you can move an element to another category, and you can define

new elements and categories. For details, see the Category entry in "Software

Identification Rule Editor Dialog Box" on page 288.

The code you define in this dialog box and the Software Element Editor dialog box

overwrites the code in applicationsSignature.xml.

Relevant "How to Discover Running Software – Scenario" on page 466
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tasks

See also "Global Configuration Files Pane" on page 251

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element

(A–Z) Description

Select a check box to include a category or software element in the discovery.

Clear a check box to remove the category or element from the discovery.

Add. Opens the Software Identification Rule dialog box, enabling you to define a new

software element. For details, see "Software Identification Rule Editor Dialog Box" on

page 288.

Export Application Signature to XML. Enables you to export the application signature

of the selected software element to an xml file.

Import Application Signature from XML. Enables you to import an application

signature from an xml file to the selected software element.

Edit. Opens the Software Identification Rule dialog box, enabling you to modify the

selected software element. For details, see "Software Identification Rule Editor Dialog

Box" on page 288.

Remove. Removes the selected software element from the library.

<List of

software

elements>

List of objects that are software elements.

Global Filtering Dialog Box

Global filtering enables you to filter Probe results for all adapters, so that only results of interest to you

are sent to the UCMDB Server.

To access In Adapter Management, do the following:

1. In the Resources tree, expand the DDMiInfra node and then expand the

Configuration Files node.

2. Right-click GlobalFiltering.xml and select Open in Frame.
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Important

Information

Before creating a filter, perform an analysis on what information you want to filter

and what data elements contains the information you want to filter.

Relevant

tasks

"Configure Filtering in UCMDB" on page 577

See also Configuration Items (CIs) in the HP Universal CMDB Administration Guide.

"Configure Filtering Using the globalFiltering.xml File" on page 221

User interface elements are described below:

UI

Element Description

Select CI. Opens the Select CI dialog box, enabling you to select a UCMDB CI.

Available when: Include or Exclude is selected in the left pane.

Select an Attribute. Opens the Select an Attribute dialog box, enabling you to add a filter

to an attribute for the selected UCMDB CI.

l Attribute. Select an attribute from the drop down list.

l Display Label. Name of the attribute.

l Type. Data type of the attribute as it appears in the CI Type Manager. For more

information, see CI Type Manager in the HP Universal CMDB Modeling Guide.

Enables you to delete the selected UCMDB CI or the attribute.

Global Filtering Configuration Settings

Enables you to activate filtering. It also enables you to define the behavior of filtering.

Important information These settings apply to all included and excluded filters.

User interface elements are described below:

UI

Element Description

Activate Enables you to activate filters.
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UI

Element Description

l Yes. Filters are activated.

l No.Filters are not activated.

Default: Yes

Recursive

Filtering

Defines a filtering behavior in which filters are applied to CIs that are linked to CIs that

have been filtered.

Using global filtering, you can filter out a CI so that it is not included in the filter results.

This CI may be a root CI, containing other CIs or relationships. By default, during the filter

process, the contained CIs and relationships, as well as any CIs related to them, are

added to the filter results—including the root CI. This causes undesired filter results.

Recursive filtering corrects this by ensuring that if a root CI is filtered out, then any

contained CIs or relationships are filtered out too, such that the root CI cannot be found

again.

Default: No

Attribute Editor

Enables you to define properties of attributes that you want filtered.

Important information This page is displayed when an attribute is selected in the left pane.

User interface elements are described below:

UI Element Description

Operator Click the drop-down list to display a list of operator types.

Value Type a function that is appropriate for the operator type.

The function must return a value.

Internal Configuration Files

The following files are for internal use only and should be changed only by users with an advanced

knowledge of content writing.
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Configuration File Description Location

discoveryPolicy.xml Includes the schedule when

the Probe does not execute

tasks. For details, see

"New/Edit Policy Dialog Box" on

page 87.

Data Flow Management >

Adapter Management > Packages

> AutoDiscoveryInfra >

Configuration Files

jythonGlobalLibs.xml A list of default Jython global

libraries that DFM loads before

running scripts.

Data Flow Management >

Adapter Management > Packages

> AutoDiscoveryContent >

Configuration Files
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Chapter 8: Discovery Rules Engine
This chapter includes:

Discovery Rules Engine Overview 295

Discovery Rules Syntax 296

How to Define Discovery Rules 305

How to View Discovery Rules in JMX 306

How to Disable the Discovery Rules Engine 307

Discovery Rules Engine Overview

When Universal Discovery discovers data, the Discovery Rules Engine processes the given set of input CI

and relationship data, and returns a set of output attribute values. The Discovery Rules engine enriches

the discovered CI and relationship data with new data deduced from the discovered attributes.

For example:

l Input: A Node contains the string Cisco and the string Version 12.3a,

l Output : The operating system for the Node is recognized as Cisco IOS Version 12.3(3a).

The Data Flow Probe then activates the Rules Engine to fill in additional information on the discovered

data.

All discovery jobs use the discovery rules engine. Out-of-the-box rules are applied to data that can be

completed by the discovery jobs (sys_object_id, mac_address, and so on). Moreover, you can add user-

defined rules to the Discovery Rules Engine.

Limitations

l The Discovery Rules Engine completes only empty fields, it does not overwrite existing values.

l Rules are run according to a random order. User-defined discovery rules have no priority over out-

of-the-box discovery rules. If the input suits more than one rule, the output is returned from the rule

that ran first. It is important to ensure that rules are accurate (existing and new rules). If rules are

accurate there is no need for prioritization. However, if a CI’s property values match two rules that
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have a single input attribute of the same type (equals, oid-starts-with, regex), then the rule that has

more information (for example, a longer OID) will be preferred.

l There are no dependencies between rules. A field that was completed using the Discovery Rules

Engine cannot be used as input for another rule.

Related Topics

l For details on the syntax of Discovery Rules, see "Discovery Rules Syntax" below.

l For details on defining new rules, see "How to Define Discovery Rules" on page 305.

l For details on viewing out-of-the-box rules, see "How to View Discovery Rules in JMX" on page 306.

l To disable the Rules Engine on a particular population adapter, see "How to Disable the Discovery

Rules Engine" on page 307.

l For details on log files, see "Data Flow Probe Log Files" on page 83.

Discovery Rules Syntax

This section describes the syntax of discovery rules. Discovery rules are supplied in an XML file. Some

examples are presented here, and detailed descriptions explaining the syntax in these examples follow.

Example 1

The following rule sets attribute vendor to hewlett_packard_co for CIs with the discovered_model

attribute equal to HP2140.

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

<rules:normalization-rules name="My rules"
xmlns:rules="http://www.hp.com/ucmdb/1-0-0/NormalizationRules">

<rules:normalization-rule ci-type="node" id="1">

<rule-input>

<attribute name="discovered_model" value="HP 2140" compare-
type="equals"/>

</rule-input>
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<rule-output>

<attribute name="vendor">

<value>hewlett_packard_co</value>

</attribute>

</rule-output>

</rules:normalization-rule>

</rules:normalization-rules>

Example 2

The following rule appends desktop to the node_role attribute list when a discovered node CI is

connected to interface whose mac_address starts with 0020C0.

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

<rules:normalization-rules name="My rules"
xmlns:rules="http://www.hp.com/ucmdb/1-0-0/NormalizationRules">

<rules:normalization-rule ci-type="node" id="3481">

<rule-input>

<connected-ci link-type="composition" direction="forward" end-
type="interface">

<connected-ci-attribute name="mac_address" value="0020C0" compare-
type="starts-with"/>

</connected-ci>

</rule-input>

<rule-output>

<attribute name="node_role">

<values>

<add>desktop</add>

</values>

</attribute>

</rule-output>

</rules:normalization-rule>

</rules:normalization-rules>
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Example 3

The following example sets the values of os_description, os_vendor, os_family attributes and appends

desktop and nt to the node_rule attribute when a discovered node CI has the discovered_os_name

starting with Windows 2000 Professional.

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

<rules:normalization-rules name="My rules"
xmlns:rules="http://www.hp.com/ucmdb/1-0-0/NormalizationRules">

<rules:normalization-rule ci-type="node" id="2">

<rule-input>

<attribute name="discovered_os_name" value="Windows 2000 Professional"
compare-type="starts-with"/>

</rule-input>

<rule-output>

<attribute name="os_description">

<value>windows_2000_professional</value>

</attribute>

<attribute name="os_vendor">

<value>microsoft_corp</value>

</attribute>

<attribute name="os_family">

<value>windows</value>

</attribute>

<attribute name="node_role">

<values>

<add>desktop</add>

</values>

</attribute>

<class-type>nt</class-type>

</rule-output>

</rules:normalization-rule>
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</rules:normalization-rules>

Example 4 (link rules)

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

<rules:normalization-rules name="My rules"
xmlns:rules="http://www.hp.com/ucmdb/1-0-0/NormalizationRules">

<rules:normalization-rule id="2909" ci-type="containment">

<link-rule-input>

<attribute name="name" value="MyName" compare-type="starts-with"/>

<end1 ci-type="node">

<attribute name="description" value="MyDescription" compare-
type="starts-with"/>

</end1>

<end2 ci-type="ip_address">

<attribute name="name" value="1.1.1.1" compare-type="starts-
with"/>

</end2>

</link-rule-input>

<rule-output>

<attribute name="description">

<value>HP StoreOnce B6000</value>

</attribute>

</rule-output>

</rules:normalization-rule>

</rules:normalization-rules>

Explanation of Examples

Element: <normalization-rules>

Description: Represents a set of discovery rules. It is the top element in the XML file.

Attributes:
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l Description (optional)

l Name (required): a unique name of the rule set in the XML file.

Inner elements:

l <normalization-rule>

Element: <normalization-rule>

Description: This element represents a single discovery rule.

Attributes:

l id (required): This ID must be unique within the scope of the XML file. In the first example above,

id=1. In the second example, id=3481.

l ci-type (required): the type of CI that the rule is applied to. In both examples above, ci-type=node.

Inner elements:

l <rule-input>

l <link-rule-input>

l <rule-output> (required)

Note: One or the other of the <rule-input> or <link-rule-input> elements must appear in the file,

but not both.

Element: <rule-input>

Description: Defines conditions on CI attributes and on attributes of connected CI(s), used for matching

between a discovered CI and the rule. For example, if you have the following rule input:

<rule-input>

<attribute name="discovered_model" value="HP 2140" compare-type="equals"/>

</rule-input>

this rule would match a CI with an attribute discovered_model = HP 2140.

Inner elements:
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l <attribute> (optional)

l <connected-ci> (optional)

Note: <rule-input> must have one of the inner elements above.

Element: <attribute>

Description: Defines a condition on a CI attribute.

Attributes:

l name (required): The name of the discovered CI attribute examined by the discovery rules engine.

l value (required): The value that the discovered CI attribute has to match.

l compare-type (required): Defines the kind of match comparison applied by the rule. It must be one

of the following options:

a. equals: The value of the discovered attribute is equal to the value in the rule.

b. starts-with: The value of the discovered attribute starts-with the value in the rule.

c. ends-with: The value of the discovered attribute ends with the value in the rule.

d. contains: The value of the discovered attribute contains the value in the rule.

e. regexp: The value of the discovered attribute matches a given regular expression in the rule.

f. oid-starts-with: Either the value of the discovered attribute is equal to the value provided in the

rule or it starts with the concatenation of the rule value and the dot (.) character.

For example, if you have the following rule:

<attribute name="sys_object_id" value=".1.3.6.1.4.1.42" compare-type="oid-
starts-with"/>

It is interpreted as either:

l value of "sys_object_id" is equal to ".1.3.6.1.4.1.42"

or

l value of "sys_object_id" starts with ".1.3.6.1.4.1.42."
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This means that the following values would match this rule:

l ".1.3.6.1.4.1.42"

l ".1.3.6.1.4.1.42.1"

but this value would not match the rule:

l ".1.3.6.1.4.1.421"

Element: <connected-ci>

Description: Defines conditions on a connected CI.

Attributes:

l link-type (required): The type of relationship between the discovered CI and the connected CI.

l direction (required): The relationship direction; which is either "forward" or "backward".

l end-type (required): The type of the connected CI.

Inner elements:

l <connected-ci-attribute>

Element: <connected-ci-attribute>

Description: Defines a condition on a connected CI attribute. Similar to the <attribute> element

(described above) that defines conditions on the attribute of a CI, the <connected-ci-attribute> refers

to an attribute of a connected CI. This element has the same structure as the <attribute> element.

Element: <link-rule-input>

Description: Defines conditions on link attributes and on attributes of its ends, used for matching

between a discovered link and the rule.

Inner elements:

l <attribute> - Zero or more attribute conditions on the link. The same as the previous <attribute>

element.
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l <end1> (required)

l <end2> (required)

Element: <end1>

Description: Defines a condition on the first end of the link.

Attributes:

l ci-type (required): the type of the end CI

Element: <end2>

Description: Defines a condition on the second end of the link.

Attributes:

l ci-type (required): the type of the end CI

Inner elements (for both end1 and end2):

l <attribute> (optional): Zero or more attribute conditions on the end. The same structure as

other<attribute> elements.

Element: <rule-output>

Description: Defines the output values set by the rule in the case of a match. It also can set the type of

the discovered CI. The rule output contains a list of attributes. Each attribute contains one or more

values, and the rule engine sets these values. The following is an example of rule output:

<rule-output>

<attribute name="vendor">

<value>hewlett_packard_co</value>

</attribute>

</rule-output>

In the output above, the attribute “vendor” has one value, and the rule engine sets this value to

“hewlett_packard_co”.

Sometimes, an attribute has a string_list type. In this case, the rule output can add a new value to the

list, as shown in the following example:
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<rule-output>

<attribute name="node_role">

<values>

<add>desktop</add>

</values>

</attribute>

</rule-output>

In the example above, the value desktop is added to the list of node_role values.

Rule output can also set a CI type, as shown in the following example:

<rule-output>

<class-type>nt</class-type>

</rule-output>

Inner elements:

l <class-type> (optional)

l <attribute> (optional)

Note: <rule-output> must have one of the inner elements above.

Element: <class-type>

Description: When used, defines the new type of the discovered CI.

Element: <attribute>

Description: Defines the attribute to be set in the case of a match.

Attributes:

l name (required): The name of the CI attribute that is set by this rule.

Inner Elements:

l <value>

l <values>
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Element: <value>

Description: Defines the value of the output attribute.

Element: <values>

Description: Defines the values of the output attribute in the case of an attribute list. The given values

are appended to the result list.

Inner Elements:

l <add>

Element: <add>

Description: Defines the value to be appended to the list of CI attribute values.

How to Define Discovery Rules

This task describes how to define a new discovery rule in the Discovery Rules Engine.

If you are working on an upgraded version of UCMDB, you can also edit user-defined rules from your

previous version.

To learn more about the Discovery Rules Engine, see "Discovery Rules Engine Overview" on page 295.

To add new user-defined discovery rules:

1. Go to Adapter Management.

2. In the Resources pane, click New , and select New Configuration File.

Enter a name for the new discovery rule. The name must begin with ruleEngine/ and end with .xml.

For example: ruleEngine/myRule.xml.

3. In the Package field, select NormalizationRules.

4. In the Editor pane that opens on the right, enter the new rule.

An example of valid rules can be found under NormalizationRules > Configuration Files, in
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ruleEngine/samples.xml.

5. Click OK.

To edit an existing discovery rule from a upgraded version of UCMDB:

1. Go to Adapter Management.

2. In the Resources pane, select the UserDefinedRules package.

3. Under Configuration Files, select the .xml file for the rule that you want to edit.

Note:

o Rules that were defined in previous versions of UCMDB (for example in

oidToHostClass.xml), can be found under the UserDefinedRules package, in the

configuration file UserDefinedOidToHostClass.xml.

o Out-of-the-box OidToHostClass rules can be found under NormalizationRules > External

resources in the ruleEngine/snmp.gz file.

How to View Discovery Rules in JMX

The Discovery Rules Engine is very large. You can search the rule base using search commands on the

JMX console.

To search for a rule:

l Log in to the JMX console using the server administrator credentials

l Go to the service: Normalization Rule Base Services, and enter one of the following search

commands:

Command Description

scanForSNMPRules Retrieves SNMP discovery rules that apply to the specified

input attributes.
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Command Description

Note:

o the sys_object_id value must always have a leading "."

o Leave empty to ignore

scanForScanFileRules Retrieves Scan File discovery rules that apply to the specified

input attributes.

Note: Leave empty to ignore

viewNormalizationRuleById Retrieves discovery rules by ID

viewNormalizationRuleByNiceId Retrieves discovery rules by user friendly ID (NiceRuleID),

Example: 4323@SNMP

viewNormalizationRules Retrieves discovery rule outputs that apply to the specified

input attributes

Format:

o Pair attributes in the following format: attrName;attrValue

o Pairs must be separated by commas.

Example: Name;HP,Version;10

How to Disable the Discovery Rules Engine

All population adapters are set up, by default, to use the Discovery Rules Engine adapters.

To disable the Discovery Rules Engine for a particular population adapter:

1. In Adapter Management, open the population adapter's configuration file (<adapter>.xml).

2. Search for the following parameter: normalizationRules isEnabled
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o If you find it, ensure that the value is set to false.

o If you do not find it, add the following line under the taskinfo tag: <normalizationRules

isEnabled="false"/>
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Chapter 9: Integration Studio
This chapter includes:

Integration Studio Overview 310

Integration in a Multi-Tenancy Environment 314

How to Work with Federated Data 315

How to Work with Population Jobs 316

How to Work with Data Push Jobs 317

How to Set Up an Integration Point 319

How to Save an Integration Point Configuration as an Adapter Default 322

How to Remove Adapter Defaults 325

How to Deploy a Package to a Remote Data Repository 326

How to Configure Probe IP Ranges with Active Directory 329

Integration Studio User Interface 329

Limitations – Integration Studio 359

Integration Studio Overview

The Integration Studio is where you manage your UCMDB integration points and connect and share

information with external repositories, such as other CMDBs, IT Performance Suite products, or third-

party products.

Integration with other products is performed over secure communication channels through Data Flow

Probes.

Alternatively, if your remote managed data repositories are accessible from the UCMDB server machine,

non-Jython-based integrations can be performed using the HP UCMDB Integration Service, enabling the

Data Flow Probe resources to be used for other discovery tasks.

Note: The HP UCMDB Integration Service is supported in a standalone UCMDB environment only.
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Integration points in the CMDB are based on adapters, which are entities that are capable of

communicating with external data repositories. A basic set of adapters is provided with the CMDB;

however, you can create additional adapters using the Federation Framework SDK. For details, see "Add

an Adapter for a New External Data Source" in the HP Universal CMDB Developer Reference Guide.

You can also create adapters in the Adapter Management module. For details, see "Resources Pane" on

page 282.

For details about how to set up integration points for data integrations, see "Integration Studio Page"

on page 344.

Integration points can be of one of the following types:

l "Population" below

l "Federation" below

l "Data Push" on page 314

Population

An integration of Population type copies data from an external data repository into the CMDB, so that

the CMDB now controls the data.

You use population in one of the following scenarios:

l When you need to track changes made by the CMDB at the CI level.

l When a remote repository is not reliable in terms of response time; for example, a network delay

prohibits you from setting up run-time federation with the repository.

l When a remote repository does not support federation capabilities (no appropriate adapter exists).

Federation

An integration of Federation type includes data in the CMDB from other sources in such a way that the

source of the data still retains control of the data.

You use the CMDB's federation capabilities to extend the scope of the existing Topology Query

Language (TQL) capabilities to encompass data that is stored and maintained in an external repository.

The ability to include such information is important as it prevents you from having to copy large

amounts of data and, instead, bring it into your CMDB only when it is really needed.
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Federation also has the benefit that the federated data does not burden the CMDB in terms of capacity;

theoretically, you can set up an integration that federates trillions of CIs and relationships. Federated

data is fetched at runtime, as requested, which lessens the impact on system performance.

Note: The CMDB does not offer change tracking on federated data because the data does not

reside within the CMDB and the CMDB is not notified when external data is modified.

Federated integration creates a federated integration point, which can then be used when defining TQL

queries. For details on TQL, see "Topology Query Language" in the HP Universal CMDB Modeling Guide.

Note: Federation can be configured in Actual state only, but can be performed in either Actual or

Authorized state.

Retrieving Data from Multiple Federated Data Sources

During TQL query calculation, you can retrieve data for the same CIT from several federated data

sources. The data is retrieved from the local CMDB, as well as from other federated data sources,

according to how you have configured integration points. As data arrives at the CMDB, it is identified and

reconciled, with the end result determined according to the configured reconciliation priority given to

the various integrations.

Each CI that is retrieved from an external data repository includes an attribute (Created By) to show

from which federated data source the CI has been retrieved.

For limitations, see "Limitations – Integration Studio" on page 359.

Retrieving Attributes from an External Data Repository

l You can retrieve the attributes of a CI from an external data repository, when the core CI data is

stored in the CMDB.

l The core data repository must be the CMDB.

l The CIT must be located in a data repository for its attributes to be defined.

l The same attributes can be retrieved from multiple data repositories.

l For details on retrieval options, see the CI Type Retrieval Mode field on the "Federation Tab" on page

331.

l When you configure an integration point to include federated CIs, you must select full federation of
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a CI or the federation of an attribute alone. You cannot set up two integrations for the same CIT

where one is mapped to an external CIT and the other is mapped to that same CIT with an external

attribute.

l A CIT can support external attributes if the adapter (which is federating the CIT data) supports

mapping information (reconciliation) for this CIT.

Reconciling Information

Federated queries should use the mapping file to reconcile the CI from the CMDB with the attributes

from the external data repository.

For details on the Mapping Engine, see "Federation Framework Flow for Federated TQL Queries" in the

HP Universal CMDB Developer Reference Guide.

For details on selecting attributes to be included in the federation, see "Federation Tab" on page 331.

For details on how reconciliation is performed, see "Data Reconciliation" on page 756.

Use Cases

l You need to discover the SMS or Altiris desktops in your system. The desktop CIT is a core CIT and is

already synchronized with the CMDB. However, you do not want to store all the desktop data in the

CMDB as this is inefficient and unnecessary. It is enough to store core attributes such as name and

MAC address in the CMDB, and to define the other details of the desktops as external attributes in

two data repositories: SMS and Altiris.

l VMware creates virtual machines that contain a virtual machine monitor (hypervisor) that allocates

hardware resources dynamically and transparently. Multiple operating systems can run concurrently

on a single physical computer. Since the allocation resources—for example, memory—are dynamic,

DFM cannot discover these resources (DFM runs once every 24 hours and the resource data can

change hourly). To enable UCMDB to always be updated with real-time data, the solution is to divide

the data into two: the core data of the virtual hosts should be discovered and placed in the CMDB;

the resource attributes should be retrieved from the external source. In this use case, the data for

these attributes is retrieved from two data repositories: CMDB and VMware.

Calculating Federated TQL Queries

When defining an adapter, you can specify whether calculation of TQL queries must be performed first

on the CMDB (default) or whether it can start on the adapter.

As an example of a one-node adapter, if you have a TQL query of Node > CPU (with conditions on the

federated CPU):
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l If the calculation is performed first on the data in the CMDB:

o The TQL query for Node is calculated in the CMDB, which retains all of the Node's data.

o Then Node > CPU is calculated by the adapter, which uses the reconciliation data from the

previous step.

l If the calculation is performed first by the adapter:

o The adapter calculates the TQL query for CPU, and returns the connected nodes as the

reconciliation data.

o Then the calculated data is sent to the CMDB, where the TQL query for Node is calculated

according to the reconciliation data from the previous step.

The option to set the adapter as the starting point of the TQL query calculation is specified in the

Adapter Management module. For details, see "Adapter Source Editor Window" on page 259.

Data Push

An integration of Data Push type copies data from the CMDB to an external data repository, so that the

CMDB no longer retains control over this data.

You use data push integrations to feed important data from your CMDB into an external system to

facilitate your necessary business processes. An example of this is pushing data discovered by DFM into

HP Service Manager, where tickets may be opened that are connected to the actual CIs in your IT

infrastructure.

If an authorized state has been defined, you can perform data push from the authorized or actual state.

For limitations on Data Push jobs, see "Limitations – Integration Studio" on page 359.

Integration in a Multi-Tenancy Environment

When executing integration queries or jobs in a multi-tenancy environment, all CIs and relationships

that are federated or populated from the remote data source are assigned an owner tenant.

If the data source environment is multi-tenancy aware, when you run a query or a job, only the CIs and

relationships of those tenants that you have permissions to view are federated or populated. The owner

tenant value is brought in with all of the other attributes.
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If the data source environment is not multi-tenancy aware, when you run the query or a job, UCMDB

automatically assigns a specified owner tenant value to each of the federated/populated CIs and

relationships. For details about selecting an owner tenant value to assign to federated/populated CIs

and relationships, see "New Integration Point/Edit Integration Point Dialog Box" on page 349.

How to Work with Federated Data

This task explains how to set up and work with data that is federated from different CMDB sources.

This task includes the following steps:

l "Set up the federation type integration " below

l "Set a reconciliation priority" below

l "View Instances in IT Universe Manager" below

l "View Reports" below

1. Set up the federation type integration

Set up the integration that will federate the data, including the CITs that should be federated. For

details, see "How to Set Up an Integration Point" on page 319.

2. Set a reconciliation priority

In the Integration Point pane, right-click the integration, and select Reconciliation Priority

Manager from the shortcut menu. For more details, see "Reconciliation Priority Window" on page

781.

3. View Instances in IT Universe Manager

For details about viewing the federated CI instances, see "Working with Views in IT Universe

Manager" in the HP Universal CMDB Modeling Guide.

4. View Reports

You can view reports about the integration in the Modeling Studio. For details see Reports in the HP

Universal CMDB Modeling Guide.
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How to Work with Population Jobs

This task explains how to schedule population jobs and select the queries that are used to populate the

CMDB with data.

This task includes the following steps:

l "Create an integration point" below

l "Set Reconciliation priority" below

l "Run the population job" below

l "Build a view of the population results" on the next page

l "View instances in IT Universe Manager" on the next page

l "View reports" on the next page

1. Create an integration point

Set up the integration to populate the data. For details, see "How to Set Up an Integration Point" on

page 319.

2. Set Reconciliation priority

In the Integration Point pane, right-click the integration, and select Reconciliation Priority

Manager from the shortcut menu. For more details, see "Reconciliation Priority Window" on page

781.

3. Run the population job

Population jobs are set to run according to a default schedule setting. However, you can manually

run the integration at any time from the Integration Jobs pane. For user interface details, see

"Integration Jobs Pane" on page 333.

Select the job.

o To synchronize all data for the first time, click the Full Synchronization button.

o To synchronize only the data changes since the job last ran, click the Delta Synchronization

button.
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Note:

o If CIs in a population job fail, the query is displayed in the Query Status tab as Completed

with a warning symbol . You can drill down to see the errors that occurred and the CIs

affected. This error data is saved in the system. When the job runs again to synchronize

changes, UCMDB remembers the failed CIs and repopulates these as well.

o If, since the last synchronization, you have changed a TQL query (other than changes to

conditions on existing nodes), click the Clear Probe Results Cache button to ensure

that the next run of the job is a full synchronization.

o High Availability environment: If a population job is running, and the UCMDB Server

responsible for write requests becomes unavailable or is changed, the job fails. You can

wait for the next invocation of the job schedule, or alternatively rerun the population job

manually.

o For ResultTreeNodes (RTNs) coming from external sources, their isDeleted attribute

setting will not be overridden by the mapping process. For example, if one RTN, which has

isDeleted attribute set true, comes from SM, using a population job, it will be deleted even

if the mapping processing changes isDeleted to false.

4. Build a view of the population results

For details about viewing the populated data, see "Working with Views in IT Universe Manager" in

the HP Universal CMDB Modeling Guide.

5. View instances in IT Universe Manager

For details about viewing the CI instances, see "Working with Views in IT Universe Manager" in the

HP Universal CMDB Modeling Guide.

6. View reports

You can view reports about the integration in the Modeling Studio. For details see Reports in the HP

Universal CMDB Modeling Guide.

How to Work with Data Push Jobs

This task explains how to schedule data push jobs and select the queries that are used to send data

from the CMDB to another data repository.
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This task includes the following steps:

l "Create an integration point" below

l "Set Reconciliation priority" below

l "Run the Data Push job" below

l "Build a view of Data Push results" on the next page

l "View instances in IT Universe Manager" on the next page

1. Create an integration point

Set up the integration to push the data from UCMDB. For details, see "How to Set Up an Integration

Point" on the next page.

2. Set Reconciliation priority

In the Integration Point pane, right-click the integration, and select Reconciliation Priority

Manager from the shortcut menu. For more details, see "Reconciliation Priority Window" on page

781.

3. Run the Data Push job

Data Push jobs are set to run according to a default schedule setting. However, you can manually

run the integration at any time from the Integration Jobs pane. For user interface details, see

"Integration Jobs Pane" on page 333.

Select the job.

o To synchronize all data for the first time, click the Full Synchronization button.

o To synchronize only the data changes since the job last ran, click the Delta Synchronization

button.

Note:

l If CIs in a data push job fail, the query is displayed in the Query Status tab as Completed

with a warning symbol . You can drill down to see the errors that occurred and the

CIs affected. This error data is saved in the system. When the job runs again to

synchronize changes, UCMDB remembers the failed CIs and repushes these as well.
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l You can define a limit on the number sequential CI failures allowed during a running

data push job. When this limit is reached, the job automatically stops running, enabling

you to troubleshoot the reason for so many failures before waiting for the entire job to

end.

In the Administration module's Infrastructure Setting Manager, select Integration

Settings and set the value of Maximum number of data push job failures allowed in

a sequence. The default value for this setting is 20,000.

l If, since the last synchronization, you have changed a TQL query (other than changes to

conditions on existing nodes), all data is synchronized and the following message is

written to the log: TQL was changed between syncs - performing Full sync!

l High Availability environment: If a data push job is running, and the UCMDB Server

responsible for write requests becomes unavailable or is changed, the data push job

fails. You can wait for the next invocation of the job schedule, or alternatively rerun the

data push job manually.

l You can control the way the job handles null value attributes in the Adapter

Configuration tab. For details, see "Adapter Configuration Tab" on page 252.

4. Build a view of Data Push results

For details about viewing the data push results, see "Working with Views in IT Universe Manager" in

the HP Universal CMDB Modeling Guide.

5. View instances in IT Universe Manager

For details about viewing the CI instances, see "Working with Views in IT Universe Manager" in the

HP Universal CMDB Modeling Guide.

How to Set Up an Integration Point

This task describes how to create and configure an integration point for a particular integration with

UCMDB.

Note: The integration adapters provided with the Discovery and Integrations Content Pack come

predefined with the basic setup recommended to perform integration with UCMDB, including

adapter properties, integration jobs and, where relevant, federation settings. You can use these
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settings or configure them to suit your needs.

This task includes the following steps:

l "Prerequisites" below

l "Create an integration point" below

l "Add the integration jobs and schedule the jobs to run" on the next page

l "For a federation-type integration, define the data to be federated" on the next page

l "How to Set Up an Integration Point" on the previous page

1. Prerequisites

The integration adapter must be correctly configured before setting up the integration.

o Pre-configured Integration Adapters: These are provided out-of-the-box with the product. It is

recommended to use the adapters as they come, without any further configuration.

However, if you do need to modify the adapter configuration, you are encouraged to do this

from the Adapter Management module rather than manually. For details about adapter

configuration, see "How to Configure Adapter Settings" on page 217.

o New External Data Source Adapters: To configure an adapter for an new external data source,

see "Add an Adapter for a New External Data Source" in the HP Universal CMDB Developer

Reference Guide.

2. Create an integration point

If you are creating a new integration point, select Data Flow Management > Integration Studio,

and click the New Integration Point button. For user interface details, see "New Integration

Point/Edit Integration Point Dialog Box" on page 349.

a. Enter a name and description for the integration point.

b. Select the appropriate integration adapter. For details on existing adapters, see "Select

Adapter Dialog Box" on page 354.

c. Select whether or not to activate the integration upon creation.

d. Upon selecting the adapter, the Adapter Properties section is populated with the relevant

adapter properties. Provide the relevant information. For details, see the relevant section in
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HP UCMDB Discovery and Integrations Content Guide.

e. Configure the adapter's protocol credentials, where required. For a list of supported protocols,

see the HP UCMDB Discovery and Integrations Content Guide.

f. Select the Probes to use for the integration.

Note:

l If your remote managed data repositories are accessible from the UCMDB server

machine, you can use the UCMDB Integration Service instead of a Data Flow Probe to

run non-Jython-based integrations. (This is relevant in a standalone UCMDB

environment only.)

In this case, in the Data Flow Probe box, select UCMDB Integration Service.

If UCMDB Integration Service does not appear in the Data Flow Probe list, ensure

that the UCMDB Integration Service is running on the UCMDB Server machine. For

details, see "How to Check the HP UCMDB Integration Service Status" on page 48.

l If your Probe is an integration probe, and it does not appear in this list, ensure that it is

connected.

g. For Jython-based integration adapters only: Create or select a trigger CI instance for the

integration.

h. When you are finished, click OK. The integration point is automatically saved.

3. Add the integration jobs and schedule the jobs to run

Select the required integration point in the Integration Point pane. In the Integration Jobs pane,

click the New Integration Job button.

o Where relevant, define the job queries.

o Population and Data Push integration jobs are set to run according to a default schedule

setting. You can change the schedule in the Schedule Definition pane.

For user interface details, see "New Integration Job/Edit Integration Job Dialog Box" on page 345.

4. For a federation-type integration, define the data to be federated

In the Federation tab, select the CITs to be federated.
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For user interface details, see "Federation Tab" on page 331.

How to Save an Integration Point Configuration as an

Adapter Default

You can save an integration point configuration as an adapter default. This is useful if you want to use

an integration point's configuration to create other integration points with a similar configuration.

This task describes how to save an integration point configuration as an adapter default.

1. Prerequisites

a. Define an integration point based on a particular adapter. For example, MSSMS, based on the

Microsoft SMS adapter.

b. Define population or push jobs and federation details.

c. Save the integration point.

2. Save the integration point configuration as an adapter default

a. In the Integration Point pane, right-click the integration point that you created, and select

Save as Adapter Default.

b. In the Save as Adapter Default dialog box, enter details for the adapter default as follows:

l Name and Description. A name for the adapter default and a description.

Caution: If you give the adapter default the same name as an existing adapter

default, UCMDB treats this as though you are redefining the existing adapter default,

and the new definition overwrites the existing definition. If you do not want to

overwrite an existing adapter default, give the new adapter default a different name.

l Path. (Optional) The path to the folder under which your adapter should be displayed in the

Select Adapter dialog box (when creating a new integration point). The adapter default is

displayed under the same category as the adapter that was originally used to create the

integration point, in the path that you define here.
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Note:

l Use only forward slashes (/) in the path.

l If you define a new folder in the path, the adapter default is displayed in that

folder, under the same category as the original adapter.

l If you leave the path empty, the adapter default is displayed directly under the

same category as the original adapter.

Using the MSSMS integration point example introduced in the Prerequisites section above, you

could save this integration point as an adapter default, calling it my_mssms_defaults and

defining the path as MyAdapters/MSSMS.
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The next time you create a new integration point, the my_mssms_defaults adapter default is

displayed under the Third Party Products category (because the out-of-the-box Microsoft SMS

adapter appears under this category), in the MyAdapters>MSSMS folder, as you specified in

the path:

3. Results

o When you save the adapter default, integration point parameters that are not related to the

connection itself are saved in the adapter default definition.

o The code for the adapter default is added to the adapter's xml file. To delete the adapter

default, see "How to Remove Adapter Defaults" on the next page.
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How to Remove Adapter Defaults

To remove an adapter default, you must delete the code that defines it from its base adapter's .xml file.

To remove an adapter default:

1. Locate the adapter on which the adapter default was based. (Adapter Management > Resources

pane).

Tip: Alternatively, you can access the adapter from the Integration Point pane by right-clicking

the relevant integration point and selecting Go To Adapter.

2. Right-click the adapter and click Edit Adapter Source.

3. In the adapter's .xml file, locate the following line:

o Non-Jython adapters:

<adapterTemplate name="<adapter_default>" description="">

o Jython adapters:

<adapterJythonTemplate name="<adapter_default>" description="">

where adapter_default is the name of the adapter default.

4. Delete the all the code from this opening tag to the closing </adapterTemplate> (or

</adapterJythonTemplate>) tag.

Caution: Do not delete the following line: </adapterTemplates>

5. Save your changes.

Example
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How to Deploy a Package to a Remote Data Repository

You can deploy a package to a data repository located on a remote machine without logging in to the

remote machine. This feature is useful if you need to deploy queries, views, or other UCMDB resources

created on one machine to other machines running UCMDB.

Note: Perform the following procedure for each data repository to which the package is to be

deployed.

This task includes the following steps:

l "Prerequisites" on the next page

l "Change timeout - optional" on the next page

l "Select the integration point" on the next page

l "Select the package" on the next page
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l "View deployment results" below

l "View Log files" on the next page

1. Prerequisites

o Verify that the Data Flow Probe is configured correctly and is connected to UCMDB.

o Verify that the version of UCMDB running on the remote machine is version 9.02 or later.

o Verify that the UCMDB Server on the remote machine is up and running.

o Create the package that must be deployed to the remote machine, and deploy this package to

the local UCMDB Server.

Note: By default, you cannot deploy a package that is larger than 10 MB.

o Create an integration point on the local UCMDB Server, that uses the UCMDB 9.x/10.x adapter.

2. Change timeout - optional

You can change the time after which UCMDB times out package deployment. If UCMDB cannot

connect to the remote machine in 5 minutes, by default, the deployment is timed out.

To change the default: Select Administration > Infrastructure Settings Manager > Integration

Settings > Remote package deploy Timeout. (The refresh rate indicates when the change takes

effect in UCMDB after the value is modified.)

3. Select the integration point

In the Integration Point pane, right-click the integration point that you created in "Prerequisites"

above. For details, see "Integration Point Pane" on page 341, and select Deploy Remote Package.

4. Select the package

a. In the Deploy Remote Package dialog box, select a package from the list of packages existing

on the local UCMDB Server. This is the package that you created in "Prerequisites" above. For

details, see "Deploy Package to Remote Data Repository using <Integration Point>" on page

331.

b. Click OK to deploy the package.

5. View deployment results
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Answer the message that is displayed: click OK to begin deploying the package.

The status of the deployed package is displayed together with the status of each individual

resource in the package.

o Successful deployment: A package is successfully deployed if all its resources are successfully

deployed.

o Failed deployment: If even one resource fails, the package deployment is considered to have

failed. Even if package deployment fails, all the successful resources are deployed on the

remote machine.

The reason for the failure, for example, a missing CIT, is displayed in the Deployed resources

section:

6. View Log files

The following table shows the locations of the log files that record any issues that might arise

during deployment:

Location Log File Name

Remote UCMDB machine, version 9.02 or later ucmdb-api.log

mam.packaging.log

Data Flow Probe probeTasks.log

probe-infra.log

adapters.log

Local UCMDB machine ucmdb-api.log

If a resource fails to deploy, an error is displayed in the Status column as well as in the log file on

the remote machine.
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How to Configure Probe IP Ranges with Active Directory

This integration retrieves the latest site information (including IP subnets) from Active Directory. This

lets you configure the IP ranges contained in the Data Flow Probe according to the contents of the

Active Directory.

1. Run jobs

Run the following jobs:

a. Range IPs by ICMP or Range IPs by NMAP

b. TCP Ports

c. Active Directory Connection by LDAP

d. Active Directory Topology by LDAP

2. Add Active Directory Topology by LDAP to Integration

a. Go to Adapter Management > Resources pane > expand Packages, expand Active Directory,

click LDAP Active Directory Connection.

b. In the Details pane, click Used as an Integration Adapter. In the Adapter Category field, type

"Active Directory".

c. Go to Integration Studio > Integration Point pane, click Active Directory Topology. In the

Integration Jobs pane, click . The Configure Probe Range by Active Directory dialog box

opens.

d. In the list of Data Flow Probes, select the server that you want to configure. In the list of Active

Directory servers, click the server that contains the site information you want to use to

configure the Data Flow Probe. Click . A new dialog box opens.

e. Accept the default IP range and save your changes.

Integration Studio User Interface

This section includes (in alphabetical order):

Data Push Tab 330
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Deploy Package to Remote Data Repository using <Integration Point> 331

Federation Tab 331

Integration Jobs Pane 333

Integration Point Pane 341

Integration Studio Page 344

New Integration Job/Edit Integration Job Dialog Box 345

New Integration Point/Edit Integration Point Dialog Box 349

Population Tab 353

Select Adapter Dialog Box 354

Topology CI Creation Wizard 355

Data Push Tab

This tab enables you to set up an integration point for pushing data to an external data repository.

To access Select the Data Push tab on the Integration Studio page.

Important

information

This tab is enabled only when data push is supported by the adapter on which you

are basing your integration point.

Relevant tasks "How to Work with Data Push Jobs" on page 317

See also o "Integration Studio Overview" on page 310

o "HP UCMDB Integration Service" on page 30

o "New Integration Job/Edit Integration Job Dialog Box" on page 345

User interface elements are described below:

UI Element Description

Integration Jobs

pane

Enables you to specify the queries that are used to push data to external data

repositories, and to schedule jobs that contain those queries.

For details, see "Integration Jobs Pane" on page 333.

Statistics tab Displays results for integration jobs that have run.
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UI Element Description

For details, see "Statistics Tab" on page 337.

Query Status tab Displays information about the queries defined for the integration job.

For details, see "Query Status Tab" on page 339.

Deploy Package to Remote Data Repository using <Integration

Point>

Enables you to deploy a package to a remote data repository using an integration point, and to view the

results of the deployment.

To access Click the Deploy a Remote Package button in the Integration Point pane. For

details, see "Integration Point Pane" on page 341.

Relevant tasks "How to Deploy a Package to a Remote Data Repository" on page 326

User interface elements are described below:

UI Element (A-

Z) Description

Deployed

resources

The status (success or failure) of each deployed resource in the package named

under Deployment status.

Deployment

status

The name and status (success or failure) of the complete package.

Package Name A list of all available packages.

Federation Tab

This tab enables you to select which CITs or attributes are to be supported by the integration point. For

example, if a TQL query includes a node that represents a specific CIT, the instances of this CIT are

accepted from this external data repository.

For details about selecting CIs, see "CI Selector Overview" in the HP Universal CMDB Modeling Guide.

To access Select the Federation tab on the Integration Studio page.
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Important

information

This tab is enabled only when data federation is supported by the adapter on which

you are basing your integration point.

Relevant tasks "How to Work with Federated Data" on page 315

See also l "Integration Studio Overview" on page 310

l "New Integration Job/Edit Integration Job Dialog Box" on page 345

User interface elements are described below:

UI Element (A-Z) Description

Click to clear all selected items.

Click to invert the selections.

Click to expand the entire hierarchical tree structure.

Click to collapse the hierarchical tree structure.

CI Type Retrieval Mode l Retrieve CIs of selected CI Type. All a CI's data, including all its

attributes, are retrieved from the data repository.

l Retrieve selected attributes. The selected attributes are

retrieved from the data repository. The CIs must already exist in

the CMDB.

Note:

l A parent CIT and all its child CITs included in an integration

point definition must use the same retrieval mode.

l You cannot select both CITs and attributes for the same

integration point.

Select Attributes You can define which attributes of an external CIT are to be included in

the federation:

l In the CI Type Retrieval Mode pane, select Retrieve selected

attributes.

l In the Select Attributes list, select the attributes that are to be
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UI Element (A-Z) Description

included in the federation.

l Save the changes.

Note: Attributes are defined in the CIT Manager. For details, see

"Add/Edit Attribute Dialog Box" in the HP Universal CMDB Modeling

Guide.

Supported and Selected CI

Types

Displays a hierarchical tree containing the supported and selected CI

Types and attributes.

When queried by an TQL query, the CITs you select here are configured

to retrieve the data from this external data repository.

Select the CITs to be supported by this integration point.

Integration Jobs Pane

This pane enables you to schedule integration jobs to run with external data repositories. The Statistics,

Query Status, and Job Errors tabs display runtime details about the selected jobs.

To access l Select the Population or Data Push tab on the Integration Studio page.

l To access the Statistics, Query Status, or Job Error tabs, select an integration point,

select the Population or Data Push tab on the Integration Studio page, and then

select a job.

Important

information

This pane is displayed only when population or data push is supported by the adapter

on which you are basing your integration point.

Relevant

tasks

l "How to Work with Population Jobs" on page 316

l "How to Work with Data Push Jobs" on page 317

See also l "Integration Studio Overview" on page 310

l "Discovery Scheduler Dialog Box" on page 492

User interface elements are described below:
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UI Element (A-

Z) Description

New Integration Job. Enables you to create an integration job. For details, see

"New Integration Job/Edit Integration Job Dialog Box" on page 345.

Edit Integration Job. Enables you to edit an existing integration job.

Delete Integration Job. Deletes the selected integration job from the list.

Refresh. Refreshes the list of integration jobs.

Note: If you refresh the list of jobs before you save a new job, you are given a

choice:

l Yes. The job is saved and the integration is refreshed.

l No. The job is not saved and the integration is refreshed.

l Cancel. The job is not saved and the integration is not refreshed.

Run Job - Synchronize Changes. Runs the selected population or data push job

and synchronizes only the changes in the data since the last time the job was run.

By default, scheduled jobs synchronize only changes except for the first time a job

runs. In that case, a full population or data push job runs, in which all relevant data

for the job is synchronized.

Note:

l If the job is scheduled to run an all-data synchronization while you are

running a changes synchronization, the scheduled all-data synchronization

will run when the job has finished synchronizing the changes.

l If CIs in a data push job fail, the query is displayed in the Query Status tab

with the status: Passed with failures. You can drill down to see the errors

that occurred and the CIs affected. This error data is saved in the system.

When the job runs again to synchronize changes, UCMDB remembers the

failed CIs and repushes these as well. For details, see "Query Status Tab"

on page 339.

Run Job - Synchronize All Data. Runs a full population or data push job. This job

copies or pushes all the relevant data for the job.
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UI Element (A-

Z) Description

Note: If the job is scheduled to run a changes synchronization while you are

running an all-data synchronization, the scheduled changes synchronization

will run when the job has finished synchronizing all of the data.

Stop Running Job. Stops running the selected job.

Available for: Data Push jobs only

Clear Probe Results Cache. Clears the cache of all job results for this integration

from the Data Flow probe as well as the last time the data was synchronized. The

next time you run a synchronization, all the data is synchronized again.

Available for: Population jobs only

<right-click

integration job

menu>

In addition to the options described above, the right-click menu provides the

following functionality:

l Show Results For Job. DFM sends an ad hoc request to the Probe and retrieves

the latest results of the job.

This ad hoc request does not run the job, but brings the results of the previous

job run that are stored in the Probe's database. If the job has not yet run, a

message is displayed.

Available for: Population jobs only.

Note: Results are not displayed if the total number of results exceeds

10,000.

l View Communication log. Opens the log that includes information about the

connection between the Probe and the remote machine. This is on condition

that you have set the Create communication log to Always or On failure. For

details, see "Execution Options Pane" on page 253.

Available for: Population jobs based on Jython adapters only.

Job Name Name given to the population or data push job.

Last

Synchronization

The type of the last run:
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UI Element (A-

Z) Description

Type l None. The job has not yet run.

l Changes. The job synchronized only the changes in the data since the last time

it ran.

l Full. The job synchronized all the relevant data for the job.

Available for: Data push jobs only

Status Population jobs:

l Waiting for Probe. The job is waiting to be received by the Probe.

l Did not run. The job has been received by the Probe but the Probe is not yet

ready to run the job.

l Preparing to run. The Probe is preparing to run the job.

Note: The status is preceded by another instance of the Waiting for

Probe status, but this time Waiting for Probe indicates that the Probe is

now ready to prepare the job for the run.

l Running. The job is running.

l Completed Successfully. The job ran successfully.

l Completed. The job ran successfully but errors or warnings were reported. See

details on the errors or warnings in the "Query Status Tab" on page 339.

l Failed. The job did not run successfully.

l Disabled. The integration point is deactivated or the trigger CI is missing.

Data push jobs:

l Did not run. The job has not yet run.

l Running. The job is currently running.

l Ended. The period between Running and Succeeded or Failed.
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Z) Description

l Completed. The job ran successfully but errors or warnings were reported. See

details on the errors or warnings in the "Query Status Tab" on page 339.

l Completed Successfully.. The last run was successful.

l Failed. The last run was not successful.

Start time /

Finish time

The time that the integration job actually started running, and when it finished

running. These columns are refreshed every time the job goes into the Running

state.

Available for: Population jobs only

Statistics Tab

This tab displays information about the CIs synchronized by the job.

Note: Statistics for population jobs are accumulative and therefore can be filtered, whereas the

data push statistics are always relevant for the last job run only.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI

Element

(A–Z) Description

Refresh. Refreshes the details statistics displayed.

View Instances. Displays all new and updated CIs. Select a CIT and click:

l View Created Instances to display created CIs of the selected type

l View Updated Instances to display updated CIs of the select type

Available for: Population jobs only

Select the time range or Probe for which to display statistics about the selected job.

l By Time Range.
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Element

(A–Z) Description

o All. Displays statistics for all job runs.

o From Now/Last Minute/Last Hour/Last Day/Last Week. Choose a period of time

for which to display statistics about the CITs.

o Custom Range. Click to open the Change Timeframe dialog box: Enter the date or

click the arrow to choose a date and time from the calendar, for the From and To

dates (or click Now to enter the current date and time). Click Last Day to enter

the current date and time in the To box and yesterday's date and time in the

From box. Click OK to save the changes.

l By Probe. To view statistics for a specific Probe, select to open the Choose Probe

dialog box.

Available for: Population jobs only

<Statistics

table>

l CIT. (Population jobs only) The name of the discovered CIT.

l Query Name. (Data push jobs only) The name of the query whose data is being

pushed.

l Created. The number of CIs created in the period selected or for the selected Probe.

l Updated. The number of CIs that were updated in the period selected.

l Deleted. The number of CIs deleted in the period selected or for the selected Probe.

l Failed. The number of CIs that were not pushed.

Available for: Service Manager 9.3 adapter only

Note: For most adapters, when you repush the same CIs to a remote machine, the

CIs are reported as Created in the Statistics table. For the Cmdb10xAdapter,

AMPushAdapter and genericPushAdapter, the CIs are reported as Updated (actual

status).

Last

updated

The date and time that the results for the selected job were last updated.
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UI

Element

(A–Z) Description

Valid to The date when the data was last synchronized.

Query Status Tab

This tab displays information about the queries defined for the job.

Note: This tab is displayed for non-Jython data push and population integration adapters only.

User interface elements are described below:

UI

Element

(A–Z) Description

Refresh. Refreshes the list of queries.

Push selected failed data. Enables you to repush the selected query/CI manually.

Available: When a failed query or CI is selected

Suppress selected failures/warnings. Enables you to suppress errors for a selected

query/CI.

Available: When a failed query or CI is selected

Note: The Suppress feature removes the failed CI from the list of errors. The error

is displayed again if the CI fails at the next synchronization attempt.

<Query

details>

Displays the details of the selected job's queries:

l Query Name. The name of the query.

l Status.

o Population jobs. The latest status of the query after the job finishes running.

o Data push jobs. The current status or the last known status of the query. If a

query passed with failures, you can double-click the query to view the errors that
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UI

Element

(A–Z) Description

occurred and on which CIs they occurred. To repush the query, click the Push

selected failed data button. To suppress all the errors for the query, click

the Suppress selected failures/warnings button.

l Start Time/Finish Time. The time at which data push for this query started and

finished.

Available for: Data push jobs only

<Errors

and

warnings>

When you double-click a job that did not complete successfully, the table displays errors

and warnings that occurred, the CI type affected, and the number of CIs that failed.

Double-click a row to see the CIs that failed due to a particular error.

To repush the CIs, click the Push selected failed data button. To suppress all the

errors for the selected CI type, click the Suppress selected failures/warnings

button.

Available for: Data push jobs only

<Failed

CIs>

When you double-click an error or warning, the table displays the exact errors that

occurred, the CIs on which they occurred, and when they occurred. The CIs are

distinguished by their display label and external ID.

To repush the CI, click the Push selected failed data button. To suppress all the

errors for the selected CI, click the Suppress selected failures/warnings button.

Available for: Data push jobs only

Job Errors Tab

This tab displays the errors or warnings reported during the job run.

Note: This tab is displayed for Jython integration adapters only.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A–Z) Description

Refresh. Refreshes the list of errors.

View Details. Displays details about the selected error.

<List of error

messages>

l Message. A message describing warnings (if the job succeeded with warnings)

or the cause for failure if the job failed.

l Severity. For details, see Error Severity Levels in the HP Universal CMDB

Developer Reference Guide.

l Reported. The time at which the error is being reported by the job.

l Query. Displayed for data push jobs only. The name of the query for which the

error is being reported.

Integration Point Pane

This pane enables you to define integration points, and schedule population and data push jobs.

Integration points are based on adapters, each of which is predefined to transmit information in

specific ways. For example, CMDBAdapter populates CIs and links from a remote CMDB, in which case

the CMDB then has a local copy of these CIs, while the ServiceManagerAdapter adapter retrieves data

from HP ServiceCenter and HP Service Manager, but HP ServiceCenter or HP Service Manager still

retains control.

For details about defining a discovery adapter as an integration adapter, see the "Used as Integration

Adapter" field in "Adapter Definition Tab" on page 244.

To access Located in the left pane of the Integration Studio.

Relevant tasks l "How to Set Up an Integration Point" on page 319

l "How to Save an Integration Point Configuration as an Adapter Default" on page

322

l "How to Deploy a Package to a Remote Data Repository" on page 326

See also l "Data Push Tab" on page 330

l "Federation Tab" on page 331
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l "Population Tab" on page 353

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element

(A-Z) Description

New Integration point. Enable you to create an integration point. For details, see "New

Integration Point/Edit Integration Point Dialog Box" on page 349.

Edit Integration Point. Enables you to edit an integration point's properties.

Delete Integration Point. Deletes the selected integration point.

Save Integration Point. Saves the changes you made to the definition of an integration

point.

Refresh All Integrations. Refreshes the list of integration points and fully refreshes

the selected integration point.

Reload supported configuration for adapter. Refreshes the supported classes and

queries of the adapter for the selected integration point.

Activate Integration Point. Activates the selected integration point.

Deactivate Integration Point. Deactivates the selected integration point.

Import From XML. Enables you to import the integration point's configuration in XML

format.

Export To XML. Enables you to export the integration point's configuration in XML

format.

Note: You must save a new integration point before you can export its

configuration.

<List of

integration

points>

Displays the list of previously-defined integration points.

An icon appears next to each integration point indicating its status:

l . Indicates that the integration is deactivated.
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UI Element

(A-Z) Description

l . Indicates that there is an error for one or more of the jobs associated with the

integration point.

l . Indicates that there were failures and/or warnings for one or more of the jobs

associated with the integration point.

l . Indicates that there were no errors, failures, or warnings for the jobs

associated with the integration point or that no job was executed for the

integration.

Additionally, icons appears next to each third party integration point indicating its

status.

l . Indicates that there were no errors, failures, or warnings for the jobs associated

with the integration point.

l . Indicates that there is an error for one or more of the jobs associated with the

integration point.

l . Indicates that the adapters that are associated with the integration point were

removed.

l . Indicates that the integration is deactivated.

<right-

click

integration

point

menu>

In addition to some of the options described above, the right-click menu provides the

following functionality:

l Go to Adapter. Opens the adapter used by the integration job in the Adapter

Management module.

l Reconciliation Priority Manager. Opens the Reconciliation Priority Manager, a

centralized location for viewing and changing the reconciliation priority for all

integration points. For details, see "Reconciliation Priority Window" on page 781.

l Deploy Remote Package. Opens the Deploy Remote Package dialog box, enabling

you to deploy a package to a data repository located on a remote machine without

logging in to the remote machine. For details, see "How to Deploy a Package to a

Remote Data Repository" on page 326.

Data Flow Management Guide

Chapter 9: Integration Studio

HP Universal CMDB (10.22) Page 343 of 795



UI Element

(A-Z) Description

Note: This button is enabled for integration points based on the UCMDB 9.x

adapter (which supports package deployment capabilities).

l Save as Adapter Default. Opens the Save as Adapter Default dialog box, enabling

you to save the configuration of the selected integration point as an adapter

default that can be used as a basis for other integration points.

Enter a name and description for the adapter default, and specify the path where

the default adapter should be saved.

For example, to save an adapter default in a user-defined folder, in the Path box,

enter:

MyAdapters/Default

Note:

o Use forward slashes (/) to separate folders in the path

o If a path is not defined, the default adapter template is saved, by default,

under the same category as the adapter that it was based on.

l Edit Integration Resources. Opens the Adapter Management page where you can

edit the adapter resources. Only the resources defined by the adapter as related to

integrations are displayed in the Resources pane.

Integration Studio Page

This page enables you to create and manage integration points.

To access Select Data Flow Management > Integration Studio.

Relevant tasks l "How to Set Up an Integration Point" on page 319

l "How to Save an Integration Point Configuration as an Adapter Default" on page

322
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l "How to Deploy a Package to a Remote Data Repository" on page 326

See also "Integration Studio Overview" on page 310

User interface elements are described below:

UI Element (A-Z) Description

Integration Point pane Enables you to manage integration points. For details, see "Integration

Point Pane" on page 341.

Right pane Displays data transfer configuration options for an integration point.

Depending on the adapter on which you base your integration point, one

or more of the following tabs is enabled:

l "Data Push Tab" on page 330

l "Federation Tab" on page 331

l "Population Tab" on page 353

New Integration Job/Edit Integration Job Dialog Box

This dialog box enables you to create or edit population and data push jobs and to schedule them to be

run at specific times.

To access Click on the Population or Data Push tabs.

Relevant tasks l "How to Work with Federated Data" on page 315

l "How to Work with Population Jobs" on page 316

l "How to Work with Data Push Jobs" on page 317

See also l "Integration Studio Overview" on page 310

l "Integration Studio Page" on the previous page

l "Integration Jobs Pane" on page 333

User interface elements are described below:
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UI Element (A-Z) Description

Name Enter a name for the job.

Note: Naming conventions for jobs:

l Job names can contain the following characters: a-z, A-Z, 0-9, hyphen

(-), underscore (_), space ( )

l Job names must not start with a digit

l Job names must be limited to a length of 50 characters

Job Definition

area

Enables you select integration queries for the job definition. For details, see

"Job Definition" below.

Available for: Non-Jython adapters only.

Scheduler

Definition area

Enables you to schedule when to run the integration job.

For data push jobs, you can set different schedules for all-data synchronization

and change synchronization.

For details about the scheduling options, see "Scheduler Definition" on the next

page.

Job Definition

UI Element (A-Z) Description

Add Query. Opens the Add Query dialog box, enabling you to add an available

integration query to the job definition.

Delete Query. Enables you to delete the selected query from the job

definition.

Move Query Up/Down. Enables you to determine the order in which the

queries should run.

Edit Query Resources. Opens the Adapter Management page where you can

edit the adapter resources. Only the resources defined by the adapter as

related to the selected query are displayed in the Resources pane.

<Query table> Displays the queries selected for the integration job.
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For non-Jython-based Data Push jobs: Selecting a query's Allow Deletion

check box enables the deletion of CIs or relationships for the query from the

remote data repository. When you next perform a full synchronization, any

CIs or relationships removed from the local CMDB are also deleted from the

remote target.

Allow Integration

Job to delete

removed data

Enables the deletion of CIs or relationships per job from the local CMDB.

When you next perform a full synchronization, any CIs or relationships

removed from the remote source are also deleted from the local CMDB.

Available for: Non-Jython-based Population jobs only.

For details about defining CITs to be deleted by a Java-based population

adapter, see "How to Define CITs to be Deleted by Java-based Population

Adapters" on page 225.

Select the Job Type Enables you to select the type of job queries to use for the integration.

l Changes - History-based. CIs and direct links, not virtual links. Has better

performance.

l RMI - Full Topology Comparison. Supports CIs and all links types.

Note: Calculated links are not supported.

Available for: Service Manager Data Push jobs only

Scheduler Definition

UI Element (A-Z) Description

Cron Expression Enter a Cron expression in the proper format. For a description of the

fields used in Cron expressions and examples of how to use them, see

Cron Expressions in the HP Universal CMDB Modeling Guide.

Delta Synchronization

tab

Enables you to schedule a synchronization of the changes.

Available for: Data Push jobs only

Ends Enables you to select when the job should stop running.
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l Never. The job continues to run until manually stopped.

l Until. Enables you to select the date when the job should stop

running.

Note: This option is disabled when you select Once.

Full Synchronization tab Enables you to schedule a synchronization of all the data.

Available for: Data Push jobs only

Repeat Enables you to select how often to run the integration job. The available

options are:

l Once. Runs the job only once.

l Interval. Runs the job at a set time interval.

l Day of Month. Runs the job on selected days of the month.

l Weekly. Runs the job on a weekly basis, on the days of the week

selected.

l Monthly. Runs the job on a monthly basis, according to months

selected.

l Yearly. Runs the job every so-many years, according to the number

of years specified.

l Cron. Use a Cron expression to schedule a job. For a description of

the fields used in Cron expressions and examples of how to use

them, see Cron Expressions in the HP Universal CMDB Modeling Guide.

Repeat every Enables you to type a value for the interval between successive runs.

Available: When you select Repeat > Interval or Yearly.

Unit of time:

l Interval. Minutes; Hours; Days; Weeks

l Yearly. Years
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Repeat on l Sun - Sat. When you select Repeat > Weekly, enables you to select

the day or days of the week to run the job.

l January - December. When you select Repeat > Monthly, enables

you to select the months of the year to run the job.

Repeat on the following

dates every month

When you select Repeat > Day of Month, enables you select days of the

month to run the job. The job runs every month.

To clear the selection click .

Scheduler enabled When selected, you can choose scheduling options for the integration

job.

Server Time The time on the UCMDB server.

Starts Enables you to select the date and time when you want the job to begin

running.

Time Zone Enables you to set the required time zone. To reset default settings,

click Refresh

.

New Integration Point/Edit Integration Point Dialog Box

This dialog box enables you to create a new integration point or edit the properties of an existing

integration point.

To access Do one of the following:

l Click the New Integration Point button in the Integration Point pane.

l Click the Edit Integration Point button in the Integration Point pane.

Important

information

The list of fields contains all of the items that may be specified when you create an

integration point. Not all of the fields are displayed for all adapters.

Each mandatory field is marked with an asterisk.

Relevant

tasks

l "How to Set Up an Integration Point" on page 319

l "How to Work with Federated Data" on page 315

Data Flow Management Guide

Chapter 9: Integration Studio

HP Universal CMDB (10.22) Page 349 of 795



l "How to Work with Population Jobs" on page 316

l "How to Work with Data Push Jobs" on page 317

See also l "Integration Studio Overview" on page 310

l "HP UCMDB Integration Service" on page 30

l For Multi-tenancy users: "Integration in a Multi-Tenancy Environment" on page

314

User interface elements are described below

UI Element (A-Z) Description

Enables you to verify Probe connectivity using the parameters provided.

Note: If you have defined additional Probes, these Probes are tested

for connectivity as well.

Additional Probes Enables you to select additional probes over which to run a data push or

federation-type integration. Click to select the additional probes.

When the integration runs, if additional Data Flow Probes are defined, the

server uses the most available Probe.

Available for: Data push and federation-type integrations only.

Adapter The adapter for the integration point. Click to select an adapter. For

details about each adapter, see the list of supported out-of-the-box

integration adapters in the Supported Content section of the HP UCMDB

Discovery and Integrations Content Guide

For help on the selected adapter, click the Show Content Help button.

CMDB State (Data Push) The state of the source machine. Values are:

l Actual

l Authorized

Note: This field is visible only when using an adapter that supports

data push and on a UCMDB for which authorized state has been
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defined.

Credentials ID Enables you to select protocol credentials for relevant adapter integration

points. Click to open the Choose Credentials dialog box.

Note: Only the required protocols for the selected integration adapter

are displayed here. For information about protocols required for each

integration adapter see "Required Discovery Protocols Pane" on page

250.

Default Owner Name The name of the owner tenant that should be assigned to the federated or

populated CIs and relationships.

Note:

l This field is displayed when creating a federation or population

type integration point in a multi-tenancy environment only.

l If no owner tenant is specified, but the Data Flow Probe selected

for the integration point has an owner tenant, then the Data Flow

Probe owner tenant is assigned to all discovered CIs.

l The System Owner Tenant is assigned when:

o no owner tenant is specified, and no owner tenant is defined on

the Data Flow Probe

o the data source is not a multi-tenancy environment

Integration Description Enter a brief description of the integration point.

Integration Name Enter a name for the integration point.

Note: The name may not exceed 45 characters.

Is Integration

Activated

Select this check box to create an active integration point. Clear the check

box to deactivate an integration, for example, to set up an integration

point without actually connecting to a remote machine.
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Note: New integration points are set as inactive by default.

Data Flow Probe The name of the Data Flow Probe used to run integration jobs.

Do one of the following:

l Use the Auto-Select option. In this case, the CMDB attempts to choose

the correct Probe according to the IP ranges that were defined for the

available Probes.

l Select the name of a specific Probe to use for these integration jobs.

When you manually select a Probe, any ranges that you defined in the

Probe settings are ignored.

Note:

o If your remote managed data repositories are accessible from

the UCMDB server machine, you can use the UCMDB

Integration Service option to run non-Jython-based

integrations, instead of a Data Flow Probe.

If UCMDB Integration Service does not appear in the Data

Flow Probe list, ensure that the UCMDB Integration Service is

running on the UCMDB Server machine. For details, see "How to

Check the HP UCMDB Integration Service Status" on page 48.

o If your Probe is an integration probe, and it does not appear in

the Data Flow Probe list, ensure that it is connected.

Trigger CI Instance Displays the CI that is to be used by the new integration point as a trigger

during integration with CIs on a remote machine.

Click the Set Trigger CI button, and select one of the following:

l Select Existing CI. Enables you to select the trigger CI through which

data is collected during integration. For details, see CI Instances Dialog

Box in the HP Universal CMDB Modeling Guide.

l Create New CI. Enables you to create the topology of the CI to be used
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as the trigger. For details, see "Topology CI Creation Wizard" on page

355.

To manage or view the trigger CI, right-click the CI. For details on these

operations, see IT Universe Manager Page in the HP Universal CMDB

Modeling Guide.

Available for: Jython-based integration adapters only

Note: If the trigger CI instance used for the integration point is

deleted, the integration point's jobs become disabled and cannot run.

In this case, you must edit the integration point and select a new

trigger CI for the integration.

Note: Additional fields are available, depending on the adapter you select. Descriptions of each

field may be viewed by holding your mouse over that field on the screen. See the HP Universal CMDB

Developer Reference Guide for details about specific adapters.

Population Tab

This tab enables you to schedule population jobs and select the queries that are used to populate the

CMDB with data.

l Schedule jobs that populate the CMDB with data from external data repositories. For details, see

"Scheduler Definition" on page 347.

l View results for jobs that have run. For details, see "Statistics Tab" on page 337.

To access Select the Population tab on the Integration Studio page.

Important

information

This tab is enabled only when data population is supported by the adapter on

which you are basing your integration point.

Relevant

tasks

"How to Work with Population Jobs" on page 316

See also o "Integration Studio Overview" on page 310

Data Flow Management Guide

Chapter 9: Integration Studio

HP Universal CMDB (10.22) Page 353 of 795



o "HP UCMDB Integration Service" on page 30

o "New Integration Job/Edit Integration Job Dialog Box" on page 345

User interface elements are described below:

UI Element Description

Integration

Jobs pane

Enables you to specify the queries that are used to populate UCMDB with data, and

to schedule jobs that contain those queries.

For details, see "Integration Jobs Pane" on page 333.

Statistics tab Displays results for integration jobs that have run.

For details, see "Statistics Tab" on page 337.

Query Status

tab

Displays information about the queries defined for the integration job.

For details, see "Query Status Tab" on page 339.

Job Errors tab Displays the errors or warnings reported during the job run.

For details, see "Job Errors Tab" on page 340.

Select Adapter Dialog Box

This dialog box enables you to select from a list of predefined adapters that are provided out of the box.

You also have the option of adding a custom adapter for a new external data repository. For details, see

"Add an Adapter for a New External Data Source" in the HP Universal CMDB Developer Reference Guide.

The Integration Framework SDK enables you to create new adapters that connect HP Universal CMDB

with external products and services. For details, see "Developing Java Adapters" in the HP Universal

CMDB Developer Reference Guide.

To access Click in the New Integration Point/Edit Integration Point Dialog Box.

Relevant tasks l "How to Work with Federated Data" on page 315

l "How to Work with Population Jobs" on page 316

l "How to Work with Data Push Jobs" on page 317

See also "New Integration Job/Edit Integration Job Dialog Box" on page 345
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User interface elements are described below:

UI Element (A-Z) Description

Click to collapse the hierarchical tree structure.

Click to expand the hierarchical tree structure.

Click to display help about the selected adapter.

<list of adapters> Displays a list of out-of-the-box integration adapters.

l For details about multiple-UCMDB integration adapters, see "Integrating

Multiple CMDBs" on page 362.

l For details about adapters used to integrate UCMDB with other HP

products and Third-Party products, and about integration tools, provided

out-of-the-box with the Discovery and Integrations Content Pack, see HP

UCMDB Universal Discovery Content Guide - HP Integrations and HP UCMDB

Universal Discovery Content Guide - Third Party Integrations.

Topology CI Creation Wizard

This wizard enables you to save a topology to the CMDB for a new adapter. This adapter can include

elements from a defined topology already existing in the CMDB as well as new elements.

For example, say a node and its IP address exist in the CMDB as a defined topology. However, the

adapter Input query defines a Microsoft SQL Server database element related to that node. This

extended topology does not exist in the CMDB. When using the wizard to create the topology, CMDB

identifies the existing node and IP address by the properties values you enter, connects the new MSSQL

database CI to the topology, and saves the complete topology in the CMDB.

Note: You cannot use an abstract or federated CIT to create a Trigger CI.

To access Select a discovery Jython adapter in the New Integration Point dialog box. In the

Trigger CI Instance menu, choose Create New CI.

Note: This wizard is available for discovery Jython adapters only, when the

Used as Integration Adapter check box is selected in Adapter Management.

Moreover:
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l All conditions (attributes, cardinality, qualifiers, and so on) are

disregarded in the Input query.

l Only regular links (that is, not join or compound links) are allowed in the

Input query.

For details on the Used as Integration Adapter check box, see "Adapter

Definition Tab" on page 244.

Important

information

l Prerequisite: To ensure that reconciliation rules work with the created

topology, prepare details of the CIs (for example, values for key properties) as

these details are needed during the wizard creation procedure.

l If there are any errors during creation, the Summary page includes an error

message and a link to the error details.

l At the end of the topology creation, the source CI is defined as the Trigger CI

instance.

See also "New Integration Point/Edit Integration Point Dialog Box" on page 349

Wizard Map The Topology CI Creation wizard contains:

"Topology Preview" > "Define CI: <CI name>" > "Define Credentials" > "Topology

Creation" > "Summary"

Topology Preview

Enables you to preview the topology definition of the integration point.

Wizard

Map

The Topology CI Creation wizard contains:

Topology Preview > "Define CI: <CI name>" > "Define Credentials" > "Topology Creation"

> "Summary"

User interface elements are described below:

UI Element (A–Z) Description

Show Legend. Toggles between hiding and displaying the topology legend.

<toolbar and

legend>

For details, see Topology Map Sidebar in the HP Universal CMDB Modeling

Guide.
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Define CI: <CI name>

Enables you to define properties of a new CI instance of the CIT.

Important

Information

l This page of the wizard is displayed for each element in the query.

l Several elements of the same CIT may exist in the query.

Wizard Map The Topology CI Creation wizard contains:

"Topology Preview" > Define CI: <CI name> > "Define Credentials" > "Topology

Creation" > "Summary"

User interface elements are described below:

UI Element

(A–Z) Description

Define New

CI Properties

Drill down to the property to be used to identify the CIT. Select the field next to the

property name and enter a new value (or choose from existing values).

Note: If the selected CIT is abstract or federated, the properties are not

displayed.

Select CI

Type

Select the CIT for which you are defining a new CI instance.

Define Credentials

Enables you to define credentials for the new CI.

Important

Information

l Any changes you make here to a protocol (updating, adding, or removing) affect

the protocol throughout DFM. Therefore, you must ensure that changes you make

(for example, to a password) are valid. If the change is not valid, the Data Flow

Probe will fail to connect at the next attempt.

l Any updates you make here can be viewed in the Data Flow Probe Setup window.

For details, see "<Protocol> Details Pane" on page 98.

l This page is displayed if the adapter writer has defined that credentials are needed
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to access the discovered component.

See Also For details on using the buttons and shortcut menus, see "<Protocol> Details Pane" on

page 98.

For details on each protocol, see the HP UCMDB Discovery and Integrations Content

Guide.

Wizard Map The Topology CI Creation wizard contains:

"Topology Preview" > "Define CI: <CI name>" > Define Credentials > "Topology

Creation" > "Summary"

Topology Creation

Enables you to read through the topology details (the CIs and relationships that are to be created) and

make changes if required.

Important

Information

Review the topology. To make changes, click the Back button.

Wizard Map The Topology CI Creation wizard contains:

"Topology Preview" > "Define CI: <CI name>" > "Define Credentials" > Topology

Creation > "Summary"

Summary

Displays the result of the topology creation.

Important

Information

l If a success message is displayed, click Finish.

Note: For Population integration points, if at least one query ends with a

warning and no errors are encountered, a Success with warnings message is

displayed.

l A CI in the topology you create may be ignored by the reconciliation process if it

matches an existing CI. If the SOURCE CI in the topology is ignored, the topology

creation process fails. If another CI is ignored (any other node in the query),

creation succeeds. This is because the SOURCE CI is needed by the query to create

the Trigger CI. If it is ignored, the trigger cannot be identified and used for the
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integration. For details on the reconciliation process, see "Reconciliation Overview"

on page 756.

l If DFM cannot create the topology, an error message is displayed. Click the link to

review the error details in the ui-server.log file, located in the following folder:

C:\hp\UCMDB\UCMDBServer\runtime\log\.

Then, click Back to fix the error and run the wizard again.

Wizard Map The Topology CI Creation wizard contains:

"Topology Preview" > "Define CI: <CI name>" > "Define Credentials" > "Topology

Creation" > Summary

Limitations – Integration Studio

This section describes certain limitations on the Integration Studio functionality.

This section includes the following topics:

l "Limitations on Population Integrations" below

l "Limitations on Federation Integrations" on the next page

l "Limitations on Data Push Integrations" on the next page

Limitations on Population Integrations

1. When configuring a population job between two CMDBs, verify that the synchronized CITs are the

same in the two CMDBs.

2. When modifying a TQL query that is used in a population job, it is recommended to run a

differential synchronization before modifying the TQL and a full synchronization after modifying

the TQL. The differential synchronization removes any data that is no longer necessary as a result

of the updated query, and the full synchronization creates new baseline data on the target system.

3. After a job runs successfully, its status remains Succeeded even after the job definition is changed

(for example, selecting another TQL query or enabling deletion) and saved.
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Limitations on Federation Integrations

1. When a virtual link exists between two data repositories, HP Universal CMDB supports mapping in

the following cases only:

o The UCMDB integration point lies at one end of the link and multiple data repositories lie at the

other end. The Cartesian product is calculated for A’s data repository (UCMDB) and B’s data

repositories (UCMDB, d2, d3).

o The same data repositories lie at both ends of the link. The link is an internal link of each data

repository and no mapping is required.

2. When changes are made in the Modeling Studio and these changes affect the results of a TQL

query, federated CIs in the view are not updated. This is because federated TQL queries are

calculated ad hoc only and are not updated when a view is recalculated. To update the federated

CIs, select the view in the CI Selector and click the Refresh CIs Tree button. (Note that the

recalculation may take a long time.) For details, see "Browse Views Mode" in the HP Universal CMDB

Modeling Guide.

3. You cannot edit the values of attributes that are configured to be retrieved from both an external

data repository and UCMDB during federation.

Limitations on Data Push Integrations

1. After modifying a TQL query that is used in a data push job, it is recommended to run a differential
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synchronization before modifying the TQL and a full synchronization after modifying the TQL. The

differential synchronization removes any data that is no longer necessary as a result of the

updated query, and the full synchronization creates new baseline data on the target system.

2. The Universal CMDB cannot push static attributes.
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Chapter 10: Integrating Multiple CMDBs
This chapter includes:

Integrating Multiple CMDBs Overview 362

Use Cases – Multiple CMDB Deployments: Discovery-CMS Solution 363

Multiple Deployments with Version 9.x/10.x CMDBs Using Population 364

Multiple Deployments with Version 9.x/10.x CMDBs Using Data Push 368

Federation in Version 9.x/10.x CMDBs 369

How to Perform Initial UCMDB-UCMDB Synchronization 370

How to Configure Global ID Generation 371

How to Use SSL with the UCMDB 9.x/10.x Adapter 372

How to Set Up Integrations Between Multiple CMDBs 373

How to Push Data from Authorized State to Actual State 379

Troubleshooting and Limitations – Multiple CMDB Integration 380

Integrating Multiple CMDBs Overview

Multiple CMDBs is a solution that allows setting up a multiple number of CMDBs for delegating the

workload and responsibility of the solution to the different CMDBs.

The Configuration Management System, CMS, is the central CMDB server and is the authority for

configuration management in the multiple CMDBs solution. It is responsible for integrating between the

different CMDB server instances and other services in the solution, as well as for generating global IDs.

The global ID is a unique CI ID that identifies that CI across the entire portfolio, making it easier to work

in multiple CMDB environments. The global ID is generated by the CMS or another CMDB that has been

designated as a global ID generator for that CI type. The class model contains the global_id_scope

attribute, which is used to specify the scope to which a particular CI type belongs. In the JMX console,

you can specify the scopes for which global IDs will be generated. For details, see "How to Configure

Global ID Generation" on page 371.

Most of the integrations are defined in the CMS, and other CMDBs or services only access the CMS to

access the data from these CMDBs or services.
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The CMS allows integration with other services using:

l Population

l Federation

l Data Push

l Data Flow Management Web Service API

l Soap Web Service

Note: Synchronization between multiple CMDBs of different versions can be performed only

between UCMDB versions 9.02 or later.

Use Cases – Multiple CMDB Deployments: Discovery-CMS

Solution

The Discovery-CMS solution enables the division of the workload and Discovery capacity over more than

one CMDB.

l Discovery 1 CMDB

l Discovery 2 CMDB

l The central CMDB acting as the CMS

Both Discovery CMDBs are responsible for running different discovery jobs in the domain, and containing

all the discovered topology. The CMS populates the node, interface, and IP from both Discovery CMDBs,

and federates the node resource CIs (CPU, file system, and printer) from Discovery 1 CMDB. The CMS

federates the node resource CIs (OS user, process, and printer) from Discovery 2 CMDB. When a user

runs a view that requests these resources on the CMS, they are brought seamlessly using federation.
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Multiple Deployments with Version 9.x/10.x CMDBs Using

Population

When you use the UCMDB 9.x or UCMDB 10.x adapter to create an integration point, you are able to

synchronize data between different CMDB instances using either population or data push. For details on

the data push method, see "Multiple Deployments with Version 9.x/10.x CMDBs Using Data Push" on

page 368.

This section includes:

l "Population from UCMDB 9.x/10.x (CMS Synchronization)" below

l "Query Support" below

l "Global ID Synchronization" on the next page

l "Automatic Completion of Reconciliation Data" on page 367

Population from UCMDB 9.x/10.x (CMS Synchronization)

During population, global IDs are synchronized. For details, see "Global ID Synchronization" on the next

page.

For details on population, see "How to Work with Population Jobs" on page 316.

Query Support

In the population flow, the job queries are retrieved from the remote UCMDB.

Two types of queries are supported for population jobs:

l Live queries. All non-federated TQL queries, when they are used for population with the UCMDB

9.x/10.x adapter.

Live queries require less bandwidth, and cause less load on the source system. There may be a short

delay from the time the change is made until the live query mechanism or the population job

receives the change (this may take up to several minutes).

Subgraphs and compound relationships are supported in queries. When using compound

relationships, you must select Show full path between source and target CIs in the Compound

Relationship properties of the query.
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l Federated queries. Queries that contain at least one federated node or attribute.

When the UCMDB 9.x/10.x adapter is used, federated queries may also be used for population.

Federated queries are calculated each time the integration is performed; the entire result set is

retrieved and filtered by the Probe.

The deletion of CIs is not supported. The aging mechanism must be used, since no information about

the deletion of CIs or links is populated. For details, see CI Lifecycle and the Aging Mechanism in the

HP Universal CMDB Administration Guide.

You can create TQL queries for integration. For details, see Topology Query Language in the HP

Universal CMDB Modeling Guide.

Global ID Synchronization

The following examples describe two types of synchronization that can be performed:

l Two-way ID synchronization

Synchronization of data occurs in both directions between two UCMDB instances.

The CMS uses the population flow to retrieve data from UCMDB-B, which may be any UCMDB. UCMDB-

B uses the population flow to populate data from the CMS.

Because synchronization is performed in two directions, global IDs are also updated on UCMDB-B.
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l Pushback of IDs

The CMS uses the population flow to retrieve data from UCMDB-B. CIs are reconciled with the data in

the CMS.

The global-ID in the CMS for each CI received is pushed back to UCMDB-B.
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The default state of this option is disabled.

For details about enabling the pushback of IDs, see "How to Set Up Integrations Between Multiple

CMDBs" on page 373.

Automatic Completion of Reconciliation Data

The UCMDB 9.x/10.x adapter automatically retrieves data needed for the reconciliation process of the

CIs brought by the population flow. The actual data retrieved is determined by the reconciliation rule

defined for the CITs of the TQL query. This is necessary to ensure that the identification process is

executed accurately and no CIs are incorrectly merged.

For example, if your population TQL query includes a node but does not have any layout selected, the

actual data that enters the CMDB is:
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l Nodes, with layout

o name

o bios_uuid

o serial_number

o additional data, according to the defined reconciliation rule

l IP Addresses, with layout

o name

o routing_domain

l Interfaces, with layout

o mac_address

o interface_name

Note:

o The automatic completion feature may actually synchronize many more CIs or links than you

intend.

o The automatic completion feature always retrieves the Global ID.

o By default, if data required for the reconciliation of a particular CI cannot be retrieved (for

example, if the data is missing in the source), that CI is ignored without causing the entire job

to fail. You can change this behavior in the CmdbAdapter configuration. For details, see

"Adapter Configuration Tab" on page 252.

Multiple Deployments with Version 9.x/10.x CMDBs Using

Data Push

When you use the UCMDB 9.x or UCMDB 10.x adapter to create an integration point, you are able to

synchronize data between different CMDB instances using either population or data push. For details on
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the population method, see "Multiple Deployments with Version 9.x/10.x CMDBs Using Population" on

page 364.

For details on the data push flow for setting up an integration between multiple CMDBs, see "How to Set

Up Integrations Between Multiple CMDBs" on page 373.

Limitations

The following limitations apply to the data push method:

l An integration point for data push can only be defined in UCMDB version 10.01 or above.

l The target CMDB must be either UCMDB version 9.05 CUP 9 and later CUPs, or UCMDB version 10.01

and above (it is not supported for UCMDB version 10.00).

l A single TQL query in the data push flow is limited to 5 million CIs and relationships. This limitation is

only for a single query; multiple TQL queries in multiple jobs may exceed this limit.

l Data Push is not supported for virtual links.

In the data push flow, a local TQL query collects data from the local CMDB and pushes this data to the

remote CMDB. The adapter filters out unsupported CITs and relationships, and it also filters out any

invalid-links and attributes.

Note: Data push is also supported for CIs and relationships from federation adapters with their

LastModifiedTime property.

Auto Complete Reconciliation

When pushing CIs or relationships to a remote CMDB, any CI or attribute that is needed for reconciliation

(according to the remote CMDB reconciliation rules) is automatically added to the CIs and attributes

already requested. This is necessary to ensure that the identification process is executed accurately

and no CIs are incorrectly merged.

Note: This may cause more data than originally selected in the TQL query to be transferred.

Federation in Version 9.x/10.x CMDBs

Federation allows the CMDB to retrieve data in real time (on-the-fly) from any remote data repository,

and combine it with the CMDB's internal data to show a complete picture of the configuration it
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manages, including multiple sources. For more information about federation, see "How to Work with

Federated Data" on page 315.

Using the UCMDB 9.x/10.x adapter to federate data from different CMDBs, enables the federation of

any CIT in the model. This means that only a small portion of data from the remote CMDBs can be

populated, and the rest of the data is federated on demand. This ability enables the delegation of the

information to multiple CMDBs, with the CMS always showing the most updated data available and at

the same time not overloading its capacity.

A CMS populates the Node, Interface, and IP from a Discovery CMDB (a CMDB whose role is to run

Discovery), and defines the CPU, File System, OS, User, Printer, and Process CIs as federated from the

same source. When a user runs a TQL query or view that has any federated CITs, these specific CIs are

brought in real time from the Discovery CMDB. They are therefore as updated as the Discovery CMDB

and do not depend on the population schedule to receive updated information. In addition, these CIs

only reside on the Discovery CMDB, and do not burden the capacity of the CMS.

The CMDB 9.x/10.x adapter supports the delegation of the federation capabilities, providing the ability

to set up a single point for data retrieval (usually the CMS). Any CMDB or service that uses the CMDB's

ability to delegate federation uses the CMDB as a virtual black box, and is unaware of whether data

comes directly from the CMS or from an external integration.

Note: When you set up a federation flow, be careful not to cause an endless loop. For example, do

not set up CMDB-X to federate data from CMDB-Y, and at the same time CMDB-Y to federate data

from CMDB-X.

How to Perform Initial UCMDB-UCMDB Synchronization

This procedure performs a full synchronization of CIs and relations between CMDBs, while retaining the

original CMDB IDs. CIs are replicated from the external CMS to the UCMDB. The procedure is generally

intended to be performed only once, on a new system.

1. Launch a Web browser that connects to the CMS, and enter the following address: http://<CMS

server>:8080/jmx-console.

2. Click UCMDB:service=Multiple CMDB Instances Services to open the JMX MBEAN View page.

3. Click the fetchAllDataFromAnotherCMDB method.

4. Enter values as required for the following fields:
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Note: You must enter information in fields that do not have default values.

o Customer ID

o Remote user name

o Remote password

o Remote host name

o Remote port 8080

o Remote Customer name (default value is Default Client)

o Maximum chunk size

o CI type to sync (default value is managed_object, causing all CI types to be synchronized)

o Relation type to sync (the default value is managed_relationship, causing all relation types to

be synchronized)

5. Click Invoke.

How to Configure Global ID Generation

1. Launch the Web browser and enter the following address:

http://<CMS server>:8080/jmx-console.

2. Click UCMDB:service=Multiple CMDB Instances Services to open the JMX MBEAN View page.
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3. Click one of the following methods and enter values as required:

setAsGlobalIdGenerator Specifies that the CMDB will act as the global ID generator

for all locally existing scopes

setAsGlobalIdGeneratorForScopes Specifies the scopes for which global IDs will be generated

setAsNonGlobalIdGenerator Stops the CMDB from acting as the global ID generator for

all scopes

4. Click Invoke.

Note: If you want to check which scopes are currently set, use the getGlobalIdGeneratorScopes

method.

How to Use SSL with the UCMDB 9.x/10.x Adapter

If the remote UCMDB server uses a certificate signed by a known certificate authority, selecting the

HTTPS (SSL) value in the Protocol field is sufficient.

If not, add the remote UCMDB server certificate to the local UCMDB JVM Trusted Stores as follows:

1. Export the remote UCMDB self-signed certificate by executing the following command (on the

remote server machine):

c:\hp\UCMDB\UCMDBServer\bin\jre\bin\keytool.exe -exportcert -
keystore c:\hp\UCMDB\UCMDBServer\conf\security\server.keystore -
alias hpcert -storepass hppass -file remoteServer.cert

2. Copy the certificate to UCMDB at C:\hp\UCMDB\UCMDBServer\bin\jre\bin and to the Data Flow

Probe at C:\hp\UCMDB\DataFlowProbe\bin\jre\bin.

3. Locate the JRE security folder, by default located in

C:\hp\UCMDB\UCMDBServer\bin\jre\lib\security\ and also at

C:\hp\UCMDB\DataFlowProbe\bin\jre\lib\security\.

4. Back up the cacerts file by copying it to another folder.

5. Open a command line window and execute the following commands on the local UCMDB and Data
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Flow Probe (to import the previously created or copied certificate):

cd C:\hp\UCMDB\<UCMDBServer/DataFlowProbe>\bin\jre\bin
keytool.exe -import -storepass changeit -keystore
c:\hp\UCMDB\<UCMDBServer/DataFlowProbe>\bin\jre\lib\security\
cacerts -trustcacerts -file
C:\hp\UCMDB\<UCMDBServer/DataFlowProbe>\bin\jre\bin\remoteServer.cert

6. At the command line prompt "Trust this certificate?", enter 'yes'.

7. Restart the UCMDB service and the Data Flow Probe service.

How to Set Up Integrations Between Multiple CMDBs

The following steps describe how to create integration points and jobs to integrate between multiple

CMDBs:

l "Define an integration point" below

l "Define and run a population job" on page 376

l "Define and run a data push job" on page 377

l "Select CI types and attributes to be federated" on page 377

1. Define an integration point

a. Navigate to Data Flow Management > Integration Studio.

b. Click the New Integration Point button to open the New Integration Point Dialog Box. For

details, see "New Integration Point/Edit Integration Point Dialog Box" on page 349.

Enter the following information:

Name (A-Z)

Recommended

Value Description

Integration

Name

<user defined> The name you give to the integration point.
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Name (A-Z)

Recommended

Value Description

Integration

Description

<user defined> Free text that describes the integration point.

Adapter UCMDB 9.x or

UCMDB 10.x

The adapter that is used to integrate between multiple

CMDBs.

Is

Integration

Activated

selected Select this check box to create an active integration point.

Hostname/IP <user defined> The name or IP address of the remote CMDB machine.

Port 8080 The port listened to by the HP UCMDB API.

Web

application

Root

Context

<user defined> The root context value of the remote CMDB. If no root

context is defined on the remote CMDB, leave this field

empty.

Protocol HTTP Selects the protocol to be used for connecting to the

remote CMDB. Valid values are:

l HTTP

l HTTPS (SSL)

Credentials

ID

Remote

UCMDB

If you must create a new credential protocol, use the

Generic Protocol as a basis. For details, see HP UCMDB

Discovery and Integrations Content Guide.

Customer

Name

<user defined> The name of the remote UCMDB from which you want to

retrieve data.

Remote

Machine

State

<user defined> The state with which you want to connect when integrating

with multi-state CMDBs.

l Actual

l Authorized
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Name (A-Z)

Recommended

Value Description

Push Back

Ids For

Population

<user defined> Introduced in version 10.21, allows you to schedule the

pushback of global IDs after CIs are populated into UCMDB,

without creating an integration point when using UCMDB

10.x adapter.

Valid values: Enabled, Disabled. Default: Disabled.

Push Back

Ids For Push

<user defined> Introduced in version 10.21, allows you to schedule the

pushback of global IDs after CIs are pushed into UCMDB,

without creating an integration point when using UCMDB

10.x adapter.

Valid values: Enabled, Disabled. Default: Disabled.

Data Flow

Probe

<user defined> Specifies which data flow probe will be used by the

integration.

Default

Owner Name

<user defined> The name of the owner tenant that should be assigned to

the federated or populated CIs and relationships.

Note:

l This field is displayed when creating a federation

or population type integration point in a multi-

tenancy environment only.

l If no owner tenant is specified, but the Data Flow

Probe selected for the integration point has an

owner tenant, then the Data Flow Probe owner

tenant is assigned to all discovered CIs.

l The System Owner Tenant is assigned when:

l no owner tenant is specified, and no owner

tenant is defined on the Data Flow Probe

l the data source is not a multi-tenancy
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Name (A-Z)

Recommended

Value Description

environment

Additional

Probes

<user defined> Additional probes over which to run a federation-type

integration. Click to select the additional probes.

When the integration runs, if additional Data Flow Probes

are defined, the server uses the most available Probe.

c. Click Test Connection to ensure that the integration point has been successfully created, and

then click OK.

d. Click OK.

You can use your integration point with any of the methods described below, population jobs, data

push jobs, or federation.

2. Define and run a population job

An out-of-the-box integration point already contains population jobs. This step is relevant only

when creating additional population jobs.

Select the Population tab to define a population job that uses the integration point you defined

above. For details, see "New Integration Job/Edit Integration Job Dialog Box" on page 345.

Note:

o When integrating between multiple CMDBs, population queries must be set up for the

source CMDB.

o Select the Allow Integration Job to delete removed data check box if you want your

population job to allow deletion of CIs and links from the source CMDB.

o By default, infrastructure CIs and containment relationships are deleted. All other CIs and

relationships are retained.

o For Multi-tenancy users: When running population with the Cmdb10xAdapter in a multi-

tenancy environment, the tenants are automatically synchronized. To receive changes
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about the tenants (owner and user), Owner Tenant and Consumer Tenants must be

defined in the TQL query layout.

Click the Run Changes Sync button to make sure that the integration has been successfully

configured.

3. Define and run a data push job

Select the Data Push tab to define a data push job that uses the integration point you defined

above. For details, see "New Integration Job/Edit Integration Job Dialog Box" on page 345.

Note:

o When integrating between multiple CMDBs, data push queries must be set up on the local

CMDB.

o Select the Allow Deletion check box for each query if you want your data push job to allow

deletion of CIs and links from the remote CMDB.

o By default, infrastructure CIs and containment relationships are deleted. All other CIs and

relationships are retained.

o For Multi-tenancy users: When running data push with the Cmdb10xAdapter in a multi-

tenancy environment, the tenants are automatically synchronized. To receive changes

about the tenants (owner and user), Owner Tenant and Consumer Tenants must be

defined in the TQL query layout.

Click the Run Changes Sync button to make sure that the integration has been successfully

configured.

4. Select CI types and attributes to be federated

a. Navigate to Data Flow Management > Integration Studio.

b. Click the Federation tab.

c. Select the CI types you want to federate from the source CMDB.

If desired, you can select only attributes to be federated. For details, see "Federation Tab" on

page 331.
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d. Click Save Integration Point .

How to Enable Scheduling Pushback of Global IDsWhen Using

UCMDB 10.x Adapter

As an integration administrator, starting from version 10.21, you are able to schedule the pushback of

global IDs without creating an integration point when using UCMDB 10.x adapter.

Two new settings are added to the Create/Edit Integration Point dialog box if you select the UCMDB 10.x

adapter (Cmdb10xAdapter):

l Push Back Ids For Population. Specifies whether you want to push back global IDs after CIs are

populated into UCMDB. Valid values: Enabled, Disabled. Default: Disabled.

l Push Back Ids For Push. Specifies whether you want to push back global IDs after CIs are pushed

into UCMDB. Valid values: Enabled, Disabled. Default: Disabled.

Note:

l For links, these two settings work only if you create integrations between the following UCMDB

versions:

o From 10.21 to 10.21
o From 10.21 to 10.11 CUP5
o From 10.11 CUP4 to 10.11 CUP5
o From 10.11 CUP5 to 10.21

Otherwise this functionality does nothing, it will just log an error message “Push back ids for

links is not supported. Probably the target server version does not support this functionality".

l For CIs, the new settings work on all versions of UCMDB.

To enable scheduling pushback of global IDs,

1. Check and make sure that the <push-back-ids> tag as follows is present in the adapter-
capabilities section of the adapter configuration file:

<support-replicatioin-data>
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<target>
<push-back-ids/>

</target>
</support-replicatioin-data>

2. Configure the integration point.

o Open an existing integration point and set Push Back Ids For Population or Push Back Ids For

Push to Enabled.

o Create a new integration point and set Push Back Ids For Population or Push Back Ids For

Push to Enabled.

How to Push Data from Authorized State to Actual State

UCMDB allows you to create an integration point by using a new adapter called Local State Push

Adapter to push data from the authorized state to the actual state. You can use a TQL query to specify

the data being pushed.

To do this, follow these steps:

1. Log in to UCMDB in the authorized state, and then go to Data Flow Management > Integration

Studio.

2. Click New Integration Point, and then specify the following integration properties:

Integration Name: Specify the name of the new integration point.

Adapter: Select Local State Push Adapter.

Is Integration Activated: Select this option

3. Specify the adapter properties:

Local Customer Name: Specify the customer.

Local State: Select Actual.

4. Click OK.

After you create the integration point, you need to create an integration job and specify the TQL query

in the Job Definition. For more information about how to do this, see the following topics:
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l "New Integration Job/Edit Integration Job Dialog Box" on page 345

l "How to Work with Data Push Jobs" on page 317

Troubleshooting and Limitations – Multiple CMDB

Integration

Troubleshooting

When performing troubleshooting, be sure to check both CMDB server and Probe logs.

l CMDB server logs

o fcmdb.log

o fcmdb.adapters.log

o error.log

o cmdb.reconciliation.log (for population jobs)

l Probe logs

o wrapperProbeGw.log

o fcmdb.log

o fcmdb.adapters.log

o probe-infra.log

Following are some problems that you may encounter and their solutions.

l Problem. TQL query not active/persistent error message.

The Query settings have been changed manually.

Solution. Run full population to reactivate/persist the query.

l Problem. The number of CIs that is populated is much larger than the requested amount.
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Solution. Since the automatic completion feature for reconciliation is turned on by default, it may

populate the CMDB with additional CIs or links, in order to contain sufficient information to insert the

CIs into the CMDB.

l Problem. Changes are not populated immediately after a job is run.

Changes may take a few minutes to be detected by the live mechanism.

Solution. Wait a few minutes for changes to be populated by your next population job.

l Problem. CIs are not populated into the CMDB.

Changes may take a few minutes to be detected by the live mechanism.

Solution. Wait a few minutes for changes to be populated by your next population job.

Check the CMDB reconciliation logs for more information.

l Problem. Deletions are not populated.

Solution:

o Make sure that you have selected the Allow Delete check box in the population job properties.

o Check the query you are running. Deletes are not supported on federated queries, and the aging

mechanism must be used.

l Problem. Queries that contain compound relationships fail.

Solution. Select Show full path between source and target CIs in the query's Compound

Relationship properties.

l Problem. Authentication fails.

Solution. Since the UCMDB 9.x /10.x adapter uses the UCMDB API for connection, set up an

integration user to ensure that you provide proper credentials. For details, see "Create an

Integration User" in the HP Universal CMDB Developer Reference Guide.

l Problem. TQL query not active/persistent error message.

The Query settings have been changed manually.

Solution. Run full population to reactivate/persist the query.

l Problem. The number of CIs that is populated is much larger than the requested amount.
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Solution. Since the automatic completion feature for reconciliation is turned on by default, it may

populate the CMDB with additional CIs or links, in order to contain sufficient information to insert the

CIs into the CMDB.

l Problem. Changes are not populated immediately after a job is run.

Changes may take a few minutes to be detected by the live mechanism.

Solution. Wait a few minutes for changes to be populated by your next population job.

l Problem. CIs are not populated into the CMDB.

Changes may take a few minutes to be detected by the live mechanism.

Solution. Wait a few minutes for changes to be populated by your next population job.

Check the CMDB reconciliation logs for more information.

l Problem. Deletions are not populated.

Solution:

o Make sure that you have selected the Allow Delete check box in the population job properties.

o Check the query you are running. Deletes are not supported on federated queries, and the aging

mechanism must be used.

l Problem. Queries that contain compound relationships fail.

Solution. Select Show full path between source and target CIs in the query's Compound

Relationship properties.

l Problem. Authentication fails.

Solution. Since the UCMDB 9.x /10.x adapter uses the UCMDB API for connection, set up an

integration user to ensure that you provide proper credentials. For details, see "Create an

Integration User" in the HP Universal CMDB Developer Reference Guide.

l Problem. The Data Push job fails with the message “Remote UCMDB version is not supported.”

Solution. The Data Push flow only supports pushing to UCMDB version 9.05 CUP 9 and later CUPs, or

UCMDB version 10.01 and later (it does not support pushing to UCMDB version 10.00). Upgrade your

remote UCMDB or alternatively, run the integration using the population flow.
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Limitations

l If the TQL query for a population job (defined on the source) includes CI types or links that do not

exist on the target, or links that are not valid, those types or links are ignored in the target data

repository.

l Since the UCMDB 9.x/10.x adapter works with the "changes" population engine, if a population flow

retrieves federated data, no removals are made in the CMDB, since the federation brings only added

or updated data.
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Chapter 11: Integrating UCMDB with CyberArk
Enterprise Password Vault
This section includes:
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How to Add CyberArk Credential for Protocols from JMX 408
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Overview

CyberArk’s Application Identity Management solution uses the Privileged Account Security solution to

eliminate the need to store application passwords embedded in applications, scripts or configuration

files, and allows these highly-sensitive passwords to be centrally stored, logged and managed within the

Vault. This unique approach enables organizations to comply with internal and regulatory compliance

requirements of periodic password replacement, and monitor all activities associated with all types of

Privileged Identities whether on-premise or in the cloud, across operating systems, databases,

applications, hypervisors, network devices, and more.

The integration between UCMDB and CyberArk's Application Identity Management allows Universal

Discovery administrators to configure credentials for supported Universal Discovery protocols, which

enables administrators to manage the credentials in a secure and easy way.

Instead of storing the passwords themselves in UCMDB/UD, this integration involves storing only

references (in the CyberArk Enterprise Password Vault part of the Privileged Account Security Solution)

to the passwords, and retrieving (using CyberArk’s AIM SDK) the passwords when they are needed from

the digital vault using the stored references.

Deployment

The following diagram illustrates the overall deployment.
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How the CyberArk Integration Works

The CyberArk integration enables UCMDB/UD to retrieve usernames and passwords from the CyberArk

Enterprise Password Vault as follows:

1. Administrators to create a Safe, Application, and Account on the CyberArk Server, including

username, password, and unique reference ID.

2. Universal Discovery administrators to create a credential on UCMDB Server, using the same

CyberArk Safe, Application, and Account values created in step 1 as reference ID in the following

format: <Safe_Name>\<Folder_Path>\<Reference_ID>

3. The CyberArk integration synchronizes the CyberArk references to Data Flow Probes. No password

information contained.

4. Universal Discovery administrators to run discovery jobs using the unique referenceID to retrieve

username and password from CyberArk.

Supported Versions

Supported CyberArk Versions

This integration supports CyberArk’s Digital Vault v7.x, v8.x, and v9.x.

Supported Probe Types

This integration supports probes on the Windows platform only.

Platform Probe Mode Supported?

Windows Union Yes

Separate Yes

Probes on Linux No

Integration Services No
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Supported Protocols

The following table describes protocols supported by CyberArk integration from UCMDB UI or supported

from JMX console.

Protocols Supported from UCMDB UI (with

CyberArk-related fields available) Protocols Supported from JMX (no UI fields)

l AS400

l AWS

l CA CMDB

l Generic DB

l Generic

l HP SIM

l HTTP

l NetApp

l NTCMD

l Powershell

l Remedy

l SNMP

l SSH

l Telnet

l vCloud

l WMI

l Asset Manager

l CIM

l HP Network Automation Java

l JBOSS

l LDAP

l NNM

l SANscreen

l SAP JMX

l SAP

l ServiceNow

l Siebel Gateway

l TIBCO

l UCS

l VMware VIM

l WebLogic

l WebSphere

l Protocols Supported from UCMDB UI. When CyberArk integration is enabled, two radio buttons

(Regular Credential and External Vault) are enabled in the Protocol Parameters dialog box. The
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existing attributes Username and Password are grouped under the Regular Credential radio button,

and two new attributes (Type and Reference) grouped under the External Vault radio button. For

details about the protocol attributes, see the section about the supported protocols in the HP

UCMDB Universal Discovery Content Guide - Supported Content.

l Protocols Supported from JMX. There are no CyberArk related fields in the Protocol Parameter

dialog box when the CyberArk integration is enabled, but you can run add CyberArk credential

reference to these protocols with the help of JMX methods. For details, see "How to Add CyberArk

Credential for Protocols from JMX" on page 408.

How to Configure CyberArk Integration

This section includes:

CyberArk Integration Configuration Workflow 389

How to Configure CyberArk Integration 390

How to Create and Configure CyberArk Account for the Integration 399

How to Add CyberArk Credential for Protocols from JMX 408
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CyberArk Integration Configuration Workflow

The diagram below illustrates the overall workflow for configuring CyberArk integration.
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How to Configure CyberArk Integration

This section contains detailed instructions about how to configure the CyberArk integration.

Note: Make sure that only administrators have the write permission to the <DataFlowProbe_

Home> directory.

1. Install CyberArk Credential Provider

Install CyberArk Credential Provider (in AIM mode) on each of the supported Probe servers. For

detailed instructions about how to install CyberArk Credential Provider, refer to the Credential

Provider and ASCP Implementation Guide.

Note: If the Probe is Manager, install the CyberArk Credential Provider on the Probe Manager.

For a Probe in separate mode, install the CyberArk Credential Provider together with the Probe

Manager.

For detailed instructions, refer to the CyberArk Credential Provider and ASCP Implementation Guide.

2. Configure CyberArk for the integration

Create a Safe, a CyberArk account, and an application ID in CyberArk, and configure CyberArk for

the integration.

For detailed instructions, see "How to Create and Configure CyberArk Account for the Integration"

on page 399.

3. Test connection

Go to the Probe server, run the checkCyberArkConn.bat tool using the following command: 

<DataFlowProbe_Home>\tools\checkCyberArkConn.bat "<SDK_Path>" <Safe_Name>
<Folder_Path> HPE_UniversalDiscovery <ReferenceID>

where,

<SDK_Path> is the path of the CyberArk Java Password SDK.

<Safe_Name> is the name of the CyberArk Safe you created in step 2.
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<Folder_Path> is the folder for CyberArk Safe. If not specified, it is Root by default.

HPE_UniversalDiscovery is the CyberArk application ID you created in step 2.

<ReferenceID> is the name of the CyberArk account you specified or auto-generated in CyberArk.

It can be found in the properties of the account you created in step 2.

For example,

C:\hp\UCMDB\DataFlowProbe\tools\checkCyberArkConn.bat "C:\Program Files
(x86)\CyberArk\ApplicationPasswordSdk\JavaPasswordSDK.jar" NancySafe Root
HPE_UniversalDiscovery nancy-cyberark-testing-refid

4. Set ApplicationID and Classpath parameters manually

Set the following parameters manually on the Probe server:

o Set ApplicationID in the probe configuration file DataFlowProbe.properties.

Note: Skip this step is you already completed step 2.

i. Open the probe configuration file

hp\UCMDB\DataFlowProbe\conf\DataFlowProbe.properties using a text editor.

ii. Locate the following line and set the application ID:

cyberark.application=HPE_UniversalDiscovery

Note: If the line does not exist, manually add the line at the end of the file.

o Set Classpath in the wrapper configuration files.
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i. Open the WrapperGateway.conf or WrapperManager.conf file in a text editor.

l If the current probe is in union mode, open the WrapperGateway.conf file;

l If the current probe is in separate mode (gateway and manager), open the

WrapperManager.conf file on the manager.

ii. Locate the following line:

wrapper.java.classpath.8=<CyberArk_Install_
Dir>\ApplicationPasswordSdk\JavaPasswordSDK.jar

Note: If the line does not exist, add it manually after the following line:

wrapper.java.classpath.7=%COMMON_CLASSPATH%

iii. Set Classpath.

For example, set classpath in the WrapperGateway.conf file as follows:

wrapper.java.classpath.7=%COMMON_CLASSPATH%

wrapper.java.classpath.8=C:\Program Files (x86)
\CyberArk\ApplicationPasswordSdk\JavaPasswordSDK.jar

iv. Save the file.

v. Restart the probe.

5. Update class model manually

You need to update class model manually. To do so,

a. Modify the Object Root infrastructure setting.

i. Log in to UCDMB, go to Administration > Infrastructure Setting Manager.

ii. Locate the Object Root infrastructure setting.

iii. Modify the value of Object Root from managed_object to root.
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iv. Click Save .

v. Log out and re-log in to UCMDB.

b. Add two attributes in the protocol CI type to update class model.

i. Locate the protocol CI type class. Go to Modeling > CI Type Manager, in the CI Types

pane, expand Root > Data > Object > Configuration > protocol.

ii. On the Attributes tab, click Add to add two attributes as follows:

Attribute 1 Attribute 2

Attribute Name external_vault_type external_password_static_key

Display Name External Vault Type External Password Static Key

Description external AAPM tool used for

authentication

reference ID/string used in AAPM

Attribute Type string string

Value Size 50 1024

For all other fields, keep default values.

For example,
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iii. Click OK.

6. (SSH and Telnet protocols only) Add SU parameters manually to update class

model

a. Locate the SSH or Telnet CI type. Go to Modeling > CI Type Manager, in the CI Types pane,

expand Root > Data > Object > Configuration > protocol > SSH/Telnet.

b. On the Attributes tab, click Add to add two super user attributes to the SSH/Telnet

protocol as follows:

Attribute 1 Attribute 2

Attribute Name su_external_vault_type su_external_password_static_key

Display Name External Vault Type for SU External Password Static Key for SU

Description External AAPM tool used for

authentication for SU

Reference ID/string used in AAPM for

SU
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Attribute 1 Attribute 2

Attribute Type string string

Value Size 50 1024

c. Click OK.

7. Enable CyberArk integration on UCMDB server

You can enable CyberArk integration using either of the following:

o Change the Enable CyberArk integration infrastructure setting value from false to true.

i. In UCDMB, go to Administration > Infrastructure Setting Manager.

ii. Locate the Enable CyberArk integration infrastructure setting and change its value from

false to true.

The default value for the setting is false.

iii. Click Save .

The setting is synchronized to all probes.

o Enable CyberArk integration from JMX console.

i. On the UCMDB Server, go to JMX console > UCMDB:service=Settings Services.

ii. Locate and invoke the setGlobalSettingValue JMX method with the following parameters:

l name: cyberark.integration.enabled

l value: true

8. Set CyberArk Reference String in the protocol credential UI for supported

protocols

To do so,

a. In UCMDB UI, go to Data Flow Management > Data Flow Probe Setup.

b. In the Domains and Probes tree, expand DefaultDomain(Default) > Credentials, select a
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supported protocol.

In this example, select AS400 Protocol.

c. In the AS400 Protocol pane, click .

d. In the AS400 Protocol Parameters dialog, provide values as necessary.

When CyberArk integration is enabled, two radio buttons (Regular Credential and External

Vault) are enabled in the Protocol Parameters dialog. The existing Username and Password

parameters are grouped under the Regular Credential radio button, and two new parameters

(Type and Reference) grouped under the External Vault radio button, as described in the table

below.

Parameter Description

Regular

Credential

Select this radio button if you prefer to use regular credential as before.

l Username. See description for the protocol in the HP UCMDB Universal

Discovery Content Guide - Supported Content.

l Password. See description for the protocol in the HP UCMDB Universal

Discovery Content Guide - Supported Content.

External Vault Select this radio button if you prefer to use an external credential vault.

l Type. The external vault type. Currently only CyberArk is supported.

l Reference. The reference ID that will be used by UCMDB/UD to retrieve

the passwords from the CyberArk Enterprise Password Vault when they

are needed.

Set the reference ID in the CyberArk Enterprise Password Vault in the

following format: <Safe_Name>\<Folder Path>\<ReferenceID>.

Where <Safe_Name> is the Safe value in CyberArk, <Folder Path> is the

folder where the Safe belongs to, and <ReferenceID> is the name of

the CyberArk account you specified or auto-generated in CyberArk.

For example, NancySafe\Root\nancy-cyberark-testing-refid.
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In this case, select External Vault and set the Reference value as described in the table above.

The following screenshots illustrate the exact CyberArk values you should use in setting the

reference string:

e. Click OK.

9. Check credential

To do so,

a. In UCMDB UI, go to Data Flow Management > Data Flow Probe Setup.

b. In the Domains and Probes tree, expand DefaultDomain(Default) > Credentials, select a

supported protocol.

In this example, select AS400 Protocol.

c. Right-click an AS400 protocol in the protocols list, and select Check credential from the

context menu.

d. In the Check Credential dialog, provide the values as described below:

l IP/Hostname: Enter the IP address or hostname of the Probe server.

l Timeout: Keep the default value.

l Data Flow Probe: Select DataFlowProbe.

e. Click OK.

A "Connection successful" message is returned.
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If CyberArk integration is not enabled, this action returns the following warning message:

CyberArk is disabled.
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How to Create and Configure CyberArk Account for the Integration

To successfully integrate UCMDB/UD with CyberArk, follow the instructions below strictly to create and

configure a safe, an account, and an application ID in CyberArk for the integration.

1. Sign in to CyberArk Password Vault

a. In your Web browser, enter http://<IP address of CyberArk Password Vault Web Access

machine>/PasswordVault.

b. Select CyberArk as the authentication method.

c. Provide your user name and password, and click Sign in.

2. Create and configure a Safe

To do so,

a. Go to the POLICIES tab and create a safe.

i. On the POLICIES tab, from the navigation pane select Access Control (Safes), and then

click Add Safe .

ii. On the Add Safe page, provide values as described below:
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l Safe name: Provide a Safe name. For example, NancySafe.

l Description: Provide a description for the Safe name.

l Saved Passwords: Keep the default Save password versions from the last [7] days

option selected.

l Assigned to CPM: Keep the default PasswordManager option selected.

iii. Click Save

b. Add the new Safe to the Safe Members list.

Data Flow Management Guide

Chapter 11: Integrating UCMDB with CyberArk Enterprise Password Vault

HP Universal CMDB (10.22) Page 400 of 795



i. On the Safe Details: <Safe Name> page, click Add Member.

ii. In the Add Safe Member dialog, click Search, and then from the returned list select the

desired Credential Provider Username (usually Prov_<server>).
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Note: The credential provider user only needs the following permissions:

l Retrieve accounts

l List accounts

l View Safe Members

iii. Click Add.

iv. Click Close.

The Credential provider username you just added should now display in the Members list.

3. Create and configure an account

a. Go to the ACCOUNTS tab, click Add Account .
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b. On the Add Account page, provide values as described below:

l Store in Safe: Select the Safe name you just created in step 2.

l Device Type: Select Operating System from the drop-down list.

Note: The required properties and optional properties may vary with the device type

you select. In this document, Operating System and Windows Domain Account are

selected for Device Type and Platform Name respectively as an example. For details

about other properties, refer to the CyberArk Credential Provider and ASCP

Implementation Guide .

l Platform Name: Select a platform name value from the drop-down list. In this example,

Windows Domain Account is selected.

l Address: (Optional) Enter the IP address of the target server that you want to discover.

l User Name: Specify the user name for the account you configure in CyberArk. This is the

account used by the UCMDB Server to connect to the target server that you want to

discover.

l Password: Enter the password for the account you configure in CyberArk.

l Confirm Password: Enter your password again.

l Name: Select an Auto-generated or Custom name for your Safe account.

If you select Custom, provide a custom account name. For example, nancy-cyberark-

testing-refid.

For example,
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c. Click Save.

4. Create and configure an application ID

a. Go to the APPLICATIONS tab and create an application ID.

i. On the APPLICATIONS tab, click .

ii. In the Add Application dialog, provide values as described below:

l Name: Specify HPE_UniversalDiscovery as the application ID for UCMDB.

l Description: Provide a description for the application ID.

l Location: Select \Applications.

l Other fields: Provide values as necessary.

Data Flow Management Guide

Chapter 11: Integrating UCMDB with CyberArk Enterprise Password Vault

HP Universal CMDB (10.22) Page 404 of 795



iii. Click Add.

b. Add the new application ID to the Safe members list.

i. Go to the POLICIES tab, from the navigation pane select Access Control (Safes), and then

select NancySafe from the Safe Name list.

ii. Click Members in the lower right corner of the page.

iii. On the Safe Details: NancySafe page, click Add Member.

iv. In the Add Safe Member dialog, select HPE_UniversalDiscovery.

v. Click Add.

c. Add the full name of the Credential Provider Servers to the Allowed Machines list.
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i. Go to the APPLICATIONS tab, select HPE_UniversalDiscovery.

ii. On the Application Details: HPE_UniversalDiscovery page, go to the Allowed Machines

tab.

iii. Click Add Machine .

iv. In the Add allowed machine dialog, enter IP, host name, or DNS.

v. Click Add.

d. Add path authentication for HPE_UniversalDiscovery.

i. Go to the Authentication tab, click Add authentication details , and then select

Path.

ii. In the Add Path Authentication dialog,

l In the Path field, enter the path, for example, C:\hp\UCMDB\DataFlowProbe.

l Make sure you select the check box for both of the following options:

l Path is folder

l Allow internal scripts to request credential on behalf of this application ID.

For example,

iii. Click Add.

e. Add operating system user authentication for the new application ID.

i. On the Authentication tab, click Add authentication details , and then select OS

user.
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ii. In the Add Operating System User Authentication dialog, provide OS user information,

for example, NT AUTHORITY\SYSTEM.

Note:

l If the Probe is running as a service, specify NT AUTHORITY\SYSTEM as OS user.

l If the Probe is running as console, specify <hostname\username> as OS User. For

example, HPSWVM0999\Administrator.

iii. Click Add.
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How to Add CyberArk Credential for Protocols from JMX

For the protocols that do not have the CyberArk related fields available after you enable CyberArk

integration from the UCMDB Server, you can add CyberArk credential for these protocols with the help

of JMX methods.

To do so,

1. Export the existing credential

a. On the UCMDB Server, launch the Web browser and enter the following address:

http://localhost:8080/jmx-console. You may have to log in with a user name and password.

b. Click UCMDB:service=DiscoveryManager to open the JMX MBEAN View page.

c. Locate the exportCredentialsAndRangesInformation operation. Do the following:

l Enter your customer ID (the default is 1).

l Enter a name for the exported file.

l Leave the password field empty.

l Set isEncrypted=False since we want to edit the exported file and import it back later.

l Set includeProbeRange=True

d. Click Invoke to export.

When the export process completes successfully, the file is saved to the following location:

C:\hp\UCMDB\UCMDBServer\conf\discovery\<customer_dir>.

2. Add CyberArk credential to the exported file

a. Navigate to the C:\hp\UCMDB\UCMDBServer\conf\discovery\<customer_dir> directory.

b. Open the exported file using a text editor.

c. At the end of the file, before the last </object> tag, manually add the following:

<attribute name="external_vault_type"
type="string">CyberArk</attribute><attribute name="external_password_
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static_key" type="string">HPSupportSafe\Root\support-cyberrk-
refid</attribute></object>

d. Save the file.

3. Import the updated credential file back to UCMDB

a. Go to the JMX Console.

b. Click UCMDB:service=DiscoveryManager to open the JMX MBEAN View page.

c. Locate the importCredentialsAndRangesInformation operation. Do the following:

l Enter your customer ID (the default is 1).

l Enter a name for the exported file.

l Leave the password field empty.

l Set isEncrypted=False since we want to edit the exported file and import it back later.

l Set includeProbeRange=True.

l Set notAllowOverlap=False.

d. Click Invoke to import.
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CyberArk Integration Troubleshooting and Limitations

l Symptom: Received an error message "User <ApplicationID> is not defined" when running

the checkCyberArkConn.bat script to test connection.

Possible Cause: The application ID is not added to the Safe in CyberArk.

Solution:  Add the applicaition ID to the Safe in CyberArk. For detailed instructions, see Create and

configure an application ID.

l Symptom: From the UCMDB UI, failed to save the CyberArk credential to UCMDB Server.

Possible Cause: Class model not updated.

Solution: Update the class model. For detailed instructions, see Update class model manually.

l Symptom: Checking credential failed with an error message similar to the following:

Failed to get credential XYZ, please check the related error logs in probe side.

Scenarios:

o Found the following error messages in the WrapperProbeGw.log:

l ... Failed to get credential for id 52_1_CMS - Failed quering CyberArk
Password, Application ID is empty.

l ...Failed to get credential for id 2_1_CMS - Failed quering attribute from
CyberArk Password.

Possible Cause: Application ID or Classpath is not properly set.

Solution: Set application ID and classpath properly. For detailed instructions, see Set

ApplicationID and Classpath parameters manually.

o Found the following error message in the WrapperProbeGw.log: Query string not legal.
Should be "safe\folder\name".

Possible Cause: The format of the Reference ID is not correct.

Solution: Update the reference ID by strictly following the reference ID format:
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<Safe_Name>\<Folder Path>\<ReferenceID>

Where <Safe_Name> is the Safe value in CyberArk, <Folder Path> is the folder where the Safe

belongs to, and <ReferenceID> is the name of the CyberArk account you specified or auto-

generated in CyberArk.

For example, NancySafe\Root\nancy-cyberark-testing-refid.

o Found the following error message in the WrapperProbeGw.log: 

Password object matching query [object=ABC;Folder=Root;Safe=XYZ] was not found
(Diagnotic Info: 9). Please check that there is a password object that answers
your query in the vault and that both the provider and the application user
have the appropriate permissions needed in order to use the password.

Possible Cause: The CyberArk Credential Provider user was not added as a member to the Safe.

Solution: Add the CyberArk Credential Provider user as a member to the Safe in CyberArk, as

follows:

For detailed instructions, see "How to Create and Configure CyberArk Account for the Integration"

on page 399.

o Found the following error message in the WrapperProbeGw.log: Error: CASVL012E User Name
[ApplicationID] is invalid.
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Possible Cause: This is related to the authentication. The OS user was not properly set when

creating the Application ID in CyberArk.

Solution: If the Probe is running as a service, add NT AUTHORITY\SYSTEM as OS user.

If the Probe is running as console, add the <hostname\username> as OS User.

l PROBLEM: After enabling CyberArk integration, there are no CyberArk related fields in the Protocol

Parameters dialog for some protocols. Is it possible to add CyberArk credential reference to those

protocols?

Solution: Yes. Apart from UDDI Registry and Universal Discovery protocols (which have no passwords

at all), we can add CyberArk credential reference to these protocols with the help of JMX methods.

For a list of protocols that are supported from JMX, see "Supported Protocols" on page 387. For

detailed instructions, see "How to Add CyberArk Credential for Protocols from JMX" on page 408.

l Limitation: Probe will not be able to retrieve passwords from CyberArk if it is running on the local

system account and that this account is not added as a member to the CyberArk Safe. 

l PROBLEM: After enabling CyberArk integration and the FIPS mode, check credential for CyberArk

failed on Windows platform. This is because the file path separator "\" in the conf files cannot be

properly processed on Windows platform. (QCCR1H104637)

Solution: When enabling CyberArk integration and the FIPS mode on Windows platforms, make sure

you replace the file path separator "\" with "/" in the conf files.

For example, replace the file path separator "\" in the following setting:

wrapper.java.classpath.8=C:\Program Files (x86)

\CyberArkApplication\PasswordSdk\JavaPasswordSDK.jar

with "/", as shown below:

wrapper.java.classpath.8=C:/Program Files (x86)

/CyberArkApplication/PasswordSdk/JavaPasswordSDK.jar

l PROBLEM: After adding a new probe to the UCMDB server that was already switched to the FIPS

mode, the automatic FIPS switch process for the new probe might fail. This is because once the

newly installed probe is started, it downloads all the resources from the UCMDB server, and when

the probe gets the probe upgrade package, it would schedule a restart, which blocks the automatic

FIPS Switch process. (QCCR1H106595)
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Workaround: Once you find that the automatic FIPS Swtich process for a new probe failed,

a. Copy the jar files of JCE Unlimited Strength Jurisdiction Policy Files 8 into the %\DataFlowProbe_

HOME%\bin\jre\lib\security directory on the Data Flow Probe machine.

For more information about how to obtain the files, see the HP Universal CMDB FIPS Deployment

Guide.

b. Add the following line into the DataFlowProbe.properties file on the Data Flow Probe machine,

and then save the file.

probe.fips.status=1

c. Restart the Data Flow Probe.

Note: If the Data Flow Probe is in separate mode, you need to perform the above steps for both

the Probe Manager and Probe Gateway instances.
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Chapter 12: Introduction to Universal Discovery
This chapter includes:

Universal Discovery Overview 415

Universal Discovery Community 415

Agent-based vs. Agentless Discovery Overview 416

Script-based vs Scanner-based Discovery 416

Universal Discovery Overview

Universal Discovery enables you to discover components that make up your system. You can discover

zones in your environment by running discovery activities in those zones. Alternatively, you can set up

and run individual discovery jobs on any node in your environment.

For more information, see:

l "Zone-based Discovery" on page 419

l "Module/Job-based Discovery" on page 459

l "Just-In-Time Discovery" on page 661

l "Inventory Discovery" on page 501

Universal Discovery Community

The Universal Discovery Community (https://hpln.hp.com/group/universal-discovery/) on the HP Live

Network provides customers with a convenient way to obtain the latest HP UCMDB Discovery and

Integrations Content Packs and related documentation.

Note: You need an HP Passport user name and password to log in to this site.
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Agent-based vs. Agentless Discovery Overview

Agent-based Discovery

To collect inventory information, you can deploy Universal Discovery agents on client or server

machines. The UD agent provides a secured communication channel between the Data Flow Probe and

the Nodes being discovered. After setting up the secure communication channel, Universal Discovery

deploys and activates scanners onto the Nodes being discovered. The Scanners scan the Nodes for

inventory information and store the scanned results in scan files which are downloaded to the Data Flow

Probe through the secured communication channel established with the UD agent.

When the UD agent is installed, collection of software utilization information is enabled. The UD Agent

also enables you to benefit from the Call Home feature. Call Home is useful in the case where a Node

was unavailable for scanning for a long period. It enables the UD agent to notify the Data Flow Probe

that the Node is currently available for scanning.

Agentless Discovery

Although agentless discovery does not require the installation of dedicated agents on the servers that

are to be discovered, it does depend on native OS or standard agents that are already installed such as

SNMP, WMI, TELNET, SSH, NETBIOS, and others. Other discovery capabilities are based on application-

specific protocols such as SQL, JMX, SAP, Siebel, and so on. For more information, see "Supported

Protocols" in the HP UCMDB Universal Discovery Content Guide - Supported Content.

Script-based vs Scanner-based Discovery

Universal Discovery performs inventory discovery using the following discovery methods.

Note:

l Selecting a discovery method depends on your organization's policy and business goals.

l More than one discovery method can be used.

Script-based discovery

This type of discovery was originally implemented in DDMA.
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Script-based discovery is often called "agentless" because it is typically implemented without agents

installed on remote nodes. However, it is possible to run these jobs with a Universal Discovery Agent

installed.

This type of discovery is best suited for organizations where deployment effort must be minimal,

footprints on remote nodes are a primary concern, and information about running software is critical.

Scanner-based discovery

This type of discovery was originally implemented in DDMI.

Scanner-based discovery uses a software component called the Scanner- an executable file that runs

on the remote node. The Scanner is deployed to remote machines and runs according to a schedule that

you configure. It can run automatically using Activities, or run manually.

Scanner-based discovery is best suited for organizations where a high degree of details about installed

software and hardware is needed.

Script-based vs Scanner-based Discovery Comparative Matrix

Attribute/Discovery

Method Script Scanner

Deployment

Component

None Executable file

Connection Method Agent or Agentless Agent or Agentless

Execution Methods Automatic (Activities) or

Manual

Automatic (Activities) or Manual

Discovery Method APIs Executable file (Scanner)

Scan Type Specific data sets Entire file system

Information

Collected

Running software Installed software, Hardware

Information Detail Moderate High

Performance

Impact on Node

None Minimal

Scalability High. Discovery job quickly Minimal. Scanning job must wait to finish
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Attribute/Discovery

Method Script Scanner

triggers subsequent jobs. before triggering subsequent jobs.

Footprint on Node None Minimal

For details on Universal Discovery Agents, see "Universal Discovery Agent Overview" on page 150.

For details on Scanners, see "Inventory Discovery Scanners" on page 505.
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Chapter 13: Zone-based Discovery
This chapter includes:

Zone-based Discovery Overview 419

Management Zone Ranking 420

Discovery Troubleshooter 423

How to Run Zone-based Discovery 423

How to Create Management Zones 425

How to Define Discovery Activities in a Management Zone 426

How to Create Discovery Activity Templates 427

How to Define Custom Discovery Activities from an Activity Template 428

How to Rank Management Zones 430

How to Configure Global Management Zone Settings 431

How to Organize the Management Zones Tree 432

How to Migrate Management Zones and Folders 433

Zone-based Discovery User Interface 435

Zone-based Discovery Overview

Zone-based discovery enables you to:

l Limit the scope of a discovery activity to a sub-set (zone) of the entire network

l Run multiple instances of the same discovery activity on different zones in the network

l Configure each discovery activity instance with different settings (parameters, scheduling)

l Diagnose discovery problems (using the Discovery Troubleshooter)

Definitions
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l Management Zone. A Management Zone is a region in the network defined by a collection of IP

ranges. A region of an organization’s infrastructure should be defined as a Management-Zone when

you want to discover all the managed objects of the region using the same scheduling policy and

parameters.

l Discovery Activity. You configure a Discovery activities to perform discovery inside a specific

Management Zone. The activities discover infrastructure (IPs, nodes), basic software (shallow

running software including application servers, databases, and web servers), deep database

configuration, and inventory ( for example, CPUs, installed software, logical volumes), among other

information. A Discovery activity includes:

o Discovery parameters that are specific to the type of the Discovery activity

o A scheduling policy

For more information on discovery activities and instructions on how to activate them, see the HP

UCMDB Discovery and Integrations Content Guide.

Example: How to Define Management Zones

Organization-X has two data-centers: DC-A and DC-B. Each data center is owned/managed by a

different administration group: Admin-Group-A and Admin-Group-B. Each administration group would

like to run its own “instance” of a Discovery activity within its data center. On DC-A, you want to discover

all machines operating on Windows once every week using the same discovery parameters. Therefore,

DC-A should be defined as a Management Zone. On DC-B, you want to discover all the J2EE servers once

every day using the same discovery parameters. DC-B should also be defined as a Management Zone.

For details on how to run zone-based discovery, see "How to Run Zone-based Discovery" on page 423.

For details on creating a Management Zone, see "New/Edit Management Zone Dialog Box" on page 441.

For details on the Discovery Troubleshooter, see "Discovery Troubleshooter" on page 423.

Management Zone Ranking

Management Zone ranking is used when a job's trigger belongs to more than one Management Zone.

This could occur when Management Zone ranges overlap, or when a trigger has more than one related

IP address and each of these IP addresses belongs to a different Management Zone.

In order to better handle discovery in Management Zones where, for example, overlaps occur,

Management Zones can be ranked. When Management Zones are ranked, activities defined in the
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Management Zones with the highest rank are run in the overlapping IP ranges, while activities in the

lower ranking Management Zones do not run in the overlapping IP ranges.

Note: Management Zones with a ranking of level 1 are the highest ranking Management Zones.

The following use-case scenarios demonstrate how ranking comes into play:

Scenario 1: Overlapping Management Zone Ranges

Say you define a large Management Zone, "mz-COMPANY," over IP range 10.111.111.0 - 10.111.111.255,

covering all of the desktops in your company. You define an Inventory Discovery activity in mz-COMPANY

to scan the desktops in the entire IP range for hardware and installed software.

In the R&D department of the company, discovery needs to be managed differently. Hardware discovery

is of no interest to you in this range of IPs but you do want to scan the desktops in this department for

installed software, as well as for software utilization. To do this, you define a smaller Management

Zone, "mz-RnD", that covers the IP range of the R&D desktops only: 10.111.111.0 - 10.111.111.20. You

define an Inventory Discovery activity to scan for installed software and for software utilization.

When you activate the activities in both Management Zones:

l the results for mz-COMPANY include data about hardware and installed software discovered on all

desktops in mz-COMPANY's range

l the results for mz-RnD include data about installed software discovered on the desktops in mz-

RnD's range, as well as information about software utilization

Notice how both sets of discovery results include information about the installed software on the

desktops in the overlapping range 10.111.111.0 - 10.111.111.20.
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Because mz-RnD requires a more specialized discovery, you can assign mz-RnD a ranking of 1, and

lower the ranking of mz-COMPANY to 2. This way, because mz-RnD has a higher ranking than mz-

COMPANY, only the discovery activities defined for mz-RnD will run in the overlapping IP range,

10.111.111.0 - 10.111.111.20. Discovery activities defined for mz-COMPANY will run in mz-COMPANY's

remaining IP range—10.111.111.21 - 10.111.111.255.

Scenario 2: Discovery Node has multiple IP Address in different Management Zones

Using the scenario above, say the desktop, Node mydvm0842, has multiple IP addresses, including

10.111.111.5 and 10.111.111.25. Note that both of these IP addresses belong to mz-COMPANY, but

10.111.111.5 belongs to mz-RnD as well.

Only one of these IP addresses is recorded in the Protocol CI in the Application IP attribute, which

mydvm0842 then uses for communicating with the Data Flow Probe and for determining which

Management Zone mydvm0842 will belong to.

If IP address 10.111.111.5 is selected, the activities from mz-RnD are used for discovery because mz-

RnD has a higher ranking.

Note: In the case of multiple IP addresses on a node, the IP address selected for communication

with the node is that which determines which Management Zone the discovery node will belong to.

In the scenario above, if 10.111.111.25 is selected, even though the Management Zone it belongs

to, mz-COMPANY, is lower ranking than mz-RnD, mz-COMPANY's activities will still run on the node,

and may lead to unexpected discovery results. This is because the second IP address, 10.111.111.5,

that was not selected for communicating with the node, is not taken into account for ranking

purposes.

It is strongly recommended to define your Management Zones in such a way that if a discovery

node has multiple IP addresses, all of the IP addresses are included in the same Management Zone.
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For details about defining Management Zones, see "New/Edit Management Zone Dialog Box" on

page 441.

Discovery Troubleshooter

It is possible that after running discovery, you will not find a particular CI in the discovery results. There

are various types of errors that can occur that would cause this to happen. The Discovery

Troubleshooter allows you to search for the missing CI, and even if you are unable to locate the missing

CI, the Discovery Troubleshooter also detects and lists errors that occurred during the discovery

process. By attempting to solve these errors, this can lead you to the missing CI.

Currently the Discovery Troubleshooter allows you to locate missing Running Software CIs. When

invoking the Discovery Troubleshooter, you are requested to enter the IP of the target host you are

looking for and choose a detection method before searching for the missing running software CI. If the

Discovery Troubleshooter does not initially succeed in connecting to the target host, it allows you to

rerun discovery with a different detection method. If the Discovery Troubleshooter does succeed in

connecting to the target host, it lists all the running software currently connected to the detected Node

CI. If the CI you are looking for is not in the list, the Discovery Troubleshooter lets you update available

application signatures, which may provide a more extensive list of all running software connected to the

detected Node CI and enable you to find the missing CI.

Note: The Discovery Troubleshooter can be run on a Management Zone only after the

Infrastructure and Basic Software Configuration discovery activities have been run on that

Management Zone.

How to Run Zone-based Discovery

This task describes a recommended workflow for running discovery in a Management Zone.

To run Zone-based discovery:

1. Prerequisites

o Verify that the Data Flow Probe is installed.
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o (UNIX only) If you want to specify the locations of data or temporary folders when installing

Universal Discovery Agent, see "How to Specify Data and Temp Folder Locations when Installing

or Updating the Universal Discovery Agent for UNIX" on page 166.

o Ensure that you have a Management Zone defined in UCMDB. For details about creating

Management Zones, see "How to Create Management Zones" on the next page.

2. Set up and activate discovery activities

In the Management Zone:

a. Set up and activate the Infrastructure Discovery Activity.

For agent-based discovery, you must ensure that the Universal Discovery (UD) Agent is

installed on the node being discovered. You can configure the Infrastructure Discovery activity

to install the UD Agent automatically. For more information, see the section describing the

Infrastructure Discovery activity in the HP UCMDB Discovery and Integrations Content Guide.

Alternatively, if you want to install the UD Agent manually, follow the instructions described in

"How to Install the Universal Discovery Agent Manually" on page 160.

b. Set up and activate other activities required for discovering the Management Zone. For more

information, see the HP UCMDB Discovery and Integrations Content Guide.

3. Results

o To verify the discovery ran successfully, select the Management Zone in the Management

Zones tree and, in the Discovery Status pane, click the Results tab.

For user interface details, see "Discovery Results Tab/Pane" on page 686.

If you do not find a particular CI in the discovery results, you can run the Discovery

Troubleshooter to search for the missing CI. For more information about running the Discovery

Troubleshooter, see "Discovery Troubleshooter Wizard" on page 435.

Note: The Discovery Troubleshooter can be run in a Management Zone only after the

Infrastructure and Basic Software Configuration discovery activities have run in that

Management Zone.

o The following events occur as a result of installing the Universal Discovery Agent:
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l The UD Agent generates a Unique ID, which is stored locally on the discovery node and in

UCMDB as follows:

l Windows and UNIX. For more information on where the Unique ID is stored, see

"Universal Discovery Agent File Locations" on page 183.

l UCMDB. Stored in the ud_unique_id attribute of Node CI.

For more information on Unique ID, see "Universal Discovery Agent Overview" on page 150.

l Software Identification Tag files are created and stored on the discovery node. For more

information about Software Identification Tags, see "Hardware and Software Recognition"

on page 527.

How to Create Management Zones

This task describes how to create a Management Zone.

1. Prerequisites. Verify that one or more Data Flow Probes/probe clusters have been added to

UCMDB and that their network ranges are defined. For details, see "How to Add Data Flow Probes

to UCMDB" on page 40.

Note: A Data Flow Probe/probe cluster without a network range cannot be bound to a

Management Zone.

2. In the Data Flow Management module, go to Universal Discovery > Zone-based Discovery tab,

right-click the folder under which you want to create the Management Zone, and then click New

Management Zone from the context menu.

3. In the New Management Zone dialog box, enter a name for the Management Zone.

Note: Naming conventions:

o The name can contain the following characters: a-z, A-Z, 0-9, hyphen (-), underscore

(_), and space ( ).
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o The name is not case sensitive; for example, mz1/mZ1/Mz1 are all the same.

o The name must not start with a digit.

o The name must be limited to a length of 50 characters.

4. Select a method for defining ranges for the Management Zone, and define the ranges.

o To bind the full range of selected Data Flow Probes/probe clusters to the Management Zone,

select Use full Data Flow Probe ranges, and select the Probes/probe clusters to bind to the

Management Zone.

o To select partial ranges from selected Data Flow Probes/probe clusters, select Define partial

ranges on Data Flow Probes. Select the Probes/clusters, and in the Ranges pane, define the

partial ranges to bind to the Management Zone.

For more details, see "New/Edit Management Zone Dialog Box" on page 441.

Note: In order to get predictable discovery results, we recommend that when defining the

ranges for your Management Zones, they are configured in such a way so that all related IP

addresses for a particular discovery node belong to the same Management Zone.

If IP addresses belonging to one discovery node span more than one Management Zone, and

the Management Zones are ranked at different levels, unpredictable discovery results may

occur. This is because the IP address that was selected to communicate with the discovery

node is used to determine which Management Zone the discovery node belongs to, and that

address may not always belong to the Management Zone with the highest rank.

5. (Optional) Click the Settings tab to configure settings for the Management Zone. For details, see

"New/Edit Management Zone Dialog Box" on page 441.

6. Click OK to save the Management Zone.

How to Define Discovery Activities in a Management Zone

This task describes how to define discovery activities in a Management Zone.
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1. In the Management Zone tree, right-click the Management Zone where you want to create the

activity, and select New Discovery Activity.

2. Select the type of discovery activity to create:

o To create a discovery activity from the out-of-the-box activities, select the activity, and follow

the wizard. For details on each of the out-of-the-box activities, see the HP UCMDB Discovery and

Integrations Content Guide.

o To create a custom discovery activity from a discovery activity template, select Templates, and

select the discovery activity template. For details, see "How to Define Custom Discovery

Activities from an Activity Template" on the next page.

Note: Before you can create a custom activity, a discovery activity template must be

defined. For details about creating discovery activity templates, see "How to Create

Discovery Activity Templates" below.

How to Create Discovery Activity Templates

This task describes how to create a discovery activity template, a collection of jobs on which to base

new user-defined discovery activities.

Note: For details about discovery activities provided out-of-the-box with Universal Discovery, see

HP UCMDB Discovery and Integrations Content Guide.

See also "How to Define Custom Discovery Activities from an Activity Template" on the next page.

To create a discovery activity  template:

1. Go to Data Flow Management > Universal Discovery > Zone-based Discovery > Management

Zones.

2. Select the Management Zones tree root.

3. In the Management Zone Actions pane on the right, click the View/Edit Discovery Activity

Templates button.

4. In the Discovery Activity Templates dialog box that opens, click Create Discovery Activity
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Template .

The New Discovery Activity Template wizard opens.

5. Enter a name for the discovery activity template and click Next.

6. On the Select Discovery Jobs page, click Add Job .

7. In the Select Jobs dialog box, select jobs to include in the discovery activity template.

Tip:

o To find a specific job, click the Find Jobs button.

o You can also select entire job modules.

8. Click Finish to save the activity template.

How to Define Custom Discovery Activities from an Activity

Template

This task describes how to define a custom discovery activity in a Management Zone based on a

discovery activity template.

Note: For details about discovery activities provided out-of-the-box with Universal Discovery, see

HP UCMDB Discovery and Integrations Content Guide.

To create a custom discovery activity  from a discovery activity template

1. Prerequisite: Ensure that the template upon which you want to base the custom discovery activity

has been created. See "How to Create Discovery Activity Templates" on the previous page.

2. Go to Data Flow Management > Universal Discovery > Zone-based Discovery.

3. In the Management Zone tree, select the Management Zone where you want to define the new

discovery activity.
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4. Click , select New Discovery Activity > Templates, and select a discovery activity template.

5. The New Discovery Activity wizard opens. Give the activity a name and click Next.

6. The Select Activity Jobs page opens.The jobs listed under Selected Jobs are those included in the

activity template you selected above.

a. For each job, define job parameters:

Note: For details about each job's parameters, see the HP UCMDB Discovery and

Integrations Content Guide.

i. Select the job in the Selected jobs list.

ii. In the Job Parameters pane, in the relevant parameter's row, select Override.

iii. In the Value column, enter the overriding value.

b. (Optional) To add more jobs to the discovery activity, click Add Job . The Select jobs dialog

box opens. Select the jobs required for the activity, and set the override values for the job

parameters.

Tip:

l To find a specific job, click the Find Jobs button.

l You can also select entire job modules.

c. (Optional) To remove a job from the activity, select the job in the Selected jobs list and click

the Remove Job button.

Click Next.

7. On the Schedule Discovery page, edit the discovery schedule as desired, and click Next.

8. On the Summary page, review the summary.

9. To activate the activity upon creation, select Activate activity.

10. Click Finish to save the activity. The activity appears in the Management Zone tree, under the

relevant Management Zone.
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How to Rank Management Zones

Management Zone ranking is used when a job's trigger belongs to more than one Management Zone.

This could occur when Management Zone ranges overlap, or when a trigger has more than one related

IP address and each of these IP addresses belongs to a different Management Zone.

Note: As noted when defining ranges for your Management Zones, if you are aware of a discovery

node having multiple IP addresses, we recommended that all of these IP addresses are included in

the ranges of only one Management Zone. If IP addresses belonging to one discovery node span

more than one Management Zone, and the Management Zones are ranked at different levels,

unpredictable discovery results may occur.

For more information and an example, see "Management Zone Ranking" on page 420.

This task describes how to assign ranks to Management Zones.

1. In the Zone-based Discovery view, select the Root folder in the Managements Zones tree.

2. In the Management Zone Actions pane on the right, click View/Edit Management Zone Ranks

.

The Management Zone Ranking dialog box opens:

o The Ranks tree displays all the defined Management Zones.

Note: By default, when Management Zones are created, they are ranked at level 1.

o When you select a Management Zone in the tree, the right pane displays the Management

Zones whose IP ranges overlap with the selected Management Zone.

o The IP ranges of the selected Management Zone are displayed in the lower area of the right

pane.

Note: The ranges displayed in the lower area of the right pane belong to the Management

Zone selected in the Ranks tree, and not to Management Zones selected in the overlapping

Management Zones area.

Data Flow Management Guide

Chapter 13: Zone-based Discovery

HP Universal CMDB (10.22) Page 430 of 795



3. To assign a different ranking to a Management Zone, select the Management Zone in the Ranks

tree and click the Rank Higher / Rank Lower button.

How to Configure Global Management Zone Settings

This task describes how to set global settings for Management Zones.

Note: This task is optional. Management Zones can be used with the default values assigned to

global settings without any changes by the user.

For more information on global settings for Management Zones, see "Global Settings Dialog Box" on

page 447.

1. In the Universal Discovery window, click the Zone-based Discovery tab.

Ensure that the root node of the Management Zone tree is selected.

2. In the Management Zone Actions section, click View/Edit Global Settings .

3. To modify Management Zone general settings, in the left pane, select General Settings.

a. Select a category and a setting, and click Properties .

b. In the Properties dialog box that opens, change the Current Value as desired, and click Save.

4. To manage Management Zone application signatures, in the left pane select Application

Signatures, and select the relevant application signatures from the tree.

5. To manage ports for Management Zones, select Ports.

o To add a new port, click Add Port . Enter a name, and port number. If the port should be

detected using TCP/UDP port scanning, select Discover Port.

Note: Naming conventions for the port:

l The port name can contain the following characters: a-z, A-Z, 0-9, hyphen (-),

underscore (_), and space ( )
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l Max length: 255 characters

o To modify a selected port, click Edit Port .

l Change the port number.

l If the port should be detected using TCP/UDP port scanning, select Discover Port,

o To remove a selected port, click Remove Port .

6. Click OK to save all changes.

How to Organize the Management Zones Tree

The following table describes the tasks that allow you to organize the Management Zones tree.

Tasks Actions

Create a new folder 1. Perform one of the following actions:

o Select the folder under which you want to create the new

folder, and then click New Folder .

o Right-click the folder under which you want to create the new

folder, and then click New Folder from the context menu.

2. Enter the folder name, and then click OK.

Note: The folder name cannot contain the following

characters:

/\%|:"<>?

Rename a folder 1. Right-click the Management Zone folder, and then click Rename

Folder from the context menu.

2. Enter the new folder name, and then click OK.
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Tasks Actions

Move a Management Zone

into a different folder

Drag the Management Zone to the target folder.

Move a folder into another

folder

Drag the folder to the target folder.

Delete a folder Use one of the following methods to delete a folder:

l Select the Management Zone folder, and then click Delete .

l Right-click the Management Zone folder, and then click Delete

Folder from the context menu.

Note: When you delete a folder, all the Management Zones under

the folder are also deleted.

How to Migrate Management Zones and Folders

This topic describes how to migrate Management Zones and folders from one instance to another.

If the Management Zone tree contains customized folders, you need to migrate all these folders before

migrating Management Zones.

Migrate folders

1. Log in to the UCMDB JMX console of the source instance. For details, see How to Access the

JMX Console in the HP Universal CMDB Administration Guide.

2. In the UCMDB JMX Quick Search box, enter listResourceTypes, and then click the result that

appears below the search box.

3. Click the Invoke button under the listResourceTypes method.
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4. Click Discovery_FOLDER_MZ.

5. Click the Resource ID of each resource in the returned list, and then back up the code in the

Resource XML text box for later use.

Repeat this step until you back up the XML code for all folders.

6. Log in to the UCMDB JMX console of the target instance, and then perform the same operations as

step 2 to step 4.

7. Click Add new resource, paste the backup XML code for one of the folders into the Resource XML

text box, and then click Save resource.

Repeat this step until you add all the folders.

Note: Always add higher-level folders before adding lower-level folders. For example, add the

folders in the following order if the Management Zone tree has three layers under Root:

a. The first-layer folders, which are directly under the Root folder.

b. The second-layer folders.

c. The third-layer folders.

Migrate Management Zones

1. Log in to the UCMDB JMX console of the source instance. For details, see How to Access the

JMX Console in the HP Universal CMDB Administration Guide.

2. In the UCMDB JMX Quick Search box, enter getManagementZone, and then click the result that

appears below the search box.

3. Enter the name of a Management Zone, and then click Invoke.

4. Back up the XML code in the Resource XML text box for later use.

Note: The path ID in the XML code indicates the ID of the parent folder that the Management

Zone belongs to. The folder ID is calculated based on the folder name and path. If the folder

keeps the name and path during the migration, the ID should be the same between the source
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instance and the target instance.

5. Repeat step 3 and step 4 until you back up the XML code for all the Management Zones.

6. Log in to the UCMDB JMX console of the target instance.

7. In the UCMDB JMX Quick Search box, enter addManagementZone, and then click the result that

appears below the search box.

8. Paste the backup XML code of one of the Management Zones into the Value field of Management

Zone XML, and then click Invoke.

9. Repeat step 7 and step 8 until you add all the Management Zones.

Zone-based Discovery User Interface

This section includes:

Discovery Troubleshooter Wizard 435

New/Edit Management Zone Dialog Box 441

Find Management Zone Dialog Box 445

Management Zone Ranking Dialog Box 446

Global Settings Dialog Box 447

Zone-based Discovery View 449

Discovery Troubleshooter Wizard

The Discovery Troubleshooter allows you to troubleshoot for running software CIs that do not show up

when you run an activity on the Management Zone. This is useful for customers who are running

activities for discovering running software, and they see that the running software is not found.

This wizard page allows you to initiate the Discovery Troubleshooter.

To access Select a Management Zone in the Management Zones tree structure on the left and

click the Troubleshooting button.

Important l The Discovery Troubleshooter wizard can be activated only within the context of a
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information Management Zone.

l The Discovery Troubleshooter wizard can be run on a Management Zone only after

the Infrastructure and Basic Software Configuration Discovery activities have been

run on that Management Zone.

l If any discovery activities are still running when you start this wizard, the Wait for

Jobs screen appears after clicking Next in the first screen of this wizard. If the Wait

for Jobs screen appears, wait until the activities finish and then continue with the

wizard.

Relevant

tasks

"How to Run Zone-based Discovery" on page 423

Wizard map The Discovery Troubleshooter Wizard contains:

Discovery Troubleshooter Wizard > "Activity Instances Mapping Page" > "Target Host

Page" > "Additional Information Is Required Page" > "Investigate Missing Node CI Page"

> "Retrieve Running Software CIs Page"

See also l "Discovery Troubleshooter" on page 423

l "Universal Discovery Overview" on page 415

l "Zone-based Discovery View" on page 449

Activity Instances Mapping Page

This wizard page allows you to select a Discovery Activity Instance associated with the Management

Zone on which you are running the Troubleshooter.

Important

information

This wizard page only appears if you have more than one Infrastructure or Basic

Software Configuration Discovery activity associated with the Management Zone.

Wizard map The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" > Activity Instances Mapping Page > "Target Host

Page" > "Additional Information Is Required Page" > "Investigate Missing Node CI Page"

> "Retrieve Running Software CIs Page"

User interface elements are described below:
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UI Element (A-

Z) Description

Activity

Instance

Lists the instances of the Activity Type. If there is more than one instance, they are

listed in a drop-down menu.

Activity Type Lists the types of Discovery Activities that are prerequisites for running the

Troubleshooter. Currently, only Infrastructure and Basic Software Configuration

Discovery activity types are listed here.

Troubleshooter

Log

This log lists all actions performed by the Troubleshooter that occur in the

background and do not appear in the user interface.

Target Host Page

This wizard page allows you to enter the name or IP address of the host that you want to discover.

Important

information

l The name or IP address that you enter on this page should be within the range of at

least one of the probes in the Management Zone. If it is not, an error message

appears.

l After clicking Next on this page, the Validate Target Host IP Address page

appears. Wait briefly while the Discovery Troubleshooter validates the target host

IP address. If the target host you entered is not within the range of the

Management Zone, the Validate Target Host IP Address page offers you an option

to choose a different target host, or close the wizard. If you choose a different

target host, the Target Host page appears again.

l Once an IP address is defined, the Discovery Troubleshooter checks if a CI exists for

that IP. If no CI exists, the Discovery Troubleshooter automatically creates a CI for

that IP address.

Wizard map The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" > "Activity Instances Mapping Page" > Target Host

Page > "Additional Information Is Required Page" > "Investigate Missing Node CI Page"

> "Retrieve Running Software CIs Page"

User interface elements are described below:
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UI Element (A-

Z) Description

Target host: Enter here the name or IP address of the host that you want to discover.

Troubleshooter

Log

This log lists all actions performed by the Troubleshooter that occur in the

background and do not appear in the user interface.

Additional Information Is Required Page

This wizard page allows you to select a method for detecting the target host.

Important

information

l After clicking Next on this page, the Discovery Troubleshooter attempts to activate

a specific job. If this job is not active, a message appears stating that the job is

about to be activated and that if you activate it, this may invoke the job on all

potential trigger CIs that are relevant to this job.

l After clicking Next on this page, the Discovery Progress screen appears and

informs you that Discovery is currently running.

Wizard map The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" > "Activity Instances Mapping Page" > "Target Host

Page" > Additional Information Is Required Page > "Investigate Missing Node CI Page"

> "Retrieve Running Software CIs Page"

User interface elements are described below:

UI Element (A-Z) Description

Select detection

method for the

requested host:

Discovery uses detection methods to communicate with the remote

machine. Choose from one of the following detection methods: WMI, Shell,

Power Shell, SNMP.

Troubleshooter Log This log lists all actions performed by the Troubleshooter that occur in the

background and do not appear in the user interface.

Investigate Missing Node CI Page

This wizard page lists errors found if the Troubleshooter does not succeed in connecting to the host,

and offers options for trying to resolve those errors.
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Important

information

This page only appears if the Troubleshooter does not succeed in connecting to the

host.

Wizard map The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" > "Activity Instances Mapping Page" > "Target Host

Page" > "Additional Information Is Required Page" > Investigate Missing Node CI Page

> "Retrieve Running Software CIs Page"

User interface elements are described below:

UI Element Description

<error

messages>

Various error messages can occur when running the Troubleshooter.

One of the more common types of error messages is Permission Denied. This error

occurs if there is a problem with the user credentials. You can attempt to fix this

error by clicking Fix by the error message. If you do this, the Update Credentials

dialog box appears, and you can update the user credentials as explained in

"<Protocol> Details Pane" on page 98. After updating user credentials, you should

choose Rerun relevant discovery job to find missing CI in this wizard page and

continue with the wizard.

Rerun relevant

discovery job

to find missing

CI

Choose this option if you see an error in the list for which rerunning a job might help

(for example, a timeout error). If you choose this option, the Discovery Progress

screen appears.

Choose a

different

detection

method to find

missing CI

If you choose this option, the wizard returns to the "Additional Information Is

Required Page" on the previous page.

Close the

Troubleshooter

and save

support log

Choosing this option exits the wizard and saves the log file to a location on the

server machine (the exact location is indicated on the page that follows).

Troubleshooter

Log

This log lists all actions performed by the Troubleshooter that occur in the

background and do not appear in the user interface.
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Retrieve Running Software CIs Page

This wizard page lists all running software that is currently listed as connected to the detected Node CI.

Wizard

map

The Discovery Troubleshooter Wizard contains:

"Discovery Troubleshooter Wizard" on page 435 > "Activity Instances Mapping Page" >

"Target Host Page" > "Additional Information Is Required Page" > "Investigate Missing Node

CI Page" > Retrieve Running Software CIs Page

User interface elements are described below:

UI Element Description

Yes, the CI

was

discovered

Check this option if the running software CI that you are looking for is in the list, or

just close the Troubleshooter since you have successfully completed

troubleshooting.

No, the CI is

still missing

Check this option if the running software CI that you are looking for is not in the list.

If you choose this option, the Software Identification Rules Management screen

appears, and you can continue the search for the missing CI as follows:

1. In the Software Identification Rules Management screen, update the available

application signatures as explained in "Software Identification Rule Editor

Dialog Box" on page 288.

2. The Troubleshooter then attempts again to find the missing CI (by re-running

its corresponding job) and this wizard page appears with a potentially more

extensive list of all running software that is connected to the detected Node CI.

3. If the running software CI that you are looking for is still not in the list, select

again No, the CI is still missing ,and the Additional Information Is Required

page appears (see below).

Additional

Information Is

Required page

If after updating the available application signatures the Troubleshooter still does

not find the missing CI, this page appears. You can choose either Update software

identification rules and rerun discovery or Close the Troubleshooter and save

support log.

If you choose Update software identification rules and rerun discovery, the

Software Identification Rules Management screen appears again and you can

continue to update the software identification rules.
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UI Element Description

Troubleshooter

Log

This log lists all actions performed by the Troubleshooter that occur in the

background and do not appear in the user interface.

New/Edit Management Zone Dialog Box

This dialog box enables you to create or edit a Management Zone.

To access Select Data Flow Management > Universal Discovery > Zone-based

Discovery tab.

l To create a Management Zone: Click New Management Zone .

l To edit an existing Management Zone: Select the Management Zone and

click Edit .

Important

information

You must have at least one Data Flow Probe defined to create a Management

Zone.

Relevant tasks l "How to Create Management Zones" on page 425

l "How to Run Zone-based Discovery" on page 423

See also l "Universal Discovery Overview" on page 415

l "Zone-based Discovery View" on page 449

l "Discovery Troubleshooter" on page 423

Details Tab

User interface elements are described below:

UI

Elements Description

Name The name of the Management Zone. This field is mandatory.

Note: Naming conventions:
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UI

Elements Description

l The name can contain the following characters: a-z, A-Z, 0-9, hyphen (-),

underscore (_), and space ( ).

l The name is not case sensitive; for example, mz1/mZ1/Mz1 are all the same.

l The name must not start with a digit.

l The name must be limited to a length of 50 characters.

Description The description of the Management Zone. This field is optional. This description

appears in the Details tab in the right pane after creating the Management Zone.

Note: The length of the description is limited to 600 characters.

Ranges Enables you to select a method for defining ranges for the Management Zone.

l Use full Data Flow Probe ranges. Displays all the Data Flow Probes/probe clusters

in the lower pane, enabling you to select Data Flow Probes/probe clusters—with

their full ranges—for the Management Zone. To select Data Flow Probes/probe

clusters for the Management Zone, see "Data Flow Probe Selection Area" below.

Note:

o Data Flow Probes/probe clusters must have a defined range before being

bound to a Management Zone.

o If changes are made to the range of a bound Data Flow Probe/probe

cluster, these changes are applied to the Management Zone's range only

after deactivating and reactivating the Management Zone.

Similarly, if you add a Probe to a bound probe cluster, the Probe is, in effect,

added to the probe cluster only after and reactivating the Management

Zone.

l Define partial ranges on Data Flow Probes. Displays the Select Ranges area in the

lower pane, enabling you to define ranges for the Management Zone that are

subsets of the ranges defined for the existing Data Flow Probes/probe clusters. For
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UI

Elements Description

details, see "<Define Probe Ranges area>" below.

Default: Use full Data Flow Probe ranges is selected

Note: In order to get predictable discovery results, we recommend that when

defining the IP ranges for your Management Zones, they are configured in such a

way so that all related IP addresses for a particular discovery node belong to the

same Management Zone.

If IP addresses belonging to one discovery node span more than one Management

Zone, and the Management Zones are ranked at different levels, unpredictable

discovery results may occur. This is because the IP address that was selected to

communicate with the discovery node is used to determine which Management

Zone the discovery node belongs to, and that address may not always belong to

the Management Zone with the highest rank.

Data Flow

Probe

Selection

Area

Displayed when Ranges > Use full Data Flow Probe ranges is selected. It displays the

all of the Data Flow Probes/probe clusters available in UCMDB, and enables you to

select Data Flow Probes/probe clusters for the Management Zone. Discovery in the

Management Zone is run over the full ranges of the selected Data Flow Probes/probe

clusters .

l Non-selected Probes list. Lists the Data Flow Probes/probe clusters in UCMDB that

can be added to the Management Zone. Select a Data Flow Probe/probe cluster and

click to move it to the Selected Probes list. Click to move all of the Data Flow

Probes/probe clusters to the Selected Probes list.

l Selected Probes list. Lists the Data Flow Probes/probe clusters selected for the

Management Zone. Select a Data Flow Probe/probe cluster and click to remove

it from the Selected Probes list. Click to remove all of the Data Flow

Probes/probe clusters from the Selected Probes list.

<Define

Probe

Ranges

area>

Displayed when Ranges > Define partial ranges on Data Flow Probes is selected.

l Domains and Probes tree. Displays the Data Flow Probes/probe clusters available

for the Management Zone.
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UI

Elements Description

l Open Data Flow Probe Setup. Opens a dialog box where you can configure the

range of the Data Flow Probe/probe cluster selected in the tree on the left, for the

current Management Zone.

For details on editing Data Flow Probe/probe cluster ranges, see "New/Edit Range

Dialog Box" on page 120.

l Select Range. Opens the Select Range dialog box, enabling you to select the

sub-ranges you want to include or exclude from the full range of the selected Data

Flow Probe/probe cluster.

In the Select Range dialog box, you can select multiple sub-ranges. If a sub-range

has more than one excluded section, you cannot choose to exclude only one

section; if you choose to exclude one section, all sections will be excluded.

l Delete Range. Enables you to delete a sub-range from the Management Zone.

This button is available only if you have previously added at least one sub-range of

the Data Flow Probe/probe cluster to the Management Zone.

Note: Deleting a sub-range here deletes the sub-range from the Management

Zone, but not from the Data Flow Probe/probe cluster itself.

Settings Tab

This tab allows you to configure settings for the selected Management Zone. For details about global

Management Zone settings, see "Global Settings Dialog Box" on page 447.

Important

information

These settings are the same as the settings that can be configured globally for all

Management Zones, with the following limitations:

l The settings that you configure for a particular Management Zone affect that

Management Zone only, and not all the Management Zones in the system.

l The settings configured for a particular Management Zone override the global

Management Zone settings for that Management Zone only.
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UI

Elements Description

General

Settings

Enables you to change the current value of a selected setting.

Note: The setting Maximum Probe Connections Per Second can be configured

globally for all Management Zones only, as this setting affects the entire probe

and not only a Management Zone.

Application

Signatures

Enables you to select application signatures for the Management Zone.

Note: The list of available application signatures is managed Global Settings

dialog box. For details, see "How to Configure Global Management Zone Settings"

on page 431.

Ports Enables you add ports or edit a port's port number, or delete a port.

Note: If the port should be detected using TCP/UDP port scanning, select Discover

Port.

Find Management Zone Dialog Box

Enables you to locate Management Zones in the tree answering to specified search criteria.

To

access

Select Universal Discovery > Zone-based Discovery > Management Zones pane, and click

the Find Management Zone button.

User interface elements are described below:

UI Element Description

Finds the next Management Zone in the tree meeting the search criteria.

Find

Management

Zone by

Enables you to search for a Management Zone by name, or IPv4/IPv6 address.

Depending on your selection, enter the relevant search criteria:

l Name. Enter the name of the Management Zone, or part of the name.

l IP Address. Enter the IP address in the relevant format.
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UI Element Description

Note: When looking for an IP address for a specific routing domain, also

specify the domain. If no domain is provided, all domains will be searched.

Direction Directs the search forwards or backwards through the Management Zone tree.

Management Zone Ranking Dialog Box

This dialog box enables you to set ranking levels for your Management Zones.

To access Select Data Flow Management > Universal Discovery > Zone-based Discovery tab

> Management Zones root, and click the View/Edit Management Zone Ranking

button.

Important

information

l Changing ranks of Management Zones may cause discovery activities to rerun.

l As noted, when defining ranges for your Management Zones, if you are aware of a

discovery node having multiple IP addresses, we recommend that all of these IP

addresses are included in the ranges of only one Management Zone. If IP addresses

belonging to one discovery node span more than one Management Zone, and the

Management Zones are ranked at different levels, unpredictable discovery results

may occur. This is because the IP address that was selected to communicate with

the discovery node is used to determine which Management Zone the Node belongs

to, and that address may not always belong to the Management Zone with the

highest rank.

Relevant

tasks

l "How to Run Zone-based Discovery" on page 423

l "How to Rank Management Zones" on page 430

See also "Management Zone Ranking" on page 420

User interface elements are described below:

UI Elements Description

Rank Higher/Lower. Enables you to move the selected Management Zone to a

higher or lower ranking level.
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UI Elements Description

Note: Management Zones with a ranking of level 1 are the highest ranking

Management Zones.

Reset. Enables you to undo changes that you made to the ranks.

Expand/Collapse All. Expands/Collapses the Ranks tree, displaying the

Management Zones under each rank.

<Ranks tree> Displays all the Management Zones under its ranking level.

<Management

Zone Ranking

Details pane>

When you select a Management Zone in the Ranks tree, the right pane displays the

following information:

l Management Zones Overlapping with <Management Zone>. Displays all of the

Management Zones that contain ranges that overlap with the range of the

selected Management Zone.

l Ranges of <Management Zone>. Displays the ranges defined for the

Management Zone selected in the Ranks tree. For more details, see "New/Edit

Range Dialog Box" on page 120.

Global Settings Dialog Box

This dialog box enables you to set and view global settings for all Management Zones in your system.

To

access

Select Data Flow Management > Universal Discovery > Zone-based Discovery tab >

Management Zone Actions pane, and click View/Edit Global Settings .

Relevant

tasks

l "How to Configure Global Management Zone Settings" on page 431

l "How to Create Management Zones" on page 425

See also l "New/Edit Management Zone Dialog Box" on page 441

l "Software Identification Rule Editor Dialog Box" on page 288

User interface elements are described below:
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UI

Elements Description

General

Settings

Enables you to manage general settings for all of the Management Zones.

l Categories pane. Displays the available setting categories. Select a category to

display the relevant settings on the right.

l Properties. Opens the Properties window, and allows you to view the properties

for a selected global setting and change it's value.

Note: You can also open the Properties window by double-clicking on a global

setting in the list.

l Undo. Restores the previous value of the selected setting (only relevant if you

changed the value of that setting).

l Filter by column. Filters the list of global settings by selecting a category from the

drop-down list and entering filter criteria in the text box.

Note: For details about each of the displayed settings, see the section describing

the globalsettings.xml file in the HP UCMDB Discovery and Integrations Content

Guide.

Application

Signatures

Enables you to manage application signatures.

l Add. Opens the Software Identification Rule Editor dialog box, enabling you to

add an application signature to the list of available signatures. For details, see

"Software Identification Rule Editor Dialog Box" on page 288.

l Edit. Opens the Software Identification Rule Editor dialog box, enabling you to

edit a selected application signature. For details, see "Software Identification Rule

Editor Dialog Box" on page 288.

l Export Application Signature to XML. Enables you to export the selected

application signature to an xml file.

l Import Application Signature from XML Enables you to import an application

signature from an xml file.
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UI

Elements Description

l Remove. Removes the selected application signature from the list of available

signatures.

Ports Enables you to manage ports.

l Add Port. Opens the Add New Port dialog box, enabling you to add a new port.

l Edit Port. Enables you to modify port number of the selected port.

l Remove Port. Enables you to remove the selected port.

Note:

l Naming conventions for the port:

o The port name can contain the following characters: a-z, A-Z, 0-9, hyphen

(-), underscore (_), and space ( )

o Max length: 255 characters

l When adding or modifying a port, if the port should be detected using TCP/UDP

port scanning, select Discover Port.

Zone-based Discovery View

This view enables you to manage Management Zones, run discovery activities in the Management

Zones, and troubleshoot why expected CIs are missing after discovery.

To access Select Data Flow Management > Universal Discovery > Zone-based Discovery

tab.

Relevant

tasks

"How to Run Zone-based Discovery" on page 423

See also l "Universal Discovery Overview" on page 415

l "Management Zone Ranking" on page 420

l "New/Edit Management Zone Dialog Box" on page 441
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l "Discovery Troubleshooter" on page 423

l "Discovery Troubleshooter Wizard" on page 435

User interface elements are described below:

Management Zones Tree Pane

The Management Zone tree displays all of the Management Zones defined in Universal Discovery and all

of the discovery activities that have been defined in each Management Zone.

UI Element Description

New Folder. Enables you to create a new Management Zone folder.

l New Management Zone. Enables you to create a Management Zone. For more

information on creating Management Zones, see "New/Edit Management Zone

Dialog Box" on page 441.

l New Discovery Activity. Enabled when you select a Management Zone. Enables

you to create discovery activities in the selected Management Zone. For more

information on defining discovery activities, see the HP UCMDB Universal

Discovery Content Guide - Discovery Activities.

Edit. Enables you to edit the selected Management Zone or discovery activity.

Delete. Deletes the selected Management Zone, discovery activity, or folder.

Note: When you delete a Management Zone, all activities associated with it are

also deleted.

When you delete a folder, all Management Zones and subfolders in the folder

are also deleted.

Find Management Zone. Opens the Find Management Zone dialog box, enabling you

to locate a Management Zone in the tree by name or by IP address. For details, see

"Find Management Zone Dialog Box" on page 445.

Reload Data. Refreshes the data in the Management Zones tree.

Activate. Activates the selected Management Zone or discovery activity.
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UI Element Description

Note: Activating a Management Zone activates all of its activities.

Deactivate. Deactivates the selected Management Zone or discovery activity.

Note: Deactivating a Management Zone deactivates all of its activities.

Pause. Pauses the selected Management Zone or discovery activity.

Note:

l Pausing a Management Zone also pauses all of the activated and running

discovery activities in the Management Zone.

l Pausing a Management Zone does not have any effect on discovery

activities that are not activated.

Resume. Resumes the selected, paused Management Zone or discovery activity.

Note:

l Resuming a Management Zone also resumes all of the paused discovery

activities in the Management Zone.

l Resuming a Management Zone does not have any effect on discovery

activities that are not activated.

Rerun.

l Management Zone root: Runs discovery again in all of the Management Zones.

l Management Zone: Runs discovery again in the selected Management Zone.

l Discovery activity: Runs the selected discovery activity again.

Troubleshoot Missing CIs. Opens the Discovery Troubleshooter wizard.

If a CI is missing from the results of a Data Flow Probe and you expected to see it,

the Discovery Troubleshooter wizard tries to find the missing CI.
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UI Element Description

Note: This feature is enabled in a Management Zone only after the

Infrastructure and Basic Software Configuration discovery activities have run.

For more information on Discovery Troubleshooter, see "Discovery

Troubleshooter" on page 423.

/ Expand/Collapse All. Expands/Collapses the Management Zone tree. When

expanded, all discovery activities that have run in the Management Zones are listed.

<Management

Zones tree

icons>

The Management Zones tree displays the following icons:

l . Represents a Management Zone folder.

l . Represents a Management Zone.

o . Indicates that all of the activated activities in the Management Zone are

running.

o . Indicates that all of the activated activities in the Management Zone are

paused.

o . Indicates that some of the activated activities in the Management Zone

are running and some are paused.

l / . Represents a running/paused activity in a Management Zone.

<right-click

menu>

In addition to some of the functionality described above, right-clicking a discovery

activity enables you to do the following:

l Clear Probe Results Cache. Clears the selected activity's results cache on

the Probes.

Note: If an activity's results cache is cleared, all discovery results are sent

again the next time the activity runs.

Management Zone Details Pane

The right pane of the Zone-based Discovery view displays varying information, depending on what you

select in the Management Zones tree on the left.
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Selected in the tree Displayed in right pane

Management Zones tree root l "Management Zone Actions Pane" on the next page

l "Discovery Status Pane" on page 455

A Management Zone folder A list of all the Management Zones under the selected folder

A Management Zone l "Management Zone Details Pane" on page 455

l "Discovery Status Pane" on page 455

A discovery activity l "Activity Details Pane" on page 456

l "Discovery Status Pane" on page 455
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Management Zone Actions Pane

Displayed when you select the Management Zones root in the tree.

This pane provides a portal to performing actions that affect all Management Zones.

UI

Element Description

Create Management Zone. Opens the New Management Zone dialog box, enabling you to

create a new Management Zone. For details, see "New/Edit Management Zone Dialog Box"

on page 441.

View/Edit Management Zone Ranking. Opens the Management Zone Ranking dialog box,

enabling you to manage the ranking levels of the Management Zones. For details, see

"Management Zone Ranking Dialog Box" on page 446.

View/Edit Discovery Activity Template. Opens the Discovery Activity Template dialog

box, where you can create or delete discovery activity templates. Discovery activity

templates can be used to as a basis for custom discovery activities.

l Create Discovery Activity Template. Open the Discovery Activity Template wizard,

enabling you to define a template on which to base custom discovery activities. For

more details, see "How to Create Discovery Activity Templates" on page 427.

l Remove Discovery Activity Template. Enables you to remove a selected discovery

activity template.

Note: You cannot remove a template if there are custom discovery activities that

use the template.

View/Edit Global Settings. Opens the Global Settings dialog box where you can view and

edit global Management Zone settings. For details, see "Global Settings Dialog Box" on

page 447.

Note: An individual Management Zone's settings override the settings defined in the

global settings. For details on configuring an individual Management Zone, see

"New/Edit Management Zone Dialog Box" on page 441 (Settings tab).
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Management Zone Details Pane

Displayed when you select a Management Zone in the Management Zone tree.

Important information To edit the details of the selected Management Zone, click the Edit

button in the Management Zones pane.

User interface elements are described below:

UI Element Description

Description The description of the Management Zone, defined when the Management Zone was

created.

Ranges

Method

The method for defining ranges for the Management Zone, as defined when creating

the Management Zone:

l Based on full Data Flow Probe ranges

l Based on partial Data Flow Probe ranges

For more details, see "New/Edit Management Zone Dialog Box" on page 441.

Ranges Displays the defined ranges for the selected Management Zone on the selected Data

Flow Probe.

Note:

l You cannot edit ranges in this pane. To edit ranges, see "New/Edit Range Dialog

Box" on page 120.

l If the ranges method is Based on partial Data Flow Probe ranges, the range

can be displayed here either according to the IP range format or CIDR format,

as explained in "New/Edit Range Dialog Box" on page 120.

Discovery Status Pane

Displays the progress and results of discovery in Management Zones. Displayed when you select the

Management Zones root, a Management Zone, or a discovery activity in the Management Zones tree.
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UI Element Description

Progress

Tab

l Displays the last status known by the UCMDB server for each job Trigger CI within

the context selected for discovery.

The information displayed varies depending on the selected area of focus.

o Management Zone root Displays the aggregated progress of the new trigger CIs

across all of the activities in all of the Management Zones.

o Management Zone: Displays the aggregated progress of the new trigger CIs

across all of the activities in the selected Management Zones.

o Discovery Activity: Displays the progress of the new trigger CIs across the

discovery activity.

For more details, see "Discovery Progress Dialog Box" on page 677.

l The information is automatically refreshed every 30 seconds.

l Use the information displayed in this pane to drill down to problematic trigger CIs, to

uncover specific problems that Universal Discovery encountered during the

discovery—for example, incorrect credentials. You can also add newly discovered CIs

to the trigger CI list.

l Hold the SHIFT and CTRL keys to select adjacent and non-adjacent CIs in a list.

Results

Tab

Displays the results from discovery activities that ran in the Management Zones, over

filterable time periods. The results displayed depend on the area of focus.

For more details, see "Discovery Results Tab/Pane" on page 686.

Activity Details Pane

Displayed when you select a discovery activity in the Management Zones tree.

UI Element Description

Overview

Tab

Displays the type and status of the discovery activity, and a summary of the activity as

it was defined when it was created. To edit an activity, select the activity in the

Management Zones tree, and click the Edit Activity button.
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UI Element Description

Activity

Jobs Tab

Displays the activity jobs available for the discovery activity.

l Activity Jobs Toolbar

o Go to Adapter. Redirects you to the adapter for the selected activity job.

o View Permission Details. Opens the Discovery Permissions dialog box,

enabling you to view the permissions data for the selected activity job.

o View Discovered CITs in Map. Displays the selected adapter, together with

its CIs and relationships, in the Discovered CITs Map window. Hold the cursor over

a CIT to read a description in a tooltip.

o View Parameters. Opens the Activity Job Parameters dialog box, enabling

you to view the parameters for the selected activity job.

o Edit Script. Displays a list of scripts related to the selected activity job.

Select a script and edit it in the Script Editor.

o Edit Trigger Query. Displays the trigger query related to the selected

activity job, enabling you to open and edit it in the Trigger Query Editor.

o Hide/Show Legend. Hides/displays the legend at the bottom of the pane.

l Activity Jobs Grid. Displays the information about jobs available for the discovery

activity.

o Activity Job Name. The name of the activity job.

o Discovered CITs. The CITs discovered by the activity job.

o Protocols. The protocols used by the activity job.

o IPv6 Support. Indicates whether the activity job's adapter supports IPv6.

o Scheduling.

l Activity Schedule indicates that the activity job runs according to the
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UI Element Description

activity's discovery schedule.

l For an activity job that does not run according to the activity's discovery

schedule, but rather according to its own discovery schedule, displays the

job's schedule.

l Indicator Icons

The following icons indicate the status of the jobs:

o Enabled job. The job is enabled with permissions.

o Enabled job has no credentials. The job is enabled but it is missing

credential information.

o Job not enabled. The job is not enabled.
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Chapter 14: Module/Job-based Discovery
This chapter includes:

Discovering Running Software 459

Modules/Jobs-based Discovery Overview 460

Viewing Permissions While Running Jobs 460

Discovered CIs and Relationships In a Multi-Tenancy Environment 461

How to Verify Whether a Discovery Job Supports IPv6 463

How to Run Module/Job-based Discovery 463

How to Manually Activate Modules/Jobs/CIs 466

How to Discover Running Software – Scenario 466

How to Define the Owner Tenant For a Discovery Job 469

Module/Job-based Discovery User Interface 470

Discovering Running Software

You can discover software (for example, a specific Oracle database) running in your environment.

This section includes the following topics:

l "Discovery Process" below

l "Running Software Default View" on the next page

Discovery Process

The discovery process runs as follows:

l The Host Resources and Host Applications jobs are activated.

l Universal Discovery searches for processes on the machines in your environment.

l Universal Discovery saves the process data (including open port and command line information) to
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the Probe database.

l The jobs run on this data in the Probe database, build the new RunningSoftware CIs according to the

data in the database, and extract the key attributes from the process data. The jobs send the CIs to

the UCMDB Server.

Running Software Default View

A default view displays the mapping of relationships between applications: Modeling > Modeling Studio

> Resources pane > Root > Application > Deployed Software.

To configure Universal Discovery to discover running software, see "How to Discover Running Software –

Scenario" on page 466.

Modules/Jobs-based Discovery Overview

You can customize discovery by making changes to an out-of-the-box discovery job or building your own

discovery jobs.

For details, see "How to Run Module/Job-based Discovery" on page 463.

For details about the jobs and how they are organized in modules, see the HP UCMDB Discovery and

Integrations Content Guide.

Viewing Permissions While Running Jobs

During a job run, you often need to know which credentials are being used to connect to a component in

the system. You also often need to know the effect of a run on network performance, for example,

whether the job should be run at night instead of during the day. View Permissions enables you to view

the objects and parameters of a job's Jython script commands, as can be seen in the following image:
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Note: The information you define here is not dynamic, that is, if an adapter is changed, the

information in this dialog box is not updated.

For details, see "Discovery Permissions Window" on page 491.

Example of Using the Discovery Permissions Window:

You are running the Host Connection by Shell job to discover a host running on a UNIX system. An

error message in the Discovery Progress pane shows that Universal Discovery could not access a

host through SSH because permission was denied. You display the Discovery Permissions window

and see that the command to access the host requires a user with a certain level of permissions.

You check the SSH Protocol window and discover that the user defined there does not have that

level of permissions.

To resolve the problem, change the user in the SSH protocol or update the permissions for the

existing user in the external system.

Discovered CIs and Relationships In a Multi-Tenancy

Environment

When discovering data in a multi-tenancy environment, CIs and relationships that are not directly

assigned an owner tenant when discovered, are assigned an owner tenant based on the owner tenant

defined in the Data Flow Probe properties, discovery adapter parameters, or discovery job properties.

The following diagram illustrates the mechanism used for assigning owner tenant to discovered

CIs/relationships:
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l For details about assigning an owner tenant to a Data Flow Probe, see "How to Define Owner

Tenants on Data Flow Probes" on page 52.

l For details about assigning an owner tenant to an discovery adapter, see "How to Define the Owner

Tenant Adapter Parameter" on page 218.

l For details about assigning an owner tenant to a discovery job, see "How to Define the Owner Tenant

For a Discovery Job" on page 469.
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How to Verify Whether a Discovery Job Supports IPv6

This task described how you can verify whether or not a particular discovery job or integration supports

IPv6. If the adapter used by the job supports IPv6, then the job supports IPv6.

1. Go to Data Flow Management > Discovery Modules/Jobs, and select the job.

2. In the Details tab, IPv6 Support displays whether or not the job supports IPv6.

Note: The adapter's Support IPv6 setting controls whether the IPv6 triggers are dispatched to the

jobs or not. While this setting can be changed, you must never make such a change for any of the

out-of-the box adapters. If the job does not have the IPv6 support yet, enabling IPv6 support for its

adapter will prevent the job from working correctly.

To see a full list of adapters that come packaged out-of-the-box with UCMDB Content Packs that

do support IPv6, see the section describing IPv6 support in the HP UCMDB Discovery and Integrations

Content Guide.

To change the IPv6 support for a user-defined adapter only:

1. In Adapter Management, select the adapter.

2. On the Adapter Configuration tab, under Trigger Dispatch Options, select (or clear) Supports

IPv6.

How to Run Module/Job-based Discovery

This task describes how to begin mapping your system and its components. You would use this workflow

to customize the components of a module.

Note: For details about running Zone-based discovery, see "How to Run Zone-based Discovery" on

page 423.

This task includes the following steps:

l "Prerequisites" on the next page

l "Set up the Data Flow Probes" on the next page
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l "Select and activate the relevant discovery jobs" below

l "Monitor the discovery process" on the next page

l "View discovery results" on the next page

1. Prerequisites

a. Verify that the Data Flow Probe is installed on a Windows machine.

Note: The Data Flow Probe installed on a Linux platform is intended for the CMS Sync

integration only, and not for discovery.

b. Verify that the relevant packages are deployed.

If you need to deploy discovery packages, see How to Deploy a Package in the HP Universal

CMDB Administration Guide.

2. Set up the Data Flow Probes

o Determine the network range

Determine the network range of the network to be discovered. For details, see "New/Edit Range

Dialog Box" on page 120.

Note: Adapters try to connect to every IP address in a range. Therefore, if a range is wide,

network performance may be affected.

o Set the relevant credentials

To enable the Data Flow Probes to connect to servers or applications using specific protocols,

you must set the relevant credentials (for example, UD, NTCMD, SNMP, TTY, or WMI). For details

on protocol parameters, see the HP UCMDB Discovery and Integrations Content Guide.

Note: The Data Flow Probe tries to connect to a node by using each credential in turn.

Universal Discovery then saves the successful credential. The next time the Data Flow

Probe connects to this node, it first tries to connect using the successful credential.

3. Select and activate the relevant discovery jobs
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Once you have defined the network range and set credentials, you can run discovery on specific

jobs. For details on running specific jobs, see HP UCMDB Discovery and Integrations Content Guide.

Tip:

o You can view a full description of a selected job in the Properties tab > Description pane.

o You can search for all jobs that discover a particular connection type.

For example, to search for all jobs that discover SNMP connections:

In the Universal Discovery > Discovery Modules/Jobs tab, click the Find Job button. In

the Find Jobs dialog box, enter SNMP in the Name box and click Find All. For details, see

"Find Jobs Dialog Box" on page 495.

4. Monitor the discovery process

You can monitor CIs being discovered in the discovery job's Discovery Progress pane, or from the

Data Flow Probe Status Window. For details, see:

o "Discovery Progress Dialog Box" on page 677

o "Data Flow Probe Status Window" on page 134

You can also creates queries to retrieve information about CIs and CITs from the CMDB. For details,

see How to Define a TQL Query in the HP Universal CMDB Modeling Guide. If necessary you can

trigger queries to manually discover objects. For details, see "Trigger Queries Pane" on page 489.

To view the results of the query, build a subset of the overall IT universe model, a view, containing

only those CIs in the CMDB that relate to a specific discovery. For details, see Pattern View Editor in

the HP Universal CMDB Modeling Guide.

5. View discovery results

You can display overall results for a discovery job or you can filter the results by time range, by

Data Flow Probe, or by cluster. Each time you log in to UCMDB and access the Universal Discovery

window, the results are updated so that the data displayed is the latest for the selected module or

job.

For details on viewing discovery results, see "Discovery Results Tab/Pane" on page 686.
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How to Manually Activate Modules/Jobs/CIs

You can manually activate modules/jobs/CIs in the Discovery Modules/Jobs tab.

To manually activate a module/job:

In the Discovery Modules pane, select the module/job, and click Activate .

To manually activate a CI:

1. Select the job with the CI you want to activate manually.

2. Disable the Data Flow Probes for the job: In the job's Properties tab >Trigger Queries pane, select

the query, and in the Probe Limit column, click the button and ensure that no Probes are

selected.

3. Manually activate CIs: In the Details tab, in the Discovery Progress pane, click the Add CI button

and manually add CIs.

The job runs using only the redispatched CIs. For details, see "Discovery Modules/Jobs – Discovery

Modules Pane" on page 476.

How to Discover Running Software – Scenario

This scenario explains how to set up the discovery of Oracle databases so that there is no need to enter

a specific set of credentials to discover each database instance. Universal Discovery runs an extract

command that retrieves the database name attribute.

In this scenario, we assume that the following syntax is used in the Oracle command lines:

c:\ora10\bin\oracle.exe UCMDB

This task includes the following steps:

l "Prerequisites" on the next page

l "Create a Command Line Rule" on the next page
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l "Define the value of an attribute" on the next page

l "Activate the Job" on page 469

1. Prerequisites

Display the Attribute Assignment Editor dialog box:

a. Go to Data Flow Management > Universal Discovery.

b. In the Discovery Modules/Jobs tab, in the Discovery Modules tree, select Host and Resources

> Basic Applications.

c. Select any one of the Host Application jobs, and in the Properties tab, select Global

Configuration Files.

Tip: If you cannot see the Global Configuration Files pane, click the Up arrow [ ] below

the Trigger Queries pane.

d. Select applicationSignature.xml, and click Edit to open the Software Library dialog box.

For details, see "Software Library Dialog Box" on page 290.

e. Select the signature to be edited and click Edit .

f. In the Software Identification Rule Editor dialog box that opens, next to Additional Attributes,

click to open the Attributes Assignment Editor dialog box.

2. Create a Command Line Rule

The command line rule is text that identifies the process to be discovered, for example,

oracle.exe c:\ora10\bin\oracle.exe UCMDB. You can substitute the text entry with a regular

expression, so that discovery is more flexible. For example, you can set up a rule that discovers all

Oracle databases, whatever their name.

Subsequently, Universal Discovery uses the information in the command lines discovered by the

regular expression to populate a CI's name attribute with the database name.

a. To create a Command Line rule that includes a regular expression, in the Attributes

Assignment Editor dialog box, click the Add button in the Parsing Rules pane. For details,

see "Attributes Assignment Editor Dialog Box" on page 260.
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b. In the Parse Rule Editor dialog box, build the rule:

l Enter a unique name in the Rule ID field: r1.

l In the Process Attribute field, select Command Line.

l In the Regular Expression field, enter the following regular expression:

.+\s+(\w+)$

This expression searches for any character (.), followed by a space or spaces (+\s+),

followed by a word or words ((\w+)) that appear at the end of the line ($). You can use the

following characters: a-z, A-Z, or 0-9. The following command line fulfills this expression:

c:\ora10\bin\oracle.exe UCMDB

3. Define the value of an attribute

In this step, you define which attribute is used by Universal Discovery to discover the Oracle

databases, and the value it should take.

a. In the Attributes Assignment Editor dialog box, in the Attribute Assignments pane, click Add

to select the attribute.

b. In the Attribute Editor dialog box that opens:

l Choose the attribute that holds the database name, from the list of Oracle CIT attributes—

in this case The Database instance name.

l Enter a value, using the following syntax: ${<rule ID name>(<group number>)}, in this case,

${r1(1)}.
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This dialog box is configured as follows: Universal Discovery enters the value of the first

group ((\w+)$) in the command line regular expression (${r1(1)}) in the name attribute of

the Oracle database CI.

That is, during discovery, Universal Discovery searches through the process files for

command lines with a word or words at the end of the line. For example, the following

command line matches this regular expression:

c:\ora10\bin\oracle.exe UCMDB

4. Activate the Job

For details, see "How to Manually Activate Modules/Jobs/CIs" on page 466 and "Discovery

Modules/Jobs – Discovery Modules Pane" on page 476.

How to Define the Owner Tenant For a Discovery Job

If you want a discovery job to assign an owner tenant to discovered CIs and relationships other than the

owner tenant defined in its adapter's parameters, you can define an override value in the job's

properties.

This task describes how to define an override for the owner tenant in the job properties.
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Note: This section is relevant for multi-tenancy environments only.

1. Prerequisite

o The owner tenant that you want to define in the discovery job's properties must already be

defined in UCMDB. For details on creating owner tenants in UCMDB, see New Tenant/Edit Tenant

Dialog Box in the HP Universal CMDB Administration Guide.

o An owner tenant parameter must be defined in the adapter that the discovery job uses. For

details, see "How to Define the Owner Tenant Adapter Parameter" on page 218.

2. In the Universal Discovery window, click the Discovery Module/Jobs tab.

3. Select the discovery job.

4. In the Properties tab, in the Overrides area, select check box next to the defaultOwner parameter,

and enter the name of the owner tenant that is to override the value in the adapter parameter.

5. Click OK to save your changes.

Module/Job-based Discovery User Interface

This section includes:

Create New Discovery Job Dialog Box 470

Discovery Modules/Jobs Window 475

Discovery Permissions Window 491

Discovery Scheduler Dialog Box 492

Find Jobs Dialog Box 495

Time Templates Dialog Box 496

Trigger Query Editor Window 497

Create New Discovery Job Dialog Box

Enables you to create a job.
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To

access

Select Data Flow Management > Universal Discovery > Discovery Modules/Jobs tab >

Discovery Modules pane, right-click a module, and select New > Job.

Relevant

tasks

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

Discovery Job Details Pane

User interface elements are described below:

UI Element (A–Z) Description

Opens the Help document related to the selected job's adapter.

To update or modify this document, see "Adapter Definition Tab" on page 244.

Click to go to the adapter in the Resources pane.

You can choose to view a map of the CIs and relationships that are discovered by

the adapter, instead of a list. Click the button to open the Discovered CITs Map

window. The selected adapter is shown together with its CIs and relationships.

Hold the cursor over a CIT to read a description in a tooltip.

Click to view permissions that are defined for specific adapters. For details, see

"Discovery Permissions Window" on page 491.

For details on editing these permissions, see "Permission Editor Dialog Box" on

page 281.

Adapter The adapter used by the job to discover the CIs.

Discovered CIs The CIs that are discovered by this job.

Input CI Type The CIT that triggers the CIs for this job.

IPv6 Support Indicates whether the job's adapter supports IPv6.

Job Name The name and description of the job and the package in which it is located.
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UI Element (A–Z) Description

Note: Naming conventions for jobs:

l Job names can contain the following characters: a-z, A-Z, 0-9, hyphen

(-), underscore (_), space ( )

l Job names must not start with a digit

l Job names must be limited to a length of 50 characters

Required

Protocols

The protocols needed by the activated job to access the system components.

Parameters Pane

Enables you to override adapter behavior.

To view a description, hold the pointer over the parameter.

To access Select a job in the Discovery Modules pane in the Universal Discovery window.

Important

Information

You can override a default adapter parameter for a specific job, without

affecting the default value.

User interface elements are described below:

UI

Element

(A–Z) Description

Name The name given to the adapter.

Override Select to override the parameter value in the adapter.

When this check box is selected, you can override the default value. For example, to

change the protocolType parameter, select the Override check box and change

MicrosoftSQLServer to the new value. Click OK in the Properties tab to save the change:

Data Flow Management Guide

Chapter 14: Module/Job-based Discovery

HP Universal CMDB (10.22) Page 472 of 795



UI

Element

(A–Z) Description

For details on editing parameters in the Adapter Parameters pane, see "Adapter Definition

Tab" on page 244.

Value The value defined in the adapter.

Trigger Queries Pane

Enables you to define one or more queries to be used as triggers to activate the selected job.

User interface elements are described below:

UI

Element

(A–Z) Description

Add Query. Opens the Choose Discovery Query dialog box, enabling you to add one or

more non-default TQL queries to be used as triggers to activate the selected job.

The Choose Discovery Query dialog box lists available queries for the job. Select a query to

displayed it in the Query Preview pane. Hold the cursor over an TQL element to view details.

Remove Query. Removes the selected query.

Note:

l No message is displayed. To restore the query, click the Cancel button.

l If a query is removed for an active job, Discovery no longer receives new CIs

coming from that query. Existing Trigger CIs that originally came from the query

are not removed.

Opens the Trigger Query Editor. For details, see "Trigger Query Editor Window" on page
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UI

Element

(A–Z) Description

497.

Available: In the job's Properties tab only.

Opens the Modeling Studio.

Available: In the job's Properties tab only.

Probe

Limit

The Probes/clusters used for the query. Click the button to open the Edit Probe

Limitation for Query Output dialog box where can select the Probes/clusters on which the

trigger query should run.

Query

Name

The name of the Trigger query that activates the job.

Global Configuration Files Pane

User interface elements are described below:

UI Element (A–Z) Description

Edit. Opens the selected configuration file in an appropriate editor.

For example, the file msServerTypes.xml opens the Script Editor.

Discovery Scheduler Pane

Enables you to set up a schedule for this job.

User interface elements are described below:

UI Element

(A–Z) Description

Click to add times to the Allow Discovery to run at list. The Time Templates dialog

box opens.

To add a time template to the list, in the Time Templates dialog box, click the Add

button to open the Edit Time Template dialog box.
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UI Element

(A–Z) Description

For details, see "Time Templates Dialog Box" on page 496.

Allow

Discovery to

run at

Choose a template that includes the days and times when the job should run.

Edit

scheduler

Click to open the Discovery Scheduler. For details, see "Discovery Scheduler Dialog

Box" on page 492.

Invoke on

new

triggered

CIs

immediately

Enables the job to run as soon as the Trigger CI reaches the Probe.

When this option is not selected, the job runs according to the schedule defined in the

Schedule Manager.

Note: If this option is not selected and a job is running, new triggered CIs are not

run by the job.

Although new triggered CIs are not run, they are counted into the status bar. This

means the status bar does not reach 100% completed, even though the job

successfully completed, and the user has to wait until the next run of the job for

the status bar to reach 100% completed.

Discovery Modules/JobsWindow

Enables you to view and manage modules and jobs, to activate jobs, and to follow job progress.

To access Select Data Flow Management > Universal Discovery > Discovery Modules/Jobs tab.

Important

information

l This tab is suitable for advanced users of Universal Discovery only.

l Each change you make in the Universal Discovery window is delivered to and stored

in the CMDB. From there, the changes are sent to the Probe. You can verify that

changes have been sent to the Probe by opening the wrapperProbe.log file located

in C:\hp\UCMDB\DataFlowProbe\runtime\logs\ and searching for the following

lines:

processing document domainScopeDocument.xml

Processing document domainScopeDocument.xml is done.
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Relevant

tasks

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

User interface elements are described below:

UI Element

(A–Z) Description

Dependency

Map tab

Displays a visual representation of the real-time progress of the process. For details,

see "Discovery Module/Jobs – Dependency Map Tab" on page 484.

Details tab Enables you to manage a module's CIs and view CI statistics. For details, see "Discovery

Module/Jobs – Details Tab" on page 481.

Discovery

Modules

pane

Each module includes jobs. You activate a module or job to discover a specific group of

CIs. For details, see "Discovery Modules/Jobs – Discovery Modules Pane" below.

Properties

tab

Enables you to view and administer the properties of modules and jobs. For details, see

"Discovery Modules/Jobs – Properties Tab" on page 485.

Discovery Modules/Jobs – Discovery Modules Pane

Enables you to view and manually manage modules and jobs. Each module includes the jobs necessary

to discover specific CIs.

To access Select Data Flow Management > Universal Discovery > Discovery Modules/Jobs

tab.

Relevant

tasks

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

User interface elements are described below:
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UI

Element

(A–Z) Description

Create New Job/Module. Enables you to create a discovery job or module for discovery

jobs.

Delete Selected Item. Removes the selected item from the modules/jobs tree.

Find Job. Click to open the Find Jobs dialog box. For example, to search for all jobs that

discover SNMP connections, in the Find Jobs dialog box, enter SNMP in the Name box and

click Find All. For details, see "Find Jobs Dialog Box" on page 495.

Refresh All. Updates the modules.

Activate Selected Discovery Jobs. You can run one job or several jobs in a module, and

one or several modules.

Select the jobs or modules and click Activate.

Deactivate Selected Discovery Jobs. Select the jobs or modules to be stopped and click

Deactivate.

Represents the module root.

To create a module, right-click to enter the name of the module you are creating.

Note: A name is case sensitive. Names beginning with an upper case letter appear in

the Discovery Modules list before names beginning with a lower case letter.

Represents a module.

l . Indicates that some of a module's jobs are activated.

l . Indicates that all of a module's jobs are activated.
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UI

Element

(A–Z) Description

Represents a job.

l . Indicates that the job is active.

l . Indicates that the job is paused.

To view an adapter description, hold the pointer over the icon.

Jobs contain configuration information derived from adapters and other resources and

are the entities controlled by users, for example, when activating or deactivating a

module.

For details on the right-click menu, see "Right-Click Menu" below.

An exclamation mark signifies that one or more of the jobs is experiencing a problem that

could affect the discovery process, for example, a protocol connection failure.

To view the reason for the problem, click the (show errors) link in the Discovery Progress

pane. For details, see "Discovery Module/Jobs – Details Tab" on page 481.

Note: If a problem is resolved by clicking the Refresh All button, the Problem

Indicator disappears.

Right-Click Menu

UI Element (A–Z) Description

Activate Module: Runs the jobs in the selected module.

Job: Runs the selected jobs

The Discovery Module discovers CITs and relationships of the types that are

described in each job, and places them in the CMDB. For example, the Class C

IPs by ICMP job discovers the Dependency, IpAddress, and Membership CITs
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UI Element (A–Z) Description

and relationships.

Clear Probe

Results Cache

Clears the results cache on the Probes.

Note: If the results cache is cleared, all discovery results are sent again

the next time the jobs run.

Content Help Opens the Help document related to the selected job's adapter.

To update or modify this document, see "Adapter Definition Tab" on page 244.

To see the full HP UCMDB Discovery and Integrations Content Guide, select Help

> Discovery and Integrations Content Help.

Create New >

Job

Opens the Create New Discovery Job dialog box, enabling you to create a job.

For details, see "Create New Discovery Job Dialog Box" on page 470.

Create New >

Module

Enables you to define a new name for the module root.

Note: Naming conventions for modules:

l Module names can contain the following characters: a-z, A-Z, 0-9,

hyphen (-), underscore (_), space ( ), and forward slash (/)

l Module names must not start with a digit

l Module names must be limited to a length of 50 characters

Deactivate Module: Stops the running jobs in the selected module.

Job: Stops the selected running jobs.

Note: To stop all the running jobs simultaneously, right-click the

Discovery Modules root folder and click Deactivate all jobs.

Delete Enables you to delete the selected module.

Caution: Only administrators with an expert knowledge of the Universal

Discovery process should delete modules.
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UI Element (A–Z) Description

Delete job Enables you to delete the selected job.

Edit Scheduling Opens the Discovery Scheduler to define a schedule for the selected job.

Edit Script Enables you to select and edit one of the selected job's scripts.

Go to adapter Opens the details of the selected adapter in the Adapter Management module,

enabling you to view and edit its definition.

Move to Enables you to move the selected module folder or job to a different folder.

Pause Click to pause an active job.

To pause all active jobs simultaneously, right-click the Discovery Modules root

folder and click Pause jobs.

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are

finished

o all the execution information is retained, including errors

l Jobs are paused based on their defined job execution policies. For

details, see "Job Execution Policies" on page 36.

Rename Enables you to enter a new display name for the selected module.

Available: When you right-click a module

Rename Job Opens the Rename Job dialog box, enabling you to enter a new display name

for the job.

Note: You cannot rename active jobs.

Available: When you right-click a job

Rerun

Discovery

Reruns the selected job using the selected Trigger CIs.
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UI Element (A–Z) Description

Resume Enables you to resume a paused job.

To resume all paused jobs simultaneously, right-click the Discovery Modules

root folder and click Resume jobs.

Save as... Enables you to clone the selected job.

Discovery Module/Jobs – Details Tab

Enables you to view and administer modules and jobs, to follow the progress of the DFM process, and to

manage errors during discovery.

To access Select Universal Discovery > Discovery Modules/Jobs tab > Discovery Modules pane

> a module/job > Details tab.

Important

Information

Depending which level you select in the Discovery Modules pane on the left, different

information is displayed in the Details tab.

If you select:

l The Discovery Module root or a module, the following panes display information

and statistics about all active jobs and errors discovered during a run:

o "Progress Pane"

o "Results Pane"

l A job, the following is displayed:

o "Discovery Job Details Pane"

o "Progress Pane"

o "Results Pane"

l Several jobs or modules, the following is displayed:

o "Selected Items Pane"

Relevant

tasks

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466
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See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

l "Error Messages Overview" in the HP Universal CMDB Developer Reference Guide

Discovery Job Details Pane

Important information Displayed when a job is selected in the Discovery Modules pane on the left.

User interface elements are described below:

UI Element (A–Z) Description

Opens the Help document related to the selected job's adapter.

To update or modify this document, see "Adapter Definition Tab" on page 244.

Click to go to the adapter in the Resources pane.

You can choose to view a map of the CIs and relationships that are discovered by

the adapter, instead of a list. Click the button to open the Discovered CITs Map

window. The selected adapter is shown together with its CIs and relationships.

Hold the cursor over a CIT to read a description in a tooltip.

Click to view permissions that are defined for specific adapters. For details, see

"Discovery Permissions Window" on page 491.

For details on editing these permissions, see "Permission Editor Dialog Box" on

page 281.

Adapter The adapter used by the job to discover the CIs.

Discovered CIs The CIs that are discovered by this job.

Input CI Type The CIT that triggers the CIs for this job.

IPv6 Support Indicates whether the job's adapter supports IPv6.

Job Name The name and description of the job and the package in which it is located.

Note: Naming conventions for jobs:
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UI Element (A–Z) Description

l Job names can contain the following characters: a-z, A-Z, 0-9, hyphen

(-), underscore (_), space ( )

l Job names must not start with a digit

l Job names must be limited to a length of 50 characters

Required

Protocols

The protocols needed by the activated job to access the system components.

Results Pane

Displays the discovery results from discovery job runs.For details, see "Discovery Results Tab/Pane" on

page 686.

Progress Pane

Displays the discovery progress. For details, see "Discovery Progress Dialog Box" on page 677.

Selected Items Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element

(A–Z) Description

<right-click

menu>

Edit Scheduling. Click to open the Discovery Scheduler to define a schedule for a

specific job. For details, see "Discovery Scheduler Pane" on page 490.

Invoke

immediately

l A check mark signifies that the DFM job runs as soon as the triggered CI reaches

the Probe. In this case, the Invoke on new triggered CIs immediately check box is

selected in the Properties tab.

l If this column does not contain a check mark, the job runs according to the

schedule defined in the Schedule Manager.

Job name The name of the job.

Schedule The scheduling information of the job as defined in the Discovery Scheduler.
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UI Element

(A–Z) Description

info

Trigger

Queries

The name of the query that activated the job. For details, see "Trigger Queries Pane"

on page 489.

Discovery Module/Jobs – Dependency Map Tab

Displays a visual representation of the real-time progress of the discovery process. The map displays

CIs that were triggered by a job, and CIs that were discovered as a result of the activated job.

To access Select Universal Discovery > Discovery Modules/Jobs tab > Discovery Modules

pane > a module/job> Dependency Map tab.

Important

Information

Depending which node you select in the Discovery Modules pane, different

information is displayed in the Dependency Map tab.

If you select:

o The Discovery Modules root, and select the Show only active Discovery jobs

check box, the Dependency Map displays only active jobs and their

interdependencies.

o The Discovery Modules root, and clear the Show only active Discovery jobs

check box, the Dependency Map displays all discovery jobs and their

interdependencies.

o A module, a topology map is displayed showing the module's active and inactive

jobs.

o A job, the topology map highlights the job in the module's map.

Relevant

tasks

o "How to Run Module/Job-based Discovery" on page 463

o "How to Manually Activate Modules/Jobs/CIs" on page 466

See also o "Universal Discovery Overview" on page 415

o "Modules/Jobs-based Discovery Overview" on page 460

o "Discovered/Created/Last Updated CIs Dialog Box" on page 674
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element

(A-Z) Description

<right-click

menu>

Use the right-click menu to view details for a job, CI, or link, for example, the number

of CI instances (of a specific type) in the CMDB or the number of CI instances created

by a specific job.

Depending on which object is selected, the following menu options are displayed:

l When a job is selected:

Show discovered CIs. Click to view the CIs discovered by the job. To filter the

query, select a CIT from the menu.

Show trigger CIs. Click to view the CIs that triggered the job.

l When a CI is selected:

Show all CIT instances. Click to view all CIs of this CI type.

l When a link from a CI to a job is selected:

Show trigger CIs for job. Click to view CIs (of the selected type) that triggered

the job.

l When a link from a job to a CI is selected:

Show discovered instances. Click to view CIs (of the selected type) that were

discovered by the job.

<Toolbar> For a description of the icons, see "Toolbar Options" in the HP Universal CMDB

Modeling Guide.

<Tooltip> Hold the pointer over a CI or job to display a description.

Show only

active

Discovery

jobs

When the Discovery Modules root is selected in the Discovery Modules pane, this

check box is displayed.

Select to display all active jobs (from any module).

Discovery Modules/Jobs – Properties Tab

Enables you to view and administer the properties of modules and jobs.
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To access Select Universal Discovery > Discovery Modules/Jobs tab > Discovery Modules pane

> a module/job > Properties tab.

Important

Information

Depending which level you select in the Discovery Modules pane, different information

is displayed in the Properties tab.

If you select:

l The Discovery Modules root, all active jobs are displayed with scheduling

information. Click any of the columns to sort the list by that column. Right-click a

job to edit its scheduling. For details, see "Discovery Scheduler Dialog Box" on page

492.

l A Discovery module, the Description and Module Jobs panes are displayed.

To edit a description, make changes in the Description pane and click OK.

See also "Module Jobs Pane" below.

l A job, the Parameters, Trigger Queries, Global Configuration Files, and Discovery

Scheduler panes are displayed. For details, see below.

Relevant

tasks

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

Module Jobs Pane

Enables you to view the active jobs for the selected module.

User interface elements are described below:

UI Element

(A–Z) Description

Add Discovery Job to Module. Opens the Choose Discovery Jobs dialog box where

you can select jobs from more than one zip file. (Hold the SHIFT or CTRL keys to select

several jobs.)
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UI Element

(A–Z) Description

Remove Selected Discovery Job from Module. Select the job and click the button.

(No message is displayed. To restore the job, click the Cancel button.)

Show discovered CITs as a map. You can choose to view a map of the CIs and links

that are discovered by the adapter, instead of a list. Click the button to open the

Discovered CITs Map window. The selected adapter is shown together with its CIs and

relationships. Hold the cursor over a CIT to read a description in a tooltip.

<Column

heading>

l Click a column heading to change the order of the CITs from ascending to

descending order, or vice versa.

l Click a column heading and drag the column to a different location in the table

columns.

l Right-click a column heading to customize the table. Choose from the following

options:

o Hide Column. Select to hide a specific column.

o Show All Columns. Displayed when a column is hidden.

o Select Columns. Select to display or hide columns and to change the order of

the columns in the table. Opens the Columns dialog box.

o Auto-resize Column. Select to change a column width to fit the contents. For

details, see Select Columns Dialog Box in the HP Universal CMDB Modeling Guide.

<List of

jobs>

All jobs included in the module. (Displayed when a specific module is selected in the

Discovery Modules pane.)

Right-click a row to open the Discovery Scheduler for the selected job. For details,

see "Discovery Scheduler Dialog Box" on page 492.

Invoke

Immediately

l A check mark signifies that the Discovery job runs as soon as the triggered CI

reaches the Probe. In this case, the Invoke on new triggered CIs immediately

check box is selected in the Properties tab.

l If this column does not contain a check mark, the job runs according to the

schedule defined in the Schedule Manager.
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UI Element

(A–Z) Description

Job Name The name of the job and the package in which the job is included.

(Displayed when a job is selected in the Discovery Modules pane.)

Schedule

Information

The scheduling information of the job as defined in the Discovery Scheduler.

Trigger

Queries

The name of the query that activated the job.

Parameters Pane

Enables you to override adapter behavior.

To view a description, hold the pointer over the parameter.

To access Select a job in the Discovery Modules pane in the Universal Discovery window.

Important

Information

You can override a default adapter parameter for a specific job, without

affecting the default value.

User interface elements are described below:

UI

Element

(A–Z) Description

Name The name given to the adapter.

Override Select to override the parameter value in the adapter.

When this check box is selected, you can override the default value. For example, to

change the protocolType parameter, select the Override check box and change

MicrosoftSQLServer to the new value. Click OK in the Properties tab to save the change:
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UI

Element

(A–Z) Description

For details on editing parameters in the Adapter Parameters pane, see "Adapter Definition

Tab" on page 244.

Value The value defined in the adapter.

Trigger Queries Pane

Enables you to define one or more queries to be used as triggers to activate the selected job.

User interface elements are described below:

UI

Element

(A–Z) Description

Add Query. Opens the Choose Discovery Query dialog box, enabling you to add one or

more non-default TQL queries to be used as triggers to activate the selected job.

The Choose Discovery Query dialog box lists available queries for the job. Select a query to

displayed it in the Query Preview pane. Hold the cursor over an TQL element to view details.

Remove Query. Removes the selected query.

Note:

l No message is displayed. To restore the query, click the Cancel button.

l If a query is removed for an active job, Discovery no longer receives new CIs

coming from that query. Existing Trigger CIs that originally came from the query

are not removed.

Opens the Trigger Query Editor. For details, see "Trigger Query Editor Window" on page

497.

Available: In the job's Properties tab only.

Opens the Modeling Studio.

Available: In the job's Properties tab only.
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UI

Element

(A–Z) Description

Probe

Limit

The Probes/clusters used for the query. Click the button to open the Edit Probe

Limitation for Query Output dialog box where can select the Probes/clusters on which the

trigger query should run.

Query

Name

The name of the Trigger query that activates the job.

Global Configuration Files Pane

Lists the global configuration files defined for the adapter used by the selected job.

User interface elements are described below:

UI Element (A–Z) Description

Edit. Opens the selected configuration file in an appropriate editor.

For example, the file msServerTypes.xml opens the Script Editor.

Discovery Scheduler Pane

Enables you to view information about the schedule set up for the selected job.

User interface elements are described below:

UI Element

(A–Z) Description

Click to add times to the Allow Discovery to run at list. The Time Templates dialog

box opens.

To add a time template to the list, in the Time Templates dialog box, click the Add

button to open the Edit Time Template dialog box.

For details, see "Time Templates Dialog Box" on page 496.

Allow

Discovery to

run at

Choose a template that includes the days and times when the job should run.
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UI Element

(A–Z) Description

Edit

scheduler

Click to open the Discovery Scheduler. For details, see "Discovery Scheduler Dialog

Box" on the next page.

Invoke on

new

triggered

CIs

immediately

Enables the job to run as soon as the Trigger CI reaches the Probe.

When this option is not selected, the job runs according to the schedule defined in the

Schedule Manager.

Note: If this option is not selected and a job is running, new triggered CIs are not

run by the job.

Although new triggered CIs are not run, they are counted into the status bar. This

means the status bar does not reach 100% completed, even though the job

successfully completed, and the user has to wait until the next run of the job for

the status bar to reach 100% completed.

Discovery PermissionsWindow

Enables you to view permissions data for jobs.

To

access

Select Data Flow Management > Universal Discovery > Discovery Module/Jobs tab > a

job > Details tab > Discovery Job Details pane , and click the View Permissions button.

See also l "Viewing Permissions While Running Jobs" on page 460

l "Adapter Definition Tab" on page 244

l "Permission Editor Dialog Box" on page 281

Relevant

tasks

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

l "Viewing Permissions While Running Jobs" on page 460

l "Adapter Definition Tab" on page 244
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l "Permission Editor Dialog Box" on page 281

User interface elements are described below:

UI Element

(A-Z) Description

Export a permission object in Excel, PDF, RTF, CSV, or XML format. For details, see

"Browse Views Mode" in the HP Universal CMDB Modeling Guide.

Objects and

Parameters

The commands that appear in the relevant Jython scripts.

Operation The action that is being run.

Permission The name of the protocol as defined for the job.

Usage

Description

A description of how the protocol is used.

Discovery Scheduler Dialog Box

Enables you to define a schedule for a specific job, for example, every day Data Flow Management

starts running an IP ping sweep on Class C networks at 6:00 AM.

To access Use one of the following:

l Right-click a job and select Edit scheduling.

l Select Universal Discovery > Discovery Modules/Jobs tab > a job > Properties tab

> Discovery Scheduler pane, and click the Edit Scheduler button.

Important

Information

l The Discovery Scheduler defines the frequency of the discovery (daily, monthly)

whereas the time template defines when the job should run (during the day, at

night, at weekends only). You can run the same schedule with different time

templates. For example, you can define a schedule that runs every day and you can

define a time template that runs at night from 01:00 AM to 05:00 AM. A job defined

in this way runs every day from 01:00 AM to 05:00 AM. You can define a second time

template to run at a different time, and you also can use this time template with

the same schedule.

l If you change a schedule for a job, DFM next runs the job according to the following

calculation: The current date and time plus the selected interval. For example, if
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you choose Once, the Invocation Time is in one hour.

For details on creating a time template, see "Time Templates Dialog Box" on page 496.

Relevant

tasks

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A–

Z) Description

Click to validate the Cron expression you entered.

<Days of

month>

(Displayed when you select Monthly.) Click the button to choose the days of the

month on which the action must run. The Select Days dialog box opens. Choose the

required days by selecting the check boxes. You can select multiple days.

l Select all. Select all the days.

l Unselect all. Clear all the selected days.

<Days of the

week>

(Displayed when you select Weekly.) Select the day or days on which the action

should run.

<Frequency> l Once. Define the task to run only once.

l Interval. Defines the interval between successive runs.

l Daily. Run a task on a daily basis.

l Weekly. Run a task on a weekly basis.

l Monthly. Run a task on a monthly basis.

l Cron. Enter a Cron expression in the correct format.

<Months of the

year>

(Displayed when you select Monthly.) Select the month or months in which the

action must run.

Data Flow Management Guide

Chapter 14: Module/Job-based Discovery

HP Universal CMDB (10.22) Page 493 of 795



UI Element (A–

Z) Description

End by Select the date and time when the action should stop running by selecting the End

by check box, opening the calendar, selecting the date and time, and clicking OK.

Note: This step is optional. If you do not need to specify an ending date, leave

the End by check box cleared.

Invocation hour (Displayed when you select Daily, Weekly, or Monthly.) Select the time to activate

the action. Click the button to open the Select Hours dialog box. Choose the

required time by selecting the check boxes. You can select multiple times.

l Select all. Select all the times.

l Unselect all. Clear all the selected times.

Note: You can also enter the time manually in the Invocation hour box.

Separate times by a comma and enter AM or PM after the hour. The

manually entered action times are not restricted to the hour and half hour

only: you can assign any hour and minute combination. Use the following

format: HH:MM AM, for example, 8:15 AM, 11:59 PM.

Invocation

Time

(Displayed when you select Once.) Choose the date and time the action should

begin running by opening the calendar and choosing a date and time, or accept the

default.

Repeat every (Displayed when you select Interval.) Type a value for the interval between

successive runs and choose the required unit of time (minutes, hours, or days).

Note: After each change, the next time that the job runs is the current time

plus the interval, that is, the job does not start immediately.

Start at Choose the date and time when the action must begin running by selecting the

Start at check box, opening the calendar, selecting the date and time, and clicking

OK.

Note: When selecting the start time, the time zone in the start time is set

according to the client machine’s location, although it may not match the

value selected in Time Zone.
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UI Element (A–

Z) Description

Time zone Select the time zone according to which the Probe must schedule jobs.

The default is <<Data Flow Probe Time Zone>>: the Probe uses its own system-

defined time zone. This enables scheduling to take place at different times in

different geographical locations.

For all Probes to start working at the same time, select a specific time zone. (This

assumes that the Probes' system date/time and time zone are correctly

configured.)

Find Jobs Dialog Box

Enables you to search for jobs answering to specific criteria. The results of the search are displayed in

the Selected Items pane in the Details tab.

To access Click the Find Job button in the Discovery Modules pane.

Relevant tasks l "How to View Job Information on the Data Flow Probe" on page 132

l "How to Find Discovery Errors" on page 667

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

User interface elements are described below:

UI Element

(A–Z) Description

Direction Searches forwards or backwards through the modules.

Find All All jobs meeting the search criteria are highlighted.

Find

Discovery job

by

Choose between:

l Name. Enter the name of the job or part of it.
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UI Element

(A–Z) Description

l Input type. CIs that triggered the job. Click the button to open the CI type list.

Locate the CI type that you are searching for.

l Output type. CIs that are discovered as a result of the activated job.

Find Next The next job meeting the search criteria is highlighted.

Time Templates Dialog Box

Enables you to define a daily or weekly schedule to run selected jobs.

To

access

Select Universal Discovery > Discovery Modules/Jobs tab > a job > Properties tab >

Discovery Scheduler pane, and click the Time Template button.

Relevant

tasks

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

l "Discovery Scheduler Dialog Box" on page 492

User interface elements are described below:

UI

Element

(A–Z) Description

Add new job execution template. Opens the Edit Time Template dialog box, enabling you

to add a time template:

l Time Template. A unique name for the time template.

Note: The name of the time template must be unique.

l Every day between. Enables you to define a daily schedule for the job execution. You

can define any hour and minute combination.
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UI

Element

(A–Z) Description

l Week Time. Enables you to define a weekly schedule for the job execution. Select this

option to select a time in the Time Definition grid. To select adjacent cells in the grid,

click and drag the mouse over the grid. To clear a time, click the selected cell in the

grid a second time.

Remove job execution template. Removes the selected time template.

Edit job execution template. Select a time template and click to edit it. Opens the Edit

Time Template dialog box.

Trigger Query Editor Window

Enables you to edit a TQL query that has been defined to trigger jobs.

To access Select Data Flow Management > Universal Discovery > Discovery Modules/Jobs tab

> Properties tab > Trigger Queries pane > a TQL query, and click the Open the Query

Editor button.

Important

Information

A Trigger query associated with a job is a subset of the Input query, and defines which

specific CIs should be the Trigger CIs for a job. That is, if an Input query queries for IPs

running SNMP, a Trigger query queries for IPs running SNMP in the range 195.0.0.0-

195.0.0.10.

Relevant

tasks

l "How to Run Module/Job-based Discovery" on page 463

l "How to Manually Activate Modules/Jobs/CIs" on page 466

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

l "Trigger CIs and Trigger Queries" on page 26

Data Flow Management Guide

Chapter 14: Module/Job-based Discovery

HP Universal CMDB (10.22) Page 497 of 795



User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A–Z) Description

<Panes> l "CI Type Selector Pane" below

l "Editing Pane" below

l "Information Pane" on the next page

Query Name The name of the Trigger query that activates the job.

CI Type Selector Pane

Displays a hierarchical tree structure of the CI Types found in the CMDB. For more details, see CI Type

Manager User Interface in the HP Universal CMDB Modeling Guide.

Note: The number of instances of each CIT in the CMDB is displayed to the right of each CIT.

Important

Information

To create or modify a TQL query, click and drag nodes to the Editing pane and define

the relationship between them. Your changes are saved to the CMDB. For details, see

How to Add Query Nodes and Relationships to a TQL Query in the HP Universal CMDB

Modeling Guide.

Relevant

tasks

l How to Define a TQL Query in the HP Universal CMDB Modeling Guide

l How to Create a Pattern View in the HP Universal CMDB Modeling Guide

Editing Pane

Enables you to edit the node selected in the Trigger Queries pane.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A–Z) Description

<node> Click to display information about the node in the information pane.

<right-click

menu>

To view a list of icons, see Shortcut Menu Options in the HP Universal CMDB

Modeling Guide.

<Toolbar> To view a list of icons, see Toolbar Options in the HP Universal CMDB Modeling

Guide.
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Information Pane

Displays the properties, conditions, and cardinality for the selected node and relationship.

Important

Information

Hold the pointer over a node to view information:

A small green indicator is displayed next to the tabs that include

information:

User interface elements are described below:

UI Element

(A-Z) Description

Attributes Displays the attribute conditions defined for the node or the relationship. For details,

see Attribute Tab in the HP Universal CMDB Modeling Guide.

Cardinality Cardinality defines how many nodes you expect to have at the other end of a

relationship. For example, in a relationship between host and IP, if the cardinality is 1:3,

the query retrieves only those hosts that are connected to between one and three IPs.

For details, see Cardinality Tab in the HP Universal CMDB Modeling Guide.
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UI Element

(A-Z) Description

Details l CI Type. The CIT of the selected node/relationship.

l Visible. A tick signifies that the selected node or relationship is visible in the

topology map. When the node/relationship is not visible, a box is displayed to the

right of the selected node/relationship in the Editing pane:

l Include subtypes. Display both the selected CI and its descendants in the topology

map.

Edit

button

To view information, select a node or relationship in the Editing pane, select the tab in

the Information pane, and click the Edit button. For details on the Node Condition

dialog box, see Query Node/Relationship Properties Dialog Box in the HP Universal CMDB

Modeling Guide.

Qualifiers Displays the qualifier conditions defined for the node or the relationship. For details,

see Qualifier Tab in the HP Universal CMDB Modeling Guide.

Selected

Identities

Displays the element instances that are used to define what should be included in the

query results. For details, see Identity Tab in the HP Universal CMDB Modeling Guide.
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Inventory Discovery Overview

Inventory Discovery helps your organization drive standardization and compliance initiatives, manage

risk, perform IT asset audits, and implement chargeback policies.

Inventory Discovery, which also includes Infrastructure discovery, determines which devices are in your

network and gathers information about each of them. It also serves as the foundation for the other

modules of discovery. For example, Universal Discovery can gather information about what software is

used and how often it is used. Universal Discovery can also build relationships between licensing and

licensed applications that are installed. These relationships are useful when reconciling your

organization's license obligations.

Inventory discovery is typically managed and run based on Management Zones using wizard-driven

activities. These activities automate management of discovery jobs, and component deployment and

upgrades. Additionally, these activities can be configured with specialized settings for each

Management Zone. For example, UNIX servers in the Data Center may have different requirements for

discovery than laptops in the Finance group. Alternatively, inventory discovery can be deployed and run

manually using any third-party software packages.

Inventory Discovery begins by deploying software components to discovered devices in the

Management Zone - Universal Discovery Agents and Scanners. Deployment methods can be automatic

using activities. Alternatively, these components can be deployed manually using third-party tools.

The Universal Discovery Agent (UD Agent) provides secure communication between the device and the

Data Flow Probe, and manages and runs the Scanner. The Scanner searches the device for detailed

hardware, configuration, and software license information, and then stores the raw discovery data in a

scan file. When the UD Agent is not installed, Scanners are managed using activities or, alternatively,

managed manually using standard shell protocols.

Next, the discovery data is enriched with content from the Software Library. This enrichment process

helps Universal Discovery recognize applications and identify hardware. Finally, enriched data is

reconciled and normalized to reduce redundancies and errors, and then stored in UCMDB CIs.

The conceptual diagram below illustrates a basic inventory discovery system:
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For details about deployment methods, see "Inventory Discovery Deployment Overview" on page 508.

For details about the Universal Discovery Agent, see "Universal Discovery Agent Overview" on page 150.

For details about setting up the Inventory Discovery activity, see the HP UCMDB Universal Discovery

Content Guide - Discovery Activities.
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Inventory Discovery Scanners

After defining requirements, the next step in an IT asset inventory is to collect data. The data is

collected by Scanners.

You configure and generate scanners using the Scanner Generator. Scanners are configured according

to the specifications determined in the planning stage of the inventory.

The Scanner Generator is used to both configure and define the level of information to be collected.

One or more scanner executable programs with the desired configuration are then generated and

subsequently run across a computer population. 

The Scanner Generator also provides a set of options for controlling the behavior of the scanner as it

scans each computer, under both normal and exceptional conditions (such as when an error occurs).

Scanner Modes

The scanner is run across the computer population to collect inventory data in one of the following

ways:

l Enterprise Mode (default). Automatically collects an inventory using the Universal Discovery's

scheduling and launching capabilities.

l Manual Deployment Mode. Scans are launched manually. For example,scans are schedule and

launched from login scripts or on non-networked machines.
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Components of a Scanner

A scanner consists of the following files:

The scanner

executable

file

This file is an executable file. It contains the constant parts of the scanner:

l strings

l data files

l the scanner executable code

The scanner

configuration

file

The configuration file is a compressed XML file containing the settings for the

scanner you are currently configuring.

When the scanners are used in Enterprise Mode, they read the configuration from a

separate configuration file. This is a binary file with a .cxz extension. The typical size

of the configuration file is about 3K. As the size of the configuration file is

significantly smaller than the size of the complete scanner, a separate scanner

configuration is useful for repetitive inventory collection when the configuration of

the scanner has been altered. In this case, only a small configuration file is delivered

to the user’s computer to run with the original scanner instead of delivering the

entire new scanner.

Note: When used in Manual Deployment Mode, the Scanner Generator generates self-contained

scanner executables that consist of a combination of the scanner executable and configuration

file.

What Information Does the Scanner Collect?

Scanners can collect several types of information and can be configured to collect any or all of them.

The details recorded for each computer within each main category depend on the options and settings

selected when the scanner is generated and the configuration of the computer.

Scanners can collect the following information:

Information Description

Hardware and

Configuration

Information

Hardware information is detected automatically. The scanners collect and store from

100 to 900 hardware items for a computer, depending on the type and manageability

options available on the computer.
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Information Description

The Scanner Generator allows a subset of the hardware collection to be disabled.

Normally this is not required, but it may be desirable to decrease the scan file size or

scan time.

The hardware details that can be defined and recorded by the scanner include the

following:

l The processor type and BIOS details.

l The memory size and configuration details.

l The computer bus type and details of the attached cards.

l The hard disk drive specifications (including the total size and free space).

l The network type and ID (if applicable). This hardware item cannot be disabled in

Enterprise Mode.

l Comprehensive detection of network settings, including detection of multiple

network adapters, TCP/IP settings, gateways, DNS servers, subnet masks, DHCP

status.

l The monitor and video display adapter details.

l The type of keyboard and mouse driver installed and details of the I/O ports.

l The Operating System version and other details.

l The expansion (or adapter) cards detected.

l The hardware data information from System Management BIOS (SMBIOS).

l Running software processes.

Software

Information

Software information is scanned automatically, and consists of detailed information

about the files and directories on the drives scanned. The information collected

about files can be defined (including the file types and the level of information

collected). It is possible to define the drives that are to be scanned based on either

the media or format of the drive, or to use the targeted scanning option to scan just

a set of directories. Specific files can be collected (that is, stored in the scan file) for

further analysis or for error recovery purposes. It is also possible to configure the
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Information Description

level of file detail stored in the scan file and filters can be set up that specify

directories or files to be included or excluded from being stored.

User or Asset

Information

User or asset information consists of configurable fields that can be collected

automatically. It usually includes the asset number which is used to uniquely identify

each computer. Asset data fields are automatically populated from the data

extracted from text files, the Windows registry/WMI and environment variables.

Software

Utilization

Universal Discovery can gather information about the software that is being used on

the machines in your network. This is referred to as Software Utilization. The

information collected can be used to optimize software license cost, for example by

eliminating unused or under-utilized software installations.

From a software recognition perspective, any files that are Unknown and are shown

to have a high Utilization should be marked for teaching.

Software utilization data shows the number of days that an application was used (as

a percentage) over a period of time. This period of time is known as the Utilization

Period.

As a guideline the Utilization Periods are as follows:

l Month (31 days)

l Quarter (90 days)

l Year (365 days)

Inventory Discovery Deployment Overview

There are several different types of deployment scenarios for Inventory Discovery. These diagrams

illustrate the basic flow of scan files from each major component of Universal Discovery.
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Scenario 1: Complete, Fully-Automated (Recommended)

l Scenario: You want a complete inventory discovery solution that takes full advantage of automated

activities that schedule and run jobs. Universal Discovery Agents are deployed that are used as shell

clients for communication with nodes, and as managers of Scanners for discovery.

l Type of discovery: Agent-based inventory discovery.

l Deployment Methods:
o The Infrastructure Activity is used to trigger deployment of the Universal Discovery Agents to

discovery nodes. Alternatively, deployment can be performed manually using third party tools.

Scanners are copied to nodes by Universal Discovery Agents.

o The Inventory Discovery Activity is used to trigger deployment of the Scanner.

l Discovery Methods: 
o The Infrastructure Activity is used to manage the Universal Discovery Agent lifecycle.

o The Inventory Discovery Activity is used to schedule, manage, and run scanner-based inventory

discovery.

l Links to Tasks:
o "How to Run Zone-based Discovery" on page 423

o "How to Install the Universal Discovery Agent Manually" on page 160
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Scenario 2: Scanner Testing

l Scenario:  You want to test the functionality of the Scanner, or to analyze scan file data or file

structure.

Alternatively, you are looking for a manually-initiated discovery process only.

l Type of Discovery: Agentless inventory discovery

l Deployment Methods: Generate a Scanner using the Scanner Generator Wizard, then copy the

Scanner file to the node using any remote access technology.

l Discovery Methods: Remote access technologies are used to connect to the discovery node and

execute the Scanner. Scanners can also be executed interactively at the console of the discovery

node. Scan files are uploaded to the Data Flow Probe via FTP or HTTP, or they can be manually copied

directly to the Data Flow Probe using any remote access technology.

l Links to Tasks:
o "Inventory Discovery Scanners" on page 505

o "How to Install the Universal Discovery Agent Manually" on page 160
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Scenario 3: Routed, Complex

l Scenario: You have a complex environment that requires a routed solution for scan files to reach

the Data Flow Probe. You also change Scanner versions or configuration files frequently and need an

automated solution to deploy them.

l Type of Discovery:  Agentless inventory discovery

l Deployment Methods:
o Scanners are manually deployed to the discovery node.

o Scanner Scheduler and Store and Forward are installed using any remote access technology.

l Discovery Methods: Scanner Scheduler schedules and runs inventory discovery.

l Links to Tasks:
o "How to Deploy the Scanner Scheduler" on page 190

o "How to Install the Store and Forward Server" on page 199

o "How to Run Inventory Discovery Manually" on page 535
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Scenario 4: Partially-Automated

l Scenario: You want a partially-automated solution for inventory discovery, but do not require any

shell communication to the node.

l Type of Discovery: Agentless inventory discovery

l Deployment Methods:  The Inventory Discovery Activity is used to deploy the Scanner.

l Discovery Methods:The Inventory Discovery Activity is used to trigger inventory discovery. The Data

Flow Probe uses NTCMD or SSH to communicate with the discovery node.

l Links to Tasks:
o "How to Run Zone-based Discovery" on page 423

o "How to Run Inventory Discovery Manually" on page 535
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Scan Files

Information that is collected from each computer is written to a scan file and is stored in the following

file formats:

l Compressed XML (XSF)

All information scanned on the computer is stored to the file. The file is compressed using gzip. The

files can be uncompressed using gzip, WinZip, or any other program that supports gzip

decompression.

l Delta Scan File (DSF)

Instead of sending a full scan file to a probe after every scan, the scanners can calculate the

difference (the delta) between the last full scan and the current one and transfer just this in Delta

Scan File format (DSF). This format can dramatically reduce network bandwidth.

Delta Scan files cannot be viewed or used in the Inventory Tools (Analysis Workbench, SAI Editor, and

Viewer).

Scan File Structure

A scan file contains a sequence of elements, each of which have various attributes. Root elements are:

l <hardwaredata>

l <applicationdata>

l <users>

l <applicationusage>

l <filedata>

l <storedfiles>

l <configurationdata>

The following is an example of several sections of a scan file: 

<?xml version="1.0" encoding = "UTF-8" ?>
<inventory codepage="1251" locale="English (United States)" fsfmajorver="7"
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fsfminorver="6" enricherver="10.00.000.555">

<hardwaredata>
 <hwAssetData type="shell">
 <hwAssetDescription type="attrib">tbrown - Xeon,
2800MHz, 3712Mb</hwAssetDescription>
 <hwAssetTag type="attrib">000590 </hwAssetTag>
 </hwAssetData>
 <hwMemoryData type="shell">
 <hwMemTotalMB type="attrib">3712</hwMemTotalMB>
 <hwSwapFiles type="shell">
 <hwSwapFiles_value type="shell_value">
 <hwMemSwapFileName         type="attrib">C:\pagefile.sys</hwMemSwapFileName>
 <hwMemSwapFileSize type="attrib">1534</hwMemSwapFileSize>
 </hwSwapFiles_value>
 </hwSwapFiles>
 <hwDOSMemoryData type="shell">
 <hwMemConventional type="attrib">640</hwMemConventional>
 </hwDOSMemoryData>
 <hwCMOSMemory type="shell">
 <hwMemExtended type="attrib">3799944</hwMemExtended>
 <hwMemCMOSTotal type="attrib">3800584</hwMemCMOSTotal>
 <hwMemCMOSConventional type="attrib">640</hwMemCMOSConventional>
 </hwCMOSMemory>
 </hwMemoryData>
 </hardwaredata>

<applicationdata>
<recogconfig>
 <sai name="C:\hp\UCMDB\DataFlowProbe\runtime\probeManager\

discoverySaiResources\saiRuntime\User.zsai"
        desc="User SAI File" date="04/06/2011" type="User"/>
 <sai name="C:\hp\UCMDB\DataFlowProbe\runtime\probeManager\

discoverySaiResources\saiRuntime\Master.zsai"
        desc="" date="07/05/2011" type="Master"/>
 </recogconfig>
 <application version="6.4.09"
 release="6.4"
 name="Windows Media Player"
 publisher="Microsoft"
 language="English"
 os="Windows 2000"
 type="Ambient music or advertising messaging software"
 typeid="143033"
 maindir="C:\Program Files\Windows Media Player"
 lastUsed="2011-08-26 00:00:00"
 versionid="9978"
 releaseid="582"
 licencedby="11907"
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 licencedbyrelease="84"/>
 <application version="6.0 sp1"
 release="6.0"
 name="Internet Explorer"
 desc="Microsoft Internet Explorer"
 publisher="Microsoft"
 language="English"
 os="Windows 98/NT/2K/ME/XP"
 type="Internet browser software"
 typeid="122252"
 maindir="C:\Program Files\Internet Explorer"
 lastUsed="2011-05-07 00:00:00"
 versionid="12790" releaseid="131"/>
</applicationdata>

<filedata>
 <dir name="C:\" date="2011-07-03 03:23:04" contains="-1">
 <file name="AUTOEXEC.BAT" size="0" modified="2011-04-03 13:51:04" attr="a"/>
 <file name="BOOT.INI" size="288" modified="2011-04-03 15:14:38" attr="rsa"/>
 <file name="sd_settings.ini" size="462" msdos="SD_SET~1.INI" modified="2011-06-
14 09:08:44" attr="a">
 <verinfo name="DOS 8.3 Name" value="SD_SET~1.INI"/>
 </file>
 </dir>
</filedata>

<storedfiles>
 <storedfile type="storedfile" name="SYSTEM.INI" size="217" istext="1"
istruncated="0" dir="C:\WINNT\SYSTEM.INI">
 <contents encoding="text">; for 16-bit app support
[386Enh]
 woafont=dosapp.fon
 EGA80WOA.FON=EGA80WOA.FON
 EGA40WOA.FON=EGA40WOA.FON
 CGA80WOA.FON=CGA80WOA.FON
 CGA40WOA.FON=CGA40WOA.FON
[drivers]
 wave=mmdrv.dll
 timer=timer.drv
[mci]
 </contents>
 </storedfile>
</storedfiles>
</inventory>
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Processing Scan Files

Processing Normal Scan Files

At the end of the enrichment process, a new enriched scan file is created; the enriched core file is

converted to UCMDB CI and relationship data, and reported to UCMDB. If delta scanning was enabled in

the parameters for the Scanner used to produce the scan file, the incoming scan file is stored in the

Original directory for future use by the delta scan processing. If delta scanning was disabled, the

incoming scan file is deleted.

Tips

l If an error occurs, the original scan file is moved to a failure directory and is not deleted.

l If an enriched scan file for the same computer already exists, the old file is overwritten.

Reprocessing Normal Scan Files

Scan files can be reprocessed after they are enriched. For example, you may want to run this operation

when you update the Software Application Index (SAI) file. For example, after you use Express Teaching

to teach applications, you may want to reprocess scan files. Scan files for selected nodes are moved

from the Processed folder to the Incoming folder. Then, the scan file is processed using the updated SAI

file.

To reprocess normal scan files, see "How to Reprocess Scan Files" on page 566.

Processing Delta Scan Files

The delta scan file is used in conjunction with the previous version of the scan file located in the Original

directory to reconstruct the new full version of the scan file. This full version is then moved into the

Incoming directory, where it gets processed in the same way as other normal scan files.

At the end of the process, the reconstructed scan file is moved to the Original directory, ready for the

next time a delta scan is found for this particular scan file instance.

For details handling delta scan files (Manual Deployment mode only), see "How to Set up the Scanner to

Handle Delta Scan Files in Manual Deployment Mode" on page 558.
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Scan File Processing Power

When the scan files flow into the incoming directory of the XML Enricher faster than the XML Enricher is

able to process them, a build-up of scan files occurs in the incoming directory. To allocate more

processing power for enriching scan files, Universal Discovery can be configured to allocate more

resources to accommodate this load.

Configuring Threads

In general, higher numbers of threads that are allocated to the XML Enricher service results in higher

amounts of CPU and memory that the XML Enricher process consumes. As a result, the processing of

scan files runs faster and faster. However, too many threads may slow down the processing if there is

not enough CPU or memory resources available. In this case, disk performance becomes a constraining

factor.

It is recommended to experiment with this setting using gradual changes and then analyze the results

in the incoming directory of the XML Enricher.

To configure the maximum number of processing threads in the XML Enricher service, see "How to

Configure the Maximum Number of Threads to Process Scan Files" on page 564.

Configuring Memory Mode or Database Mode

You can configure the mode in which the XML Enricher service runs when processing scan files. Select

the mode that best suits your system or business needs as follows.

Mode Memory Usage Hard Disk Usage

Memory High Low

Database Low High

To configure this mode, see "How to Configure XML Enricher to Suit the Probe Deployment Mode" on

page 561.
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XML Enricher

The XML Enricher is a process that runs in the background and automatically adds application data to

scan files. This process is called scan file enrichment. It works as follows:

1. The XML Enricher looks for new scan files (xsf or dsf format) in the Incoming directory.

2. If a file is found, it processes the file using SAI (Software Application Index) application recognition.

3. Information about recognized applications is added to the file data and separate

<applicationdata>, <applicationusage>, and <users> sections are added to the XML file.

4. Two types of enriched scan files are created:

o In the Processed directory complete enriched files are stored. They contain the complete scan

file information enriched with the application recognition and software utilization data. The

Inventory tools (the Viewer, the Analysis Workbench, and the SAI Editor) can make use of the

files in the Processed directory for analysis and application teaching. To prevent locking of the

scan files in the Processed directory, and to reduce the load on the computer running the Data

Flow Probe, it is recommended to copy these files to the Universal Discovery Administrator’s

desktop where Inventory Tools are installed.

o In the ProcessedCore directory, the core enriched files are created. These files do not contain

the information about stored files. Additionally, the files do not contain information about file

and directory data. Therefore, they are much smaller than the fully enriched files. The core

enriched files are used internally by the InventoryDiscovery adapter to process the scan file

information and convert it to the UCMDB CI and relationship data. This directory is not created

by default and must be configured. For more information, see "How to Create the Processed

Core Directory" on page 565.

The XML Enricher can also be used to re-enrich scan files that were enriched previously. This can be

useful after applying a significant update to the SAIs.
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For information about setting up the XML Enricher to optimize performance, see "How to Configure the

Maximum Number of Threads to Process Scan Files" on page 564 and "How to Configure XML Enricher to

Suit the Probe Deployment Mode" on page 561.

For information about setting up software recognition options, see "XML Enricher: Software Recognition

Configuration Dialog Box" on page 655.
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Software Application Index (SAI) Files

The Software Application Index (.zsai) files contain a database of software applications. The XML

Enricher uses these files to perform application recognition.

Note: These files are supplied in Content Packs by Hewlett-Packard and are not editable.

Master.zsai Contains English versions of software and language-neutral versions of Windows

software.

French.zsai Contains French versions of Windows software.

German.zsai Contains German versions of Windows software.

Unix.zsai Contains English and language-neutral versions of UNIX software.

BaseUnixOS.zsai Contains language-neutral installed package rules for base UNIX operating system

software.

Mac.zsai Contains language-neurtral versions of Apple Mac software.

Legacy.zsai Contains older versions of Unix and Windows applications for all languages.

XML Enricher Log Files

Master Log

A running log that contains all activity that occurred in the XML Enricher service. By default, it is named

XMLEnricherService.log and contained in the following

location: C:\hp\UCMDB\DataFlowProbe\runtime\log

The format for a line in the log file is:

<date> <time> <thread> <level> <description>

Parameter Description

<date> Format: YYYY-MM-DD

<time> Format: HH:MM:SS:MSS
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Parameter Description

where:

l HH. Hours

l MM. Minutes

l SS. Seconds

l MSS. Milliseconds

<thread> The name of the processing thread where the log event occurred.

l Main. The main thread .

l Pool 1- Thread <ThreadNumber>

where <ThreadNumber> represents the thread where the log event occurred.

Note: The maximum amount of threads can be configured. For more

information, see "How to Configure the Maximum Number of Threads to Process

Scan Files" on page 564.

<level> One of the following:

l Info. Information-related entry.

l Error. An error occurred. Stack information is provided.

l Debug. A debugging event.

<description> Provides details about the logging event.

Scan File Error Logs

Error information about scan files that have not been successfully enriched are created in two

locations. For information about the file structure of XML Enricher service, see "XML Enricher Directory

Structure" on page 595.

Note: The data contained in the text file and the XML file is the same.
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l Text File. A text file is created in one of the following subdirectories in the Failed subdirectory:

o Error

o Delta

o Corrupt

The naming convention of this text file is as follows:

<ScanFileName> .xsf.log

where <ScanFileName> is the name of the scan file.

l XML File. If the ProcessedCore directory is created, an XML file that contains error information is

created. For information about creating this directory, see "How to Create the Processed Core

Directory" on page 565.

The naming convention of this XML file is as follows:

<ScanFileName> .xml

where <ScanFileName> is the name of the scan file.

Application Teaching

Application Teaching is a process to improve application recognition.

The following are ways to perform application teaching:

l Rules. For more information, see "Using Rules to Teach Applications" below.

l Express Teaching. For more information, see "Express Teaching Overview" on page 702.

Using Rules to Teach Applications

Overview

Rules are used to teach applications in order to improve application recognition.
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After a discovery job, the XML Enricher attempts to match data that is contained in a scan file to rules.

Rules are contained in SAI files and are created by Hewlett-Packard and by users.

Universal Discovery offers two main ways to teach applications:

l Application Rules. Choose the Package Rules or Version Data Rules option.

l File Rules. Specify files to use to recognize applications.

Ensure that the application or the release or version of the application is not already taught by Hewlett-

Packard. All rules taught by Hewlett-Packard are contained in the Master SAI files in the Software

Library. To see if your app or version is contained in the SAI library, see the release notes for the latest

Content Pack.

Tip:

l As an alternative to teaching applications yourself, you can contact HP Support and submit a

request for Hewlett-Packard to add rules for your application to the next release of the Content

Pack. For more information, contact HP Support.

l For the fastest and most convenient method, especially when teaching applications that are

packaged in a standard format, choose Application Rules > Package Rules option.

For both ways, you identify files that Universal Discovery uses to recognize applications or release or

versions of applications. While each are similar, there are differences in the number of supported

platforms, and the effort levels required to configure the rules.

The SAI Editor and Viewer is used when configuring rules for both methods. To install these tools, see

Inventory Tools in the HP Universal CMDB Data Flow Management Guide.

Note: Hewlett-Packard provides some package rules and version data rules out-of-box, and

actively maintains them in the Content Pack updates.

In general terms for each way, teach an application as follows:

1. Install the application

2. Run the scanner (additional configuration options required for Package Rules) and analyze the

scan file using Inventory Tools

3. Configure the rule by entering the package name (Package Rule) or by specifying individual files

(File Rule)
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4. Teach different releases and versions for the same application by typing a regular expression

(Package Rule), or by specifying additional individual files for that release or version (File Rule)

5. (Optional) Use Viewer to view the rule to ensure the rule information was saved.

Application Rules

Package Rules

(Most platforms/Operating Systems)

This method leverages package information, specifically the name of the package, to recognize

applications.

Not all applications are packaged using standard formats. If the application is not using standard or

support packages, for example, an .exe file, consider using File based rules.

Using this method is best for simple scenarios. The effort required to configure a rule is comparatively

low because you create one simple rule for all releases and versions of an application and then UD

automatically recognizes all releases and versions.

For more information on supported package types, see Supported Package Types in the HP Universal

CMDB Inventory Tools User Guide.

Version Data

(Windows only)

Essentially, this option operates the same as Package Rules, but the regular expressions that are used

to recognize releases and version information use the information contained in the executable files of

the file system. This option is recommended when consistent publisher and version information is

reported in the version data inside its executable files.

File

(Most platforms/Operating Systems)

To use this method effectively, you must be knowledgeable about the file contents of each package

that you want to teach.

If there are many versions of an application, you must install each version of the application.

Additionally, you must identify files that help UD recognize each version of the application. Alternatively,

consider using the Package Rules method.

You teach individual files for different releases and versions of the same application. Then, you assign

categories to each of those files that helps Universal Discovery identify the relationship of the file to

the application.
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Rules Matrix

The following table summarizes basic attributes of the ways to teach applications:

Type/Attribute Platform Effort Level Target Use

Package Many Low Standard Packaged Apps

Version Windows Low Windows Executables

File All High Executables

How to Use Rules to Teach Applications

Application Rules

Package Rules

For an example, see Example of a Recognition Rule Using Installed Package Information in the HP

Universal CMDB Inventory Tools User Guide.

Version Data Rules

See Version Data Based Recognition Rules in the HP Universal CMDB Inventory Tools User Guide.

For an example, see Example of a Recognition Rule Using Version Data in the HP Universal CMDB

Inventory Tools User Guide.

File

See Teaching Applications to the User SAI in the HP Universal CMDB Inventory Tools User Guide.

Note: The HP Universal CMDB Inventory Tools User Guideis installed together with the installation of

the Inventory Tools.

Enriched Scan File Structure

The XML Enricher reads scan files and outputs enriched XML scan files containing all of the original data

as well as data identified in the application recognition step.

Each file is stored as a <file> element. When a file is identified as belonging to an application, two

attributes are added to the element:
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l versionid

l flag

For example,

<file name=”winword.exe” size=”12345” versionid=”1111” flag=”M”/>

represents a file named winword.exe identified as belonging to the application with a version ID of

1111. The type of the file is “M”, which means Main file. The possible values for the type field are:

flag “type” tag in enriched XML file

Main M

Associated Y

3rd Party 3

Device Driver A

Unknown N

The versionid attribute refers to the unique ID associated with every version in the SAI library. In an

enriched XML scan file, the <applicationdata> section contains a list of applications identified on the

machine along with the version IDs.

For example:

<applicationdata>
<application version="6.0 sp1"

release="6.0"
   name="Internet Explorer"

desc="Microsoft Internet Explorer"
publisher="Microsoft"
language="English"
os="Windows 98/NT/2K/ME/XP"
type="Internet browser software"
typeid="122252"
maindir="C:\Program Files\Internet Explorer"
lastUsed="2004-05-05 00:00:00"
versionid="12790"
releaseid="131"

   />

<application version="6.0 sp1"
release="6.0" name="Outlook Express"
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   publisher="Microsoft"
language="English"
os="Windows 98/NT/2K/ME/XP"
type="Desktop communications software"
typeid="105020"
maindir="C:\Program Files\Outlook Express"
lastUsed="2004-05-05 00:00:00"
versionid="12792"
releaseid="372"
licencedby="12790"
licencedbyrelease="131"

   />

</applicationdata>

The example above could be found for a machine with just two applications on it: Microsoft Internet

Explorer and Microsoft Outlook Express. The licencedby attribute indicates that Microsoft Outlook

Express is licensed by Microsoft Internet Explorer. In other words, while both are licensable applications,

this machine requires one license for Microsoft Internet Explorer; with this license, no separate Outlook

Express license is required.

Hardware and Software Recognition

Recognition is the process of identifying certain properties and attributes of a hardware device or a

software application by leveraging content that is supplied by Content Packs and by publisher data.

Hardware Recognition

l Discovery Rules. A database containing information on hardware that is available for sale by a wide

range of manufacturers. The Discovery Rules Engine determines the device’s operating system,

application, device family, and model. Then, Discovery Rules assigns a device type to your device

model.

This database is updated monthly and is included in Content Packs. For more information, see the

Universal Discovery Community website (https://hpln.hp.com/group/universal-discovery/).

To find more information about viewing Discovery Rules that are installed on your system, see "How to

View Discovery Rules in JMX" on page 306.

Note: An HP Passport user name and password is required to log in to this site.
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Software Recognition

l Software Identification Tags. Universal Discovery supports the ISO/IEC 19770-2 standard. A

software identification tag is an XML file that contains identification information about a software

product. The tag is installed on a discovery node together with the software product, and it uniquely

identifies the software. When tags are captured by Scanners during discovery, the data can be

leveraged for improved software asset management and compliance.

The tag may be created as part of the installation process, or added later for software already

installed without tags.

Software identification tag files must have the .swidtag file extension in order to be recognized by

Inventory Discovery tools. You can create installed package rules that can match the information

found in the software ID tags.

For more information, about viewing software identification tags, see "Inventory Tools" on page 530.

l Software Application Index (SAI). SAI files provided with the Content Pack contain information to

identify applications on a discovery node. The library also contains license relationship information

that allows Universal Discovery to identify how individual software products are related to a

software product suite.

SAI files can be exported from the Administration > Package Manager, then select SAI. For more

information, see How to Export a Package in the HP Universal CMDB Administration Guide.

In addition to the standard libraries, Universal Discovery includes several tools that allow you to

create your own library extensions in the form of one or more User SAI files that can be applied to

the automatic Application Recognition process. For more information, see the section that describes

the SAI Editor in "Inventory Tools" on page 530. For more information about teaching applications to

improve the Application Recognition process, see "Application Teaching" on page 522.

The SAI contains information about applications in multiple languages for multiple platforms. SAI

files are available as follows:

Windows The following languages are available:

o English

o French
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o German

UNIX SAI files are available for the following variant systems:

o BaseUnix

o HP-UX

o AIX

o Solaris

Mac Mac OS X

App Store Applications

"App" Store applications refer to applications that are downloaded or distributed from an online digital

distribution platform store.

Information about App Store applications that is collected during Inventory Discovery is sent to UCMDB

and contained in the Installation Source attribute of the Installed Software CI.

For more information on viewing CIs, see "CI Selector" in the HP Universal CMDB Modeling Guide.

Custom Hardware or Asset Mapping

Universal Discovery provides the capability to create custom mappings between captured data

contained in scan files and attribute of a CI in UCMDB.

By default, Universal Discovery maps a large subset of scan file data to UCMDB CIs and relationships,

however, not all data is mapped.

Note: If you create post-scan scripts to capture customized data, you need to create mappings for

this data. For more information on post-scan scripts, see "Pre-Scan and Post-Scan Scripts" on page

243.

To create custom mappings of hardware or asset-related data, see "How to Map Scan File Attributes to

UCMDB" on page 569.
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Inventory Tools

The Inventory Tools enable you to view and analyze scan file data.

Note: These tools are installed using the Data Flow Probe Installer program. They are installed

together with the Data Flow Probe. However, it is recommended to install them on a separate

computer to prevent performance degradation on the Data Flow Probe, and also to prevent data

corruption of the SAI files. For more information on installing Inventory Tools, see the section that

describes installing Data Flow Probes in the interactive HP Universal CMDB Deployment Guide.

To install them separately, run the Data Flow Probe Installer program and select the Inventory

Tools type installation. For details about supported platforms, see the HP Universal CMDB Support

Matrix document.

To start the tools (on Windows), click Start > Programs > HP UCMDB > Inventory Tools.

When the Inventory Tools are installed on your Windows computer,you can view the help

documentation for the tools by clicking the Help menu option of the Inventory Tool. Users of all

platforms that have Adobe Reader installed on the computer can also view the help documentation

by clicking Start > Programs > HP UCMDB > Inventory Tools.

Software Application Index (SAI) Editor

View Software Application Index (SAI) file data, and perform additional tasks as follows:

l View and edit a collection of SAI files

l Create new User SAIs

l Move and copy items between SAIs (you can only edit User SAIs), and delete items

l Export the contents of an SAI to XML format

l Display license relationships

l Add and edit existing license relationships

Viewer

Displays software, hardware and asset information that is collected for an individual computer as

follows:
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l Details of all software scanned, presented in an explorer style view

l User entered asset information

l Detailed and summarized hardware and configuration information

l The contents of key files collected during Inventory Discovery, such as system configuration files

l Details of all logical drives

l Details of all recognized applications and their utilization statistics

l Detailed comparison of two scan files

Analysis Workbench

Perform analysis tasks using three types of information as follows:

l Software files that are recognized as belonging to a particular application

l Unidentified software and files that may belong to unrecognized applications

l Hardware and asset data

Analysis Workbench uses the Software Application Index (SAI) that contains application and version

descriptions to identify the files found during Inventory Discovery. Scan results are checked against

the SAI to identify and recognize software. Any unrecognized files can be marked for further

investigation, and when identified, their details can be added to the SAI file so they will be correctly

identified in the future. For more information on Application Teaching, see "Application Teaching" on

page 522.

BDNA Normalize Integration

BDNA Normalize is a software product that is capable of normalizing raw inventory data against the

normalized catalog called BDNA Technopedia. Universal Discovery can integrate with BDNA Normalize, so

that the normalized installed software produced by the scanner-based inventory discovery is

normalized using the BDNA Technopedia data instead of Universal Discovery SAI.

When BDNA integration is enabled, the following changes occur during the BDNA installation and

configuration:
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l Folders are created in <DataFlowProbeInstallDir>\runtime\xmlenricher\Scans as follows:

o ProcessedNew. BDNA Normalize monitors this folder for scan files.

o OriginalCore. Contains the scan files enriched by BDNA Normalize.

Note: These folders are created when the configurations are performed on the Data Flow Probe

and not when BDNA Normalize is installed. However, OriginalCore folder is created only when you

enable the Debug mode. For more information on enabling the Debug mode, see "Debug Mode"

on the next page.

l The scan file workflow is changed as follows:

l The following attributes were added to the Installed Software CI type in the Universal Discovery class

model to hold BDNA Normalize specific data:

Attribute

Name

Display

Name Description

component Component Contains the name of the installed software component as

described in the BDNA Technopedia catalog. (e.g: Client, Server,

Agent,...)

service_

pack

Service Pack Contains the name of the service pack of the installed software

product as described in the BDNA Technopedia catalog.
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Attribute

Name

Display

Name Description

edition Edition Contains the edition of the installed software product as described

in the BDNA Technopedia catalog.

recognized_

by

RecognizedBy Indicates the source of the normalized installed software data.

When the value is "SAI", the installed software is normalized using

Universal Discovery SAI. When the value is "BDNA", the installed

software is normalized using BDNA Normalize.

Debug Mode

The Debug mode preserves the scan files enriched by BDNA Normalize in the

<DataFlowProbeInstallDir>\runtime\xmlenricher\Scans\OriginalCore directory, so that troubleshooting

of the BDNA Normalize operation can be done. When the debug mode is disabled, a copy of the BDNA

Normalize enriched scan file is not kept and once it is processed, it is deleted by the inventory discovery

jobs.

Software Utilization

The Software Utilization Data collected by Universal Discovery for applications recognized via its SAI

library is available and is normalized to the BDNA Technopedia format. The Software Utilization Data is

not available for applications that are not recognized by Universal Discovery (via SAI), but can be

recognized by BDNA Normalize.

Discovery Options for Client IP Ranges

Universal Discovery offers options to use or not use SNMP when discovering client type IP ranges. The

option that you choose depends on your organization's policies.

Discovery

Option Advantages Disadvantages

Without SNMP l Switch/router IP addresses are not

used.

IP addresses in UCMDB are not up-to-

date.
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Discovery

Option Advantages Disadvantages

l Switch/router passwords are not

used.

With SNMP IP addresses in UCMDB are up-to-date. l Switch/routers IP ranges are used.

l Switch/routers passwords are used.

How to Run Inventory Discovery

This high level task describes how to run Inventory Discovery in your environment.

This task includes the following steps:

1. "Prerequisites " below

2. "Run inventory discovery" below

3. "Results" on the next page

1. Prerequisites

o Ensure that UCMDB is running.

o Ensure that the Data Flow Probe server is running.

o (For Zone-based discovery only) Ensure that you have discovered the infrastructure in your

management zones. To do this, see "How to Run Zone-based Discovery" on page 423.

2. Run inventory discovery

Select one of the following methods to run inventory discovery:

o (Recommended) Zone-based. Use a Discovery Activity to run in specific Management Zones. For

more information, see "Inventory Discovery Activity" in the HP UCMDB Universal Discovery

Content Guide - Discovery Activities.

o Manual. Use any third party software packages to run inventory discovery. For more

information, see "How to Run Inventory Discovery Manually" on the next page.
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3. Results

To verify the discovery ran successfully, select the Management Zone in the Management Zones

tree. In the Discovery Status pane, click the Results tab.

Note: If you are not using Management Zones, click the Inventory Discovery job.

For user interface details, see "Discovery Results Tab/Pane" on page 686.

How to Run Inventory Discovery Manually

This task describes how to run inventory discovery manually.

This task includes the following steps:

l "Prerequisites" below

l "Configure the scanners" below

l "Distribute the scanners" on the next page

l "Run the scanners" on the next page

l "Save the scan files to the Data Flow Probe" on the next page

l "Run inventory discovery job" on the next page

l "Results" on the next page

1. Prerequisites

o Ensure that a Data Flow Probe server is running.

o Ensure that UCMDB is running.

2. Configure the scanners

Generate a scanner using the Scanner Generator Wizard. For more information, see "Scanner

Generator Wizard" on page 603.
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Note: Ensure you select Manual Mode in the Scanner Generator Wizard.

3. Distribute the scanners

Connect to discovery nodes using any remote access technology to copy the scanner executable

file to the discovery node.

4. Run the scanners

Methods to run scanners are as follows:

o Attended

Click the executable file. To see a list of default file names, see "Scanners tab" on page 651.

o Unattended

Connect to the discovery nodes using any remote access technology, third party solution, or

scripting solution and then run the scanner executable file. To see a list of default file names,

see "Scanners tab" on page 651. You can pass command line parameters to the discovery node

shell to override any configurations that were used in the Scanner Generator. For more

information about scanner command line options, see "Scanner Command Line Parameters

Overview" on page 583.

5. Save the scan files to the Data Flow Probe

Methods to save the scan file to the Data Flow Probe are as follows:

o Use an integrated solution that schedules scan times and automatically routes scan files. For

example, Store and Forward together with Scanner Scheduler. For more information, see "Store

and Forward Overview" on page 199 and "Scanner Scheduler Overview" on page 190.

o Manually copy the scan file from a discovery node to the Data Flow Probe using any remote file

transfer technology. For more information, see "XML Enricher Directory Structure" on page 595

and "Scanner Options Page" on page 639.

6. Run inventory discovery job

Run the Inventory Discovery by Manual Scanner Deployment job. For more information, see "How

to Manually Activate Modules/Jobs/CIs" on page 466.

7. Results

To verify the discovery ran successfully, select the Management Zone in the Management Zones

tree. In the Discovery Status pane, click the Results tab.
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Note: If you are not using Management Zones, click the Inventory Discovery job.

For user interface details, see "Discovery Results Tab/Pane" on page 686.

How to View Discovery Status of an Inventory CI in JMX

As an inventory discovery administrator, you can invoke the getDiscoveryStateForInventoryCI method

to check the discovery status of an inventory CI, so that you can verify the health and live state of that

device.

To do so,

1. Log in to the UCMDB JMX console. (Launch the Web browser and enter the following address:

http:/<server_name>:8080/jmx-console. You may have to log in with a user name and password.)

2. Locate UCMDB:service=Discovery Manager and click the link to open the Operations page.

3. Locate the getDiscoveryStateForInventoryCI operation.

4. Enter your Customer ID. (Default: 1)

5. For the ciId field, enter the global ID for the inventory CI for which you want to check the discovery

status.

a. In UCMDB UI, go to Modeling > IT Universe Manager.

b. In the CI Selector pane, go to the Search CIs tab, click the Start the Search icon for the CI

Name field.

c. From the returned results, select a discovered node.

d. Go to the Properties tab in the right pane, scroll down to locate the Global Id property.

e. Right-click the value for the Global Id property, select Copy Property Name and Value.

f. Paste the value into the ciId field in the JMX console and remove the property name.

6. Click Invoke.

The result displays, which looks similar to the following:

Data Flow Management Guide

Chapter 15: Inventory Discovery

HP Universal CMDB (10.22) Page 537 of 795



The result page contains discovery information in three sections:

o Discovery State

Field Description

First Discovery Time when the CI was discovered for the first time.

Last Seen Time when this CI was last discovered successfully by a job.

When there are no active jobs to discover this CI, or all jobs failed in

discovering this CI, the value is N/A.

Last Discovery

Result

Last discovery result. Available statuses include:

l Pending. There are one or more active discovery jobs that are

running. This CI is not yet discovered.

l Success. The CI was successfully discovered.

l Fail. Discovery of this CI failed with one or more errors.

l Warning. Discovery of this CI completed with one or more warning

messages.

l N/A. No active jobs and trigger CIs are available for discovering this CI.

o Agent State

N/A if no agent is available.
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When agent is used, this section displays agent related information. The same information can

also be found in the Properties tab of the CI.

o Scanner State

N/A is no scanner is available.

When scanner is used, this section displays scanner related information. The same information

can also be found in the Properties tab of the CI.

Note:

l If the trigger CI is a Probe Gateway CI, then the job discovery status and the Last Seen value for

the specific CI will not display.

l When a discovery job is deactivated, its last discovery record is not available even if the job had

successfully discovered the CI when it was active.

l The Last Seen value or the Last Discovery Result occasionally get reflected a bit late after the

job is finished in the Universal Discovery UI.

How to View Agent Deployment Log for an Inventory CI in

JMX

As an inventory discovery administrator, you can invoke the getAgentDeploymentLogForInventoryCI

method to check the agent deployment log for an inventory CI. You work with the JMX console.

This task includes the following steps:

1. Log in to the UCMDB JMX console. (Launch the Web browser and enter the following address:

http://localhost:8080/jmx-console. You may have to log in with a user name and password.)

2. Locate UCMDB:service=Discovery Manager and click the link to open the Operations page.

3. Locate the getAgentDeploymentLogForInventoryCI operation.

4. In the Value field for customerID, enter you customer ID. (Default: 1)

5. For the ciId field, enter the global ID for the inventory CI for which you want to check the discovery
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status.

a. In UCMDB UI, go to Modeling > IT Universe Manager.

b. In the CI Selector pane, go to the Search CIs tab, click the Start the Search icon for the CI

Name field.

c. From the returned results, select a discovered node.

d. Go to the Properties tab in the right pane, scroll down to locate the Global Id property.

e. Right-click the value for the Global Id property, select Copy Property Name and Value.

f. Paste the value into the ciId field in the JMX console and remove the property name.

6. Click Invoke.

The result displays.

How to Edit Pre-/Post-Scan Scripts

This task describes how to edit pre- and post-scan scripts in your Management Zones.

This task includes the following steps:

l "Prerequisites" below

l "Navigate to the script editor" on the next page

l "Edit the script" on the next page

l "(optional) Import resource files" on the next page

l "Deploy the scripts" on page 542

l "Results" on page 542

1. Prerequisites

o A Data Flow Probe is installed.

o A Management Zone is defined.
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2. Navigate to the script editor

You can access the Pre/Post Scan Script Editor in the following ways:

o In the Management Zone:

i. Set up and activate the Inventory Discovery Activity.

ii. On the Preferences Page, click to select Scanner based Inventory Discovery and then

click Edit script. The Pre/Post Scan Script Editor opens.

o From the Adapter Management module:

Inventory Discovery > Adapters, click Inventory Discovery by Scanner, expand the Global

Configuration Files pane, click the PrePostScanScriptingConfiguration file, and click Edit .

3. Edit the script

a. Click the platform for which you want to edit a script. Depending on the platform, you might

also need to select a version.

Tip: Click All UNIX to create a script that is used as a backup script in case a script for any

of the other UNIX variant scripts fails to run.

b. Click pre scan script or post scan script. The script editing window opens.

c. Write your script using shell commands that are appropriate for the platform or shell that is

running on the discovery node.

4. (optional) Import resource files

To include files that your script requires, import them by clicking the Resources node in the left

pane and then click . The Import Files dialog box is displayed. Select the files you want to

include in the script package.

Note:

o When files are transferred to the remote machine, they will not be marked as executables-

even if they are executables. Ensure you mark them as executables in the pre/post scripts

before running them.
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o Resources files are never removed automatically. If you want to remove them after your

scripts run, ensure your scripts perform clean-up operations as needed.

5. Deploy the scripts

To deploy and run the scripts, click to select Run Pre/Post Scripts on the Preferences Page of the

Inventory Discovery Activity.

6. Results

To verify the script is deployed successfully, verify the script file is stored in the same directory as

the scanner executable. For more information on the location of the scanner executable, see the

section describing scanner file locations in "Scanner File Locations" on page 592.
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How to Set Up Asset Fields for Data Collection

This task describes how to set up the asset data fields to be collected by the Scanner Generator.

For an example on how to set up a Combination type asset field, see "How to Set Up Asset Fields for

Data Collection - Example" on page 555.

Note: It is strongly recommended that Description and Asset Tag fields are included in your list of

asset fields.

1. In the Scanner Generator wizard, go to the Asset Data page > Asset Data tab.

2. Click Create New Field . The Choose Field dialog box opens, showing all standard fields not

currently in use by the scanner. For a full list of asset fields, see "Asset Fields" on the next page.

3. Select a field and click OK.

4. Configure the asset field:

a. On the Asset Data tab, select the field you just added, and click Edit Field .

b. Configure the asset field as described in "Asset Field Configuration Dialog Box" on page 636.

i. Define a caption for field and determine the maximum length.

ii. Select the type of field.

iii. Next to the Parameter box, click Change to define parameters for the field. For details

about the parameter options, see "Asset Field Parameters" on page 546.

5. Consider the order of the asset fields as they appear in the Asset Fields list, and correct their order

where necessary.

Important: A field cannot depend on a field that is placed below it in the Asset Fields list. That

is, if you have set up any derived or automatic fields that require data from fields below them

in the list, you must move them to a position in the list that is above these fields.

To correct the order of the fields, select and drag a row to the desired location in the list.
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Asset Fields

The Scanner Generator provides several predefined standard field types that indicate to which

hardware field the asset field is mapped.

l The following table lists the special standard asset fields:

Note: It is strongly recommended to include these fields in your list of asset fields.

Field Description

Description

Can be configured to contain a brief description of the machine being scanned.

Default: Combination type. It combines information from several hardware and

asset fields.

When loading data from scans into the analysis tools (Analysis Workbench and

Viewer), the contents of the Description field are displayed for each scan file to

help identify it.

Asset

Tag

Contains a unique identifier for the machine being scanned. It is normally populated

from a sequence of hardware fields such as MAC Address, Serial Number or Asset

tag.

The asset number entered in this field is used to name the off-site scan file.

l The following table lists other standard field types that indicate to which hardware field an asset

field is mapped:

Field Description Hardware Field in Scan File

Asset Tag The Asset Tag field contains a unique identifier for

the machine.

hwAssetTag
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Field Description Hardware Field in Scan File

Automatic

Asset

Fields

These asset data fields can be automatically

populated from data extracted from text files, the

Windows registry/WMI or environment variables.

You can configure up to 56 automatic fields, which

can then be used in the calculation of derived or

calculated fields.

hwAssetAutomatic1..56

Bar Code For machines with bar codes on them, use this field

to allow the bar code to be entered or stored

hwAssetBarCode

Building Identified the building containing the machine hwAssetBuilding

Business

Unit

Name of business unit hwAssetBusinessUnit

Cellphone

Number

Cell/Mobile phone number of user. hwAssetCellphoneNumber

Cost Center Cost center description or code hwAssetCostCenter

Department Department description or code hwAssetDepartment

Device

Type

Device type of the machine (Server, Notebook,

Tower and so on)

hwAssetDeviceType

Division Division description or code hwAssetDivision

Employee

ID

Employee ID as used in the organization. hwAssetEmployeeID

First Name First name of user hwAssetUserFirstName

Floor The floor on which the machine is located hwAssetFloor

Full Name Full name of user hwAssetFullName

Job Title Job title of user hwAssetUserJobTitle

Last Name Last name of user hwAssetUserLastName

Machine

Make

Make or Manufacturer of the machine hwAssetMachineMake
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Field Description Hardware Field in Scan File

Machine

Model

Model of the machine. This data can be populated

from SMBIOS using a Sequence Field on machines

supporting SMBIOS.

hwAssetMachineModel

Office

Location

Location of the office - normally a combination of

country and city

hwAssetOfficeLocation

Printer

Asset Tag

Asset tag of a local printer attached to the machine,

if any

hwAssetPrinterAssetTag

Printer

Description

Description of a local printer attached to the

machine, if any

hwAssetPrinterDescription

Room Description, name or number of the room containing

the machine

hwAssetRoom

Section Section description or code hwAssetSection

Telephone

Extension

Internal telephone extension hwAssetTelephoneExtension

Telephone

Number

Full direct telephone number of user hwAssetTelephoneNumber

User Field User-defined fields. You can configure up to 30 User

fields.

hwAssetUserField1..30

Asset Field Parameters

Calculated Fields

Calculated fields can be automatically populated from data extracted from text files, the Windows

registry, environment variables and so on.

l "Environment Variable Extract Fields" on the next page

l "Registry Extract Fields" on the next page

l "Text File Extract Fields" on page 548

l "WMI Extract Fields" on page 550
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Environment Variable Extract Fields

This field is set up to read the value contained in an operating system’s environment string. For

example, you may have the Host Name or SMS ID stored in an environment variable and want this to be

automatically picked up by the scanner.

Parameter Description

Enter the name of an environment variable Examples of environment variables: TEMP and PATH.

Registry Extract Fields

This type of field searches the Windows registry for the defined key and makes an automatic entry of

the key value. This extract field is applicable to Windows only.

Parameter Description

Enter

registry

path to

the value

The full path to the registry value you want to have in this field in the form

RegistryKey\Value.

Example:

To find out whether the Screen Saver is active on the system, you can use the following

registry extract field:

HKEY_CURRENT_USER\Control Panel\Desktop\ScreenSaveActive

The registry does not allow the backslash ("\") character in the RegistryKey. However, it

can be used in Value. If the backslash character is contained in the Value name, it must

be escaped. For example, if Value is "a\b", it must be specified as follows:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\VSS\
VssAccessControl\\NT Authority\NetworkService

In Windows, the paths to various registry values can be found by viewing the content in

the Registry Editor. For more information about the Registry Editor refer to the

Windows documentation.

In 64-bit versions of Windows, portions of the registry entries are stored separately for

32-bit applications and 64-bit applications and mapped into separate logical registry

views using the registry redirector and registry reflection. This is because the 64-bit

version of an application may use different registry keys and values than the 32-bit

version. There are also shared registry keys that are not redirected or reflected.
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Parameter Description

Because the Universal Discovery Windows scanner is a 32-bit application, by default, the

scanner only reads the 32-bit portion of the registry.To access the 64-bit registry

portion in 64-bit versions of Windows, the scanner supports the following prefixes:

Note: The prefix includes the colon (:).

l 32:. Forces only the 32-bit registry value to be read.

l 64:. Forces only the 64-bit registry value to be read. In 32-bit versions of Windows,

the registry extract field with this prefix will always be empty.

l 3264:. Reads the 32-bit registry value, and, if it is empty, reads the 64-bit registry

value.

l 6432:. Reads the 64-bit registry value, and, if it is empty, reads the 32-bit registry

value.

If no prefix is given, the scanner reads the 32-bit registry value only.

The actual registry value path should follow the prefix, as shown in the following

example:

Text File Extract Fields

This field searches a named text file for a defined character string and makes an automatic entry of

the characters between the search string and the end of the line.

This field type is normally used for the Asset Number field. This is used to extract the asset number

from the file Asset.bat on the line containing the text: SET ASSETNO=
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Parameter Description

File Name The name of the file (and the file path) that the information is to be extracted from.

Note:

l Entries in this field are case-sensitive. This is applicable to UNIX and Mac OS X only.

l You can use an environment variable to specify the file name. The environment

variable name must be in upper case for this to happen. If it is not, the string is

interpreted as a literal.

For example, if the path is %WINDIR%\SMS.INI, then the final path (assuming

WinDir=C:\WINNT) will be C:\WINNT\SMS.INI.

But if the path is %WinDir%\SMS.INI, then no substitution will take place and the file

extract will fail. This is done to ensure that it is possible to extract files from a

directory or a file that has one or more % signs in the name.

Another example of using an environment variable is as follows:

You can type: %HOME%/.bashrc , or %SYSTEMDIR%\win.ini. In this case, %HOME%

will be replaced with the value of the HOME environment variable.

This is applicable to all platforms, and UNIX notation of the form $NAME is not

supported.

Search Determines what information is to be extracted.

l A search string expression can be created in two ways depending on the file

contents:

l If you type * (an asterisk) for the search string, the scanner takes the complete first

line of the file.

The scanner can find a line beginning with a particular anchor in a text file, and

extract the rest of the line following the anchor. For example, if the line of the file

has the following structure VariableName=Value, and Value needs to be extracted,

set the search string to be VariableName=

Note:

l The search string is case insensitive.
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Parameter Description

l In the file being extracted from, if a comment is on the same line as the search

string, then the comment is also returned. To prevent this happening, ensure

that any comments in the file are placed on separate lines from the search

string. This is particularly relevant to UNIX users.

WMI Extract Fields

Windows Management Instrumentation (WMI) is a component of the Microsoft Windows operating

system that provides management information.

Some data on Windows operating systems is only available via the WMI interface. This type of field

allows the scanner to be configured to extract and store specific pieces of WMI data. The Windows

scanner populates this field on computers where WMI is enabled.

Parameter Description

Query Windows Management Instrumentation Query Language (WQL) is a subset of SQL that is

used to make data queries inside WMI.

WQL Query. The following example of a WQL query collects the name and the frequency

properties of the installed processor:

For example, select Name,CurrentClockSpeed from Win32_Processor

For more information about WMI and WQL refer to the Microsoft MSDN website.

l WQL Query. The WQL query used to make data queries in WMI.

For example, select Name,CurrentClockSpeed from Win32_Processor

The above query collects the name and the frequency properties of the installed

processor.

l Object Path. Should usually be: root\cimv2

This is the default path for CIM v2 data provided by WMI.

l Timeout. Specifies how long (in seconds) to wait until the query returns a single

instance of the queried data. If no data is returned within this period, the query

returns nothing and the value of the field is blank.
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Parameter Description

Note: You can use -1 to wait indefinitely for the query to return data. However,

this is not recommended since it may cause the query to hang.

Options l Collect the first instance/Collect all instances. Determines whether to collect

information from the first instance only, or from all instances.

For example, if there are several processors in a computer you can choose to collect

the information about the very first processor or about all processors.

If instances are requested, their values are separated with the string specified in the

Separate Instance With field.

When multiple properties are specified, the values returned by the query will be

separated with the string specified in the Separate Property Values With field.

l Separate Instance With. When Collect all instances is selected, the values collected

from each instance are separated with the string specified here.

l Separate Property Values With. When multiple properties are specified, the values

returned by the query are separated with the string specified here.

Output

Properties

Enables you to add a property whose value is required in the asset field. The WQL query

returns an instance of the WMI class which can have many properties. The required

properties need to be specified manually.

For example: select * from Win32_Processor

This returns all properties for processor, but if Name is required, it should be specified in

the Output Properties box.

l . Enables you to add an output property.

l . Enables you to remove the selected output property.

Derived Fields

Derived fields have dependencies on the data of other types of fields. That is, the data they contain is

derived from other fields.
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l "Sequence Fields" below

l "Combination Fields" on the next page

l "OS/Scan Fields" on page 554

Sequence Fields

The Sequence field enables you to define a sequence of up to ten asset or hardware fields. Each of

these fields returns a value depending on the machine or environment running. The value returned as

the result of the sequence field is the first of these fields containing a non-blank value.

Parameter Description

Field

Sequence

The sequence of the field.

Expand the tree on the right and drag a field to the File Name list on the left.

Ignore

Strings

Used to specify a set of values that are known to be incorrect, fake, or unwanted. These

values should be ignored.

For example, when specifying a MAC address as one of the hardware fields in a

sequence, you can designate the known fake MAC addresses in the Ignore Strings so

that they can be filtered out.

A blank field can be defined based on either of the following two criteria:

l The string matches an ignore string.

l The length of the field is shorter than the number specified in the Shorter Than field.

l Matching. A string or a set of strings.

For example, you can define a set of ignore strings as Unknown;unknown;Not

Tested.

Note: The string is case-sensitive; strings must be separated by semicolons (;).

If the content of the sequence field matches (is equal to) any of the strings specified

here, the field is considered to be blank. For example, if the string Not Found is

defined here, then a field that has the value ‘Not Found’ is considered to be blank.
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Parameter Description

You can type a string in the form: *STRING*. Here the asterisks (*) are ignored and

any string that contains the texts between the two asterisks will also be ignored.

l Shorter Than. Specifies the minimum length of the string to be considered as non-

blank.

If a field value’s length is shorter than the specified number, then the field is ignored

and considered blank.

Default: Minimum: 1; Maximum: 255

Note: An empty value’s length is 0; an empty field is always ignored.

Combination Fields

These fields can combine up to five asset or hardware fields into a single field. This is particularly useful

for the Description field.

The combination field is made up by string substitution.

For a detailed example on setting up a Combination type asset field, see "How to Set Up Asset Fields for

Data Collection - Example" on page 555.

Parameter Description

Master

substitution

string

The template substitution string that makes up the combination field.

This string replaces the percent values (for example, %1) with the appropriate

hardware or asset item.

Syntax: Use the percentage symbol followed by a number.

Note: You can also specify some text before or after the percent notation which

will be a constant part of the value of the field.

Examples

l ‘%1 (%2)’

l If the master substitution string %1 %2MHz %3Mb is defined for the Description
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Parameter Description

field in the asset entry form, where the following index definitions apply:

Index Field/Description Display

%1 CPU Data\CPUs\CPU Type CPU Type

%2 CPU\CPUs\CPU Speed (MHz) CPU SpeedMHz

%3 Memory Data\Total memory (Mb) Total MemoryMb

then Description field may look as follows:

Core i7 2666MHz 3958Mb

Definitions Displays the fields selected from the Fields tree (on the right) to be used in the

substitution string.

The list can contain up to five index entries (represented as %1, %2, %3, %4 and %5).

<Right-click

menu>

l To insert a field into the Definitions pane, right-click the field in the Fields tree

and click Add .

l To remove a field from the Definitions pane, right-click the field and click Delete

.

OS/Scan Fields

These fields allow the definition of multiple types of data sources to provide an automatic entry

depending on the scanner used and the operating system being scanned.

This type of asset field is useful in situations when you want to scan multiple operating systems but

want to collect the same piece of information for each from different sources.

For example, the data can be extracted from the registry on Windows or from a file on UNIX and Mac OS

X.

Parameter Description

Field

Index

l The operating system affected by this definition.

l Drop-down list: Links the operating system to the line numbers of the relevant field
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Parameter Description

in the Fields referred to list.

Fields

Referred

to

Fields selected from the Fields tree (on the right) to be included in this definition.Can be

any existing asset field or any hardware/configuration field (except hardware fields

where multiple values may be collected, such as CPU type or IP address).

Fields

tree

Displays the available fields.

Order of the Fields in the Form

You must consider the order of the fields in the form, and move them round accordingly. The rule is:

A field cannot depend on a field that is placed below it in the form.

That is, if you have set up any derived or automatic fields that require data from fields below them in

the form, you must move them to a position in the form that is above these fields.

To correct the order of the field in the form:

1. Reorder the fields by clicking on a row and dragging the selected line to its new location in the

form.

2. When you click Next in the Asset Data page, a confirmation message may be displayed.

3. Click Yes to have the Scanner Generator automatically reorder the fields.

4. Click No to reorder the fields manually.

How to Set Up Asset Fields for Data Collection - Example

This example describes how to set up a Combination type asset field.

Combination fields can combine up to five asset or hardware fields into a single field. This is particularly

useful for the Description field.

In this example, the field combines the first and last names of an employee, and the department he

works for, into one field, with the following format

<First name> <Last Name> - <Department>
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1. In the Scanner Generator wizard, go to the Asset Data page > Asset Data tab.

2. Select Description, and click Edit Field .

3. Configure the asset field as described in "Asset Field Configuration Dialog Box" on page 636.

a. In the Caption field, type Employee.

b. Select a field data type: Under Derived Fields, select Combination Field.

c. Next to the Parameter box, click Change to define parameters for the combination field.

4. Build the master substitution string to yield the desired format. In the Master Substitution String

field, enter

%1 %2 - %3

5. Select the asset fields that you want to appear in the resulting field.

In the Fields tree:

a. Under Asset Data, double-click Department.

b. Under Asset Data, double-click First Name.

c. Under Asset Data, double-click Last Name.

6. To display Department after the name, in the Definitions grid, drag Department down to the third

place in the list.
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The numbers in the Definitions grid correspond to the numbers in the Master Substitution String

field. So:

o %1 will be replaced with First Name (#1 in the grid)

o %2 will be replaced with Last Name (#2 in the grid)

o %3 will be replaced with Department (#3 in the grid)

Result

If the first name is John, the last name is Doe, and the department he works in is Research and

Development, the resulting combination field string will be:

John Doe - Research and Development

Data Flow Management Guide

Chapter 15: Inventory Discovery

HP Universal CMDB (10.22) Page 557 of 795



How to Set up the Scanner to Handle Delta Scan Files in

Manual Deployment Mode

When conducting an inventory in Manual Deployment mode, for the delta scan file processing in the XML

Enricher to work correctly, ensure you do the following:

1. Configure the Scanner to save scan file results locally and enable delta

scanning

On the Scanner Generator > Scanner Options > Saving tab page, select the Save results locally)

option and the Enable Delta Scanning option. For more information, see "Scanner Options Page"

on page 639.

2. Configure the Scanner to save scan results to the Incoming directory.

o On the Scanner Generator > Scanner Options > Saving tab page, select the Save result to

network (off-site) option. For more information, see ."Scanner Options Page" on page 639.

l Depending on whether HTTP or HTTPS is used for off-site scan file saving, the save file path

should be as follows:

l HTTP: http://DataFlowProbeHost:1977/incoming

l HTTPS: https://DataFlowProbeHost:8453/incoming

where:

l 1977 is the default Probe Manager JMX port. If the Probe Manager JMX was configured

to use a different port, 1977 in the URL above needs to be replace with the

corresponding probe manager port.

l 8453 is the default HTTPS port. If a different port is used (as described earlier), 8453 in

the URL above needs to be replaced with the corresponding HTTPS port.

l DataFlowProbeHost is the host name or the IP address (IPv4/IPv6) of the Data Flow

Probe machine.

l By default, the Data Flow Probe shares the Incoming and Original directories via HTTP.
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l The Data Flow Probe can be configured to share these directories via HTTPS instead.

The following entries in the DataFlowProbe.properties file (located in

C:\hp\UCMDB\DataFlowProbe\conf\) control the HTTPS behavior. The settings are defined, by

default, as follows:

l jettyHttpsEnabled = false

l jettyHttpsPort = 8453

To enable HTTPS, set jettyHttpsEnabled = true.

To HTTPS port by modifying the jettyHttpsPort setting.

l When the Data Flow Probe is installed, user credentials are provided for uploading scan files

to the Data Flow Probe. These credentials are stored in the DataFlowProbe.properties file on

the Data Flow Probe.

To change the user name:

In the DataFlowProbe.properties file locate

com.hp.ucmdb.discovery.Probe.JMX.UploadAuth.User and replace the value with the new

user name.

To change the password:

A. Access the Data Flow Probe JMX console. Launch a Web browser and enter the following

address: http://<Data Flow Probe machine name or IP address>:1977. If you are

running the Web browser locally, enter http://localhost:1977.

You may have to log in with a user name and password.

Note: If you have not created a user, use the default user name sysadmin and the

password sysadmin to log in.

B. Search for type=mainProbe, and click the link.

C. Click getEncryptedKeyPassword, enter a new password, and click Invoke.

D. Copy the generated value to the Clipboard.
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E. In the DataFlowProbe.properties file locate

com.hp.ucmdb.discovery.Probe.JMX.UploadAuth.Pwd and paste the new encrypted

password over the old value.

Note: You can also use the command line option -p:<path> with the Scanner to override the

selection made in the Scanner Generator.

3. Configure the path to the Original directory.

o On the Scanner Generator > Scanner Options > Saving tab page, set the Path to Original Off-

Site Scan Files option. For more information, see "Scanner Options Page" on page 639.

Depending on whether HTTP or HTTPS is used for off-site scan file saving, the path should be as

follows:

l HTTP: http://DataFlowProbeHost:1977/original

l HTTPS: https://DataFlowProbeHost:8453/original

The special user, UploadScanFile, with the corresponding password should be configured for

the original directory.

Note:

o You can also use the Scanner -r:<path> command line option to specify the location of this

directory.

o In addition to the default HTTP/HTTPS options, you can configure manual deployment

Scanners to store the off-site scan files using the following:

l File Share. This is usually only suitable for Windows platforms. The Incoming and

Original directories of the XML Enricher can be shared via Windows shares. For

example: Incoming$ and Original$, then the off-site scan file path and the original scan

path in the Scanner Generator can be configured as the following UNC paths:

\\DataFlowProbeHost\Incoming$ and \\DataFlowProbeHost\Original$. Make sure that

these shares/NTFS permissions on these directories allow appropriate access to all

users, under the user's account through which the manual deployment Scanners are to

be executed.

l FTP/FTPS. The Incoming and Original directories of the XML Enricher can be shared via
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FTP/FTPS protocols. The Data Flow Probe does not include an FTP/FTPS server, but

either a standard Windows FTP server supplied with IIS can be installed or enabled, or a

suitable 3rd-party server can be installed for this purpose.

The FTP/FTPS URLs must be configured for off-site scan saving. For example:

ftp://DataFlowProbeHost/incoming and ftp://DataFlowProbeHost/original.

How to Configure XML Enricher to Suit the Probe

Deployment Mode

When the Data Flow Probe is installed, the XML Enricher is configured, by default, for the Standard

Deployment mode.

Note: The XML Enricher’s Windows service is configured with the Manual start up and the probe

starts the XML Enricher service on demand when necessary. So you should not change the startup

mode of the XML Enricher service.

If another Probe deployment is used, the XML Enricher settings must be manually adjusted to fit the

deployment mode of the Probe.

Note:

l The XML Enricher configurations described below have been tested against the Data Flow Probe

deployment modes.

However, other configurations may potentially be supported, provided that enough resources

(memory and CPU) are available for the XML Enricher.

For details about the Data Flow Probe deployment modes, see the HP Universal CMDB Support

Matrix document.

l This task relevant for Data Flow Probes meant for discovery (on Windows machines) only.

This task includes the following steps:
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l "Configure the XML Enricher parameters" below

l "Restart the XML Enricher" on the next page

l "Results " on the next page

1. Configure the XML Enricher parameters

Configure the XML Enricher parameters to suit the Data Flow Probe deployment mode:

a. Set the XML Enricher mode and maximum amount of memory allocated by the Java Virtual

Machine for the XML Enricher service, per the Data Flow Probe's deployment mode:

i. On the Data Flow Probe machine, locate the WrapperEnricher.conf file in the following

folder:

c:\hp\UCMDB\DataFlowProbe\bin\xmlenricher

ii. Open the file in any text editor.

iii. In the Java Additional Parameters section, locate the following parameter, and set the

value per the Data Flow Probe deployment mode:

Parameter Description

DsaiDataProvider The XML Enricher mode.

Probe Deployment Mode

Small Database

Standard Memory

Enterprise Memory

iv. In the Maximum Java Heap Size (in MB) section, locate the following parameter, and set

the value per the Data Flow Probe deployment mode:

Parameter Description

MaxMemory The maximum amount of memory that the Java Virtual Machine

allocates for the XML Enricher service.
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Parameter Description

Probe Deployment Maximum Memory

Small 3584

Standard 5120

Enterprise 8192

b. Configure the maximum number of processing threads to allocate to processing scan files in

the XML Enricher service for all management zones:

i. On the Data Flow Probe machine, locate the enricher.properties file in the following

folder:

c:\hp\UCMDB\DataFlowProbe\conf\

ii. Locate the following parameter, and set the value per the Data Flow Probe deployment

mode:

Parameter Description

max_

enricher_

thread_

number

Probe Deployment Threads

Small 1

Standard 2

Enterprise 4

Note: One thread is used initially. For Standard and Enterprise

deployment, the actual number of threads used is gradually

increased by 1, depending on load conditions and up to the maximum

number of threads (configured in this setting).

2. Restart the XML Enricher

Restart the HP Universal Discovery XML Enricher service on the Data Flow Probe machine.

3. Results
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Navigate to

c:\hp\UCMDB\DataFlowProbe\runtime\xmlenricher\scans\incoming

and analyze whether the scan file processing is at an acceptable level.

If there is a large build up of the scan files in the incoming directory that does not get cleared

after some time and continues to grow, this indicates that the XML Enricher's does not have

enough resources to process scan files. In this case, the number of threads needs to be increased.

Verify the number of threads that the XML Enricher service is using. For details, see "How to Check

XML Enricher Health Using JMX" on page 566.

When increasing the number of threads, the amount of memory allocated to the JVM needs to be

increased as well. If the Standard mode parameters are not sufficient, use the parameters for the

Enterprise mode deployment.

How to Configure the Maximum Number of Threads to

Process Scan Files

This task describes how to configure the maximum number of processing threads to allocate to

processing scan files in the XML Enricher service for all management zones.

Note: This is a global parameter.

To configure the maximum number of threads to process scan files:

1. Prerequisites

Ensure that the Data Flow Probe is running.

2. Open the file

Open <Probe installation folder>\conf\enricher.properties file using any text editor.

where <Probe installation folder> is where you installed the Data Flow Probe.

3. Set a value for the maximum number of threads

Locate the parameter max_enricher_thread_number= and set a value.
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o Default: 8

o One thread is used initially. Then the number gradually increases by 1, depending on load

conditions.

4. Restart the Data Flow Probe

Restart the Data Flow Probe service.

5. Results

a. Navigate to <DataFlowProbe>\runtime\xmlenricher\scans\incoming and analyze whether the

scan file processing has increased to an acceptable level. If not, consider increasing the value

that you set in step 3.

b. Verify the number of threads that the XML Enricher service is using. For more information, see

"How to Check XML Enricher Health Using JMX" on the next page.

How to Create the Processed Core Directory

This task describes how to create the ProcessedCore directory for XML Enricher service. This directory is

used to store processed core scan files

To create the Processed Core directory:

1. Locate the file

In the Data Flow Management module > Universal Discovery > Discovery Modules/Jobs tab, click

Hosts and Resources and then expand Inventory Discovery by Scanner. Right-click Inventory

Discovery by Scanner and then click Go to Adapter . In the Resources pane, click Configuration

Files and then double click EnricherServiceSettings.ini. A text editor opens the file.

2. Edit the file

Locate the "cfgActions=" line. Then, add the following string anywhere in the line:

eaOutputCoreXML

Note: Ensure that commas separate your entry from other entries.
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3. Restart

Restart the Data Flow Probe service.

4. Results

The ProcessedCore directory is created at:

<DataFlowProbe>\runtime\xmlenricher\scans\

where <DataFlowProbe> is where you installed the Data Flow Probe.

How to Check XML Enricher Health Using JMX

This task describes how to view health statistics of an XML Enricher service using the JMX console.

1. Prerequisites

The Data Flow Probe where the XML Enricher service is running is started.

2. Connect to the Data Flow Probe

Launch your Web browser and enter the following address: http://<DataFlowProbe>:1977, where

<DataFlowProbe> is the name of IP address of the machine on which the XML Enricher service is

running.

3. View statistics

a. Under the Local_<DataFlowProbe> section, click the XMLEnricherMonitor service.

b. Select the viewXmlEnricherStatuses method and click Invoke.

4. Results

Health statistics for the XML Enricher are displayed.

How to Reprocess Scan Files

This task describes how to reprocess scan files.

1. Right-click a Node CI or any of its subtypes.

2. Select Actions > Reprocess Scan File. The scan file is moved from the Processed folder to the
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Incoming folder and then reprocessed.

For more information about reprocessing scan files, see "Processing Scan Files" on page 516.

How to Import SAIs to the Data Flow Probe

This task describes how to import SAI files and then deploy the files to the Data Flow Probe. SAI files can

be master delta files that are contained in Content Pack updates, or files can be User SAIs that are

created using the SAI Editor. You can also use SAI files created by third parties.

Note: If you want to install the entire contents of the Content Pack update, see the HP UCMDB

Discovery and Integrations Content Pack Update Release Notes.

To import SAIs to the Data Flow Probe:

1. Prerequisites

o Ensure that the UCMDB Server is running.

o Ensure that the Data Flow Probe server is running.

o Do one of the following:

l Download a Content Pack update. This archive file is located on the Universal Discovery

Community (https://hpln.hp.com/group/universal-discovery/) on HP Live Network.

l Ensure that user SAI files are stored on your computer.

2. Import the SAI files

Data Flow Management > Software Library, in the SAI Files pane, click and select Import SAI

File or Import SAI file from CP. For more information about these options, see "SAI Files Pane" on

page 692.

3. Results

The Data Flow Probe is updated with the SAI files. To verify this, check the files at
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C:\hp\UCMDB\DataFlowProbe\runtime\probeManager\discoverySaiResources\saiRuntime.

Note: If you want to re-process scan files, see "How to Reprocess Scan Files" on page 566.

How to Import Normalization Rules to the Data Flow Probe

This task describes how to import normalization or discovery rules files and then deploy the files to the

Data Flow Probe. These files are contained in Content Pack Updates.

Note: If you want to install the entire contents of the Content Pack update, see the HP UCMDB

Discovery and Integrations Content Pack Update Release Notes.

1. Prerequisites

o Ensure that the UCMDB Server is running.

o Download a Content Pack Update. This archive file is located on the Universal Discovery

Community (https://hpln.hp.com/group/universal-discovery/) on the HP Live Network.

2. Import the normalization rules files

In UCMDB > Adapter Management > Resources Pane, click and select Import Normalization

Rules from Content Pack. For more information about this page, see "Resources Pane" on page

282.

3. Results

The Data Flow Probe is updated with the normalization rules files. To verify this, check the files at

C:<DataFlowProbe>\runtime\probeManager\discoveryResources\ruleEngine

where <DataFlowProbe> is the location where the Data Flow Probe server is installed.

How to Configure and Optimize Inventory Discovery

This task describes how to configure Inventory Discovery to improve recognition and to improve

performance.

This task includes the following steps:
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l "Analyze discovery results" below

l "Optimize recognition" below

l "Increase performance" below

Analyze discovery results

l To analyze scan files, see "Inventory Tools" on page 530.

Optimize recognition

l To teach applications, see "Application Teaching" on page 522.

l To configure software recognition options, see "XML Enricher: Software Recognition Configuration

Dialog Box" on page 655.

Increase performance

l To configure to use delta scan files, see "How to Set up the Scanner to Handle Delta Scan Files in

Manual Deployment Mode" on page 558.

l To optimize the XML Enricher engine, see "Scan File Processing Power" on page 517.

How to Configure Analysis Asset Fields

The Analysis Asset Field configuration settings that affect the XML Enricher cannot be modified in the

Web UI. You can change these settings by using the Viewer. To do this, follow these steps:

1. Select Start > All Programs > HP UCMDB > Inventory Tools > Viewer on the computer where the

Data Flow Probe is installed.

2. Use File > Options > Asset Fields to configure the Analysis Asset Fields.

For more information, see "Inventory Tools" on page 530.

How to Map Scan File Attributes to UCMDB

This task describes how to map attributes that are contained in scan files to UCMDB CIs.
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This task includes the following steps:

1. "Prerequisites" below

2. "Select a CI to map" below

3. "Select attributes to map" on the next page

4. "Results" on the next page

1. Prerequisites

Before creating a mapping, perform an analysis on what information you want to map, what data

element in the scan file contains the information you want to capture, where the data element in

the scan file is located, and which UCMDB CI you want to store this information.

2. Select a CI to map

a. Open the Hardware Mapping Configuration dialog box. To do this, perform one of the following:

Note: Alternatively, advanced users can manually edit the ParseEnrichedScanFile.py

script file to create complex topologies. There is a commented out sample available in this

script that demonstrates how to map the hwAssetDescription asset field to the node's

Description attribute.

i. Adapter Management > Inventory Discovery by Scanner > Adapter Definition tab ,

expand the Global Configuration Files pane, click HardwareMappingConfig and then

click Edit .

ii. Inventory Discovery Activity > Preferences Page, then click the Custom Mapping

button. For more information, see the section describing the Inventory Discovery Activity

in the HP UCMDB Discovery and Integrations Content Guide.

b. Click Select CI to select a CI. The Select CI dialog box opens.

Note: This option is only available when Hardware Mapping Configuration is selected in

the left pane.

c. Select a CI that you want to create a mapping.

d. In the CI Editor, select properties for the selected CI.
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3. Select attributes to map

a. Click Select Attributes to select attributes. The Select an Attribute dialog box opens.

b. Select properties for the selected attribute in the Attribute Editor.

4. Results

Verify that data in the scan file was mapped as expected to UCMDB by using the CI Type Manager.

For more information, see "CI Type Manager" on page 1 in the HP Universal CMDB Modeling Guide.

Mapping Hardware or Asset Fields to UCMDB - Use-Case

Scenarios

This document describes common scenarios for customized mappings of data from scan files to

UCMDB.

For a task related to this scenario, see "How to Map Scan File Attributes to UCMDB" on page 569.

For concept details, see "Custom Hardware or Asset Mapping" on page 529.

These use cases assume that the scanner has captured the data that you want from the target

machine, and that the scanner has written the data to the scan file. Configuring the scanner to collect

data and store it in an empty field in the scan file is beyond the scope of this document. For more

information, see "Asset Data Page" on page 634.

Note:

l The field names and attribute names described in this document are merely examples. The

attribute names were selected because they should not impact out-of-the-box reconciliation

rules in UCMDB. Before mapping, always perform an analysis to ensure that storing data in scan

file fields and in CIs will not impact other data, or impact reconciliation. For information about

reconciliation, see "Reconciliation Overview" on page 756.

l Generally, most hardware and asset-related information is stored in an attribute under Node CI.

If you create your own CI to store your data, it is recommended to create a relationship

between your new CI and Node CI.
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Tip: you can map several strings of data from scan file fields to several CI attributes as long as the

CI attributes belong to the same CI in a single pass through the wizard. For example, to map String1

to NodeCI and to map String 2 to Node2CI. you must make two passes through the wizard.

User Scenario 1 (single attribute to existing CI)

This use-case scenario describes how to map a single string of hardware or asset data that is contained

in a scan file field to an existing UCMDB CI attribute.

1. Background

Assume the following:

o Your scanner has written the collected data to the hwAssetField1 field in the scan file.

o You want to store hardware and asset-related information in Node CI.

Tip: To learn about mapping data to a new CI that you create, skip to the next scenario on

this page.

2. Select a CI that contains the attribute that you want to contain your mapped data

a. Open the Hardware Mapping Configuration dialog box. For more information, see "Hardware

Mapping Configuration Dialog Box" on page 598.

b. Click . In the Select CI dialog box, expand Configuration Item, expand Infrastructure

Element, and select Node. Click OK.

c. Accept all of the defaults in the CI Editor. Notice that Node appears in the left tree pane.

3. Select an attribute to store your mapped data

a. In the left tree pane, ensure that Node is selected and click . The Select an Attribute dialog

box opens. This list contains all attributes for the Node CI.

Note: The list is not sorted alphabetically.

b. In the Select an Attribute dialog box, click the Attribute field and select the Note attribute.

Accept the defaults and click OK. Notice that this attribute name appears in the left tree pane.
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Note: The Note attribute is a common attribute and data stored here will not cause any

reconciliation rule issues. However, you can choose another available attribute. To see

which attributes are not populated, or which attributes contain non-critical data, perform

an analysis using the CIT Manager in UCMDB.

c. In the Attribute Editor on the right pane, in the Value field, click . The Select a Shell Tag

dialog box opens. Expand Asset Data and select the name of the scan file field that contains

the data that you want to map.

Note: The names in this list are friendly names- mouse over each entry to see the scan file

XML tag names for each entry. For example, user field 1 is also called hwAssetField1.

d. Select the user field 1attribute. Accept all defaults and click OK.

4. Results

After the Inventory Discovery by Scanner job runs, ensure that your mapped data is contained in

Node.Note in UCMDB.

User Scenario 2 (multi-attribute to new CI)

This use-case scenario describes how to map multiple strings of hardware or asset data that is

contained in scan file fields to multiple attributes under a newly-created UCMDB CI.

1. Background

Assume the following:

o Your scanner has written collected data to the hwAssetField1 field and written collected data

to hwAssetField2 field in the scan file.

o You want to map the data to attributes under a new CI. Let assume the following about your

new CI:

Note: For more information, see the section on how to create a new CI in the HP Universal

CMDB Modeling Guide.
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l You named your new CI NewCI.

l NewCI CI has some relationship defined with Node CI.

Note:

l Note the relationship type.

l Generally, most hardware and asset-related information is stored in an attribute

under a CI that is connected, or has some relationship with Node CI.

2. Select your new CI

a. Open the Hardware Mapping Configuration dialog box. For more information, see "Hardware

Mapping Configuration Dialog Box" on page 598.

b. Click . In the Select CI dialog box, select your newly-created CI. Select NewCI.

c. In the relationship field, select the relationship type that you selected when setting up the CI in

the CI Type Manager.

d. In the Create New CI field, select Yes.

e. Accept all of the defaults in the CI Editor. Notice that NewCI appears in the left tree pane.

3. Select attributes to store your mapped data

a. In the left tree pane, ensure that NewCI is selected and click . The Select an Attribute

dialog box opens. This list contains all attributes for NewCI CI.

l These attributes were inherited based on which parent you selected when you created

your new CI.

l The list is not sorted alphabetically.

b. Click the Attribute field and select the Note attribute. Accept the defaults and click OK. Notice

that this attribute name appears in the left tree pane.
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c. In the Attribute Editor on the right pane, click the in the Value field to open the Select a

Shell Tag dialog box. Expand Asset Data and select the name of the scan file field that

contains the data that you want to map.

Note: The names in this list are friendly names- mouse over each entry to see the actual

tag names for each field. For example, user field 1 is also called hwAssetField1.

d. Select the userfield1 attribute.

e. Accept all defaults and click OK.

f. Repeat this step to map your second string of data. For example, select the UserLabel

attribute to store your data, and then select user field 2 for the Value field.

4. Results

After Inventory Discovery by Scanner has run, ensure that your mapped data is contained in

NewCI.Note and NewCI.UserLabel in UCMDB.

How to Set Extract Options

All calculated asset fields defined can be set up so that only part of the string is selected instead of the

entire string. They can also be set up, for example, to use the last part rather than the first part of the

string. This can be useful for obtaining the last part of a calculated field that is too long.

Various other settings for manipulating the field contents are also available.

To set extract options:

1. After you have selected the field data type, click Extract. The button is only enabled for those field

that are calculated. This option is not available for user-entered fields. The Asset Field Extract

Options dialog box is displayed.
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2. In the Extract Characters From group box, specify whether you want to use the last part or the

first part of the string. Select one of the following options:

o Start - Uses the first part of the string. Use the arrows next to the Skip characters box to

specify how many characters are to be skipped from the beginning of the string.

o End - Uses the last part of the string. Use the arrows next to the Skip characters box to specify

how many characters are to be skipped from the end of the string.

For example, ABCDEF123. If you select End and skip 4 characters, the result is ABCDE.

3. In the Options group box, select the options as follows:

o Convert to Upper Case- Select this option to convert the alphabetic characters to upper case, if

required.

o Treat Field as a File Name- Select this option to treat the string in the asset field as a file

name.

Some characters are invalid in file names, so any invalid characters can be replaced with the

character specified in the Replace Invalid Characters With box. For example, underscore (_) is a

valid file name character and can be used to replace invalid characters.

If you select the Delete Invalid Characters option then any invalid characters are deleted.

4. If the extracted field is empty or is not found, then a default value for the string can be specified in

the Default Value box. For example, if the text string Not Found is entered in this box, then an

empty field or a field that has not been found is assigned this default value.

Data Flow Management Guide

Chapter 15: Inventory Discovery

HP Universal CMDB (10.22) Page 576 of 795



Configure Filtering in UCMDB

This task describes how to use the UCMDB interface to filter the UCMDB CIs that are discovered.

1. Prerequisites

Before creating a filter, perform an analysis on what information you want to map and what data

element in the scan file contains the information you want to filter.

2. Select a CI to filter

a. Select Adapter Management.

b. In the Resources tree, expand the DDMiInfra node and then expand the Configuration Files

node.

c. Right-click GlobalFiltering.xml and select Open in Frame.

d. In the Global Filtering dialog box, click Include or Exclude.

l Include. All CIs that do not match the filter are removed. If this marker is left empty, all

results are sent to the server.

l Exclude. All CIs that match the filter are removed. If this marker is left empty, all results

are sent to the server.

e. Click Select CI Type . The Select CI Type dialog box opens.

Note: This option is only available when Include or Exclude is selected in the left pane.

f. Select a CI for which you want to create a filter, and click OK.

3. Select attributes to filter

a. Click Select Attribute . The Select an Attribute dialog box opens.

b. Select properties for the attribute, and click OK.
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Note: You can use the "between" operator when filtering results, but only when the Object

class is “ip_address” and the attribute name is “name”.

For details on CI attribute types, see "Attributes Page" in the HP Universal CMDB Modeling Guide.

4. Activate and configure settings

In the Global Filtering Configuration Settings pane, select your options.

Available when: Global Filtering Configuration or Include or Exclude is selected in the left pane.

5. Results

Use the CI Type Manager to verify that data is filtered as expected in UCMDB. For more

information, see "CI Type Manager" in the HP Universal CMDB Modeling Guide.

How to Enable Discovery of App-V Applications

This task describes how to enable detecting, recognizing, and utilization reporting for App-V virtual

applications.

Note: For information on supported technologies, see "Application Virtualization Supported

Technologies" on the next page.

This task includes the following steps:

l "Prerequisites " below

l "Configure package rule" on the next page

l "Run Inventory Discovery" on the next page

l "Results " on the next page

1. Prerequisites

o Install the Software Utilization plug-in on the discovery node. For more information, see "How to

Configure Software Utilization" on page 720.

o Install Microsoft App-V client version 5.0 on the discovery node.
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o Ensure that Microsoft PowerShell is installed on the discovery node.

2. Configure package rule

To configure a package rule, see the section that describes configuring package rules in the

Inventory Tools User Guide PDF document. For more information, see "Inventory Tools" on page

530.

3. Run Inventory Discovery

Run Inventory Discovery. For more information on running Inventory Discovery, see the HP UCMDB

Discovery and Integrations Content Guide.

4. Results

The Installed Software CI is populated with information about App-V virtual applications. For more

information about CIs, see CI Selector in the HP Universal CMDB Modeling Guide. .

Application Virtualization Supported Technologies

The following virtual application technologies are supported:

l Microsoft Application Virtualization (App-V)

How to Rename Scanner Executable Files

You can rename the file name for scanner executables when performing Inventory Discovery by

Scanner.

1. Select Universal Discovery > Discovery Modules/Jobs tab > Discovery Modules pane > Inventory

Discovery by Scanner job > Properties tab.

2. Expand the Global Configuration Files pane, click ScannersConfigurationbyPlatform.xml, and

then click . The Script Editor opens.

3. In the Script Editor, search for the following tag: <scanner-remote-executable-name>. The

following results are displayed:
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a. The first occurrence is the global parameter.

Note: This value is overwritten by subsequent occurrences.

b. The second occurrence is for the Windows platform.

4. For each occurrence, type the file name that you want in the following tag:

<executable><File Name></executable>

where <File Name> is the name of the file that you want to rename for that platform.

Note:

l In ScannersConfigurationbyPlatform.xml, the properties in the <platform name="all"> section

will be taken ONLY when the properties are not set in a specific platform section. For example, if

there is no scanner-remote-executable-name set in the <platform name="windows" display-

name="Windows"> section, the value scan will be taken from the <platform name="all">

section.

l If you rename the scanner executable file, make sure that the configuration in the <platform

name="windows" display-name="Windows"> section is updated accordingly. For example, if

you want to rename the scanner executable file from scan.exe to udscan.exe, the scanner-

remote-executable-name in the <platform name="windows" display-name="Windows">

section should be changed from scan.exe to udscan.exe.

l If the scanner executable file is only renamed in the <platform name="all"> section but is not

renamed in the <platform name="windows" display-name="Windows"> section, the

Inventory Discovery by Scanner job will upgrade the scanner on the remote machine even

though the IsScannerUpgradeAllowed option is set to false.

How to Integrate BDNA Normalize with Universal Discovery

This task describes how to integrate BDNA Normalize. After BDNA is installed, and after the

configurations are performed on the Data Flow Probe, the normalized installed software data produced

by the scanner-based inventory is normalized using the BDNA Technopedia catalog instead of the

Universal Discovery application library (SAI). To enable this integration, perform the following:
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1. Configure the Data Flow Probe

a. Edit the dataflowprobe.properties file. To do this, go to <DataFlowProbeInstallDir>\conf

directory.

where <DataFlowProbeInstallDir> is the directory where Data Flow Probe is installed.

l Find the following string and change the value to true:

com.hp.ucmdb.discovery.probe.agents.probemgr.

xmlenricher.external.application.recognition=false (default = false).

l (Optional if you want to enable Debug) Find the following string and change the value to

true:

com.hp.ucmdb.discovery.probe.agents.

probemgr.xmlenricher.external.application.recognition.

debug=false (default = false).

Note: For more information on Debug mode, see "BDNA Normalize Integration" on page

531.

2. Install BDNA Normalize

Install BDNA according to the vendor instructions.

3. Configure BDNA

a. Double-click the Normalize shortcut that should be created by BDNA Normalize on the Windows

desktop.

b. In the Data Source pane, locate HP XSF and then click . The Normalize Settings dialog box

opens.

Note: If the HP XSF process has not been created, click on New Process and select "HP

Universal Discovery (XSF)" as the datasource.

c. Click the Data Source tab.

d. Review the settings in the Input Folder - it should point to the

<DataFlowProbeInstallDir>\runtime\xmlenricher\Scans\ProcessedNew directory.
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e. In Actions section, the XSF Out field should point to the

<DataFlowProbeInstallDir>\runtime\xmlenricher\Scans\ProcessedCore directory.

4. Results

Data enriched by BDNA can be pushed using integration adapters to other systems.

Tip: Use the newly-created RecognizedBy (recognized_by) attribute for the Installed

Software CI to locate and leverage BDNA-created data. If the value of this attribute is "BDNA" -

then installed software is normalized using the BDNA Technopedia catalog. If value is "SAI", the

installed software CI is normalized using the Universal Discovery application library (SAI).

Attribute values can be seen by using the CI Types pane.

For more information on CI Types and attributes, see "CI Type Manager Page" in the HP

Universal CMDB Modeling Guide.

How to Discover Client IP Ranges Without SNMP

This task describes how to discover client type IP ranges without using SNMP.

1. Enable the option

a. Go to Data Flow Probe > Adapter Management > Resources pane. Click Packages,

AutoDiscoveryContent, Configuration Files, and globalsettings.xml. The file opens in a text

editor.

b. Locate the following line and change the value to true: <property

name="pingClientTypeIp">false</property>.

2. Configure the Infrastructure Activity

a. In Infrastructure Activity > Preferences page, select Ping Sweep within the ranges of

Management Zone. For more information about this activity, see HP UCMDB Discovery and

Integrations Content Guide.

b. Ensure that the following options are NOT selected: IP/MAC Harvesting and Discover Network

Devices in Client IP Ranges.
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Scanner Command Line Parameters Overview

Scanner settings are typically configured when creating a scanner using the Scanner Generator.

However, you may want to override these configured settings when manually running the scanner.

Examples of when to override scanner configuration file settings are as follows:

l The scanner encounters a problem when trying to capture information during a scan.

l Assume the scanner is configured to save the scan file to a remote location. For example, a Data

Flow Probe server or a Store and Forward server. In this scenario, you want to re-route the scan file

to another location.

l Assume the scanner is configured to save the scan file to a remote location. However, a segment of

the network is down. In this scenario, you want to re-route the scan file to another location.

l You want to optimize the scan performance for certain machines, or you want to optimize the scan

performance at certain times.

Tip: Command line parameters and parameter values that are used to run the scanner can be

viewed in Analysis Workbench, or they can be viewed in Viewer at Hardware and Configuration tab

> System Data folder. This is useful when you want to check if the scan results were obtained from

a scanner that was run with any special command line options. For more information about these

Inventory Tools, see "Inventory Tools" on page 530.

How to Use Command Line Parameters

You can specify command line parameters by:

l Typing the command from a command line (for example, the Windows command prompt, or the

UNIX/Mac OS X shell). In UNIX/Mac OS X make sure you specify the path to the scanner.

For example:

/tmp/scanlinux-x86 -?

launches the Linux scanner from the /tmp directory and displays a list of valid command line options.

l Creating a Windows shortcut. Type the command line options (if any) after the quotation marks.

For example:
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"C:\TEMP\Scanwin32-x86.exe" -?

launches the Win32 scanner and displays a list of valid command line options.

l Typing the command in the Windows Run command in the Start menu. Type in or navigate to the

location where the scanner executable is located. Type the command line parameter or switch after

the quotation marks.

For example:

"C:\TEMP\Scanwin32-x86.exe" -?

Scanner Command Line Parameters

Parameters that can be used to control the operation of the scanner and used to control which

information is captured are as follows. These parameters are typically used in a command line interface

to override parameter values that are contained in the scanner configuration file.

Note: Most of these parameter corresponds to an option in the Scanner Generator wizard. For

more information, see "Scanner Generator Wizard" on page 603.

Command Line Parameters for Scanners

Parameter Description

-force Do not check disk space when saving the scan file off-site. This may be

useful when the operating system reports insufficient space, but this is

actually due to access rights.

-p:<path> Default off-site save path. The path can be one of the following types of

values, depending on the destination of the scan file:

l Normal file path - The full path name, beginning with the drive letter.

For example:

-p:c:\Inventory\Scans
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Parameter Description

l UNC path - When running on Windows, a UNC path can be entered as

the argument to this option. The format of a UNC path is:

\\servername\sharename\path\

For example:

-p:\\DataFlowProbeServer\Incoming\

The user running the scanner must have Write permissions to the

specified path.

l FTP/S URL - A destination URL of an FTP server. The format of the

URL is:

ftp://<username>:<password>@<hostname>
:<port>/dir

For example:

-p:ftp://scanuser:scanpasswd@DataFlowProbeServer.
mycompany.com/nm/scanner/uploadscans

l HTTP/s URL - A destination URL of an HTTP server. The format of the

URL is:

http://<hostname>:<port>/dir

For example:

-p:http://DataFlowProbeserver.mycompany.com/nm/
scanner/uploadscan

The username and password is not supported here. If the username

and password is required with HTTP saving, specify it in the Advanced

Settings dialog in the Saving tab of the Scanner Generator. For

detailed information, see "Save result to network (off-site)" on page

640.

The scanners support URL encoding in usernames, passwords, and

directory names. In a URL, you can replace @ with %40, and the scanner
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Parameter Description

translates %40 to @ before it calls the FTP server. For example, if you

type scanuser%40mycompany, the scanner will translate that as

scanuser@mycompany when it logs in to the FTP server.

-r:<path> The default path to the original scan files. A UNC path can also be

entered as the argument to this option. The format for a UNC path is:

\\servername\sharename\path\

For example:

Scanwin32-x86 -r:\\Hewlett-Packard\ED\scanfiles\

Note: The user that is running the scanner must have read

permissions to the specified UNC path.

-scandays:<Count> Scan only if previous scan was more than Count days ago. Forces the

scanner to perform the scan only if the previous scan was <Count> or

more days ago.

For example:

-scandays:7

For example, if the scanner is launched from a login script every day, it

will only perform the scan every week.

When the scandays:<Count> parameter is specified, the scanner

attempts to check when the last scan was run. If no previous scan file is

found, no messages are displayed and the scan runs. If a scan file is

found, the following message is added to the log file:

"Checking the age of Scan File "%s"

Where %s is the full name of the scan file it checks. If there is a problem

determining the age of the scan file (for example, if it is a newer version

or it is corrupt), it then outputs:

The age of the Scan File cannot be determined.

If it does manage to obtain the date, it outputs:

Last scan was %d days ago
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Parameter Description

Where %d is an integer number.

-incl:<switch> Enables (or includes) certain types of information collected in a scan.For

a list of options, see "Scanner Information Type Parameters" on page

590.

To include BIOS data and video data, include the following

statement:

-incl:10 -incl:30

-excl:< switch > Disables (or excludes) certain types of information collect in a scan.For a

list of options, see "Scanner Information Type Parameters" on page 590.

To exclude BIOS data and video data, include the following

statement:

-excl:10 -excl:30

-

scandayofweek:<Number>

Scan only on specified day of week (0-Sun,1-Mon, etc.). <Number> can

be one of the following:

0-Sunday
1-Monday
2-Tuesday
3-Wednesday
4-Thursday
5-Friday
6-Saturday

For example:

-scandayofweek:5

This will cause the scan to be performed on Fridays only. The scandays:

and scandayofweek: options can be combined. For example:

Scanwin32-x86 -scandays:14 –scandayofweek:3

This causes the scan to be performed every other Wednesday.

-paths Define exactly which directories to scan; the parameter can be repeated

as many times as necessary.
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Parameter Description

For example:

scan -paths:/etc -paths:/var -paths:/bin

scans just /etc, /var and /bin and their subdirectories.

Note: You must ensure that the Allow scanner command line to

override this selection option is checked in the Scanner Generator

Software Data pagefor this to work.

-l:<filename> The default file name of the local scan file, local$.xsf. If the path is

specified in the file name, then the default path for storing the local

scan file is also overridden.

-t:<path> The default path for storing temporary files.

-v If set to on, the scanner does not make the local scan file read-only or

hidden.

-o:<filename> Takes the off-site scan file name from the command line.

For example (non UNIX):

Scanwin32-x86 -o:r:\results\SC002154

Where r:\results\SC002154 is the path to the file SC002154.

If a file name is not entered, the file is named Default.xsf. If the path is

not specified, the file is placed in the directory configured for off-site

scan files in the Scanner Generator. If the path is specified on the

command line (even if it is relative), it replaces the path configured in

the Scanner Generator.

Example 1:

scanlinux-x86 -o:newname

Saves the off-site scan file, newname.xsf, to the location configured

in the Scanner Generator.

Example 2:

scanlinux-x86 –o:/tmp/newname
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Parameter Description

Saves the off-site scan file to /tmp/newname.xsf.

Example 3:

scanlinux-x86 –o:subdir/newname

Saves the off-site scan file, newname.xsf, to the subdir subdirectory

of the current directory.

-log:<level> Specifies the level of debugging information that will be written to the

scanner log when the scanner is running. The log is saved in the scan file

and also as a separate file:

l In most cases, you can view the scanner log by using the Viewer.

l If a problem has occurred that prevents the scanner from saving the

scan file, you can view the scanner log file from the Diagnostic panel

in the Device Manager.

<level> can be one of the following:

l off: Detailed logging is turned off. This is the default.

l debug: Debug messages are logged in addition to the regular

scanner messages. They are more-detailed providing additional

information.

l trace: All regular, debug, and detailed messages are logged. The

detailed messages provide tracing details as to scan runs, returned

error codes, and software scanning. This option automatically

enables the generation of the error log file.

-cert Specifies the path to the certificate file. This path is used with offsite

scan saving when performed using the secure SSL-based protocol, such

as ftps or https, to specify the certificate file (for self-signed

certificates) or the file containing certificate authority files (for

ftps/websites running with the regular certificate issued by a certificate

authority). To obtain the file containing all recent certificate authorities

extracted from the Mozilla browser, see:

http://curl.haxx.se/docs/caextract.html
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Parameter Description

If the -cert command line option is not specified, the scanner still tries

to save scan files using ftps/https, but without using any certificates.

-d Specifies whether delta scanning is enabled or not.

If set to on, this enables delta scanning if it is disabled in the scanner

generator.

If set to off, this disables delta scanning if it is enabled in the scanner

generator.

If the setting fails to specify on or off, the scanner prints the help

message and returns.

-scriptstimeout Specifies the timeout (in minutes) for running pre/post scan scripts.

-? The full list of command line options can be obtained by running the

scanners with the -? or /? command line option.

Scanner Information Type Parameters

The following parameter values can be used for enabling or disabling certain hardware and software

scans when manually running the scanner.

These parameter values are used together with the -excl and -incl parameters. For more information,

see "Scanner Command Line Parameters Overview" on page 583.

Information Type Parameter Value

BIOS data 10

BIOS extension 11

SMBIOS  Information 12

Compaq Asset Tag 13

Plug and Play Version 14

Video data 30

Monitors 31
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Information Type Parameter Value

Port data 40

Keyboard and mouse data 50

Disk data 60

Local USB hard drives 62

Memory data 70

Swap files 72

CPU data 80

Operating system data 90

Device driver files 91

Cluster data: 92

Services 93

Virtual machine data 94

User profiles 95

OS registered applications 96

Containers 97

WMI software features 98

Packaged file data 99

Storage data 100

Devices 101

SCSI/IDE serial numbers  102

Network data 110

TCP/IP data 111

IPX data 112

Netbios data 113
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Information Type Parameter Value

Network shares 114

Bus data 120

PCI cards 121

PCMCIA cards 122

MCA cards 123

EISA cards 124

ISA PnP card detection 125

USB data 126

Peripherals 130

System configuration 150

Software identification tags 901

Running Process Detection 902

TCP/IP Connectivity Detection 903

Scanner File Locations

When you use activities to automate discovery, the Scanner is copied to the discovery node according to

the default value in the Inventory Discovery by Scanner job adapter.

The default file location of the Scanner is as follows:

Platform File Location Path

Windows %SystemRoot%

Note: %SystemRoot% is normally located at C:\Windows.

Solaris Sparc $HOME/.discagnt

Note: $HOME is normally “/”, so the directory is “/.discagnt/”.
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Platform File Location Path

Mac OS ~/.discagnt/

Note: The "~" symbol normally is “/var/root”, so the directory is “/var/root/.discagnt/.Linux

HP-UX

AIX

Web Server Configuration for Saving Scan Files via HTTP

Apache and IIS Web Servers

The Web Server needs to be configured to allow execution of the PUT command. Usually, by default web

servers are set to enable POST and GET commands. You will need to ensure that if you are using HTTP

saving that the PUT command is enabled in the directory.

The following is a quick description of what you would have to enable for HTTP saving on both Apache

and IIS:

Apache

1.3

If you are using basic authentication, do the following:

1. In the bin directory run:

htpasswd -c "<path>\htpass" Username

2. Enter the following in the htaccess file of the directory that you intend to save in:

PUT_EnablePut On

PUT_EnableDelete Off

AuthType Basic

AuthName "Write" AuthUserFile "<path>\htpass"

Require user Username

3. Download the mod_put.so file and put it into the modules directory.

4. Enter the following into the httpd.conf file:

LoadModule put_module modules/mod_put.so
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Apache

2.x

l As mod_put is Apache 1.3 specific and is no longer available in Apache 2.x, mod_dav

should be used instead to provide the HTTP PUT capabilities

l Make sure that mod_dav is loaded. For example, the following line in the Apache web

server configuration can be used to enable it:

LoadModule dav_module modules/mod_dav.so

l Then for a particular location you can enable mod_dav with the following setting: DAV

On

Refer to the documentation for Apache’s mod_dav module for more details.

IIS Check the option that allows writing to the desired save directory. Ensure that you have

given write access to the username and password that you plan on adding to the scanner's

http save path.
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XML Enricher Directory Structure

The XML Enricher uses a directory structure on the Data Flow Probe computer under the probe's

installation directory. By default, the root of this directory structure is:

C:\hp\UCMDB\DataFlowProbe\runtime\xmlenricher

The following table shows various directories that are used by the XML Enricher.

Directory Explanation

Scans The base directory.

Scans\Failed The base failure directory. Failed scans are moved to a subdirectory of this

one.

Scans\Failed\Corrupt Scans that cannot be read or may not be scan files are moved here.

Scans\Failed\Delta If the original scan file is missing or there is an error applying the delta scan

file to the original one, then those delta scan files will be moved here.

Scans\Failed\Error When any other error occurs, scan files are moved here.

Scans\Incoming The incoming directory. The Enricher looks for new scan files here.

Scans\Logs Stores the log files. Manual deployment Scanners may save the log into the

off-site location.

Scans\Original This folder is used for delta scanning. It stores copies of original scan files,

which are then used in conjunction with delta scan files to recreate the new

version of the scan file.

Scans\Processed The processed directory. Enriched scan files are created here.

Scans\Processed\

[user defined]

You can group the scan files based on Hardware fields. This is user-defined.

Define the setting as follows:

l Go to Inventory Discovery by Scanner job > Properties > Global

Configuration Files

l Select EnricherServiceSettings.ini

l Click the button

Data Flow Management Guide

Chapter 15: Inventory Discovery

HP Universal CMDB (10.22) Page 595 of 795



Directory Explanation

The XML Enricher Configuration dialog is displayed

l On the General tab, use the Scan File Management part

See "Scan File Management" on page 656.

Scans\ProcessedCore Stores the processed core files.

Scans\Sending The Inventory Discovery job moves the new processed core files here for

further processing.

Scans\Temp This is where the XML Enricher stores its temporary files.

The following flowchart shows how the enrichment process works for XSF and delta (DSF) scan files.
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Enriched XSF File Structure

Scanfile.dtd describes the structure of the scan file in standard DTD format.

Note: The file is a text file, but is easiest to read with an XML reader.

An XSF scan file contains a sequence of elements, each of which have various attributes. Root elements

are:
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l <hardwaredata>

l <applicationdata>

l <users>

l <applicationusage>

l <filedata>

l <storedfiles>

l <configurationdata>

Inventory Discovery User Interface

This section includes:

Hardware Mapping Configuration Dialog Box 598

Scanner Generator Wizard 603

XML Enricher: Software Recognition Configuration Dialog Box 655

Hardware Mapping Configuration Dialog Box

Enables you to map scan file hardware attributes to UCMDB CIs.

To access Use one of the following:

l Select Adapter Management > Resources pane > Inventory Discovery > Adapters

>  Inventory Discovery by Scanner. Click the Adapter Definition tab, expand the

Global Configuration Files pane, click HardwareMappingConfig, and click .

l From the Inventory Discovery activity, go to the Preferences page and click the

Custom Mapping button.

Note:  This option is available only when Scanner Based Inventory Discovery

is selected on the Preferences Page.
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Important

information

Before creating a mapping, perform an analysis on what information you want to map,

what data element in the scan file contains the information you want to capture,

where the data element in the scan file is located, and which UCMDB CI you want to

store this information.

Relevant

tasks

"How to Map Scan File Attributes to UCMDB" on page 569

See also Configuration Items (CIs) in the HP Universal CMDB Administration Guide.

User interface elements are described below:

UI

Element Description

Select CI. Opens the Select CI dialog box, enabling you to create a new mapping between a

scan file attribute and UCMDB CI properties.

When the Select CI dialog box opens, select a CI that you want to create a mapping.

Available when: Hardware Mapping Configuration is selected in the left pane.

Select an Attribute. Opens the Select an Attribute dialog box, enabling you to add a

mapping between a scan file attribute and a selected UCMDB CI.

l Attribute. Select an attribute from the drop down list to map to scan file attributes.

l Display Label. The name of the attribute

l Type. The data type of the attribute as it appears in the CI Type Manager. For more

information, see the section describing the CI Type Manager in the HP Universal CMDB

Modeling Guide.

Enables you to delete the selected UCMDB CI or attribute.

CI Editor

Enables you to define attributes of the UCMDB CI that you want to map to scan file attributes.

Important information This page is displayed when a CI is selected in the left pane.

User interface elements are described below:
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UI Element Description

CI Name The display name of the CI that is selected in the left pane.

Relationship Click the ellipsis to open the Select Relationship with Node CI dialog box, enabling

you to select the relationship that you want for the mapping.

If you want to remove the value in this field, click .

Note:

l This is an optional field.

l If there are no options available in the drop down list, there are no

relationships that are created in UCMDB for the selected CI.

l Selected values are ignored if they conflict with system values.

Kind The number of instances of the CI to map.

l Single. Only one instance of the selected CI is created in UCMDB.

l Multiple. Multiple instances of the selected CI are created in UCMDB.

Select this option if there are multiple instances of a particular type of data (shell

tag/field) that you want to map. For example, you want to map the hwCPU field.

However, you notice that there are multiple instances of this field contained in the

scan file. If single is selected, only the first instance of hwCPU is mapped. If you

want to map more than the first instance of this data (i.e, the child data elements

contained in the shell/parent element), select the multiple option. For example, if

there are three instances of hwCPU in the scan file and you select multiple, three

instances of the CI are created in UCMDB.

Create New

CI

Enables you to create a CI instance for the selected CI.

l Yes. Create a new CI instance to map scan file information to a CI type when the CI

type is not contained in the ParseEnrichedScanFile.py script.

l No. Ignores mapping of the selected CI when the CI type is not contained in the

ParseEnrichedScanFile.py script.

Default: No
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UI Element Description

Parent Shell Opens the Select a Shell Tag dialog box, enabling you to select a structural part of the

scan file where the information that you want to map is located. Select a value for this

field if you want to define the value type for the mapped attribute as array.

Otherwise, this is an optional field.

Attribute Editor

Enables you to define properties of scan file attributes that you want mapped to UCMDB CIs.

Important information This page is displayed when an attribute is selected in the left pane.

User interface elements are described below:

UI

Element Description

Attribute

Name

Displays the name of the attribute that is selected in the left pane. Click to open the

Select an Attribute dialog box to edit properties of the attribute.

Note:  If you change the attribute name, the previous attribute values are

overwritten.

Value

Type

The data type of the attributes in your scan file.

l Scalar. Non-composite value, such as boolean, numeric, or character data types.

l Array. Collection of values or variables that are selected by one or more indices.

Note:  This option is only available when there is a value for the Parent Shell field

in the "CI Editor" on page 599.

l Pre/Post. Use mappings that are contained in scripts that can map scan file values to

UCMDB CIs.

l Script. Customize data parsing by using aJython script.

Value Values that are displayed correspond to the option that is selected in the Value Type

field.
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UI

Element Description

l Scalar. Click the ellipsis to open the Select a Scalar Tag dialog box and then select

a structural part of the scan file where your mapped information is located.

l Array. Click the ellipsis to open the Select an Array Tag dialog box and then select a

tag type that corresponds to the attribute tags in your scan file.

Note:  If this option is selected, the only options that are displayed are tags for

the value set for the Parent Shell field in "CI Editor" on page 599.

l Pre/Post. The Scanner reads the output of the pre- and post-scan scripts and

captures all lines with the following structure:

<attributename>=<value>

The length of the <attribute> tag can be up to 256 characters, and the length of the

<value> tag can be up to 1024 characters.

Note: The Scanner captures any script output line that contains an equal sign

(=), except if the equal sign is the first character on the line.

l Script. Enter your Jython script code. For more information, see Create Jython Code

in the HP Universal CMDB Developer Reference Guide.

Note:  The script must return a value.

Overwrite Select an option to overwrite values that were generated by the

ParseEnrichedScanFile.py script when the last Inventory Discovery job ran.

l Yes. The values generated from this mapping overwrite previous values.

l No. The values generated from this mapping do not overwrite previous values.

Default: No
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Scanner Generator Wizard

Enables you to configure and generate scanners to collect information.

To access Use one of the following:

To create a new scanner configuration, or edit an existing scanner configuration

(Enterprise Mode):

1. In the relevant Management Zone, go to the Inventory Discovery activity >

Preferences page.

2. Under Scanner-based Inventory Discovery, expand the Scanner Configuration

pane, and click New/Edit Scanner Configuration.

To create/edit a manually deployed scanner (for Manual Deployment mode):

1. Select Data Flow Management > Adapter Management > Resources >  Inventory

Discovery >Scanner Configuration Files.

2. Select the configuration file (.cxz) in the tree on the left, and click the Generate

Scanners... button in the right pane.

Important

information

For details about the Enterprise and Manual Deployment scanner modes, see

"Inventory Discovery Scanners" on page 505.

Wizard map The Scanner Generator Wizard contains:

"Scenario Page" > "Standard Configuration Page" > "Collection Page" > "Hardware Data

Page" > "Software Data Page" > "Software Details Page" > "Asset Data Page" >

"Scanner Options Page" > "Scanners to Generate Page" > "Generating Scanners Page"

Scenario Page

This page enables you to select a mode for generating the scanner.

Important

information

General information about the wizard is available in "Scanner Generator Wizard".

Wizard map The "Scanner Generator Wizard" contains:

Scenario Page > "Standard Configuration Page" > "Collection Page" > "Hardware Data

Page" > "Software Data Page" > "Software Details Page" > "Asset Data Page" >
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"Scanner Options Page" > "Scanners to Generate Page" > "Generating Scanners Page"

User interface elements are described below:

UI Element Description

Enterprise

Mode

Automatically collect an inventory using the scheduling and launching capabilities

of HP UCMDB.

In this mode, several options are pre-configured to facilitate seamless scanner

integration. Some of these options are not editable.

Manual

Deployment

Mode

Inventory scans are launched from login scripts or non-networked machines, and

not automatically HP UCMDB.
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Standard Configuration Page

This page enables you to select a default scanner setup or to select a previously stored setup.

Important

information

General information about the wizard is available in "Scanner Generator Wizard".

Wizard map The "Scanner Generator Wizard" contains:

"Scenario Page" > Standard Configuration Page > "Collection Page" > "Hardware Data

Page" > "Software Data Page" > "Software Details Page" > "Asset Data Page" >

"Scanner Options Page" > "Scanners to Generate Page" > "Generating Scanners Page"

User interface elements are described below:
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UI Element Description

Default

Settings

l Inventory Scan. Uses default configuration setting for the scanner. Defines a

set of options suitable for a general inventory. Enough software information is

collected to allow comprehensive inventory analysis. All hardware information is

collected and a standard series of asset data fields are defined.

l Shallow Scan. Defines a set of options to allow very quick scans. Because

hardware scanning is very fast, most hardware items (some are disabled by

default) are collected, but limited software scanning takes place, and the data

collected is not sufficient to perform reliable software license recognition.

l Detailed Scan. If scanning time is not a critical factor, this option can be used

to collect the maximum amount of information. This, however, extends the

scanning time significantly.

Note: Use this option in special cases only.

l Enable scanning of Java class file. If you select Inventory Scan or Detailed

Scan (see above), you can enable Java scanning. Enabling this option does the

following:

o Java .class files are stored in the scan file.

o Java specific environment variables for targeted scanning is enabled.

o Windows scanner adds the location of the Java Home directory to the list of

directories for a targeted scan.
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UI Element Description

Stored

Settings

l Read From Server. Reads the settings from a previous Enterprise Mode

configuration stored on the server. The drop down combo box lists previously

configured scanner configurations. The names displayed with angle brackets

around them (for example, <default>) are predefined configurations. It is

possible to read predefined configuration settings, but it is not possible to

overwrite them when generating the new configuration. If you choose a

predefined configuration, you must rename it when you come to the last page

of the Scanner Generator wizard in order to save it to the server. If you save

this configuration, it will be available from the server with the other previous

configurations.

l Read From File. Replaces various configuration settings by reading

information from files on the local machine. It can read parameters from

previously generated scanners, scanner configuration files (.cxz), and scan files

(.xsf). When the file name is provided, the Scanner Generator determines the

type of the file based on the file extension, which eliminates the need to have a

separate entry for each.
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Collection Page

This page enables you to select the type of computer data to collect.

Important

information

l The selections you make on this page determine which of the data detail pages are

displayed.

l When carrying out initial scanner deployments you might want to use hardware and

asset data collection to establish basic information for the target machine. This

can be followed up later by a more comprehensive scan that includes software

data.

l General information about this wizard is available in "Scanner Generator Wizard".

Wizard map The "Scanner Generator Wizard" contains:

"Scenario Page" > "Standard Configuration Page" > Collection Page > "Hardware Data

Page" > "Software Data Page" > "Software Details Page" > "Asset Data Page" >

"Scanner Options Page" > "Scanners to Generate Page" > "Generating Scanners Page"

User interface elements are described below:

UI Element Description

Hardware

and

Configuration

If selected, the scan collects hardware and configuration data, including details of

the processor, memory configuration, computer bus, attached cards, hard disks,

attached drives, monitor, video adapter, keyboard, mouse, OS version, network

protocols and addresses. See "Hardware Data Page".

Note: In Enterprise mode, this option is always selected and cannot be disabled.

Software

Data

If selected, the scan collects detailed information about files and directories on all

scanned drives. The information collected about files can be defined (including the

file types inventoried and the level of information collected). It is possible to define

which drives are to be scanned based on the media of the drive, as well as determine

which files are included in the scan file and which are ignored. See "Software Data

Page".

Asset Data If selected, the scan collects Asset data which consists of asset fields that can be

collected automatically. See "Asset Data Page".
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Hardware Data Page

This page enables you select the hardware categories to be collected by the scanner.

Important

information

l By default, most hardware options are selected. Disable specific hardware

detection routines if there is a known problem scanning these hardware items. You

disable the hardware detection routines for a specific category by clearing the

check box next to the item. All other hardware detection will take place as usual.

l The hardware options have equivalent command line options that can be used at

run-time.

For information about scanner command line options, see "Scanner Command Line

Parameters Overview".

l General information about the wizard is available in "Scanner Generator Wizard".

Wizard map The "Scanner Generator Wizard" contains:

"Scenario Page" >"Standard Configuration Page" > "Collection Page" > Hardware Data

Page > "Software Data Page" > "Software Details Page" > "Asset Data Page" >

"Scanner Options Page" > "Scanners to Generate Page" > "Generating Scanners Page"

Hardware data items are described below:

Category Description

BIOS

information

Collects information about the computer BIOS, including the computers asset tag,

the BIOS date, ID, manufacturer and revision (where applicable).

l BIOS extensions. Detects installed BIOS extensions, such as video or SCSI BIOS.

l SMBIOS. Collects hardware data from System Management BIOS.

l Plug’n’Play. Provides details of whether the BIOS installed on the computer is

Plug and Play compatible. If the BIOS supports Plug and Play specification, the

version of the specification is collected.

Note: Select these options if you want to collect data for software license

compliancy. For more information, see "How to Calculate License Compliancy for

IBM" on page 717.
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Category Description

CPU

Identification

Identifies the CPU (model), establishes if it has got FPU (numeric coprocessor), MMX

(MultiMedia eXtensions) and ISSE/SSIMD capability and reports the speed of the CPU,

cache characteristics.

For newer Intel and compatible processors, the manufacturer, model, family and

stepping ID are reported.

Select this check box if you want to collect data for software license compliancy. For

more information, see "How to Calculate License Compliancy for IBM" on page 717.

Memory Detects the total amount of memory installed on the computer, including the

amount of conventional and extended memory.

l Swap File data. Collects data about swap files used for virtual memory.
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Category Description

Operating

System

Collects information about the operating system and its configuration.

l Device Driver Data. When this option is enabled, the Windows scanner

enumerates all devices to determine which files are used as device drivers. Each

file in this list is given the ‘Device Driver’ attribute when stored in the scan file.

The device driver option is now disabled by default to increase speed of the

hardware scanning.

l Cluster Data. Collects information about Windows Server Cluster membership. It

detects that the machine is part of a cluster, the name and description of the

cluster and the list of nodes connected to the cluster.

l Services. Collects information about installed operating system services.

l Virtual Machines. Detects whether the scanner is running in VMware, Virtual PC,

Terminal Services, Hyper-V, LPAR, vPar, or nPartition. From an asset management

point of view, it is important to be able to determine which scanned machines are

virtual (for example, so you do not pay too much maintenance for too many

machines).

l Profiles. Collects data about user profiles.

l OS Registered Applications. Collects data about installed applications that are

registered with the operating system. On Windows (pre-Vista), it collects data as

displayed by the Add/Remove programs item in the Control Panel. On Windows

(Vista and later), it collects data as displayed by the Programs and Features item

in the Control Panel. On UNIX, it collects data from the system’s software package

manager.

l Packaged File Data. Collects information about the relationship between the

installed applications (packages) and the files that belong to them. When this

option is set, it causes the scanner to interrogate the native operating system

package manager to retrieve the relationship information. This ensures that the

installed package rule-based recognition can correctly recognize the files as

belonging to the installed package/application.
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Category Description

l WMI Software Features. Collects the information about installed applications

from WMI as stored in the Win32_SoftwareFeature class. The Win32_

SoftwareFeature WMI class is not available on the Windows 2003 Server by

default. The WMI provider that supports this class is an optional component on

Windows 2003 Server, and it is not installed by default. To enable this WMI

provider, you must go to Control Panel > Add Remote Programs > Add/Remove

Windows Components > Management and Monitoring Tools > WMI Windows

Installer Provider and install the WMI Windows Installer Provider component.

Once this component is installed, the data collected by WMI Software Features

hardware detection becomes available.

l Containers. Collects data about containers available in the operating system.

Currently, this is supported for Solaris zones, HP-UX nPartition/vPar, and AIX LPAR.

l Software Identification Tags. Collects the information in software identification

tag files, which are XML files that consist of identification and management

information about a software product. These tag files uniquely identify the

software product, providing data for software inventory and asset management.

During the hardware detection phase, the Scanner collects the information from

software tag files from the common system location, as well as from the top

level directory of the application, in the event that software scanning of the

installation locations is done. If you do not select the Software Identification

Tags check box, the Scanner will not collect any information from tag files during

the hardware detection phase. For detailed information, see "Software

Identification Tags".

l Running Processes. Collects information about running processes.

o TCP/IP Connectivity. Collects information about open TCP/IP connections for

running processes.

Note: The Running Processes option must be enabled to select this

option.
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Category Description

Video Records details of the Video Display Adapter, which include the adapter type (EGA,

XGA, VGA and so on) and model/manufacturer, where possible.

In Windows the current desktop resolution and number of colors are also picked up.

l DDC Data. When connected to a VESA DDC compliant monitor, collects full

monitor information.

I/O Ports Detects and reports on the number of serial and parallel ports, the I/O address for

each, and for serial ports, the UARTs attached.

SCSI / ASPI

Detection

Checks for the presence of an ASPI (Advanced SCSI Programming Interface) driver for

a SCSI adapter. If the driver is available, the host SCSI adapter name is reported.

l SCSI/IDE/ATAPI devices. Detects installed devices, such as hard drives, CD-ROMs,

tape drives and other such devices. Also detects Serial ATA disks.

l SCSI/IDE/ATAPI serial numbers. Detects serial numbers of the installed devices

(where available). Also detects the serial number of Serial ATA disks.
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Category Description

Network

Information

Detects the network configuration, including Logon Name, Workgroup Name,

Machine ID, and Domain Name.

Detects information such as multiple network adapters, gateways, DNS servers,

subnet masks, DHCP status.

Information about installed network protocols (TCP/IP, NetBIOS/NetBEUI, IPX/SPX)

and network addresses is also provided.

l TCP/IP. Collects information about an installed TCP/IP protocol. This information

includes domain, DNS Servers, Node type, NetBIOS Scope ID, WINS proxy status,

NetBIOS resolution status.

Network adapter information (including description, IP address, IP routing status,

subnet mask, default gateways, DHCP status, DNS suffix, autoconfiguration

status) is also provided.

l IPX/SPX. Collects information about the IPX/SPX protocol.

l NetBIOS/NetBeui. Collects information about the NetBIOS or NetBEUI protocol.

l Shared Devices. Collects information about shared devices, such as disks and

printers.

Note: In Enterprise Mode,you can disable subsets of network information.

However, you should not disable ALL network information.

Keyboard

and Mouse

Reports on the type of keyboard attached (extended or normal); whether a mouse is

connected and mouse driver is loaded; the mouse brand and version of the driver,

number of buttons and type of connection (serial, PS/2, bus).
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Category Description

Disk Drives Collects advanced information about all attached disk drives. This information

includes the type of the drive (floppy disk, hard disk, CD-ROM, network), the type of

the file system (FAT, NTFS, HPFS), amount of total and free space, location of the

hard drive partitions on the physical hard disk, and so on.

l Local USB Hard Drives Controls the way USB hard drives are treated. If selected

(default setting), the USB hard drives are treated as local hard drives, and their

size is counted towards the total and free space on the local hard drives, which is

recorded in the hwDiskTotalFreeMB and hwDiskTotalSizeMB hardware fields. If

the option is not selected, the USB hard drives are treated as removable drives,

and their size are not counted towards the total size. Also, by default, the USB

hard drives are not scanned during a “classic” local hard drive scan. However, you

can enable scanning by selecting Software Details > Drives > Removable Drives

> Other removable drives. This option is currently only applicable to the Windows

scanner.

Bus

Detection

Detects the architecture of the bus used in the PC:

l EISA. Detects and reports details of EISA cards.

l MCA. Detects and reports details of MCA cards.

l PCI. Detects and reports details of PCI cards.

l PCMCIA. Detects and reports details of PCMCIA cards.

l ISA PnP Cards. Detects and reports details of ISA Plug and Play cards.

l USB Data. Detects and reports details of the USB host adapters, hubs and

devices attached to them.

Note: If the bus types checked for by the scanner are not available, the tests for

checking the cards are not performed.

Peripherals Checks for installed peripherals, such as printers, modems and sound cards.

UNIX System

Configuration

Collects UNIX, Linux, and Mac OS X configuration information.
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Software Data Page

This page enables you to select the method for scanning software. The choice of scan method

determines how extensive the software scan will be.

Important

information

l Available: When Software Data is selected on the Collection Page (see wizard

map below).

l Under most circumstances, the default settings (which are determined by the

presets chosen on the Standard Configuration page) are satisfactory for defining

the software information collected, but the Scanner Generator allows the default

options to be modified to create custom settings.

l General information about the wizard is available in "Scanner Generator Wizard" on

page 603.

Wizard map The "Scanner Generator Wizard" contains:

"Scenario Page" > "Standard Configuration Page" > "Collection Page" > "Hardware Data

Page" > Software Data Page > "Software Details Page" > "Asset Data Page" > "Scanner

Options Page" > "Scanners to Generate Page" > "Generating Scanners Page"

User interface elements are described below:

UI Element Description

Targeted

Directory Scan

Enables optimum scanning speed and software license accuracy. Only selected

locations are scanned, which are identified by the scanner from various sources,

such as Windows shortcuts, Services, file associations, environment variables,

and so on.

Note: This option is most suitable for Windows/Mac OS X platforms.

Classic Local

Drive Scan

Enables a complete scan of all local non-removable drives. This option takes

longer to complete and is used when performing a detailed scan.

Combined Scan Enables both of the previous options: scan all local hard drives as well as

directories on the network pointed to by shortcuts, file associations and

environment variables, such as PATH.

Allow scanner If you select this option, the default drive selection specified can be overridden by
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UI Element Description

command line to

override this

selection

specifying a list of drive letters or directories to scan on the command line using

the –paths command line option.

An example of a command line override is:

Scanwin32-x86 -paths:C:\Windows -paths:D:

If you clear this option, you cannot change the scan selection by specifying drive

letters or paths on the command line.

For more information, see "Scanner Command Line Parameters Overview" on

page 583.
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Software Details Page

This page enables you to select files and directories to scan and store.

Important

information

l Available: When Software Data is selected on the Collection Page (see wizard

map below).

l This page displays a set of sub-tabs according to the selections made on the

Software Data page.

l General information about the wizard is available in "Scanner Generator Wizard" on

page 603.

Wizard map The "Scanner Generator Wizard" contains:

"Scenario Page" > "Standard Configuration Page" > "Collection Page" > "Hardware Data

Page" > "Software Data Page" > Software Details Page > "Asset Data Page" >

"Scanner Options Page" > "Scanners to Generate Page" > "Generating Scanners Page"

This page contains the following tabs:

l "Drives Tab"

l "Directories Tab"

l "File Scanning Tab"

l "Stored Files Tab"

Drives Tab

Enables you to define which of the drives are to be scanned Options are provided for scanning all drives

or just a particular type of drive.

Important

information

Available for Classic Local Drive or Combined scans only. For details, see

"Software Data Page" on page 616.

User interface elements are described below:
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UI Element Description

Local Drives Hard disk drives visible and mounted by the current operating system. In

Windows, normal hard disk drives are assigned drive letters by the

operating system and are usually included in the scanning process. 

Removable Drives Drives with non fixed media that can be removed or exchanged. Removable

drives are normally not included for scanning:

l CD and DVD Drives. Scans the contents of CD and DVD drives.

l Floppy Drives. Scans the contents of floppy drives.

l Other Removable Drives. Scans other removable drives (for example,

SyQuest drives).Scanning removable media is not usually recommended,

because the content of these drives varies depending on the media

currently in the drive.

Note: For detailed information about scanning automatically mounted

drives, see Automount (AutoFS) Drives (below).

Miscellaneous Drives Drives that are neither local nor removable, and may or may not have local

physical media associated with them:

l Network Drives. Scans the contents of network drives.

Note: The network drives can be scanned by multiple computers.

See Automount (AutoFS) Drives (below) for detailed information about

scanning automatically mounted drives.

l SUBST Drives. Scans "virtual" drives created using the operating

system’s substitute command, SUBST, on Windows, or by the loopback

file system (lofs) on UNIX. This is not normally desirable as a substituted

drive can be scanned using both its true drive letter/path and

substituted drive letter/path.

Note: Use this option with caution.
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l Automount (AutoFS) Drives. When not selected (default), the scanner

does not scan any auto-mounted drives. The scanner does not attempt

to mount any indirect automount drives. It may mount a direct

automount drive if it comes across its mount point during the software

scanning process, but the direct automount drive itself is not scanned.

When selected, the automount drives are scanned only if all of the

following conditions are met:

o The directory where the drive’s mount point is located is, itself, being

scanned, for example, it is located on a drive for which the

corresponding drive-type check box is selected.

o The drive-type check box for the real drive type of the automount

drive is also selected. For example, an auto-mounted NFS drive is

scanned only when the Network Drives check box is also selected.

o The drive is a direct automount drive or if the drive is an indirect

automount drive, it has to be either already mounted or during the

scanning process the scanner has to encounter a symbolic link

pointing to a location within the indirect automount drive’s directory

structure.

Example:

The following example shows how these three conditions are met:

A direct automount DVD drive mounted under /usr/local/cd (where

/usr/local is located on a local hard drive) is scanned only when both

Local Drives and CD and DVD Drives check boxes are selected.

l Other Drives. Scans drives created using other devices drives (for

example, RAM drives).

Note:

o Scanning drives created using device drivers can lead to false

reporting of files on a computer.
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o Use this option with caution.

Directories Tab

Enables you to specify which directories to scan.

Important

Information

l Available for Targeted or Combined scans only. For details, see "Software Data

Page" on page 616.

l For Windows operating systems, you can also scan desktop and Start menu

shortcuts.

l By scanning only selected directories rather than complete drives, software

scanning is made faster.

l Although you can specify the file systems and directories (known to the Scanner

Generator) that you want to include or exclude during scanning, you can override

the settings of the file systems and specific directories and files during software

scanning by using the content in the override files. For details on how to add

content to the override files, see "Scanner Options Page" on page 639.

User interface elements are described below:

UI Element Description

Directories

from

shortcuts

(Windows

only)

l Start Menu. Scans the directories that are pointed to by shortcuts on the Start

menu.

l Desktop. Scans the directories that are pointed to by shortcuts on the desktop.

l Only use shortcuts to files with these extensions. Scans only shortcuts that

point to files with one of the specified extensions.

Directories

from other

sources

l Windows Services. Select to include directories containing Windows Services for

targeted scanning. As the name implies, this option applies to Windows scanners

only.

l Java Home. Select if you want the scanners to add the Java Home directory to
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the list of directories for a targeted scan. This option applies to Windows

scanners only.

Note: If you checked the Enable scanning of Java class files on the Standard

Configuration page, this option is selected by default.

l Non-Global Zone Root Directories. Select if you want the scanners to add the

Solaris non-global (local) zone root directories to the list of directories for a

targeted scan. This ensures that all directories used by non-global zones are

scanned during the software scanning process. This option applies to Solaris

scanners only.

l Packaged File Data. Select if you want to make sure that the directories where

the files belonging to installed packages are located are added to the list of

directories to be scanned. For this option to work, the Packaged File Data option

must be enabled on the "Hardware Data Page" on page 609.

l File Associations. Select if you want the scanners to add directories containing

applications that are associated with various file types (for example NotePad for

.txt files) to the list of directories for a targeted scan. This option applies to

Windows scanners only.

l Software Utilization. This setting instructs the scanner to include any

directories from where used programs are executed. These directories will be

included in the list of directories for a targeted scan. This ensures that the

scanner collects the file data required for recognition of used applications. This

option applies to all scanners.

l Program Files/Applications. Select if you want the scanners to add the standard

location for program files to the list of directories for a targeted scan. On

Windows, it is the Program Files directory, which is normally located in the root

of the Windows system drive (such as C:\Program Files). On Mac OS X, it is the

/Applications directory where the applications are installed by default.

Directories

from

environment

group

l Include directories from these environment variables. If selected, the paths

included in the environment variables specified here are also be added to the list

to scan. If you specify multiple environment variables, you must separate each

name with a semicolon (;).
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Shortcuts to

excluded

drives.

(Combined

scans only)

l Scan excluded drives. When selected, this option forces all directories pointed

to by shortcuts to be scanned. If not selected, the directories that are located on

the drives that are excluded by the drive selection on the Drives tabs are not

scanned.

When selected, the scanners may scan directories on network volumes. This is

particularly useful when scanning for software licenses as the scanner detects

files that are part of a network install that is accessible from the machine.

Shortcuts to

the

network/Used

programs

launched

from the

network.

(Targeted

Directory

scans only)

l Scan network drives. When selected, this option forces all directories pointed to

by shortcuts to be scanned. The scanners may scan directories on network

volumes. This is particularly useful when scanning for software licenses as the

scanner detects files that are part of a network install that is accessible from

the machine.

If not selected, the directories that are located on the drives that are excluded by

the drive selection on the Drives and Drive Selection tabs are not scanned.

Usually shortcuts to network drives or network directories from which used

programs were executed are not scanned.

File Scanning Tab

Enables you to specify the level of detail for the information collected about files and directories and

the methods used to check and identify files.

User interface elements are described below:

UI Element Description

Collect File

Data

Enables you to configure the file scanning options.

Files to Scan

sub-tab

Enables you to specify how much information is collected about files and the

checking processes used.

l Add. Opens the Select Files to Process dialog box, enabling you to add a filter

for files to scan:
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o File Name. Specify the relevant wildcard file type to process. For example,

*.tmp means all files with the .tmp extension. Multiple specifications,

separated with semicolons, are also accepted.

o Action. Select one of the following actions:

l Signature. Collects file signatures for the specified type of file.

The signature is an ISO checksum (CRC) of the first 8KB of the file. To

calculate the signature, the scanner opens the file and reads the first 8KB

from it. Collecting signatures helps to establish the file’s identity. Two

different files rarely have the same signature. Signatures are used by the

software recognition in analysis tools to improve software application

recognition. Also, only those fields for which signatures were collected can

optionally be identified by the scanner (see "File Identification sub-tab" on

the next page).

l Ignore. Ignores the type of file specified in the File Name box.

o Attributes. Select from the following options as required:

l Read Only. Files with the read-only attribute are capable of being

displayed, but not modified or deleted.

l Hidden. Files with the hidden attribute are not normally visible to users.

For example, hidden files are not listed when you execute the Command

Prompt DIR command. However, most file management utilities allow you

to view hidden files.

l System. Files with the System attribute.

In general, if a given attribute is not selected, the entry having the attribute

will not match, even if the file name does.

o Size Range (Kb). If required, select the Limit Processing by File Size and

specify the maximum and minimum file sizes. Only files within this size range

are processed.

l Edit. Enables you to edit the selected file scan filter.

l Delete. Deletes the selected file scan filter.
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l Move up/Move down. Enables you to change the order of the filters.

The order in which process selections occur is important. For example, use Ignore

first before making Signature process selections.

This ensures that the Ignore items are processed first before a file needs to be

opened. It may be necessary to ignore certain files, the content of which is

constantly changing.

Examples of files to ignore because of changing content are files that are

normally used as swap files, such as pagefile.sys.

l <Files to Scan list>. Displays the checking methods used for processing files.

You can build up a prioritized list of filters which specify a sequence of checking

processes to be used.

Note:

Using the options on this page, it is possible to define which files get their

signature calculated and collected, based on criteria such as file extension,

attributes or size.

Only files that have signatures enabled are opened and are available for further

processing. If a copy of the file name is all that is required, use the following

command.

Ignore *.*

The file name, size and attributes may still be picked up in the scan file but no

signatures are calculated. This greatly reduces scanning time, but because less

data is collected, application recognition accuracy may be adversely affected.

File

Identification

sub-tab

Enables to you determine whether the scanner identifies files based on their

content.

l Identify File Type. Instructs the scanner to check every file that was selected for

signatures to identify all executable and archive files. The scanner can identify

LZH, LHA, ZIP, ARJ, ARC and PAK archives. Selecting this enables two further

options:

o Process Archives as Subdirectories. Treats archive files as subdirectories and

lists the files included in each archive (it does not extract information from
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within these files). If this option is not selected, archive files are not scanned

for embedded files and directories.

If this option is selected, a further option is made available:

l Process Archives inside GZIP Files. Enables the handling of archives

located in gzip files (such as .tar.gz files). These are tar archives that were

compressed using gzip. This option instructs the scanner to process such

archives.

o Collect Internal File Identification. Collects internal file information included

in the executable file, for example, version data and legal copyright. This

option must be enabled if you are using Express Teaching to teach

applications. For more information about Express Teaching, see "Express

Teaching Overview" on page 702.

o ELF Prelinking Aware. During software scanning, this option instructs the

scanner to check if an executable file has been pre-linked by the ELF

Prelinking Utility (prelink). The ELF Prelink Utility is used to speed up loading

times of ELF shared libraries and executables by modifying them to reduce the

number of the reallocations the dynamic linker needs to do to load them in

memory. If this option is enabled, the scanner calculates the size and

signature of the file before it was pre-linked. This is useful for accurate

application recognition since the file size and signature are used to perform

application matching. However, enabling this option does produce extra

overhead during the scan as the scanner needs to run the pre-link utility to

obtain the original executable file. The pre-linked file is not modified by the

scanning process; the original file is only reconstructed temporarily in order to

collect the size and signature.

Note: This is for Linux platforms only.

l Preserve Last Access File Date. Collects the Last Accessed time stamp for files

(where available). The support for the Last Accessed time stamp varies

depending on the operating system and file system used.

When this setting is used on UNIX computers, although the last access time is

preserved, the ctime of the file gets changed. For this reason we recommend

that you do not use this setting on Linux, Mac OS X or UNIX computers.
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Note: When this option is enabled, the XML Enricher can make use of this

feature to accurately estimate the time when recognized applications were

last executed.

l Process Software Id Tag Files. Enables the collection of information from

software tag files during the software scanning phase. During the hardware

detection phase, the information from tag files that are located in the common

system location and in the root of the application's installation directory is picked

up. The tag files stored in the root of the application's installation directory can

be collected only if the application is in a standard package format, or a directory

where the application is installed is scanned during the software scanning phase.

For more information, see "Software Identification Tags" on page 184.

File

Information

to Store sub-

tab

Enables you to define which file details to store in the scan file.

l Add. Opens Select Files to Process dialog box, enabling you to add filter

criteria for file information to store. For details, see "File Information to Store tab

> Select Files to Process Dialog Box" on page 630.

l Edit. Enables you to edit the selected filter. For details, see "File Information

to Store tab > Select Files to Process Dialog Box" on page 630.

l Remove. Deletes the selected filter.

l Move up/Move down. Enables you to reorder defined filter criteria.

l By default, store information on all files. If selected, and no other options are

specified, then information about all files is stored in the scan file.

l By default, discard information on all files. If selected, and no other options

are specified, then no file data is stored in the scan file.

l Do not store empty directories When selected (default), the scanner discards

information about directories that have no files in them. This can include

directories that may have files in them, but you have set up the scanner not to

scan for these particular types of file.

Note:

Data Flow Management Guide

Chapter 15: Inventory Discovery

HP Universal CMDB (10.22) Page 627 of 795



l In addition to the default settings, you can define a prioritized list of filters,

in a manner similar to that of the File to Scan page. Each filter can specify

directories or files to be included or excluded from being stored. Each file

and directory entry found during scanning is looked up in the list, and the

first matching entry determines whether the entry is stored or not.

l The options chosen here can dramatically affect both scanning speed and

scan file size. Under normal circumstances, the default options are

adequate.

l Multiple filter criteria can be specified on each line if they are separated by a

semicolon.

Stored Files Tab

Enables you specify the files to be collected and stored (embedded) in the scan file created for each

computer scanned. The types of files usually collected are system configuration files.

Important

information

l The collected files can be viewed in Viewer or exported from Analysis Workbench.

For more information, see "Inventory Tools" on page 530.

l If a targeted directory scan selection was made earlier and does not include a

specific directory in which a stored file may be found (including the root directory),

then any required stored file must be specifically defined here with the full path.

User interface elements are described below:

UI Element Description

Clears the list of files to store.

Store

specific

files

Enables you to select specific files to be collected and stored (embedded) in the scan

file created for each computer scanned.

Only Store

files

smaller

than

Enables you to limit the size of the files to be stored

When large files are collected and stored, restricting the size of files collected can

prevent creation of very large scan files.

Data Flow Management Guide

Chapter 15: Inventory Discovery

HP Universal CMDB (10.22) Page 628 of 795



UI Element Description

<Files to

Store list>

l <Right-click menu>. Enables you to add a new file to store, or delete a file from the

list.

l File Name to Store. Displays a default list of system files. The name of the files can

include wildcard characters unless a specific directory is used.

For example, collecting the Config.sys file for each computer scanned across a

population provides a snapshot of the system configuration for each computer. This

enables the analysis and consolidation of system configuration across the computer

population.

Other commonly collected files are Net.cfg, Profile.ini, AutoExec.Bat, Win.ini,

System.ini, and Boot.ini.

Note: The one Universal Discovery specific file included in the list is the override

file, called override.ini on Windows systems and .override.ini on UNIX/Mac OS X

systems. This is an ASCII file used by the scanner at run-time to store a list of

files to be ignored (that is not opened at run-time). For more details, see

"Directories Tab" on page 621.

l Found Where. Displays the location of the file.

o /etc directory. Stores the file only if it is found in the UNIX /etc directory.

o /var directory. Stores the only file if it is found in the UNIX /var directory.

o Any Root. Stores the file only if it is found in a root directory.

o Anywhere. Stores the file wherever it is located.

o Root of Boot Drive. Stores the file only if it is found in the root of the boot drive.

o Specific directory. All the files in the specific directory are collected, but sub-

directories are not included.

For example, the stored files could be configured to be:

C:\Documents\*.*
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In this case, the scanner stores all the files in the C:\Documents directory.

o Specific File. A specific copy of the file is collected irrespective of whether it is

included in the software scan.

For example, the list of specific stored files could be configured to be:

C:\Documents\config.txt

Z:\net.ini

/etc/fstab

In this case, the scanner storee the config.txt file from the C: drive (when

scanning PCs), the net.ini on the Z: drive (if it is available, and only on PCs) and a

file named fstab in the /etc directory (when scanning UNIX machines).

Note: Files are stored only if the directory where the file is located is

included in the software scan, unless the specific directory is specified.

File Information to Store tab > Select Files to Process Dialog Box

This dialog box enables you to select files and file attributes to store after scanning.

To

access

Select Scanner Generator wizard > Software Details page > File Scanning tab > File

Information to Store tab, and click Add .

User interface elements are described below:

UI Element Description

Storage Determines whether the filtered file information is to be stored or discarded.

Type Determines the type of files to include in the filter. The filter options differ depending

on the file type selected here.

l Files. Filters all files.

l Files inside Archives. Filters only archived files.
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l Directories. Filters only directory files.

Options

(Files)

When Type > Files is selected, the following filter options are available:

l Identified as Executable. Files that are identified as any kind of executable (such

as .exe and .com).

Note: This takes effect only if the Identify File Type option in the "File

Identification sub-tab" is selected.

l Has UNIX or Mac Executable Attribute. UNIX allows three different levels of

access to a file for three different categories of users: owner, group, and other.

o Read. View the file or directory without making changes.

o Write. Make changes to the file or directory

o Execute. Execute the file or list files in a directory.

This option instructs the scanner to store or discard files that have executable file

access in any of the user categories (namely, owner, group or other.)

l Identified as Archives. Files that are identified as compressed, such as .zip, .lzh.

Note: This takes effect only if the Identify File Type option on the "File

Identification sub-tab" is selected.

l Scanned (i.e. Not Ignored). Includes all files that are not ignored on the File

Scanning tab.

l Matches Wildcard Mask(s). Includes files that match the wildcards specified here.

o Case-sensitive match. Includes all files that match regardless of case.

Available: When Matches Wildcard Mask(s) is selected.

Note:

l All of the selected options are OR-ed together; that is, the entry is considered

a match if any of the selected entries match.
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l The order and content of these options can affect scanning speed and

function significantly. If the default is Discard, and a Store - Identified as

executable entry is included, all files have to be scanned before the scanner

can determine if they are to be discarded.

Options

(Files Inside

Archives)

When Type > Files Inside Archives is selected, the following filter options are

available:

l Matches Wildcard mask(s). Includes archived files that match the wildcards

specified here

o Case Sensitive Match. Includes all files that match regardless of case.

Available: When Matches Wildcard mask(s) is selected.

Note: Files discarded in this way are not scanned either, and a wildcard filter can

speed up the scanning process.

Options

(Directories)

When Type > Directories is selected, the following filter options are available:

l Named. It this option is selected, the directory name specified in the entry field

must match 100% (however, it is not case-sensitive) in order for a match to be

established. For windows directories, the directory name must include the drive

letter. The path wildcards * and ? can be used for matching the directory name.

The root directory \ or / cannot be excluded in this way.

For example, \Private would match any directory where a directory starts with

Private

l Where Name Contains. If this option is selected, the name specified in the entry

field is a partial string; any directory containing this string in its name is

considered a match.

For example, Temporary would match any directory with Temporary anywhere in

the name.

l Case Sensitive Match.For either of the directory options, includes all directories

that match regardless of case.

l Include Subdirectories . For either of the directory options, includes

Data Flow Management Guide

Chapter 15: Inventory Discovery

HP Universal CMDB (10.22) Page 632 of 795



UI Element Description

subdirectories of matching entries as well. This is particularly useful for discarding

entire directory trees, such as recycle folders, temporary Internet files and private

directories.

Note:

l The contents of filtered directories are not stored in the scan file. If the Do

not store empty directories option (File Information to Store tab) is selected,

filtered directories are considered to be empty and are not stored in the scan

file either. If this option is not selected, the filtered directories are

represented in the Directories and Files tab of the Viewer application by a No

entry icon.

l Directories are filtered prior to scanning (that is, directories that are not

stored are not scanned at all). Consequently, directory filters may speed up

scanning.
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Asset Data Page

This page enables you to define and set up the asset data collected by the scanners.

Important

information

l Available: When Asset Data is selected on the "Collection Page" (see page 608).

l The Asset Number sub-tab is available in Manual Deployment mode only.

l General information about the wizard is available in "Scanner Generator Wizard" on

page 603.

Related

tasks

"How to Set Up Asset Fields for Data Collection" on page 543

Wizard map The "Scanner Generator Wizard" contains:

"Scenario Page" > "Standard Configuration Page" > "Collection Page" on page 608 >

"Hardware Data Page" > "Software Data Page" > "Software Details Page" > Asset Data

Page > "Scanner Options Page" > "Scanners to Generate Page" > "Generating Scanners

Page"

Asset Data Tab

Enables you to configure customized asset information as each computer is scanned. 

Important

information

l Initially, a default list of entries is displayed . These can be modified to create a

custom list of entries. For information about including other information about the

user, see IT Universe Manager in the HP Universal CMDB Modeling Guide.

l By default, asset fields are not mapped to any of the UCMDB CI attributes so the

data is only available in the scan files. To map the needed asset fields, you must

configure the mapping between the asset fields and the desired UCMDB attributes.

For details, see "How to Map Scan File Attributes to UCMDB" on page 569.

l Each row in the Asset Fields list defines a piece of asset data and results in one

item being collected during the inventory.

User interface elements are described below:

Data Flow Management Guide

Chapter 15: Inventory Discovery

HP Universal CMDB (10.22) Page 634 of 795



UI Element Description

Create New Field. Opens the Choose Field dialog box, enabling you to choose an asset

field to be automatically collected. For more information about the available asset

fields, see "Asset Fields" on page 544.

Edit Field. Opens the Asset Field Configuration dialog box, enabling you to edit the type

and settings for the selected asset field. For more information, see "Asset Field

Configuration Dialog Box" on the next page.

Delete. Deletes the selected asset field.

Tip: To delete multiple asset fields simultaneously, hold the Ctrl or Shift key while

selecting the fields.

<Asset

Fields

list>

Displays the asset fields to be collected by the scanner.

l Caption. The display name for the asset field, as is displayed in the Inventory Tools.

l Field. The name of the asset field.

l Field Type. The type of field. The field can be a calculated, derived, or automatic

field type. For more information, see "Asset Field Configuration Dialog Box" on the

next page.

Asset Number Tab

Enables you to set options for managing the asset number used to uniquely identify a machine.

Important

information

l Available in Manual Deployment mode only.

In Enterprise mode the options for selecting the source is always from the Asset

tag field.

l Each computer that is scanned needs to be identified by a unique tag known as the

Asset Tag. Asset tags are generally assigned to allow each hardware item to be

recorded and identified in an asset management tool, such as HP Asset Manager.

The conventions used depend on the numbering system and asset registering

policies adopted by your organization. Ensure that your asset numbers can be

reconciled between Universal Discovery and HP Asset Manager.

User interface elements are described below:
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Asset Tag

Field

If selected, this uses the value in the Asset Tag field created in the Asset Data tab.

This is usually used as the unique key to identify each computer.

Note: When this is selected (default) and an offsite scan file will be saved, an

Asset Tag field must be defined in the Asset Data tab before you can continue

with the wizard.

Scanner

Command

Line (/o

switch)

An offsite scan file name can also be specified by the -o: command line option. This

overrides the scan file name (as well as the path, if specified).

To configure this, select the Scanner Command Line (/o) option. The scan file name is

taken from the command line. This is entered using the -o: command line option when

the scanner is started, using the name specified.

For example:

Scanwin32-x86 -o:FP00017

Asset Field Configuration Dialog Box

Enables you configure asset fields to collect during scanning.

To access Select Scanner Generator wizard > Asset Data page > Asset Data tab > asset field in

the list, and click Edit Field .

Important

information

The asset data fields are automatically populated. The data is either calculated or

derived. The data can be extracted from text files, the Windows registry, environment

variables and WMI fields. All data entry fields can be given a default value.

User interface elements are described below:

UI Element Description

Opens the Asset Field Extract Options dialog box, enabling you to set up calculated

asset fields so that only part of the string is selected instead of the entire string. They

can also be set up, for example, to use the last part rather than the first part of the

string. This can be useful for obtaining the last part of a calculated field that is too

long.

l Extract Characters From. Enables you to specify whether you want to use the first

part or the last part of the string, and the number of characters to skip from the
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beginning or end of the string respectively.

For example, if you have the string ABCDEF123, selecting Start and skip 4

characters would result in the string EF123.

l Options. Enables you the configure how to treat the extracted strings:

o Convert to Upper Case. Converts the alphabetic characters to upper case, if

required.

o Treat Field as a File Name. Treats the string in the asset field as a file name. In

the case of characters that are invalid in file names, you can define a character

to replace the invalid character, or have the scanner delete the invalid

character.

l Default Value. Enables you to define a default value for the string if the extracted

field is empty or not found.

For example, if the text string Not Found is entered in this box, then an empty field

or a field that has not been found is assigned the value, Not Found.

Available for: Calculated fields only.

Note: This button is not available for user-defined fields.

Caption The display name for the asset field. The caption is displayed in the Inventory Tools.

Field The name of the asset field. Click the Choose button to select a field type. For a list of

the available asset fields, see "Asset Fields" on page 544.

Max Width The maximum number of characters for the asset field.

Field Data

Type >

Calculated

Fields

Calculated fields can be automatically populated from data extracted from text files,

the Windows registry, environment variables and so on.

l Environment Variable Extract. Accepts data from a specified environment variable

set in the operating system.

l Registry Extract. Extracts its value from the Windows registry. The Data field must

contain a valid registry key name to extract from, for example:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control
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\TimeZoneInformation\StandardName

l Text File Extract. Extracts information from a single line in a named text file.

This field type is normally used for the Asset Number field. This is used to extract

the asset number from the file, Asset.bat, on the line containing the text:

SET ASSETNO=

Other useful file extracts include the predefined SMS, which extracts the SMS

Unique Machine ID.

l WMI Extract. Extracts and stores pieces of data on Windows available through the

WMI interface. The Windows scanner populates this field (if set up) on systems

where WMI is enabled.

Field Data

Type >

Derived

Fields

Derived fields have dependencies on the data of other types of fields. That is, the data

they contain is derived from other fields.

l Sequence. Enables you to define a sequence of up to ten asset or hardware fields.

Each of these fields returns a value depending on the machine or environment

running.

The value returned as the result of the sequence field is the first of these fields

that contains a non-blank value.

l Combination. Uses a substitution string to replace occurrences of %1, %2 and so

on. placeholders with the actual values of hardware or asset fields. An example of a

Combination field can be found in the Description field of the default Asset Data

tab.

Up to five fields can be combined into one.

l OS/Scan. Allows a single field to collect different information for different

operating systems. For example, you may want to extract information from a

registry on Windows and from a file on UNIX.

For each scanner platform a separate asset field could be defined.

Field

Parameters

Enables you to configure parameters for the field type selected. For details about the

parameters for each field type, see "Asset Field Parameters" on page 546.
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Scanner Options Page

This page is used configure the behavior of the scanner during the usual scanning process and under

exception conditions, and how to save the inventory results.

Important

information

General information about the wizard is available in "Scanner Generator Wizard" on

page 603.

Wizard map The "Scanner Generator Wizard" contains:

"Scenario Page" > "Standard Configuration Page" > "Collection Page" on page 608 >

"Hardware Data Page" > "Software Data Page" > "Software Details Page" > "Asset Data

Page" > Scanner Options Page > "Scanners to Generate Page" > "Generating Scanners

Page"

Saving Tab

Enables you to set options for saving the inventory scan results.

Note: For Enterprise Mode some of the options are pre-set to optimal values and cannot be

changed.

User interface elements are described below:

UI

Element Description

Save

result

locally

Saves the scan file to the local machine.

By default, the local scan file is called local$.xsf. This default name can be changed by

using the -l scanner command line option.

The Windows scanner uses the Hewlett-Packard\Universal-Discovery subdirectory of the

application data directory for all users.

l Enable delta scan files. Enables delta file scanning, where the scanners first save the

complete scan files offsite by copying the local scan files.

Instead of sending a full scan file to a server after every scan, the scanners calculate

the difference (the delta) between the last full scan and the current one - and transfer

just this data. This can dramatically reduce the amount of network bandwidth used
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when using Universal Discovery. By default, delta scanning is enabled.

The XML Enricher re-assembles the full scan files based on the previous scan and the

delta scan. No other Universal Discovery component uses the delta scan file. The re-

assembled scan can however, be used in the Viewer and Analysis Workbench inventory

tools.

Note: To set up the scanner to handle delta scan files in Manual Deployment

mode, see "How to Set up the Scanner to Handle Delta Scan Files in Manual

Deployment Mode" on page 558.

Note: In Enterprise mode results are always saved locally—this setting cannot be

changed.

Save

result

to

network

(off-

site)

Saves the scan file to a remote (offsite) disk (such as floppy disk or network drive).

Click Advanced to specify the file path or URL:

l File. Saves the results to the specified file path. In the File Path/URL field, specify the

path as follows:

o Normal file path. The full path name, beginning with the drive letter.

For example: c:\Inventory\Scans.

o UNC file path. The UNC path.

Use the following format: \\servername\sharename\path\

For example: \\DataFlowProbe\ScansIncoming

Note:

l The specified UNC path must have write access. Do not specify a file name

here.

l The offsite save location can be overridden by using the -p: or /p: command
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line option. For example: Scanwin32-x86 -p:C:\Scanners\

l A UNC path can also be entered as the argument to this option. The format

for the UNC path is: \\servername\sharename\path\

For example: Scanwin32-x86 –p:\\DataFlowProbe\ScansIncoming

l In Windows, if the UNC name specified is visible to the machine, the scan file

will be saved to the specified location, even if it is not mapped to a drive

letter.

l On UNIX and Mac OS X machines, the UNIX/Mac OS X save path is used

instead, allowing UNIX-style syntax for specifying directories to be used. On

UNIX/Mac OS X, do not use drive letters, and the save path must instead

start with ‘/’ (root) and point to a directory writable by the scanner.

l FTP/FTPS. The scanner saves the scan file to the FTP or FTPS server specified in the

File Path/URL field. If necessary, provide the username and password to access the

specified path.

When an FTP location is specified with the -p scanner command line option, the user

name and password can be encoded into the URL as follows:

ftp://user:password@host:port/dir

For detailed information, see the description of -p:<path> in "Scanner Command Line

Parameters Overview" on page 583.

l HTTP/HTTPS. The scanner saves the scan file to a Web server specified in the File

Path/URL field, if it has been configured to allow writing to a particular directory. If

necessary, provide the username and password to access the specified path.

Ensure that the web server has been configured to allow saving to it using HTTP. For

details, see "Web Server Configuration for Saving Scan Files via HTTP" on page 593.

By default both the Incoming and Original directories of the XML Enricher are shared

via HTTP. This can be changed to HTTPS by adjusting the Data Flow Probe configuration.

See "Processing Scan Files" on page 516.
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Always

create

log file

The log file stores progress messages for scanner hardware detection, indicates what

directory data is scanned, how long the software scanning took, and contains the status of

the scan file saving.

A log file is always created if this option is selected. If this option is not selected, a log file

is only created if an error is encountered.

Depending on the saving options chosen, the log file is saved to the following locations:

l The same location as the local scan file.

l The same location as the off-site scan file (if an off-site location has been specified).

l In the scan file itself (as a stored file).

The name given to the log file is the same as the name of the scan file. For example, if the

scan file is called: XSF014.xsf, then the log file generated will be called: XSF014.log.

Settings Tab

Enables you to control the behavior of the scanner as it scans each computer, and how it interacts with

users. By default, the scanner is made to run with the lowest priority, but goes to full speed when the

screen saver is active.

User interface elements are described below:

UI

Element Description

Define

how fast

the

scanner

should

run

When Run scanners at low priority is selected, the scanners can be set to run at slower

than normal speed, so that they do not impact on the users work.

Use the slider control to specify how slow or how fast the scanner should run.

When selected, PC-based scanners allocate CPU resources less aggressively and wait

much longer between each file scanned. In UNIX and Mac OS X, the scanner performs a

renice of itself to run at a lower priority.

If you select Increase scanning speed when the screen saver is running (Windows), the

scanner increases its speed to normal as long as it detects that the screen saver is
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running. As soon as the screen saver disappears, the scanner runs slower again.

Define

various

time-

outs

used by

the

scanner

l Retry off-site save after error. The scanner attempts to retry off-site scan file

saving if an error occurs the specified number of times.

l Delay before retrying off-site save. The scanners wait for the specified amount of

time (in hours, minutes and seconds) before retrying the off-site scan file saving, if an

error previously occurred in this process.

l Maximum random delay before scan. (Windows scanner only.) The scanner waits for

the specified amount of time (in hours, minutes and seconds) before doing anything

on the machine.

Default: 00:00:00 hh:mm:ss

Maximum value: 23:59:59 hh:mm:ss

If the scanner is launched via a login script, using this option allows the saving of scan

files to be spread over a longer period to avoid overloading the network at busy

periods. For example, in the morning, when all users come to work, power up their

computers, and start the scanners at approximately the same time.

l Maximum software scan run time. Sets the maximum amount of time (in days, hours,

minutes, and seconds) that the scanner runs. This setting is useful in protecting the

scanner from scanning large volumes which were inadvertently included into the

software scanning scope. If the scanner reaches the configured maximum time, it

saves the scan files with the partial software details recorded right to that moment,

and exists with the exit code 7.

Default: 00:00:00:00 dd:hh:mm:ss (No limit applies.)

l Software scan cut-off time. Sets the local time of the day on the managed computer

(using the 24-hour clock) when the software scan has to stop. This setting is useful as

a safety feature in cases when there are certain periods of the day during which the

scanning must not be performed. When the cut-off time is reached, the scanner saves

the scan file containing the partial software inventory, and exits with the exit code 7.

Note: This option must be used with great care to avoid incomplete results being
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saved regularly. The inventory has to be scheduled early on during the day to

allow the scanner to complete the full software inventory.

Default: 00:00:00 hh:mm:ss, meaning the scan is not stopped. If, for example, you want

to stop the scan before midnight, enter 23:59:59.

Define

other

settings

that

control

the

scanner

behavior

Leave at least this amount of space in the Temp directory. Enables you to set the

amount of the disk space (in MB) the scanner must reserve to be available in the Temp

directory before failing.

During software scanning the scanner stores the partial software scan result in the temp

directory. If the amount of disk space available in the Temp directory is too low, normally

the scanner uses all the available space and when none is left, it fails. However, during the

time when no Temp space is available, other processes running on the system may start

failing as well. This setting ensures that at least the specified amount of space is left

reserved for other processes to continue their normal operation.

For example, if 5 MB is specified, the scanner uses the space in the Temp directory until

there is 5 MB of free disk space left, and when this limit is reached, the scanner fails.

Note:  This number must be an integer.

Default: 0, meaning no limitation.

Miscellaneous Tab

User interface elements are described below:

UI Element Description

Terminate

the scanner

if the

following

environments

are detected

When the scanner is run inside a virtual environment, you may not want a full

software scan to take place because this would scan the server for every virtual

machine.

When the scanner detects the selected virtual environment, the scanner exits

without doing any processing with a special error level 20, allowing a script that

launches the scanner to handle this situation and launch another scanner tailored
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for the virtual environment, if required. 

Select the

action to

perform

when no user

is logged into

the computer

(Windows)

Defines the action to take if there is no user logged into the computer (Windows

scanner only).

l Scan immediately. Forces the scanner to run under the local system account. It

will not be able to collect the environment information for a particular user. The

environment settings for the local system account will be detected. Also any

program running under the local system account does not have access to

network resources, so the scanner will not be able to access any files or

directories on the network.

l Wait until someone logs in. Instructs the scanner to wait until an interactive

user logs into the system. When this is detected, the scanner impersonates this

user and executes using this user’s account. This allows the scanner to collect

environment information for the user.

Note: This setting is not suitable for standalone servers where interactive

users rarely log in.

l Exit the scanner. The scanner simply exits without scanning the computer.

Note:

l Enterprise mode: The Windows scanner is launched via the Universal

Discovery agent or by agentless NTCMD protocol. The agent itself, or the

NTCMD protocol component, runs as a Windows service under the

LocalSystem account. However, the scanner always tries to impersonate the

account of the currently logged in user in order to collect the required

network, environment, and other configuration information for the user.

This setting specifies the scanner behavior when no user is logged in at the

time the scan is scheduled.

l Manual Deployment mode: The scanner runs under the account of the

currently logged in user, so normally these settings do not apply. They might

only take effect when the scanner is launched by a software distribution tool

that can run it under the LocalSystem account. In this case, the above logic

for Enterprise mode applies.
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TCP/IP

connectivity

options

Enable the use of the pfiles command. Enables the use of the pfiles command on

the Solaris and HP-UX platforms.

Default: No.

Troubleshooting Tab

Enables you to set up additional troubleshooting options for the scanners.

User interface elements are described below:

UI Element Description

Additional

command

line

parameters

to supply to

the scanners

You can specify additional content for the override files here. Although the options for

the scanner are normally set using the Scanner Generator, it may be necessary to

change some settings to allow better operation on some machines. The operation of

a scanner can be modified with the use of the various command line parameters.

Additional file scanning configuration specified in the override.ini (Windows) file and

the .override.ini file (UNIX/Mac OS X) can be entered in this field. The content specified

here is processed by the scanner before processing the content of the override file (if

available on the system where the scanner runs).

Additional

content for

.override.ini

file

You can override the settings of the file systems, directories, and files during the

software scanning process by specifying additional settings in the override file. As

indicated, on Windows systems, the name of this file is override.ini. On UNIX and Mac

OS X systems, the name of this file is .override.ini. The override file must be located

in the same directory as the scanner executable.

l File Systems

Because it is always possible, particularly on UNIX and Mac OS X systems, that

some file systems are not in the list, you can create a file where you can specify

any additional names of file systems that you want to include or exclude during

scanning.

You can also specify names of existing file systems in case you want to change the

inclusion/exclusion of such file systems after the scanner has been generated.

The format of the file is as follows:
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[include]
fs=<name of a file system>
[exclude]
fs=<name of a file system>

There can be several fs entries in each section.

For example, to ensure that all afs mount points are scanned, and that nfs and

swap volumes are not, create the override file with the following contents and

place it in the same directory as the scanner prior to running:

[include]
fs=afs
[exclude]
fs=nfs
fs=swapfs

Note:

o The name of the file, the sections and the files systems are case-sensitive

o For the feature to work correctly, the override file must be present in the

directory in which the scanner resides.

l Directories and Files

The override file can also be used to exclude specific directories or files from

being scanned without regenerating the scanner.

Note: Files can only be excluded; they cannot be included.

To make use of this file, add one or more

dir = <name>

or

file = <name>

entries to the [exclude] section of the override file. Excluded directory names

must be fully qualified. Excluded file names can contain wild cards.
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Note: When excluding files using the override file, the scanner may still store

information about the excluded files in the scan file. Adding file entries to the

override file ensures that the file will not be opened for any reason, so no file

identification, signatures, or archive processing will happen for excluded files.

o Example 1

Exclude a specific file system, two directories and all files with exe extension.

[exclude]
fs=autofs
dir=/temp
dir=/etc
file=*.exe

o Example 2

This runs a scan without software on a Windows machine.

[exclude]
fs=FAT
fs=NTFS

o Example 3 Virus Warning

Since the scanner opens files on the computer, if real-time antivirus software

is in operation, it may detect a virus being present in a file.

Depending on the virus product being used, actions will have been defined to

deal with an encountered virus. Some will try to deal with the problem and

immediately disinfect the file. Others will try to move the infected file to a

quarantine directory and rename its file extension. In this case, the quarantine

directory may be scanned by the scanner later during its scan.

To prevent this from happening, use the override file with *.vir specified for

exclusion (where .vir is a typical quarantine file extension). Check the specific

virus product to find the extension for this type of file.
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Scanners to Generate Page

This page is used to specify which scanners to generate and where they will be stored.

Important

information

General information about the wizard is available in "Scanner Generator Wizard" on

page 603.

Wizard map The "Scanner Generator Wizard" contains:

"Scenario Page" > "Standard Configuration Page" > "Collection Page" > "Hardware Data

Page" > "Software Data Page" > "Software Details Page" > "Asset Data Page" >

"Scanner Options Page" > Scanners to Generate Page > "Generating Scanners Page"

User interface elements are described below:

UI Element Description

Generates the scanners based on the settings defined in the Scanner Generator wizard.

Output

Options

tab

Enables you to set up scanner descriptions, save the configuration to an HTML file if

required, and (Enterprise Mode only) name the configuration (.cxz) file.

See below.

Scanners

tab

Enables you to select which of the scanners to generate.

Available: In Manual Deployment mode only.

Output Options tab

Enables you to set up scanner descriptions, save the configuration to an HTML file if required, and

(Enterprise Mode only) name the configuration (.cxz) file.

Having a scanner description is very useful for change control if different scanners are being developed

for different circumstances. It is useful for documentation purposes, to have a file with the scanner’s

configuration stored in a file. If this step is missed, load the scanner or a scan file derived from it into

Scanner Generator to produce the documentation.

User interface elements are described below:
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Scanner

Description

A description that identifies the scanner.

For example:

Standard PC Inventory – May 18, 2012

The scanner description is saved in the scan file as the hwScannerDescription

hardware field, and subsequently in UCMDB in the description attribute of the

inventory_scanner CI.

Save

scanner

options to

an HTML

file

Saves the scanner options to the specified HTML file. Enter the full path and file name.

This instructs the Scanner Generator to output an HTML file containing a complete

listing of all settings defined elsewhere in the program. The HTML file cannot be used

by the Scanner Generator, but is intended for user/internal documentation purposes.

Example of the ScannerOptions.html File

You can look at a ScannerOptions.html file using an Internet browser such as the

Microsoft Internet Explorer. The following shows the first few sections that you will find

in the file:
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Scanner

Generator

Output

(Enterprise

mode only)

In Enterprise mode, the Scanner Configuration file (.cxz) is saved on the UCMDB

database (resources for the InventoryDiscovery adapter) as well, using the same file

name as the copy specified in the Configuration File Name to Use field.

The configuration file is a compressed XML file containing the settings for the scanner

you are currently configuring.

When the scanners are used in the Enterprise Mode, they read the configuration from a

separate configuration file. This is a binary file with a .cxz extension. The typical size of

the configuration file is about 3 KB. As the size of the configuration file is significantly

smaller than the size of the complete scanner, a separate scanner configuration is

useful for repetitive inventory collection when the configuration of the scanner has

been altered. In this case only a small configuration file is delivered to the user’s

computer to run with the original scanner instead of delivering the entire new scanner.

Scanners tab

Enables you to select which of the scanners to generate.

Note: Available in Manual Deployment mode only.

User interface elements are described below:

UI Element Description

Generate

Scanners

for

Enables you to select scanners to generate.

Selecting the check box adjacent to scanner enables the scanner.

Click or to enable or disable all of the scanners in the tree

respectively.

Click to reverse the scanners selected. That is, those that were enabled

become disabled, and those that were disabled become enabled.

When you hover over a scanner with the mouse, the status bar under the tree displays

whether the scanner is enabled or disabled, and displays the full scan file name of

where - on the local computer that runs the browser session - the scanner will be

generated.
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Note: (Windows and Linux only) Use the 64-bit version of the scanner when running

the scanner on a 64-bit computer to ensure that data is collected as expected.

Base

Scanner

File Name

The base name of the scanner (up to five characters).

Make sure to use a fully qualified file name

Alternatively, for each scanner, you can either have a file name to identify the operating

system, or you can use a separate directory for each operating system.

The initial part of this file name can be entered in the Base Scanner File Name box. The

remaining three characters of the file name are used to describe the scanner

executable.

For example, by entering scan (the default setting) in the Base Scanner File Name box,

the following scanners can be generated (if they have been selected in the Generate

Scanners For section): 

Scanner File Name Scanner Type

scanwin-x64.exe Windows (x64)

scanwin-x86.exe Windows (x86)

scanwinh-x64.exe Windows (x64, hidden)

scanwinh-x86.exe Windows (x86, hidden)

scansolaris-sparc Solaris (SPARC)

scansolaris-x86 Solaris (x86)

scanhpux-hppa HP-UX (HPPA)

scanhpux-ia64 HP-UX (ia64)

scanaix-ppc AIX (POWER)

scanlinux-x86 Linux (x86)

scanlinux-x64 Linux (x64)

scanmacosx-x86 Mac OS X (x86)

Data Flow Management Guide

Chapter 15: Inventory Discovery

HP Universal CMDB (10.22) Page 652 of 795



UI Element Description

Output

Directory

The directory where the generated scanners are saved.

Output

Directories

The manner in which scanner files are named and stored.

l One Directory. All scanners that are selected are stored in one directory.

l Separate Directories. All scanners that are selected are stored in individual

subdirectories named per the operating system.

Note: Scanner file names are changed to scan.exe.
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Generating Scanners Page

After you have selected the scanners to be generated and have clicked Generate, the last page of the

Scanner Generator wizard is displayed. This page shows the progress information during the generation

of the actual scanner executable.

Important

information

General information about the wizard is available in "Scanner Generator Wizard" on

page 603.

In Enterprise Mode, the scanner configuration is generated instead of stand-alone

scanners, and the configuration is uploaded to the UCMDB server and stored in the

UCMDB database as the Scanner Configuration resource files in the Inventory

Discovery adapter. If you chose to generate your scanner from a stored default

predefined configuration on the server when you were on the Standard Configuration

page, you will be told to rename it, since default predefined configurations cannot be

overwritten.

Right-clicking anywhere in the log window displays a shortcut menu which allows you

to:

l Save the contents of the window to a log file.

l Copy the contents of the log window to the clipboard.

l Clear the log window.

If a scanner already exists with the same name in the chosen directory, a confirmation

message is displayed. This allows you to choose whether to overwrite the existing

scanner.

After the scanners have been generated, click Finish to exit the Scanner Generator.

The generated scanners can be found in the directory specified in the Scanners tab of

the Scanners to Generate page.

Wizard map The "Scanner Generator Wizard" contains:

"Scenario Page" > "Standard Configuration Page" > "Collection Page" > "Hardware Data

Page" > "Software Data Page" > "Software Details Page" > "Asset Data Page" >

"Scanner Options Page" > "Scanners to Generate Page" > Generating Scanners Page
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XML Enricher: Software Recognition Configuration Dialog Box

To

access

Use one of the following:

l Select Data Flow Management > Software Library, and click .

l Select Universal Discovery > Discovery Modules/Jobs > Discovery Modules > Hosts

and Resources > Inventory Discovery > Inventory by Scanner > Properties tab >

Global Configuration Files pane, and double-click EnricherServiceSettings.ini.

l Select Universal Discovery > Discovery Modules/Jobs > Discovery Modules > Hosts

and Resources > Inventory Discovery > Inventory by Scanner > Inventory Discovery

by Manual Scanner Deployment > Properties tab > Global Configuration Files pane,

and double-click EnricherServiceSettings.ini.

l When creating or editing an Inventory Discovery activity, in the Preferences tab click

Mapping Options. For details, see the HP UCMDB Discovery and Integrations Content

Guide.

Related

tasks

"How to Configure XML Enricher to Suit the Probe Deployment Mode" on page 561

See

also

l "XML Enricher" on page 518

l "Enriched Scan File Structure" on page 525

User interface elements are described below:

UI Element (A–Z) Description

Restores the XML Enricher settings to the default setting.

General tab Enables you to set general XML Enrichment options. See "General Tab" below.

SAI Recognition

tab

Enables you determine how the XML Enricher uses the SAI files for application

recognition. See "SAI Recognition Tab".

General Tab

User interface elements are described below:
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Z) Description

Basic l Process Utilization Data. By default this option is set to Yes. If you want to stop

processing utilization data, change this option to No.

l Application Recognition. There are the following options for Application

recognition:

o Software application index (SAI). This is the default setting. Instructs the

XML Enricher to use the Software Application Index files (.zsai) to perform

application recognition. The SAI files contain a database of software

applications. By default, only executable files are sent to the recognition

engine for processing. You can set this so that all files are sent to the

recognition engine by modifying the filter settings. See "Filtering" on page

660.

o No recognition. Disables any application recognition. When recognition is

disabled, scan file processing is slightly faster as no file information is sent

to the recognition engine for processing. However, the processed scan files

are not enriched with application data, and no application data is added to

the UCMDB database.

l Import unrecognized files. By default, this option is set to No. If you want to

use Express Teaching to teach applications, change this option to Yes. For more

information about Express Teaching, see "Express Teaching Overview" on page

702.

Scan File

Management

Enables you to configure how to manage the scan files.

Group Processed Scan Files. The grouping commands help you organize your scan

files in the processed directory. You can group your scan files based on the value of

the hardware fields collected by the Scanners. For example, if the grouping is done

on the hwHostOS field, all scan files for computers having the same operating

systems are grouped in the corresponding directory for that operating system.

Clicking the button opens the Scan File Group dialog box, enabling you to create

a scan file group:

l Group processed scan files by hardware field. Select a hardware field from

the drop-down list.Details of the field are displayed in the Detail pane.
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UI Element (A–

Z) Description

Note: The value of the selected hardware field is used as the name of a

subdirectory under the Processed directory. If the chosen field is blank in a

scan file, that file is moved to a Blank directory.

l Value to use if hardware field is blank. Because the directory name cannot

be empty, when the value of the selected hardware field is empty, the string

configured in this field is used instead to name the subdirectory.

SAI Recognition Tab

User interface elements are described below:

SAI Files Enables you to specify the SAI files that the XML Enricher uses to recognize

applications. The master SAI set comes with the latest Content Pack and is

available in the sai.zip package. For details about deploying your own SAI files, see

"SAI Files Pane" on page 692.

l <SAI Files grid>.For each SAI file that appears in the list, the following

information is displayed:

o Use. Specifies whether an SAI file is used by the XML Enricher. The

XML Enricher only uses the selected SAI files.

o Name. The name of the SAI file.

o ID. The ID for the user SAI file.

Note: Because a master SAI file does not have an ID, it displays an ID of

N/A. Each user SAI receives an integer ID on creation. The ID must be

unique within the organization. The UD tools (including XML Enricher and

Inventory Tools) need all user SAIs they load to have a different ID. It is

therefore important to ensure IDs are unique.

o Size. The size (in kilobytes)

o Type. The file type: Master (read-only) or User (editable)
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o Date.

l Master SAI files: The date the file was created.

l User SAI files: The date the file was last saved.

o Description. The description given to the SAI file when it was created.

l SAI File Used to Store Rule-Created Items. Specifies the SAI file to which

items created by rules are added. These rules are present within the SAI files

themselves. You can specify additional rules by using the SAI Editor.

If this field is left blank, Universal Discovery creates a file called Auto.zsai and

puts this in the same location as the first Master SAI.

Note:

o For descriptions of SAI files, see "Software Application Index (SAI) Files"

on page 520.

o For more information about SAI files and the process of application

recognition, see the SAI Editor documentation.

Advanced

SAI Options

Determine how the XML Enricher performs the SAI application recognition. The

available options are as follows:

l Level 3 recognition heuristics. This option determines when the XML Enricher

processes scan files for a particular machine.

o Yes. The XML Enricher waits until all the files in all the directories on that

machine have been read before issuing its final recognition information.

More accurate recognition is achieved.

o No. Machine-based recognition does not take place, and recognition data is

returned after each directory is loaded.

A time overhead of about 10% is normal when Level 3 recognition heuristics is

enabled.

Default: Yes.

l Auto-identify unrecognized device driver file.
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If this option is set to Yes, it instructs the XML Enricher to mark files that meet

the following criteria as recognized in the enriched scan file:

o They cannot be identified by standard SAI recognition.

o They have the Device Driver attribute.

Files used as Device Drivers represent a large portion of the files that are not

identified by the Application Library. Being able to identify these automatically

can significantly reduce the effort required to achieve good recognition rates.

Default: Yes.

l Override OS language. Works in conjunction with the Preferred language

option (below). If you specify a Preferred language, and you set the Override

OS language option to Yes, the recognition engine overlooks the OS locale

setting and uses the Preferred language that you specify.

Default: No

l Report multiple installations of the same version. Specifies whether to

report multiple instances of the same application version that are installed.

Default: No

Note: If a user wants to report multiple installations of the same version

software, set the correct scan configurations for Inventory Discovery by

Scanner job so that scanner can collect enough information into a scan file.

l Preferred language. Enables you to specify the language that the XML Enricher

uses when it encounters more than one language version of the same

application. For example: if there are two application versions in the SAI (one

English and one French) that are very similar, or the same in terms of the

comprising files, setting the preferred language to French favors French

applications if the recognition ratings for these application versions are the

same.

This option works in conjunction with the Override OS Language option (above).

Default: Neutral. No preferred language is set.
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Filtering Determines what types of files the XML Enricher processes:

l Use only files with the following extensions. Specifies the extensions of the

particular file types processed by the XML Enricher. Type the extensions that

you want to use directly into the box. Separate extensions with commas or

semicolons. Only these file types are processed.

l Use only executable files. Specifies that only executable files should be

processed by the recognition engine. This includes *.exe, *.com, *.dll and other

files containing executable code.

Default: Yes

l Look also for files within archives. Specifies that files within archive files

should be processed. The following archive file types are supported: ARJ, ZIP

v1, ZIP v2, LHA, LZH, ARC, CAB, TAR, GZIP, TAR/GZIP, and PAK.

Default: No

l Regular expressions used to filter junk files. Some files may be executable

but are of no interest for licensing or other purposes. These files are often

identifiable by file name. For example: TMP[0-9]*\.\$\$\$. This option enables

you to specify file names that should be ignored by the XML Enricher. Do this by

entering regular expressions in the multi-line edit box - one expression on each

line. Files whose names match the regular expressions are ignored.

When the XML Enricher matches a file name against a junk filter regular

expression, the file name is first converted to lowercase. For this reason, all

letters entered as part of the regular expression must be in lowercase for a

match to successfully occur.
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Chapter 16: Just-In-Time Discovery
This chapter includes:

Just-In-Time Discovery Overview 661

How to Configure Just-In-Time Discovery 661

Just-In-Time Discovery Overview

Universal Discovery integrates with RUM to provide real time, passive discovery and monitoring of

topology changes in a given environment. This is known as the Just-In-Time (JIT) discovery mechanism.

One or more RUM Engines can be configured to interact with Universal Discovery's Data Flow Probes.

The RUM Engine gathers information from RUM Probes in its network, and passes relevant information

on to the Data Flow Probes. From the Universal Discovery perspective, the RUM Engines behave as

passive discovery probes, where the Data Flow Probes are the active probes.

The passive probes also send notifications about discovered information to the Data Flow Probes.

Notifications can include, for example, changes in environment topology, such as an unseen IP address,

or software that is not running. You configure these notifications in Universal Discovery. Based on these

notifications, the Data Flow Probes report, add, or remove relevant CIs to or from the UCMDB Server, or

designate them as candidates for deletion.

For details about setting up the passive discovery probes and running JIT Discovery, see "How to

Configure Just-In-Time Discovery" below.

How to Configure Just-In-Time Discovery

This task describes how to set up Just-in-Time discovery to provide passive, real-time discovery and

monitoring of traffic in a given environment.

To learn more about Just-In-Time discovery, see "Just-In-Time Discovery Overview" above.

1. Prerequisites

HP Real User Monitor (HP RUM) version 9.20 or later must be installed on a separate server, and

must be running and configured to integrate with a Data Flow Probe.
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Note: The HP RUM Installation can be downloaded from HP Software Support

(https://softwaresupport.hp.com). Search for BAC Real User Monitor.

To configure HP RUM to integrate with a Data Flow Probe:

a. In HP RUM, select Configuration > UD Probe Connection Settings.

b. Enter the host name of the Data Flow Probe to which the RUM Engine is to report, and port

through which it is to send data to the Data Flow Probe.

c. Select a connection protocol.

d. Leave Authentication, Proxy, and SSL settings empty.

e. Save your configuration.

2. Configure passive discovery probe notifications and removal verification policy

a. In Data Flow Management > Data Flow Probe Setup >, select the domain where the passive

discovery probe (RUM Engine) resides.

b. In the Domain and Probes pane, click Passive Discovery Probes.

c. In the Passive Discovery Probes Pane configure the passive probe notification options and

removal verification policy. For details see "Passive Discovery Probes Pane" on page 114.

d. In the Domains and Probes pane select the passive discovery probe that you want to configure

e. In the Passive Discovery Probe details > Passive Discovery  Integrated Ranges pane,

configure the ranges over which the passive discovery probe should perform discovery, and

the ports it should monitor. For details, see "Passive Discovery Probe Details Pane" on page
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117.

f. Ensure that the passive probe status is Connected, If it is suspended, click the Resume Probe

button in the Domains and Probes pane toolbar.

3. Activate passive Just-in-Time discovery

a. Go to the Universal Discovery > Discovery Modules/Jobs tab.

b. Under Network Infrastructure > JIT Discovery select JIT Passive Discovery.

c. Click the Activate Selected Discovery Jobs button. When the passive probes are

activated, they download configuration (ranges and notifications) and start to report

notifications to the Data Flow Probe.
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Chapter 17: Discovery Progress and Results
This chapter includes:

Managing Problems With Error Reporting 664

Data Validation on the Data Flow Probe 665

Filtering Discovery Results 666

How to View the Current Status of Discovered CIs 667

How to Find Discovery Errors 667

How to Manage Discovery Errors 668

How to Enable Content Data Validation 669

Content Data Validation Jython Scripts 670

Discovery Progress and Results User Interface 672

Managing Problems With Error Reporting

During discovery, many errors may be uncovered, for example, connection failures, hardware problems,

exceptions, time-outs, and so on. You can drill down from the Trigger CI that caused the problem to view

the error message itself.

DFM differentiates between errors that can be ignored (for example, an unreachable host) and errors

that must be dealt with (for example, credential problems or missing configuration or DLL files).

Moreover, DFM reports errors once, even if the same error occurs on successive runs, and reports an

error even if it occurs once only.

For details on severity levels, see "Error Severity Levels" in the HP Universal CMDB Developer Reference

Guide.

Error Table in Database

All DFM errors are saved to the discovery_problems table in the Probe Manager database schema. (The

error information is saved to the database—and is not handled in the Probe's memory—to guarantee

delivery to the server.) The Probe holds the latest list of problems for each Trigger CI. After each run,
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the Probe checks for changes and reports them in the Discovery Progress pane. For details, see

"Discovery Progress Dialog Box" on page 677.

Data Validation on the Data Flow Probe

After discovery or integration, results are processed, each one verifying a different aspect of the

outgoing discovery result - class model validation, redundant results validation, and so on. This is called

the result processing chain.

This section includes:

l "Class Model Data Validation" below

l "Content Data Validation" on the next page

Class Model Data Validation

The CIT model resides on the Data Flow Probe (as well as in the CMDB). This enables data validation to

take place on the Probe when receiving data from services. Problems are generated for a specific

Trigger CI and displayed to the user.

The following validation takes place on the Probe:

l The CIT of the CI is compared to that in the CIT model.

l The CI is checked to verify that all key attributes are present (on condition that the CmdbObjectId

attribute is not defined).

l The CI's attributes are checked to verify that they are all defined in the CIT.

All invalid attributes raise an error, which reports on a specific CI. When the Probe finds invalid data that

is related to the CITs, all data that the Probe has collected on that CI is dropped by the Probe and is not

sent to the server.

See also: "Server-Side Data Normalization" on page 765.

For details on attributes, see CI Type Attributes in the HP Universal CMDB Modeling Guide.
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Content Data Validation

Content that comes out-of-the-box with the Discovery and Integrations Content Pack uses standard

libraries. However, user-defined packages might not be compatible with the standard APIs and can send

invalid data to the UCMDB server.

To provide strong validation for data reported to the UCMDB server, UCMDB allows for additional

content data validation before the data is sent to the UCMDB server, and indication of any invalid data.

To perform content data validation, you can create validation Jython scripts and specify them in the

dedicated configuration file, dataValidationlibs.xml.

The Content Data Validation module loads and executes sets of Jython scripts defined in the

dataValidationlibs.xml file. The content data validation Jython scripts should contain the ValidateData

function, which is the entry point for data validation execution.

For details about how to configure the content data validation Jython scripts, and for some examples,

see "Content Data Validation Jython Scripts" on page 670.

To enable or disable Content data validation in UCMDB, see "How to Enable Content Data Validation" on

page 669.

Filtering Discovery Results

You can filter results sent by the Probe to the HP Universal CMDB server. You would probably need to

filter irrelevant data regularly during production runs and specifically when you are testing a limited

environment.

There are two levels of filtering:

l Adapter filtering. The Probe filters the results for a specific adapter and sends to the CMDB only

those filtered CIs. You define an adapter filter in the Results Management pane in the Adapter

Configuration tab. For details, see "Adapter Configuration Tab" on page 252.

l Global filtering. Universal Discovery filters the results of all jobs running on a Probe. You define

global filters in the globalFiltering.xml file. For details, see "Configure Filtering Using the

globalFiltering.xml File" on page 221 or "Configure Filtering in UCMDB" on page 577.

The order of filtering is as follows:
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1. During a discovery run, the Data Flow Probe first searches for an adapter filter and applies the

filter to the results of the run.

2. If there are no adapter filters, Universal Discovery searches for a global filter and applies that filter

to the results.

3. If no filters are found, all results are sent to the UCMDB Server.

How to View the Current Status of Discovered CIs

This task describes how to view the current status of discovered CIs.

1. Prerequisites

Verify that the Probe is enabled and is connected to the HP Universal CMDB server. For details, see

"How to Start a Data Flow Probe" on page 42.

2. Access Data Flow Probe status

a. Go to Data Flow Management > Data Flow Probe Status.

b. Select a connected Probe, and click .

The Progress list displays the current status of every job that ran or is running on the Probe.

For details about the information displayed, see "Data Flow Probe Status Window" on page 134.

c. To view details about a particular job, select the job in the Progress list and click the View Job

progress button. For details about the properties displayed, see "<Job Name> Dialog Box"

on page 133.

How to Find Discovery Errors

This task describes how to investigate problems that arise during discovery.

Note: For details about severity levels and so on, see "Managing Problems With Error Reporting" on

page 664.
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1. Prerequisites

Set up DFM. For details, see "Data Flow Management Setup" on page 28.

2. Select the Module/Job

You can view error messages for one job, one module, or all modules. For details on running a job,

see "How to Run Module/Job-based Discovery" on page 463.

3. Locate the Problem CI

Use the Discovery Progress user interface to drill down to the error messages. For details, see

"Discovery Progress Dialog Box" on page 677.

Example of an error message:

How to Manage Discovery Errors

This task describes how to investigate problems that arise during a discovery run.

Note: For details about severity levels and so on, see "Managing Problems With Error Reporting" on

page 664.

1. Prerequisites

Set up DFM. For details, see "Data Flow Management Setup" on page 28

2. Run the discovery job

You can view error messages for one job, one module, or all modules. For details on running a job,

see "How to Run Module/Job-based Discovery" on page 463.

3. Locate the problem CI
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Use the Discovery Progress pane to drill down to the error messages. For details, see "Discovery

Progress Dialog Box" on page 677.

Example:

DFM displays the error message:

4. Troubleshoot the problem

o For Fatal errors, you should contact HP Software Support.

o For other errors, check the CIs. For example, a Trigger CI that does not fall within the Probe's

range may show an error.

o For details on setting communication logs, see "Execution Options Pane" on page 253.

o For details on managing problems, see "Managing Problems With Error Reporting" on page 664.

How to Enable Content Data Validation

This task describes how to enable or disable the execution of content data validation.

1. In the DataFlowProbe.properties file (located in c:\hp\UCMDB\DataFlowProbe\conf), set the

appilog.agent.local.process.result.dataValidation.content parameter as follows:

o true. Enables content data validation (default)

o false. Disables content data validation

2. Restart the Probe to update the changes.

3. If you are enabling validation, ensure that your content data validation configuration file,

dataValidationlibs.xml, is defined with the necessary Jython and library scripts. For details, see

"Content Data Validation Jython Scripts" on the next page.

For more information about Content Data Validation, see "Content Data Validation" on page 666.
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Note: The value given to the appilog.agent.local.process.result.dataValidation.content

parameter in the DataFlowProbe.properties file can be overridden on an adapter level by adding

the \"enableContentDataValidation\" parameter to the adapter parameters. If this parameter is

absent among the adapter parameters (by default), the value defined in the

DataFlowProbe.properties file is used.

Content Data Validation Jython Scripts

The Content Data Validation Jython scripts are divided into main scripts and library scripts. Each "main"

script must have the ValidateData function which is the entry point for the execution of data validation.

The ValidateData function has the following parameters:

l TaskResults. Provides the API accessing data objects.

l Environment. Provides the API for accessing Environment information, such as the Probe Gateway

name, the Probe Gateway IP, and the domain name.

The dataValidationlibs.xml file is a configuration file where you define which scripts to execute and

which to execute as libraries. The file is divided into sections which logically define the data validation

execution.

Example of the dataValidationlibs.xml File

<datavalidation parserClassName="com.hp.ucmdb.discovery.
library.communication.downloader.cfgfiles.
ContentDataValidationConfigFile">

<script name="dataValidator1.py">

<library name="validator1.py"/>

</script>

<script name="dataValidator2.py" cit="Node,Process">

<library name="validator2.py"/>

<library name="validator3.py"/>

</script>

</datavalidation>

where:
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l validator<x>.py is a library script.

Libraries must be ordered according to their dependency. In this example, validator3.py uses

validator2.py, so validator3.py appears after first validator2.py.

l The cit parameter lists the CITs that the script receives for validation. In this example, the

dataValidator2.py script receives only Node and Process CITs for validation.

Handling Errors and Warnings

l addError/addWarning. Use this API from the TaskResults parameter to attach error/warning to

triggered CIs. Bulk is reported to the UCMDB server.

l raise ContentDataValidationException. Use to report an error message if the bulk should be

discarded.

Example of API Usage

l Main Script

#dataValidator1.py

import validator1

def ValidateData(TaskResults, Environment):

logger.info('probe gateway is :', Environment.
getProbeGatewayID())

logger.info('probe gateway ip is :', Environment.
getProbeGatewayIP())

logger.info('probe domain is :', Environment.
getProbeManagerDomain())

objectsForUpdate = TaskResults.getResultObjects()

size = objectsForUpdate.size()

if size > 0:

for i in range(0, size):
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object = objectsForUpdate.get(i)

validator1.validate(object, TaskResults)

if object.getObjectClass() == 'host':

TaskResults.addError(100, 'host CIT is not in class
model')

pass

l Library Script

#validator1.py

from com.hp.ucmdb.discovery.library.results.resultprocess import
ContentDataValidationException

def validate(object, TaskResults):

if object.getAttribute('description') == None:

TaskResults.addWarning(100, 'No description set for the object
of type ' + object.getObjectClass())

if object.getAttribute('host_hostkey') == None:

// fatal error, all bulk and all previous errors will be removed
from bulk

// this error will be shown in UI

raise ContentDataValidationException, 'Attribute host_hostkey is
absent'

Discovery Progress and Results User Interface

This section includes:

Choose CIs to Add Dialog Box 673

Discovered/Created/Last Updated CIs Dialog Box 674

Discovery Progress Dialog Box 677

Discovery Results Tab/Pane 686
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Related CIs Window 689

Show Results for Triggered CI Dialog Box 690

Choose CIs to Add Dialog Box

Enables you to choose CIs to run with selected jobs.

To access Select Discovery Progress > Drill down to the CI instances, and click the Add CI

button.

For more details, see "Discovery Progress Dialog Box" on page 677.

Relevant

tasks

l "How to Find Discovery Errors" on page 667

l "How to Manage Discovery Errors" on page 668

l "How to Run Module/Job-based Discovery" on page 463

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

l "Managing Problems With Error Reporting" on page 664

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI

Element

(A–Z) Description

Adds the CI to the list of triggers that run with the discovery job.

Note: If you choose CIs with an error status, a message is displayed when you add

the CI.

Search CIs Contains filters with which you can limit the number of CIs that appear in the Search

Results pane.

l . Displays the search results.

l By Discovery Query. Select a Discovery query to search for those CIs that match the

query.
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UI

Element

(A–Z) Description

l Show only CIs containing. To search for CIs that include a certain text, enter the

text here.

l Exact match. Select to search for CIs with the exact match of the text label. (By

default, you search by entering part of a text. For example, searching for 10 within

the IP CIs finds all the IPs that contain 10 in their address. Entering 10 then selecting

Exact match finds no results.)

Search

Results

Displays a list of triggered CIs answering to the criteria set in the filter. To add the CIs to

the list in the triggered CIs pane, select the CIs. You can make multiple selections.

l CIT. The CI type of the selected triggered CI.

l CI. The label of the triggered CI.

l Related Host. The label for the node related to the triggered CI.

l Related IPs. The IPs of the related node.

l Reported. The time that the CI was reported.

Page. The list of CIs is divided into pages. The number in the Page box indicates which

page is currently displayed. To view other pages, use the up and down arrows, or type

the page number, and press Enter.

To determine the number of CIs that appear on a page, right-click the up or down button

and choose the required number. The default is 25.

Discovered/Created/Last Updated CIs Dialog Box

The Discovered CIs dialog box enables you to view all CI instances found for a selected query node.

The Created/Last Updated CIs dialog boxes enable you to view all CI instances that were created or

updated during the last discovery run.

The Created by <Job> dialog box displays the CI instances created when running a selected job.

To access These dialog boxes are accessible from various places in the Universal Discovery

window, and all display information about discovered CI instances.
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l A job's Dependency Map tab. Right-click a CI, a job or a relationship. For more

information, see "Discovery Module/Jobs – Dependency Map Tab" on page 484.

l Discovery progress: Drill down to a CI and click Show additional data .

l Discovery Results: Select a CI and click View Created/Updated Instances .

Important

Information

When viewing discovery results, the CI instances displayed are retrieved from the

server when this dialog box opens. The number of CIs may differ from the number of

CIs displayed in the Results pane because some created CIs may have been merged or

deleted since they were created by the job.

Relevant

tasks

l "How to Find Discovery Errors" on page 667

l "How to Manage Discovery Errors" on page 668

l "How to Run Module/Job-based Discovery" on page 463

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

l "Managing Problems With Error Reporting" on page 664

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

Specify the CIT you want displayed in the table. The table also includes

the children of the selected CIT.

Delete from CMDB. Deletes the selected CI from the database.

Properties. Opens the Configuration Item Properties dialog box for the

selected CI.

Refresh. Refreshes the list of CI instances.

Set Filter. Filters the CI instances you want to display for the selected

discovery. Opens the Filter CI Instances dialog box.

Clear Filter. Clears the filter definitions you created in the Filter CI

Instances dialog box.
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UI Element (A-Z) Description

Select Columns. Enables you to select the columns to be displayed. For

details, see "Select Columns Dialog Box" in the HP Universal CMDB

Modeling Guide.

Enables you to set the sort order of the CI instances. For details, see

"Sort Column Content Dialog Box" in the HP Universal CMDB Modeling

Guide.

Find. Displays the Find toolbar.

Send Mail. Enables you to send the table data in an email.

Choose the export format for the table data. The available options are:

l Excel. The table data is formatted as an .xls (Excel) file that can be

displayed in a spreadsheet.

l PDF. The table data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of

columns to display to ensure that the report is legible.

l CSV. The table data is formatted as a comma-separated values (CSV)

text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the

comma (,) must be defined as the list separator. In Windows, to

verify or modify the list separator value, open Regional Options

from the Control Panel, and on the Numbers tab ensure that the

comma is defined as the List Separator value. In Linux, you can

specify the list separator in the application that opens the CSV

file.

l XML. The table data is formatted as an XML file that can be opened

in a text or XML editor.

Tip: To extract HTML code from the report:

o Save the file as HTML
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UI Element (A-Z) Description

o Open the file in an HTML editor

o Copy the relevant table into the target file

Rows per page Select the number of rows to be displayed on each page. You can also

manually enter value for the number of rows per page.

Click to navigate through the results page by page or to jump to the first

or last page.

<CI Instances> The CI instances created during the discovery. You can double-click an

instance to open the Configuration Item Properties dialog box for that

CI.

<CI instances shortcut

menu>

For details, see "IT Universe Manager Shortcut Menu" in the HP Universal

CMDB Modeling Guide.

Discovery Progress Dialog Box

This dialog box displays the progress of running discoveries, and enables you to drill down to discovered

CI instances.

To access Use one of the following:

l In the CI Instances dialog box, right-click a CI instance, click Actions, and select

Show Discovery Progress.

l Select Data Flow Management > Universal Discovery:

o Zone-based Discovery tab > a node in the tree > Discovery Status pane (on

the right) > Progress tab.

o Discovery Modules/Jobs tab > a node in the tree > Details tab (on the right)

> Discovery Progress pane.

Important

information

The discovery progress information displayed is the last status known by the UCMDB

server for each job Trigger CI within the context selected for discovery.

Relevant

tasks

l How to Check the Status of Application Discovery (Rediscover a View) in the HP

Universal CMDB Modeling Guide.

l "How to Find Discovery Errors" on page 667
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l "How to Manage Discovery Errors" on page 668

l "How to Run Module/Job-based Discovery" on page 463

See also l Error Messages Overview in the HP Universal CMDB Developer Reference Guide

l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

l "Managing Problems With Error Reporting" on page 664

Triggered CIs View - Progress/Status Matrix

Displays the status of triggered CIs through the progress of discovery.

UI Element

(A-Z) Description

Refresh. Refreshes the matrix.

Add CI. Opens the Choose CIs to Add dialog box, enabling you to add a newly-

discovered CI to the triggered CI list. For details, see "Choose CIs to Add Dialog Box" on

page 673.

Available: Discovery Modules/Jobs view only, when you select a module/job.

Rerun Discovery. Enables you to rerun the selected discovery modules/jobs.

/ Pause / Resume. Enables you to pause or resume the selected discovery

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are finished

o all the execution information is retained, including errors

l Jobs are paused based on their defined job execution policies. For details, see

"Job Execution Policies" on page 36.
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UI Element

(A-Z) Description

Available: Discovery Modules/Jobs view only

Progress

bar

Displays the percentage of new trigger CIs that have completed the discovery process

for the set of jobs contained within the focus area that you have selected for discovery

since the last time the activity was modified.

Note: When you activate discovery, the trigger CIs list are prepared. During this

time, discovery progress may not be reflected immediately.

Thereafter, discovery progress is automatically refreshed every 30 seconds.

Understanding the Progress/Status Matrix and the Progress Bar

Progress

Status Total

Pending

Probe

Displays the total

number of trigger

CIs waiting for the

Probe to pick them

up for execution.

Displays the

number of

triggered CIs

successfully

waiting for the

Probe to pick them

up for execution.

-- --

Reached

Probe

Displays the total

number of

triggered CIs that

reached the Probe,

and may have

started running.

Displays the

number of

triggered CIs that

successfully

reached the Probe,

and may have

started running.

Displays the

number of

triggered CIs that

successfully

reached the Probe

and have started

running, but have

warnings.

--

Completed Displays the total

number of

triggered CIs that

completed running

(successfully or

Displays the

number of

triggered CIs that

successfully

completed

Displays the

number of

triggered CIs that

successfully

completed

Displays the number

of triggered CIs that

failed to complete

running, did not reach

the Probe, or were
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Progress

Status Total

unsuccessfully). running. running, but have

warnings.

not picked up by the

Probe for execution.

Total Displays the total

number of

triggered CIs.

Displays the total

number of

successful

triggered CIs.

Displays the total

number of

triggered CIs that

were successful,

but had warnings

Displays the total

number of failed

triggered CIs.

Note: When discovery is kicked off by schedule, as opposed to manually being started, trigger CIs

that have completed at least once do not go back into Pending Probe and Reached Probe status,

and are therefore not reflected in the Pending Probe and Reached Probe rows of the

Progress/Status Matrix. However, when consecutive runs of the trigger CIs complete, their statuses

are reflected in the appropriate status column of the Completed row of the matrix.

Similarly, since the progress bar displays the percentage of completed trigger CIs, the progress bar

does not change unless new trigger CIs are dispatched or an existing trigger CI is manually rerun.

CI Count View

Clicking a link in the Triggered CIs view enables you to view the number of triggered CIs for each

discovery job that have reached the selected stage of discovery and with the selected status.

Important

Information

In the Discovery Modules/Jobs view, the CI Count job is displayed only when standing on

a module which contains 2 or more jobs. If there is only one job in the module, clicking

the triggered CI displays the CI Instances view.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element

(A-Z) Description

Up one level. Enables you to go back to the Triggered CIs view.

Show triggered CIs. Enables you to drill down to individual triggered CIs.

Refresh. Refreshes the table.
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UI Element

(A-Z) Description

Remove CI. Deletes the selected CI. The CI is deleted from the specific job or activity

job.

Available: Discovery Modules/Jobs view only, when you select a module category and

select a job.

Rerun Discovery. Enables you to rerun the selected discovery jobs. The execution

complies to the defined execution policy for the relevant discovery jobs.

/ Pause / Resume. Enables you to pause/resume a selected job.

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are finished

o all the execution information is retained, including errors

l Jobs are paused based on their defined job execution policies. For details, see

"Job Execution Policies" on page 36.

Available: Discovery Modules/Jobs view only

CI Count Displays the number of triggered CI per job that have reached the selected stage of

discovery and with the selected status.

Job Name Displays the list of jobs that have reached the selected stage of discovery and with the

selected status.

Show

errors

/Show

warnings

Displays the Triggered CIs > Completed with Errors / Completed Successfully with

Warnings view, listing all error/warning messages, their related jobs, severity, and

count information.

The Show errors option is available for links in the Failures column of the

Triggered CIs view only.

The Show warnings option is available for links in the Failures column of the

Triggered CIs view only.
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UI Element

(A-Z) Description

Right-clicking an error message from the Completed with Errors view or a warning

message from the Completed Successfully with Warnings view enables you to do the

following:

l Remove CI

l Rerun Discovery

l Show All <Error Message> Issues. Displays all similar discovery issues related to a

specific job, thus allowing you to view all CIs impacted by this particular discovery

issue.

Available:

o Available only when accessing the Discovery Progress dialog box from IT

Universe Manager.

o Available for all users with the View Discovery Status and Error and Show

Discovery Progress permissions.

CI Instances View

Clicking a job in the CI Count view displays the triggered CIs for that discovery job.

UI

Element

(A-Z) Description

Up one level. Enables you to move up a level of information.

Refresh. Refreshes the list of triggered CIs.

Add CI. Opens the Choose CIs to Add dialog box, enabling you to add a newly-discovered CI

to the triggered CI list. For details, see "Choose CIs to Add Dialog Box" on page 673.

Available: Discovery Modules/Jobs view only

Remove CI. Deletes the selected CI. The CI is deleted from the specific job or activity job.
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UI

Element

(A-Z) Description

Available: Discovery Modules/Jobs view only

Filter CIs. Enables you to filter the displayed CIs.

l By Status. Available only when viewing the CIs of a particular discovery job in the

Discovery Module/Jobs view.

o All. Displays all the Trigger CIs.

o Waiting for Probe. Displays the Trigger CIs that are ready to be dispatched and

are waiting for the Probe to retrieve them.

o In Progress. Displays the Trigger CIs that are active and are running on the Probe.

o In progress (being removed). Displays the Trigger CIs that are being removed

from the Trigger CIs list.

o Success, Failed, Warning. Displays only those CIs that have the selected status.

l By Probe. Displays only the CIs triggered by a selected probe/cluster. Click to open

the Select Probes dialog box.

l By Dispatch Type. Displays a list of CIs according to one of the following options:

o All. Displays both CIs that are used to manually activate the job and Discovery TQL

queries that are used to automatically activate the job.

o Manually Added. Displays the CIs that are used to manually activate the job.

o By Discovery Query. Displays the CIs that are used to automatically activate the

job.

l Reset. Click to remove any filters.

Show Message. When there are warnings/errors,opens a message box containing all the

warning/error messages for the triggered CI.

Show additional data. Opens the Discovered CIs dialog box, enabling you to view

additional information about the CI. For details, see "Discovered/Created/Last Updated

CIs Dialog Box" on page 674.
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UI

Element

(A-Z) Description

Show results for triggered CI. An ad hoc request is sent to the Data Flow Probe and

retrieves the latest results of the job (CIT name and number of discovered CIs) that is

running on a specific trigger CI.

This ad hoc request does not run the job, but brings the results of the previous job run

that are stored in the Probe's database. If the job has not yet run for this trigger CI, a

message is displayed. See "Show Results for Triggered CI Dialog Box" on page 690.

If no communication log exists on the Probe, a message is displayed. You can choose to

always create communication logs. For details, see "Adapter Configuration Tab" on page

252.

Rerun Discovery. Enables you to rerun the discovery on the selected CI.

/ Pause / Resume. Enables you to pause/resume a selected discovery.

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are finished

o all the execution information is retained, including errors

l Jobs are paused based on their defined job execution policies. For details, see

"Job Execution Policies" on page 36.

Available: Discovery Modules/Jobs view only

Look for To search for a specific Probe, related host, or related IP, enter part of its name in the

box and click the button.

<CI

Instances

table>

Displays all the CI instances discovered by selected job. You can drill down into any CI

instance. If triggered CIs failed, or succeeded with warnings, you can drill down further to

better understand the cause for the warning or failure.

<right-

click

In addition to some of the functionality described above, right-clicking a CI enables you to

do the following:
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UI

Element

(A-Z) Description

menu> l Debug. Enables you to debug a CI. You can:

o View Communication Log. View the communication log.

o Go to Adapter. Go directly to the job's adapter

o Go to Job. Go directly to the job's details (Discovery Modules/Jobs view only)

o Edit Script. Select a script to edit

o Rerun discovery

l Enable Communication Log.Creates a log file for this session. The log file

contains information about the connection between the Probe and a remote

machine.

Note: To capture results about the connection, see the Enable

Communication Log And Record Results option on this menu.

l Enable Communication Log And Record Results. Creates a log file for this

session. The log file contains information about the connection between the

Probe and a remote machine. Additionally, it enables capturing the discovered

results; these discovered results may help in investigating various discovery

problems.

l Enable Scanner Debug Log. Used for most scanner debugging purposes.

l Enable Scanner Trace Log. Used for more comprehensive scanner debugging

purposes.

Note: Communication log files are created on the Probe Manager under the

C:\hp\UCMDB\DataFlowProbe\runtime\

communicationLog folder. For details on how the communication logs work,

see Record DFM Code in the HP Universal CMDB Developer Reference Guide.

l Download Scanner Log. Saves the debug or trace log to a specified location.
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UI

Element

(A-Z) Description

If a log for the selected CI is unavailable, enable the debug or trace log using the

Rerun Discovery menu option.

l Run from step.

Enables you to manually run the job on the selected CI from a particular step in the

job's workflow. This is useful if you do not want to rerun the whole discovery job on

the CI, but only a part of it.

Note:

o The workflow steps are defined in the job’s adapter file. You can view or edit

the workflow in the Adapter Definition tab for the relevant adapter. For

details, see "Adapter Definition Tab" on page 244.

o You cannot run the job from particular step if the status of the CI is Waiting

for probe or In Progress.

Available: In the Discovery Modules/Jobs view; For CIs that trigger workflow-based

jobs

l Reprocess Scan File. Reprocesses the scan files of the selected CI.

Available: In the Discovery Modules/Jobs view; For CIs that trigger workflow-based

jobs

Discovery Results Tab/Pane

This tab/pane displays the discovery results from discovery job runs or from discovery activities that ran

in Management Zones.

To access Select Data Flow Management > Universal Discovery:

l Zone-based Discovery tab > a node in the tree > Discovery Status pane (on the

right) > Results tab.

l Discovery Modules/Jobs tab> a node in the tree > Details tab (on the right)
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> Discovery Results pane.

Important

Information

UCMDB includes a purging mechanism for managing old discovery result statistics. This

mechanism enables faster display of discovery result statuses. That is, the old result

records are merged and are therefore still available for the user. This feature is

controlled by two system parameters:

l appilog.collectors.ResetDiscoveryStatisticsIntervalHours.name=Reset Discovery

Statistics Interval by Hours. This property defines the interval of merging

discovery results (the interval for running the purging mechanism).

l appilog.collectors.DiscoveryStatisticsArchiveDays.name=Discovery results

statistics archive period. This property defines the number of days after which

discovery results are archived (the number of days after which the statistics are

considered old).

Relevant

tasks

l "How to Find Discovery Errors" on page 667

l "How to Manage Discovery Errors" on page 668

l "How to Run Module/Job-based Discovery" on page 463

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

l "Managing Problems With Error Reporting" on page 664

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI

Element

(A–Z) Description

Refresh. Retrieves the latest discovery results from the server (job results are not

automatically updated in the Results pane).

View Instances. Displays all new and updated CIs. Select a CIT and click:

l View Created Instances to view CIs created during the discovery

l View Updated Instance to view CIs updated during the discovery

Note: When you double-click a row, created CI instances are displayed.
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UI

Element

(A–Z) Description

Available: When the discovery results include created or updated instances.

Select the time range or Probe for which to display discovery results and statistics.

l By Time Range:

o All. Displays results for all job runs.

o From Now/Last Minute/Last Hour/Last Day/Last Week. Choose a period of time

for which to display results.

o Custom Range. Opens the Change Timeframe dialog box where you can enter the

date or choose a From and To date and time from the calendar. Click Now to

enter the current date and time. Click Last Day to enter the current date and

time in the To box and yesterday's date and time in the From box. Click OK to save

the changes.

l By Probe: To view results by Probe, select to open the Choose Probe dialog box.

Selecting All Data Flow Probes displays the results for all of the Data Flow Probes.

Show all declared CI Types. By default, only discovered CITs are listed in the table; the

Discovered CIs column includes CITs if the number of CIs found is greater than zero. Click

the button to display every CI that can be discovered by the job, even if the Discovered

CIs value is zero:

<Results

grid>

Displays the discovery results and statistics.

l CIT. The name of the discovered CIT.

You can configure discovery so that any object reported by the job and whose CIT is

not defined in the adapter's discovered CITs list is marked in red. Objects include

those added by the Probe result mechanism.

To set this parameter:
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UI

Element

(A–Z) Description

a. Select Administration > Infrastructure Settings Manager.

b. Select the General Settings category.

c. Locate the Enable statistics results validation according to adapter parameter.

d. Change the value to True.

l Created. The number of CIT instances created in the period selected or for the

selected Probe.

l Deleted. The number of CIT instances deleted in the period selected or for the

selected Probe

l Discovered CIs. The number of CIs that were discovered for each CI type.

l Total. The total number of CIs in each column.

l Updated. The number of CIT instances that were updated in the period selected.

Filter The time range set with the Set Time Range button.

Last

updated

The date and time that the Results grid was last updated.

Related CIsWindow

Enables you to view, in map format, the CIs that are related to a selected CI.

To access In the Discovered CIs dialog box, right-click a CIT and select Get Related CIs.

Important Information Related CIs are CIs that are the parent, child, or sibling of an existing CI.

Relevant tasks l "How to Find Discovery Errors" on page 667

l "How to Manage Discovery Errors" on page 668

l "How to Run Module/Job-based Discovery" on page 463

See also l "Universal Discovery Overview" on page 415

Data Flow Management Guide

Chapter 17: Discovery Progress and Results

HP Universal CMDB (10.22) Page 689 of 795



l "Modules/Jobs-based Discovery Overview" on page 460

l "Managing Problems With Error Reporting" on page 664

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<right-click

menu>

For details, see "Shortcut Menu" in the HP Universal CMDB Modeling Guide.

<menu> For details, see "Toolbar Options" in the HP Universal CMDB Modeling Guide.

<Topology Map> For details, see "Topology Map Overview" in the HP Universal CMDB Modeling

Guide.

Show Results for Triggered CI Dialog Box

Enables you to view the results of running an ad hoc request to the Probe. Discovery acquires the

results by running the job on a selected Trigger CI. In the case of an error, a message is displayed.

To access Select Discovery Progress > Drill down to the CI Instances, right-click a CI, and select

Show Results for Triggered CI.

Relevant

tasks

l "How to Find Discovery Errors" on page 667

l "How to Manage Discovery Errors" on page 668

l "How to Run Module/Job-based Discovery" on page 463

See also l "Universal Discovery Overview" on page 415

l "Modules/Jobs-based Discovery Overview" on page 460

l "Managing Problems With Error Reporting" on page 664

User interface elements are described below:

UI Element

(A-Z) Description

Select a CIT and click to display additional information in the Show Results for

Triggered CI dialog box.
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UI Element

(A-Z) Description

Click to open a topology map showing a result map for the Triggered CI. Right-click a

CIT to view its properties.
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Chapter 18: Software Library
This chapter includes:

Software Library Overview 692

Software Library User Interface 692

Software Library Overview

The Software Library Viewer enables you to view the contents of Software Application Index (SAI) files

that are contained in the UCMDB software library. Additionally, you can export, import, and also deploy

SAI files to the Data Flow Probe.

Software Library User Interface

This chapter includes:

SAI Files Pane 692

Software Library Window 694

Advanced Search Dialog Box 700

SAI Files Pane

This pane enables you to view the all of the SAI files that are contained in UCMDB.

To access Data Flow Management > Software Library

Important

information

Highlight an SAI file and view related information about that file in the Applications

pane and the Details pane.

Tip: Highlight multiple SAI files to see related information about all the files in the

Details pane.

Note: By default, the last SAI file that was used by the user is displayed, or the
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default global SAI file is displayed. To set a default SAI file, update the parameter

in Infrastructure Settings Manager Page in the HP Universal CMDB Administration

Guide.

Relevant

tasks

"How to Teach Applications Using Express Teaching Wizard" on page 703

See also "Express Teaching Overview" on page 702

UI

Element Description

New SAI File. Enables you to perform the following:

l New SAI file. Opens the New SAI dialog box enabling you to create a new user SAI file.

Note: Newly-created files take a few minutes to create before you can teach to

the file.

Delete. Deletes the selected User SAI file.

Export. Exports the selected SAI file.

Import. Enables you to select a method to import SAI file information to the UCMDB server.

l Import SAI file. Opens the Import SAI dialog box, enabling you to import a User SAI file

or an archive (.zip) file to UCMDB. In the dialog box, ensure that you click the file type

drop-down button to select the correct file type.

Note: User SAI files on the Data Flow Probe are overwritten. This action cannot be

undone.

l Import SAI from CP. Opens the Import SAI from CP dialog box, enabling you to import

the master SAI files only that are contained in a Content Pack Update archive file.

Advanced Search.

Refresh. Refreshes the information that is displayed in the pane.
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UI

Element Description

Note: Perform this after you import master SAI files from a Content Pack Update to

UCMDB.

Deploy. Deploys the selected User SAI file to a Data Flow Probe from UCMDB.

Opens the Express Teaching wizard, enabling you to teach applications to Universal

Discovery. For more information, see "Express Teaching Overview" on page 702.

Available when: A user SAI file is selected.

Not available when: Multiple user SAI files are selected.

Note: The user SAI file that is selected is the file that is used when using Express

Teaching.

Opens the Software Recognition Configuration wizard. For more information, see "XML

Enricher: Software Recognition Configuration Dialog Box" on page 655.

Software Library Window

This window enables you to view the contents of the SAI files that are contained in the UCMDB software

library, including details about publishers and applications.

To access Select Data Flow Management > Software Library.

Important

information

l Previously-selected SAI files are selected by default. Otherwise, the first SAI file

that is displayed is selected.

l To view SAI file details and statistics for multiple SAI files, select at least two SAI

files in the SAI pane.

l The following iconography appears in multiple panes:

. Indicates a Master SAI file.

. Indicates a User SAI file.

. Indicates a publisher.
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. Indicates an application.

. Indicates a User SAI file is being created and will be ready in a few minutes.

While this icon is displayed, Express Teaching is disabled for this file.

Relevant

tasks

"How to Teach Applications Using Express Teaching Wizard" on page 703

See also "Express Teaching Overview" on page 702

SAI Pane

The SAI pane displays the list of SAI files that are contained in UCMDB.

User interface elements are described below:

UI

Element Description

New SAI File. Opens the New SAI dialog box, enabling you to create a new user SAI file.

Note:

l Newly-created files take a few minutes to create before you can teach to the file.

l You do not need to type in a file type suffix.

l Valid characters are: a-z, A-Z, 0-9, blank space, underline and hyphen.

Delete. Deletes the selected user SAI file.

Export. Exports the selected SAI file.

Import. Opens an Import SAI dialog box, enabling you to import SAI file information to the

UCMDB server.

l Import SAI file. Opens the Import SAI dialog box, enabling you to import a User SAI file

or an archive (.zip) file to UCMDB. In the dialog box, ensure that you click the file type

drop-down button to select the correct file type.

Note: User SAI files on the Data Flow Probe are overwritten if the files have the

same file names. This action cannot be undone.
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UI

Element Description

l Import SAI from CP. Opens the Import SAI from CP dialog box, enabling you to import

the master SAI files only that are contained in a Content Pack Update archive file.

Advanced Search. Opens the Advanced Search dialog box, enabling you to find detailed

information that is contained in SAI files. For more information, see "Advanced Search

Dialog Box" on page 700.

Refresh. Refreshes the information that is displayed in the pane.

Note: Perform this after you import SAI files from a Content Pack Update to UCMDB.

Deploy. Deploys the selected user SAI file from UCMDB to Data Flow Probe servers.

Available when: User SAI files that contain newly-taught applications which have not been

deployed to the Data Flow Probe.

Opens the Express Teaching Wizard, enabling you to teach applications to Universal

Discovery. For more information, see "Express Teaching Overview" on page 702.

Available when: A user SAI file is selected and ready for teaching.

Not available when: Multiple SAI files are selected.

Note: The user SAI file that is selected is the file that is used when using Express

Teaching.

Opens the Software Recognition Configuration Wizard, enabling you to set options for scan

file recognition. For more information, see "XML Enricher: Software Recognition

Configuration Dialog Box" on page 655.

Publishers and Applications Pane

The Publishers and Applications pane displays publisher and application information that are contained

in the selected SAI files.

Important information Available when: Only one SAI file is selected in the SAI pane.

User interface elements are described below:
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UI Element Description

Refresh. Refreshes the information that is displayed in the pane.

Note: Perform this after you import master SAI files from a Content Pack update

to UCMDB.

Expands the contents of the directory tree enabling you to view the applications.

Collapses the contents of the directory tree and hides the applications.

Details Pane

The Details pane displays detailed information about the selected SAI file, the selected publisher, and

the selected application.

Important

information

l Contains multiple sub-panes and contains multiple tabs depending on your

selection in the Publishers and Applications pane.

l To see the SAI file details and statistics of an SAI file, select an SAI file or SAI files in

the SAI Files pane. Ensure the root of the Publishers and Applications pane is

selected.

l To see details of a publisher, select an SAI file in the SAI pane and also select a

publisher in the Publishers and Applications pane.

l To see details of an application, select an SAI file in the SAI Files pane and also

select an application in the Publishers and Applications pane.

l Some tabs are displayed only when an SAI file is selected in the SAI pane and the

root of the Publishers and Applications pane is selected.

User interface elements are described below:

UI Element Description

Details Tab Displays sub-panes that show detailed information about the selected SAI file.

Note: The information contained in these tabs are displayed in tabular form

when multiple SAI files are selected in the SAI pane.
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UI Element Description

The following sub-panes are displayed:

l SAI File Details. Displays detailed information about a selected SAI or application.

o Name. Name of the SAI file.

o Description. Description of the SAI file.

o ID. ID number of the SAI file.

o Date. For master SAI files, the date the SAI file was released. For user SAI files,

the creation date.

o Type. Type of the SAI file.

l Possible values: Master or User.

o In Use. Specifies whether the SAI file is used by the XML Enricher to enrich scan

files.

l Statistics. Displays statistics about the selected SAI file or SAI files that are

selected in the SAI pane.

o Publishers. Number of publishers.

o Applications. Number of applications.

o Versions. Number of versions.

o Releases. Number of releases.

o Package Rules. Number of package rules.

o Version Data Rules. Number of version data rules.

Application

Types Tab

Displays application types that help you to identify the different types of software

that are contained in the selected SAI file.

Operating

Systems Tab

Displays the names of the operating systems that are contained in the selected SAI

file.

Languages

Tab

Displays the languages that are contained in the selected SAI file.
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UI Element Description

File Based

Tab

Displays sub-panes that show detailed information about applications and their

release and version information.

Available when:An application is selected in the Publishers and Applications pane.

The following sub-panes are displayed:

l Application Details Pane. Displays detailed information about the application.

l Release and Versions Pane. Displays release and version details.

o Releases. Displays the releases that are associated with the application.

o Versions. Displays any versions that are associated with the selected release

in the Releases sub-pane.

o Licensing Releases. Displays the releases that the selected application

licenses. For example, a Microsoft Office suite.

o Licensed Releases. Displays any releases that are licensed by the selected

application. For example, Microsoft Word.

Rule Based

Tab

Displays sub-panes that show package rule and version rule information about the

selected SAI file.

Available when:An application is selected in the Publishers and Applications pane .

The following sub-panes are displayed:

Package Rules Pane and Version Data Rules Pane.

l Commercial. Commercial or license type of the package or application.

l Language. Language of the package or application.

l Package Name. Name of the package or application used to recognize the

application.

l Package Type. File type of the application package.

l Operating System. Operating system on which the package or application runs.

l Release Match. Scan file data field that contains the release information, and

also the regular expression used to extract the release information.
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UI Element Description

l Version Match. Scan file data field that contains the version information, and also

the regular expression used to extract the version information.

Note: All version data rules are for Windows only.

Advanced Search Dialog Box

This dialog box enables you to find information contained in the SAI files that are in the UCMDB software

library.

To access
Select Data Flow Management > Software Library, and click .

Relevant tasks "How to Import SAIs to the Data Flow Probe" on page 567

See also "Software Library Window" on page 694

UI Element Description

Search for

words

Enter an alphanumeric string to search.

Note:

l Auto-complete is enabled.

l Limited approximate string matching is enabled. For example, "microsoft" is

returned when you type "micro" or "soft". However, "microsoft" is not returned

when you type "microsoftx" or "xmicrosoft"

Tip: Click the drop-down menu to see previous search strings.

Executes the search.

Available when:  All required search criteria have been met.

Scope Specifies the SAI files that you want to include in your search.

Default: The selected SAI file in the SAI pane is pre-populated. Use the browse

button to select or deselect SAI files.
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UI Element Description

Opens the Search Scope dialog box, enabling you to select the SAI files that you

want to search.

Search in Select at least one of the following information items to include in your search:

l Publisher Name

l Application Name

l Release Name

l Version Name

l File Name

Limit to

results

Specifies the maximum number of results for your search.

Default: Unlimited

Go to Displays the location of the search result in the Publishers and Applications pane

of the Software Library.

Available when: A search result row is selected.
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Chapter 19: Express Teaching
This chapter includes:

Express Teaching Overview 702

Unrecognized Files 702

How to Teach Applications Using Express Teaching Wizard 703

How to Deploy User SAI Files 705

How to Clean Up Unrecognized Files 705

How to Clean Up Aged Unrecognized Files 706

How to Send a Publisher File to HP 707

Express Teaching User Interface 708

Express Teaching Overview

Express Teaching is a wizard that improves application recognition by increasing the amount of

applications that are recognized on discovery nodes. Express Teaching is a web-based, lighter

alternative to teaching applications than SAI Editor or Analysis Workbench.

Note: For Windows only.

During the teaching process, information contained in unrecognized files is matched to information

contained in Software Application Index (SAI) files. When the wizard is completed and you are finished

with all of your teaching updates, then you deploy your updates to the Data Flow Probes.

To teach applications using the Express Teaching wizard, see "How to Teach Applications Using Express

Teaching Wizard" on the next page.

Unrecognized Files

Unrecognized files are files that are stored on remote machines and not recognized by Universal

Discovery. The information about these files are usually imported and stored by the Data Flow Probe.
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For more information on how to configure the XML Enricher to import unrecognized files, see "XML

Enricher: Software Recognition Configuration Dialog Box" on page 655.

Periodically, you may want to remove unrecognized files for the following reasons:

l Large amounts of unrecognized files are causing performance problems

l Large amounts of unrecognized files are consuming large amounts of hard drive space

l You have deleted a Node CI instance for a node, and you want to remove unrecognized files that are

associated with the deleted node

You can remove all unrecognized files, or you can remove unrecognized files that reach an aging

threshold.

To clean up all unrecognized files, see "How to Clean Up Unrecognized Files" on page 705.

To clean up aged unrecognized files, see "How to Clean Up Aged Unrecognized Files" on page 706.

How to Teach Applications Using Express Teaching Wizard

This task describes how to teach applications to Universal Discovery using the Express Teaching wizard.

1. Prerequisites

Ensure that the Data Flow Probe is installed and running.

2. Configure the XML Enricher Service

Ensure that the XML Enricher service that is running on the Data Flow Probe is configured to import

unrecognized files.

To do this, In the Software Recognition Configuration Dialog Box, select import unrecognized files.

For more information, see "XML Enricher: Software Recognition Configuration Dialog Box" on page

655.

3. Run Inventory Discovery

For more information about setting up inventory discovery, see the HP UCMDB Discovery and

Integrations Content Guide.

4. Teach applications
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Start the Express Teaching Wizard to teach applications to Universal Discovery. Teaching

applications ensure better application recognition during inventory discovery. To do this, see

"Express Teaching Wizard" on page 708.

5. Deploy the SAI file

Tip: If you plan to teach more than one application, skip this step. When you are finished

teaching applications, perform this step.

After teaching applications, deploy the SAI delta file to the Data Flow Probe. To do this, see "How to

Deploy User SAI Files" on the next page.

6. Enrich scan files- Optional

You can reprocess scan files that are currently on the Data Flow Probe. When you do this,scan files

that were created from the last Inventory Discovery job are enriched with information about the

applications that you taught in step 4. Additionally, the unrecognized files that were associated

with those taught applications are immediately removed from the unrecognized files list in Express

Teaching Wizard.

To reprocess scan files, see "Processing Scan Files" on page 516.

Alternatively, you can wait to see results until the next Inventory Discovery job occurs.

7. Results

o The files that you used to teach applications should not appear in "Select Files Page" on page

711.

o Verify that the taught application has been recognized and reported to UCMDB. To do this, go to

Modeling > CI Type Manager. Under NodeElement, right-click the Installed Software CIT and

select Show CIT Instances.

o If teaching did not yield the expected results, use the SAI Editor inventory tool. For more

information, see "Inventory Tools" on page 530.
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How to Deploy User SAI Files

This task describes how to deploy User SAI files to Data Flow Probes after using the Express Teaching

wizard.

1. Prerequisites

You used the Express Teaching wizard and want to deploy one of more User SAI files to Data Flow

Probes.

Note: The XML Enricher service on the Data Flow Probe may be restarted after you perform

this task.

2. Select a file

a. In Data Flow Management, go to the Software Library module and click . The User SAI dialog

box opens.

b. From the list, select the User SAI files you want to deploy to the Data Flow Probe. Alternatively,

to deploy all User SAI files that have been created since the last deploy operation, select

Deploy all User SAI files.

3. Deploy the SAI file

Click Deploy to deploy the selected User SAI files to the Data Flow Probes.

4. Results

Verify the deployment is successful by viewing the User SAI file at the following location on the

Data Flow Probe machine: 

c:\hp\UCMDB\DataFlowProbe\\runtime\probeManager\discoverySaiResources\saiRuntime

How to Clean Up Unrecognized Files

This task describes how to remove unrecognized files from the Data Flow Probe.
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1. Clear all the data from the Data Flow Probe

Run the clearprobedata.bat script. For details, see "How to Clear Data Flow Probe Data" on page

58.

2. Results

All unrecognized files are deleted from the Data Flow Probe.

How to Clean Up Aged Unrecognized Files

This task describes how to configure the Data Flow Probe to automatically remove unrecognized files

that have not been used to recognize applications and are no longer needed to store.

1. Locate the file

Locate the DataFlowProbe.properties file in the following folder:

C:\hp\UCMDB\DataFlowProbe\conf

2. Set the aging threshold

Find the UnrecognizedFileExpirationTime parameter and change the value to the number of days

that the Data Flow Probe waits before deleting unrecognized files.

Note:

o Default: 30 days

o The value should be longer than the longest interval used for inventory scanning.

3. Restart the Data Flow Probe service

Restart the Data Flow Probe. To do this, see "How to Start a Data Flow Probe" on page 42.

4. Results

Unrecognized files are deleted.
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How to Send a Publisher File to HP

This task describes how to export the vendors_mapping.properties file and send it to HP Support. This

file contains normalization information about publishers/vendors. You should perform this task

periodically and after you use the Express Teaching wizard.

This task includes the following steps:

1. "Prerequisites " below

2. "Locate the file" below

3. "Export the file" below

4. "Send the file to HP" below

5. "Result" below

1. Prerequisites

You have recently used the Express Teaching wizard.

2. Locate the file

In Adapter Management expand Inventory Discovery, expand Configuration Files, and then click

vendors_mapping.properties. The file contents are displayed in the right pane.

3. Export the file

a. Click to open the file in an external editor. For example, Notepad.

b. In the Full Path field, type or browse an external editor executable file.

c. Save the file as a text file.

4. Send the file to HP

Open an HP Support ticket and send the file.

5. Result

The file is included in the next Discovery and Integration Content Pack. For more information, see

the HP UCMDB Discovery and Integrations Content Guide.
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Express Teaching User Interface

This chapter includes:

Express Teaching Wizard 708

Express Teaching Wizard

This wizard enables you to teach applications to Universal Discovery using information from

unrecognized files.

To access Select Data Flow Management > Software Library, and click in the SAI Files pane.

Important

information

l Ensure XML Enricher is configured to import unrecognized files. For more

information, see "XML Enricher: Software Recognition Configuration Dialog Box" on

page 655.

l Ensure that a recent Inventory Discovery job has run. For more information, see

"Inventory Discovery Activity in the HP UCMDB Universal Discovery Content Guide -

Discovery Activities.

l Ensure the Data Flow Probe is connected and running.

Relevant

tasks

"How to Teach Applications Using Express Teaching Wizard" on page 703

Wizard map "Select a Probe Page" > "Select an Application Page" > "Select Files Page" > "Select

Application Details Page" > "Review Data Page" > "Summary Page"

See also "Express Teaching Overview" on page 702

Select a Probe Page

This page enables you to select a Data Flow Probe to perform application teaching.

Important

information

l If there are multiple domains in your environment, click the domain name to

expand the list of Data Flow Probes running in that domain.

l If you receive the "no unrecognized files" message, review the Important

information section of "Express Teaching Wizard" above.
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l Ensure you select the Data Flow Probe that corresponds to the IP range for the

application.

Wizard map Select a Probe Page > "Select an Application Page" > "Select Files Page" > "Select

Application Details Page" > "Review Data Page" > "Summary Page"

Relevant

tasks

"How to Teach Applications Using Express Teaching Wizard" on page 703

See also "Express Teaching Overview" on page 702

User interface elements are described as follows:

UI Element Description

Domains and Probes Select a Data Flow Probe.

Note: For more information, see "Data Flow Probe Setup Window" on

page 89.

Select an Application Page

This page enables you to select an application that you want to teach.

Note: The displayed applications are derived from meta data that are contained in unrecognized

files on the Data Flow Probe that you selected on "Select a Probe Page" on the previous page.

Important

information

l Use one of the following methods to find applications that you want to teach:

o If you know which application or publisher you want to teach, type this

information into the appropriate fields and then click Search.

o If you want to see the entire list of applications that are associated with

unrecognized files, click Search.

l Limited approximate string matching is automatically enabled for the Application

Name and Publisher fields. For example, "Xadobe" and "adobeX" are both returned

when you type "adobe".

Wizard map "Select a Probe Page" > Select an Application Page > "Select Files Page" > "Select

Application Details Page" > "Review Data Page" > "Summary Page"
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Relevant

tasks

"How to Teach Applications Using Express Teaching Wizard" on page 703

See also "Express Teaching Overview" on page 702

User interface elements are described as follows:

UI Element

(A-Z) Description

Application

Name

Column. Applications that are associated with unrecognized files.

Text Field. Type the name of an application that you want to teach and then click

Search. For more information on how to enter information in this field, see the

Important information section.

Description Additional information about the application that is associated with unrecognized files.

File Count Number of unrecognized files that are associated with the application.

Note: The value in this column reflects the number of unnormalized files that are

associated with the application.

Minimum

nodes

Enables you to filter the results by clicking or selecting a minimum number of nodes

where the unrecognized files were scanned.

Node Count Number of nodes where at least one unrecognized file was scanned.

Publisher Column. Publisher names that are associated with unrecognized files.

Text Field. Type the name of the publisher you want to teach and click Search.

Alternatively, click to open the Publisher dialog box where you can select from a list

of all publishers.

For more information on how to enter information in this field, see the Important

information section.

Note: Publisher names are normalized. Therefore, publisher names may appear

slightly differently.

Click to open the Publisher dialog box and display a list of all publishers.

Tip: To improve normalization of publishers, see "How to Send a Publisher File to
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UI Element

(A-Z) Description

HP " on page 707.

Version Version number that is associated with the application.

Note:  This may be different to the version of the file associated with the

application.

Select Files Page

This page enables you to specify which files to use to teach the application.

Important

information

l At least one file must be selected.

l To select all files, select the check box at the top.

l Selecting a main file is recommended. Main files identify the application. An

application can have multiple main files, but normally there is only one. If a Main file

is found, the application is considered present.

Wizard map "Select a Probe Page" > "Select an Application Page" > Select Files Page > "Select

Application Details Page" > "Review Data Page" > "Summary Page"

Relevant

tasks

"How to Teach Applications Using Express Teaching Wizard" on page 703

See also "Express Teaching Overview" on page 702

User interface elements are described as follows:

UI Element Description

File Name Column. Names of files that are associated with the application.

Text Field. The name of the selected file.

File Size Column. Size of the files (in kilobytes) that are associated with the application.

Text Field. The size of the selected file (in kilobytes).
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UI Element Description

Note: N/A appears when Care About Size is set to No.

Care About

Size

Yes. The size of the file is used as a recognition criterion.

Default: Yes.

No. The size of the file is not used as a recognition criterion. As a result, only the match

on the file name is needed to produce a successful file match. Moreover, the

application is recognized only if the file is a main file.

Relation to

App

Indicates the relationship between the file that is selected and the application.

By default, the first executable file that is found which is associated with the

application is marked as Main.

l Main. Indicates that an application is installed when this file is detected.

l Associated. Indicates that a file may belong to an application but does not

necessarily require a license.

l 3rd party. Indicates a file that is included with the application but is produced by a

third party.

File

information

tab

Displays detailed information about files for the selected unrecognized file in the top

pane.

l File Type. Type of the executable file. For example, Win32.exe, where exe is the

file type.

l Product Version. Application version number associated with the application.

Note:  This may be different than the file version of the file that is associated

with the application.

l Product Name. Name of the application that is associated with the selected file.

l File Version. Version number of the selected file.

l Publisher. Publisher name that is associated with the selected file.

l File Signature. A checksum of the first 8 kilobytes of a file.
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UI Element Description

l Description. Additional information about the selected file.

File source

tab

Displays the normalized list of scan file names that contain the selected unrecognized

files.

Select Application Details Page

This page enables you to select details for the application. You can also create new application details.

Important

information

l All fields on the main page are mandatory.

l Operating System and Language fields are automatically set according to the

version that is selected.

l (Applicable for all fields) If the name in the meta data of the unrecognized file was

successfully matched to an entry in the SAI, the name will be highlighted in the

search results. If there is no match, no entry is highlighted and you must select

another variation of the name or create a new entry.

Wizard map "Select a Probe Page" > "Select an Application Page" > "Select Files Page" > Select

Application Details Page > "Review Data Page" > "Summary Page"

Relevant

tasks

"How to Teach Applications Using Express Teaching Wizard" on page 703

See also "Express Teaching Overview" on page 702

User interface elements are described as follows:

UI Element

(A-Z) Description

Application The name of the application that you want to teach.

Available when: A publisher is selected.

. Opens the Application dialog box, enabling you to filter by application name and

select another variation of the application name.

Note: This list contains unnormalized data.
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UI Element

(A-Z) Description

. Opens the New Application dialog box, enabling you to create a new application.

Type a name and a description. From the drop down list, select an application type

which is stored as an attribute for the application. Then, select the application you just

created.

Publisher The publisher name of the application.

. Opens the Publisher dialog box, enabling you to filter by publisher name and select

another variation of the publisher name from the unnormalized list.

. Opens the New Publisher dialog box, enabling you to create a new publisher. Type a

name and description.

Release The release number for the application.

Available when: An application is selected.

. Opens the Releases dialog box, enabling you to filter by releases and select

another release.

. Opens the New Release dialog box, enabling you to create a new release. Type a

name.

Version Version number for the application.

Available when: A release is selected.

Review Data Page

This enables you to review information about the application before the information is saved.

Wizard

map

"Select a Probe Page" > "Select an Application Page" > "Select Files Page" > "Select

Application Details Page" > Review Data Page > "Summary Page"

Relevant

tasks

"How to Teach Applications Using Express Teaching Wizard" on page 703

See also "Express Teaching Overview" on page 702
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Summary Page

This page enables you to view the details of the application that was saved to the user SAI file.

Wizard

map

"Select a Probe Page" > "Select an Application Page" > "Select Files Page" > "Select

Application Details Page" > "Review Data Page" > Summary Page

Relevant

tasks

"How to Teach Applications Using Express Teaching Wizard" on page 703

See also "Express Teaching Overview" on page 702

User interface elements are described as follows:

UI

Element

(A-Z) Description

Continue Starts the Express Teaching wizard again so you can teach more applications.

Finish Closes the Express Teaching wizard. When you are finished teaching, deploy your updates

to the Data Flow Probe. To do this, see "How to Deploy User SAI Files" on page 705.

Note: You may want to improve publisher/vendor normalization by sending a file to

HP Support. For more information, see "How to Send a Publisher File to HP " on page

707.
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Chapter 20: Software License Compliancy

Software License Compliancy Overview 716

Software Utilization 716

How to Calculate License Compliancy for IBM 717

How to Calculate Licenses for Oracle 720

How to Configure Software Utilization 720

Software License Compliancy Overview

Universal Discovery helps manage your software costs and license compliancy obligations by identifying

software inventory, measuring use activity, and automatically linking complex licensing and licensed

application relationships. These activities enable your organization to better align software spending

with business priorities. Moreover, tracking and maintaining software license information ensures that

only the allowed number of licenses are in use, and that there are enough licenses for everyone using

the software. This is often used when limited license counts are available to avoid violating strict license

controls.

Universal Discovery builds relationships between licensed and licensing installed applications.

Additionally, Hewlett-Packard provides documentation to help you calculate your license obligations for

the following installed software packages:

l IBM. See "How to Calculate License Compliancy for IBM" on the next page.

l Oracle. See "How to Calculate Licenses for Oracle" on page 720.

To run a report that shows relationships between licensed and licensing applications, see Application

License Report in the HP Universal CMDB Modeling Guide.

To calculate software use activity, see "How to Configure Software Utilization" on page 720.

Software Utilization

Universal Discovery can collect information about the software that is used on discovery nodes. The

information that is collected can be used to optimize software license costs, for example, by eliminating
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unused or under-utilized software installations.

Software Utilization data shows the number of days that an application was used (as a percentage) over

a period of time.

Universal Discovery includes a plug-in that collects software utilization data by monitoring the

processes that are running on the discovery node. There is a separate file for each day, and there is also

a file that contains aggregated utilization information for a utilization period. This summary file is an

XML file called discusg.cxu. It is encoded using UTF-8 and then compressed using the gzip file format.

When a discovery node is scanned, the Scanner collects a copy of the discusg.cxu file and stores its

content in the scan file in a folder called Software Utilization Data. Then, the XML Enricher extracts

and processes the software utilization data. The XML Enricher does the following during its processing:

l Extracts and parses the XML data out of the stored file.

l Calculates the software utilization for each recognized application and adds this information to the

enriched scan file.

l Adds a Utilized flag to the file attributes.

Tip: From a software recognition perspective, any files that appear in the scan file that are

unknown and have a high software utilization rate should be marked for teaching. For more

information about Application Teaching, see "Application Teaching" on page 522.

For more information, see "How to Configure Software Utilization" on page 720.

To see platform-specific file location information for software utilization data files, see "Universal

Discovery Agent File Locations" on page 183.

For details on how to view software utilization data by using Inventory Tools, see "Inventory Tools" on

page 530.

For more information on how software utilization data is reported, see Reports in the HP Universal

CMDB Modeling Guide.

How to Calculate License Compliancy for IBM

You can calculate your license compliancy position for the IBM software packages using the Processor

Value Unit, which is a unit of measure used to differentiate licensing of IBM software on distributed

processor technologies. The number of required licenses per processor is determined by multiplying the

number of processor chips where IBM software is installed by the number of cores per chip. Then, the

resulting value is multiplied by a processor value unit multiplier that IBM provides.
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You can also see reports on PVU values if you configure adapters to push certain data to Asset

Manager. For more information, see the section describing integrations in the HP UCMDB Discovery and

Integrations Content Guide.

Note: License calculations of full capacity (non-virtualized) environments are supported only.

This task includes the following steps:

1. "Locate the scan file data that you want to use for the calculation" below

2. "Find the processor value unit " on the next page

1. Locate the scan file data that you want to use for the calculation

Open a scan file using Viewer. For more information, see "Inventory Tools" on page 530. Then,

locate certain data in scan files to determine the vendor and processor technology. To do this,

refer to the following table:

Generic Name

Universal Discovery

Field Name UCMDB CI/Attribute Name

Processor Vendor hwCPUVendor CPU/CPU_Vendor

Processor Name hwCPU_Type CPU/CPU_Specifier

Server Model Number

(required for IBM only)

hwBIOSMachineModel Node/Discovered_Model

Maximum Number of Sockets

per Server

hwPhysicalCPUCount Calculate Raw Count of CPU CI

Instances for Each Node

Processor Model Number hwCPUDescription CPU/CPUType

Processor Type (Cores per

Socket)

hwCPUCoreCount CPU/Core_Number

hwPhysicalCPUCount Calculate Raw Count of CPU CI

Instances for Each Node

Processor Attributes Mapping

Note:

The values of the fields in the Universal Discovery Field Name column can be viewed by

opening a scan file in the Viewer. In the Viewer, the data is contained at Hardware and
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Configuration > Hardware Data > CPU Data > CPUs or BIOS.

The values of the fields in the UCMDB CI/Attribute Name column can be viewed at UCMDB >

Modeling > CI Type Manager. For more information, see "CI Type Manager" in the HP Universal

CMDB Modeling Guide.

Use a search engine to map Server Model Number values in the Universal Discovery column

or the UCMDB CI/Attribute Name column to the Server Model Number column in the IBM

Processor Value Unit table. Enter the value into the search engine and perform basic analysis

to derive the correct value.

The Processor Model Number value is contained in a long string. For example, in the string

"Intel(R) Core (TM) i5 CPU M540 @ 2.53GHz"the Processor Model Number value is "M540". To

find Processor Model Numbers locally on a discovery node, see more information at IBM

Processor Model Number Discovery Guide (http://www-

01.ibm.com/software/lotus/passportadvantage/x86_server_processor_model_number_

discovery_guide.html#windows).

To calculate Processor Type (Cores per Socket) using the corresponding field in the Universal

Discovery Field Name column, use the following calculation:

[hwCPUCoreCount/hwPhysicalCPUCount]

If the value is equal to 1, the processor is a single (one) core processor type.

To calculate Processor Type (Cores per Socket) using the corresponding field in the UCMDB

CI/Attribute Name column, use the following calculation:

[CPU/Core_Number]/Calculate Raw Count of CPU CI Instances for Each Node]

2. Find the processor value unit

Go to the IBM PVU Licensing table to find the processor technology for which you want to calculate

the processor value unit.Then, find the multiplier in the PVUs Per Core column.

Note: Not all processor names are listed in the IBM PVU Licensing table.
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How to Calculate Licenses for Oracle

HP Universal Discovery for Oracle License Management Service allows clients to run an internal Oracle

compliance discovery job which publishes the results within the HP Universal Configuration Management

Database.

For more information, see HP Universal Discovery for Oracle License Management Service.

How to Configure Software Utilization

Configure Software Utilization depending on your method of discovery, and on your discovery node

platform.

To configure software utilization in a Management Zone, perform the following:

Zone-based Discovery

1. Infrastructure Discovery wizard: On the Universal Discovery Agent Deployment page, select a value

for Software Utilization Period.

2. Inventory Discovery wizard: On the Preferences page, select Scanner-based Inventory Discovery

and expand the Mapping Options pane. In the Model per user data when number of users is at

least box, select or enter the number of users.

Note: The default scanner configuration file is already configured to collect utilization data.

However, if you customize the scanner configuration file using the Scanner Generator, on the

Software Details page ensure that Software Utilization is selected. For details on the

Scanner Generator wizard, see "Inventory Discovery Scanners" on page 505.

Manual

l Windows. When installing the UD Agent using the Agent Installation wizard, on the Software

Utilization page, ensure that you select a value for the Software Utilization Period option. For

more details, see "Agent Installation Wizard" on page 168.

l UNIX. Use command line parameters when installing a discovery package on a discovery node. For

more information, see "Universal Discovery Resources for UNIX" on page 178.
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Agentless Discovery

When configuring and deploying discovery resources using manual methods, in the Scanner Generator >

Software Details > "Directories Tab" on page 621, ensure that the select the Software Utilization

option is selected.
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Chapter 21: Business Service Discovery
This chapter includes:

Service Discovery Overview 723

How to Create Service Discovery Activities 724

How to Edit Service Discovery Activities 725

How to Run Service Discovery 725

Service Discovery User Interface 728

Service Discovery Overview

Service Discovery enables you to configure and run activities to discover your business services and

applications. The discovery process starts from a CI that represents the URL of a specified service, and

continues only with other CIs that can potentially be related to the service.

The Service Discovery process builds dependency graphs from the consumer-provider components that

make-up a service, as follows:

1. A business-service CI is connected to the start-point component.

The start-point component is the first CI referred by the URL of the service. This is the URL through

which the service is consumed by users or by other business services.

2. The start-point component is connected to its neighbor components with consumer-provider

relationships.

These neighbor components are the providers that are directly used by the start-point component.

In this context, these neighbor components take on a consumer role.

3. The start-point’s neighbor components (now taking on consumer roles) are connected via

consumer-provider relationships to their own neighbors (their providers).

Discovery recursively connects neighbors to additional neighbors of these neighbors via consumer-

provider relationships, until all the components that make up the service are connected.

Often, a component or running software may be both a consumer and a provider.
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For more information about consumers and providers, see "Providers and Consumers" in the HP

Universal CMDB Developer Reference Guide.

Service Scope

You use service-border rules to define when one service ends and another one starts. These rules

enable the discovery process to categorize consumer-provider relationships as either internal or

external.

l An external consumer-provider relationship connects two components that belong to different

business services.

l An internal consumer-provider relationship connects two components that belong to the same

business service.

The discovery process can report this category for consumer-provider relationships, since it is

populated as the value of an attribute of the consumer-provider relationship.

You can therefore define the service scope to be all the components reachable from the start-point

component by a path made only of internal consumer-provider relationships (that is, only consumer-

provider relationships labeled as internal).

While discovering a service's components, the discovery process halts when it reaches a new provider

that is connected by an external consumer-provider relationship. This means that the discovery process

does not discover a provider's neighbors. To enable this functionality, you must define service-border

rules before you initiate the discovery process.

However, in many cases, you want to discover the service before defining the service-border-rules. You

want to see which components make up the service, and only then define the service-border-rules for

these discovered components. To limit the discovery process and prevent it from endlessly discovery

neighbors of neighbors, use the Hop Limit setting when you create a Service Discovery activity.

How to Create Service Discovery Activities

1. Prerequisites. You must have a valid Automated Service Modeling license to create service

discovery activities.

2. Go to Data Flow Management > Service Discovery.

3. Click . The New Service Discovery Activity dialog box opens.
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4. Enter the details for the new Service Discovery activity.

For more information, see "New/Edit Service Discovery Activity Dialog Box" on page 747.

5. When you are finished, click OK.

How to Edit Service Discovery Activities

1. Go to Data Flow Management > Service Discovery.

2. Select a service discovery activity and click . The Edit Service Discovery Activity dialog box opens.

You can do the following:

o select a different template that contains parameter overrides

o change the activity's scheduling

o Change the maximum number of hops for the activity.

For more information, see "New/Edit Service Discovery Activity Dialog Box" on page 747.

3. When you are finished, click OK.

How to Run Service Discovery

This task describes how to map services and their components.

This task includes the following steps:

l "Prerequisites" on the next page

l "Set up the Data Flow Probes" on the next page

l "Create an activity" on page 727

l "Run an activity" on page 727

l "Monitor the discovery process" on page 727

l "View discovery results" on page 727
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1. Prerequisites

a. Verify that the Data Flow Probe is installed on a Windows machine.

Note: The Data Flow Probe installed on a Linux platform is intended for the CMS Sync

integration only, but not for discovery.

b. Verify that the relevant packages are deployed.

If you need to deploy discovery packages, see "How to Deploy a Package" in the HP Universal

CMDB Administration Guide.

c. Ensure that the Enable Search option is enabled.

To change the status of the Enable Search option, do the following:

i. Select Administration > Infrastructure Settings Manager > General Settings category

> Search Engine Enabled.

ii. Set the value to True.

iii. Restart the UCMDB Server.

2. Set up the Data Flow Probes

o Determine the network range

Determine the network range of the network to be discovered. For details, see "New/Edit Range

Dialog Box" on page 120.

Note:

l You must configure the probe's IP address in the probe range.

l A Service Discovery activity will only try to connect to those IP addresses that may

potentially be relevant for the discovered services, not to every IP address in the range.

Make sure the network range is wide enough and contains all the IP addresses for your

discovered services.

o Set the relevant credentials
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To enable the Data Flow Probes to connect to servers or applications using specific protocols,

you must set the relevant credentials (for example, UD, NTCMD, SNMP, TTY, or WMI). For details

on protocol parameters, see the HP UCMDB Discovery and Integrations Content Guide.

Note: The Data Flow Probe tries to connect to a node by using each credential in turn.

Universal Discovery then saves the successful credential. The next time the Data Flow

Probe connects to this node, it first tries to connect using the successful credential.

3. Create an activity

In the Service Discovery module, create a Service Discovery activity that will model a business

service. For more information, see "How to Create Service Discovery Activities" on page 724.

4. Run an activity

In the Service Discovery module, click Activate to run a Service Discovery activity. For more

information, see "Service Discovery Page" on page 750.

5. Monitor the discovery process

You can monitor CIs being discovered in the discovery job's Discovery Progress pane, or from the

Data Flow Probe Status Window. For details, see:

o "Discovery Progress Dialog Box" on the next page

o "Data Flow Probe Status Window" on page 134

6. View discovery results

o In UCMDB, You can display overall results for a discovery job or you can filter the results by time

range, by Data Flow Probe, or by cluster. Each time you log in to UCMDB and access the Universal

Discovery window, the results are updated so that the data displayed is the latest for the

selected module or job.

For details on viewing discovery results, see "Discovery Status – Results Tab" on page 745.

o You can also view models you have created in the Service Modeling module in the UCMDB

Browser.
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Service Discovery User Interface

This section includes:

Discovery Progress Dialog Box 728

Discovery Status – Progress Tab 736

Discovery Status – Results Tab 745

New/Edit Service Discovery Activity Dialog Box 747

Service Discovery Activity Templates Dialog Box 750

Service Discovery Page 750

Discovery Progress Dialog Box

This dialog box displays the progress of running discover activities, and enables you to drill down to

discovered CI instances.

To access Select Data Flow Management > Service Discovery > a node in the tree > Discovery

Status pane (on the right) > Progress tab.

Important

information

The discovery progress information displayed is the last status known by the UCMDB

server for each job Trigger CI within the context selected for discovery.

Relevant

tasks

l "How to Check the Status of Application Discovery (Rediscover a View)" in the HP

Universal CMDB Modeling Guide.

l "How to Find Discovery Errors" on page 667

l "How to Manage Discovery Errors" on page 668

l "How to Run Service Discovery" on page 725

See also l "Error Messages Overview" in the HP Universal CMDB Developer Reference Guide

l "Service Discovery Overview" on page 723

l "Managing Problems With Error Reporting" on page 664
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Triggered CIs View - Progress/Status Matrix

Displays the status of triggered CIs through the progress of discovery.

UI Element

(A-Z) Description

Refresh. Refreshes the matrix.

Add CI. Opens the Choose CIs to Add dialog box, enabling you to add a newly-

discovered CI to the triggered CI list. For details, see "Choose CIs to Add Dialog Box" on

page 673.

Available: Discovery Modules/Jobs view only, when you select a module/job.

Rerun Discovery. Enables you to rerun the selected discovery modules/jobs.

/ Pause / Resume. Enables you to pause or resume the selected discovery

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are finished

o all the execution information is retained, including errors

l Jobs are paused based on their defined job execution policies. For details, see

"Job Execution Policies" on page 36.

Available: Discovery Modules/Jobs view only

Progress

bar

Displays the percentage of new trigger CIs that have completed the discovery process

for the set of jobs contained within the focus area that you have selected for discovery

since the last time the activity was modified.

Note: When you activate discovery, the trigger CIs list are prepared. During this

time, discovery progress may not be reflected immediately.

Thereafter, discovery progress is automatically refreshed every 30 seconds.
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Understanding the Progress/Status Matrix and the Progress Bar

Progress

Status Total

Pending

Probe

Displays the total

number of trigger

CIs waiting for the

Probe to pick them

up for execution.

Displays the

number of

triggered CIs

successfully

waiting for the

Probe to pick them

up for execution.

-- --

Reached

Probe

Displays the total

number of

triggered CIs that

reached the Probe,

and may have

started running.

Displays the

number of

triggered CIs that

successfully

reached the Probe,

and may have

started running.

Displays the

number of

triggered CIs that

successfully

reached the Probe

and have started

running, but have

warnings.

--

Completed Displays the total

number of

triggered CIs that

completed running

(successfully or

unsuccessfully).

Displays the

number of

triggered CIs that

successfully

completed

running.

Displays the

number of

triggered CIs that

successfully

completed

running, but have

warnings.

Displays the number

of triggered CIs that

failed to complete

running, did not reach

the Probe, or were

not picked up by the

Probe for execution.

Total Displays the total

number of

triggered CIs.

Displays the total

number of

successful

triggered CIs.

Displays the total

number of

triggered CIs that

were successful,

but had warnings

Displays the total

number of failed

triggered CIs.

Note: When discovery is kicked off by schedule, as opposed to manually being started, trigger CIs

that have completed at least once do not go back into Pending Probe and Reached Probe status,

and are therefore not reflected in the Pending Probe and Reached Probe rows of the

Progress/Status Matrix. However, when consecutive runs of the trigger CIs complete, their statuses

are reflected in the appropriate status column of the Completed row of the matrix.
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Similarly, since the progress bar displays the percentage of completed trigger CIs, the progress bar

does not change unless new trigger CIs are dispatched or an existing trigger CI is manually rerun.

CI Count View

Clicking a link in the Triggered CIs view enables you to view the number of triggered CIs for each

discovery job that have reached the selected stage of discovery and with the selected status.

Important

Information

In the Discovery Modules/Jobs view, the CI Count job is displayed only when standing on

a module which contains 2 or more jobs. If there is only one job in the module, clicking

the triggered CI displays the CI Instances view.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI

Element

(A-Z) Description

Up one level. Enables you to go back to the Triggered CIs view.

Show triggered CIs. Enables you to drill down to individual triggered CIs.

Refresh. Refreshes the table.

Remove CI. Deletes the selected CI. The CI is deleted from the specific job or activity job.

Available: Discovery Modules/Jobs view only, when you select a module category and

select a job.

Rerun Discovery. Enables you to rerun the selected discovery jobs. The execution

complies to the defined execution policy for the relevant discovery jobs.

/ Pause / Resume. Enables you to pause/resume a selected job.

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are finished

o all the execution information is retained, including errors
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UI

Element

(A-Z) Description

l Jobs are paused based on their defined job execution policies. For details, see

"Job Execution Policies" on page 36.

Available: Discovery Modules/Jobs view only

CI Count Displays the number of triggered CI per job that have reached the selected stage of

discovery and with the selected status.

Job

Name

Displays the list of jobs that have reached the selected stage of discovery and with the

selected status.

CI Instances View

Clicking a job in the CI Count view displays the triggered CIs for that discovery job.

UI

Element

(A-Z) Description

Up one level. Enables you to move up a level of information.

Refresh. Refreshes the list of triggered CIs.

Add CI. Opens the Choose CIs to Add dialog box, enabling you to add a newly-discovered CI

to the triggered CI list. For details, see "Choose CIs to Add Dialog Box" on page 673.

Available: Discovery Modules/Jobs view only

Remove CI. Deletes the selected CI. The CI is deleted from the specific job or activity job.

Available: Discovery Modules/Jobs view only

Filter CIs. Enables you to filter the displayed CIs.

l By Status. Available only when viewing the CIs of a particular discovery job in the

Discovery Module/Jobs view.

o All. Displays all the Trigger CIs.
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UI

Element

(A-Z) Description

o Waiting for Probe. Displays the Trigger CIs that are ready to be dispatched and

are waiting for the Probe to retrieve them.

o In Progress. Displays the Trigger CIs that are active and are running on the Probe.

o In progress (being removed). Displays the Trigger CIs that are being removed

from the Trigger CIs list.

o Success, Failed, Warning. Displays only those CIs that have the selected status.

l By Probe. Displays only the CIs triggered by a selected probe/cluster. Click to open

the Select Probes dialog box.

l By Dispatch Type. Displays a list of CIs according to one of the following options:

o All. Displays both CIs that are used to manually activate the job and Discovery TQL

queries that are used to automatically activate the job.

o Manually Added. Displays the CIs that are used to manually activate the job.

o By Discovery Query. Displays the CIs that are used to automatically activate the

job.

l Reset. Click to remove any filters.

Show Message. When there are warnings/errors,opens a message box containing all the

warning/error messages for the triggered CI.

Show additional data. Opens the Discovered CIs dialog box, enabling you to view

additional information about the CI. For details, see "Discovered/Created/Last Updated

CIs Dialog Box" on page 674.

Show results for triggered CI. An ad hoc request is sent to the Data Flow Probe and

retrieves the latest results of the job (CIT name and number of discovered CIs) that is

running on a specific trigger CI.

This ad hoc request does not run the job, but brings the results of the previous job run

that are stored in the Probe's database. If the job has not yet run for this trigger CI, a

message is displayed. See "Show Results for Triggered CI Dialog Box" on page 690.
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UI

Element

(A-Z) Description

If no communication log exists on the Probe, a message is displayed. You can choose to

always create communication logs. For details, see "Adapter Configuration Tab" on page

252.

Rerun Discovery. Enables you to rerun the discovery on the selected CI.

/ Pause / Resume. Enables you to pause/resume a selected discovery.

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are finished

o all the execution information is retained, including errors

l Jobs are paused based on their defined job execution policies. For details, see

"Job Execution Policies" on page 36.

Available: Discovery Modules/Jobs view only

Look for To search for a specific Probe, related host, or related IP, enter part of its name in the

box and click the button.

<CI

Instances

table>

Displays all the CI instances discovered by selected job. You can drill down into any CI

instance. If triggered CIs failed, or succeeded with warnings, you can drill down further to

better understand the cause for the warning or failure.

<right-

click

menu>

In addition to some of the functionality described above, right-clicking a CI enables you to

do the following:

l Debug. Enables you to debug a CI. You can:

o View the Communication Log

o Go directly to the job's adapter

o Go directly to the job's details (Discovery Modules/Jobs view only)
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UI

Element

(A-Z) Description

o Select a script to edit

o Rerun discovery

l Enable Communication Log.Creates a log file for this session. The log file

contains information about the connection between the Probe and a remote

machine.

Note: To capture results about the connection, see the Enable

Communication Log And Record Results option on this menu.

l Enable Communication Log And Record Results. Creates a log file for this

session. The log file contains information about the connection between the

Probe and a remote machine. Additionally, it enables capturing the discovered

results; these discovered results may help in investigating various discovery

problems.

l Enable Scanner Debug Log. Used for most scanner debugging purposes.

l Enable Scanner Trace Log. Used for more comprehensive scanner debugging

purposes.

Note: Communication log files are created on the Probe Manager under the

C:\hp\UCMDB\DataFlowProbe\runtime\

communicationLog folder. For details on how the communication logs work,

see "Record DFM Code" in the HP Universal CMDB Developer Reference Guide.

l Download Scanner Log. Saves the debug or trace log to a specified location.

If a log for the selected CI is unavailable, enable the debug or trace log using the

Rerun Discovery menu option.

l Run from step.

Enables you to manually run the job on the selected CI from a particular step in the

job's workflow. This is useful if you do not want to rerun the whole discovery job on
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UI

Element

(A-Z) Description

the CI, but only a part of it.

Note:

o The workflow steps are defined in the job’s adapter file. You can view or edit

the workflow in the Adapter Definition tab for the relevant adapter. For

details, see "Adapter Definition Tab" on page 244.

o You cannot run the job from particular step if the status of the CI is Waiting

for probe or In Progress.

Available: In the Discovery Modules/Jobs view; For CIs that trigger workflow-based

jobs

l Reprocess Scan File. Reprocesses the scan files of the selected CI.

Available: In the Discovery Modules/Jobs view; For CIs that trigger workflow-based

jobs

Discovery Status – Progress Tab

This dialog box displays the progress of running discoveries, and enables you to drill down to discovered

CI instances.

To access Select Data Flow Management > Service Discovery > a node in the tree > Discovery

Status pane (on the right) > Progress tab.

Important

information

The discovery progress information displayed is the last status known by the UCMDB

server for each job Trigger CI within the context selected for discovery.

Relevant

tasks

l "How to Check the Status of Application Discovery (Rediscover a View)" in the HP

Universal CMDB Modeling Guide

l "How to Find Discovery Errors" on page 667

l "How to Manage Discovery Errors" on page 668

l "How to Run Service Discovery" on page 725
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See also l "Error Messages Overview" in the HP Universal CMDB Developer Reference Guide

l "Service Discovery Overview" on page 723

l "Managing Problems With Error Reporting" on page 664

l Service Discovery Errors Report in the HP Universal CMDB Modeling Guide

Triggered CIs View - Progress/Status Matrix

Displays the status of triggered CIs through the progress of discovery.

UI Element

(A-Z) Description

Refresh. Refreshes the matrix.

Add CI. Opens the Choose CIs to Add dialog box, enabling you to add a newly-

discovered CI to the triggered CI list. For details, see "Choose CIs to Add Dialog Box" on

page 673.

Available: Discovery Modules/Jobs view only, when you select a module/job.

Rerun Discovery. Enables you to rerun the selected discovery modules/jobs.

/ Pause / Resume. Enables you to pause or resume the selected discovery

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are finished

o all the execution information is retained, including errors

l Jobs are paused based on their defined job execution policies. For details, see

"Job Execution Policies" on page 36.

Available: Discovery Modules/Jobs view only

Progress

bar

Displays the percentage of new trigger CIs that have completed the discovery process

for the set of jobs contained within the focus area that you have selected for discovery
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UI Element

(A-Z) Description

since the last time the activity was modified.

Note: When you activate discovery, the trigger CIs list are prepared. During this

time, discovery progress may not be reflected immediately.

Thereafter, discovery progress is automatically refreshed every 30 seconds.

During the discovery process, you may receive the following message: The progress

status does not reflect the latest changes, since the activity is waiting for some of

its triggers to rerun.

When you see this message, although the progress bar shows 100% completion, the

discovery of the service is not yet complete. After a few seconds, some of the triggers

will be rerun. These triggers require a rerun because after they were executed, new

information was discovered, possibly causing them to have more results than they did

before. This most often occurs for dependency search jobs. Only after the bar shows

100% and this message no longer appears is the discovery is truly finished.

Understanding the Progress/Status Matrix and the Progress Bar

Progress

Status Total

Pending

Probe

Displays the total

number of trigger

CIs waiting for the

Probe to pick them

up for execution.

Displays the

number of

triggered CIs

successfully

waiting for the

Probe to pick them

up for execution.

-- --

Reached

Probe

Displays the total

number of

triggered CIs that

reached the Probe,

and may have

started running.

Displays the

number of

triggered CIs that

successfully

reached the Probe,

and may have

started running.

Displays the

number of

triggered CIs that

successfully

reached the Probe

and have started

running, but have

--
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Progress

Status Total

warnings.

Completed Displays the total

number of

triggered CIs that

completed running

(successfully or

unsuccessfully).

Displays the

number of

triggered CIs that

successfully

completed

running.

Displays the

number of

triggered CIs that

successfully

completed

running, but have

warnings.

Displays the number

of triggered CIs that

failed to complete

running, did not reach

the Probe, or were

not picked up by the

Probe for execution.

Total Displays the total

number of

triggered CIs.

Displays the total

number of

successful

triggered CIs.

Displays the total

number of

triggered CIs that

were successful,

but had warnings

Displays the total

number of failed

triggered CIs.

Note: When discovery is kicked off by schedule, as opposed to manually being started, trigger CIs

that have completed at least once do not go back into Pending Probe and Reached Probe status,

and are therefore not reflected in the Pending Probe and Reached Probe rows of the

Progress/Status Matrix. However, when consecutive runs of the trigger CIs complete, their statuses

are reflected in the appropriate status column of the Completed row of the matrix.

Similarly, since the progress bar displays the percentage of completed trigger CIs, the progress bar

does not change unless new trigger CIs are dispatched or an existing trigger CI is manually rerun.

CI Count View

Clicking a link in the Triggered CIs view enables you to view the number of triggered CIs for each

discovery job that have reached the selected stage of discovery and with the selected status.

Important

Information

In the Discovery Modules/Jobs view, the CI Count job is displayed only when standing on

a module which contains 2 or more jobs. If there is only one job in the module, clicking

the triggered CI displays the CI Instances view.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI

Element

(A-Z) Description

Up one level. Enables you to go back to the Triggered CIs view.

Show triggered CIs. Enables you to drill down to individual triggered CIs.

Refresh. Refreshes the table.

Remove CI. Deletes the selected CI. The CI is deleted from the specific job or activity job.

Available: Discovery Modules/Jobs view only, when you select a module category and

select a job.

Rerun Discovery. Enables you to rerun the selected discovery jobs. The execution

complies to the defined execution policy for the relevant discovery jobs.

/ Pause / Resume. Enables you to pause/resume a selected job.

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are finished

o all the execution information is retained, including errors

l Jobs are paused based on their defined job execution policies. For details, see

"Job Execution Policies" on page 36.

Available: Discovery Modules/Jobs view only

CI Count Displays the number of triggered CI per job that have reached the selected stage of

discovery and with the selected status.

Job

Name

Displays the list of jobs that have reached the selected stage of discovery and with the

selected status.

CI Instances View

Clicking a job in the CI Count view displays the triggered CIs for that discovery job.
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UI

Element

(A-Z) Description

Up one level. Enables you to move up a level of information.

Refresh. Refreshes the list of triggered CIs.

Add CI. Opens the Choose CIs to Add dialog box, enabling you to add a newly-discovered CI

to the triggered CI list. For details, see "Choose CIs to Add Dialog Box" on page 673.

Available: Discovery Modules/Jobs view only

Remove CI. Deletes the selected CI. The CI is deleted from the specific job or activity job.

Available: Discovery Modules/Jobs view only

Filter CIs. Enables you to filter the displayed CIs.

l By Status. Available only when viewing the CIs of a particular discovery job in the

Discovery Module/Jobs view.

o All. Displays all the Trigger CIs.

o Waiting for Probe. Displays the Trigger CIs that are ready to be dispatched and

are waiting for the Probe to retrieve them.

o In Progress. Displays the Trigger CIs that are active and are running on the Probe.

o In progress (being removed). Displays the Trigger CIs that are being removed

from the Trigger CIs list.

o Success, Failed, Warning. Displays only those CIs that have the selected status.

l By Probe. Displays only the CIs triggered by a selected probe/cluster. Click to open

the Select Probes dialog box.

l By Dispatch Type. Displays a list of CIs according to one of the following options:

o All. Displays both CIs that are used to manually activate the job and Discovery TQL

queries that are used to automatically activate the job.

o Manually Added. Displays the CIs that are used to manually activate the job.
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UI

Element

(A-Z) Description

o By Discovery Query. Displays the CIs that are used to automatically activate the

job.

l Reset. Click to remove any filters.

Show Message. When there are warnings/errors,opens a message box containing all the

warning/error messages for the triggered CI.

Show additional data. Opens the Discovered CIs dialog box, enabling you to view

additional information about the CI. For details, see "Discovered/Created/Last Updated

CIs Dialog Box" on page 674.

Show results for triggered CI. An ad hoc request is sent to the Data Flow Probe and

retrieves the latest results of the job (CIT name and number of discovered CIs) that is

running on a specific trigger CI.

This ad hoc request does not run the job, but brings the results of the previous job run

that are stored in the Probe's database. If the job has not yet run for this trigger CI, a

message is displayed. See "Show Results for Triggered CI Dialog Box" on page 690.

If no communication log exists on the Probe, a message is displayed. You can choose to

always create communication logs. For details, see "Adapter Configuration Tab" on page

252.

Rerun Discovery. Enables you to rerun the discovery on the selected CI.

/ Pause / Resume. Enables you to pause/resume a selected discovery.

Note:

l When you pause an active job:

o triggers that are currently running continue to run until they are finished

o all the execution information is retained, including errors

l Jobs are paused based on their defined job execution policies. For details, see

"Job Execution Policies" on page 36.
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UI

Element

(A-Z) Description

Available: Discovery Modules/Jobs view only

Look for To search for a specific Probe, related host, or related IP, enter part of its name in the

box and click the button.

<CI

Instances

table>

Displays all the CI instances discovered by selected job. You can drill down into any CI

instance. If triggered CIs failed, or succeeded with warnings, you can drill down further to

better understand the cause for the warning or failure.

<right-

click

menu>

In addition to some of the functionality described above, right-clicking a CI enables you to

do the following:

l Debug. Enables you to debug a CI. You can:

o View the Communication Log

o Go directly to the job's adapter

o Go directly to the job's details (Discovery Modules/Jobs view only)

o Select a script to edit

o Rerun discovery

l Enable Communication Log.Creates a log file for this session. The log file

contains information about the connection between the Probe and a remote

machine.

Note: To capture results about the connection, see the Enable

Communication Log And Record Results option in this menu.

l Enable Communication Log And Record Results. Creates a log file for this

session. The log file contains information about the connection between the

Probe and a remote machine. Additionally, it enables capturing the discovered

results; these discovered results may help in investigating various discovery

problems.

l Enable Scanner Debug Log. Used for most scanner debugging purposes.
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UI

Element

(A-Z) Description

l Enable Scanner Trace Log. Used for more comprehensive scanner debugging

purposes.

Note: Communication log files are created on the Probe Manager under the

C:\hp\UCMDB\DataFlowProbe\runtime\

communicationLog folder. For details on how the communication logs work,

see "Record DFM Code" in the HP Universal CMDB Developer Reference Guide.

l Download Scanner Log. Saves the debug or trace log to a specified location.

If a log for the selected CI is unavailable, enable the debug or trace log using the

Rerun Discovery menu option.

l Run from step.

Enables you to manually run the job on the selected CI from a particular step in the

job's workflow. This is useful if you do not want to rerun the whole discovery job on

the CI, but only a part of it.

Note:

o The workflow steps are defined in the job’s adapter file. You can view or edit

the workflow in the Adapter Definition tab for the relevant adapter. For

details, see "Adapter Definition Tab" on page 244.

o You cannot run the job from particular step if the status of the CI is Waiting

for probe or In Progress.

Available: In the Discovery Modules/Jobs view; For CIs that trigger workflow-based

jobs

l Reprocess Scan File. Reprocesses the scan files of the selected CI.

Available: In the Discovery Modules/Jobs view; For CIs that trigger workflow-based

jobs
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Discovery Status – Results Tab

This tab displays the discovery results from discovery job runs.

To access Select Data Flow Management > Service Discovery > a node in the tree > Discovery

Status pane (on the right) > Results tab.

Relevant

tasks

l "How to Find Discovery Errors" on page 667

l "How to Manage Discovery Errors" on page 668

l "How to Run Service Discovery" on page 725

See also l "Service Discovery Overview" on page 723

l "Managing Problems With Error Reporting" on page 664

l Service Discovery Errors Report in the HP Universal CMDB Modeling Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI

Element

(A–Z) Description

Refresh. Retrieves the latest discovery results from the server (job results are not

automatically updated in the Results pane).

View Instances. Displays all new and updated CIs. Select a CIT and click:

l View Created Instances to view CIs created during the discovery

l View Updated Instance to view CIs updated during the discovery

Note: When you double-click a row, created CI instances are displayed.

Available: When the discovery results include created or updated instances.

Select the time range or Probe for which to display discovery results and statistics.

l By Time Range:

o All. Displays results for all job runs.
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UI

Element

(A–Z) Description

o From Now/Last Minute/Last Hour/Last Day/Last Week. Choose a period of time

for which to display results.

o Custom Range. Opens the Change Timeframe dialog box where you can enter the

date or choose a From and To date and time from the calendar. Click Now to enter

the current date and time. Click Last Day to enter the current date and time in the

To box and yesterday's date and time in the From box. Click OK to save the

changes.

l By Probe: To view results by Probe, select to open the Choose Probe dialog box.

Selecting All Data Flow Probes displays the results for all of the Data Flow Probes.

Show all declared CI Types. By default, only discovered CITs are listed in the table; the

Discovered CIs column includes CITs if the number of CIs found is greater than zero. Click

the button to display every CI that can be discovered by the job, even if the Discovered CIs

value is zero:

<Results

grid>

Displays the discovery results and statistics.

l CIT. The name of the discovered CIT.

You can configure discovery so that any object reported by the job and whose CIT is

not defined in the adapter's discovered CITs list is marked in red. Objects include

those added by the Probe result mechanism.

To set this parameter:

a. Select Administration > Infrastructure Settings Manager.

b. Select the General Settings category.

c. Locate the Enable statistics results validation according to adapter parameter.
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UI

Element

(A–Z) Description

d. Change the value to True.

l Created. The number of CIT instances created in the period selected or for the

selected Probe.

l Deleted. The number of CIT instances deleted in the period selected or for the

selected Probe

l Discovered CIs. The number of CIs that were discovered for each CI type.

l Total. The total number of CIs in each column.

l Updated. The number of CIT instances that were updated in the period selected.

Filter The time range set with the Set Time Range button.

Last

updated

The date and time that the Results grid was last updated.

New/Edit Service Discovery Activity Dialog Box

This dialog box enables you to create or edit a Service Discovery activity.

To access Select Data Flow Management > Service Discovery and do one of the following:

l To create an activity: Click New Service Discovery Activity .

l To edit an existing activity: Select an activity and click Edit .

Relevant tasks l "How to Create Service Discovery Activities" on page 724

l "How to Edit Service Discovery Activities" on page 725
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Details Area

User interface elements are described below:

UI

Elements Description

Activity

Name

The name of the activity. This field is mandatory.

Note: Naming conventions:

l The name can contain the following characters: a-z, A-Z, 0-9, hyphen (-),

underscore (_), and space ( ).

l The name is not case sensitive.

l The name must be limited to a length of 40 characters.

Type Select the CI type of the service that will be created and discovered by this activity.

URL Enter a valid URL for the starting point for the Service Discovery activity.

Valid URLs have the one of the following formats:

l [<protocol>://][<name>][.<domain>][.<root-domain>][:<port>][/<site>]

l [<protocol>://][<IP>][:<port>][/<site>]

where:

l <protocol> = http:// or https://

l <name> = The <name> can contain any Unicode letter, character, or number. The

<name> may contain a dash ("-"), but not at the beginning or at the end, nor can

there be two or more consecutive dashes. The <name> may not contain any other

special character.

l <domain> = Same as <name>.

l <root-domain> = The <root-domain> must contain at least two characters, and can

contain any Unicode letter, but no numbers. The <root-domain> may not contain

any special characters.
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UI

Elements Description

l <IP> = Any valid IPv4 address.

l <port> = The <port> may contain only digits—at least two, and no more than 5.

l <site> = Any character (including special characters), but excluding white spaces.

Note: Only the <name> or <IP> values are mandatory (depending on the selected

format for the URL); all other values are optional.

Template Select a Template resource. Parameter values in a template override those specified

for a job (if any).

A default template (with default parameter values) exists, and you can use this

template if you do not want to create one. The default template can be changed. For

more information, see "Service Discovery Activity Templates Dialog Box" on the next

page

Hop Limit Limit the scope of the Service Discovery activity by specifying the maximum number of

consumer-provider relationships to be discovered. The default value is 5.

Scheduling Area

This tab allows you to schedule jobs for the Service Discovery activity.

Caution: When creating discovery jobs, try to avoid scheduling multiple jobs to run during the same

time frame.

UI

Elements Description

Repeat

Every:

Enables you to specify the interval at which the activity will run.

Allow

Discovery

to run at:

Enables you to constrain the time at which the activity will run.

Select a predefined time from the drop-down list, or click and then click to open

the Edit Time Template dialog box, where you can define a custom time frame.
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Service Discovery Activity Templates Dialog Box

A Template resource specifies parameter overrides for selected jobs of the Service Discovery activity.

These jobs must be a subset of the jobs specified in the Type resource that is selected for this Service

Discovery activity. Different Service Discovery activities can use different templates, and the same

template may be assigned to different Service Discovery activities.

Editing a template that is already associated with one or more activities will change the parameters for

those activities. In the next scheduled run of such an activity, those new parameter values will be used.

This dialog box enables you to create or edit a Service Discovery activity template.

To access Select Data Flow Management > Service Discovery. Select an activity and click

.

Relevant

tasks

l "How to Create Service Discovery Activities" on page 724

l "How to Edit Service Discovery Activities" on page 725

User interface elements are described below:

UI Element Description

Enables you to create service discovery activity templates.

Enables you to specify overrides for particular parameters in the activity's jobs.

Deletes the selected template.

Refreshes the list of templates.

Service Discovery Page

This page enables you to manage and run Service Discovery activities, and troubleshoot why expected

CIs are missing after discovery.

To access Select Data Flow Management > Service Discovery.

Relevant tasks "How to Create Service Discovery Activities" on page 724

See also l "Service Discovery Overview" on page 723
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l "New/Edit Service Discovery Activity Dialog Box" on page 747

User interface elements are described below:

Service Discovery Activities Pane

The Service Discovery Activities pane displays all of the service discovery activities that have been

defined.

UI

Element Description

New Service Discovery Activity. Enables you to create service discovery activities.

Edit. Enables you to change the following information for the selected discovery activity:

l template

l schedule

l maximum number of hops

Delete. Deletes the selected discovery activity.

Reload Data. Refreshes the data in the Service Discovery Activities pane.

Activate. Activates the selected discovery activity.

Note: If the trigger CI for the activity is missing, the activity name will be grayed out

and you will not be able to activate the activity. The jobs for this activity will still run,

but you will not be able to modify the activity in any way. It is recommended to delete

the invalid activity and recreate it.

Deactivate. Deactivates the selected discovery activity.

Pause. Pauses the selected discovery activity.

Resume. Resumes the selected, paused discovery activity.

Rerun. Runs the selected discovery activity again.
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UI

Element Description

Opens the Service Discovery Activity Templates dialog box.

Click to create a new template, or click to edit an existing template.

This dialog box enables you to define specific overrides to parameters in jobs that are

included in the default template.

<right-

click

menu>

In addition to some of the functionality described above, right-clicking a discovery activity

enables you to do the following:

l Clear Probe Results Cache. Clears the selected activity's results cache on the

Probes.

Note: If an activity's results cache is cleared, all discovery results are sent again

the next time the activity runs.

Service Discovery Details Pane

The right pane of the Service Discovery view displays the following information:

l "Activity Details Pane" below

l "Discovery Status Pane" on page 754

Activity Details Pane

Displayed when you select a discovery activity in the Service Discovery Activities pane.

UI Element Description

Overview

Tab

Displays the type and status of the discovery activity, and a summary of the activity as

it was defined when it was created. To edit an activity, select the activity and click the

Edit Activity button.

Activity

Jobs Tab

Displays the activity jobs available for the discovery activity.

The Activity Jobs tab displays all possible jobs that can run during the execution of a

service discovery activity. However, some jobs may not be executed since they are not

Data Flow Management Guide

Chapter 21: Business Service Discovery

HP Universal CMDB (10.22) Page 752 of 795



UI Element Description

necessary for the service being discovered. The jobs that are actually executed are

listed in the "Discovery Status – Progress Tab".

l Activity Jobs Toolbar

o Go to Adapter. Redirects you to the adapter for the selected activity job.

o View Permission Details. Opens the Discovery Permissions dialog box,

enabling you to view the permissions data for the selected activity job.

o View Discovered CITs in Map. Displays the selected adapter, together with

its CIs and relationships, in the Discovered CITs Map window. Hold the cursor over

a CIT to read a description in a tooltip.

o View Parameters. Opens the Activity Job Parameters dialog box, enabling

you to view the parameters for the selected activity job.

o Edit Script. Displays a list of scripts related to the selected activity job.

Select a script and edit it in the Script Editor.

o Edit Trigger Query. Displays the trigger query related to the selected

activity job, enabling you to open and edit it in the Trigger Query Editor.

l Activity Jobs Grid. Displays the information about jobs available for the discovery

activity.

o Activity Job Name. The name of the activity job.

o Discovered CITs. The CITs discovered by the activity job.

o Protocols. The protocols used by the activity job.

o IPv6 Support. Indicates whether the activity job's adapter supports IPv6.

o Scheduling. Displays the details of the activity job's discovery schedule.
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Discovery Status Pane

Displays the progress and results of the selected discovery activity.

UI Element Description

Progress

Tab

l Displays the progress of the new trigger CIs across the discovery activity. For more

information, see "Discovery Status – Progress Tab" on page 736.

l The information is automatically refreshed every 30 seconds.

l Use the information displayed in this pane to drill down to problematic trigger CIs, to

uncover specific problems that Universal Discovery encountered during the

discovery—for example, incorrect credentials. You can also add newly discovered CIs

to the trigger CI list.

l Hold the SHIFT and CTRL keys to select adjacent and non-adjacent CIs in a list.

Results

Tab

Displays the results from the selected discovery activity. For more information, see

"Discovery Status – Results Tab" on page 745.
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Chapter 22: Data Reconciliation
This chapter includes:

Reconciliation Overview 756

Identification Service 757

Data-In Service - Populating UCMDB 764

Merging Matched CIs Using Reconciliation Priority Rules 769

How to Create an Identification Rule 769

How to Add Reconciliation Priorities to a CI Type 772

Identification Rule Schema 772

Reconciliation Priority Window 781

How to Enable Attribute Name Verification during the Matching Phase of Identification 785

How to Enable CI Type Tenant Owner Verification during the Matching Phase of Identification 786

Reconciliation Overview

Reconciliation is the process of identifying and matching entities from different data repositories (for

example, UCMDB Universal Discovery, DDMI, ticketing, or BSM). This process is designed to avoid

duplicate CIs in UCMDB.

Many different data collectors can send CIs to UCMDB. In actuality, each different source might be

providing information about the same CI. The reconciliation process is responsible for identifying and

matching entities from different data collectors and storing them, without duplicating CIs, in UCMDB.

Three main services provide support for the reconciliation process:

l Identification service. Responsible for comparing incoming data (input CIs), according to defined

identification rules. For details, see "Identification Service" on the next page.

l Data In service. Responsible for inserting data into UCMDB. This service decides whether to:
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o merge incoming data with existing CIs in UCMDB

o ignore input CIs in the case of multiple matches

For details, see "Data-In Service - Populating UCMDB" on page 764.

l Merge. In Federation and Data-in flows, this service is responsible for merging CIs. Merging is done in

accordance with defined reconciliation priority rules. For details, see "Merging Matched CIs Using

Reconciliation Priority Rules" on page 769.

These services operate during the data-in process for inserting data from different sources into

UCMDB, and during federation for connecting or merging information from different data repositories

during TQL query calculations.

Identification Service

The Identification service uses identification rules to identify CIs. An identification rule is composed of

three criterion sets:

l Identification criteria. A set of criteria that defines all possible conditions to find all candidate CIs

for matching to a newly introduced CI. Two CIs are identical if one of the identification criteria is

satisfied.

l Match criteria. There are two types of match criteria:

o Match verification criteria. A set of criteria that are applied to all candidates left over after

performing identification (in the previous step). MMatch verification ends successfully only when

all applied verification criteria are true or missing data (NA).

o Match validation criteria. An ordered set of criteria that is applied to all candidates left over

after performing match verification. For each criterion, the following results are possible:

l A true result implies a match

l A false result implies no match

l Missing data (NA) causes reconciliation to proceed to the next criterion. If all validation

criterion are NA, then all candidates left after match verification will be implied as matched
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When trying to determine whether or not two CIs are the same (according to the identification rule),

each criterion is evaluated. Each criterion, in one of the above sections, contains one or more

conditions. There are two types of conditions:

l Attribute conditions. Test whether or not two CIs have the same value (or same value while ignoring

case) as the given attribute defined for the condition.

l Connected CI conditions. Test whether or not the two CIs share the same number of connected CIs

defined for the condition.

For a criterion to evaluate to a true value, all of the conditions must evaluate to true. If one condition

evaluates to false, the entire criterion evaluates to false. If one condition cannot be evaluated (its

required data is missing in one of the two CIs being identified), the condition returns unknown, and, in

turn, the entire criterion that contains it returns as unknown.

The identification process is as follows:

1. At least one identification criteria must return true. The identification process tests the

identification criteria.

o If there is at least one identification criterion that returns true, the identification process

continues.

o If no identification criterion returns true, then the CIs are not the same and the identification

process ends here.

2. Are there contradictions between the CIs? The identification process tests the verification

criteria.

o If all of the verification data returns either true or unknown, the identification process

continues.

o Otherwise, there is a contradiction between the two CIs, and they are not the same and the

identification process ends here.

3. Evaluate the validation criteria. The identification process tests the verification criteria one by

one and according to each one's priority:

o If the validation criterion is satisfied, the two CIs as the same.

o If none of the validation criteria are satisfied, and a validation criterion returns false, the two

CIs are unmatched.

o If none of the validation criteria are satisfied or refuted:
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i. The the criteria from the next priority are evaluated.

ii. If there are no more criteria (the last priority was evaluated), then the two CIs are the

same.

Identification Process Example

The following items are used in this example:

Input node l name = n1

l ip_address = ip1

l MAC address = m1

l os_family = nt

UCMDB nodes l N1: name=n2

l N2 :

o ip_address=ip1,ip2

o MAC address=m1

o os_family=nt

l N3:

o name=n3

o MAC address = m1

o hw_id = id1

o os_family = unix)

1. For each UCMDB node, run the identification criteria:

o Node N1 does not match any identification criteria, so it will not be added to the candidates

list.

o Node N2 matches the IP identification criterion of the input node, so it will be added to the
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candidates list.

o Node N3 does not match the input node by the IP identification criterion, but does match by

the MAC address identification criterion, so it will be added to the candidates list.

Therefore, the candidates list is: N2 and N3.

2. For each node in the candidates list, run OS match verification criteria. Node N3 does not

satisfy this rule, since its OS is UNIX and the input node’s OS is NT. Therefore, N3 will be

removed from the candidates list.

The candidates list is: N2.

3. Run the match validation criteria one by one on node N2. Since node N2 has no data conflicts,

the match validation criteria are approved and N2 is marked as matched.

The result of the identification process is: N2 = ip_address=ip1,ip2, MAC address=m1, os_

family=nt.

To configure match criteria, see "Identification and Match Criteria Configuration " below.

For examples of configuring identification rules, see "Examples of Identification Configuration" on page

763.

Note: The identification process creates an identification map which is limited by default to

2,000,000 mappings. Each identification between two CIs is considered a separate mapping for

each CI involved. Additionally, there is default limit of 5,000 mappings per CI. If you get an error

saying that the identification map is too large, it may indicate that there is a problem with your

data (for example, many nodes connected to a single IP address). Check the

cmdb.reconciliation.identification.log for warnings. If there are none, check the

cmdb.reconciliation.log to examine the actual identification map for unusual items.

Identification and Match Criteria Configuration

Depending on your data source, available credentials, and specific system security settings, an

integration point may have access to only a limited set of attributes when identifying a CI.

For example, IP range discovery detects two IP addresses (10.12.123.101 and 16.45.77.145), and creates

two nodes. However, detailed system discovery may detect that those two IP addresses are actually

configured on two network interfaces in the same node.
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This means that you cannot always rely on a single matching set of attributes for identification – other

possible attributes that can potentially help to identify the CI should also be listed. In the previous

example, the node identification attributes can be the IP address and the network interface. If you use

the IP address to identify the CI, you see that all three discovered nodes are the same node.

Suppose that detailed system discovery detects a node with IP address 10.12.123.101 and network

interface MAC1. At some point, that node was shut down, and the same IP address (10.12.123.101) was

given to another node with network interface MAC2. These two nodes have the same IP address;

however; it is obviously not the same CI. Performing match validation on the network interface data

helps us to realize that it is not the same node.

The identification criteria are used to select candidates, and the match criteria are used to approve the

identification result or dismiss it. For example, while handling input CI A, we may get identification

candidates B and C, and the match criteria will dismiss B. In that case, we are left with C, which means

that A is identified as C.

Identification Criteria

Data that the reconciliation engine receives from different data sources may contain different subsets

of the attributes (topology) necessary for identifying a CI. The identification criteria should contain all

potential attributes on which CI matching can be done.

Specifications

Each identification criterion defines a potential condition for CI matching. The criterion can be an

attribute such as node name, or topology such as IP address. A criterion may contain two or more

conditions, to create a more complex matching rule. It may also contain different condition operators

such as equals or contains, or it may contain some master value that defines a value in the CI that will

always allow a match.

During the identification process, all identification criteria are running to find all candidate CIs for

matching.

Possible Node Identification Criteria

l HW ID

l Network interface (containing a condition operator)

l Node name

l IP address (containing a condition operator)
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Match Criteria

While identification criteria list all potential attributes for matching the data, match criteria contain the

attributes that are essential for matching CIs, if any exist. This means that if two CIs are marked as

candidates to be matched by the identification criteria, the match criteria will check if the data exists in

both CIs in order to match the condition.

Match criteria are also used during the Data-In process in case of multiple matches, to make the

decision to merge CIs from the CMDB. The CIs are merged only if the match criteria are satisfied. If one

of the CIs does not satisfy the match criteria, the merge is not performed.

Specifications

A match criterion is satisfied if two candidate CIs have the same essential data (as defined in the that

criterion), the data matches the condition, or if at least one of the CIs has no essential data.

Match criteria can be divided into two categories:

l Match verification criteria – if the verification criterion is not satisfied on two candidate CIs, these

CIs are not matched.

l Match validation criterion – if the criterion with higher priority is satisfied (without missing data) on

two candidate CIs, the validation criterion with lower priority is even not checked and the CIs are

marked as matched. Similarly, if the validation criterion with higher priority is refuted on two

candidate CIs, the criterion with lower priority is even not checked and the CIs are marked as not

matched.

Possible Node Match Criteria

l Match verification criteria uses the discovered OS data for verification. This means that if two nodes

have discovered OS data and this data does not match, these two nodes are not matched.

l Match validation criteria (ordered from highest to lowest priority):

Priority 1. HW ID with an equals operator

Priority 2. Node name with an equals operator

Priority 3. Network interface with a contains operator

This means that if two nodes with the same HW ID are discovered, they are marked as matched

even if they have different network interfaces or node names. On the other hand, if the discovered

HW IDs on the nodes are not the same, the nodes are not marked as matched even if the network

Data Flow Management Guide

Chapter 22: Data Reconciliation

HP Universal CMDB (10.22) Page 762 of 795



interfaces and node names are the same. The network interface rule is checked only if one of the

nodes has no discovered HW ID.

Examples of Identification Configuration

Sample "vlan" CI Type Identification Configuration

<identification-config type="vlan">
<identification-criteria>

<identification-criterion>
<attribute-condition attributeName="vlan_id"/>
<connected-ci-condition ciType="physical_port"

linkType="membership">
<overlap-fixed-operator number-of-matches="1"/>

</connected-ci-condition>
</identification-criterion>

</identification-criteria>
</identification-config>

Sample "Installed Software" CI Type Identification Configuration

<identification-config type="installed_software" xmlns:xsi=
"http://www.w3.org/2001/XMLSchema-instance" xsi:noNamespaceSchemaLocation=
"C:\StarTeam\UCMDB\mam\ws\assets\dc\backend\reconciliation\src\main\
resources\schema\reconciliation.xsd"

description="Installed Software is identified by a combination of their
container Node and either its Name or DML Product Name.
Two similarly identified installed software will be considered different
entities in case of mismatch of either File System Path, DML Product Name or
its Name.">
    <identification-criteria>
        <identification-criterion>
            <attribute-condition attributeName="dml_product_name"/>
            <attribute-condition attributeName="root_container"/>
        </identification-criterion>
        <identification-criterion>
            <attribute-condition attributeName="name"/>
            <attribute-condition attributeName="root_container"/>
        </identification-criterion>
    </identification-criteria>
    <match>
        <verification-criteria>
            <verification-criterion>
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                <attribute-condition attributeName="file_system_path"/>
            </verification-criterion>
        </verification-criteria>
        <validation-criteria>
            <validation-criterion priority="1">
                <attribute-condition attributeName="dml_product_name"/>
            </validation-criterion>
            <validation-criterion priority="2">
                <attribute-condition attributeName="name"/>
            </validation-criterion>
        </validation-criteria>
    </match>
</identification-config>

Data-In Service - Populating UCMDB

After the Identification service runs, the identified data is merged and inserted into the UCMDB by the

Data  In service. When the CI is created, a stable ID is generated. The stable ID remains the same when

the name, attribute name, or property values (during normalization) change.

One of the major problems that the Data In service solves is deciding what to do if the input CI matches

multiple UCMDB CIs.

To make this decision, the Data In service uses match criteria.

The process is as follows:

1. Input CIs are merged with each matching UCMDB CI.

2. For each pair of CIs resulting from this merge, match (verification and validation) criteria are run.

o If at least one pair does not pass the match criteria check, the CIs are not merged, and the Data

In service ignores the input CI.

o If all pairs pass the match criteria check, the CIs are merged.

Note: The CIs are merged by the Merge service.

For examples of multiple CI matching, see:
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l "Multiple CI Matching - Example 1" on the next page

l "Multiple CI Matching - Example 2" on page 767

Server-Side Data Normalization

Before populating the CMDB with new CIs, the server normalizes the incoming data as follows:

l When a CI of type ip_address is reported, if one of the name or the ip_address_value attributes

contains data, the other is populated automatically.

l When a CI of type ip_subnet is reported, if one of the network_netmask or ip_prefix_length

attributes contains data, the other is populated automatically.

l When the REPLACE_VALUE_WITH_VALUE_FROM_SYSTEM_PROPERTY qualifier is defined for a

particular attribute, the attribute is normalized with the specified system property value.

For example, the routing_domain attribute, by default, contains the REPLACE_VALUE_WITH_

VALUE_FROM_SYSTEM_PROPERTY qualifier where:

o CONSTANT_TO_REPLACE data item is defined as ${DefaultDomain}

o SYSTEM_PROPERTY_NAME data item is defined as default.domain

This means that if a CI of type ip_address is reported with ${DefaultDomain} in the routing_domain

attribute, then the routing_domain attribute is populated with the value in the default.domain

setting.

l If the CI attribute's Discovery Auto Truncate (DDM_AUTOTRUNCATE) qualifier is enabled, then

results of type STRING are truncated according to the database encoding setting.

Note: By default, the database encoding is defined as UTF-8. This encoding can be changed in

the Infrastructure Settings Manager, in the Reconciliation Settings > Database Encoding

setting (reconciliation.auto.truncate.db.encoding). To access the Infrastructure Settings

Manager, go to Administration > Infrastructure Settings Manager. For more details, see

"Infrastructure Settings Manager Page" in the HP Universal CMDB Administration Guide.

l If the CI attribute has a case qualifier that is enabled, then the case of all of the results are

normalized. The case qualifiers are:
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Qualifier Display Name Description

TO_UPPER_CASE Upper Case Normalizes all results to upper case

TO_LOWER_CASE Lower Case Normalizes all results to lower case

Note: The deprecated qualifiers, DDM_AUTOUPPERCASE and DDM_AUTOLOWERCASE, can also

be used to normalize results to upper case or lower case respectively, if enabled.

l If the Discovery Auto Trim (DDM_AUTOTRIM) qualifier for the attribute is enabled, any leading and

trailing spaces and tabs are removed from the string.

For more information about attributes, see "CI Type Attributes" in the HP Universal CMDB Modeling

Guide.

Multiple CI Matching - Example 1

The following example demonstrates how the Data-In service matches multiple with different

identification criteria where there are no conflicts.

1. The input bulk data is received.

2. The service identifies matching CIs in the CMDB

In this example, the input node matches four nodes in the CMDB having different identification

criteria.
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3. The service merges the input CI with each matching CI in the CMDB.

4. The service checks for conflicts between the resulting merged CIs.

Nodes N2, N3, and N4 are the same CI; therefore, it is obvious that there is no conflict between

them. The only difference between nodes N1 and N2 is the additional MAC address in N1. Since the

MAC address match validation criterion uses the contains operator, there is no conflict between

nodes N1 and N2 either.

Conclusion: There are no conflicts with any of the CMDB matching nodes.

5. Decision: The Data-In service merges all of the CIs into one CI.

For details on how the CIs are merged into one CI, see "Merging Matched CIs Using Reconciliation

Priority Rules" on page 769.

Multiple CI Matching - Example 2

The following example demonstrates how the Data-In service handles multiple CIs with different

identification criteria where there are conflicts.
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1. The input bulk data is received.

2. The service identifies matching CIs in the CMDB

3. The service merges the input CI with each matching CI in the CMDB.

In this example, the input node matches two nodes in the CMDB having different identification

criteria, but there are conflicts with the matching nodes in CMDB: N1 and N2 have conflicting MAC

address match criteria.

4. Decision: The CIs are not all merged to one CI.
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Merging Matched CIs Using Reconciliation Priority Rules

During Data In and federation, when a CI is matched with another CI, they need to be merged.

Reconciliation priorities, defined using the Reconciliation Priority Manager, are conflict resolution rules

that determine how the matched CIs are merged.

This behavior becomes relevant in the following situations:

l Data In. The Reconciliation Priority Manager determines whether or not to insert an already existing

CI into the CMDB.

l Federation. The Reconciliation Priority Manager determines how to handle a CI when multiple data

repositories supply the same CI with different values.

To solve this problem, you can define priorities for each data repository to each CIT and attribute.

For details, see "How to Add Reconciliation Priorities to a CI Type" on page 772.

How to Create an Identification Rule

This task describes how to prepare the XML schema for an identification rule.

The identification rule is defined in an XML file. The rule describes the required identification and match

criteria for a specific CI type.

When you apply an identification rule to a CI type, it is also applied to each of the CI type's descendants,

unless one of them has a identification rule of its own.

You can create an identification rule document from a blank document or use existing information as a

basis.

Note: UCMDB is packaged with out-of-the-box identification rules for most usable and problematic

CITs, such as node, running software, and so on.

To create an identification rule:

1. Navigate to Modeling > CI Type Manager.

2. Click the Details tab.
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3. In the Identification area, in the Identification field, select Advanced identification, and click Edit

at the bottom of the Identification area.

4. In the Edit Identification Rule dialog box that opens, define identification criteria and match

(verification and validation) criteria for the identification rule. For details about the schema

elements and attributes, see "Identification Rule Schema" on page 772.

Example of the identification criteria section

In this example:

o A 66% match of mac_address from the connected interface CI types is required.

o If the number of identification candidates vs the CMDB with the same value of mac_adress

is equal to or greater than 50, then this value is automatically excluded from further

identification process.
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o The name attribute must be the same.

o The name attribute is not case sensitive.

o A 66% match of the connected IP addresses is required.

o Both name and routing_domain of the connected IP address must be the same in order to

match.

o The bios_uuid attribute must be the same.

o Only one of the identification criteria needs to be fulfilled for the reconciliation engine to

find a possible match.

Example of the match criteria section

In this example:
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o The structure of the conditions is the same as those conditions in the Identification section.

o Only one priority criterion is given in this example, but there may be many criteria with the

same priority.

How to Add Reconciliation Priorities to a CI Type

1. Go to the Data Flow Management > Reconciliation Priority module.

2. In the CI Types pane, select the CI type.

3. In the CI Type Overrides pane, select an integration and changes its priority by editing the value in

the Priority field.

4. To set the priority for a specific attribute of that CI type:

a. In the Attribute Overrides pane, click Add .

b. In the Add Attribute dialog box, select the attribute from the list and click OK.

5. Select the attribute in the Attribute Overrides pane, and change the value in the Priority field.

Note: To reset the attribute to its default value, select the attribute in the Attribute Overrides

pane, and click Reset Attribute .

6. Click the Save button in the CI Types pane to save your changes.

Identification Rule Schema

Element

AttributesName and Path Description

identification-config The parent element for the

identification rule document.

Name. description

Description. A textual
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Element

AttributesName and Path Description

description of the

identification rule.

Is required. Optional

Type. String

Name. type

Description. The CI type to

which the identification rule

will apply.

Is required. Required

Type. String

identification-criteria

(Identification-config)

The parent element for all the

possible identification criteria for

the CI type. For details, see

"Identification Criteria" on page

761. The identification criteria

may contain many identification-

criterion elements. Can appear at

most once.

match

(Identification-config)

The parent element for all the

possible match criteria for the CI

type. For details, see "Match

Criteria" on page 762. Can appear

at most once.

multiple-match-resolving

(Identification-config)

When two or more CIs of the CI

type are identified to one another,

they may be of any descendant CI

type as well. This element states

that one of the descendant CI

types is preferred over the others.

Can appear at most once.

Name. preferred-type

Description. Specifies the CI

type of the CI that will be

preferred when there are

multiple matches which cannot

be merged.

Is required. Optional
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Element

AttributesName and Path Description

Type. String

preferred-property

(identification-config >

multiple-match-resolving)

This element specifies the

property value of the CI that will

be preferred when there are

multiple matches which cannot be

merged.

Name. name

Description. The name of the

property.

Is required. Required

Type. String

Name. value

Description. The value of the

property.

Is required. required

Type. String

Name. priority

Description. The priority of

this preferred property.

Is required. Optional

Type. Integer

identification-criterion

(Identification-config >

identification-criteria)

This element defines a single

identification criterion. The

criterion may contain many

conditions for identification, and

for the criterion to return True, all

of them must return True.

Name. targetType

Description. Indicates for

which CI type this criterion is

valid. If this attribute is

omitted, then the criterion is

applied to any derived type.

Is required. Optional

Type. String

Name. isTargetTypeDerived

Description. Specifies whether
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Element

AttributesName and Path Description

the target type is a derived

type of the current CI type.

Is required. Optional

Type. String

key-attributes-condition

(identification-config >

identification-criteria >

identification-criterion)

This special condition states that

the CI type is identified by its key

properties and CI type name, and

not by any identification criteria. If

this condition exists, it should be

the only one in the criterion, as

well the only criterion in the

identification section. Can appear

at most once.

attribute-condition

(identification-config)

identification-criteria >

identification-criterion -OR-

identification-config

identification-criteria >

identification-criterion >

connected-ci-condition -OR-

identification-config > match >

validation-criteria )

Defines a condition based on an

attribute.

Name. attributeName

Description. The name of the

attribute.

Is required. Required

Type. String

Name. autoExcludeThreshold

Description. If the number of

identification candidates with

the same attribute value

exceeds this threshold, then

that value is automatically

excluded from the

identification process.

Is required. Optional

Type:

l Positive integer.
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Element

AttributesName and Path Description

l A value of 0 disables this

feature.

Name. masterValue

Description. For the purpose

of fulfilling the condition, the

value defined here is

considered equal to any other

value.

Is required. Optional

Type. String

Name. operator

Description. Specifies whether

the equality of attribute

values should be case

sensitive or not. The default is

case sensitive.

Is required. Optional

Type. One of the values:

Equals or EqualsIgnoreCase

Name. includeNullValue

Description. Specifies whether

a CI should still be considered

as a valid value if it has a null

(empty) value in the attribute,

and the condition will process

normally; or is the condition

ignored and the reconciliation

engine moves to the next

criterion. Default value is False

Is required. Optional
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Element

AttributesName and Path Description

Type. Boolean

Name. conditionType

Type. One of the following

values:

approveAndContradict

condition is used for both

approving and contradicting

CIs (default).

contradictionOnly condition is

used to contradict two CIs.

approvalOnly condition is used

for approving CIs only.

connected-ci-condition

(Identification-config

identification-criteria >

identification-criterion -OR-

identification-config > match >

verification-criteria -OR-

identification-config > match)

Defines a condition based on

connected CIs. The connected

condition may contain attribute

conditions. If no attribute

conditions exist, the condition

matches the connected CI type

using its own identification rule.

Name. ciType

Description. The type of CI

that is assumed to be

connected to the CI type to

which this rule belongs using

the linkType attribute.

Is required. Required

Type. String

Name. linkType

Description. The type of link

that the ciType attribute uses

to connect to the CI type to

which this rule belongs

Is required. Required

Type. String

Name. isDirectionForward
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Element

AttributesName and Path Description

Description. The direction of

the link. Default value is True

(from the rule’s CI type to

ciType).

Is required. Optional

Type. Boolean

overlap-fixed-operator

(Identification-config >

identification-criteria >

identification-criterion >

connected-ci-condition)

Defines the fixed number of

matches to connected CIs that are

needed to fulfill the condition for

the connected-ci-condition

element to return True. Either this

or overlap-operator must exist.

Name. number-of-matches

Description. The number of

matches.

Is required. Required

Type. Integer

overlap-operator

(Identification-config >

identification-criteria >

identification-criterion >

connected-ci-condition)

Defines the percent of connected

CIs (from the total input number

of connected CIs) that are needed

to fulfill the condition for the

connected-ci-condition element

to return True. Either this or

overlap-fixed-operator must

exist.

Name. match-percent

Description. The percent of

matches.

Is required. Required

Type. Integer between 1 and

100

verification-criteria

(Identification-config > match)

The parent element for all the

possible verification criteria for

the CI type. For details, see "Match

Criteria" on page 762. The

verification criteria must contain

at least one verification-criterion

element. Can appear at most

once.

verification-criterion

(Identification-config > match

> verification-criteria)

This element defines a single

verification criterion. The criterion

may contain many conditions for

verification.

Name. targetType

Description. The derived CI

type for which this criterion is
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Element

AttributesName and Path Description

valid. If this attribute is

omitted, then the criterion is

applied to any derived type.

Is required. Optional

Type. String

Name. isTargetTypeDerived

Description. Specifies whether

the target type is a derived

type of the current CI type.

Is required. Optional

Type. Boolean

Name.

numberOfConflictsToFail

Identification

Description. The number of

conflicting conditions that will

cause the current criterion to

fail.

Default Value: 1.

Is required. Optional

Type. Integer

validation-criteria

(Identification-config > match)

The parent element for all

possible validation criteria for the

CI type. For details, see "Match

Criteria" on page 762. The

validation criteria must contain at

least one validation-criterion

element. Can appear at most

once.
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Element

AttributesName and Path Description

validation-criterion

(Identification-config > match

> validation-criteria)

This element defines a single

validation criterion. The criterion

may contain many conditions for

validation.

Name. priority

Description. The criterion’s

priority.

Is required. Required

Type. Integer

Name. targetType

Description. The derived CI

type for which this criterion is

valid. If this attribute is

omitted, then the criterion is

applied to any derived type.

Is required. Optional

Type. String

Name. isTargetTypeDerived

Description. Specifies whether

the target type is a derived

type of the current CI type.

Is required. Optional

Type. Boolean

Name.

numberOfConflictsToFail

Identification

Description. The number of

conflicting conditions that will

cause the current criterion to

fail. Default Value: 1.

Is required. Optional

Type. Integer

Data Flow Management Guide

Chapter 22: Data Reconciliation

HP Universal CMDB (10.22) Page 780 of 795



Reconciliation Priority Window

This window enables you to specify the reconciliation priority for a particular integration point, CIT, or

attribute.

The Reconciliation Priority Manager provides a centralized location where you can view and change the

reconciliation priority for all integration points.

Note: In the Integration Point Pane, you can modify the reconciliation priority for the selected

integration point only. For details, see "Integration Point Pane" on page 341.

For details about the reconciliation engine, see "Data Reconciliation" on page 756.

To access Do one of the following:

l Select Data Flow Management > Reconciliation Priority.

l Select Data Flow Management > Integration Studio, right-click an Integration point

and select Reconciliation Priority Manager .

Relevant

tasks

l "How to Work with Federated Data" on page 315

l "How to Work with Population Jobs" on page 316

l "How to Work with Data Push Jobs" on page 317

User interface elements are described below:

UI Element (A-Z) Description

Integration Enables you to select a specific integration point for which to specify the

reconciliation priority.

Alternatively, you can set priorities for all integration points.

CI Types pane Lists the CI types and attributes that are supported by the selected

integration point.

See below for more details.

Reconciliation Priority

Overrides pane

Lists all integration points that contain the selected CI Type , and the

priority overrides for the selected CI types, if any.

See below for more details.
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CI Types pane

This pane lists the CI types and attributes that are supported by the selected integration point.

Note: If there is a manual override on an item in the tree, that item and all its parent items are

displayed with an asterisk next to the CI type.

UI Element

(A-Z) Description

Expands/collapses the entire hierarchical tree structure.

Tree View Click Tree View to select the display format of the CI types tree. The following options

are available:

l Display label

l Class name

l Legacy class name

Toggles the display of the legend at the bottom of the CI Types pane.

Saves the changes to the priority override settings.

Filters the tree to display only those CI types that have reconciliation priority

overrides, and their parents.

Reconciliation Priority Overrides Pane

CI Type Overrides Area

UI Element

(A-Z) Description

Inherited

From

The name of the CI type from which the priority level is inherited.

Integration

Name

The name of the integration point for which the override is defined.
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UI Element

(A-Z) Description

Priority Displays the priority that is assigned to a particular CI Type. This value can range from -

1,000,000 to 1,000,000. The default priority level for all items is 100. If you change the

priority of an entry, the new value propagates downwards to all descendants of that

particular CI type.

To change the priority of a CI type, do the following:

l Click the Priority field and enter a new value.

l Press Enter.

l Click in the CI Types pane.

Attribute Overrides Area

UI Element

(A-Z) Description

Opens the Add Attribute dialog box, enabling you to select attributes for which you want

to set overrides.

l Integration Point. Displays a list of all defined integration points.

Select the integration point for which you want to change an attribute's priority. If

an integration point is selected, only attributes for this integration point can be

added to the list.

l Attribute. Enables you to select an attribute for which you want to specify a priority

override. To view the hidden attributes among this list, select the Show hidden

attributes check box.
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UI Element

(A-Z) Description

Note: Hidden attributes are not marked as Visible in the Attributes pane of the

CI Type Manager. For details, see Attributes Page in the HP Universal CMDB

Modeling Guide.

Resets the value of the selected attribute to its default value.

Note: If you reset the priority for an attribute, and this priority is not overridden in

any parent of this CIT, the attribute override row is removed from the list, and the

value is restored to 100. If a parent of this CIT does have an attribute override for

this attribute, the value is set to the parent's value.

Attribute The name of the attribute for which you are specifying a priority override.

Inherited

From

The name of the CI type from which the priority level is inherited.

Integration

Name

The name of the integration point for which the override is defined.

Priority Displays the priority that is assigned to a particular attribute. This value can range from

-1,000,000 to 1,000,000. The default priority level for all items is 100. If you change the

priority of an entry, the new value propagates downwards to all descendants of that

particular CI type.
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UI Element

(A-Z) Description

Note: When you change the priority, you must click in the CI Types pane to save

your changes.

How to Enable Attribute Name Verification during the

Matching Phase of Identification

The reconciliation.match.attributes JMX setting verifies names of attributes during the matching

phase of the identification process. If, compared to the other CI, there is a different value among the CI

attribute values defined in this setting, the verification process stops and the match is rejected.

Only the attributes that are inherited from the Managed Object should be used in this setting (for

example, global_id and name). Names of the attributes specified in the setting should be separated by

comma.

This setting applies only to CIs that are identified based on the Identification Rule.

The following example explains how this setting works:

l If you have two node CIs:

o Node1 with global_id=g1 and name=n

o Node2 with global_id=g2 and name=n

o reconciliation.match.attributes set to global_id

This scenario will result in the two nodes not matching.

l If Node1 does not have global_id set, the two CIs will match.

To enable this setting, do the following:

1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.

2. In the name field, enter reconciliation.match.attributes.

3. In the value field, enter names of the CI attributes, separated by comma.
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Note: To disable this setting, leave the value field empty.

4. Click Invoke.

How to Enable CI Type Tenant Owner Verification during the

Matching Phase of Identification

You can dynamically add a verification criterion based on the TenantOwner attribute during the

matching phase of the identification process for CIs by using the new JMX setting

reconciliation.tenantaware.citypes. If, compared to the other CI, there is a different value among the

CI attribute values defined in this setting, the verification process stops and the match is rejected.

The following example explains how this setting works:

l If you have two node CIs:

o Node1 with TenantOwner=t1 and name=n

o Node2 with TenantOwner=t2 and name=n

o reconciliation.tenantaware.citypes set to node

This scenario will result in the two nodes not matching.

l If Node1 does not have TenantOwner set, the default Tenant will be provided.

Note: If you add a node CIT, UNIX for example, you do not have to add it since it is inherited by

identification rule. Only if you change the UNIX CIT identification rule, you need to add it explicitly.

To enable TenantOwner attribute verification for CITs that are identified by key

attributes,

1. Add the ID_ATTRIBUTE qualifier for the TenantOwner attribute of the managed_object CIT.

Note: The TenantOwner attribute will be inherited to all the child classes. Make sure that a

child class does not override it.
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a. Go to the JMX console > UCMDB:service=URM Services.

b. Invoke the listResourceTypes method.

c. On the returned page, click CM_CLASS, then click managed_object.

d. In the Resource XML box, add the following attribute qualifier to the TenantOwner attribute:

<Attribute-Qualifier name="ID_ATTRIBUTE" is-factory="false" is-user-
modified="true” version="15">

<Data-Items/>
</Attribute-Qualifier>

e. Click Save resource.

2. Invoke the JMX method updateClassModel to update the class model (go to the JMX console >

UCMDB:service=Class Model Services, and invoke the updateClassModel method with 1 in the

Value field for customerID).

3. Reload the class model from persistency (go to the JMX console > UCMDB:service=Class Model

Services, and invoke the reloadClassModelFromPersistency method).

4. Go to JMX console > UCMDB:service=Model Services, invoke the recalculateID method with

classname field empty.

This may take a while as it updates the calculated IDs for all instances of the classes with key

attributes identification.

To enable the reconciliation.tenantaware.citypes setting for specific CITs (separated by

comma) that are identified based on identification rules,

1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.

2. In the name field, enter reconciliation.tenantaware.citypes.

3. In the value field, enter names of the CITs, separated by comma.

Note: To disable this setting, leave the value field empty.

4. Click Invoke.
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To enable the reconciliation.tenantaware.citypes setting for all the CITs that are identified

based on identification rules,

1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.

2. In the name field, enter reconciliation.tenantaware.citypes.

3. In the value field, enter *.

4. Click Invoke.

Note: If you changed the Tenant ID on the Data Flow Probe, make sure you clear the probe cache as

well by performing either of the following:

l Log in to the probe server, run the following script:

Windows: \hp\UCMDB\DataFlowProbe\tools\clearProbeData.bat

Linux: \hp\UCMDB\DataFlowProbe\tools\clearProbeData.sh

l Log in to the UCMDB server UI, go to Data Flow Management > Universal Discovery >

Discovery Modules/Jobs. For each of the jobs that run on the probe, right-click the job and

select Clear Probe Results Cache.

Tenant Owner Related Known Issues, Problems, and Workaround

l PROBLEM: After switching to Tenant aware reconciliation, the OwnerTenant attribute becomes

read-only in the Configuration Item Properties dialog.

Workaround: Use Assign Tenants functionality from the CI’s context menu.

l PROBLEM: After removing the Key Attributes qualifier from the OwnerTenant attribute of the

Managed Object, sometime no properties are displayed for the CIs in UI.

Workaround: If you want to switch back (to disable Tenant aware reconciliation), do the following:

a. Remove the ID_ATTRIBUTE qualifier for the TenantOwner attribute on the managed_object CIT.

b. Remove the value of the reconciliation.tenantaware.citypes setting.

c. Reload the class model from persistency (go to the JMX console > UCMDB:service=Class Model
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Services, and invoke the reloadClassModelFromPersistency method).

d. Go to JMX console > UCMDB:service=Model Services, invoke the recalculateID method with

classname field empty.

e. Go to JMX console > UCMDB:service=Model Services, invoke the updateClasModel method.

l LIMITATION: Enrichment is not invoking the Reconciliation on Update OwnerTenant via Associate

Tenant Rule. As a result, you may have duplicated data in the system in case if you update the

OwnerTenant's CI to a tenant that already has this CI.

Workaround: None.

l LIMITATION: CIs with Identification rule would be duplicated in case if the user is updating the

OwnerTenant CI to a tenant that already has this CI from Update OwnerTenant in the Assign

Tenants module.

Workaround: None.

l PROBLEM: When adding Consumer Tenants to a CI, the System Default Tenant appears in the list of

Consumers after saving, even if it was not selected. This issue occurs only when changing the Owner

Tenant or the Consumer Tenant.

Workaround: None.

l PROBLEM: When removing all Consumer Tenants from a CI (from the IT Universe), an error is thrown

and the Owner Tenant is overwritten with the System Default Tenant.

Workaround: To avoid removing the System Default Tenant from the Consumer Tenants list, make

sure you set the System Default Tenant as consumer.

Only when the System Default Tenant is not set as consumer, the Owner Tenant will be overwritten

with the System Default Tenant when trying to save.

l PROBLEM: Error message received when setting up a tenant aware environment, for the OOTB

enrichments which are adding CIs. (QCCR1H104949)

Workaround: If there are enrichments which are creating new CIs, after setting the environment as

tenant aware, the attribute Owner tenant should be set for those CI Types which are being created

through enrichments.
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Appendix A: Troubleshooting and Limitations –
Data Flow Management
This section describes general troubleshooting and limitations related to working with Data Flow

Management.

l "Troubleshooting – Universal Discovery" below

l "Limitations – Universal Discovery" on page 793

Note:

l For details on using log files to perform basic troubleshooting, see:

o "Data Flow Probe Log Files" on page 83

o Log Files in the HP Universal CMDB Administration Guide

Troubleshooting – Universal Discovery
l "Discovery Results Do Not Appear in the Topology Map" on the next page

l "Triggers Running Unexpectedly in Management Zone" on the next page

l "Job Running Triggers Not Within Probe Limit" on the next page

l "Networks and IPs" on page 792

l "TCP Ports" on page 792

l "Discover Resources on a Windows XP Machine" on page 792

l "Trigger CIs for jobs in a management zone are in continuous "Progress" status" on page 793

l "Device attributes are not populating or contain unexpected or null values" on page 793

l "Inventory Discovery by Scanner job fails" on page 793
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Discovery Results Do Not Appear in the Topology Map

Problem. Data that should have been discovered during the discovery process does not appear in the

topology map.

Verification. The CMDB cannot retrieve the data or build the query results. Check the Discovery Results

pane. If the CIs were not created, the problem is occurring during the Discovery process.

Solution. Check the error messages in the probeMgr-services.log file located in

C:\hp\UCMDB\DataFlowProbe\runtime\logs.

Triggers Running Unexpectedly in Management Zone

Problem: There are triggers running in the Management Zone that should not be running.

Reason: Running triggers continue to run in the case where a Probe cluster is bound to the

Management Zone, and the Probes in the cluster are removed from the cluster while the triggers are

running.

Solution: To stop the triggers running, deactivate and then reactive the Management Zone.

Job Running Triggers Not Within Probe Limit

Problem: A discovery job is running triggers that are not within its Probe limit.

Indication: Triggers are not released from a job in the following cases:

Scenario 1

1. ProbeA and ProbeB belong to Cluster1.

2. Range IPs by ICMP is limited to run only on Cluster1. The job runs on both Probes in Cluster1.

3. ProbeB is removed from Cluster1.

4. In the next scheduled run of Range IPs by ICMP, you notice that the trigger is still running on both

Probes in the cluster, even though ProbeB no longer belongs to Cluster1.

Scenario 2

1. ProbeA is in Cluster1; ProbeB is under the Default Domain

2. Range IPs by ICMP is limited to run only on ProbeB.

3. ProbeB is added to Cluster1.
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4. In the next scheduled run of Range IPs by ICMP, you notice that the trigger is still running on

ProbeB, even though ProbeB now belongs to Cluster1.

Solution. Deactivate and then reactive the job.

Networks and IPs

Problem. Not all networks or IPs have been discovered.

Indication. Not all the networks or IPs appear in the topology map results.

Verification. The IP address range in the Data Flow Probe Setup window does not encompass the scope

of the networks or IPs that should have been discovered.

Solution. Change the scope of the Discovery range:

1. Select Data Flow Management > Data Flow Probe Setup.

2. Select the Probe and the range.

3. Change the IP address range in the Ranges box as required.

TCP Ports

Problem. Not all TCP ports have been discovered.

Indication. Not all TCP ports appear in the topology map results.

Verification. Open the portNumberToPortName.xml file (Data Flow Management > Adapter

Management > DDM Infra > Configuration Files > portNumberToPortName.xml), and search for the

missing TCP ports.

Solution. Add the port numbers that should be discovered to the portNumberToPortName.xml file.

Discover Resources on a Windows XP Machine

Problem. Failure to discover resources on a machine running on the Windows platform.

l Solution 1. Start > Settings > Control Panel > System. In the Remote tab, verify that the following

check box is selected: Allow users to connect remotely to this computer.

l Solution 2. In Windows Explorer, select Tools > Folder Options. In the View tab, clear the Use simple

file sharing (Recommended) check box.
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Trigger CIs for jobs in a management zone are in continuous "Progress" status

Problem. If you notice that trigger CIs for jobs in a management zone are in continuous "Progress"

status, configure Data Flow Probe to ignore certain call home requests from the Universal Discovery

Agent.

l Solution. To resolve this issue, change a parameter value as follows:

o GlobalSettings.xml file

o allowCallhomeInterval parameter

o Default is 24.

o Measured in hours that call home requests are ignored.

o Allowable values are any integer greater than 0.

Device attributes are not populating or contain unexpected or null values

Problem. If you notice that certain devices contain unexpected values or contain no values.

l Solution. To resolve this issue, run the Rulebase Support Report and send to HP Support for analysis.

For more information, see HP Universal CMDB Modeling Guide.

Inventory Discovery by Scanner job fails

Problem. If you notice that the Inventory Discovery by Scanner job fails.

Indication. The Communication log contains the following entry: "Step Wait XML Enricher Process

execution failed.".

Solution. If BDNA Normalize integration is enabled, troubleshoot BDNA Normalize operation using its

documentation or contact BDNA support.

Limitations – Universal Discovery
l When Discovery is installed on a non-English operating system, names of modules, Management

Zones, and jobs are limited to English characters (a-z; A-Z).

l When naming entities in Data Flow Management , you can use the following characters:
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o Modules: a-z, A-Z, 0-9, hyphen (-), underscore (_), space ( ), and forward slash (/).

o Management Zones: a-z, A-Z, 0-9, hyphen (-), underscore (_), and space ( ).

o Jobs: a-z, A-Z, 0-9, hyphen (-), underscore (_), and space ( ).

o Names can be a maximum length of 50 chars and MUST NOT start with a digit.

l When entering IP addresses, use only digits and asterisks (*)

l Each Content Pack installation overrides all out-of-the-box resources with the contents of that

Content Pack. This means that any changes you made to these resources are lost. This applies to

the following resources: Queries, Views, Enrichments, Reports, Discovery Jython scripts, Discovery

adapters, Discovery jobs, Discovery resources, Discovery configuration files, Discovery modules, CI

Types, and Relationships. (Attributes added to CI Types and Relationships are not overridden).

In general, you should refrain from making changes to out-of-the-box resources. If you must do so,

be sure to track your changes so that they can be re-applied after you install a Content Pack.

Important general fixes (not specific to your environment) should be sent to CSO so that they can be

analyzed and included as part of one of the next Content Packs.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an

email client is configured on this system, click the link above and an email window opens with the

following information in the subject line:

Feedback on Data Flow Management Guide (Universal CMDB 10.22)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and

send your feedback to cms-doc@hpe.com.

We appreciate your feedback!
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